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Using This Help File
Sections in this chapter:

Navigation Bar<UseHelp/Nav>

Menu Buttons<UseHelp/HUB>

Popup Tooltips<UseHelp/Pop>

Conventions<UseHelp/Conv>

Link Location Arrow<UseHelp/Arrow>

This Help File can only be accessed through the KARMA application. If KARMA can not locate the file when you request 
help, it will ask you to locate this file. You should not move the file from where it was installed by the Installer or rename 
it. An Adobe Acrobat® version (.pdf) of this same file was installed on your hard drive and can be used for printing and 
online searching if desired.

The Help File can be opened in four different ways:
1) by using the main Help Menu, which has several locations in this file preselected for easy access;
2) by pressing the key shortcut Cmnd+H (Mac) or Ctrl+H (Windows), taking you to the Table Of Contents;
3) by pressing the key shortcut Cmnd+H (Mac) or Ctrl+H (Windows) while a popup Tooltip is showing, thereby taking you 
directly to the parameter associated with the Tooltip; and
4) by choosing the “Help” command from any of the round Menu Buttons that can be found in each window and page of the 
application (see below).

<Nav><1117><1118><1119><1120><1121><1122><1123><1124>
Navigation Bar
The buttons on the Navigation Bar at the top of the Help Window allow you to move through the Help File. You may also 
select a chapter directly with the “Select Chapter” popup menu.

 

Except for the Table Of Contents button, the other buttons may be inactive at various times (grayed out) depending on 
where you are in the document.

The Help File remembers your current position every time you click on a new hypertext link, or use the buttons to move 
somewhere else. These positions are assembled into a list of up to 25 links. The Back (Previous Link) and Forward (Next 
Link) buttons allow you to step backwards or forwards through this list. Each time you close the Help Window, the list is 
reset to zero, and the buttons will be disabled next time you open the window.

When the Help Window is front most (or when a modal dialog is open in front of it), certain keys on the computer keyboard 
can also be used to navigate through the file, instead of or in addition to the above buttons:

 

You can also use the mouse wheel to scroll up/down the current page.

    Even though a modal dialog may be up, you can still open and access the Help File. You cannot click on it with the mouse, 
but all of the key commands above let you navigate through it and get information on the modal dialog that is up if desired.

<HUB><0000><0001><0002>
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Menu Buttons
 

Each of the round “Menu Buttons” next to the editor or page titles produce a popup menu when clicked. They each have 
“Help” as the first item, giving you a direct link to the applicable section of this file. Select “Help” on any of these 
buttons for immediate access to the chapter containing information about the parameters in that section of the application.

The other commands in each of the Menu Buttons are utility functions that relate to the particular editor or page that the 
button is associated with. Therefore, these items will vary according to the location of the button. For information on the 
commands in each of these buttons, consult the chapter that relates to the page or editor that the button is associated 
wi th.

<Pop><0001>
Popup Tooltips
 

Popup Tooltips are short descriptions that popup while holding the mouse cursor over various labels, parameters and 
objects in the application. Tooltips can be turned on or off globally for the entire application, in addition to having several 
groups within the tooltip system that can be independently controlled. You can turn them globally on/off from the Help 
Menu, or also from the Preferences Editor, where other control options such as the delay before they appear can be set. 
You can control exactly which objects have tooltips and the amount of time delay before they pop up, or only the use of 
the ‘t’ key to make them pop up. For more information, see Preferences - Tooltips.
<Prefs/Tooltips>

For example, after you get used to working with KARMA, it may be helpful to set the tooltips to only popup over labels 
(and not parameters), and have the longest delay time setting. That way, you may never notice they are there during 
normal speed of working, but if you want a reminder or a hint about some function, you can hold the mouse over a label 
and it will appear. Or, you may wish to use the option where popping up is completely disabled, but you can still press the 
‘t’ key to make a tooltip popup at any time.

    When a tooltip is showing, if you press Cmnd+H (Mac) or Ctrl+H (Windows), you will be taken directly to the Help File 
and the applicable parameter for more information.

    To make a tooltip go away when it is showing without moving the mouse off an object, press any key on the computer 
keyboard. Also, a tooltip will automatically disappear after approximately 15 seconds.

<Conv>
Conventions
--- Keyboards/Devices - - -

--- Parameters - - -

Parameters and changeable settings are displayed in bold type surrounded by square brackets, with a blue diamond icon 
like this:

    [Parameter] (object type) [range]

Unless otherwise specified, “Motif” refers to the any of the Motif XS, Motif XF, S70/S90 XS or Rack-XS products. 
Unless otherwise specified, “MOX” refers to any of the MOX and MOXF products. 
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--- Hypertext Links ---

Hypertext links to other areas of the help file are shown in red and are underlined, like this:

I'm A Hypertext Link

As you move the cursor over a link, it will change into a “hand,” indicating that you can click on it. You will be taken to 
the linked item (the example above does not take you anywhere).

    If you are using the Acrobat .pdf version, the main chapter title links in the Index and the Section Dividers work, but 
the individual links sprinkled throughout the chapters currently do not.

--- Key Commands ---

Key Commands (such as Ctrl+M) are shown in blue type, like this.

--- Notes ---

    Notes are presented in brown type like this (with a balloon icon), and present additional information about a particular 
topic.

--- Important Items ---

    Important items are presented in red type like this (with an exclamation point icon), and are important notices 
concerning various features and functions of KARMA.

--- Tips ---

    Tips are presented in magenta type like this (with a light bulb icon), and are suggestions and tricks to help you get the 
most out of KARMA.

--- Example Performances/Generated Effects ---

Example Performances and GEs are shown in bold green type like this: 001: Industrial Strength.

<Arrow>
Link Location Arrow
 

The red Link Location Arrow shows the position in the file corresponding to the last link or button that was used. In other 
words, when you locate to a place in the Help File, a red arrow highlights the position so you can easily find what you’ve 
asked for. Any of the following methods of changing locations in the Help File will move the red arrow:

     - clicking on hypertext links;
     - using the buttons in the Navigation Bar at the top of the window;
     - using Menu Buttons to locate to various chapters;
     - using  Cmnd+H (Mac) or Ctrl+H (Windows) on a popped-up tooltip to locate to a Help File section.
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Basic Operations
Sections in this chapter:

How To Make It Stop!<Basic/Stop>

User Interface Objects<Basic/UI>

     Inc/Decs (Tiny Up/Down Arrows)<Basic/IncDec>

     Numericals (Number Boxes)<Basic/Num>

Moving Windows Without Title Bars<Basic/Mov>

Dialogs And OK/Cancel Buttons<Basic/Dialog>

Also see Using The Pattern Grids<UseGrid>

This chapter discusses some basic operations that should be helpful to new users.

<Stop>
Basic Operations - How To Make It Stop!
The computer’s Return Key stops the KARMA function without actually turning it off. You can immediately restart it by 
playing the keyboard or activating a Chord Trigger button. You can also use the KARMA On/Off button in the Real-Time 
Controls Window (or the computer’s [F9] function key). But using the Return Key can be more useful since no toggling back 
and forth is required. The Motif/MOX Remote Mode has the sequencer transport [STOP] button assigned to this feature as 
well .

For an in depth review of all key commands in KARMA Software, see Keyboard Shortcuts.
<KbdShort><UI>

Basic Operations - User Interface Objects
<IncDec>
Inc/Decs (Tiny Up/Down Arrows)

 

Next to every numerical (number box) and popup menu in the KARMA software is an “Inc/Dec.” Named for the operations 
“increment/decrement” (meaning to increase or decrease in value), they can be used to increase or decrease the setting 
in the number box or popup menu. Single clicks increment and decrement by one; on most Inc/Decs, you can hold down the 
mouse and it will begin scrolling continuously after a short delay.
<Num>
Numericals (Number Boxes)

 

The number fields used in all areas of the application are referred to as “Numericals.” They can be manipulated or set in 
several ways:

1) Click the numerical with the mouse. It becomes highlighted and ready to accept input. Enter the value with the computer 
keys (generally numbers, but in the case of MIDI Note numericals, you may also use letters, such as c4) Press Enter or 
Return to set the value.

2) Click the numerical with the mouse. It becomes highlighted and ready to accept input. Use the up/down arrow keys on 
the computer keyboard to increment and decrement the value.

3) Click the numerical but do not release the mouse. By dragging up or down, you can scroll the value contained inside. 
Press Enter or Return to set the value, or click somewhere else to end the edit.

4) Use the Inc/Dec (tiny up/down arrows) next to the numerical to increment or decrement the value in the associated 
numerical. Single clicks increment and decrement by one; on most Inc/Decs, you can hold down the mouse and it will begin 
scrolling continuously after a short delay.

Floating Point Numericals

 

When scrolling or incrementing/decrementing the value in a floating point numerical, it will shift by amounts determined 
by the last fractional value manually entered. In other words, if the last value entered was a whole number such as “1” 
(which is the default), clicking the up arrow once will change to 2, then 3 etc. If the last value entered had one decimal 
place, such as “1.1,” then clicking once would increment to 1.2, then 1.3 etc. If the last value entered had two decimal 
places, such as “1.11,” then clicking once would increment to 1.12, then 1.13 etc. This also applies to scrolling with the 
mouse or using the up/down arrow keys of the keyboard.
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�    There are currently only a few floating point values in KARMA: the Tempo fields, and the GE Editor > Note Series Page 
“Replications” parameter.

<Mov>
Basic Operations - Moving Windows Without Title Bars
 

Windows OS only: Most of the dialogs in the KARMA application do not have conventional title bars. You can still move 
them simply by moving the mouse cursor up to the top area of the window. It will turn into a “hand” cursor, indicating 
that you can click and drag the window to a new location.

<Dialog><1110><1111><1112><1113><1114><1116>
Basic Operations - Dialogs And OK/Cancel Buttons
 

In many dialogs, the “Cancel” button is represented by a red X, while the “OK/Save/Accept” button is represented by a 
green checkmark. These buttons are mapped to the following Key Commands:

Cancel                  Esc (Mac/Win), Cmnd+Period (Mac), Ctrl+Period (Win)
OK            Enter, Return (Mac/Win)

If there is a “Don’t Save” button, it is mapped to:

Don’t Save     Cmnd+D (Mac), Ctrl+D (Win)

Some dialogs have an option or checkbox such as “Don’t Show Again” or “Don’t Show Again This Session.” Choosing 
these options will silence those types of warnings until the next time you launch the application, or in some cases until you 
reset the warning dialogs in the Preferences.

Other useful chapters to consult now that you’ve made it this far include:

Using The Pattern Grids<UseGrid>

Menu Reference<MenuRef>

Keyboard Shortcuts<KbdShort>

KARMA Memory Architecture<MemArch>
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<1243><1244><1245>

First Launch/Tutorials
 

First Launch Dialog
The First Launch Dialog is presented when you launch the application for the first time. It will continue to be shown each 
time you launch the application until you click the “Don’t Show This Again” button. After that, if you ever wish to see it 
again for some reason, you need to use the “Reset Warning Dialogs” button on the Preferences - General Tab.
<Prefs/General>

The only purpose of this dialog is to alert you to the fact that there are a number of tutorials included with the software 
that should be worked through to familiarize yourself with basic operations. These tutorials are not part of this Help 
Reference Guide - rather, they are separate PDF documents included with your installation.

The “Tutorials Folder” button provides instant access to the folder on your computer containing the tutorials, and will 
open it and bring it to the front. Alternately, you can always gain access to the Tutorials Folder from KARMA’s Help 
Menu. 
<TutFolder>
Tutorials Folder
 

Your KARMA Motif installation includes a Tutorials Folder containing a number of instructional tutorials that should be 
worked through to familiarize yourself with basic operations. These tutorials are not part of this Help Reference Guide - 
rather, they are separate PDF documents included with your installation. You can always gain access to the Tutorials 
Folder from KARMA’s Help Menu (Mac version shown above). <MenuRef2/Help>
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Since more tutorials may be added to the application from time to time, a list is not provided here. You can always consult 
the KARMA Motif Documentation page to see the latest tutorials and revisions and make sure you are up-to-date:

h t t p : / / k a r m a - l a b . c o m / k m o / d o c s

For reference, the location of the Tutorials Folder in a default installation is:

Mac OS X:                      Applications/KARMA Motif/Tutorials

Windows (XP):                 Program Files/KARMA Motif/Tutorials

Windows (Vista/Win7):     Users/YourAccount/Documents/KARMA Motif/Tutorials

On Windows, the Tutorials are also in Start Menu, for easy access.
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Main Window
Sections in this chapter:

Overview<SWGUI/Over>

Toolbar<SWGUI/Toolbar>

Status Area<SWGUI/Status>

KDF Area<SWGUI/KDF>

Add Bank Dialog<SWGUI/AddBank>

 

<Over>
Main Window - Overview
The Main Window of the application provides most of KARMA’s interface and features in a single window design, with 
multiple editors accessed by the Editor Selection Buttons at the top. The window contains a KDF Area that displays the 
contents of the currently loaded KARMA Data File (KDF) as rows of banks, for Performances, GEs and Templates. It also 
contains a Status Area that displays useful run-time information, controls the Tempo of the current Performance and 
allows control over KARMA’s six Modules in a number of ways. The window can be divided into the following sections:
<1915><1916><1917><1918><1919><1920><1921><1922><1923><1924><1925><1926>

Editor Selection Buttons/Editor Display Area
These buttons allow different groupings of parameters (Editors) to be displayed in the Editor Display Area. Each of the 
Editors and the Editor’s pages have a separate chapter in this manual describing their parameters and features. This 
chapter discusses the features of the Main Window surrounding the Editor Display Area.
<SWGUISect>

Toolbar
These buttons provide quick access to some commonly used features and commands of the application, all of which are 
available on various menus as well, but have been provided here for convenience. See Main Window - Toolbar.
<SWGUI/Toolbar><1891>

Chord Display
Shows the currently analyzed chord type from the notes received as input source material. When KARMA is on, this 
shows the chord from the current edit module’s input zone. When KARMA is off, this shows the chord from the entire 
keyboard. If the Performance Editor’s Master Transpose setting is being used to transpose the output of KARMA, a +/- 
number of semitones will be displayed in front of the chord name. <PE/Transpose>
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KDF Area
Displays the contents of the currently loaded KARMA Data File (KDF) as rows of banks, for Performances, GEs and 
Templates. See Main Window - KDF Area.
<SWGUI/KDF>

Status Area
Displays useful run-time information, controls the Tempo of the current Performance and allows control over KARMA’s 
six Modules in a number of ways. See Main Window - Status Area.
<SWGUI/Status>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with the Main Window:

 

(Click on the links for detailed information on utilities not fully explained here.)

New KDF…
Allows you to create a new KDF file, the same as choosing this option from the application’s File Menu.
<MenuRef/NewKDF>

Add Bank…<SWGUI/AddBank>

Delete Selected Bank(s)…
Allows you to remove any selected banks from the .kdf file. You will be given an opportunity to cancel. Note that it is not 
recommended to remove banks of GEs or Templates unless you know what you are doing, as you may cause problems with 
any Performances that use them.

Rename Selected Bank…<OthDlg/Brn>

Lock/Unlock Selected Banks
Toggles the locked setting for all selected banks. You can use this to lock or unlock multiple banks at the same time. A 
locked bank will present warning dialogs when you attempt to alter the data in the bank by pasting, clearing, storing etc. 
You can use this to protect banks from accidental overwrites. You can also lock/unlock a single bank from within the Bank 
Display Editor. A Bank Lock Icon is displayed to the right side of a locked bank, underneath the Bank Type Designator.

Reset Module Name List…
Allows you to reset the list of Module Names available in the Performance Editor > GE Setup/Mix Page to the factory 
default. If you have used Module Names in the Performances, they may need to be manually reset. If you have created 
custom names, they will be lost. You will be given an opportunity to cancel when selecting this command. For more 
information on Module Names, see GE Setup/Mix - Module Parameters. <MixEd/ParmsGE>

Reset Scene Name List…
Allows you to reset the list of Scene Names available in the Real-Time Controls Editor to the factory default. If you have 
used Scene Names in the Performances, they may need to be manually reset. If you have created custom names, they will 
be lost. You will be given an opportunity to cancel when selecting this command. For more information on Scene Names, 
see RT Controls - Scene Matrix Area. <RtcEd/0845>

Reset RT Control Name List…
Allows you to reset the list of RT Control Names available in the Real-Time Controls Editor to the factory default. Since 
RT Control Names are used in all Performances, they may need to be manually reset. If you have created custom names, 
they will be lost. You will be given an opportunity to cancel when selecting this command. For more information on RT 
Control Names, see RT Controls - View: RTC. <RtcEd2/2363>

Open KDF Files (bottom of menu)
The open KDF files are dynamically appended to the bottom of the menu. If only one is open (as typical), it is displayed but 
grayed out. If more than one is open, they are all displayed here, with the current one given a checkmark. You can switch 
between them by selecting a different one, which then becomes the “Current KDF” from which Performances are loaded.

<Toolbar>

Page 14



Main Window - Toolbar

 

The Toolbar buttons provide quick access to some commonly used features and commands of the application, all of which 
are available on various menus as well, but have been provided here for convenience. Some of them will be grayed out at 
various times depending on the current state of the software. The following table provides a brief description of each 
button, the applicable computer keyboard commands (if assigned) and the chapter to consult for more information.
<1898>
    [Open]                      Cmnd+O (Mac)     Ctrl+O (Win)

Brings up the standard open dialog, allowing you to locate and open a different KDF file. Multiple KDF files can be open at 
the same time; you switch between them using the Main Application Window’s Menu Button, or the Window Menu. This is 
the same as using the Open command on the File Menu.
<MenuRef/File><1905>
    [Close]                     Cmnd+W (Mac)     Ctrl+W (Win)

Closes the current KDF file. You will be given an opportunity to save any edits. If only one KDF file is open, the button will 
be grayed out, since you must always have at least one KDF open. This is the same as using the Close command on the File 
Menu.
<MenuRef/File><1899>
    [Save]                      Cmnd+S (Mac)     Ctrl+S (Win)

Saves any changes to the current KDF file. Note that this only saves changes stored to the KDF file; if you have edited a 
Performance, you must first store it in the KDF. If no changes have been made, the button will be grayed out. This is the 
same as using the Save command on the File Menu.
<MenuRef/File><1906>
   [Save As]

Brings up the standard save dialog, allowing you to save the current KDF File in a different location or with a different 
name. This is the same as using the Save As… command on the File Menu.
<MenuRef/File><1904>
   [Save All]

Similar to Save, in that it saves any changes to the current KDF file. In addition, it also saves any changes to the current 
Performance, including any edits to any GEs within it. In other words, it is equivalent to performing the following 
operations in this order:

    (1) save any edited GEs to the same locations;
    (2) save the current Performance to the same location;
    (3) save the KDF under the same name and location. 

If no changes have been made, the button will be grayed out. This is the same as using the Save All Edits (Perf/GE/KDF) 
command on the File Menu.
<MenuRef/File>

    Care should be exercised in using this option, since saving edits to GEs that you might not know you made could affect 
the operation of other Performances that use the same GE. Therefore, if any GEs are edited, you will be given an option to 
cancel with the Save All Edits Warning Dialog, so that you can decide if you really want to overwrite the GEs.
<OthDlg/SaveAllWarn><1913>
   [Save Performance]

Brings up the Multi-Bank Save Dialog, allowing you to store the current Performance in the same location, or a different 
location. If no changes have been made to the current Performance, the button will be grayed out. This is the same as 
clicking on the [Save] button at the top of the Performance Editor.
<OthDlg/Mbs><1897><PerfNotes>
    [Performance Notes]   Cmnd+\ (Mac)     Ctrl+\ (Win)

Opens a document containing detailed information about the currently selected Performance. You can edit or create your 
own Performance Notes documents; the path to the file is stored in the Performance Editor > Other Page.
<KexEd><1900>
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�   [Help]                       Cmnd+H (Mac)     Ctrl+H (Win)

Opens this online Help File/Reference Guide. This is the same as using the Help command on the Help Menu.
<MenuRef2/Help><1901>
    [Preferences]           Cmnd+, (Mac)      Ctrl+, (Win)

Opens the Preferences Dialog, allowing you to edit global settings that affect the way the KARMA application behaves. 
This is the same as selecting Preferences from the Application Menu (Mac) or Edit Menu (Windows).
<Prefs>

    MIDI Setup Preferences are located elsewhere, in the MIDI Setup (Global) Editor. <MsuEd>
<1903>
    [All Notes Off]          Cmnd+/ (Mac)     Ctrl+/ (Win)

Sends multiple “All Notes Off” commands on all MIDI Channels in use to silence any hanging notes. Also performs a 
general internal reset of certain variables. This is the same as using the All Notes Off command on the Utilities Menu.
<MenuRef2/Utiltiies><1902><Bypass>
    [Bypass]                   C m n d +0  (Mac)     Ctrl+0  (Win)

Turning Bypass on allows you to completely “disconnect” the KARMA Software from the Motif/MOX, as if it was turned 
off and you were just working with the keyboard. This is the same as using the Bypass command on the Options Menu.
<MenuRef/Options><1907>
    [Stop]                    R e t u r n

Stops all KARMA activity, without turning it off, so that you can restart it when desired. If KARMA is not running, the 
button will be grayed out. This is the same as using the Stop command on the Utilities Menu. <MenuRef2/Utilities>

<Status>
Main Window - Status Area
 

The Status Area is the main “Control Center” and “Information Display” for the KARMA software. The settings here 
affect some very basic functionality such as which of KARMA’s seven Control Layers is active (thereby specifying which 
one you are making changes to when editing the Real-Time Sliders and Switches), whether specific Modules are running in 
the overall Performance, which Module you might be editing in terms of Module-specific parameters, and whether one or 
more Modules are soloed. The Status Area also displays in the bottom portion some helpful information about the Current 
RT Control Layer and its GE, its Scenes, and the current KDF file.

It can be divided into the following sections, parameters and functions, from top to bottom:
<1882><1883>
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�   [Tempo] (numerical) [40.00...300.00 BPM]

Sets the overall Tempo for the Performance, in Beats Per Minute (BPM). The Tempo LED next to it flashes according to 
quarter notes. 

Note that each Generated Effect is stored with the tempo that was being used when it was last saved, so that a reference 
exists for the correct tempo to use it at. However, the Performance Tempo overrides the settings of all the GEs being 
used by that Performance. When you load a GE using the popup menus in various other editors, the GE Tempo will not 
normally affect the Performance Tempo unless the “Loading GE Loads GE Tempo” option in the Options Menu is checked. 
Therefore, if you are auditioning single GEs and want to hear them at the tempo that they were intended to be used at, you 
should select that option. Then when the GE is loaded, it will replace the Performance Tempo with the GE Tempo. This only 
applies to GEs that are loaded using the popup menus in the GE Editor, or the corresponding GE popup menus in the 
Performance Editor > GE Setup/Mix Page.

    The GE Tempo and Performance Tempo settings are “linked,” in that if you adjust the GE Tempo while listening to a GE 
you will also be changing the Performance Tempo.
<1908><1909><1911><1912>
Activity LEDs
There are three colored LEDs that flash according to different types of MIDI data that KARMA is generating:

    - Note Activity (yellow)  -  Flashes when KARMA is generating MIDI Note data.
    - CC Activity (green)  -  Flashes when KARMA is generating MIDI CC (Control Change) data.
    - Bend Activity (purple)  -  Flashes when KARMA is generating MIDI Pitch Bend data.
<1895>

    [Current Performance] (popup menu) [1...128]
Displays the name of the currently selected Performance. A diamond (Mac) or asterisk (Windows) is displayed to the left 
of the name if the Performance has been edited. You may also click on it popup a menu to select another Performance in 
the current Performance Bank. The Performance is then loaded, replacing the previous settings, and the parameters in the 
various editing windows change to reflect the new values.

Four Columns Of Buttons
There are four columns of buttons. Depending on the number of enabled Modules, various rows may be grayed out. From 
left to right:
<1894><1880><1887>
    [RT Control Layer] (radio buttons) [Layers 1...7]

Selects the “Current Real-Time Control Layer” of the interface. The 8 Real-Time Sliders, 8 Real-Time Switches and 8 
Scene Selector Buttons (of the Real-Time Control Page) are then mapped to the selected Module (or Master) Layer. There 
are seven RT Control Layers, including one for each Module and a top-level Master Layer that can control aspects of all 
Modules at the same time, including the Current Scene for each Module. The label displays a descriptive name for each 
Real-Time Control Layer of the interface. The Module names can be assigned on the Performance Editor > GE Setup/Mix 
Page.
<MixEd/0107>

    Hidden shortcut: double-click one of these buttons to bring the Real-Time Controls Page to the front showing the RT 
Sliders and Switches for the selected layer.
<1884>
    [Edit] (radio buttons) [Modules 1...6]

Selects the “Current Edit Module,” which is the Module that is displayed for editing in the GE Editor and other places 
where only a single Module can be displayed (such as the Performance Editor > RT Parms Page). This is independent of 
which RT Control Layer is currently selected - you can be editing one Module’s GE, while the RT Control Layer is set to a 
different layer for real-time control.

    Hidden shortcut: double-click one of these buttons to bring the GE Editor to the front for the selected Module.
<1885>
    [Run] (buttons) [Modules 1...6]

When on, enables the selected Module in all Scenes, according to the Track Mute settings.  When off, disables the Module in 
all Scenes regardless of the Track Mute settings. You can use this to temporarily turn off a Module in a Performance in all 
Scenes at the same time. The Module may still playing, but it is muted, so it can be activated at any time and be at the 
correct place in the phrase. The Run settings are stored with the Performance.
<1886>
    [Solo] (buttons) [Modules 1...6]

Solos the selected Module, even if the Run button is off. More than one Module can be soloed at the same time. Solos for 
the Keyboard Layers are in the Performance Editor > GE Setup/Mix Page. Solos are NOT stored with the Performance.

<1893><1892>

    You can clear all solos at once with the “Clear Solo” command on the Edit Menu, or by the hidden shortcut of 
cmnd-clicking (Mac) or ctrl-clicking (Win) a Solo button wth the mouse.

Information Area
The Information Area at the bottom displays the following items:
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Current RT Control Layer Info
Displays the currently selected Real-Time Control Layer of the interface (which can be changed by the buttons above), and 
the RTC Model Type for the GE that is associated with the currently selected RT Control Layer (this specifies how the RT 
Controls are assigned to it).
<1888>
Current KDF Info
Displays the name of the current KDF (KARMA Data File), from which a Performance is loaded. You can have more than 
one KDF file open at a time, but only one of them is the current KDF.
<1889><1890>
Current GE Info
Displays the name of the GE Bank and GE for the Current Edit Module (selected by the Edit buttons above).
<1896>
Scene (Startup Scene)
Displays the current Scene for the current RT Control Layer. The Startup Scene (when the Performance was loaded) for 
the layer is shown in parentheses for reference.
<1910>
Current Function Set (S70/S90 XS only)
Displays the currently selected Function Set when using the S70/S90 XS DAW Remote Mode. Function Sets are changed 
using the 1-8 buttons on the right side of the keyboard.

<KDF>
Main Window - KDF Area
 

“KDF” stands for KARMA Data File (also referred to as the “.kdf file” because of its three-letter extension). The KDF 
file contains all the data for the Performances you work with. You can have multiple KDF files open, and move between 
them during a session if desired, but only one KDF is the “current KDF,” meaning you are editing or playing a 
Performance located in that file. The current KDF has its contents displayed in the KDF Area as rows of banks (two 
different views are shown above, scrolled up and down), while other KDF Files that are not current are hidden and can be 
made current using the Main Window’s Menu Button (the KARMA Motif Logo) or the bottom of the Window Menu.
<0975>
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Scroll Bar
Use to scroll more banks into view if necessary. You can also use the mouse wheel, the computer’s Page Up and Page 
Down keys, or the computer keyboard’s arrow keys to advance the selection to the next row (when the Bank Display 
Editor is not showing; otherwise, the arrow keys apply to the Bank Display Editor).
<0974>

Bank Rows
Each row represents a different bank in the file, and they are arranged in three sections: Performance Banks (blue) at the 
top, GE Banks (green) in the middle, and Template Banks (yellow) at the bottom. Click to select, double-click to open, 
command-click (Mac) or control-click (Win) to select more than one at a time. When double-clicked, the Bank Display 
Editor of the Main Window will be selected and the selected bank will be displayed. You can then view and select individual 
Performances, GEs, and other items by clicking on them.

You can have up to 32 banks of Performances, 32 banks of GEs and 6 Banks of Templates in a KDF file.

    Entire banks can be copied, pasted, and deleted (cleared) by selecting the desired Bank Rows in the KDF Window and 
using the commands on the Edit Menu (when the Bank Display Editor is not being shown - otherwise, the Edit Menu applies 
to the Bank Display Editor). You can also use the commands on the Main Window’s Menu Button (the KARMA Motif Logo).

Each of the three types of bank rows (Performances, GEs and Templates) can be double-clicked, which will open the 
corresponding bank in the Bank Display Editor, as described in these other chapters:

Bank Display (Performances) <PBD>

Bank Display (GEs) <GBD>

Bank Display (Templates) <TBD>

Bank Type Designator
Each bank row contains a Bank Type Designator that shows the setting of that bank’s Bank Type parameter. Each bank 
within each type (Performances, GEs and Templates) should have a unique Bank Type setting, which can be assigned in the 
Bank Display Editor.

Bank Lock Icon
If a bank is locked (preventing accidental overwriting of the data in that bank), a Bank Lock Icon is shown underneath the 
Bank Type Designator. Banks can be locked and unlocked in the Bank Display Editor, or by using the “Lock/Unlock Selected 
Banks” command in the Main Window’s Menu Button.

<AddBank><0980>
Main Window - Add Bank Dialog
 

The Add Bank Dialog allows you to add one bank at a time to the current KDF File. It can be opened from the Main Window’s 
Menu Button (the KARMA Motif Logo). It will automatically add a bank of the next “type” that is currently not in the file - 
for example, if you have Performance Banks A, B, and C in the file, adding a Performance bank will add Performance Bank 
D. You can change this using the Bank Type setting (if necessary) in the new bank’s Bank Display Editor.

    If you have a bank row of the same type you are adding selected in the KDF Are when you add the bank, it will insert 
the new bank below the selected one. Otherwise, it will add the new bank at the end of the section corresponding to the 
bank type (Performances, GEs or Templates).
<0981>

    [File Name] (label)

Displays the name of the KDF file to which you will add a bank (which is always the current KDF file).
<0984>

    [Performances] (button)

Adds a bank of Performances. You can have up to 32 banks of Performances in a KDF file.
<0985>
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    [GEs (Generated Effects)] (button)

Adds a bank of Generated Effects. You can have up to 32 banks of GEs in a KDF file.
<0986>

    [Templates] (button)

Adds a bank of Templates for storing and accessing Rhythm Patterns, Drum Patterns, etc. You can have up to 6 banks of 
Templates in a KDF file.
<0989>

    [Execute] (button)

Adds the specified bank without closing the dialog, so that you can continue adding banks.
<0987><0988>

    [OK/Cancel] (buttons)

The Cancel button (red X) closes the dialog without adding any banks to the file. The OK button (green checkmark) closes 
the dialog and adds the selected bank to the file. It then selects the bank in the KDF Area and scrolls it into view if 
necessary.
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<0842>

Real-Time Controls (RTC) - Part 1
Sections in this chapter:

Overview<RtcEd/Over>

Display Selector<RtcEd/Display>

MIDI Activity Display<RtcEd/Activity>

Phase Activity Display<RtcEd/PhsActivity>

Scene Matrix Area<RtcEd/Matrix>

Chord Trigger Area<RtcEd/Chord>

Sections in Part 2: <RtcEd2>

View Selector<RtcEd2/View>

View Area: Mix<RtcEd2/Mix>

View Area: RTC<RtcEd2/Parms>

 

 

<Over>
RT Controls - Overview
The Real-Time Controls Editor (also referred to as the RT Controls Editor or RTC Editor) is the default start-up page for 
KARMA Motif. It’s where you go for top-level real-time control of the KARMA Performance, and will likely be the page 
that you use the most often, unless you get into editing or creating your own Performances and GEs. 

Of course, you can vary any parameter in a GE or a Performance directly on the screen with the mouse in real-time. What 
we mean by “Real-Time Control” here is that multiple parameters can be assigned to the eight RT Sliders and eight RT 
Switches, and then varied in real-time via MIDI Controllers (such as any programmable control surface, or the control 
surface of the Motif/MOX in Remote Mode). The values of those 16 Real-Time Controls (RTC) are stored in the current 
scene, and can be changed to radically different settings by changing scenes. The MIDI CCs that each slider and switch will 
respond to are set up in the MIDI Setup (Global) Editor > RTC Setup Page.
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<MsuRTC>

The editor is divided into four different sections:

Activity Display
Switches between two different activity displays via the Display Selector radio buttons on the left. The MIDI Activity 
Display shows the incoming MIDI notes on a keyboard grid, and the outgoing MIDI messages being generated by KARMA, 
with a row for each Module. The Phase Activity Display shows the current Phase Pattern Step for each of the Modules and 
its relationship to the Scene Change Quantize Window. <RtcEd/Display>

Scene Matrix Area
Parameters for selecting scenes, controlling when they change, and selecting the current Control Layer being displayed 
and edited in the RTC View.

Chord Trigger Area
Contains the 16 Chord Trigger buttons, each of which can store a chord, trigger a Motif/MOX arp or trigger hits and SFX, 
and buttons for several other features as well, such as the Fill, Stutter, Retrigger, Assignable Switches 1/2, KARMA 
On/Off and Latch.

View Area (Mix/RTC)
Switches between two different views via the View Selector radio buttons on the left. The Mix View displays the Track 
Volumes and Track Mutes for the current scene in the Master RT Control Layer, while the RTC View displays the settings 
for the 16 RT Controls for the current scene in the current RT Control Layer. <RtcEd2/View>
<MenuBut>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this editor:

 

(Click on the links for detailed information on utilities not fully explained here.)

Change Appearance When Edited
When on (checked), the slider heads and buttons in the Mix or RTC View will display a yellow dot when they are different 
from the stored values of the Scene, indicating they have been edited. When off, there will be no change in appearance. 
This setting is stored in the Preferences.

Show Controlled Values
When on (checked), moving the mouse over any of the 16 RT Controls in the RTC View (eight sliders and eight switches) 
will popup the Controlled Values Display, displaying the current values of any parameters that are assigned to them. When 
the control is activated, the values update as the control is moved. When off, this feature is disabled. This setting is 
stored in the Preferences. <RtcEd2/Parms>

Copy From Performance...<PEUtils/Mco>
Opens the Copy From Performance Dialog with the options related to RT Controls already set. 

Copy Scenes…<RtcDlg/CopySwapScenes>
Opens the Copy Scenes Dialog allowing you to copy a scene in one or more Control Layers, to one or more other scenes. 
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Swap Scenes…<RtcDlg/CopySwapScenes>
Opens the Swap Scenes Dialog allowing you to swap any two scenes, in one or more Control Layers at the same time. 

Reorder Scenes…<RtcDlg/Reorder>
Opens the Reorder Scenes Dialog, allowing to reorder the arrangement of the first 8 scenes in any Control Layer.

Set RTC Values In Scenes…<RtcDlg/SetRTC>
Allows you to modify any RTC settings (RT Switches and RT Sliders) in any RT Control Layer in all 32 scenes at the same 
time.

Set Mix Values In Scenes…<RtcDlg/SetMix>
Allows you to modify any Mix settings (Track Volumes and Track Mutes) in all 32 scenes at the same time.

Revert All Scenes
Returns all settings in all 32 Scenes in the all Control Layers to the stored values, as if you had reloaded that part of the 
Performance. You cannot return to the edited values.

Revert All Scenes (In Layer)
Returns all settings in all 32 Scenes in the current Control Layer to the stored values, as if you had reloaded that part of 
the Performance. You cannot return to the edited values.

Reset Scene Names (In Layer)
Resets the names of the 32 Scenes in the current Control Layer to the default names, i.e. Scene 1, Scene 2, Scene 3...

Swap RTC Settings...<RtcDlg/Swap>
Opens the Swap RTC Settings Dialog, allowing you to swap the assignments of controllers within a Performance.

Clear RTC Names (In Layer)
Clears the name assignments for all eight sliders and eight switches, in the currently selected Control Layer.

    There is no option to cancel. To return to the previous settings, you will need to reload the Performance.

Auto Assign RTC Names (In Layer)
Based on the GE RT Parms and PE RT Parms that are being controlled, appropriate names (out of the default factory names 
such as Rhythm Swing % and Rhythm Complexity) can be automatically assigned for the eight sliders and eight switches. 
You can use this when creating new KARMA function assignments, or changing GE selections.

    When you select this menu item, it will rename all eight sliders and eight switches. There is no option to cancel. To 
return to the previous settings, you will need to reload the Performance.

    Please be aware that even in the case of a Performance for which you have not edited the KARMA function, executing 
this command may assign names that are different from the currently specified names. That is because the programmer 
made other choices that were felt more appropriate.

    While the default names are useful for quick settings, many times you can set them to even more appropriate names by 
checking the names in the same general area of the list for variations or greater clarity.

    To see what this is doing on a Performance that is already named, you can use the “Clear RTC Names” Utility above 
f i r s t .

The following three items relate to resetting or replacing the list of RT Control Names available to be assigned to the 16 
RT Controls in the RTC View. Since RT Control Names are used in all Performances, the Performance’s assignments may 
need to be manually reset. If you have created custom names, they will be lost. You will be given an opportunity to cancel 
when selecting these commands. For more information on RT Control Names, see RT Controls - View: RTC.
<RtcEd2/Parms>

Reset RT Control Name List…
Allows you to reset the list of RT Control Names available to be assigned to the 16 RT Controls in the RTC View to the 
factory default. 

Load RT Control Names From File...
Opens the Standard File Open Dialog, allowing you to locate another KDF File containing RT Control Names that you want to 
load into the current KDF File. This replaces the RT Control Names in the current file.

Import RT Control Names...
Opens the Standard File Open Dialog, allowing you to locate a text file containing a list of RT Control Names that you wish 
to import into the current KDF File. This replaces the RT Control Names in the current file.

<Display><0888><0889><0890>
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RT Controls - Display Selector
 

    [Display] (radio buttons) [MIDI, Phs]

The top portion of KARMA’s Real-Time Control Editor can be switched between two different activity displays, using the 
radio buttons to the left of the area: the MIDI Activity Display and the Phase Activity Display. 

MIDI Activity Display:
A Keyboard Display shows incoming MIDI notes that are used to trigger the KARMA GEs or play the Keyboard Layers. For 
each of the six Modules, a row displays the Notes and other MIDI messages that are being generated or passed thru on that 
particular Module. The sizes of common MIDI keyboards as they relate to the display is shown above the Keyboard Display. 
Underneath it, the notes being generated are displayed as vertical lines, with longer lines indicating higher velocities. In 
the shorter row sections to the left of the Keyboard Display, various other MIDI messages are displayed (Control Change, 
Pitch Bend and Aftertouch).

Phase Activity Display:
Displays the current Phase Pattern Step for each Module, and its relationship to the other Modules and the Scene Change 
Quantize Window. The Phase Pattern is located in the Module’s GE Editor > Phase Page.

<Activity><0883><0884><0885><0886><0887><2102>
RT Controls - MIDI Activity Display

 

When the MIDI Activity Display is selected, the top portion of the Real-Time Controls Editor features a Keyboard Display 
showing the incoming MIDI notes that are used to trigger the KARMA GEs or play the Keyboard Layers.  For each of the six 
Modules, a row displays the Notes and other MIDI messages that are being generated or passed thru on that particular 
Module. The sizes of common MIDI keyboards as they relate to the display is shown above the Keyboard Display. 
Underneath it, the notes being generated are displayed as vertical lines, with longer lines indicating higher velocities. In 
the shorter row sections to the left of the Keyboard Display, various other MIDI messages being generated are displayed 
as follows, with 0...127 being spread out from left to right:

- Expression (CC 11), Volume (CC 07), Pan (CC10) and Balance/Effects Pan (CC08) are displayed in yellow.
- Pitch Bend and Aftertouch are displayed in purple.
- All other CCs (Control Change) are displayed in blue.

<PhsActivity><2100><2101><2103>
RT Controls - Phase Activity Display
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When the Phase Activity Display is selected, the top portion of the Real-Time Controls Editor shows the relationship 
between the current Phase Pattern Step in each Module’s GE and the Scene Change Quantize Window, in addition to the way 
that they may be affected by various operations such as Retrigger, Stutter, etc. A row for each Module displays the GE’s 
current Phase Pattern Step, with unused Phase Pattern steps displayed as outlines, while the Scene Change Quantize 
Window LED flashes according to the metric division specified for the Scene Change Quantize Window.

    The GE’s Phase Pattern can be viewed in the Module’s GE Editor > Phase Page. <PhsEd>

<Matrix>
RT Controls - Scene Matrix Area
 

The Scene Matrix Parameters section contains settings for working with scenes, and for changing which Control Layer is 
displayed in the rest of the RT Controls Window. Here you can conveniently view and edit the selected Scenes for each of 
the seven RT Control Layers at the same time. You can also set a Scene Change Quantize Window that controls a time 
interval for when the scene changes will occur, and view information about upcoming scene changes.

    For a much larger version of the Scene Matrix Grid, suitable for easier editing with the mouse, see the Scene Matrix 
Editor. 
<SmxEd><0853>

    [RTCM (RTC Model)] (label)
This label displays the RTC Model type for the GE loaded into a particular Control Layer, or [MASTER] when displaying the 
Master Layer.
<0847><0854><smx-rtcl>
    [RT Control Layer] (popup menu) [0...6, Master...Module 6]

    [RT Control Layer Buttons] (clickable numbers) [M, 1...6]

Chooses between the Master Layer and a Control Layer for each Module. In a multi-module Performance, the Real-Time 
Control Window can be up to 7 layers deep: there is a Master Control Layer and a Control Layer for each Module. Each 
layer has its own slider, switch, and scene settings. The Control Layer menu and Control Layer buttons (the tiny numerals 
to the left of the Scene Matrix grid) let you switch between these layers - as do the RT Control Layer buttons in the Main 
Window’s Status Area - they are all linked together. When you change the RT Control Layer, all of the sliders, switches 
and scenes will update instantly to show their current values and names within the selected layer. The Control Layer 
button corresponding to the current layer will be highlighted in blue, as will the row of the Scene Matrix grid.

This can also be operated with the computer’s Function Key [F12] or Shift+[F12], depending which computer keyboard 
option you have selected in the Preferences - Workspace Page. <Prefs/Work>

The current RT Control Layer also influences which layer is the “target” for various real-time control changes from the 
computer keyboard, external MIDI controllers, or the Motif/MOX Remote Mode. For example, if the current RT Control 
Kayer is Module 2, triggering scene changes and editing RT Slider and RT Switches from the Remote Mode or external 
MIDI controllers will change scenes and edit parameters in the Module 2 Layer, and not the Master Layer.

    The names shown in the Control Layer menu can be set to more descriptive names for each Module, by clicking the 
Module Name button to the left of the menu.
<0876><0879><smx-grid>

    [Scene Matrix Grid] (grid)

The Scene Matrix grid includes a row of buttons for each Module, with the top row corresponding to the Master Layer. 
Each row has 32 buttons, with the first eight buttons corresponding to the eight scenes capable of being selected by the 
Motif/MOX Remote Mode. This lets you select any scene in any layer directly, without changing the Control Layer setting. 
The grid shows an overview of which Scene is selected in any of the layers at any given time.

You can click in any row and column and change scenes in any Module, or change scenes in the Master Layer and 
consequently change the other layers if they are linked to it (if “Link Scenes To Master” is on (checked)). When the Scene 
Quantize Window is set to the higher values such as 1...4 Bars, selecting a scene will not change it immediately. In this 
case, the pending scene changes will blink red as shown above, in any rows that have been clicked as well as the 8 Scene 
Selector buttons beneath the grid.
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If you click the tiny labels on the left side (M, 1...6), you will change the Control Layer setting to the selected layer, and 
the entire row and label will be highlighted blue to indicate the current Control Layer setting. This is the same as using the 
RT Control Layer buttons in the Main Window’s Status Area.
<0848><smx-scene>
    [Scene] (popup menu) [0...31]

Selects one of the 32 Scenes in the current Control Layer. The eight RT Sliders and eight RT Switches update to the stored 
values in the scene (if the RTC View is being shown). If selecting a scene in the Master Layer, the Module Layers can 
change to a specified scene as well, if the “Link Scenes To Master” setting is enabled for that Module. If selecting a scene 
in the Master Layer (and the Mix View is being shown), the Track Volumes and Track Mutes will update instead.
<0838>

    [Scene Selector Buttons] (8 buttons)

A Scene is a collection of settings for the eight RT Sliders and eight RT Switches. Additionally, in the Master Layer the 
scene stores the eight Track Volumes and eight Track Mutes. Each Performance has up to 32 Scenes - the first eight 
Scenes in the selected Control Layer may be selected by these buttons, which correspond to the eight Scene Switches of 
the Motif/MOX Remote Mode. Scenes 9 ~ 32 can be accessed using the Scene Matrix Grid above, the Scene Menu above, or 
the Scene Matrix Page. Controllers can be assigned in the MIDI Setup (Global) Editor > RTC Setup Page.
<MsuRTC/Scenes>

When the Scene Quantize Window is set to the higher values such as 1...4 Bars, selecting a scene will not change it 
immediately. In this case, the button with the pending scene change will blink red as shown above.

        Mac
        Ctrl + 1 - Scene 1 (in current Control Layer)
        Ctrl + 2 - Scene 2 (in current Control Layer)
        Ctrl + 3 - Scene 3 (in current Control Layer)
        Ctrl + 4 - Scene 4 (in current Control Layer)
        Ctrl + 5 - Scene 5 (in current Control Layer)
        Ctrl + 6 - Scene 6 (in current Control Layer)
        Ctrl + 7 - Scene 7 (in current Control Layer)
        Ctrl + 8 - Scene 8 (in current Control Layer)

        Win
        Ctrl + Shift + 1 - Scene 1 (in current Control Layer)
        Ctrl + Shift + 2 - Scene 2 (in current Control Layer)
        Ctrl + Shift + 3 - Scene 3 (in current Control Layer)
        Ctrl + Shift + 4 - Scene 4 (in current Control Layer)
        Ctrl + Shift + 5 - Scene 5 (in current Control Layer)
        Ctrl + Shift + 6 - Scene 6 (in current Control Layer)
        Ctrl + Shift + 7 - Scene 7 (in current Control Layer)
        Ctrl + Shift + 8 - Scene 8 (in current Control Layer)
<0877><smx-link>
    [Link Scenes To Master] (buttons) [Off, On]

Allows a Module’s Control Layer to be controlled by the Master Layer. When on, changing scenes in the Master Layer will 
select a new scene for the Linked Module.

On:
Changing a scene in the Master Layer selects a new scene for the linked Module Layer. All six Modules independently store 
their current scene in the top level Master scene. It can be the same scene for each linked Module, or completely different 
scenes. This allows complete flexibility as to which Modules have which scenes in which combinations. For example if 
Master scene 1 is selected, Module 1 (e.g., drum pattern) could be switched to scene 5, and Module 2 (e.g., bass riff) 
could be switched to scene 8.

Off :
Changing a scene in the Master Layer only changes Module parameters assigned to the sliders and switches in the Master 
Layer. The Module Layers do not change scenes, but stay where they are. Each layer is independent.
<0878>
    [Enable Master RTC] (buttons) [Off, On]

Used in conjunction with “Link Scenes To Master” to disconnect any parameters in the Module that may be assigned to 
sliders and switches in the Master Layer.

Off :
If there are controls in the Master Layer that are assigned to the specified Module, moving them or changing scenes in the 
Master Layer will have no effect on the Module’s parameters. This allows you to “disconnect” a Module Layer from the 
Master and “freeze” its current sound (in conjunction with turning Link Scenes To Master off).

On:
If there are controls in the Master Layer that are assigned to the specified Module, moving them or changing scenes in the 
Master Layer will affect the parameters and sound of the Module.

Scenes can be selected with the following computer keys (see Keyboard Shortcuts for other ways to change scenes):
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    In order to completely disconnect a Module from alteration by the Master Layer (“freeze” its settings), you need to 
uncheck both Link Scenes To Master and Enable RTC By Master. If you only disable Link Scenes To Master, the settings of 
the Master scenes may still influence any parameters that are hooked up to controls in both the Master and Module 
Layers, depending on whether they were last moved in the Master. Of course, any Module’s Real-Time Parameters that 
are only assigned to controls in the Master Layer for that Module will also be affected by the Master scenes, unless 
Enable RTC By Master is off (unchecked). When Enable RTC By Master is turned off (unchecked), any parameters that are 
assigned to controls in both the Master and Module Layers may change, because the values for the Module Layer will be 
sent out for whatever scene is selected in the Module Layer. In other words, if Duration Control is assigned in both layers 
to a Slider, and it was last moved in the Master Layer, the GE will be playing with the Master Layer duration setting. If 
you disconnect the Master Layer, the duration value indicated by the Module Layer will be sent out. You can adjust the 
Module Layer’s Duration Control setting to sound the same at that point, if desired. Turning “Enable RTC By Master” back 
on will resend the Master Layer’s duration setting, if it was the last moved control connected to the duration in that 
Master scene.
<0844><smx-qtz>
    [Scene Change Quantize Window] (popup menu) [0...8]

Specifies the metric division by which scene changes will be quantized, in any of the Control Layers. Depending on the 
setting, this may delay the scene change from occurring until the next beat, next bar, or several bars later.

16th triplet…Quarter:
These smaller values set the window as a note value relative to the tempo. For triplet-based patterns, you may need to 
select one of the triplet-based settings if you intend to perform scene changes “off the beat.”

1 Bar…4 Bars:
These larger values set the window in terms of measures, relative to both the tempo and the time signature of the 
Performance or the individual Module’s GE.

    If the KARMA Time Sig. (Time Signature) parameter at the top of the Performance Editor is set to something other 
than “GE/TS”, then the specified Time Signature is what will be used to calculate the bar lengths. If the Time Sig. is set 
to “GE/TS” (meaning that each Module’s GE uses its own stored internal time signature), then the bar length is calculated 
using an internal averaging formula based on the Time Signatures of all GEs that are in use. 

 

    Scene changes selected at a timing that is within a 32nd note of the Scene Change Quantize Window setting will be 
considered “late” (shown by the pink color in the diagram above), and will cause the scene change to occur immediately. 
If the scene change is later than this, it will be considered “early” (shown by the yellow color in the diagram above), and 
will occur at the next metric division corresponding to the Scene Change Quantize Window (not all settings are shown in 
the diagram, just examples of the shorter settings).

    Certain operations will reset and restart the Scene Change Quantize Window, including using the Stutter Buttons and 
the Retrigger Button in the Real-Time Controls Editor (or controlling those features via MIDI).
<0846>

    [Module Name Button] (button)

Allows a descriptive name to be chosen for each Module from a large list of predefined Module Names. By default, in a new 
Performance the Modules are named Module 1, Module 2, Module 3 etc., but you can choose something that is more 
appropriate if desired (such as Drums, Bass, etc.). These names then show up in other pages of the Performance Editor, 
the top of the GE Editor, and the RT Control Window, making it easier to identify a particular Module. See Module Name 
Select Dialog.
<PEUtils/ModNames><0845><smx-name>

    [Scene Name Button] (button)

Allows a descriptive name to be chosen for each Scene from a large list of predefined Scene Names. By default, in a new 
Performance the Modules are named Scene 1, Scene 2, Scene 3 etc., but you can choose something that is more 
appropriate if desired (such as Verse, Chorus, Fill, Intro). These names then show up in in the Scene. See Scene Name 
Select Dialog.
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<RtcDlg/SceneNames><Chord><0852>
RT Controls - Chord Trigger Area
 

The Chord Trigger Area contains the 16 Chord Trigger buttons, each of which can store a chord, trigger a Motif/MOX arp 
or trigger hits and SFX, and buttons for several other features as well, such as the Fill, Stutter, Retrigger, Assignable 
Switches 1/2, KARMA On/Off and Latch.<0860><0861>
<0862><0863><0864><0865><0866><0867><0868><0869><08670><0871><0872><0873><0874><0875>

    [Chord Trigger Buttons] (16 buttons)

The 16 Chord  Trigger buttons each store a chord of up to eight notes and velocities. They can be clicked with the mouse, 
triggered via a CC message or the Motif/MOX Remote Mode, or activated using the Function Keys of your computer 
keyboard:

        [F1]...[F8] - Chord Trigger Button 1...Chord Trigger Button 8
        Shift + [F1]...[F8] - Chord Trigger Button 9...Chord Trigger Button 16
        Ctrl + a [Mac], Ctrl + Shift + a [Win]  - Chord Trigger Assign
<0859>

    [Chord Assign] (button)

Allows you to easily assign a chord of up to eight notes and velocities to one of the 16 Chord Trigger buttons. There are 
two ways you can do this:

Method 1:
1. Play a chord on the keyboard (the last chord is always kept in memory).
2. Click on the Assign button to turn it on. The LED will light.
3. Click one of the 16 Chord Trigger Buttons. The chord you played in step 1 will be registered to that button, and the 
Assign button will turn off.
4. Save the Performance to keep the new settings.

Method 2:
1. Click on the Assign button to turn it on. The LED will light.
2. Play the chord on the keyboard. To assign notes that are difficult to play simultaneously, hold down the first note on a 
keyboard and then add additional notes one by one with the other hand. You can create extremely wide voicings this way 
that would be impossible to play normally.
3. Click one of the 16 Chord Trigger Buttons. The notes and velocities you played in step 2 will be registered to that 
button, and the Assign button will turn off.
4. Save the Performance to keep the new settings.

The Assign button can also be operated with a key shortcut on the computer keyboard, see above under Chord Trigger 
Buttons. Alternately, it can be operated via a CC message or the Motif/MOX Remote Mode.
<0858>
    [Chord Edit] (button)

Brings to the front the Chord Trigger Editor, where you can edit each note and velocity of a Chord Trigger, apply utility 
functions such as transposition and velocity scaling to them as well, and edit other Chord Trigger-related features. This is 
the same as using the “Chord Triggers” Editor Selection Button at the top of the Main Window.
<CtgEd><0856>
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   [KARMA On/Off] (button) [Off, On]

Turns KARMA’s music generation features on or off, allowing you to play on the keyboard with or without generating the 
groove. You can use this to turn KARMA off, play an intro using the left and right hand Keyboard Layer sounds, and then 
turn KARMA on to begin the music generation with the Fill button, the next Chord Trigger or chord played on the keyboard 
in KARMA’s input area, etc. You can use this to stop a KARMA Performance, although it’s often preferable to use the Stop 
command (press the computer’s Return key). The computer keyboard’s Function Key [F9] may be used to toggle this 
on/off (or an assigned CC or the Motif/MOX Remote Mode).

    When off, the KARMA Function will not generate any data for the six Modules, and the Key Zone Page Timbre Thru 
setting(s) are active.
<KeyEd/Thru><0857>

    [Latch On/Off] (button) [Off, On]

Allows any Modules that have the Trigger Page Note Latch parameter set to “LB - Module obeys Latch Button status” in 
the current Performance to be controlled by this switch. When the Latch button is on, KARMA’s music generation will 
continue to play after you press a Chord Trigger or operate the keyboard. With the Latch button off, as soon as you 
release the pad or keyboard input notes, KARMA will stop. You can use this during live performance to stop and restart 
the groove in various interesting ways – such as un-latching all of the music momentarily, then using the Fill button to 
bring it back in. Furthermore, Modules can be individually assigned to use it or ignore it, so turning this off can be set to 
leave the drums running for example, but everything else stops until you play a new chord. The computer keyboard’s 
Function Key [F11] may be used to toggle this on/off (or an assigned CC or the Motif/MOX Remote Mode).

    If the Module’s Trigger Page Note Latch setting is not set to “LB,” operating this button will have no effect on the 
latch for that Module. See Trigger Page - Note and Envelope Triggering Parameters.
<TrgEd/ParmsTrig><2097>

    [Assignable Switches 1/2] (buttons) [Off, On]

Controls the sound or effect settings for selected Modules or Kbd Layers, or may be configured in certain Performances 
to change the lead sound or the octave it plays in. These correspond to the “Assignable Function 1 & 2” switches on the 
Motif/MOX in Song Mode, or in the Motif/MOX Remote Mode, or other external controller assigned in the MIDI Setup 
(Global) Editor > RTC Setup Page.
<MsuRTC/ASwitches><2096>

    [Assignable Switches In Scenes] (checkboxes) [Off, On]

Controls whether each switch has its settings stored and recalled in each scene. Off = each switch is operable as a 
real-time control unaffected by scene changes; on = each scene can store and change the settings.
<2098>

    [Fill Button] (button)

Triggers a fill on any modules that have been set to use this feature through Dynamic MIDI - whatever fill function has 
been programmed into the current Performance. This can be a drum fill, or a melodic riff, or a combination of both – any 
KARMA Module can be programmed in the Performance to be activated by this button, and then stopped by a number of 
actions, such as the next Scene Change, the next played chord on the keyboard or Chord Trigger, a number of bars, etc. If 
KARMA is not running (but is on), the Fill button can be used to start the Performance with a fill, after which it will 
automatically use the notes stored on Chord Trigger 1 to start the groove. The computer’s Function Key [F13] (or [F12]) 
can trigger this, depending which computer keyboard option you have selected in the Preferences - Workspace Page, or an 
external CC or the Motif/MOX Remote Mode.
<Prefs/Work><2104>

    [Auto-Fill On Scene Change] (checkbox)

When on, selecting any scene change in the Master Control Layer automatically triggers a fill leading into the scene 
change. If you like having a fill every time you change scenes, you can avoid having to additionally hit the Fill button by 
using this feature, which is stored with the Performance.

<2091>
    [Retrigger Button] (button)

Activates the Dynamic MIDI Retrigger feature – you can use it to rhythmically retrigger all assigned Modules (and 
Motif/MOX arps if they are running) from the beginning of their patterns, achieving DJ-like sample-triggering effects 
with the entire groove. Unlike the Stutter feature, each press of the button will retrigger the groove one time. In most 
Performances, all KARMA Modules are assigned to this function with the exception of the Fill Module; but this can be 
individually configured if desired. If KARMA is not running (but is on), this can be used to start a Performance - it will use 
the notes stored on Chord Trigger 1.The parameter settings are stored in each Performance on the Performance Editor > 
Dynamic MIDI Page.
<DynEd><2092><2093><2094><2095>

    When using this feature, you may wish to increase the size of the Scene Change Quantize Window (usually set to 1 Bar 
in most Factory Performances) in order to allow longer fills.
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   [Stutter Buttons - Fast, Medium, Slow] (buttons)

The Stutter feature allows the entire groove (or parts of the groove) to be rapidly retriggered at three different rates 
(according to settings in each Performance). Pressing each button once will stutter until the next downbeat (evenly 
divisible by the specified Stutter Multiplier in KARMA’s Dynamic MIDI settings). Holding the buttons will continually 
stutter until the next downbeat after release. You can move from one button to the other and change the stutter rate while 
it is stuttering. Each KARMA Module can be individually programmed to respond to this in each Performance, but 
typically, all Modules except the Fill are activated. The parameter settings are stored in each Performance on the 
Performance Editor > Dynamic MIDI Page. <DynEd>

The “Stutter Window” (base rate which is then multiplied) for each Module can be individually programmed as well on 
KARMA’s Performance Editor > Trigger Page, although typically they are all set to the same rate.
<TrgEd/ParmsTrig>
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Real-Time Controls (RTC) - Part 2
Sections in this chapter:

View Selector<RtcEd2/View>

View Area: Mix<RtcEd2/Mix>

View Area: RTC<RtcEd2/Parms>

Sections in Part 1: <RtcEd>

Overview<RtcEd/Over>

Display Selector<RtcEd/Display>

MIDI Activity Display<RtcEd/Activity>

Phase Activity Display<RtcEd/PhsActivity>

Scene Matrix Area<RtcEd/Matrix>

Chord Trigger Area<RtcEd/Chord>

<View><1816 ><1817><1823>
RT Controls - View Selector
 

    [View] (radio buttons) [Mix, RTC]

The bottom portion of KARMA’s Real-Time Control Editor can be switched between two different views, using the radio 
buttons to the left of the area: the Mix View and the RTC View. 

Mix View:
Displays the Track Volume and Track Mute settings for each of the 8 tracks in a KARMA Performance, along with the 
Master Volume. The settings (with the exception of the Master Volume) are stored in the current scene in the Master 
Control Layer. Therefore, it doesn’t matter which RT Control Layer is presently selected – this view remains the same.

RTC View:
Displays the 16 Real-Time Control settings (8 RT Sliders and 8 RT Switches) for the current scene of the current Control 
Layer. Depending on which layer is selected, you could be looking at the Master Layer settings, or the settings for a single 
Module such as the drums or bass.

The View can be switched with an assigned CC or by the appropriate button in the Motif/MOX Remote Mode. The view that 
is showing (and the current RT Control Layer in the case of the RTC View) determines the routing of the following 
controllers from the Motif/MOX Remote Mode or external controllers specified in the MIDI Setup (Global) Editor > RTC 
Setup Page:
<MsuRTC/Sliders>

- Knobs [1] – [8]   
- Sliders [1] – [8]
- Switches [1] – [8]
- Compare/Restore Current Scene button

In other words, changing the view changes the target of the controllers listed above.

<Mix>
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RT Controls - View Area: Mix
 

When the Mix View is selected, the bottom portion of the Real-Time Controls Editor displays the Track Volume and Track 
Mute settings for each of the 8 tracks in a KARMA Performance, along with the Master Volume. An audio-style meter 
next to each slider displays the MIDI activity of the 8 Track Volumes and Master Volume. The settings (with the exception 
of the Master Volume) are stored in the current scene in the Master Control Layer. Therefore, it doesn’t matter which RT 
Control Layer is presently selected – this view remains the same.

There are eight columns, each containing a slider and a switch, and labels displaying a name for the Module or Keyboard 
Layer, and a ninth Master Volume slider. The sliders, switches, Compare/Restore button and View can be assigned to 
transmit or receive specified MIDI CCs in the MIDI Setup (Global) Editor > RTC Setup Page. This allows you to use external 
devices to control them such as any commercially available control surface or the Motif/MOX Remote Mode, and record 
the movements into sequencers. 
<MsuRTC>

See also the Remote Mode and Sequencing tutorials included in the Tutorials Folder.
<SetupKMO/TutFolder><1808><1812><1818>
    [Track Volume] (numerical) [0...127]

Displays the value of the volume slider as it is moved, or allows you to directly enter a volume for the Module or 
Keyboard Layer from 0 to 127, moving the slider to that value. This value is stored in each scene.
<1809><1813>

    [Track Volume Slider] (slider) [0...127]

Controls the volume of the Module or Keyboard Layer. Click on the head and drag, or click anywhere on the slider to jump 
to that location. If the value is edited, a yellow dot will be shown (controlled by the “Change Appearance When Edited” 
item in the Menu Button for the Real-Time Control Editor). You can double-click the slider to return to the original value.
<1810><1814>

    [Module/Keyboard Layer Name] (label)

Displays a descriptive name for each Module or Keyboard Layer, which can be assigned on the Performance Editor > GE 
Setup/Mix Page. <MixEd/ParmsGE>
<1811><1815><1824>
    [Track Mute] (button) [Off, On]

Allows each Module to be individually muted (turned off) in the current scene. When the scene is changed, the track mute 
settings can bring in or out different parts. If the value is edited, a yellow dot will be shown (controlled by the “Change 
Appearance When Edited” item in the Menu Button for the Real-Time Control Editor).
<1820>

    [Master Volume Slider] (slider) [0...127]

Controls the volume of the entire Performance. Click on the head and drag, click anywhere on the slider, or double-click to 
reset to the stored value.
<1821><1822>

    [Master Volume] (numerical) [0...127]

Displays the value of the Master Volume slider as it is moved, or allows you to directly enter a volume from 0 to 127, 
moving the slider to that value.
<1819>
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  [Compare/Restore] (button)

Allows the Mix (Volumes/Mutes) in each scene of the Master RT Control Layer to be compared individually with the 
stored settings of the original Performance. The Compare button will be grayed out if nothing has been edited in the 
applicable scene. Once compared, the button text changes to “Restore”. Pressing the button a second time restores the 
settings back to the previously edited state. Edited values in the scene are displayed with yellow dots (controlled by the 
“Change Appearance When Edited” item in the Menu Button for the Real-Time Control Editor).

    These operations are quantized by the Scene Change Quantize Window and happen in the same way that scene changes 
do (delayed until downbeat) – so you can use this as a performance feature, by modifying a scene in real-time to 
something completely different, then comparing it back to the original as if it was a scene change. Furthermore, each 
scene in each layer, in each view maintains its own compare buffer, so you can switch between scenes and layers, 
editing, comparing and restoring at any time and in any layer or scene.

<Parms>
RT Controls - View Area: RTC
 

When the RTC View is selected, the bottom portion of the Real-Time Controls Editor displays the 16 Real-Time Control 
settings (8 RT Sliders and 8 RT Switches) for the current scene of the current Control Layer. Depending on which layer is 
selected, you could be looking at the Master Layer settings, or the settings for a single Module such as the drums or bass.

There are eight columns, each containing a slider and a switch, and labels displaying a name describing the function of the 
slider or switch. The sliders, switches, Compare/Restore button and View can be assigned to transmit or receive 
specified MIDI CCs in the MIDI Setup (Global) Editor > RTC Setup Page. This allows you to use external devices to control 
them such as any commercially available control surface or the Motif/MOX Remote Mode, and record the movements into 
sequencers. See the Remote Mode and Sequencing tutorials included in the Tutorials Folder. <MsuRTC>
<1825>

Current RT Control Layer
Displays the number of the current Module Control Layer, or “M” for the Master Layer.

Edited Mark
As shown in the diagram above, slider heads and buttons can display a yellow dot when they are different from the stored 
values, indicating they have been edited. This is controlled by the “Change Appearance When Edited” item in the Menu 
Button for the Real-Time Control Editor. When a slider is edited, you can double-click it to revert back to the original 
value.

Controlled Values Display
A small window that pops up over each of the sliders and switches (when the mouse is held over them) showing the 
value(s) of any parameters that are assigned to them. The values update as the control is moved. You can activate or 
deactivate this feature using the “Show Controlled Values” item in the Menu Button explained at the top of this chapter. If 
there is more than one parameter assigned (as in the picture shown above) they are displayed in a single or double row 
depending on the number of parameters. 

In the Module Control Layers 1...6, the format is:

[07] 230  
  |   |
  |  Current Controlled Value      
  GE RT Parm Number [01...32]
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In the Master Layer the Module number is also shown, or a “P” indicating a Performance RT Parm:

2[07] 230  
|  |   |
|  |   Current Controlled Value      
|  RT Parm Number [01...32, 01...08]
Module Number [1...6, P]

<2360><2365>
    [RT Slider Name Button] (button)
    [RT Switch Name Button] (button)

These small buttons to the left of the Slider/Switch Name labels next to each of the 16 RT Controls open the RTC Name 
Select Dialog when clicked, allowing you to select one of many predetermined names to describe the function of the 
corresponding slider or switch.
<RtcDlg/Names><2363><2366>

    [RT Slider Name] (label)
    [RT Switch Name] (label)

Describes the function of the slider or switch. Click the button to the left to select a different name.

In KARMA, there are multiple ways to achieve a certain sort of effect. Let’s say we’re talking about varying the 
“Rhythm Complexity” - you could do this by changing the Rhythm Random Factor, the Velocity Random Factor, The Drum 
Rest Random Factor (in a Drum Pattern), the Rhythm Multiplier, etc. Seeing one of these parameter names on the screen 
wouldn’t necessarily tell you much about what the actual effect of varying it is, if it was just displayed automatically. So 
the Programmer gets to decide on an effect to achieve (when designing a GE), such as varying the Rhythm Complexity. He 
can do this using any one of multiple different parameters, some of them with non-intuitive names. But after assigning 
this parameter to the slider/switch, he can then give it an intuitive (hopefully) name that describes in more simple words 
what it is supposed to do. Furthermore, multiple parameters with different names can be assigned to a single RT Control, 
so again, the name of the function is separate from the parameters.

    You can have KARMA automatically assign default names based on the current parameters settings using the “Auto 
Assign Names (in Layer)” item in the Menu Button described at the top of this chapter.
<2362>
    [RT Slider Value] (numerical) [0...127]

Displays the value of the corresponding slider as it is moved, or allows you to enter directly a value from 0 to 127, 
jumping the slider to that value.
<2361><1805>
    [RT Slider] (slider) [0...127]

Allows you to graphically control the RT Parms assigned to the slider. Click on the head and drag, or click anywhere on 
the slider to jump to that location. If the value is edited, a yellow dot will be shown (controlled by the “Change 
Appearance When Edited” item in the Menu Button for the Real-Time Control Editor). You can double-click the slider to 
return to the original value.
<2364><1804>
    [RT Switch] (button) [Off, On]

Allows you to graphically control the RT Parms assigned to the switch. Click on the button to toggle between the off and on 
positions. If the value is edited, a yellow dot will be shown (controlled by the “Change Appearance When Edited” item in 
the Menu Button for the Real-Time Control Editor).
<1803>

    [Compare/Restore] (button)

Allows the RT Slider and RT Switch settings in each Scene in each RT Control Layer to be compared individually with the 
stored settings of the original Performance. The Compare button will be grayed out if nothing has been edited in the 
applicable scene. Once compared, the button text changes to “Restore”. Pressing the button a second time restores the 
settings back to the previously edited state. Edited values in the scene are displayed with yellow dots (controlled by the 
“Change Appearance When Edited” item in the Menu Button for the Real-Time Control Editor).

    These operations are quantized by the Scene Change Quantize Window and happen in the same way that scene changes 
do (delayed until downbeat) – so you can use this as a performance feature, by modifying a scene in real-time to 
something completely different, then comparing it back to the original as if it was a scene change. Furthermore, each 
scene in each layer, in each view maintains its own compare buffer, so you can switch between scenes and layers, 
editing, comparing and restoring at any time and in any layer or scene.
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Scene Matrix
Sections in this chapter:

Overview<SmxEd/Over>

Parameters<SmxEd/Parms>

 

<Over>
Scene Matrix - Overview
The Scene Matrix Editor is essentially a dedicated, much larger version of the Scene Matrix Grid in the Real-Time 
Controls Editor. This can be very useful for viewing on a laptop during live performance, or easier selection of scenes 
with the mouse (or a touch-enabled device). Otherwise, the functionality is virtually identical. Therefore, this chapter 
will mainly discuss any differences between the two; for expanded information, please see the RT Controls - Scene 
Matrix Area. <RtcEd/Matrix>

Scene Matrix Grid (Scene Buttons 1-16, 17-32)
Unlike the smaller Scene Matrix Grid in the RT Controls Editor that is 32 columns by 7 rows, the Scene Matrix Editor 
splits the grid into a top and bottom section of 16 columns x 7 rows each. Therefore, for each RT Control Layer, there are 
two rows, linked together: one in the top section (for Scenes 1-16), and one in the bottom section (for Scenes 17-32). In 
other words, although the grid is split into two sections, together they function as one large grid, similar to the RT 
Controls Editor.

RT Control Layers, Current RT Control Layer
The labels displaying the names of the 7 RT Control Layers (down the left side) also function as a means of selecting and 
displaying the current RT Control Layer. Click on a label to change the RT Control Layer, and the label in both the upper 
and lower sections of the grid will change colors to indicate the current layer (yellow for the Master Layer, blue for the 
Module Layers). Furthermore, the two rows of scene buttons corresponding to the current layer will gain a stripe through 
the middle, as shown for Module 2 (Bass) in the above diagram. Other means of changing the RT Control Layer as explained 
in other chapters are also linked to this display, including using the buttons in the Main Window Status Area, using 
computer keyboard keys, and using the Motif/MOX Remote Mode.
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Current Scene, Pending Scene Change
As shown in the diagram above, the current scene for the Module Layer is displayed with a yellow button; the current 
scene for each Module Layer stored within the Master Layer scene are displayed with blue buttons. A pending scene 
change that has been selected (but has not yet occurred according to the Scene Change Quantize Window) blinks red.

P a r a m e t e r s
Other than changing Scenes and RT Control Layers, there are only three parameters in the editor: the Scene Popup and 
Name Selector, the Scene Change Quantize Window, and the Link To Master buttons. All of these perform the same function 
as those in the RT Controls Editor, and are linked to them, as described below.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this editor:

 

(Click on the links for detailed information on utilities not fully explained here.)

Copy Scenes…<RtcDlg/CopySwapScenes>
Opens the Copy Scenes Dialog allowing you to copy a scene in one or more Control Layers, to one or more other scenes. 

Swap Scenes…<RtcDlg/CopySwapScenes>
Opens the Swap Scenes Dialog allowing you to swap any two scenes, in one or more Control Layers at the same time. 

Reorder Scenes…<RtcDlg/Reorder>
Opens the Reorder Scenes Dialog, allowing to reorder the arrangement of the first 8 scenes in any Control Layer.

<Parms>
Scene Matrix - Parameters

The parameters included in the Scene Matrix Editor are duplicates of the same settings in the RT Controls - Scene Matrix 
Area.
<RtcEd/Matrix><2296><2290>
    [RT Control Layer] (labels) [M, 1...6, Master, Module 1...Module 6]

Clicking on a label changes the current RT Control Layer. The current RT Control Layer is highlighted in yellow (for the 
Master Layer) or blue (for a Module Layer). See the description for the RT Control Layer Buttons in the RT Controls - 
Scene Matrix Area.
<RtcEd/smx-rtcl><2294>

    [Scene Matrix Grid] (grid)

The Scene Matrix grid is broken into two sections, with the top section controlling Scenes 1-16 and the bottom section 
controlling Scenes 17-32. Each section includes a row of buttons for each Module, with the top row corresponding to the 
Master Layer. See the description for the Scene Matrix Grid in the RT Controls - Scene Matrix Area. 
<RtcEd/smx-grid><2291>
    [Scene] (popup menu) [0...31]

Selects one of the 32 Scenes in the current Control Layer. See the description for the Scene popup in the RT Controls - 
Scene Matrix Area.
<RtcEd/smx-scene><2292>

    [Scene Name Button] (button)

The round triangle button to the left of the Scene popup menu allows a descriptive name to be chosen for each Scene from 
a large list of predefined Scene Names. See the description for the Scene Name Button in the RT Controls - Scene Matrix 
Area.
<RtcEd/smx-name><2295>
    [Link Scenes To Master] (buttons) [Off, On]

Allows a Module’s Control Layer to be controlled by the Master Layer. When on, changing scenes in the Master Layer will 
select a new scene for the Linked Module. See the description for the Link Scenes To Master buttons in the RT Controls - 
Scene Matrix Area.
<RtcEd/smx-link><2293>
    [Scene Change Quantize Window] (popup menu) [0...8]

Specifies the metric division by which scene changes will be quantized, in any of the Control Layers. See the description 
for the Scene Change Quantize Window in the RT Controls - Scene Matrix Area.
<RtcEd/smx-qtz>
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Chord Triggers
Sections in this chapter:

Overview<CtgEd/Over>

Keyboard Display<CtgEd/Kbd>

Global Parameters<CtgEd/Glob>

Chord Note Parameters<CtgEd/Chord>

About Intelligent Transposition<CtgEd/About>

Intelligent Transposition Parameters<CtgEd/Intel>

Transpose & Modify Velocity<CtgEd/Transpose>

 

<Over>
Chord Triggers - Overview
The Chord Triggers Editor provides editing for the notes, velocities and MIDI Channel of each of the 16 Chord Triggers, an 
extensive array of features allowing Chord Triggers to be used to control Motif/MOX arps and/or hits and sfx with 
Intelligent Transposition, along with a number of useful utility functions for modifying and managing the Chord Triggers.
<CtgEd/About>

Keyboard Display
Shows the last played/edited Chord Trigger, or notes from the keyboard (that can be assigned to a Chord Trigger) - as 
blue dots. Since a Chord Trigger stores up to 8 notes, only the last 8 notes played will be displayed. It also displays, as 
yellow dots, notes that are triggered by Chord Triggers using the “Last Played Notes” feature and “Intelligent 
Transposition”.
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Transpose & Modify Velocity
This section allows you to transpose the pitch and modify the velocity settings of one or more chords in real-time, 
auditioning the results before committing to the edit.
<1684>

Chord Selection Buttons
Switches the Parameter Area between Chord Triggers 1~4, 5~8, 9~12, or 13~16.

Parameter Area
For each of the four displayed Chord Trigger buttons, a column is displayed which can be divided into two sections:

Chord Note Parameters
The top section of the Chord Trigger column contains the eight notes and velocities that can be assigned to the button, 
along with the MIDI Channel. The notes and velocities can be edited or assigned from the keyboard.

Intelligent Transposition Parameters
The bottom section of the Chord Trigger column contains parameters that allow you to trigger Motif/MOX arps or hits and 
sfx on other MIDI Channels that are not used by the six KARMA Modules or the two Keyboard Layers.
<MenuBut>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this editor:

 

(Click on the links for detailed information on utilities explained in other chapters.)

Copy/Swap Chord Triggers... <CtgDlg/CopySwap>
Opens the Copy/Swap Chord Triggers Dialog, allowing you to copy or swap Chord Triggers within the current 
Performance.

Clear Chord Triggers... <CtgDlg/Clear>
Opens the Clear Chord Triggers Dialog, allowing you to clear all parameters or just the note assignments from selected 
Chord Triggers in the current Performance. 

Copy Chord Triggers From Performance... <CtgDlg/CopyPE>
Opens the Copy Chord Triggers From Performance Dialog, allowing you to copy one or more Chord Triggers from another 
Performance in the current KDF. 

Initialize Chord Triggers
Resets all 16 Chord Triggers to 4 groups of Cmin7, Dmin7, Fmin7, GMin7, with all other parameters turned off.

Link Velocity Editing
When this is activated, a checkmark appears. Then, editing any note’s velocity in a Chord Trigger will adjust all notes in 
that chord to the same velocity. You can use this to easily set the entire chord to a particular velocity.

Average Velocities
Averages the velocities of all notes, within each Chord Trigger.

Sort Chord Notes Up
Sorts the notes in each Chord Trigger by pitch, in an ascending direction.

Sort Chord Notes Down
Sorts the notes in each Chord Trigger by pitch, in a descending direction. Note that this is the recommended direction for 
making sure a root note will play on a monophonic program, with KARMA off.

<Kbd><1689>
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Chord Triggers - Keyboard Display
 

The Keyboard Display shows the last played/edited Chord Trigger, or notes from the keyboard (that can be assigned to a 
Chord Trigger) - as blue dots. Since a Chord Trigger stores up to 8 notes, only the last 8 notes played will be displayed. It 
also displays, as yellow dots, notes that are triggered by Chord Triggers using the “Last Played Notes” feature and 
“Intelligent Transposition”. For example, most of the Factory Performances use the “Last Played Notes” feature on 
Chord Triggers 9~16; these will show as yellow dots - but cannot be assigned to another Chord Trigger. A white diamond 
mark indicates Middle C.

<Glob>
Chord Triggers - Global Parameters
 

The Global Parameters section at the top of the Parameter Area contains the main Assign button for assigning chords, a 
few parameters related to the Velocity Mode, a Quantize Window for quantizing the Chord Triggers, and a setting related 
to how note names are displayed.
<1700>
    [Quantize Window] (popup menu) [0...5: 16th triplet...Quarter]

Specifies the overall Quantize Window (metric division) for any Chord Triggers that have the Quantize setting turned on. If 
you then trigger them a bit early, they will be synchronized with the rest of the Performance. This is mainly used in 
conjunction with the Intelligent Transposition Parameters explained in a later section of this chapter.
<CtgEd/Intel><1685>
    [Assign] (button)

Allows you to easily assign a chord of up to eight notes and velocities to one of the 16 Chord Trigger buttons. There are 
two ways you can do this:

Method 1:
1. Play a chord on the keyboard (the last chord is always kept in memory).
2. Click on the Assign button to turn it on. The LED will light.
3. Click one of the 16 Chord Trigger Buttons. The chord you played in step 1 will be registered to that button, and the 
Assign button will turn off.
4. Save the Performance to keep the new settings.

Method 2:
1. Click on the Assign button to turn it on. The LED will light.
2. Play the chord on the keyboard. To assign notes that are difficult to play simultaneously, hold down the first note on a 
keyboard and then add additional notes one by one with the other hand. You can create extremely wide voicings this way 
that would be impossible to play normally.
3. Click one of the 16 Chord Trigger Buttons. The notes and velocities you played in step 2 will be registered to that 
button, and the Assign button will turn off.
4. Save the Performance to keep the new settings.

The Assign button can also be operated with a key shortcut on the computer keyboard, see below under Chord Trigger 
Button. Alternately, it can be operated via a CC message or the Motif/MOX Remote Mode.
<1686><VelMode>
    [Velocity Mode] (popup menu) [0..2]
Selects one of three ways of generating note velocities from the Chord Trigger, with regards to velocity sensitive input 
devices. Note that since the computer keyboards function keys are not velocity-sensitive, this has a very limited effect 
on the chords being generated from the function keys, but can be used to make them all somewhat softer or louder, since a 
simulated “Function Key Velocity” is able to be set.

When used with Chord Triggers that are storing a chord:

0. Fixed Velocity
The Chord Triggers will send the stored velocity for each note as it is programmed, without any velocity sensitivity.

1. Vel. Sensitive
The programmed velocities of the notes are scaled to become louder or softer, depending on the velocity with which the 
pad is triggered, while maintaining the same relationship to each other.
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2. Individual
Each Chord Trigger can operate individually as “Fixed” or “Velocity Sensitive” depending on the setting of the “Velocity 
Sensitive” checkbox at the botttom of this Chord Note Parameters section. For example, you might use this to have the 
first eight Chord Triggers play chords into KARMA at a fixed velocity, while the other eight play drum sounds with 
velocity sensitivity.

When the Chord Trigger is set to “Last Played Notes”, it works a bit differently:

0. Fixed Velocity
A single Velocity field (in row 1) is enabled, and specifies the velocity for the entire chord. The velocities of the 
individual last played notes themselves are ignored; i.e. if you play notes on the keyboard within the Last Played Zone, 
those velocities are not used and the single specified velocity is used for all notes in the chord, when it is triggered or 
retriggered.

1. Vel. Sensitive or 2. Individual (with Velocity Sensitive checked)
All Velocity fields are disabled, and the velocities come from the actual last played notes. If you play a chord in the Last 
Played Zone with low velocities, triggering the Last Played Chord Trigger will issue those notes with the same velocities. 
If the Chord Trigger has the Retrigger checkbox on, then as you play new chords or regular Chord Triggers, the Last 
Played Chord Trigger will automatically retrigger the notes with the actual velocities as they are being played. 

    The velocity response can be additionally tailored with the Performance Editor > Velocity Response Page.
<1677><FuncVel>

    [Function Key Velocity] (numerical) [1...127]

Allows a simulated “velocity level” to be set for the computer’s Function Keys (which are not velocity sensitive). In 
other words, since they only generate a fixed level, you can set the level at which you want them to be interpreted. If you 
set this to 90, for example, then each Function Key will be assumed to have been pressed with a velocity of 90. This is 
mainly for testing the Vel. Sensitive Mode from the computer. Not available when the Velocity Mode is Fixed.
<1693>

    [Accidentals] (button) [b,#]

Chooses whether chord names containing an accidental will be displayed as sharp (C# Maj) or flat (Db Maj). For example, 
if your chords are basically in the key of C Minor, you would normally prefer to see accidentals as flats (i.e. Eb, not D#). 
If the chords are based in the key of A Major, you would normally prefer to see accidentals as sharps (i.e. C#, not Db). 
This is a display-only setting, and has no effect on music generation. This setting is stored in each Performance.

<Chord>
Chord Triggers - Chord Note Parameters
 

The top section of each of the four displayed chord columns contains the Chord Note Parameters - the eight notes and 
velocities, the Chord Trigger’s MIDI Channel, and a few related parameters. A label in each column shows the analyzed 
Chord Type, such as “Emin7_11” (or “Last Played Notes” if using that feature). A Chord Trigger button allows each 
chord to be triggered with the mouse (or the function keys, or incoming CC messages, or the Motif/MOX Remote Mode.)
<1675>
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    [MIDI Channel] (popup menu) [1...16, [G] (Global)]

Specifies the MIDI Channel on which the Chord Trigger will transmit its notes. For example, you can use this to have 
different Chord Triggers activate different KARMA Modules by setting this to something other than Channel 1, and then 
setting the Module’s Input Channel to the same value in the Performance Editor > MIDI  Setup Page. Alternately, by setting 
the Channel to values that are not used to trigger the KARMA Modules or play the Keyboard Layers, you can trigger 
Motif/MOX arps, or hits and sound effects.
<1674>

    [Chord Trigger Button] (button)

Sends the stored notes and velocities into KARMA as MIDI Input, where they can trigger KARMA Modules or be routed to 
other destinations. They can be clicked with the mouse, triggered via a CC message or the Motif/MOX Remote Mode, or 
activated using the Function Keys of your computer keyboard:

        [F1]...[F8] - Chord Trigger Button 1...Chord Trigger Button 8
        Shift + [F1]...[F8] - Chord Trigger Button 9...Chord Trigger Button 16
        Ctrl + a [Mac], Ctrl + Shift + a [Win]  - Chord Trigger Assign
<1676>

    [Chord Name] (label)

Shows the chord type as analyzed by KARMA’s chord recognition, or “Last Played Notes” if using that feature.
<1671><1688>
    [Note 1~8] (numerical) [-1: Off, 0...127: C-1...G9]

Specifies the MIDI Note Number for one of the notes assigned to a Chord Trigger Button. A chord may contain up to up to 
eight notes. As shown above, unused Notes display the “-” symbol, indicating they are off. If you select the numerical 
with the mouse and drag all the way down, you will get this “-”. You can enter MIDI Note Names directly (i.e. for C3 just 
type c3 on the computer keyboard), or scroll with the mouse, use the computer up/down arrow keys, or use the Inc/Dec 
arrows next to each field.

When the “Last Played Notes” checkbox is on, all of the note fields are grayed out since they are not used. If notes have 
been previously assigned, they will stiill display in the grayed out fields, but they have no effect. You can clear them with 
the “Clear Chord Triggers” command in the editor’s Menu Button.

    You can also assign the note directly from MIDI Input using the “Assign From Keyboard Buttons” described below.
<1672>

    [Velocity 1~8] (numerical) [1...127]

(When used as a normal Chord Trigger storing a chord.) Specifies the velocity for one of the notes assigned to a Chord 
Trigger Button. When the chord is triggered, each note will be input into KARMA with the velocity specified here.

    You can also assign the velocities directly from MIDI Input using the “Assign From Keyboard Buttons” described 
below.
<1690>

    [Velocity (Last Played)] (numerical) [1...127]
(When used with the “Last Played Notes” feature.) Specifies a single velocity used for all notes in the chord, when the 
Velocity Mode is Fixed (or the Chord Trigger is set to not use vel. sensitivity). Otherwise, the actual velocities of the last 
played notes are used.
<1673>

    [Assign From Keyboard Buttons] (button)

To the left of each note field in the chord is a small keyboard button. When turned on, the next note and velocity you play 
on the MIDI Input device will be assigned to that field. If you turn on multiple buttons, for however many are turned on the 
next sequential notes from the MIDI Input Device will be assigned in order from the top to the bottom of the column (Notes 
1~8).

    Of course, the easiest way to assign a chord to a Chord Trigger Button is to simply use the Assign Button and play the 
chord on the MIDI Input Device. See the description above.
<1691>

    [Velocity Sensitive] (checkbox) [Off, On]

When on, the Chord Trigger will be Velocity Sensitive; when off, the Chord Trigger will operate in Fixed Mode, always 
generating the specified velocities. Only available when the Velocity Mode is set to “Individual”.
<1692>

    [Master Transpose] (checkbox) [Off, On]

When on, the Chord Trigger will be transposed according to the Performance’s Master Transpose setting (useful for 
melodic notes); when off, the Chord Trigger will ignore the Performance Transpose (useful for drum sounds and sfx). Only 
available when the MIDI Channel of the Chord Trigger is set to a channel that is not being used as a Module or Keyboard 
Layer’s Input Channel (since notes generated by a Module or Keyboard Layer always are affected by the Master 
Transpose).

<About>
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Chord Triggers - About Intelligent Transposition
The “Intelligent Transposition” feature allows you to use the Chord Triggers to play sounds on other MIDI Channels than 
the ones KARMA is using for the six Modules and two Keyboard Layers, such as triggering Motif/MOX arps or hits and 
sound effects, by using a setting named “Last Played Notes” to determine what notes will be sent. Rather than using 
pre-stored notes (which limits their usefulness to only the programmed chord, which may or may not match what you are 
doing, especially if you are playing your own chords on the keyboard), they use the last played notes from either the 
keyboard or a Chord Trigger. So whatever chord was last played, you can trigger it from these specially set-up Chord 
Triggers to play Motif/MOX arps with a matching chord, or hits and sfx (which can optionally play only the root note if 
desired).

For example, in most of the KARMA Factory Performances, two different Motif/MOX arps are configured to be triggered 
by Chord Triggers 9 to 12, and 13 to 16 (two groups of four). Each group of four (or sometimes one group of eight) 
generally has the first Chord Trigger in the group set to the root scale step, so that it generates the same chord that was 
last played. Other Chord Triggers in the group then transpose the last played notes intelligently into other scale steps, so 
that you can trigger ascending or different arp patterns that relate to the last played chord (“Intelligent Chord Trigger 
Transposition”).

In other words, let’s say you played a Cmaj triad on the keyboard, or from one of the first eight Chord Triggers. The first 
CT in the arp group (CT 9) would send a Cmaj to the arp; the second CT might send a Dmin (the second scale step), the 
third CT might send an Emin (the third scale step), and so on. If you played a minor chord, the notes would be similarly 
intelligently transposed to fit the scales steps of a minor scale – you have to try it to fully understand how it works. You 
can also watch the “KARMA Motif Software – Introduction” video on karma-lab.com for a good demonstration.

Generally, the arp Chord Triggers are set to latch – this is not the Motif/MOX arp’s latch setting, but a setting in the 
Chord Triggers – you will see the button turn on when you press it, and stay on – and the arp keeps running. Triggering the 
same button a second time turns it off.

Furthermore, the arp Chord Triggers can be assigned to Exclusive Groups, such that a new one shuts off the previous one. 
Typically, the four Chord Triggers in each arp group shut each other off - in some Performances, the two different arps 
shut each off; in others, they can be layered on top of each other. The Performance Notes for each Performance details 
the scale steps and various ways the arp Chord Triggers shut each other off.

Additionally, the latched arp Chord Triggers can be shut off by other operations, such as a scene change, the end of a fill, 
the start of a stutter, etc. In most Performances, they have been set to turn off at a scene change – and note that you can 
select the same scene you are presently on if you just want them to go off without changing scenes. In some 
Performances, they are also set to turn off at the end of a fill – all of this can be individually configured for each 
Performance, using the parameters in the next section.

About the Stutter Feature and Chord Triggers
When a Chord Trigger is sending notes on channels that do not match the input channels of the Modules or Keyboard Layers 
(i.e. sending to additional external arps or hits as described in this section), the Stutter and Retrigger features can be 
used to stutter or retrigger those Chord Triggers with the groove. The Chord Trigger must either be latched or physically 
held down. Pressing any of the Stutter buttons in this case will stutter not only the Modules that are programmed to react 
to it, but the Chord Trigger as well - and the same goes for the Retrigger button.

It is important to note that the Chord Triggers do not have their own “Stutter Window” parameter (found in the 
Performance Trigger Page for each Module). They always take the Stutter Window from the first Module set to be 
stuttered in the Performance Editor Dynamic MIDI settings for the stutter buttons. This is generally Module 1, but if 
Module 1 were for some reason deselected from being activated by the stutter buttons, the next activated Module’s 
settings would be used.

<Intel>
Chord Triggers - Intelligent Transposition Parameters
 

The parameters in this section are used to control the Motif/MOX arps, and occasionally hits or sound effects. For a 
discussion of the general purpose of these parameters, see About Intelligent Transposition in the previous section.
<CtgEd/About><1695>
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    [QTZ - Quantize] (checkbox) [Off, On]

When on, KARMA will attempt to quantize the press of the Chord Trigger to the running Performance. Note that it is only 
possible to quantize Chord Triggers that arrive early; this setting has no effect on Chord Triggers that are late. The 
rhythmic division to which they are quantized is set, per Performance, with the Quantize Window setting in the Global 
Parameters section.
<CtgEd/Glob><1696>
    [PRE - Predelay] (checkbox) [Off, On]

When on, the notes that come from the Chord Trigger will issue slightly early (when quantized). When using the Chord 
Triggers to trigger external arps (such as the Motif/MOX), it may be necessary to use this to achieve proper 
synchronization. Not available unless the Quantize checkbox is on.
<1698>
    [LPN - Last Played Notes] (checkbox) [Off, On]

Specifies whether the Chord Trigger will send the last played notes on the keyboard (or other Chord Trigger) instead of a 
stored set of notes and velocities. You can use this feature with external arpeggiators (for example), so that the last 
played chord can be sent, whether it came from other Chord Triggers or from the input zones of the keyboard, without 
having to worry about storing predetermined chords for this purpose. 

    Not available unless the Chord Trigger Channel is set to a channel that is not one of the Module or Keyboard Layer input 
channels. When the Chord Trigger is set to a Module or Keyboard Layer input channel, it sends notes directly into the 
Module or Keyboard Layer; in this case, you cannot use the Last Played Notes feature.
<2117>
    [MON - Mono] (checkbox) [Off, On]

When the Chord Trigger is using “Last Played Notes”, specifies that only the single lowest note of the last played notes is 
sent. This can be useful for triggering sounds like orchestra hits, distorted guitar chords, etc. Not available unless the 
Last Played Notes checkbox is on.
<1699>

    [ATR - Auto-Trigger] (checkbox) [Off, On]

When the Chord Trigger is using “Last Played Notes” (and latched or held down), specifies that new notes will be 
automatically triggered when a new chord is played on the kbd or sent from another Chord Trigger. Not available unless 
the Last Played Notes checkbox is on.
<1694>
    [Chord Shift] (checkbox) [Off, On]

When using “Last Played Notes” and transposing them by semitones, allows the resulting transposed notes to be shifted to 
fit the current chord, forcing notes to remain in the proper scale for the chord. Not available unless the Last Played Notes 
checkbox is on. This is what is referred to as Intelligent Transposition. <CtgEd/About>

If you set the Last Played Transpose for eight Chord Triggers to 0, 2, 4, 5, 7, 9, 10, 12 and turn on Chord Shift, they 
will shift the chord through the 7 scale steps (and octave) of any chord that is played on the keyboard or sent in from 
another Chord Trigger sending notes. Other transpose settings in between the listed values will provide alternate voicings 
that may be useful.
<1697>
    [Last Played Zone] (popup menu) [0...7: Module 1...6, Kbd Layer 1..2]

Specifies one of the zones (key ranges) in the Performance Key Zones Page from which to take the last played notes - for 
example, you can choose a zone for any of the Modules, or a zone from one of the Keyboard Layers. Not available unless 
the Last Played Notes checkbox is on.

Generally, you should choose the same zone for all Chord Triggers that you want to use last played notes within the same 
zone. In other words, if Modules 1, 2, 3, and 4 have the same exact key zone settings in the Performance, they would 
operate the same for the Last Played Zone – and so, if setting four Chord Triggers to that zone, you should choose the 
same Module for all four chord triggers. While you could set them to different Modules and it would work the same, this is 
less efficient in terms of KARMA’s processing as it has to look at more zones than required each time the Chord Trigger is 
pressed.
<2107>

    [Last Played Transpose] (numerical) [-36...+36 semitones]

When using the “Last Played Notes” feature, allows those notes to be transposed up or down by semitones. This can be 
useful for generating additional chords on external arps from whatever is being played in the specified zone. Not available 
unless the Last Played Notes checkbox is on.

If you set the Last Played Transpose for eight Chord Triggers to 0, 2, 4, 5, 7, 9, 10, 12 and turn on Chord Shift, they 
will shift the chord through the 7 scale steps (and octave) of any chord that is played on the keyboard or sent in from 
another Chord Trigger sending notes. Other transpose settings in between the listed values will provide alternate voicings 
that may be useful.
<2108>
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   [LA - Latch] (checkbox) [Off, On]

Allows the Chord Trigger to be latched in an on position, sustaining the notes it is sending until it is triggered again to 
unlatch it. Other settings here determine other actions that can also unlatch the Chord Trigger.

    This can be used to sustain Chord Triggers that are set to normal stored chords as well - it does not depend on the Last 
Played Notes feature.
<2109>
    [KB - Off By Keyboard] (checkbox) [Off, On]

When a Chord Trigger is latched, specifies that notes from the selected zone to the right will unlatch it. For example, you 
can specify that notes from a Keyboard Layer zone (or the entire keyboard) will unlatch the Chord Trigger. Not available 
unless the Latch checkbox is on.
<2110>
    [Off By Keyboard Zone] (popup menu) [0......8: Modules 1...6, Kbd Layer 1..2, Full]

When Off By Keyboard is on, and the Chord Trigger is latched, notes from the selected zone will unlatch it - unless the 
Chord Trigger button is being physically held down. For example, you can specify that notes from a Keyboard Layer zone 
or the entire keyboard (Full) will unlatch it.
<2111>
    [Off By Other] (checkboxes) [Off, On]

Allows several other actions to be selected to unlatch a Chord Trigger that is latched, such as three different exclusive 
groups, a scene change, the end of a fill, or the stutter feature. Not available unless the Latch checkbox is on.
<2112>

    [EX1, EX2, EX3 - Exclusive Group 1,2,3] (checkboxes) [Off, On]

When a Chord Trigger is latched, all Chord Triggers that share the same exclusive group setting will unlatch it. For 
example, all Chord Triggers set to Exclusive 1 will unlatch any other Chord Trigger set to Exclusive 1. 

Exclusives only turn off chords that are latched; however, chords that are not latched may be part of the exclusive group 
(non-latched chords can shut off latched chords). For example, you could set up Chord Triggers 9~12 to trigger an 
external arp on Channel 9 using the Last Played Notes feature, set them to Latch on and Exclusive 1, and they will turn 
each other off, with only the last pressed one sustaining. If you then assigned Chord Triggers 1-8 (which normally are 
sending chords into KARMA) to Exclusive 1 as well, any new Chord Trigger sending a chord into KARMA would also shut 
off the latched external arp. Meanwhile, if you had Chord Triggers 13~16 also assigned to an external arp in a similar 
fashion, except those four buttons were assigned to Exclusive 2, they would shut each other off, but not affect any other 
latched buttons. And the other buttons would not affect them, since they are assigned to a different Exclusive Group.
<2113>
    [SCH - Scene Change] (checkbox) [Off, On]

When a Chord Trigger is latched, a scene change will unlatch it - unless the Chord Trigger button is being physically held 
down. Not available unless the Latch checkbox is on.
<2114>
    [FILL - End Of Fill] (checkbox) [Off, On]

When a Chord Trigger is latched, the end of a fill will unlatch it - unless the Chord Trigger button is being physically held 
down. Not available unless the Latch checkbox is on.
<2115>

    [S|R - Stutter/Retrigger] (checkbox) [Off, On]

When a Chord Trigger is latched, activating the stutter or retrigger features will unlatch it - unless the Chord Trigger 
button is being physically held down. If this is off, you can stutter or retrigger the latched Chord Trigger. Not available 
unless the Latch checkbox is on.

<Transpose>
Chord Triggers - Transpose & Modify Velocity
 

The parameters in this section are not stored in the Performance - rather, they allow you to make real-time 
modifications to the transposition of the notes and the velocities of the notes, to one or more Chord Triggers at a time. 
You can audition the results by playing the Chord Triggers, without actually modifying them. Once you have a result you 
like, you can press the “Set Values” button and the changes are written to the Chord Triggers.

    It is important to note these settings are a temporary real-time modification that do not affect the Performance until 
the Set Values button is clicked. Storing a Performance with these values set to some modification does not automatically 
enter them in the Performance.
<1678>
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�   [Chords] (popup menu) [All, 1...16, groups of 4, 8 or 12]

Specifies which of the Chord Triggers will be affected by the Transpose and Velocity settings. You can choose from single 
chords, groups of 4, 8 or 12, or all Chord Triggers.
<1679>

    [Transpose Octave] (popup menu) [-3...+3]

Transposes the specified Chord Triggers by an octave amount. This is combined with the Semitone setting.
<1680>
    [Semitone] (popup menu) [-12...+12]

Transposes the specified Chord Triggers by a semitone amount. This is combined with the Octave setting.
<1682>
    [Modify Velocity] (popup menu)  [Offset, Absolute]

Selects one of two modes that the Value field will operate in:

Offset:
The Value field accepts a range from -63...+64, and this value is used to raise or lower the velocities in the specified 
Chord Triggers by that amount, maintaining the original relationship, but making the whole chord louder or softer.

Absolute:
The Value field accepts a range from 1...127, and this value is used as an absolute setting for all notes in the specified 
Chord Triggers. You can use this to set all velocities to 100, for example.
<1683>
    [Value] (numerical) [-63,...+64, 1...127]

Operates in two different ways, depending on the setting of the Modify Velocity menu. Offset raises or lowers all notes in 
the chords by the specified amount, while Absolute sets all notes in the chords to the specified velocity.
<1681>

    [Set Values] (button)

Applies the transposition and velocity modifications to the specified Chord Triggers. Once the settings have been made to 
your satisfaction and sound correct, you then apply them with this button. The settings of the entire Transpose & Modify 
Velocity section then return to zero. Note that while the values have been entered into the current Performance’s Edit 
Buffer, the changes are not permanent until you save the Performance and the KDF File.
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<0698>

Chord Input/VK (Virtual Keyboard)
Sections in this chapter:

Overview<CjmEd/Over>

Virtual Keyboard<CjmEd/VK>

Chord Input<CjmEd/Input>

Chord Reference<CjmEd/ChordRef>

<Over>
Chord Input/VK - Overview
The Chord Input/VK Editor provides you with two different ways to input MIDI data into KARMA Motif using just the 
computer keyboard and the mouse. You can use this for testing while programming, experimenting with different chords, 
or just for fun! (Of course, you can also use the Chord Triggers from the computer keyboard to trigger KARMA, but the 
two panels on this page act somewhat differently.)

<VK>
Chord Input/VK - Virtual Keyboard
 

The Virtual Keyboard allows you to send MIDI Data into the Keyboard Layers of KARMA without actually using a MIDI Input 
Device. In other words, the notes played on the Virtual Keyboard will be sent into the left hand and right hand Keyboard 
Layers as if you were playing them from the keyboard; however, no notes will be input to KARMA, so only the Keyboard 
Layer sounds will be played. You can click with the mouse in the Virtual Keyboard and drag it around, or you can turn on 
the “Use Computer Keyboard” checkbox and “play” the VK from the computer keys. Currently played notes light up in 
blue.

When the computer keyboard’s shift key is held down, it acts similar to a damper/sustain pedal: notes that you play with 
the computer keys or by clicking on the Virtual Keyboard will sustain and overlap each other. There is one difference: 
releasing the shift key does not release the sustain; rather, the next note played ends the previous notes.
<0665>

Virtual Keyboard
Clicking and dragging with the mouse sends individual notes into KARMA, on the Keyboard Layer channels. You can overlap 
notes by using the shift key as a sustain pedal. You can play the keyboard from your computer keys as well.
<0663>

Octave Label
Displays the octave depending on the current setting of the octave up/down buttons to the right.
<0664>

Computer Keyboard Map
Display the notes on the computer keyboard that activate each key when the “Use Computer Keyboard” checkbox is on. 
For example, z-x-c in the second row of keys play C-E-D, while q-w-e in the fourth row of keys play C-E-D an octave 
higher. The following diagram shows the relationship to the black and white keys of a two and a half octave virtual 
keyboard:
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Menu Button
A popup menu allowing instant access to this help chapter.
<0701>

    [Use Computer Keyboard] (checkbox) [Off, On]

When on, allows you to play the virtual keyboard using the computer keys listed above the middle two octaves. The shift 
key functions like a sustain pedal. Use the octave up/down buttons to change which octaves the keys access.

    When using an S70/S90 XS and the DAW Remote Mode, the number keys 0~9 and the period, minus and plus keys are 
used by the S70/S90 XS HID keys [1]-[10] and [14]-[16] (as explained in the “Using The Remote Mode” tutorial) and are 
not available to trigger the black notes in the top two octaves.
<0700>

    [Note Velocity] (numerical) [1...127]

Specifies the velocity to be used for notes generated by clicking on the virtual keyboard, or using the computer keys to 
play it.
<0702>

    [Octave Up/Down] (buttons)

Shifts the octave of the Virtual Keyboard up or down, covering different areas of the full range of notes. When “Use 
Computer Keyboard” is on, the left/right arrow keys can be used to activate the buttons.

<Input>
Chord Input/VK - Chord Input
 

The Chord Input section allows you to send MIDI Data into KARMA without actually using a MIDI Input Device. It contains a 
Chord Grid comprising 240 chords based on 20 different chord types and 12 different keys. Furthermore, it can allow you 
to experiment with chord types you might not be familiar with.
<0666>
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Chord Grid
Click on the grid with the mouse to send the chord specified by the column in the key specified by the row into KARMA as 
MIDI Input, as if it came from a keyboard or other MIDI Device. You may drag around and change the chord type without 
releasing the mouse.

Chords (Y Axis)
Across the top of the grid are specified 20 different chord types. Clicking in a column sends the chord specified by the 
column in the key specified by the row. See the Chord Reference later in this chapter for the exact notes.
<CjmEd/ChordRef><0667>

Key (X Axis)
The rows correspond to the 12 notes in an octave, from C to B going from bottom to top. Clicking in a row sends the chord 
specified by the column in the key specified by the row.
<0669>

Current Chord
The Current Chord is indicated by the “intersection” graphic in the grid and displayed as a Chord Symbol in the bottom of 
the editor. The chord will also be displayed at the top of the Main Window. This field also displays the chord when played 
from a MIDI Input Device, the same as the one at the top of the Main Window.
<0668><0673><0674><0675><0676><0677>

Octave Buttons
The Octave Buttons allow you change the input octave of the chord that is sent when you click on the grid. They 
correspond to the five octaves of a 61 note keyboard in terms of range. In other words, with the third octave button 
pressed, clicking a C Major chord would send [C E G C] with the bottom C at Middle C (60). With the first octave button 
pressed, it would be the same as playing the C chord in the lowest octave of your 61 note keyboard.

Menu Button
A popup menu allowing instant access to this help chapter.
<0670>

Random Selection Parameters
Allows you to have chords randomly selected every “n” milliseconds, as specified by the “ms” Field. This feature is 
something that was written more as a test function, so it’s not as full-featured as it might be someday. It’s not really 
intended to produce useful results at the moment, but we decided to leave it in. Have fun!
<0671>

    [Randomize On/Off] (button) [Off, On]

When on, a new chord will be randomly selected on the Chord Grid at timing intervals specified by the “ms” parameter 
below. When off, you use the grid with the mouse.
<0672>
    [ms (milliseconds)] (numerical) [100...10,000 ms (10 seconds)]

Specifies the time interval for choosing the next chord at random, in milliseconds. For example, 5000 is five seconds.
<0662>
    [Send to Keyboard Layer 1] (checkbox) [Off, On]

Allows the notes generated by clicking on the grid to be sent to Keyboard Layer 1 in addition to the input of the Modules. 
This allows the chord to play a LH pad sound as well, similar to a Chord Trigger or the keyboard.
<0699>

    [Chord Velocity] (numerical) [1...127] 

Specifies the velocity to be used for notes generated by clicking on the chord grid.
<0678><0679><0680><0681><0682><0683><0684><0685><0686>
<0687><0688><0689><0690><0691><0692><0693><0694><0695><0696><0697><ChordRef>
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Chord Input/VK - Chord Reference
All chords are four notes. The following table lists the four notes for each chord type in the key of C:
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<0611>

Data Display
Sections in this chapter:

Overview<DadEd/Over>

Display Parameters<DadEd/Parms>

Display Setup Dialog<DadEd/Setup>

     Display Activity<DadEd/ModDisp>

     Object Specifications<DadEd/ModSpec>

     Color Setup<DadEd/Colors>

     Display Characteristics<DadEd/DispChar>

 

<Over>
Data Display - Overview
The Data Display Editor provides a captivating and colorful way to view the MIDI data being generated by KARMA in 
real-time. Complete control over the colors, velocity scaling of color, note head sizes, shapes and other attributes of the 
display is provided by the Data Display Setup Dialog. However, the Data Display is not just “eye candy” - you will find it 
a helpful visual aid and diagnostic tool when trying to determine exactly what KARMA may be generating at a given 
moment as you are programming GEs and Performances.
<0606>

Data Display Area
Displays the MIDI Data being generated by KARMA in one of several different “layouts” (Display Types). The output of 
each of the six Modules can be viewed in different colors, along with the notes you play on the Keyboard Layers, and the 
notes that are generated by any Chord Triggers set to trigger Motif/MOX arps and hits or SFX.
<0605>

Display Setup Dialog
Opens the Data Display Setup Dialog, where settings can be made for all the colors and shapes viewed in the Data Display 
Area.
<DadEd/Setup>

Menu Button
A popup menu allowing instant access to this help chapter.

<Parms>
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Data Display - Display Parameters
 

<0601>
    [On/Off] (button) [Off, On]

When on, the Data Display Area displays in real-time the current MIDI Data being generated by KARMA (Modules, 
Keyboard Layers and Chord Triggers). When off, the display freezes with whatever was last generated. When first turned 
on, the display will erase and start displaying data at the far left side.
<0602>
    [Resolution] (popup menu) [0...7: 1x...40x]

Sets the overall resolution and time frame for the display, allowing you to “zoom in” and “zoom out” on the data. A 
setting of 6x is the default “normal” setting. Higher settings such as 12x or 20x allow you to examine events with 
greater accuracy. Lower resolutions such as 1x or 2x allow you to display a longer period of time.
<0603>
    [Display Type] (popup menu) [0...7]

Selects one of eight different formats for displaying the data, which determines how many different CC Display areas 
there are, whether the Modules and Keyboard Layers are displayed in separate areas or on top of each other, etc.

 

0: All-2p   C0-C8, 2 pixels per note, 6 large CC display areas
Displays data for all six Modules, two Keyboard Layers and Chord Triggers on top of each other, with an area for Note 
Data in the range of C0~C8 at the top followed by six different Vel/CC display areas. This has the smallest size for Note 
Data in the first four types (two vertical pixels per note), but the greatest detail for CCs. The six CC areas display: 
Velocity, Pan (CC 10), Bend, other CCs 0~16, 17~64, 65~127.
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1: All-3p   C0-C8, 3 pixels per note, 4 large CC display areas
Similar to 0: All-2p above, except the Note Data area is larger (three vertical pixels per note) and there are only four 
“CC” display areas: Velocity, Pan (CC 10), Bend, and all other CCs.

2: All-4p   C0-C8, 4 pixels per note, 4 smaller CC display areas
Similar to 1: All-3p above, except the Note Data area is larger (four vertical pixels per note) and the four CC areas are 
compressed with less vertical resolution.

3: All-5p   C0-C8, 5 pixels per note, no CC display areas
Displays only Note Data for all six Modules, two Keyboard Layers and Chord Triggers with the largest vertical resolution 
of five pixels per note. No CC, Velocity, or Bend information is displayed - just notes.

4: 4 mod    separate tracks, C1-C8, 1 pixel per note, 1 CC display area
Displays Modules 1~4 as separate “tracks,” with Note Data in the range of C1-C8 being displayed, at a vertical 
resolution of one pixel per note. There is one “CC” area for each track that displays Velocity, Bend, and all other CCs. 
Keyboard Layers and Chord Triggers are not shown in this format.

5: 5 mod    separate tracks, C2-C8, 1 pixel per note, 1 CC display area
Displays Modules 1~5 as separate “tracks,” with Note Data in the range of C2-C8 being displayed, at a vertical 
resolution of one pixel per note. There is one “CC” area for each track that displays Velocity, Bend, and all other CCs. 
Keyboard Layers and Chord Triggers are not shown in this format.

6: 6 mod A  separate tracks, C2-C7, 1 pixel per note, 1 CC display area
Displays Modules 1~6 as separate “tracks,” with Note Data in the range of C2-C7 being displayed, at a vertical 
resolution of one pixel per note. There is one “CC” area for each track that displays Velocity, Bend, and all other CCs. 
Keyboard Layers and Chord Triggers are not shown in this format.

7: 6 mod B  separate tracks, C2-C8, 1 pixel per note, no CC display area
Displays Modules 1~6 as separate “tracks,” with Note Data in the range of C2-C8 being displayed, at a vertical 
resolution of one pixel per note. No CC, Velocity, or Bend information is displayed - just notes. Keyboard Layers and 
Chord Triggers are not shown in this format.
<0604><0608><0609><0610>

    [Markers] (buttons)

Labels
Allows short labels to be displayed along the vertical axis of the display, such as Note Markers “C2, C4, C6,” labels for 
the CC Display areas, etc.

Horizontal
Allows horizontal marker lines to be turned on and off. In the Note Display Areas, they indicate staff lines, while in the CC 
Data display areas, they indicate 0, 64 and 127.

Vertical
Allows vertical marker lines to be turned on and off. These are arbitrary and simply subdivide the display, without having 
any specific relationship to time. However, vertical marker lines can also be drawn at beat divisions by the metronome. 
See Metronome Editor.
<MetEd><0605>
    [Setup] (button)

Opens the Display Setup Dialog (discussed below), allowing the colors for various parts of the Note Series Display to be 
customized.

<Setup>
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Data Display - Display Setup Dialog
 

The Data Display Setup Dialog is opened by clicking the Setup Button in the upper right corner of the Data Display Editor. 
Complete control over the various objects displayed, colors, velocity scaling of color, note head sizes, shapes and other 
attributes of the display is provided. The dialog is divided into several groups of settings as shown above.

Display Activity
Settings that control which  objects (Modules, Keyboard Layers and Chord Triggers), and what exactly is displayed for 
them. See Display Activity.
<DadEd/ModDisp>

Object Specifications
Parameters that control the size and shape of the various objects that are drawn to represent the MIDI Data. See Object 
Specifications.
<DadEd/ModSpec>

Color Setup
Specifies colors for the different areas of the display and the objects drawn to represent the MIDI Data. See Color Setup.
<DadEd/Colors>

Display Characteristics
Parameters that specify certain other characteristics of the display of data such as Velocity Data, Note Duration Lines, 
Resolution etc. See Display Characteristics.
<DadEd/DispChar><0652>

Defau l t
Returns the settings to the factory default colors and specifications.
<0653><0654>

Cancel /OK
The Cancel Button closes the dialog and returns all settings to the previous settings. The OK Button closes the dialog and 
saves your changes in the Preferences File.

    Although the Display Setup Dialog is a modal dialog, you can drag the top of the window and move the dialog, and watch 
your edits being displayed in the Data Display Editor in real-time as you make changes.

    Although there is presently only one stored group of all of the settings for the Data Display Editor (stored in the 
Preferences), future versions may support loading and saving multiple groups of settings as “Display Presets.”

<ModDisp><0626>
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Data Display Setup - Display Activity
 

This section contains settings that control which objects (Modules, Keyboard Layers and Chord Triggers) are displayed, 
and what exactly is displayed for them. You can use this to configure the view so that only certain objects are displayed, 
even though all of them may be playing. There are columns for each of the six Modules, two Keyboard Layers, and Chord 
Triggers. The larger round On/Off buttons at the top indicate which object is being controlled:

1~6: Modules 1 through 6

K1, K2: Keyboard Layers 1 and 2

CT: Chord Trigger Notes that are not triggering KARMA Modules. In other words, notes generated by Chord Triggers 
where the Chord Trigger’s MIDI Channel is not set to an Input Channel for a Module. Examples of this include most of the 
Factory Performances, where Chord Triggers 9~16 are programmed to control Motif/MOX arps, hits or SFX. Chord 
Triggers that are assigned to send notes into the Modules are not controlled by this setting, since any notes they trigger 
or cause to be generated are controlled by the Module column itself.
<0620><0613><0614><0615>
    [On/Off] (buttons) [Off, On]

Allows the display of data for each of the six Modules, the two Keyboard Layers, and the Chord Triggers to be turned on 
or off individually. When off, the column of buttons beneath becomes grayed out, as shown above (for Module 3). You can 
use this to remove certain Modules from the overall display even though you can still listen to them generate data - you 
just won’t see them.
<0621>
    [Duration] (button) [Off, On]

When on, the durations of the notes for the specified Module will be drawn as lines extending from the note head to the end 
of the note. When off, only the note heads will be drawn.
<0622>
    [Velocity] (button) [Off, On]

When on, the velocities of the notes for the specified Module will be displayed in the Velocity Area of the Data Display, as 
specified by the Display Type. When off, no velocity data will be displayed.
<0623>
    [Pan] (button) [Off, On]

When on, Pan Data (MIDI CC 10) for the specified Module will be displayed in the CC Area of the Data Display, as specified 
by the Display Type. When off, no Pan Data will be displayed.
<0624>
    [Bend] (button) [Off, On]

When on, Pitch Bend Data for the specified Module will be displayed in the CC or Bend Area of the Data Display, as 
specified by the Display Type. When off, no Bend Data will be displayed.
<0625>
    [Other] (button) [Off, On]

When on, all other MIDI Data not covered by the other options for the specified Module will be displayed in the CC Area of 
the Data Display, as specified by the Display Type. When off, no data will be displayed.

<ModSpec><0633><0637><0638>

Page 54



Data Display Setup - Object Specifications
 

This section contains parameters that control the size and shape of the various objects that are drawn to represent the 
MIDI Data. There are columns for each of the six Modules, two Keyboard Layers, and Chord Triggers (as explained above 
in the Display Activity section).
<DadEd/ModDisp><0627>
    [Note Head Shape] (popup menu) [Rect, Frame, Circle, Ring]

Selects one of four basic shapes for the Note Head that is displayed for every note: square (filled and unfilled) or circular 
(filled or unfilled).

    Note Head Pixels must be set to five pixels or greater for a circular shape to be seen, and three pixels or greater for 
any shape to be seen.
<0628>
    [Note Head Pixels] (popup menu) [1,3,5,7,9,11,13,15,17,21 pixels]

Sets the width and height (in pixels) of the object drawn to represent the Note Head. The actual shape is specified by the 
Note Head Shape parameter.
<0629>
    [Velocity Caps Pixels] (popup menu) [1,3,5,7,9,11,13,15,17,21 pixels]

Sets the width (in pixels) of the horizontal line drawn for the velocity of each note (which may be displayed as the “cap” 
of a vertical line if desired). A width of one pixel simply draws a point.
<0630>
    [Pan Lines Pixels] (popup menu) [1,3,5,7,9,11,13,15,17,21 pixels]

Sets the width (in pixels) of the horizontal line drawn for every Pan (CC 10) data value received. A width of one pixel 
simply draws a point.
<0631>
    [Bend Lines Pixels] (popup menu) [1,3,5,7,9,11,13,15,17,21 pixels]

Sets the width (in pixels) of the horizontal line drawn for every Pitch Bend data value received. A width of one pixel 
simply draws a point.
<0632>
    [Other Data Pixels] (popup menu) [1,3,5,7,9,11,13,15,17,21 pixels]

Sets the width (in pixels) of the horizontal line drawn for every other type of MIDI data value received. A width of one 
pixel simply draws a point.

<Colors>
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Data Display Setup - Color Setup
 

The parameters in this section specify colors for the different areas of the display and the objects drawn to represent the 
MIDI Data. There are columns for each of the six Modules, two Keyboard Layers, and Chord Triggers (as explained above 
in the Display Activity section).
<DadEd/ModDisp><0634><0635><0636><0658><0659><0660>

    [Velocity Hi/Lo] (color buttons)

For each Module, the Hi Color specifies the color the Note Head and Note Duration will be drawn in when received with a 
Velocity of “127,” and the Lo Color specifies the color they will be drawn in when received with a Velocity of “1.” All 
velocities in between are scaled to a shade between the two. The default settings allow notes to “fade” as they decrease 
in velocity. However, if you program two radically different colors, interesting visual displays can be achieved based on 
the changing velocities.
<0639>

    [Note Tail (Duration) Scale %] (numerical) [1...100%]

Specifies a percentage of the Note Head’s color that will be used to draw the duration line. In other words, when a Note 
Head is drawn, first the color is calculated based on the note’s velocity according to the Velocity Hi/Lo Color settings 
above. With Scale % set to 100%, the duration line will be drawn with the exact same color. However, it seemed that it 
looked better if they were scaled down somewhat, so this parameter lets you darken the duration lines by a certain 
percentage.
<0640>
    [Background] (color button)

Specifies a color for the overall background of the whole Data Display.
<0641>
    [Center Line] (color button)

Specifies a color for the lines representing Middle C and the center 64 value of the CC/Vel Display Areas. These lines are 
only displayed when the Horizontal Markers button is on.
<0642>
    [Inner Lines] (color button)

Specifies a color for the inner Staff Lines in the Note Areas. These lines are only displayed when the Horizontal Markers 
button is on.
<0643>
    [Outer Lines] (color button)

Specifies a color for the outer Staff Lines in the Note Areas, and the lines representing 0 and 127 in the CC/Vel Display 
Areas. These lines are only displayed when the Horizontal Markers button is on. Also specifies the color used for the 
Vertical Marker Lines that are only displayed when the Vertical Markers button is on.
<0644>
    [Bar Lines] (color button)

Specifies a color for “Bar Lines” that are generated on the beat by the Metronome. See Metronome Editor.
<MetEd><0645>
    [Text] (color button)

Specifies a color for the labels such as C2, C4, Pan, Bend and so on that are displayed on the left vertical axis. These 
labels are only displayed when the Labels Marker button is on.

<DispChar>
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Data Display Setup - Display Characteristics
 

The parameters in this section specify certain other characteristics of the display of data such as Velocity Data, Note 
Duration Lines, Resolution, Markers etc.
<0646>

    [Velocity Display] (buttons)

Selects whether to display velocities as simple horizontal lines or points like other MIDI data types, or to draw a vertical 
line with a cap, similar to most sequencing programs.
<0647><0655><0656><0657>

    [Markers] (Buttons)

This parameter is linked with the same parameter in the main Data Display Editor - changing one will change the other. See 
Display Parameters: Markers.
<DadEd/0604><0648>

    [Duration Lines] (buttons) [0...6]

Allows one of six different line types to be used for the duration lines of the notes. In other words, the first choice is a 
solid line, but the next five are different variations on a dotted line theme. The last “R” button signifies choosing the 
duration lines at random from all six of the line variations.
<0649>
    [Resolution] (popup menu) [0...7: 1x...40x]

This parameter is linked with the same parameter in the main Data Display Editor - changing one will change the other. See 
Display Parameters: Resolution.
<DadEd/0602><0650>
    [Display Type] (popup menu) [0...7]

This parameter is linked with the same parameter in the main Data Display Editor - changing one will change the other. See 
Display Parameters: Display Type.
<DadEd/0603>
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Bank Display (Performances)
Sections in this chapter:

Overview<PBD/Over>

Parameters<PBD/Param>

Filter Display By Category<PBD/Fbc>

 

<Over>
Bank Display (Performances) - Overview
The Bank Display Editor can display any bank of data from the KDF Area of the Main Window. Double-clicking a row in the 
KDF Area switches to the Bank Display Editor (if it is not already showing) and displays the bank in the center of the 
Editor Display Area. <SWGUI/KDF>

Three types of bank data can be viewed in the Bank Display Editor: Performances, GEs (Generated Effects), and 
Templates. This chapter discusses the Bank Display Editor when a Performance Bank has been displayed. See also:

Bank Display (GEs) <GBD>

Bank Display (Templates) <TBD>

A Performance Bank Display can be opened for any bank of Performances in the current KDF File - and you can have up to 
32 banks of Performances in a KDF file. As shown above, the Bank Number and Bank Name are displayed at the top. The 
editor displays the 128 Performances in the bank in gray. The current Performance (if it is located in the bank) will be 
displayed in blue, or any other Performances that have been selected with the mouse.

Performance Bank Displays can be opened by double-clicking a Performance Bank Row in the Main Window’s KDF Area, or 
clicking the round triangle button to the left of the Performance Selection popup menu at the top of the Performance 
Editor, which switches to the Performance Bank Display containing the currently loaded Performance.

When a Performance Bank Display is in front, you can navigate around it and change the currently loaded Performance by 
using the arrow keys on the computer keyboard. Pressing an arrow key while holding down the option key (Mac) or alt key 
(Win) will bring up the Rename Selected Performance Dialog, the same as opt/alt+clicking or using the “Rename Selected 
Performance...” utility below. 

    Even when a Performance Bank Display is not in front, you can always advance to the next/previous Performance by 
using the up/down arrow keys and the cmnd key (Mac) or ctrl key (Win).

You can also use the Edit Menu when Performance Bank Displays are in front. You can select multiple Performances with 
the mouse (or all of the Performances in a bank with Cmnd+A (Mac) or Ctrl+A (Win)), and Cut, Paste, Copy or Clear the 
Performances using menu commands.
<1183>

Performance Bank Name
Displays the name and number of the bank. Banks can be renamed using the appropriate commands in the Main Window’s 
Menu Button or the Menu Button in the Bank Display.
<1185>

Performances In Bank
Click to select and load Performance. Shift+click to select more than one (for cutting and pasting or initializing). 
Shift+click and drag to select ranges. Ctrl+click (Mac) or c+click (Win) and drag to draw a marquee around areas. Colored 
labels can be attached to Performance names to help with organization, using the Menu Button’s “Set Label” command.
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Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with the Performance Bank 
Display:

 

(Click on the links for detailed information on utilities explained in other chapters.)

Initialize Selected Performances…
Initializes the selected Performances in the bank to a default starting point (shift-click to select more than one). You will 
be presented with the Initialize Current/Selected Performance dialog where you can choose one of the Module Setup types 
for the initialized Performances. <PEUtils/Init>

Rename Selected Performance...<OthDlg/Bdr>

Filter Display By Category …<PBD/Fbc>

Find Performance By Name...<OthDlg/FBN>

Performance Info<Pfi>

Rename This Bank...<OthDlg/Brn>

Delete This Bank…
Deletes the Performance Bank from the current KDF File and closes the window. You will be given a chance to cancel if 
desired.

Initialize This Bank…
Initializes all Performances in the bank to a default starting point. You will be presented with the Initialize 
Current/Selected Performance dialog where you can choose one of the Module Setup types for the initialized 
Performances. <PEUtils/Init>

    Deleting or initializing a bank cannot be undone, so the only way to restore data after this is to reload the KDF File 
from disk.

Renumber Yamaha IDs In This Bank…<PEUtils/Renumber>

 

Set Label (sub-menu)
Allows you to affix a colored label to the selected Performances, for organizational purposes, such that they are 
displayed in the various menus where you can view and select them.
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Clear Labels In Bank…
Clears any colored labels from all Performances in the bank. You will be given a chance to cancel if desired.

Count Labeled Items In Bank
Displays the following dialog, showing how many Performances in the bank are labeled with the various colored labels. 
This can be useful during development - for example, if you have various Performances in various states of completion 
labeled with different colored labels, you can quickly count how many of each state are completed.

 

<Param>
Bank Display (Performances) - Parameters
 

<1184>
    [Bank Type] (popup menu) [0...31, A...Z, AA...FF]

Sets the Bank Type of the Performance Bank. For KARMA Motif this has no particular effect other than being used by the 
software as an internal identifier - so you should generally not have more than one bank of any given type in a KDF file. 
Each bank should be set to a unique Bank Type.
<1182>
    [Bank Lock Icon] (button)

Displays the lock status of the bank (red = locked, yellow = unlocked). Click to change the status. Locked banks present a 
warning dialog if you attempt to edit any data in them, in order to protect the data from accidental overwrites.

    You can lock/unlock multiple banks at the same time using the Main Window’s Menu Button “Lock/Unlock Selected 
Banks” command.

<Fbc><1826>
Bank Display (Performances) - Filter Display By Category
 

The Filter Display By Category dialog allows you to filter the Performance Bank Displays to hilight Performances based on 
Category, easily identifying those that belong to certain groups. Opened by the corresponding command in the Bank 
Display’s Menu Button, you can select a specific Performance category, and have the contents of any Performance Bank 
Displays instantly highlight the Performances in that category.

The diagram above shows the results of choosing the “Woodwind/Reed” category on a Bank Display that is behind it - 
Performances belonging to that category are highlighted by dimming all other Performances in the display.

You can close the dialog and leave the filtering in place; open it again to remove the filtering and return the Bank Displays 
to their normal appearance.

Page 60



    You can still choose other Performances while the Bank Displays are in this state; only the display of the Performance 
names is affected.
<1830>
    [Choose Category] (popup menu) [number of Performance Categories]

Selects a category to use when filtering the Performance Bank Displays.
<1828><1829>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog and returns to the previous settings that were in use before the dialog was 
opened. The OK Button (green checkmark) closes the dialog and accepts the current settings to use for filtering 
Performance Bank Displays.
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Bank Display (GEs)
Sections in this chapter:

Overview<GBD/Over>

Parameters<GBD/Param>

Filter Display By Category<GBD/Fbc>

Filter Display By RTC Model Type<GBD/Fbr>

 

<Over>
Bank Display (GEs) - Overview
The Bank Display Editor can display any bank of data from the KDF Area of the Main Window. Double-clicking a row in the 
KDF Area switches to the Bank Display Editor (if it is not already showing) and displays the bank in the center of the 
Editor Display Area. <SWGUI/KDF>

Three types of bank data can be viewed in the Bank Display Editor: Performances, GEs (Generated Effects), and 
Templates. This chapter discusses the Bank Display Editor when a GE Bank has been displayed. See also:

Bank Display (Performances) <PBD>

Bank Display (Templates) <TBD>

A GE Bank Display can be opened for any bank of GEs in the current KDF File - and you can have up to 32 banks of GEs in a 
KDF file. As shown above, the Bank Number and Bank Name are displayed at the top. The editor displays the 128 GEs in the 
bank in gray. The current GE (if it is located in the bank) will be displayed in blue, or any other GEs that have been 
selected with the mouse.

GE Bank Displays can be opened by double-clicking a GE Bank Row in the Main Window’s KDF Area, or clicking the round 
triangle button to the left of the GE Selection popup menu at the top of the GE Editor, which switches to the GE Bank 
Display containing the currently loaded GE.

When a GE Bank Display is in front, you can navigate around it and change the currently loaded GE by using the arrow keys 
on the computer keyboard. Pressing an arrow key while holding down the option key (Mac) or alt key (Win) will bring up 
the Rename Selected GE Dialog, the same as opt/alt+clicking or using the “Rename Selected GE...” utility below. 

You can also use the Edit Menu when GE Bank Displays are in front. You can select multiple GEs with the mouse (or all of 
the GEs in a bank with Cmnd+A (Mac) or Ctrl+A (Win)), and Cut, Paste, Copy or Clear the GEs using menu commands.
<1181>

GE Bank Name
Displays the name and number of the bank. Banks can be renamed using the appropriate commands in the Main Window’s 
Menu Button or the Menu Button in the Bank Display.
<1180>

GEs In Bank
Click to select and load a GE. Shift+click to select more than one (for cutting and pasting or initializing). Shift+click and 
drag to select ranges. Ctrl+click (Mac) or c+click (Win) and drag to draw a marquee around areas. Colored labels can be 
attached to GE names to help with organization, using the Menu Button’s “Set Label” command.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with the GE Bank Display:
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(Click on the links for detailed information on utilities not fully explained here.)

Load GE Options…<Prefs/GELoad>
Opens the Preferences Dialog to the General tab, where the Load GE Options settings can be found.

Initialize Selected GEs…
Initializes the selected GEs in the bank to a default starting point (shift-click to select more than one). You will be 
presented with the Initialize Current/Selected GE dialog where you can choose one of the existing RTC Model types for the 
initialized GEs. <GEUtils/Init>

Rename Selected GE...<OthDlg/Bdr>

Filter Display By Category …<GBD/Fbc>

Filter Display By RTC Model Type …<GBD/Fbr>

Find GE By Name...<OthDlg/FBN>

Performance Info<Pfi>

Rename This Bank...<OthDlg/Brn>

Delete This Bank…
Deletes the GE Bank from the current KDF File and closes the Bank Display. You will be given a chance to cancel if desired.

Initialize This Bank…
Initializes all GEs in the bank to a default starting point. You will be presented with the Initialize Current/Selected GE 
dialog where you can choose one of the existing RTC Model types for the initialized GEs.
<GEUtils/Init>

    Deleting or initializing a bank cannot be undone, so the only way to restore data after this is to reload the KDF File 
from disk.

 

Set Label (sub-menu)
Allows you to affix a colored label to the selected GEs, for organizational purposes, such that they are displayed in the 
various menus where you can view and select them.

Page 63



Clear Labels In Bank…
Clears any colored labels from all GEs in the bank. You will be given a chance to cancel if desired.

Count Labeled Items In Bank
Displays the following dialog, showing how many GEs in the bank are labeled with the various colored labels. This can be 
useful during development - for example, if you have various GEs in various states of completion labeled with different 
colored labels, you can quickly count how many of each state are completed.

 

<Param>
Bank Display (GEs) - Parameters
 

<1179>
    [Bank Type] (popup menu) [0...31, A...Z, AA...FF]

Sets the Bank Type of the GE Bank. For KARMA Motif this has no particular effect other than being used by the software 
as an internal identifier - so you should generally not have more than one bank of any given type in a KDF file. Each bank 
should be set to a unique Bank Type.
<1178><Lock>
    [Bank Lock Icon] (button)

Displays the lock status of the bank (red = locked, yellow = unlocked). Click to change the status. Locked banks present a 
warning dialog if you attempt to edit any data in them, in order to protect the data from accidental overwrites.

    You can lock/unlock multiple banks at the same time using the Main Window’s Menu Button “Lock/Unlock Selected 
Banks” command.

<Fbc><1840>
Bank Display (GEs) - Filter Display By Category
 

The Filter Display By Category dialog allows you to filter the GE Bank Displays to highlight GEs based on category and 
(optional) subcategory, easily identifying those that belong to certain groups. Opened by the corresponding command in the 
Bank Display’s Menu Button, you can select a specific category and subcategory, and have the contents of any GE Bank 
Displays instantly highlight the GEs with those criteria.
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The diagram above shows the results of choosing the “Gated” category and “Complex” subcategory on a Bank Display 
window that is behind it - GEs belonging to that type are highlighted by dimming all other GEs in the display. The 
subcategory choice is optional and can be left as off (the default), showing all GEs in the category - or you can use it to 
narrow the choices down further. (Each category has potentially different subcategories; for example, most have 
“Simple” and “Complex”, while the Drum category has 10 different subcategories.)

You can close the dialog and leave the filtering in place; open it again to remove the filtering and return the Bank Displays 
to their normal appearance.

    You can still choose other GEs while the Bank Displays are in this state; only the display of the GE names is affected.
<1841>
    [Choose Category] (popup menu) [number of Categories]

Selects a category to use when filtering the GE Bank Displays.
<1842>
    [Choose Subcategory] (popup menu) [number of Subcategories]

Selects a subcategory to use when filtering the GE Bank Displays. The subcategory choice is optional and can be left as off 
(the default), showing all GEs in the category - or you can use it to narrow the choices down further. (Each category has 
potentially different subcategories; for example, most have “Simple” and “Complex”, while the Drum category has 10 
different subcategories.)
<1843><1844>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog and returns to the previous settings that were in use before the dialog was 
opened. The OK Button (green checkmark) closes the dialog and accepts the current settings to use for filtering GE Bank 
Displays.

<Fbr><1836>
Bank Display (GEs) - Filter Display By RTC Model Type
 

The Filter Display By RTC Model Type dialog allows you to filter the GE Bank Displays to hilight GEs based on RTC Model, 
easily identifying those that belong to a certain type. Opened by the corresponding command in the Bank Display’s Menu 
Button, you can select a specific RTC Model Type, and have the contents of any GE Bank Displays instantly highlight the 
GEs with that type.

The diagram above shows the results of choosing the “GV1 - Gated Vel/Pat 1” RTC Model Type on a Bank Display that is 
behind it - GEs belonging to that type are highlighted by dimming all other GEs in the display.

You can close the dialog and leave the filtering in place; open it again to remove the filtering and return the Bank Displays 
to their normal appearance.

    You can still choose other GEs while the Bank Displays are in this state; only the display of the GE names is affected.
<1837>
    [Choose RTC Model Type] (popup menu) [number of RTC Models]

Selects an RTC Model Type to use when filtering all GE Bank Displays. Any affected Bank Displays will update immediately 
without closing this dialog.
<1838><1839>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog and returns to the previous settings that were in use before the dialog was 
opened. The OK Button (green checkmark) closes the dialog and accepts the current settings to use for filtering GE Bank 
Displays.
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<1593><1594><1595><1596><1597><1598><1599><1600><1601><1602><Top>

Bank Display (Templates)
Sections in this chapter:

Overview<TBD/Over>

Parameters<TBD/Param>

Individual Template Banks<TBD/Ind>

About Templates<TBD/About>

 

<Over>
Bank Display (Templates) - Overview
The Bank Display Editor can display any bank of data from the KDF Area of the Main Window. Double-clicking a row in the 
KDF Area switches to the Bank Display Editor (if it is not already showing) and displays the bank in the center of the 
Editor Display Area. <SWGUI/KDF>

Three types of bank data can be viewed in the Bank Display Editor: Performances, GEs (Generated Effects), and 
Templates. This chapter discusses the Bank Display Editor when a Template Bank has been displayed. See also:

Bank Display (Performances) <PBD>

Bank Display (GEs) <GBD>

A Template Bank Display can be opened for any bank of Templates in the current KDF file - and you can have up to 6 banks 
of Templates in a KDF file. As shown above, the Bank Number and Bank Name are displayed at the top. Template Bank 
Displays can be opened by double-clicking a Template Bank Row in the Main Window’s KDF Area, or clicking the round 
triangle button to the left of the Templates Selection popup menu at the upper right of the GE Editor, which switches to the 
Template Bank Display containing the Templates used by the currently loaded GE.

As shown in the image above, the bank represents an entire set of the various Individual Template Types used within 
KARMA - Rhythm Templates, Duration Templates, Velocity Templates etc. The different Template Types are assigned and 
used from the page with which they are associated. For example, Rhythm Templates are associated with the GE Editor > 
Rhythm Page. For more information, see About Templates below. You can copy and paste whole Template Banks from one 
KDF file to another by selecting the corresponding row in the KDF File and using the Edit Menu’s commands.
<TBD/About><1603>

Template Bank Name
Displays the name and number of the bank. Banks can be renamed using the appropriate commands in the Main Window’s 
Menu Button or the Menu Button in the Bank Display.

Individual Template Banks (Per Type)
A button exists for each type of Individual Template within a bank of Templates. Clicking the buttons open Individual 
Template Banks as explained below. <TBD/Ind>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with the Template Bank 
Display:
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(Click on the links for detailed information on utilities not fully explained here.)

Rename This Bank...<OthDlg/Brn>

Delete This Bank…
Deletes the Template Bank from the current KDF File and closes the Bank Display. You will be given a chance to cancel if 
desired.

<Param>
Bank Display (Templates) - Parameters
 

<1592>
    [Bank Type] (popup menu) [0...5, A...F]

Sets the Bank Type of the Template Bank. For KARMA Motif this has no particular effect other than being used by the 
software as an internal identifier - so you should generally not have more than one bank of any given type in a KDF file. 
Each bank should be set to a unique Bank Type.
<1604>
    [Bank Lock Icon] (button)

Displays the lock status of the bank (red = locked, yellow = unlocked). Click to change the status. Locked banks present a 
warning dialog if you attempt to edit any data in them, in order to protect the data from accidental overwrites.

    You can lock/unlock multiple banks at the same time using the Main Window’s Menu Button “Lock/Unlock Selected 
Banks” command.

<Ind><1605>
Bank Display (Templates) - Individual Template Banks
 

An Individual Template Bank Display Window can be opened for any type of Individual Templates in an open KDF File. Unlike 
the other Bank Display types, which are shown in the center of the Bank Display Editor, these are floating windows that 
open up on top of the sections of the GE Editor with which they are associated. In other words, a Rhythm Template Bank 
Display Window will be displayed on top of the GE Editor > Rhythm Page, and so on. Once shown, they can be closed in the 
normal way with the window’s close button; they will also close automatically when any other window (including the Main 
Window) is brought to the front.

As shown above, the Bank Number, Bank Name and Template Type are shown in the title bar (Mac OS X shown; Windows is 
similar). The window displays the 64 Templates in the bank in gray. The currently selected Template will be displayed in 
yellow, or any other Templates that have been selected with the mouse.

Individual Template Bank Display Windows can be opened by clicking the appropriate button within a Template Bank 
Display, which then switches to the associated GE Editor page and opens the Individual Template Bank above it. For 
example, clicking the “Rhythm Templates” button in a Template Bank Display will switch the Main Window to the GE 
Editor > Rhythm Page, and then open the bank of Rhythm Templates in front of it. Individual Template Bank Display 
Windows can also be opened by clicking the round triangle button to the left of the Templates menu within the various GE 
Editor pages that have Templates, such as the Rhythm Editor, Duration Editor, etc. <TBD/Top>

When an Individual Template Bank Display Window is in front, you can navigate around it and change the currently loaded 
Template by using the arrow keys on the computer keyboard. Pressing an arrow key while holding down the option key 
(Mac) or alt key (Win) will bring up a Rename Template Dialog, the same as opt/alt+clicking.
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You can also use the Edit menu when Bank Display Windows are in front. You can select multiple Templates with the mouse 
(or all of the Templates in a bank with Cmnd+A (Mac) or Ctrl+A (Win)), and Cut, Paste, Copy or Clear the Templates using 
menu commands.

    The first location in each Individual Template Bank is a special item named [As Stored]. It is used to restore the 
parameters of the template to those that are actually stored in the GE. This means that each GE can have its own stored 
patterns, they can be replaced by selecting different templates (by real-time control for example), and they can then be 
restored by choosing the [As Stored] item. Therefore, it is not possible to store a template in this location, or clear it, or 
rename it.

Templates In Bank
Click to select and load a Template. Shift+click to select more than one (for cutting and pasting or clearing). Shift+click 
and drag to select ranges. Ctrl+click (Mac) or c+click (Win) and drag to draw a marquee around areas.

Menu Button
A popup menu allowing instant access to this help chapter.

<About>
Bank Display (Templates) - About Templates 
Certain of the parameters in the various GE Editor pages can be saved as a “Template” for a specific KARMA attribute, 
such as rhythm, duration, velocity etc. In general, a Template stores the settings of the particular pattern grid in the 
selected Phase, and some associated parameters. This can be useful for Templates that you use often, or that you like to 
use as a starting point for further experimentation, or to maintain a library of Templates. Furthermore, Templates can be 
switched in real-time when they are assigned as RT Parms, causing radical changes in what is being generated. In most of 
the GEs, one or more Individual Template Types are assigned as RT Parms, and can be varied in real-time and stored in 
the scenes, so that you can completely change the contents of various pattern grids instantly - selecting from up to 64 
different Rhythm or Index Patterns, for example.

There can be more than one bank of Templates in a KDF File (up to six). Each GE stores a reference to which Bank it is 
using, which is set by the Template Bank parameter in the upper right of the GE Editor. All Templates used in a GE must 
come from the same Template Bank - for example, you cannot use Rhythm Templates from one bank and Index Templates 
from another at the same time. <GE/0176>

The following GE Editor pages have Templates associated with them - click to go to the portion of the chapter dealing with 
the specific type of Individual Templates: <GE>

Rhythm<RhyEd/Template>

Duration<DurEd/Template>

Index<NteEd/Template>

Cluster<CluEd/Template>

Velocity<VelEd/Template>

CCs<POffEd/Template>

WaveSeq<WavEd/Template>

Drum<DrmEd2/Template>
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Note Maps
Sections in this chapter:

Overview<NteMap/Over>

Note Map Grid<NteMap/TGrid>

Parameters<NteMap/Parms>

Copy Note Map Dialog<NteMap/CopyTable>

Transpose/Shift Dialog<NteMap/Transpose>

Restore Note Maps Dialog<NteMap/Restore>

 

<Over>
Note Maps -  Overview
The Note Maps Editor allows a “final note shaper” to be applied at the end of the KARMA note generation process, within 
each Module of a Performance. The Note Map feature is a table of values implemented as a large grid (128 x 129), 
allowing any incoming MIDI note generated by KARMA (0~127) to be remapped to any other MIDI note (0~127), or filtered 
out (removed). Therefore, a diagonal line represents “linear/no change,” and what goes in is what comes out. Note Maps 
may also be referred to as “Note Map Tables” since they are essentially a table of values consisting of pairs of x,y 
values.

The Note Map feature can be useful for:

Drum GEs w/Drum data
• Filter out (remove) any note, or any number of notes from an existing GE drum groove.
• Remap any GE’s notes on a particular drum kit to sound good on another drum kit. 
• “Tame” and “limit” the effect of repeats w/ transpose on the drums, without affecting basic groove notes.
One thing that’s useful is to turn on Melodic Repeat on drums, with some sort of transpose value - it instantly creates 
additional rhythms with random drum notes. Many times, however, 98% of what is being created is cool except there’s a 
Cuica, Crash, Vibraslap or some other weird note in there that spoils the whole effect, so it’s not usable. Since the Note 
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Map can operate on “All Notes”, “Main Notes Only”, or “Repeat Notes Only”, it becomes simple to just limit/remove 
the bad notes coming from the repeats, and leave all the rest of the syncopation that sounds cool.
• Real-time modifications
Since “Note Map Mode (On/Off)” and other parameters can be assigned as RT Parms, the Note Map can be used in 
real-time to drop out the snare, change snare to sidestick or hi-hats to rides, change the drum kit into a completely 
different mapping for a different scene, etc. It’s true that some of this may already be programmed into the GE, but this 
allows it to be applied to any GE after the programming is already finished. You’ll find that the Factory Performances that 
we provide make extensive use of this feature, by having Slider 5 in the Master RT Control Layer almost always be 
assigned to “Alternate Drum Map”, switching between a large number of Note Maps that completely alter which drums 
and cymbals are being played in each scene.

Melodic GEs (GE Type = Riff, Gated, Real-Time, or Drum GEs with note data)
• Thin out overall note activity, on all notes, just repeated notes, or just main notes.
• Remap or remove certain undesirable tones.
For example, say you have created a groove or effect where you like everything except there is a Major 7th when you 
play a straight major chord (for example), and there’s no way to edit or modify the GE to remove it. You can easily do 
this in every octave of the Note Map, and remap the 7th to some other more desirable note (which maintains the activity), 
or remove it completely (which leaves a space or rest instead).
• Get two or three (or more) completely different phrases out of the same GE.
This is done by mapping all input octaves of the Note Map to a single output octave or two (i.e. all input notes are mapped 
to notes in the range C2 to C3). Setup up different mappings in different octaves of the X values (left to right). Then, by 
varying in real-time the transpose octave of the input notes, target the selection of different parts of the Note Map to 
generate the output notes. Change the octave of the transpose, and get a different phrase (since it runs through a different 
octave of the Note Map).
• Run different Modules simultaneously through different areas of the same Note Map.
In the “Kbd Track (C2 Ref)” mode, you can use the Module transpose and other GE transposes to move modules to 
different areas of the Note Map, and then use the Timbre’s pitch transpose to bring them back to the normal range, so that 
different modules can essentially have their own area of the Note Map to run through. In other words, you could transpose 
the Bass GE down by -24, which would run it through the octaves of the Note Map at C0->C2, and then put the timbre’s 
pitch transpose at +24. Then you could run an additional module through the Note Map, which would be using C3->G7, and 
the two modules will not conflict with each other, yet each have their own range inside the single Note Map.

As summarized in the diagram above, the Note Map Editor can be divided into the following sections:

Note Map Grid
A single Note Map displayed graphically on a large grid, with various generated note displays running down the sides and 
across the top. You can click on individual cells to edit them.

P a r a m e t e r s
Options that affect certain characteristics of the Note Map Grid, allow individual cells to be edited numerically, and allow 
Note Maps to be restored or compared.

Keyboard Display
A graphic across the bottom of the Note Map Grid that displays incoming MIDI notes, and also can be clicked to locate a 
particular note to edit.

Reference Labels
Indicators showing the octaves of the Note Map and other useful information. Whether the labels reference Middle C as C3 
or C4 is controlled by the “Middle C Display” option in the Preferences - Workspace settings.
<Prefs/MidC>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this Editor:
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(Click on the links for detailed information on utilities not fully explained here.)

Rename Note Map…
Allows you to rename any of the Global Note Maps (the Custom Note Map cannot be renamed).

Copy Note Map…<NteMap/CopyTable>

Transpose Note Map By…<NteMap/Transpose>

Shift Note Map By…<NteMap/Transpose>

Restore This Note Map…<NteMap/Restore>

Restore All Note Maps…<NteMap/Restore>

Import Note Maps From KDF...
Opens the Standard File Select dialog, allowing you to locate a KDF file from which to read Note Map data. All of the Note 
Maps in the current KDF file will be replaced by the data from the selected KDF File.

<TGrid><1781><1782><1791><1792><1793><1794><1795><1796><1798><1799>
Note Maps - Note Map Grid
 

    [Note Map Grid] (128 columns by 129 rows)

The Note Map is a table of values implemented as a large grid, allowing any incoming MIDI note generated by KARMA 
(0~127) to be remapped to any other MIDI note (0~127), or filtered out (removed). You can click on any cell in the Note 
Map to change it, and use the command-key (Mac) or control-key (Win) to connect cells and draw straight lines, as well as 
using the numerical fields in the Parameters are to edit individual cells by number or note.

As shown in the diagram above, there are a number of different graphic indicators to help you determine which notes you 
are remapping. Contrasting gray shading is used to indicate octaves - each “checkerboard square” is an octave. The 
darker square of 5 octaves in the center corresponds to the 5 octaves of a 61 note keyboard (minus one note). Reference 
labels down the side show each octave, Middle C, and the “Kbd Tracking Reference,” which relates to the use of the Kbd 
Track parameter in the Performance Editor > Control Page.
<CtlEd/ParmsNM>

The X-axis of the Note Map (the columns) represent the pitch of the incoming notes, and the Y-axis (the rows) represent 
the pitch the the note will be remapped to. The bottom row is labeled “Remove” and allows any note to be filtered out of 
the final output. When you click on the grid with the mouse, the note at the current X value (left to right) is mapped to the 
note at the Y Value (bottom to top). The last clicked “cell” in the grid is displayed in the “In (X)/Out (Y)” fields to the 
left for info or easier editing (see below). If “Show Crosshairs” is turned on, a red set of marks will surround the 
currently selected note. 
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The “Linear Diagonal” line represents “no remapping” - notes positioned on this line leave the Note Map with the same 
pitch as they enter it. When notes are moved off the diagonal line, faint markings in the grid show the original diagonal 
line. “Remapped Notes” are any notes that are off the Linear Diagonal line. As the GE is playing in real-time, incoming 
notes will blink in the Keyboard Display at the bottom, the generated notes will blink blue in the LED Tracking Arrays down 
each side and across the top. The generated notes will also blink the cells black on the Note Map Grid itself, allowing you to 
find the notes in the map that are currently sounding. 

    The real-time blinking of the Note Map Grid, Keyboard Display, and LED Tracking Arrays while notes move through the 
Note Map will only happen if the Note Map being displayed and edited is the one that is selected in the Current Edit Module, 
on the Performance Editor > Control Page. <CtlEd/ParmsNM>
<1797>

    [Keyboard Display] (clickable graphic)

Displays incoming MIDI notes as they enter the Note Map. Clicking on the graphic plays the corresponding note (when 
“Audition Note” is on), and selects that X/Y value for display and editing in the “In (X)/Out (Y)” fields below.
<Parms>
Note Maps -  Parameters
 

The parameters in this area control some aspects of the display, allow you to specify an incoming and outgoing note 
directly instead of clicking on the grid, and allow you to edit multiple common notes in different octaves to the same 
relative pitch.
<1800>

    [Module] (label)

Displays the current edit Module using the displayed Note Map.
<1783>
    [Note Map] (popup menu) [0 = Custom, 1...64 = Global]

Chooses the single “Custom” Note Map in the current Performance, or one of the Global Note Maps. It is then loaded into 
the grid for display and editing.
<1784>

    [Show Crosshairs] (checkbox) [Off, On]

When on, clicking in the grid (or using the In (X)/Out (Y) fields) will display a set of “crosshairs” surrounding the last 
clicked intersection. This can help you more easily locate the values being edited.
<1785>
    [Audition Note] (checkbox) [Off, On]

When on, clicking on the grid (or using the In (X)/Out (Y) fields) plays the note that is being edited. Clicking in the 
Keyboard Display along the bottom will also select and play the note.
<1786>

    [Octave Replicate] (checkbox) [Off, On]

When on, any edit you make with the mouse within an octave will be made in every octave. This also applies to the In 
(X)/Out (Y) edit fields. This is mainly for applying the Note Map to Melodic GEs, where you want to do something like 
remove every minor third, remap every fourth to a fifth, etc., and have that change take place in every octave.
<1787><1788>
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   [In (X)/Out (Y)] (numericals) [0...127, 0...128]

These fields allow you to select any “X/Y” pair on the grid and modify it. You can type MIDI Note Numbers (i.e. 36) and it 
will turn them into Note Names, or you can type the name directly (i.e. C4). If you click on the Note Map Grid with the 
mouse, the current X/Y value is displayed here for easy editing. When either one of the value fields is selected, you can 
scroll with the mouse or use the up/down arrow keys to increment/decrement by one, or hold down the arrow keys for 
continuous advancement. Clicking in the Keyboard Display along the bottom will also select that note for editing.
<1789>
    [Reset] (button)

Resets the current Note Map to the “Linear Diagonal” (no change in pitch to any notes).
<1790>

    [Compare/Restore] (button)

When a Note Map has been edited, the Compare button becomes available, and will restore the previous state of the Note 
Map when clicked. At that time, the button changes to “Restore,” and clicking it again will go back to the edited state. 
Once you select another Note Map for viewing, any edits are “accepted” and the button is again grayed out.

    IMPORTANT: When you edit one of the Global Note Map Tables (anything other than “Custom”) and switch to another 
table, it is permanently edited in the KDF in RAM, and you cannot restore it unless you reload the KDF (or use the 
“Restore” commands in the Menu Button). The “Custom” table is stored in the Performance and therefore can be 
restored (if necessary) by reloading the current Performance.

<CopyTable><0587>
Note Maps -  Copy Note Map Dialog
 

The Copy Note Map Dialog allows you to copy a Note Map from one location to another. It can be opened by the “Copy Note 
Map...” command in the Note Maps Editor Menu Button. The most common use of this utility is to copy one of the Global 
Note Maps into the Custom Note Map, where you can modify it for other purposes. If you try to copy the other way, into 
one of the Global Note Maps, you will receive a warning dialog advising you that you may not want to proceed (since this 
could affect other Performances that may rely on the current Global Note Maps).

    You can also copy a Note Map simply by using the Edit Menu Copy command while the Note Map is showing, then go to 
the desired destination map and use Edit Menu > Paste.
<0585>
    [Source] (popup menu) [0: Custom, 1...64: Global Note Maps]

Selects the Note Map that you wish to copy to another location.
<0586>
    [Destination] (popup menu) [0: Custom, 1...64: Global Note Maps]

Selects the Note Map location that you wish to replace with the copy.
<0588>

    [Execute] (button)

The Execute Button (three green arrows) performs the specified copy operation without closing the dialog, in case you 
want to perform other operations.
<0589><0590>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing the copy operation. The OK Button (green checkmark) 
closes the dialog and performs the specified copy operation.

<Transpose>
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Note Maps -  Transpose/Shift Dialog
 

The Transpose or Shift Dialog can move the entire Note Map up or down, left or right by a specified number of semitones. 
It is a form of the generic Specify Value Dialog. The dialog is accessed by two different Note Maps Editor Menu Button 
commands, which operate slightly differently: <OthDlg/SpecVal>

Transpose Note Map By…
Moves all of the the cells in the Note Map up or down by the specified number of semitones. You can use this to change the 
octave of melodic GEs while keeping a certain mapping intact.

Shift Note Map By…
Moves all of the the cells in the Note Map “diagonally” by the specified number of semitones. In other words, cells will be 
shifted both up and to the right, or down and to the left, at the same time - which is especially useful for drums. For 
example, say you had a Note Map set up to remap a specific Drum Kit. If you transposed the Drum Voice up by an octave, 
the Note Map would no longer match the Drum Kit. You would then use this function to Shift the Note Map up and to the 
right by +12 semitones, at which point it would again work correctly with the transposed Drum Kit.

    You can also transpose or shift the Note Map using the computer keyboard. With the mouse over the Note Map Grid, 
hold down the following keys (the cursor turns into a four-directional arrow) and used the arrow keys to move the entire 
Note Map up or down by one row, or left or right by one column at a time:

          [shift] + [opt] + [cmnd] + arrow keys (Mac)
          [shift] + [alt] + [ctrl] + arrow keys (Win)

<Restore><0709>
Note Maps -  Restore Note Maps Dialog
 

The Restore Note Maps Dialog can restore a single Note Map or all Global Note Maps at the same time, from either the last 
saved version of the current KDF file, or the Factory Default settings. The dialog is accessed by two different Note Maps 
Editor Menu Button commands, which operate slightly differently:

Restore This Note Map…
Will replace only the currently selected Note Map that is being viewed in the Note Maps Editor. This includes the Custom 
Note Map in the current Performance as well as any of the 64 Global Note Maps. The title of the dialog will show “Restore 
This Note Map”.

Restore All Note Maps…
Will replace all 64 Global Note Maps. Will not replace the Custom Note Map of any Performance, including the currently 
loaded one. The title of the dialog will show “Restore All Note Maps” (shown above).
<0710><0711>

Two different options are provided for selecting where the restored Note Maps will come from:

    [From Last Saved Version Of KDF] (radio button)

The Note Map or Note Maps will be restored from the last saved version of the current KDF file on your hard drive. This 
would be essentially the same as closing and reloading the current KDF file without saving any changes to the Note Maps. 
You could use this if you modified one or more Global Note Maps, had not yet saved the changes to the KDF file, and wanted 
to restore them to what they were previously.

    [From Factory Default] (radio button)

The Note Map or Note Maps will be restored from the factory default settings. This would be the same as restoring them 
to the versions included in the original unaltered Factory Preload KDF file.
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<0712><0713>
    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any modifications to the Note Maps. The OK Button (green 
checkmark) closes the dialog and restores the specified Note Map or Note Maps. This cannot be undone other than by 
reloading the current KDF file.
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Import To GE
Sections in this chapter:

Overview<ImpGE/Over>

Import & Store<ImpGE/Import>

Parameters<ImpGE/Parms>

 

<Over>
Import To GE -  Overview
The Import To GE Editor is where you can import short phrases and turn them into GEs. The imported data should be in 
Standard MIDI File format (SMF) on your computer (typically ending in .MID) - note that most keyboard and DAWs are 
capable of exporting data from the sequencer in this format. You can then edit the GEs further and build Performances 
with them.

When you import a file, the data is kept in memory temporarily so you can repeatedly try different settings if you want. 
The Analysis Area shows how the data will be mapped to the Drum Pattern grids, how many rows will be used in each 
grid, velocities of notes and various other useful information - and the “prediction” changes when you change settings, so 
you can “optimize” the results. You can switch to the GE Editor > Drum Page and see the results of the conversion 
immediately after pressing Execute.

Be sure to consult the included tutorial on “Creating GEs with the Import To GE Editor” for detailed examples of how to 
use this editor.

    At this time, the best results are obtained by performing any melodic phrases in the key and tonality of CMajor or 
CMajor7.
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�   The “Import To GE Editor” is somewhat limited in scope, and will be enhanced in future versions. However, it is 
important to note that the relationship between a GE and a sequenced phrase is slim at best. Do not expect these functions 
to magically translate every nuance of a sequenced phrase into a GE. This is impossible and actually counter-intuitive to 
the nature of KARMA. If you want a sequenced phrase to sound like a sequenced phrase, use a sequencer. These functions 
exist to allow you to easily get some basic notes and settings into a GE. From there, you may need to work with it further 
to achieve the results that you want. However, you may also immediately apply KARMA’s variation-generating magic to 
the phrase, which is not possible with a sequencer.
<1738>
Analysis Area
Shows a representation of how the data will end up once it is imported. This will change in real-time as you change 
various parameters, so you can optimize the results of the import operation.

P a r a m e t e r s
The various parameters that influence how the imported phrase is mapped to a GE.

Import & Store
Allows you to import Standard MIDI Files from your computer, after which you can play them and turn them into GEs.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this editor:

 

Clear Data In Memory
Clears the last loaded SMF data in memory and resets the Analysis Area to the “empty” state.

<Import>
Import To GE -  Import & Store
 

This section of buttons and menus near the bottom of the window allows you to import short phrases and turn them into 
GEs, storing them in the current KDF file. The imported data must be in Standard MIDI File format (SMF) on your computer 
(typically ending in .MID).
<1740>

    [Select New File] (button)

Opens the Standard File Select dialog where you can locate a Standard MIDI File on your computer’s hard drive. After 
answering OK, the data is imported into memory and an analysis of the results will be shown in the Analysis Area. You 
may then change the parameters to better optimize the results. When you are ready, press the Execute button and the data 
will be turned into a GE in the specified location.
<1742>

    [Play Original] (button)

Once a section of data has been loaded into memory, the Play Original button allows you to hear the data played back for 
comparison purposes. For example, you could use this to listen to a drum groove while gaining an understanding of what is 
printed in the Analysis Area. 

    This is not a 100% accurate reproduction as it plays back with a resolution of 24 cpq, but it’s good enough for 
reference.
<1743><1744>

    [GE Bank]
    [GE Location]

The GE Bank and GE menus allow you to choose a location in which to store the GE that you will be creating. This should 
generally be a location within an unlocked GE User Bank, not one of the locked GE Factory Banks. If a bank is not available, 
you can use the “Add Bank” command from the Menu Button of the Main Window. Once you press the Execute button, the 
GE will be stored into the specified location, with the name of the data that was imported. You can change this name by 
using the “Save” button at the top of the GE Editor, or renaming it in the appropriate GE Bank Display.
<1746>
    [Open GE Bank Display] (button)

The round triangle button opens a GE Bank Display for the selected bank of GEs.
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<GBD><1712>
   [Execute]
Once the Analysis Area looks good to you, pressing the Execute button causes the GE to be created in the specified GE Bank 
and Location. You can immediately go to the GE Editor > Drum Page and see the results, while triggering the new GE from 
the keyboard or Chord Triggers and experimenting with the real-time control possibilities in the Real-Time Control 
Window.

    If the results aren’t as intended after executing the Import, just try it again with different settings. You can continue 
overwriting the same GE location until the results are satisfactory.

<Parms>
Import To GE -  Parameters
 

<1714>
    [GE Type] (popup menu) [0...3]

Selects a specific type of GE to create. Presently, a Generated-Drum GE (with melodic or drum data) is the only option.

    Just because it is “Generated-Drum” doesn’t mean you cannot create melodic phrases. Actually, some of the more 
interesting melodic effects you can create with KARMA come from using the Drum Patterns with Note Data.
<1710>

    [Interpretation] (popup menu) [0…1]

When the GE Type being created is “Generated-Drum,” this specifies whether to treat the data being imported as a drum 
groove, or melodic phrase data. This enables different options in the area below, as well as chooses which type of RTC 
Model will be applied to the data at the end of the process.

0: Drums
Specifies that the resulting GE will be used to generate a drum or percussion groove, will be assigned an RTC Model of 
“DP1 – Drum/Perc 1,” and will be in a “fixed position” such that changing input note data does not cause the pattern to 
transpose.

1: Melodic
Specifies that the resulting GE will be used to generated melodic phrase data, will be assigned an RTC Model of “DM1 – 
Drum Melodic 1,” and will change keys and chords depending on input note data.

    When this is changed, the settings of all other parameters are returned to default settings, which are somewhat 
different for Drum vs. Melodic.
<1713>
    [Quantization] (popup menu) [0…7 = Off, 32nd…Qtr]

Sets the rhythmic division to which the imported data will be quantized before being assigned to the Drum Pattern Grids. 
This should generally be longer than or equal to the Division setting.
<1715>
    [Division] (popup menu) [0…7 = Off, 32nd…Qtr]

Sets the rhythmic value of a step in the resulting GE’s Drum Patterns and Rhythm Patterns. This should generally be 
shorter than or equal to the Quantization setting.
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�    Quantization and Division are related to and dependent on each other. Generally, you will want them to be the same, for 
example, both set to 16th, such that each step in the resulting Drum Pattern is a 16th, and you’ve quantized the imported 
data to 16th notes as well. A Drum Pattern would therefore be a maximum of 4 bars long (64 steps / 16 = 4 bars). For 
patterns containing 32nd notes, you would set them both to 32nd, and the resulting Drum Pattern would be 2 bars in 
length, and run twice as fast. You might use them set differently if you wanted a pattern containing 16ths to end up with 
32nd resolution in the GE, for example, and the data was a bit sloppy in timing.
<1716>
    [Import Bars] (popup menu) [0…1]

Indicates which bars of the pattern to import. For example, when a drum groove is 8 bars with a fill at the end, if you 
only import the first 4 bars, you will not get the fill. If you apply this to an 8 bar phrase, you will get a 4 bar phrase with 
the beginning and end of the phrase. If you apply this to a 4 bar phrase, you would end up with a 2 bar phrase, and so on.

0 x x x x  = import bars sequentially, however many will fit.
1 x - - x   = import the first part of the pattern, and the fill at the end.

This works in conjunction with the “Phase Pattern” below.
<1717>
    [Phase Pattern] (popup menu) [0…3]

When importing an 8 bar pattern with a fill at the end (for example), you end up with a 4 bar phrase in the Drum Grids (at 
16th note resolution). But you can set the Phase Pattern Drum “pr” (pattern restart) buttons to simulate the 8 bar 
phrase, for example by restating the pattern and playing the first half 3 times, followed by the second half, which creates 
an 8 bar phrase with the fill at the end.

0 x-x-x-x-x-x-x-x-  =  retriggers the pattern every 2 bars of 4/4

1 x-x-x-x-x-x-x---   =  makes a 16 bar phrase by retriggering every 2 bars
                              except in bar 15, which then lets the fill play

2 x-x-x---x-x-x---   =  makes an 8 bar phrase by retriggering every 2 bars
                               except in bars 7 and 15, which then let the fill play

3 x---x---x---x---   =  retriggers the pattern every 4 bars of 4/4

So for example, when importing an 8 bar drum pattern with a fill at the end, you would set “Import Bars” to 1, and 
“Phase Pattern” to 2, and you will get something very close to the original pattern.
<1718>
    [Split Notes into 3 Patterns] (checkbox) [Off, On]

This controls whether the notes in the pattern will be split into the three different Drum Pattern grids using several 
different criteria, or simply allocated to the 21 available rows in the order they are found.

Off
The notes in the pattern are allocated according to pitch from the lowest to the highest, across the 21 rows, with row 1 
of pattern 1 receiving the lowest note, and row 7 of pattern 3 receiving the highest note.

On
The following two options become available:
<1720>
    [Split by Notes] (radio button)

Mainly for Melodic Data, it allows you to specify which note range of a pattern goes to which grid, so you could put the 
bass notes on one grid, the middle notes on another, and the high notes on a third. When this option is chosen, two split 
point fields (numericals) become available. By moving the split points around, you can change which notes end up on which 
grid - watch the Analysis Area while doing this.
<1719>

    [Split by Drums/Cyms/Perc] (radio button)

This selects the standard KARMA convention of attempting to allocate the notes to patterns as follows:

        Pattern 1: kicks, snares, toms
        Pattern 2: hi-hats, cymbals, rides
        Pattern 3: everything else (percussion)

When this option is selected, an additional parameter “Drum Map” becomes available (see below).
<1711>
    [Drum Map] (popup menu) [0…2]

When the “Split by Drums/Cyms/Perc” option is selected above, this parameter becomes available and allows you to 
select one of several different drum maps for splitting the data into 3 different patterns:

0: GM
Select this option when importing drum phrases created to go with a General MIDI drum kit.

1: GM +12 (Korg)
Select this option when importing drum phrases created to go with Korg drum kits.

Page 79



�2: Motif (Yamaha)
Select this option when importing drum phrases created to go with Motif/MOX drum kits.
<1721>

    [Note Split Threshold (Lo)] (numerical) [C-1...G9]

Specifies the highest note that will appear in Pattern 1. Notes above this value will appear in Patterns 2 and 3 according 
to the Note Split Threshold (Hi) setting below.
<1722>
    [Note Split Threshold (Hi)] (numerical) [C-1...G9]

Specifies the highest note that will appear in Pattern 2. Notes above this value will appear in Pattern 3.
<1723><1724><1725><1726><1728>
    [Split into 3 Rows by Velocity] (checkbox) [Off, On]

This allows a pattern to attempt to keep some of the velocity it was programmed with. Due to the structure of a GE, it’s 
not possible for each note to get the exact velocity it was programmed with from the imported data. But the various 
velocity options allow a close approximation to be achieved in most cases.

Off
Each note of a specific note number will take one row only in the resulting pattern, with a Row Velocity Offset 
corresponding to the accumulated average velocity (avgVel) of all the notes in the row across the whole pattern.

On
This controls whether each note is split into up to 3 rows (with different Row Velocity Offsets), based on several 
different velocity threshold settings. 

There are four different pairs of Velocity Thresholds that will be available depending on the setting of “Split Notes Into 3 
Patterns” (described above):

The first value of each pair is the “Low Threshold” – velocities lower than or equal to this value will be split to velLev[2] 
(in the Analysis Area). The second value is the “Hi Threshold” – velocities lower than or equal to this value will be split 
to velLev [1]. Velocities higher than the Hi Threshold will be split to velLev[0]. As a result, a single note number may end 
up in 1, 2 or 3 different rows, based on velocity, and the Row Velocity Offset for the Drum Pattern will be set according 
to the calculated average velocity for the row. By varying the thresholds while watching the Analysis Area, you can 
optimize how many rows end up in each pattern. (The Analysis Area shows the loVel and hiVel for each row, and the 
resulting avgVel.)

    By setting any two Thresholds to the same value, you can limit it to only 2 levels maximum per note, not 3.

When “Split Notes Into 3 Patterns” is Off:
The top pair of Velocity Threshold values is available, which allows each note to be split into 3 different rows based on 
velocity. The options for individual patterns will be grayed out.

When “Split Notes Into 3 Patterns” is On:
The top pair of Velocity Thresholds will be grayed out. Instead, each Pattern may have this feature turned on or off 
individually, and there is a separate set of Velocity Threshold values for each Pattern. You might turn one of them off if 
there are too many notes to fit into a particular pattern, but the other patterns have room for the velocity variations.

(Depending on the setting for “Interpretation” or “Split Notes Into 3 Patterns,” the labels will be different for these.)

Pat 1: Low/Drums
Split the notes that will go to Pattern 1 into up to 3 rows for each note based on the Velocity Threshold settings next to 
the label.

Pat 2: Mid/Cymbals
Split the notes that will go to Pattern 2 into up to 3 rows for each note based on the Velocity Threshold settings next to 
the label.

Pat 3: High/Perc
Split the notes that will go to Pattern 3 into up to 3 rows for each note based on the Velocity Threshold settings next to 
the label.
<1727><1729><1730>

    [Velocity Threshold (Lo)] (numerical) [1...127]

Velocities below this value will be split into a third row. Velocities equal to or above this value are subject to the Velocity 
Threshold (Hi) setting.

    [Velocity Threshold (Hi)] (numerical) [1...127]

Velocities below this value will be split into a second row (and possibly a third row according to the Velocity Threshold 
(Lo) setting). Velocities equal to or above this value are split into the first row.

    By setting the two thresholds to the same value, you can limit it to only 2 levels per note, not 3.
<1731><1732><1733><1734>
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�  [Create Velocity Pattern] (checkbox) [Off, On]

Allows a Velocity Pattern to be created from the analyzed data of the selected patterns, and applied to the selected 
patterns. For example, this can be used to try and get more nuance to the velocities of the kick and snare, or the hi-hats, 
or the percussion.

Basically, a recorded phrase or drum groove may have a lot of velocity nuances going on with the notes. KARMA is not 
able to accurately assign a velocity to each note; it is capable of assigning all instances of a particular note a velocity 
level, or in the case of using the “Split Into 3 Rows by Velocity” feature, assigning a note to up to 3 rows of the pattern 
with different Velocity Offsets. However, a Velocity Pattern can be applied to these rows with its own velocity offsets, 
imparting further velocity nuances onto the generated notes.

Off
A default Velocity Pattern is assigned to the Pattern Grid, but it is not activated for any Drum Patterns in the Phase 
Pattern Grid.

On
This attempts to create some kind of an overall Velocity Pattern based on the cumulative differences in velocity of the 
original notes in each column of the grids versus the actual velocity they will be performed with by the resulting GE. Note 
that selecting more than one pattern combines the analysis across those patterns, with less accurate results. Probably 
the best results are realized by only choosing one pattern to be affected by the Velocity Pattern.

(Depending on the setting for “Interpretation,” the labels will be different for these.)

1: Low/Drums
Include the notes for Pattern 1 in the analysis, and set the Phase Pattern to apply the resulting Velocity Pattern to 
Pattern 1.

2: Mid/Cymb
Include the notes for Pattern 2 in the analysis, and set the Phase Pattern to apply the resulting Velocity Pattern to 
Pattern 2.

3: High/Perc
Include the notes for Pattern 3 in the analysis, and set the Phase Pattern to apply the resulting Velocity Pattern to 
Pattern 3.
<1747>
    [Factor] (popup menu) [x1...x8]

Specifies a factor by which the analyzed velocity values are compressed before creating the Velocity Pattern. Use lower 
settings to spread out the values across the rows of the grid, or higher settings to compress the values closer to the top.
<1735>

    [Optimize Velocity Offsets] (checkbox) [Off, On]

Allows the velocities of the notes on the 3 patterns to be maximized up so that the full range of velocities can be 
generated based on how the GE is triggered and controlled. (Generally should be always on.)

Off
When set to off, the Row Velocity Offsets in the resulting Drum Pattern are set exactly as shown by the avgVel 
calculation in the Analysis Area. 

On
When set to on, the Row Velocity Offsets in each pattern are raised so that at least one of them is at 0, and then 
decreases the overall Pattern Velocity Offset, so that the end result sounds the same, but it is more logical when viewed, 
and allows greater control of the overall volume of each pattern by the normal GE RTP. In other words, instead of having a 
pattern with 3 rows at –20, -30, and –40, and a Pattern Velocity Offset of 0, this would raise the 3 rows to  0, -10, and 
–20, with a Pattern Velocity Offset of –20, which sounds the same. 
<1736>

    [Create Duration Pattern] (checkbox) [Off, On]

Allows the durations of the notes in the imported data to be analyzed, and a Duration Pattern to be constructed that 
attempts to replicate the durations of the original notes. Similar to Velocity information, the structure of a GE does not 
permit an exact capture of the duration information, as notes that occur at the same moment will always have the same 
duration, unlike the imported data. However, this can come close to the original in many cases. This is off by default for 
Drum Grooves, as it has no effect unless you were using a Drum Kit that has hold turned off. But for Melodic 
Interpretation, this can be very useful. The DM1 RTC Model that is applied to that type of GE provides Duration Control on 
one of the sliders, so you can adjust it further.
<1737>
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   [Assign RTC Model] (checkbox) [Off, On]

Allows the correct RTC Model to be applied to the GE after it is created. (Generally should always be on.)

Off
No RTC Model is applied. However, changes to the GE may still occur as part of the SMF Import process.

On
Automatically assigns the appropriate RTC Model after conversion. This is the recommended setting for compatibility with 
other GEs in the system. However, it is possible that a user may set up his own custom GE values and RTC assignments 
that he wants to keep when importing the pattern (as much as possible within the design of the feature.) However, for 
voicing that is compatible with the library of GEs included with KARMA, this should always be on.
<1739>

    [Default Settings] (button)

Restores all of the parameters to default settings, which are different depending on Melodic or Drum Interpretation. Use 
this to go back to the defaults. Changing the Interpretation setting will also return the settings to the defaults.
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Performance Info
 

The Performance Info Editor displays information about the current performance, including which GEs are being used, how 
many other times those GEs are used in other Performances, each GE’s etc. This can be useful, for example, when you 
wish to know if you are modifying a GE that may be used by other Performances. In addition to being opened by the 
“Performance Info” button at the top of the Main Window, you will also find it in the Menu Buttons in the GE Editor, 
Performance Editor, and GE and Performance Bank Displays.

Performance Info
This section displays information about the current Performance.

GE Info
A column for each of the six Modules displays information about the GE loaded in that Module, and other Performances that 
may be using it.

Menu Button
A popup menu allowing instant access to this help chapter.
<0898>
    [Bank] (label)

Displays the name of the Performance Bank containing the currently loaded Performance.
<0899>

    [Performance] (label)

Displays the name of the currently loaded Performance.
<0900>

    [Programmer] (label)

Displays the programmer name stored with the current Performance.
<0891>

    [Category] (label)

Displays the category assignment of the current Performance.
<0901>
    [Module Name] (label)

Displays a descriptive name for each Module, which can be assigned on the Performance Editor > GE Setup/Mix Page.
<0892>
    [GE Bank ] (label)

Displays the name of the GE Bank containing the GE that is loaded into the specified Module.
<0893>
    [GE] (label)

Displays the name of the GE that is loaded into the specified Module.
<0894>
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   [GE Programmer] (label)

Displays the name of the programmer that is stored with the GE.
<0895>

    [GE Category] (label)

Displays the category assignment of the GE.
<0902>

    [GE Subcategory] (label)

Displays the subcategory assignment of the GE.
<0903>
    [RTC Model] (label)

Displays the GE’s RTC Model type.
<0896>
    [Perfs Used In] (label)

Displays the total number of Performances in the current KDF file that reference the GE in the specified Module.
<0897>

    [Locations] (label)

Displays the location(s) of the Performances using the GE referenced by that Module, in the current KDF File. The format 
is bank.location, being one-relative. For example, 1.1 indicates the first Performance in the first Performance Bank; 2.5 
indicates the fifth Performance in the second Performance Bank. If there are more than will fit, the rest will not be 
displayed.
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<2051>

MIDI Setup (Global) Editor
Sections in this chapter:

Overview<MsuEd/Over>

 

<Over>
MIDI Setup (Global) - Overview
The MIDI Setup (Global) Editor contains most of the global MIDI settings for the application that are outside of the MIDI 
routing stored in each Performance, along with settings for external MIDI control, the Sync Page, the Metronome Page, 
and others. This is where you configure some overall preferences settings related to the MIDI operation of the application. 
The editor has a number of individual pages which can be displayed using the triangular Page Selection Buttons to the left. 
The parameter settings in this editor are stored in the application’s Preferences file.

The MIDI Setup (Global) Editor can be displayed by the following methods:
- pressing the “MIDI Setup (Global)” button in the top row of Editor Selection Buttons in the application’s Main Window;
- choosing “MIDI Setup (Global) Editor” from the Window Menu;
- using the keyboard shortcut Cmnd+U (Mac) or Ctrl+U (Win).

    Additional Preference settings for the workspace and non-MIDI related features can be found in the Preferences Dialog. 
<Prefs><2050>

Communication Status
Displays the current status of MIDI communication between KARMA software and the keyboard device. The message 
displayed will show “Yamaha Motif” for both XS and XF, and “Yamaha MOX” for both MOX and MOXF.
<2049>

MIDI Received LED
Flashes whenever MIDI data of any type is received on any open MIDI port. Open ports are determined by the MIDI Port 
Manager.
<MidPort><2052>

Page Selection Buttons/Page Display Area
Allow different groupings of parameters (pages) to be displayed in the Page Display Area. Each of the MIDI Setup (Global) 
Pages has a separate chapter in this manual describing their parameters and features.
<MIDISect>
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Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this editor:

 

MIDI Setup Assistant... - runs the MIDI Setup Assistant function directly. <MSA>

MIDI Port Manager... - opens the MIDI Port Manager. <MidPort>
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General
Sections in this chapter:

Overview<MsuGen/Over>

Global Parameters<MsuGen/Global>

Local Control/Bypass<MsuGen/Local>

Select Performances Remotely<MsuGen/SelectPerf>

Sequencing Reset<MsuGen/SeqReset>

Other<MsuGen/Other>

 

<Over>
General - Overview
The General Page of the MIDI Setup (Global) Editor contains the important Global Port and Channel settings that allow the 
application to communicate with the keyboard device. It also contains a number of other global settings related to the MIDI 
operation of the application - many of these will likely never need to be edited and are only of interest to advanced users. 
The parameter settings on this page are stored in the application’s Preferences file.

The General Page can be displayed by the following methods:
- clicking the “General” button in the Page Selection Buttons on the left side of the MIDI Setup (Global) Editor;
- choosing “General” from the “Pages” sub-menu underneath the “MIDI Setup (Global) Editor” item in the Window Menu.

    Additional Preference settings for the workspace and non-MIDI related features can be found in the Preferences Dialog. 
<Prefs>

Global Parameters
Settings that affect overall communication between the software and the keyboard device.

Other Parameter Groups
The page is divided into multiple separate sections, each of which is described below in more detail.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Restore Default Settings
Restores the settings on the General Page to the recommended default settings.

<Global>
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General - Global Parameters
 

These global settings tell KARMA which MIDI ports and channels to use to communicate with the keyboard device. This is 
used to change modes on the keyboard, select corresponding Songs, Voices and Performances, send parameters back and 
forth via SysEx, etc.

    KARMA requires that the appropriate keyboard device matching the application be physically located on the Global In 
and Out Ports and Channels, or it will not generate MIDI.
<2057><2059>
    [Global Input Port] (popup menu) [varies depending on the MIDI Ports on your computer]

Selects the MIDI Port that KARMA will use to receive communications from your keyboard device. The choices in this 
menu will be determined by the MIDI Ports on your computer. Enabled ports are determined by the MIDI Port Manager.
<MidPort><2060>
    [Global Input Channel] (popup menu) [1...16]

Selects the MIDI Channel that KARMA will use to receive communications from your keyboard device. This setting should 
be the same as the devices’s Global MIDI Channel setting.
<2058><2061>
    [Global Output Port] (popup menu) [varies depending on the MIDI Ports on your computer]

Selects the MIDI Port that KARMA will use to transmit communications to your keyboard device. The choices in this menu 
will be determined by the MIDI Ports on your computer. Enabled ports are determined by the MIDI Port Manager.
<MidPort><2062>
    [Global Output Channel] (popup menu) [1...16]

Selects the MIDI Channel that KARMA will use to transmit communications to your keyboard device. This setting should be 
the same as the device’s Global MIDI Channel setting.
<2063>
    [Global Device Type] (popup menu) [display only]

<Local>
General - Local Control/Bypass
 

These options allow you to control whether the software automatically controls the Local Control On/Off setting of the 
Motif/MOX, and what happens when you toggle KARMA’s Bypass setting (Options Menu) on and off.
<2066>

    [Automatic Local Control] (checkbox) [Off, On]

Off: You handle the settings of the Local Control on the Motif/MOX manually. The Keyboard Thru setting (on the Options 
Menu) specifies whether MIDI data is echoed to the Motif/MOX or not, in both normal use and when using Bypass.

On: When the software is launched, it will automatically send a Local Control Off message to the keyboard, and when you 
exit the software, a Local Control On message will be sent. When on, the following two operational choices are available:
<2064>

    [Bypass Toggles Local Control] (radio button)

Allows the keyboard’s Local Control setting to automatically follow the status of the Bypass setting (which is a command 
on the Options Menu). Bypass on sets Local Control on (so the keyboard works again), Bypass off sets Local Control off (so 
that the software can work properly.) The Keyboard Thru setting is ignored with this option.

Displays the overall type of device that you are using the software with. This will be preset to the type of device 
recognized on the Global Ports by the initial configuration procedure (or by running the MIDI Setup Assistant, or changing 
the Global Port Menus to another product manually).
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   [Bypass Sends Keyboard Thru If On] (radio button)

When Bypass is on, MIDI on the Global Channel will be echoed back thru to the keyboard (if Keyboard Thru on the Options 
Menu is on), allowing it to be played with Local Control Off. You would use this option if you wanted the Bypass feature to 
not change the Local Control On/Off status.

    IMPORTANT! If you use the keyboard without the software, and Local Control is set to off, the keyboard will appear to 
have stopped working (no sound). To use the keyboard without KARMA Motif, set Local Control back to on.

<SelectPerf>
General - Select Performances Remotely
 

These options allow you to use the Motif/MOX to remotely select Performances in the KARMA Software. When enabled, 
you can select a Song from the Motif/MOX’s bank buttons and have the correct Performance selected in the KARMA 
software. It presently only works in Song Mode, where the Motif/MOX sends Song Select messages, or Multi Mode for the 
Rack-XS, where Program Change messages are sent.

    In order for this feature to work properly, the Performance and corresponding song must have the same location. In 
other words, inside a Performance Bank, Performance 5 must be set up to load Song 5 (in the Performance Editor > Other 
Page). If you have Performance 5 set up to correspond to and load Song 10, selecting Song 10 in the Motif/MOX will load 
Performance 10, not Performance 5.

    You should never use this feature to change KARMA Performances while they are still running. The reason is that the 
Motif/MOX does not send the Song Select message until well after the Song has already been changed. So what can happen 
is that the previously playing KARMA performance may be generating panning and CC information, wave-sequence 
changes, etc. If you change to a different Song while KARMA is playing, it will continue generating MIDI for some short 
amount of time, which will be applied to voices and parts in the new Song. You will end up with parts panned incorrectly, 
voices sounding incorrect, even voices playing the wrong waveforms (if the previous Performance was using KARMA 
wave-sequencing).
<2067>

    [Select from Keyboard/Rack] (checkbox) [Off, On]

When on, selecting a Song from the Motif/MOX’s front panel will select the corresponding Performance in the software, if 
it is available. When the Rack-XS is being used, the text of the label changes to “Select from Rack,” and selecting Multis 
from the Rack’s front panel can be used to select KARMA Performances.
<2068>

    [Select from Other Controller] (checkbox) [Off, On]

When on, selecting a Song from an external controller (selected as Input in the Performance Editor > MIDI Setup Page) will 
select the corresponding Performance in the software, if available.

<SeqReset><2076>
General - Sequencing Reset
 

When recording a KARMA Performance into a sequencer (either the Motif/MOX’s internal sequencer, or an external DAW) 
using the “Control Track” method (explained elsewhere in the Tutorials), you often will change scenes and modify various 
KARMA Real-Time Control settings. When you play the recorded sequence back, it will not operate correctly if the 
Performance is not reset (reloaded) to its original starting point, since it will likely be in an edited state, set to a 
different scene, etc. Using the following option ensures that when the song locates back to the beginning, the Performance 
is reloaded back to its original configuration.

    [Reload Performance on SPP 0] (checkbox) [Off, On]
Allows the receipt of a Song Position Pointer message of zero (Locate To Start) to reload the current Performance, 
reverting any edits and resetting it to its original state.
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�   It’s important to realize that this feature can also get in the way or cause problems. For example, when you save a 
song on the Motif/MOX, it automatically sends this message. So if you have edited a Performance while working on it, and 
edited the song, and then you save the song, it will blow out your Performance edits in the software. You need to save the 
edits in KARMA first, then save the Motif/MOX song. That’s why this feature interacts with the Preferences Dialog 
setting “Warn when edited and reloading the current Performance” - so the first time you use this feature you may see 
the warning dialog, which can be turned off in the Preferences while you are working with sequencing. For more info see 
Preferences Dialog - General Tab.<Prefs/General>

<Other>
General - Other
 

The following additional options should not be adjusted unless you are an advanced user and know what you are doing, as 
the default values should work for most cases. When in doubt as to whether you have adversely modified a setting, you 
can use the Menu Button’s “Restore Default Settings” command to reset this page to the factory defaults.
<2069>

    [SysEx Transmission - Packet Delay] (numerical) [0...255 milliseconds]

    Not used with the Yamaha USB or FW Driver. Only applies to standard MIDI Interfaces.

Sets the amount of time in milliseconds to wait between transmitting each packet of System Exclusive data. Shorter 
settings can make it faster, but try longer settings (85 - 150) if experiencing MIDI SysEx errors. This setting only 
affects the transmission of SysEx data, not the receiving of it. Based on our testing, the Mac version defaults to 85 ms, 
while the Windows version defaults to 0 ms.
<2070><2071>
    [Default Thru Bend Range] (numericals) [-12...+12 semitones]

Sets the default Bend Range (in semitones) that will be transmitted for pitch bend levers and wheels (0~64, 64~127) 
when the KARMA On/Off Switch is in the on position (Real-Time Controls Window). The plus (+X) setting indicates the 
range when the lever or wheel is moved “up” and the minus (-X) setting indicates the range when the lever or wheel is 
moved “down.” Since KARMA Performances may modify the bend range as part of the overall effect, this allows it to be 
returned to something “normal” when used with the pitch bend controller, even if the bend range is modified.

    When a module has Pitch Bend Thru enabled on the Performance > MIDI Filter - Input section, and is using a Drum GE or 
Drum Fill GE (as determined by RTC Model DP1 or DF1), it uses the bend range stored in the GE’s Bend Page (which is 
generally 12 semitones), allowing the drum kits to be bent an octave up or down by the pitch bend controller (wheel or 
joyst ick).
<FilEd/FiltIn><2072><2073>
    [Overall Note Range Limit] (numerical) [1...127, C-2...G8]

Sets the lowest and highest possible note that can be generated by any of KARMA’s features, on a global level. This can be 
used to globally prevent KARMA from generating notes outside of a specific “safe range” if desired. The default setting is 
the full range of MIDI note numbers.
<2074>
    [Thin Echoed CC/Bend Data - Thinning On] (checkbox)

When this is on, incoming MIDI data is “thinned” before being echoed thru to the modules, reducing how much MIDI data is 
sent. The amount of thinning is based on the Factor setting below.
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When receiving controller values from the keyboard, KARMA generally echoes through many of the CC values to each of 
the modules (based on settings in the Performance Editor > MIDI Filter Page). This can result in massive quantities of 
CC/Bend data being put into the MIDI stream, such that it actually causes the keyboard to stutter and slow down when 
receiving the data from the software. This is also dependent on the resolution of the controllers being received. For 
example, many of the controllers on the device may be high-resolution, and transmit every value from 0 to 127, even 
when moved quickly. So imagine wildly flailing such a controller, which is coming into KARMA software and being echoed 
out to 6 modules at the same time (6x the data being generated) - it can totally overflow the MIDI stream. When thinning 
is on, intermediate values in the MIDI are removed, using time windows, such that the outgoing values are more sparse. In 
most cases, this thinning cannot even be heard, but it effectively fixes the situation. 
<2075>

    [Thin Echoed CC/Bend Data - Factor] (numerical) [1..15]

Sets the amount of CC/Bend data thinning that is performed on echoed MIDI data, with higher values causing more thinning. 
See the description above for why this is necessary. A default value of 6 seems to work well. 
<2077>

    [Block Aftertouch Time Window] (numerical) [0...3000 milliseconds]

Sets the amount of time (in milliseconds) that Aftertouch will be blocked after playing a note on the Keyboard Layers. This 
is used to prevent overly sensitive AT mechanisms from constantly affecting the keyboard sounds during medium to rapid 
playing. A setting of 0 disables this feature. A default setting of 175 ms seems to work well.
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RTC Setup
Sections in this chapter:

Overview<MsuRTC/Over>

General<MsuRTC/General>

Transmit/Receive<MsuRTC/Transmit>

A. Switches/A. Knobs<MsuRTC/ASwitches>

Sliders/Switches/Knobs<MsuRTC/Sliders>

Scenes<MsuRTC/Scenes>

Control Layer<MsuRTC/Control>

Chord Triggers<MsuRTC/Chords>

 

<Over>
RTC Setup - Overview
The RTC Setup Page of the MIDI Setup (Global) Editor allows you to specify the MIDI Control Change Messages and Note 
Numbers that will be utilized by the sliders, switches and other controls in the Real-Time Control Window for transmitting 
and receiving MIDI data. This allows you to use any programmable external MIDI controller such as a Korg NanoPad, 
Steinberg CMC-QC, Peavey PC1600, etc. to move the RT Controls and control KARMA in real-time. Another use is to 
allow the movements of the RT Controls to be recorded into a sequencing program or device. The parameter settings on 
this page are stored in the application’s Preferences file.

The RTC Setup Page can be displayed by the following methods:
- clicking the “RTC” button in the Page Selection Buttons on the left side of the MIDI Setup (Global) Editor;
- choosing “RTC Setup” from the “Pages” sub-menu underneath the “MIDI Setup (Global) Editor” item in the Window 
Menu.

Parameter Groups
The page is divided into eight separate sections, as shown above, each of which is described below in more detail.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:
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Restore Default Settings
Restores the settings on the RTC Setup Page to the recommended default settings.

<General>
RTC Setup - General
 

The General section contains settings for

The General section contains settings for various miscellaneous features and functions that do not belong in one of the 
other parameter groups.
<2152><2153><2154><2155><2157><2158><2159><2161><2162><2178>

    [General Transmit/Receive CC] (popup menu) [Off, 0...126]

Selects a MIDI CC number for controlling the following in the Real-Time Controls Window (or elsewhere if noted):

On/Off [0,127] - controls the KARMA On/Off button. <RtcEd/0856>

Latch [0,127] - controls the Latch button. <RtcEd/0857>

Stop [any value] - controls the Stop function (i.e. using the Return Key or the Stop button in the Main Editor’s toolbar).
<Basic/Stop>

Tempo [inc/dec] - increases or decreases the Tempo of the current Performance. * <SWGUI/1882>

Master Volume [0...127] - controls the Master Volume of the current Performance. <RtcEd2/1820>

Transpose Up [any value] - increases the Master Transpose value by one semitone (in the Performance Editor).
<PE/Transpose>

Transpose Down [any value] - decreases the Master Transpose value by one semitone (in the Performance Editor). 
<PE/Transpose>

RTC/Mix Select [0,127] - toggles the RTC/Mix View displayed in the Real-Time Controls Editor bottom portion (0 = RTC). 
<RtcEd2/View>

Silence Input Notes [0, 127] - activates the Silence Input Notes feature (which has no corresponding physical control in 
the software). When this button is held down and one of the 16 Chord Triggers is pressed (or you play notes on the 
keyboard), KARMA will be triggered with the notes, but you will not hear the chord played by any of the Keyboard Layer 
sounds.

For example, typically the first eight Chord Triggers send the notes into KARMA and play a synth pad or keyboard sound 
in the left hand area of the keyboard split at the same time (as does a chord played with your left hand in KARMA’s input 
zones of the keyboard). You may wish to trigger and control the groove without having the chord played by the keyboard 
sounds, as a real-time Performance gesture. As long as you hold down the Silence Input Notes button, the Keyboard Layer 
sounds will be silent but KARMA will still be triggered with the chord.

This is intended mainly as a temporary real-time Performance gesture; for example, you change to one of the simpler 
scenes, and you wish to play a chord progression triggering KARMA for a few bars, but do not want to hear the pad sound 
that is assigned to the LH area. However, as it requires holding down the button, it’s not suitable for something extended, 
as it also mutes notes in the RH area.

Another way of accomplishing this would be to turn on the Track Mute for Keyboard Layer 1 (the LH area) – but this mutes 
it in the current Master Layer scene only. However, this does “stay off” without holding down the button, and then you 
can play RH lead sounds while triggering chords with the LH pad sound turned off.

Compare [0,127] - functions differently depending which view is selected in the Real-Time Controls Editor:

-- RTC View: toggles the Compare button for the currently selected Scene and Control Layer (RTC settings).
<RtcEd2/1803>

- Mix View: toggles the Compare button for the currently selected Scene (Volume settings). <RtcEd2/1819>

    * In order to control Tempo, the device must be capable of sending a “rotary encoder” type message indicating 
incrementing and decrementing the value. Moving the controller in the increment direction continuously sends a single 
value of 64 or less (typically 1), while moving the controller in the decrement direction continuously sends a single value 
greater than 64 (typically 65 or 127). This allows the Tempo to be adjusted up or down from the original value that the 
Performance is loaded with. Tempo control will not work with a controller that sends an absolute continuous MIDI value of 
0~127 across its range.

<Transmit>
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RTC Setup - Transmit/Receive
 

The Transmit/Receive section contains settings for managing the MIDI ports and channels used to communicate the 
Real-Time Control messages back and forth with various devices that may be used as controllers, or even external 
programs such as DAWs and sequencers that are being used to record a KARMA Performance. The two Receive Ports are 
merged together and can be used at the same time with different devices. The choices in these port menus will be 
determined by the MIDI Ports on your computer. Enabled ports are determined by the MIDI Port Manager.
<MidPort><2189><2190><2195><2197><2198><2199>
�   [Transmit Port/Channel] (popups)

Selects an Output Port and MIDI Channel on which the RT Controls will transmit the selected CC/Note number as MIDI data. 
You would use this to allow the movements of the RT Controls to be sent to a sequencing program or other external 
device. Note that none of the controls will transmit MIDI data unless the Active checkbox to the right is on.
<2191>
   [Transmit Active] (checkbox) [Off, On]

When on, the specified CCs (or Notes) will be sent when any applicable assigned KARMA feature or function is activated. 
This includes activating them from the computer keyboard or mouse.
<2192><2193><2196>
   [Receive Port/Channel] (popups)

Selects an Input Port and MIDI Channel on which the RT Controls will “listen” for the selected CC/Note number. You would 
use this to allow an external controller such as a Korg NanoPad to control the RT Controls, or a recorded track of data in 
an external sequencer. Note that none of the controls will receive MIDI data unless the Active checkbox to the right is on.
<2194>
    [Receive Active] (checkbox) [Off, On]

When on, the various assigned KARMA features and functions will respond to the assigned incoming CCs (or Notes).

<ASwitches>
RTC Setup - A. Switches/A. Knobs
 

The A.Switches/A.Knobs section contains settings for assigning MIDI CCs to the Motif’s/MOX’s two assignable switches 
and two assignable knobs. This allows the two switches to control the corresponding buttons in the Real-Time Controls 
Windows, and the two assignable knobs (Tone 1 Knobs 7 and 8) to be routed and controlled by the Performance Editor > 
MIDI Filter Page.
<2175>
   [Assignable Switch Transmit/Receive CC] (popup menu) [Off, 0...126]

Selects a MIDI CC number for each of the two Assignable Switches in the Real-Time Controls Window. These should match 
the settings in the Motif/MOX (which are CC 86 and 87 by default).
<2177>
   [Assignable Knob Transmit/Receive CC] (popup menu) [Off, 0...126]

Selects a MIDI CC number for each of the two Assignable Knobs (Tone 1 Knobs 7 and 8), allowing them to be controlled by 
the Performance Editor > MIDI Filter Page. These should match the settings in the Motif/MOX (which are CC 16 and 17 by 
default).

<Sliders>
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RTC Setup - Sliders/Switches/Knobs
 

The Sliders/Switches/Knobs section contains settings for assigning MIDI CCs to the eight Real-Time Control Sliders and 
Switches that can operate in each Control Layer of the Real-Time Controls Window.
<2148><2151>

    [Slider Transmit/Receive CC] (popup menu) [Off, 0...126]

Selects a MIDI CC number for each of the eight sliders in the Real-Time Controls Window.
<2149>

    [Switch Transmit/Receive CC] (popup menu) [Off, 0...126]

Selects a MIDI CC number for each of the eight switches in the Real-Time Controls Window.
<2150>

    [Knob Transmit/Receive CC] (popup menu) [Off, 0...126]

Selects a MIDI CC number for each of the eight sliders in the Real-Time Controls Window, to be alternately controlled by a 
knob, using a rotary encoder knob scheme.*

    * In order to use the Knob settings, the device must be capable of sending a “rotary encoder” type message indicating 
incrementing and decrementing the value. Moving the controller in the increment direction continuously sends a single 
value of 64 or less (typically 1), while moving the controller in the decrement direction continuously sends a single value 
greater than 64 (typically 65 or 127). This allows the slider to be adjusted up or down from the original value that the 
Performance is loaded with. The Knob settings will not work with a controller that sends an absolute continuous MIDI value 
of 0~127 across its range.

<Scenes>
RTC Setup - Scenes
 

The Scenes section contains settings for assigning a MIDI CC (or multiple CCs, depending on the selected mode of 
operation) to change Scenes in the current Performance.
<2164><2165>
    [Scene CC Mode] (radio buttons)

Sets one of two different ways that CCs can be used to select Scenes, depending on the programming options of the 
external controller you are planning to use:
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1 CC - Value is Scene
In this mode, a single CC is used to specify Scene changes, with the CC value of 0~31 selecting Scenes 1~32 of the 
current Module Control Layer.

8 CCs - for 8 Scenes
In this mode, 8 separate CCs are used to select the first 8 Scenes of the current Module Control Layer. A CC Value of 127 
will select the associated Scene. This can be useful with some external controllers that cannot use the first method 
(which provides access to all 32 scenes).
<2156><2163>

    [Scene Transmit/Receive CC] (popup menu) [Off, 0...126]

(When operating in the “1 CC” mode) - sets the MIDI CC Number that Scene changes will use when transmitting or 
receiving MIDI data, with the value 0~31 indicating the Scene.

(When operating in the “8 CCs” mode) - sets the MIDI CC Number that this Scene will use when transmitting or receiving 
MIDI data. A CC value of 127 received on this CC number will select this Scene; selecting this Scene will transmit this CC 
with a value of 127.

<Control>
RTC Setup - Control Layer
 

The Control Layer section contains settings for assigning a MIDI CC (or multiple CCs, depending on the selected mode of 
operation) to change the Control Layer in the current Performance.
<2171><2172><2174>

    [Control Layer CC Mode] (radio buttons)

For selecting the Control Layer, there are three different modes of operation, depending on the capabilities of your 
programmable controller:

Value = Layer
A CC Value of 0 selects the Master Layer, while values 1~6 select the corresponding Module Layer.

Cycle (Switch)
For use with a momentary switch: pressing the switch (a value greater than 0) cycles to the next Module Control Layer. 
After the last Module Layer in use is selected, it wraps around back to the Master Layer.

7 CCs
Allows each of the seven Control Layers to be selected by a separate CC, with a value of 127.
<2173><2179>

    [Control Layer Transmit/Receive CC] (popup menu) [Off, 0...126]

(When operating in the “Value” or “Cycle” modes) - sets the MIDI CC Number that will be used to change the Control 
Layer.

(When operating in the “7 CCs” mode) - sets the MIDI CC Number that will be used to select this Control Layer. A CC 
value of 127 received on this CC number will select this Layer; selecting this Layer will transmit this CC with a value of 
127.

<Chords>
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RTC Setup - Chord Triggers
 

The Chord Triggers section contains settings for assigning MIDI CCs or MIDI Note Numbers to KARMA’s 16 Chord Triggers
<2166><2167>

    [Chord Triggers - CC/Note Mode] (radio buttons)

CC (Control Change)
When this option is selected, each Chord Trigger will transmit and be triggered by the assigned CC (Control Change) 
number, with the value 1~127 equaling the velocity, and a value of zero indicating the release.

Note Number
When this option is selected, each Chord Trigger will transmit and be triggered by the assigned MIDI Note Number and 
velocity.
<2168><2169>

    [Transmit Mode] (radio buttons)

Chord Trigger Notes
When this option is selected, the Chord Triggers will transmit the actual notes and velocities (up to eight) that are 
programmed into it.

CC/Note Number
When this option is selected, the Chord Triggers will transmit the selected CC number and value (velocity), or the single 
assigned MIDI Note.
<2176>
    [Chord Assign Receive CC] (popup menu) [Off, 0...126]

Sets the MIDI CC Number that the Chord Assign Button will use when receiving MIDI data.
<2170>

    [Chord Trigger Transmit/Receive CC] (popup menu) [Off, 0...126]

Selects a MIDI CC number or Note Number for each of the 16 Chord Trigger buttons in the Real-Time Controls Window, 
depending on the settings of the Assign CC/Note radio buttons at the top.
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Dynamic MIDI (CC)
Sections in this chapter:

Overview<MsuDyn/Over>

Parameters<MsuDyn/Parms>

 

<Over>
Dynamic MIDI (CC) - Overview
The Dynamic MIDI (CC) Page of the MIDI Setup (Global) Editor allows you to specify the first 14 controllers that will be 
listed in the Performance Editor’s Dynamic MIDI Sources menu from a list of MIDI Control Change Messages. The Dynamic 
MIDI Sources List is a length list of various controllers, and operations that can be assigned to trigger many of KARMA’s 
interactive functions, such as Fills, Retriggering, Stutter and much more. While much of the lengthy list of sources is 
fixed, the first 14 locations can be user-specified (although it is generally not recommended to change them unless you 
are an advanced user with a deep understanding of KARMA Performances). The parameter settings on this page are stored 
in the application’s Preferences file.
<DynSrc>

The Dynamic MIDI (CC) Page can be displayed by the following methods:
- clicking the “Dyn MIDI” button in the Page Selection Buttons on the left side of the MIDI Setup (Global) Editor;
- choosing “Dynamic MIDI (CC)” from the “Pages” sub-menu underneath the “MIDI Setup (Global) Editor” item in the 
Window Menu.

P a r a m e t e r s
A section containing the selections for the 14 Dynamic MIDI User CCs.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Restore Default Settings
Restores the settings on the Dynamic MIDI (CC) Page to the recommended default settings.

<Parms>
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Dynamic MIDI (CC) - Parameters
 

<0796>
    [Dynamic MIDI User CCs] (popup menu) [0...127]

Allows you to specify the first 14 controllers that will be listed in the Performance Editor’s Dynamic MIDI Sources menu 
from a list of MIDI Control Change Messages. For more information on Dynamic MIDI Control, see the Performance Editor > 
Dynamic MIDI Page. <DynEd>

    In most cases, you should not entertain changing these unless you are an extremely advanced user with a fairly deep 
understanding of how KARMA Performances are set up. Most of the included factory Performances utilize many of these 
and expect them to be set to the default settings. Changing these without taking other actions may break some of the 
functionality of the Performances, such as the Fill Button, Retrigger, Stutter, etc. Fortunately, you can restore these to 
the default settings if you did change them, by using the Menu Button command “Restore Default Settings” explained 
above.
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MIDI Filter
Sections in this chapter:

Overview<MsuFil/Over>

Parameters<MsuFil/Parms>

 

<Over>
MIDI Filter - Overview
The MIDI Filter Page provides a comprehensive set of MIDI filters that operate on all data going in and out of the KARMA 
software. This is mainly useful for testing purposes, or configuring the software within an extensive MIDI system, where 
the interaction of other gear may be sending MIDI messages that are causing some problems within KARMA. You likely will 
never need to use this, but it’s there. (Note that each Performance in KARMA has a stored set of MIDI filters to handle 
common filtering needs for the Modules and Keyboard Layers, in the Performance Editor > MIDI Filter Page. If you simply 
want to filter Pitch Bend in a particular Performance, then here is not the place to do it, as it will render Pitch Bend 
non-functional for all Performances.) The parameter settings on this page are stored in the application’s Preferences 
file.<FilEd>

The MIDI Filter Page can be displayed by the following methods:
- clicking the “Filter” button in the Page Selection Buttons on the left side of the MIDI Setup (Global) Editor;
- choosing “MIDI Filter” from the “Pages” sub-menu underneath the “MIDI Setup (Global) Editor” item in the Window 
Menu.

P a r a m e t e r s
The MIDI Filter Page contains two identical columns - one for MIDI Input, and one for MIDI Output.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Restore Default Settings
Restores the settings on the MIDI Filter Page to the recommended default settings (all off).

<Parms>
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MIDI Filter - Parameters
 

The MIDI Filter Page contains two identical columns - one for MIDI Input, and one for MIDI Output, containing the following 
settings:
<2131>
    [Mode] (popup) (0...2)

Kbd Layers/Thru
Filter the selected MIDI messages on the input/output ports and channels of the Keyboard Layers and any other MIDI-Thru 
related features.

Modules
Filter the selected MIDI Messages on the input/output ports and channels of the Modules.

A l l
Filter the selected MIDI Messages on all of the input/output ports and channels used by KARMA.
<2132><2133><2134><2135><2136><2137><2138><2139><2140><2141>

    [Filter Checkboxes] (checkboxes) [Off, On]

Each of the following checkboxes filters a different type of MIDI Data:

Notes

Program Changes

Pitch Bend

Channel Aftertouch

Poly Aftertouch

System Realtime (Clock)

System Exclusive (SysEx)

CCs - All (Filter all Control Change messages)

CC1...CC8 (Select up to 8 different individual Control Change messages)

    One potential use of this page would be to disable Aftertouch on the Keyboard Layers for all Performances, if you do 
not like to use Aftertouch. You would set the MIDI Filter (Input) section to Mode “Kbd Layers/Other” and check the 
Channel Aftertouch checkbox.
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 <1133>

Sync
Sections in this chapter:

Overview<SynEd/Over>

Parameters<SynEd/Parms>

Yamaha Special Notes<SynEd/MotifNotes>

 

<Over>
Sync - Overview
The Sync Page of the MIDI Setup (Global) Editor controls whether KARMA will use its own internal clock (and send it to 
external devices), use an external device’s clock for synchronization (and optionally echo that clock to other devices), or 
automatically switch between the two. Although the settings in here will be configured automatically when first launching 
the software, you may need to set these choices when synchronizing KARMA to other devices, or synchronizing other 
devices to KARMA. The parameter settings on this page are stored in the application’s Preferences file.

Typically for KARMA Motif, you will want KARMA Software to be the “Master” and the keyboard to be the “Slave,” so 
that you can control the tempo of the keyboard  from the software and have any beat-synchronized effects sync up to 
what KARMA is generating. When the software is auto-configured on first launch, or when you run the MIDI Assistant as 
explained in the “Installation and First Launch” tutorial, it automatically sets this page correctly, as explained in 
Communication Configuration - KARMA Software. 
<KMoCfg>

The Sync Page can be displayed by the following methods:
- clicking the “Sync” button in the Page Selection Buttons on the left side of the MIDI Setup (Global) Editor;
- choosing “Sync” from the “Pages” sub-menu underneath the “MIDI Setup (Global) Editor” item in the Window Menu;
- using the keyboard shortcut Cmnd+Y (Mac) or Ctrl+Y (Win). 

    In the following descriptions, “System Realtime Messages” refers collectively to MIDI Clock (also known as MIDI Beat 
Clock), MIDI Start, MIDI Stop, and MIDI Continue messages. KARMA can sync to MIDI Beat Clock, not MTC (MIDI Time 
Code).
<1132>

Receiving LED
Flashes when receiving MIDI Clock and other System Realtime Messages on any open MIDI port. Open ports are determined 
by the MIDI Port Manager.
<MidPort>

P a r a m e t e r s
This section contains parameters that let you synchronize KARMA with your external MIDI devices.

Menu Button
A popup menu allowing instant access to this help chapter and any utilities associated with this page:

 

Restore Default Settings
Restores the settings on the Sync Page to the recommended default settings.

<Parms>
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Sync - Parameters
 

<1128><1134>
    [Mode] (button) [0...2]

Switches between Internal Clock (driving external devices in sync with KARMA as the Master), External Clock (being 
driven by an external device with KARMA as the Slave), and Auto Mode (automatically switches between the two). The 
label shown as “Send/Echo” in the above diagram will change to “Send” in Internal Mode and to “Echo” in External Mode. 
The Sync State label is only shown when in Auto Mode.

Internal
KARMA will use its own internal clock, and send System Realtime Messages to external devices when the “Send” 
checkbox is on (below). System Realtime Messages from external devices are ignored. The Input Port will be disabled, and 
the Output Ports and parameters allows KARMA’s MIDI Clock to be sent to other devices.

External
KARMA will sync to MIDI Clock and System Realtime Messages received from an external device, and echo those 
messages to external devices when the “Echo” checkbox is on (below). The Input Port will be enabled, and the Output 
Parameters section allows the messages being received to be echoed (sent) to other devices on other ports.

Auto
When KARMA senses MIDI Clock at the Input Port, it will operate in External Mode; when no incoming clock is sensed, it 
will operate in Internal Mode - it will automatically switch between the two modes. This is the default setting and normal 
recommended operating mode. When operating in Auto Mode, a Sync State label appears under the Mode menu indicating 
which of the two modes is presently operating.
<1129>
    [Input Port] (popup menu) [varies depending on the MIDI Ports on your computer]

Selects the port on which System Realtime Messages from an external device will be received. The choices in this menu 
will be determined by the MIDI Ports on your computer. Enabled ports are determined by the MIDI Port Manager. Not 
available when set to Internal Mode.
<MidPort><1131>
    [Send/Echo] (checkbox) [Off, On]

Toggles on/off the sending or echoing of MIDI Clock and System Realtime Messages to the selected Output Port(s). When 
the Mode setting is Internal, the checkbox allows KARMA’s System Realtime Messages to be sent to other devices on 
other ports, and the label displays “Send.” When the Mode setting is External, the checkbox allows the System Realtime 
Messages being received to be echoed to other devices on other ports, and the label displays “Echo.” When the Mode 
setting is Auto, the System Realtime Messages are sent or echoed depending on the current Sync State.

Off
MIDI Clock and System Realtime Messages (Start/Stop/Continue) will not be sent (or echoed) to the selected Output Port. 

On
MIDI Clock and System Realtime Messages (Start/Stop/Continue) will be sent (or echoed) to the selected Output Port.
<1130>
    [Output Port] (popups) [varies depending on the MIDI Ports on your computer]

Selects a port on which System Realtime Messages generated (or received) by KARMA will be sent (or echoed) to 
external devices. The choices in this menu will be determined by the MIDI Ports on your computer. Enabled ports are 
determined by the MIDI Port Manager. You can send messages to up to four different devices, and control all of them from 
the KARMA software. Note that the messages will not be sent unless the “Send/Echo” checkbox next to the Output Port 
menu is checked.
<MidPort><1626>
   [Filter Start/Continue] (checkbox) [Off, On]

When on, allows the MIDI Start/Continue messages sent by KARMA to be filtered from the output to the specified ports. 
For example, with the Yamaha MOX/MOXF, triggering a KARMA Performance normally causes a Start message to be sent 
to the sequencer. Due to the way the MOX/MOXF needs to be configured to work with KARMA, this will cause the 
“empty” one-bar song containing the KARMA Performance to start playing, and it will stop after four beats and send a 
message back to KARMA stopping the Performance. Therefore, this option is set to on by default for the MOX/MOXF.

Page 104



<1627>
    [Filter Stop] (checkbox) [Off, On]

When on, allows the MIDI Stop messages sent by KARMA to be filtered from the output to the specified ports.
<1628>
    [Filter Clock] (checkbox) [Off, On]

When on, allows the MIDI Clock messages sent by KARMA to be filtered from the output to the specified ports.

<MidPort><MotifNotes>
Sync Editor - Yamaha Special Notes
 

 

 

In order to control the tempo of your Yamaha device from the KARMA Motif software, you should apply the following 
settings as shown above:

Motif XS and XF: UTILITY > Control > MIDI > MIDI Sync = MIDI

MOX and MOXF: UTILITY > MIDI > SYNC > MIDI Sync = external

Motif Rack-XS: UTILITY > MIDI 1/6 > MIDI Sync = external

S70/S90 XS: UTILITY > MIDI 1/3 > MIDI Sync = external

This will normally be configured automatically when you load the included Yamaha data file for your device containing the 
KARMA Performances, which includes system settings for your device.

This way, when you change the Tempo of Performances inside the software, the tempo-synchronized effect settings 
(IFX/MFX) of the keyboard will stay properly in sync. For more information on setting these options in the hardware 
devices, see:

Communication Configuration - XS & XF<MotifCfg>

Communication Configuration - MOX & MOXF<MOXCfg>

Communication Configuration - Rack-XS<RackCfg>

Communication Configuration - S70/S90 XS<S90XSCfg>

For more information on synchronization options, especially when sequencing with internal or external sequencers, see 
the tutorial:

Sequencing With KARMA Motif (in the Tutorials Folder)<SetupKMO/TutFolder>
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<0739>

Metronome
Sections in this chapter:

Overview<MetEd/Over>

Parameters<MetEd/Parms>

 

<Over>
Metronome - Overview
The Metronome Page of the MIDI Setup (Global) Editor allows you to generate a MIDI-note metronome that can be a useful 
timing reference when you are creating and editing GEs and Performances. The parameter settings on this page are stored 
in the application’s Preferences file.

The Metronome Page can be displayed by the following methods:
- clicking the “Metro” button in the Page Selection Buttons on the left side of the MIDI Setup (Global) Editor;
- choosing “Metronome” from the “Pages” sub-menu underneath the “MIDI Setup (Global) Editor” item in the Window 
Menu;
- using the keyboard shortcut Cmnd+R (Mac) or Ctrl+R (Win). 

P a r a m e t e r s
Control the settings of the metronome, such as note, velocity, beat division, etc.

Menu Button
A popup menu allowing instant access to this help chapter and any utilities associated with this page:

 

Restore Default Settings
Restores the settings on the Metronome Page to the recommended default settings.

    When the Metronome is on, vertical beat markers (vertical lines) are generated and displayed in the Data Display 
Editor. If you want to see the vertical beat markers but not hear the metronome, set the Metronome Port to something 
that is not being use, or the Velocity to “1.” 
<Parms>
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Metronome - Parameters
 

<0733>
    [Metronome On/Off] (button) [Off, On]

When on, a note is generated at regular intervals according to the settings and sent to the specified MIDI Device on the 
specified Channel. This provides a useful timing reference while editing GEs. It also causes a vertical line to be drawn in 
the Data Display Page indicating the beat divisions.
<0732>
    [Only when KARMA is running] (checkbox) [Off, On]

When on, the metronome will only sound when KARMA is playing. Stopping KARMA stops the metronome. When off, the 
metronome will play continuously.
<0734>
    [Port] (popup menu) [varies depending on the MIDI Ports on your computer]

Selects the MIDI Device that you wish to send the metronome notes to. The choices in this menu will be determined by the 
MIDI Ports on your computer. Enabled ports are determined by the MIDI Port Manager. <MidPort>
<0735>
    [Channel] (popup menu) [0...15: 1...16]

Specifies the MIDI Channel that the metronome note will be generated on.
<0736>
    [Note] (popup menu) [0...127: C-1...G9]

Selects the MIDI Note Number that will be generated as the metronome. This popup menu displays either MIDI Note 
Numbers, GM Drum Names, or a combination of the two depending on the settings in the Preferences - Popups Tab.
<Prefs/Popups><0737>
    [Velocity] (numerical) [1...127]

Sets the velocity with which the note will be generated.
<0731>
    [Duration] (numerical) [1...500 milliseconds]

Sets the duration of the note in milliseconds.
<0738>
    [Beat] (popup menu) [0...3: 32nd, 16th, 8th, Quarter Notes]

Sets the rhythmic division at which to generate the metronome note. This relates to the Performance Tempo setting in 
BPM.

Page 107



Devices
Sections in this chapter:

Overview<MsuDev/Over>

Parameters<MsuDev/Parms>

 

<Over>
Devices - Overview
The Devices Page of the MIDI Setup (Global) Editor contains some settings specific to the device the software is 
controlling - in this case, the Yamaha device and the use of the device’s Remote Mode to control KARMA. In addition, other 
external controllers such as a Korg nanoPAD2 or the Steinberg CMC-PD or CMC-QC can be used to control KARMA as 
well, provided they are mapped to one of the provided Control Maps. The parameter settings on this page are stored in the 
application’s Preferences file.

The Devices Page can be displayed by the following methods:
- clicking the “Devices” button in the Page Selection Buttons on the left side of the MIDI Setup (Global) Editor;
- choosing “Devices” from the “Pages” sub-menu underneath the “MIDI Setup (Global) Editor” item in the Window Menu.

    For detailed information on using the Remote Mode to control KARMA, see the Remote Mode Tutorial by choosing 
“Tutorials Folder” from the Help Menu.

    The Motif or MOX Remote Mode can only be used with a USB or Firewire MIDI connection type, which requires the prior 
installation of the correct Yamaha drivers on your computer. You cannot use it with a standard MIDI interface. Other 
controllers may also require the installation of USB/FW drivers provided by their respective companies, although older 
controllers (without USB/FW) may work with a standard MIDI interface.

P a r a m e t e r s
This section contains parameters that let you control options specific to the Yamaha device, or other external controllers 
that may also be used to control KARMA through the Remote Control Maps.

Menu Button
A popup menu allowing instant access to this help chapter and any utilities associated with this page.

 

Restore Default Settings
Restores the settings on the Devices Page to the recommended default settings.

<Parms><1933>

Page 108



Devices - Parameters
 

This section contains parameters that let you control options specific to the Yamaha device, such as the use of the 
Motif/MOX Remote Mode to control KARMA, or other external controllers that may also be used to control KARMA 
through the Remote Control Maps.

    The Motif or MOX Remote Mode can only be used with a USB or Firewire MIDI connection type, which requires the prior 
installation of the correct Yamaha drivers on your computer. You cannot use it with a standard MIDI interface. Other 
controllers may also require the installation of USB/FW drivers provided by their respective companies, although older 
controllers (without USB/FW) may work with a standard MIDI interface.
<1927><1932>
    [Remote Active] (checkbox) [Off, On]

Specifies whether the Remote Mode feature (or similarly mapped external controllers) will be used to receive MIDI 
messages (and send KARMA status updates to the keyboard’s display if applicable). If you do not wish to use the Remote 
Mode feature with the keyboard’s Remote Mode (or similarly mapped external controllers) to control KARMA, this should 
be turned off.
<1930>
    [Remote Port In Active] (checkbox) [Off, On]

Specifies whether the selected Remote Port is actively receive MIDI messages from the keyboard (or similarly mapped 
external controller). 
<1928>
    [Remote Port In] (popup menu) [varies depending on the MIDI Ports on your computer]

Selects a MIDI Port that KARMA will use to receive communications from the keyboard’s Remote Mode (or similarly 
mapped external controller). The choices in this menu will be determined by the MIDI Ports on your computer. Enabled 
ports are determined by the MIDI Port Manager.
<MidPort><1931>

    [Remote Port Out Active] (checkbox) [Off, On]

Specifies whether the Remote Port Out is actively sending status messages to the keyboard’s display (if applicable).
<1929>
    [Remote Port Out] (popup menu) [varies depending on the MIDI Ports on your computer]

Selects the MIDI Port that KARMA will use to send status messages to the keyboard’s display while in Remote Mode. The 
choices in this menu will be determined by the MIDI Ports on your computer. Enabled ports are determined by the MIDI 
Port Manager.
<MidPort><1934>
    [Control Map] (popup menu) [0...3]

Selects one of several different predetermined mappings of MIDI messages to KARMA features. The device specified in the 
Remote Port In menu should be programmed to match this map.

0: Motif XF/XS - Digital Performer
Matches the Motif XS and XF Remote Mode; can also be used as a general template for most types of programmable 
external controllers.

1: MOX - Cubase
Matches the MOX6/MOX8 Remote Mode and Remote Setup #40 KARMA Motif.

2: Steinberg CMC-QC
Specialized map provided for the Steinberg CMC-QC Quick Controller.

3: Steinberg CMC-PD
Specialized map provided for the Steinberg CMC-PD Pad Controller.

    The exact settings of these Control Maps and preprogrammed setups for certain external controllers can be found in 
various Karma-Lab Reference and Tutorial documents provided elsewhere. For the latest documents and resources, visit 
http://www.karma-lab.com/kmo/docs.
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MIDI Port Manager
Sections in this chapter:

Overview<MidPort/Over>

Input Port Parameters<MidPort/Input>

Output Port Parameters<MidPort/Output>

 

<Over>
MIDI Port Manager - Overview
The MIDI Port Manager dialog provides a method for managing which MIDI ports will be opened for use within the KARMA 
software. The choices in this dialog affect which MIDI Ports are enabled or disabled in the input and output port menus of 
various KARMA editor pages. Therefore, if you wish to select a port as a MIDI source or destination but it is grayed out, 
you need to open this dialog and enable the appropriate ports. (On Windows, generally a port that has been opened by one 
application is not available to be opened and used by another application. On the Mac, this is not the case; however the 
dialog still provides for specifying which ports will be available within the software as MIDI sources and destinations.) 

During first launch of the software, the appropriate ports needed for the software will be auto-configured, so you may 
not ever need to use this dialog. However, if your port arrangements have been changed by adding or removing MIDI 
drivers and devices you may need to manually reconfigure the open ports if the KARMA software is no longer operating 
with the correct ports. Additionally, if you want to enable additional ports for use with external controllers and other 
devices you will need to do it here. The parameter settings in this dialog are stored in the application’s Preferences file.

The MIDI Port Manager dialog can be displayed by the following methods:
- choosing “MIDI Port Manager” from the MIDI Setup (Global) Editor’s Menu Button;
- choosing “MIDI Port Manager” from the Performance Editor > MIDI Setup Page’s Menu Button;
- choosing “MIDI Port Manager” from the Window Menu.

Input Port Parameters
This section contains parameters for opening and closing MIDI Input Ports for incoming MIDI messages.

Output Port Parameters
This section contains parameters for opening and closing MIDI Output Ports for outgoing MIDI messages.
<2278>

Enable VMD (Virtual MIDI Driver) - Windows only
Enables or disables the Karma-Lab Virtual MIDI Driver (32-bit Windows operating systems only). A restart is required to 
change this. This is not available on the Mac - use the Apple IAC Driver in the Audio MIDI Setup to create virtual ports.

    For Virtual Ports on 64-bit Windows operating systems, please use the free LoopBe1 driver or more advanced 
LoopBe30 driver from http://www.nerds.de .
<2273><2277>
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Scroll Bars
Up to eight ports are displayed in each section; you can use the scroll bars to view more if your computer has them. A 
maximum of 32 ports will be listed in each section.
<2279><2280>

Cancel /OK
Buttons that close the dialog. Cancel does not make any changes and leaves the settings as they were prior to opening the 
dialog. OK will attempt to open or close any MIDI ports that you have made changes to.

Menu Button
A popup menu allowing instant access to this help chapter and any utilities associated with this dialog.

 

Select All
Selects (checks) all ports to be opened when the dialog is closed.

Deselect All
Deselects (unchecks) all ports to be closed when the dialog is closed.

Deselect [Disabled] (Windows Only)
Deselects only the disabled ports that may be checked and cannot be clicked with the mouse.

<Input><2272>
MIDI Port Manager - Input Port Parameters
 

This section contains parameters for opening and closing MIDI Input Ports for incoming MIDI messages.
<2271><2281>
    [Port Name (Input)] (label) [varies depending on the MIDI Ports on your computer]

Displays the name and number of the MIDI Input Port, for receiving incoming MIDI messages. The exact names will be 
determined by the MIDI Ports on your computer. Disabled (grayed-out) ports may have already been opened by other 
applications and are not available (Windows only).
<2270>
    [Open (Input Port)] (checkbox) [Off, On]

When on, indicates the selected MIDI Input Port is open, or will be opened when the dialog is closed. When off, indicates the 
selected MIDI Input Port is closed, or will be closed when the dialog is closed. 
<2283>
    [Virtual Port] (icon) (Windows only)

A small “V” icon in a circle indicates that the port is a Karma-Lab Virtual Input Port for receiving messages from other 
applications, and is always open (32-bit Windows operating systems only). Not available on the Mac - use the Apple IAC 
Driver in the Audio MIDI Setup to create virtual ports.

    For Virtual Ports on 64-bit Windows operating systems, please use the free LoopBe1 driver or more advanced 
LoopBe30 driver from http://www.nerds.de .

<Output><2276>
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MIDI Port Manager - Output Port Parameters
 

This section contains parameters for opening and closing MIDI Output Ports for outgoing MIDI messages.
<2275><2282>
    [Port Name (Output)] (label) [varies depending on the MIDI Ports on your computer]

Displays the name and number of the MIDI Output Port, for sending outgoing MIDI messages. The exact names will be 
determined by the MIDI Ports on your computer. Disabled (grayed-out) ports may have already been opened by other 
applications and are not available (Windows only).
<2274>
    [Open (Output Port)] (checkbox) [Off, On]

When on, indicates the selected MIDI Output Port is open, or will be opened when the dialog is closed. When off, indicates 
the selected MIDI Output Port is closed, or will be closed when the dialog is closed. 
<2284>
    [Virtual Port] (icon) (Windows only)

A small “V” icon in a circle indicates that the port is a Karma-Lab Virtual Output Port for sending messages to other 
applications, and is always open (32-bit Windows operating systems only). Not available on the Mac - use the Apple IAC 
Driver in the Audio MIDI Setup to create virtual ports.

    For Virtual Ports on 64-bit Windows operating systems, please use the free LoopBe1 driver or more advanced 
LoopBe30 driver from http://www.nerds.de .
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<1141><1142><1143><1144>

Communication Status
The KARMA Software communicates constantly with the keyboard device via System Exclusive messages (often referred 
to as SysEx for short.) The Communication Status Window shows the current status of the communications between the 
software and the keyboard device. The window automatically closes when the main application window is brought to the 
front. If you wish to open it for any reason, you can choose the “Communication Status” item on the Window Menu.

    The images shown here are from KARMA Motif for Mac OS X; for Windows, they will be similar.

    The messages displayed will show “Yamaha Motif” for XS, XF, Rack-XS and S70/S90 XS, and “Yamaha MOX” for 
MOX and MOXF.

 

FIG. 1 - Communication Established

The window has two different appearances. When communication is properly established, it will look like the image in FIG. 
1. This indicates that the device was located on the Global In/Out Ports in the General Page of the MIDI Setup (Global) 
Editor, and shows which ports are in use (based on their position in the lists of ports in the popup menus).

    [Close] (bu t ton )

Closes the window. You can open it again at any time from the Window Menu.

When communication has not been established (or has been interrupted), an alert sound will occur and the window will pop 
open and display the message shown below in FIG. 2. When communication is re-established, an alert sound will occur again 
and the message will change to that shown in FIG. 1. 

 

 FIG. 2 - Communication Not Established

FIG. 2 indicates that the keyboard was not located on the Global In/Out Ports in the General Page of the MIDI Setup (Global) 
Editor. The easiest solution is to click the “Run MIDI Setup Assistant” button, which will search and test all of your 
computer’s MIDI ports to find the required keyboard device and automatically configure the software. If successful, the 
dialog will then change to the image in FIG. 1.

    [Help] ( bu t t on )

Opens the Help File to this chapter.

    [Run MIDI Setup Assistant] (button)

Clicking this button runs the MIDI Setup Assistant, explained in detail in the next chapter.<MSA>

If you are having difficult establishing communication between the software and your keyboard device, please also refer 
to the following sections or documents:
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Installation and First Launch Tutorial (in the Tutorials Folder)<SetupKMO/TutFolder>

Communication Configuration - XS & XF<MotifCfg>

Communication Configuration - MOX & MOXF<MOXCfg>

Communication Configuration - Rack-XS<RackCfg>

Communication Configuration - S70/S90 XS<S90XSCfg>

Communication Configuration - KARMA Software <KMoCfg>

MIDI Port Manager <MidPort>
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MIDI Setup Assistant
Sections in this chapter:

Overview<MSA/Over>

Select Device Type/Connection Dialog<MSA/SelType>

If you are having difficult establishing communication between the software and your keyboard device, please also refer 
to the following sections or documents:

Installation and First Launch Tutorial (in the Tutorials Folder)<SetupKMO/TutFolder>

Communication Configuration - XS & XF<MotifCfg>

Communication Configuration - MOX & MOXF<MOXCfg>

Communication Configuration - Rack-XS<RackCfg>

Communication Configuration - S70/S90 XS<S90XSCfg>

Communication Configuration - KARMA Software <KMoCfg>

Additional Rack-XS Setup <RackSetup>

MIDI Port Manager <MidPort>

<Over><1528>
MIDI Setup Assistant - Overview
The MIDI Setup Assistant will automatically search all MIDI ports of your computer to find the required keyboard device 
and try to establish communication. If successful, it will also auto-configure various other MIDI-related settings to the 
factory defaults.

The MIDI Setup Assistant can be activated by the following methods:
- clicking the “Run MIDI Setup Assistant” button in the Communication Status Window as explained in the previous 
chapter; <CommStat>
- choosing the “MIDI Setup Assistant” command from the Menu Button in the MIDI Setup (Global) Editor.
<MsuEd>
As the first step in the procedure, the Select Device Type/Connection Dialog (described later in this chapter) will be 
shown as in FIG.1: <MSA/SelType>

 

FIG. 1 - Select Device Type/Connection Dialog

Select your Yamaha device type and MIDI connection type, and press OK. If the MIDI Setup Assistant is successful, the 
Communication Status Window will then change to the image shown in FIG. 2:

 

FIG. 2 - Communication Established

    The messages displayed will show “Yamaha Motif” for XS, XF, Rack-XS and S70/S90 XS, and “Yamaha MOX” for 
MOX and MOXF.
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�While it is running, it displays the dialog shown in FIG. 3, from which you can cancel at any time (depending on how many 
ports your multiport interface/driver and computer has, this may take a bit of time):

 

FIG. 3 - MIDI Setup Assistant While Running

 

FIG. 4 - Unsuccessful Conclusion To MIDI Setup Assistant

If your keyboard device is not located for some reason, you will see the dialog shown above in FIG. 4. If you cannot rectify 
the problem using the suggestions in the dialog, please see the links at the top of this chapter for more detailed 
information. 

    KARMA Motif requires that a Yamaha Motif/MOX be physically located on the Global In and Out Ports and Channels, or 
it will not generate MIDI. 

<SelType>
MIDI Setup Assistant - Select Device Type/Connection Dialog
 

The Select Device Type/Connection Dialog appears in the following cases:

- first launch of the KARMA software after a new installation or new Preferences file;
- running the MIDI Setup Assistant;
- selecting the “Restore Default Settings” items from the Menu Buttons of some of the MIDI Setup (Global) Editor pages.

    As shown above, the Cancel Button and the “Close All Other MIDI Ports” checkbox are not available during the first 
launch of the software or when creating a new Preferences File.
<1666>
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    [Select Device Type] (popup menu) [0...5]

Specifies the type of Yamaha device you are connecting to the software.
<1667>

       [Select Connection Type] (popup menu) [0...2]

Specifies the type of MIDI connection used by the Yamaha device and your computer. USB or FireWire/mLAN is 
recommended and requires the proper Yamaha drivers* to be installed. Use of a regular MIDI interface is not 
recommended and limits some features of the KARMA software. For example, the use of Remote Mode to control KARMA 
is only available with the USB or FW driver.

    When running the MIDI Setup Assistant, the software loops through all open ports and tests them all, regardless of the 
specified connection type. Therefore, if you specify one type but the device is located first on another type, the automatic 
connection will be made with the first located connection type.

    * For Yamaha drivers, see http://download.yamaha.com.
<1665>

    [Close All Other MIDI Ports] (checkbox)

(Not available during first launch.) When on, the MIDI Setup Assistant will close all open ports in the MIDI Port Manager 
except the ones required for the specified device. When off (the default setting), the required ports will be added to any 
ports that are presently open. For example, if you have more than one of the supported Yamaha devices, you may wish to 
use the MIDI Setup Assistant to switch between them. In addition, you may have other external controller ports already 
open that you wish to remain open. With the checkbox off, any ports required by the specified device will be opened if not 
open already and the other open ports will remain open. With the checkbox on, switching to the other device will close all 
other ports except the ones required for the specified device.
<1668><1669>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without continuing the MIDI Setup Assistant function (not available during first 
launch). The OK Button (green checkmark) closes the dialog and begins the MIDI Setup Assistant function to locate your 
keyboard device.

Motif XS, Motif XF, MOX, MOXF, Rack-XS, S70/S90 XS
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<0134>

Performance Editor
Sections in this chapter:

Overview<PE/Over>

Performance Management<PE/Perf>

Global Parameters<PE/Global>

 

<Over>
Performance Editor - Overview
The Performance Editor allows the Generated Effects for up to six different Modules and the settings for up to two 
Keyboard Layers to be configured as a “Performance.” Additional Module parameters not found in the GEs themselves are 
edited here, including Key Zones, MIDI Controller assignments, Triggering methods, and Velocity Response settings, among 
others.

Performance Management
Allows you to load Performances from banks of stored Performances, and to store edited Performances or new 
Performances you have created. 

Global Parameters
Parameters that affect the entire Performance such as Type, Time Signature, Master Transpose and Master Volume.
<0119>

Page Selection Buttons/Page Display Area
Allow different groupings of parameters (pages) to be displayed in the Page Display Area (center window of the screen). 
Each of the Performance Editor Pages has a separate chapter in this manual describing their parameters and features.
<PESect>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this editor:
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Click on the links below for detailed information on the utilities not fully explained here:

Initialize Current Performance…<PEUtils/Init>

Copy/Swap Module In Current Performance…<PEUtils/ModSwap>

Copy From Performance...<PEUtils/Mco>

Set Master Volume In All Performances…
Brings up the generic Specify Value Dialog, allowing you to enter a value that will be used to set the Master Volume of all 
Performances in the current KDF file to the same value (0-127).
<OthDlg/SpecVal>

Find Performance By Name...<OthDlg/FBN>

Performance Info<Pfi>

Performance Notes
Opens a document containing detailed information about the currently selected Performance, the same as the Performance 
Notes button in the Main Window’s Status Area. <SWGUI/PerfNotes>

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the Performance Editor > RT Parms Page for more information. 

<RPPEd><Perf>
Performance Editor - Performance Management
 

The parameters in this section allow you to load Performances from banks of stored Performances, and to store edited 
Performances or new Performances you have created. 
<0120><0136>
    [Bank] (popup menu) [0...number of banks in current KDF File-1]

Selects one of the Performance Banks within the current KDF File. The Performance is then loaded, replacing the previous 
settings, and the parameters in the various editing windows change to reflect the new values.
<0121><0137>
    [Performance] (popup menu) [0...127]

Selects one of many Performances from within the current Performance Bank. The Performance is then loaded, replacing 
the previous settings, and the parameters in the various editing windows change to reflect the new values.
<0137>

    [Open Performance Bank Display] (button)

Opens a Performance Bank Display for the current bank of Performances.
<PBD><0125>
    [Save] (button)

Brings up a Save Dialog allowing you to name the Performance and save it in a memory location. 
<OthDlg/Mbs><0126>
    [Clear] (button)

Brings up a dialog allowing you to clear the selected Performance. You will be given an opportunity to cancel. After 
clearing, the Performance will disappear from the Performance popup menus. 

    Storing or clearing only affects the Performance in RAM. To save these changes to disk, you must save the KDF File by 
choosing “Save,” “Save As…” or “Save All…” from the File menu.

    Since the changes are not written to disk until one of the Save commands is executed, to undo a change after you have 
stored or cleared a Performance you can close and reopen the current KDF file.

<Global>
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Performance Editor - Global Parameters
 

The parameters in this section affect the entire Performance. An audio-style meter underneath the Master Volume Slider 
displays the MIDI activity for all combined Modules and Keyboard Layers.
<0123>
    [Performance Type] (popup menu) [0...5]

Sets the number of Modules used in a Performance. Setting this to other than “6 Modules” will cause parameters for 
unused Modules to become grayed out.
<0124>
    [Time Signature] (popup menu) [0, 1...48 = GE/TS, 1/4...16/16]

If set to “GE/TS” the individual Time Signatures of the GEs are used in each Module. Other settings override the GEs and 
set an overall Time Signature for the whole Performance.

    If the GE’s Phase Length Mode is not  “TS – Time Signature,” then when the Performance Time Signature here is set to 
anything other than “GE/TS” the GE will function as if it is set to “TS-Time Signature,” since it needs some reference to 
a time signature to adjust to a new one. In this case, it acts like it has a setting of 4/4 in both Phases, and a Phase Cycle 
Mode of “E.”

    When changing the Performance Time Signature to a different Time Signature, the previous setting will be completed 
before changing to the new one. In other words, if you change to 1/4 in the middle of a measure of 4/4, the measure will 
complete a full four beats before changing to 1/4.
<0141><Transpose>
    [Master Transpose] (numerical) [-12...+12 semitones]

Transposes the entire KARMA Performance up or down in semitones. This allows you to play in one key, but have KARMA 
generate musical output in a different key. If set to other than “0”, the semitone transpose value will be shown in front 
of the chord name displayed in the application’s Main Window.
<0139>

    [Master Volume] (numerical) [0...127]

Controls the overall volume level of the entire Performance.
<0140>

    [Master Volume Slider] (slider)

Controls the overall volume level of the entire Performance.
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GE Setup/Mix
Sections in this chapter:

Overview<MixEd/Over>

Module Parameters<MixEd/ParmsGE>

Keyboard Layer Parameters<MixEd/ParmsKbd>

 

<Over>
GE Setup/Mix - Overview
The GE Setup/Mix Page provides a centralized location for setting the Generated Effect for each Module, whether they are 
off or on (running), the Module’s Transpose setting and a descriptive name for each Module and Keyboard Layer. 
Furthermore, it provides an alternate view and means of controlling the mix of the 8 Track Volumes in the currently 
selected scene. An audio-style meter underneath each Volume Slider displays the MIDI activity of the 8 Track Volumes. A 
row exists for each Module, which may be grayed out depending on how many Modules are active in the current 
Performance, according to the Performance Type parameter, while the two Keyboard Layers are displayed at the top of 
the page. The page can be divided into the following areas:

Module Parameters
Allows you to select one of many GEs to be used by the Module, give each Module a descriptive name that can be viewed in 
other pages of the interface, control the Transposition, Solo and Run (On/Off) status of each Module, and set the Track 
Volume of each Module in the current scene.

Keyboard Layer Parameters
Allows you to give each Keyboard Layer a descriptive name that can be viewed in other pages of the interface, control the 
Solo of each Keyboard Layer, and set the Track Volume of each Keyboard Layer in the current scene.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy From Performance... <PEUtils/Mco>

Load GE Options... <Prefs/GELoad>

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the Performance Editor > RT Parms Page for more information. 
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<RPPEd>

<ParmsGE>
GE Setup/Mix - Module Parameters
 

The parameters in this section control which GE is loaded into a particular Module, allow you to give each Module a 
descriptive name that can be viewed in other pages of the interface, control the Transposition, Solo and Run (On/Off) 
status of each Module, and set the Track Volume of each Module in the current scene. An audio-style meter underneath 
each Volume Slider displays the MIDI activity for that Module.
<0106><0107>

    [Module Name] (button/label)

Clicking the round triangle button to the left of the label opens the Module Name Select Dialog, allowing a descriptive name 
to be chosen for each Module from a large list of predefined names. By default, in a new Performance the Modules are 
named Module 1, Module 2, Module 3 etc., but you can choose something that is more appropriate if desired. These names 
then show up in other pages of the Performance Editor, the top of the GE Editor, and the RT Control Window, making it 
easier to identify a particular Module.
<PEUtils/ModNames><0112>
    [Run] (button) [Off, On]

Turns on the selected Module. When off, the Module may still playing, but it is muted. The Run settings are stored with the 
Performance. Turning Run off effectively shuts off the Module in all scenes, regardless of the Track Mute settings.
<0113>
    [Solo] (button) [Off, On]

Solos the selected Module, even if the Run button is off or the Track is muted. Solos are NOT stored with the Performance.
<0104>
    [GE Bank] (popup menu) [number of GE Banks in current KDF File]

Selects one of the GE Banks within the current KDF File. The GE is then loaded into that Module, replacing the previous 
settings, and the parameters in the various editing windows change to reflect the new values. Using this menu is the same 
as using the GE Bank menu in the Generated Effect Editor, for the Current Edit Module.
<0105>
    [GE] (popup menu) [1...128]

Selects one of many GEs from within the current GE Bank for that Module. The GE is then loaded into that Module, replacing 
the previous settings, and the parameters in the various editing windows change to reflect the new values. Using this 
menu is the same as using the GE menu in the Generated Effect Editor, for the Current Edit Module.

    Selecting a new GE with the Bank or GE popup menus also changes which Module is the “Current Edit Module.” This 
affects which Module’s information is displayed in the Status Area of the Main Window, as well as which GE is shown for 
editing in the GE Editor.<GE>

    GEs can also be selected in several other ways: from the top of the GE Editor, or by choosing a GE in an open GE Bank 
Display Window. In those cases, the GE is loaded into the Current Edit Module.
<0111>
    [Transpose] (numerical) [-36...+36 semitones]

Transposes the output of a Module's phrase, by transposing the input notes up or down in semitones before they create the 
GE’s Note Series or influence the pitch of a GE’s Drum Pattern. Therefore, this is a “pre” transpose, which effectively 
controls the pitch of the phrases or chords produced by the KARMA module. This parameter will often be assigned to an RT 
Switch in the Master Layer for transposing the GE’s phrase within different scenes. Note that this does not transpose the 
effective range for soloing when using Direct Indexing. However, the separate “Transpose” parameter in the GE Editor > 
Direct Index Page can be used to transpose the Direct Indexing range with regards to the GE. See Direct Index - General 
Parameters.
<DixEd/ParmsGen>

    [~Octave Transpose] (virtual) [-36...+36 semitones; quantized]
       [~Oct/5th Transpose] (virtual) [-36...+36 semitones; quantized]

These are not true parameters, but “virtual” parameters for RT Parm control. They do not physically exist on the GE 
Setup/Mix Page, but perform a modifying function on the Transpose parameter above. They can be found in the GE 
Setup/Mix Group when assigning parameters in the Performance Editor > RT Parms Page, and have a tilde (~) at the 
beginning of the parameter name (indicating that it is virtual). These parameters operate exactly the same as the 
Transpose parameter above, but are specifically for assigning to a continuous controller such as a slider. With “Octave 
Transpose” the transpose setting will only change to the octave values (-36, -24, -12, 0, 12, 24, 36), and with 
“Oct/5th Transpose” the values will only change on the octave or fifth values (-36, -29, -24, -27, -12, -5, 0, 7, 12, 
19, 24, 31, 36).
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<0110>
    [Track Volume] (numerical) [0...127]

Displays the value of the Track Volume Slider as it is moved, or allows you to directly enter a volume for the Module 
from 0 to 127, moving the slider to that value. This value is stored in each scene.
<0118>

    [Track Volume Slider] (slider) [0...127]

Controls the volume of the Module. Click on the head and drag, or click anywhere on the slider to jump to that location. If 
the value is edited, a yellow dot will be shown (controlled by the “Change Appearance When Edited” item in the Menu 
Button for the Real-Time Control Editor). You can double-click the slider to return to the original value. A controller can 
be assigned in the MIDI Setup (Global) > RTC Setup Page. 

<MsuRTC><ParmsKbd>
GE Setup/Mix - Keyboard Layer Parameters
 

The parameters in this section allow you to give each Keyboard Layer a descriptive name that can be viewed in other 
pages of the interface, control the Solo of each Keyboard Layer, and set the Track Volume of each Keyboard Layer in the 
current scene. An audio-style meter underneath each Volume Slider displays the MIDI activity for that Keyboard Layer.

    The Keyboard Layers are configured on the Key Zones Page.
<KeyEd><2000><2001>
    [Kbd Layer Name] (button/label)

Clicking the round triangle button to the left of the label opens the Module Name Select Dialog, allowing a descriptive name 
to be chosen for each Module from a large list of predefined names. By default, in a new Performance the Keyboard Layers 
are named Keyboard 1 and Keyboard 2, but you can choose something that is more appropriate if desired. These names 
then show up in other pages of the Performance Editor, the top of the GE Editor, and the RT Control Window, making it 
easier to identify a particular Keyboard Layer.
<PEUtils/ModNames><2008>
    [Solo] (button) [Off, On]

Solos the selected Keyboard Layer, even if the Track is muted. Solos are NOT stored with the Performance.
<2002>
    [Track Volume] (numerical) [0...127]

Displays the value of the Track Volume Slider as it is moved, or allows you to directly enter a volume for the Keyboard 
Layer from 0 to 127, moving the slider to that value. This value is stored in each scene.
<2003>

    [Track Volume Slider] (slider) [0...127]

Controls the volume of the Keyboard Layer. Click on the head and drag, or click anywhere on the slider to jump to that 
location. If the value is edited, a yellow dot will be shown (controlled by the “Change Appearance When Edited” item in the 
Menu Button for the Real-Time Control Editor). You can double-click the slider to return to the original value. A controller 
can be assigned in the MIDI Setup (Global) > RTC Setup Page. <MsuRTC>
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Control
Sections in this chapter:

Overview<CtlEd/Over>

Control Parameters<CtlEd/ParmsControl>

Clock Parameters<CtlEd/ParmsClock>

Note Map Parameters<CtlEd/ParmsNM>

 

<Over>
Control - Overview
The Control Page contains a number of parameters related to the range of the notes, the tracking of the Modules when you 
move the input notes around, whether the Modules are driven by the internal clock or the Manual Advance Feature, and 
whether the notes of a Module are remapped to other notes. A column exists for each of the Modules in a Performance, 
which may be grayed out depending on how many Modules are active in the current Performance. At the top of each 
column is the Module Name, which can be edited from the GE Setup/Mix Page. Each column is divided into three groupings 
of parameters:

Range Parameters
Allow control over some overall note range and tracking aspects of the Module.

Clock Parameters
Allow a Module’s effect to be “Manually Advanced” by repeated triggers assigned in the Dynamic MIDI Page. 

Note Map Parameters
Allow a Module’s effect to be run through a Note Map Table, where each note may be individually changed to a different 
note. 

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy From Performance... <PEUtils/Mco>

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the Performance Editor > RT Parms Page for more information. 
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<RPPEd><ParmsControl>
Control - Range Parameters
 

These parameters affect some overall operational aspects of the Module related to the range of the notes and the tracking 
of the Modules when you move the input notes around (by playing in different octaves on the keyboard).
<0081>

    [Module Name] (label)

Displays a descriptive name for each Module, which can be assigned on the GE Setup/Mix Page.
<MixEd/ParmsGE><0083>
    [Force Range] (popup menu) [0...4]

Allows the input notes to be restricted to several useful ranges, before they are sent to the GE. In the following 
discussion, the use of “C2B2” indicates the octave below Middle C with reference to Middle C as C3 (Yamaha standard). If 
the “Middle C Display” option in the Preferences - Workspace settings. is set to “C4” for Korg standard, this 
parameter’s options using C2B2 will instead show C3B3. Regardless of the Middle C setting, the parameter works the 
same in both cases.
<Prefs/MidC>

0: Off - as played
Input notes are passed on to the GE as played, with no further alteration. 

1: Lowest - all notes in same octave as lowest note
The input notes will be forced to a range within one octave of the lowest note, and duplicate pitches are discarded. Useful 
for eliminating inversions so that a chord voiced in different ways produces identical results. See FIG. 1 below.

2: Highest - all notes in same octave as highest note
The input notes will be forced to a range within one octave of the highest note, and duplicate pitches are discarded. Useful 
for eliminating inversions so that a chord voiced in different ways produces identical results. See FIG. 1 below.

 

Played on keyboard:
[E1, G#2, E3, B3, D#4]  - (EMaj7 chord, open voicing)

Resulting transposed input notes:
Lowest: input notes transposed to [E1, G#1, B1, D#2]
Highest: input notes transposed to [E3, G#3, B3, D#4]

3: C2B2[1] - all notes near 4th octave (compress 1 oct, maintain inversion)
The input notes will first be compressed to a one octave span and then forced to a range near the middle (4th) octave, so 
that wherever you play on the keyboard, it produces a phrase near the same octave (you can then change the actual 
octave it ends up in with the Module’s GE Setup/Mix: Transpose parameter). This is similar to how most arranger 
keyboards work, and essentially maintains the inversion the chord was played with, although the compression of notes 
into one octave may change the voicing (open voicings will be reduced to closed voicings).

The “Force Range Wrap” parameter specifies the highest scale step after which the generated phrase will transpose down 
an octave to stay near the 4th octave. For example, with the Force Range Wrap setting at F#: If the pitch of the lowest 
note or root is C to F#, it will be placed in the 4th octave with the other notes grouped above it. If the pitch of the lowest 
note or root is a G to B, it will be placed in the 3rd octave, with the other notes grouped above it (thereby dropping the 
input notes by an octave). This essentially maintains the inversion the chord was played with (although the voicing will be 
compressed into one octave) - notes may also extend into the 5th octave or 3rd octave. This is effective when you wish 
to produce phrases or patterns having a similar inversion to what was played, but in a fixed range regardless of where 
you are playing on the keyboard. See FIG. 2 below.
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Played on keyboard:
[E1, G#3, B3, D#4] - (EMaj7 first inversion)
[G#2, B3, D#4, E4] - (EMaj7 second inversion)
[B2, D#4, E4, G#4] - (EMaj7 third inversion)
[D#4, E4, G#4, B4] - (EMaj7 fourth inversion)

Resulting transposed input notes with C2B2[1]:
[E2, G#2, B2, D#3] - (EMaj7 first inversion)
[G#1, B1, D#2, E2] - (EMaj7 second inversion)
[B1, D#2, E2, G#2] - (EMaj7 third inversion)
[D#2, E2, G#2, B2] - (EMaj7 fourth inversion)

    When the GE’s Note Series: Note Type setting is “Scalic or “Scalic 2”, chord recognition is used to determine the 
pitches in the Note Series, and the Force Range Wrap setting relates to the bass note of the recognized chord. In other 
words, CMaj/G, EbMaj/G and GMaj all have “G” as the bass note of the chord, and if Force Range Wrap was set to “F#” 
the phrases would all drop an octave at the same point (when going down from G to F#).

4: C2B2[2] - all notes in 4th octave (compress 1 oct, can change inversion)
The input notes will be compressed and forced to a range strictly within the 4th octave (you can then change the actual 
octave it ends up in with the Module’s GE Setup/Mix: Transpose parameter). Therefore, the chord inversion may change 
significantly; for example, the bass note may change. This is effective when you want to absolutely limit the input notes 
to a specific octave. The Force Range Wrap parameter is not available in this case. See FIG. 3 below.

 

Played on keyboard:
[E1, G#3, B3, D#4] - (EMaj7 first inversion)
[G#2, B3, D#4, E4] - (EMaj7 second inversion)
[B2, D#4, E4, G#4] - (EMaj7 third inversion)
[D#4, E4, G#4, B4] - (EMaj7 fourth inversion)

Resulting transposed input notes with C2B2[2]:
[D#2, E2, G#2, B2] - (EMaj7/D#)  (all identical)

5: C2B2[3] – all notes in 4th octave (don’t compress, maintain inversion)
(new in version 3.2) This setting is identical to 3: C2B2[1], with the exception that notes are not compressed into a one 
octave range prior to being shifted into the 4th  octave area, thereby maintaining not only the inversion they were played 
with, but the voicing intervals. In other words, if you play an open-voiced version of a chord spanning two octaves, it will 
be shifted into the 4th octave relative to the Force Range Wrap setting while keeping the two-octave spread of the input 
notes (you can then change the actual octave it ends up in with the Module’s GE Setup/Mix: Transpose parameter). See 
FIG. 4 below.
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Played on keyboard:
[E1, G#3, B3, D#4] - (EMaj7 first inversion)
[G#2, B3, D#4, E4] - (EMaj7 second inversion)
[B2, D#4, E4, G#4] - (EMaj7 third inversion)
[D#4, E4, G#4, B4] - (EMaj7 fourth inversion)

Resulting transposed input notes with C2B2[3] (octave shifted, voicing same):
[E2, G#4, B4, D#5] - (EMaj7 first inversion)
[G#1, B2, D#3, E3] - (EMaj7 second inversion)
[B1, D#3, E3, G#3] - (EMaj7 third inversion)
[D#2, E2, G#2, B2] - (EMaj7 fourth inversion)

    This only has an effect when the Note Series Note Type is “Regular” (meaning the input notes are taken as played) and 
has no effect on melodic Drum GEs.
<0082>
    [Force Range Wrap] (popup menu) [0...11: C...B]

When Force Range (above) is set to “3: C2B2[1]” or “5: C2B2[3],” this parameter sets the highest scale step for the 
chord’s root or bass note, after which the range-modified input notes will be dropped down an octave in order to stay 
centered around the 4th octave. This is similar to how most arranger keyboards work. For example, if the value is F#, 
then starting with G the notes will be dropped down an octave.

FIG. 5 shows an example where a Maj7 chord in a variety of voicings is played through 7 scale tones, i.e. CMaj7, DMaj7, 
EMaj7, FMaj7, GMaj7 etc. with a Force Range setting of 3: C2B2[1]. Since Force Range Wrap = 6: F#, the resulting input 
notes drop down an octave starting with the GMaj7 chord. This allows you to keep a GE in a specific range regardless of 
where a chord is played on the keyboard, but to adjust at which point it drops down an octave. Furthermore, the diagram 
shows the effect of the notes being compressed to one octave, even though the input notes are widely spaced open 
voicings.
 

FIG. 6 shows the same Maj7 chord voicings played with a Force Range setting of 5: C2B2[3]. Since Force Range Wrap = 4: 
E, the resulting input notes drop down an octave starting with the Fmaj7 chord. Furthermore, the diagram shows that the 
widely spaced open voicings of the input notes are maintained as played, with the results shifted so that the lowest root 
note remains near the 4th octave.
 

    Not available unless Force Range is set to 3: C2B2[1] or 5: C2B2[3].
<0084>
    [Root Position] (button) [Off, On]

Allows the GE Note Series to be created in root position, regardless of the inversion of the input notes, based on chord 
recognition. Notes generated from the Note Series may then behave more predictably with all inversions of a chord.

In other words, when this is off, if you play CMaj/E, the Note Series will start from E and continue up, or if you play 
CMaj/G, the Note Series will start with G (this assumes also that Note Series Inversion is “0”). By using Root Position 
set to on, you can make sure that any inversion of a chord ends up the same. For example, CMaj/E and CMaj/G will both 
be the same as CMaj, and the Note Series will start from a C.
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�    When Root Position is turned on for any Note Type except “Regular” (i.e. Scalic, Scalic2, Chromatic, Whole Tone 
etc.), the behavior is very consistent: the scale specified by the Note Type is place in root position before applying the 
rest of the Note Series parameters to create the Note Series.

However, when Root Position is turned on for Note Type = “Regular,” the behavior is a bit different, and requires some 
explanation. If the input notes span an octave or less, the effect is very predictable, and similar to the effect when Note 
Type is any other setting besides “Regular.”

 

If the input notes span more than an octave, the effect is less predictable. If the Input Sort is “Up, As Played, or 
Random,” the first note of each replication will be the root pitch class (meaning that the Note Series will start with the 
root note, i.e. if the key of the chord is D, the first note will be a D). If the Input Sort is “Down”, then the last note of 
each replication will be the root pitch class. However, notes lower than the root note will still be allowed, since, after all, 
the purpose of “Regular” Note Type is to collect the notes as played. For example, with Input Sort “Up,” if you play G2 – 
C4 – E4 – G 4 (Cmaj/G), the notes will be ordered so that a C is first, but the low G will still be present in each 
replication.

 

Note that Force Range may be applied in conjunction with Root Position. For example, with any Force Range setting other 
than off, the effects of Root Position with Note Type = “Regular” become quite predictable, as spans greater than an 
octave are essentially compressed into one octave before going into the Note Series section.

    When the GE Type is “Generated-Drum,” the notes come from Drum Patterns and not the Note Series. The Drum 
Patterns can be used to generate melodies, in addition to drum and percussion grooves. Root Position also has a similar 
effect on how the Drum Patterns are transposed, but only if “Drum-Track Keyboard” is on - see GE Editor - Drum - 
Pattern Editing Grid & Associated Parameters.
<DrmEd/PatGrid>

In addition, when the GE Type is “Generated-Drum,” if using arpeggiated pitch bending (based on the Note Series), the 
resulting pitch bend data will also be affected - see GE Editor > Bend Page - Drum Parameters.
<BndEd/ParmsDrm>

When the GE Type is “Real-Time,” this parameter has no effect unless you are using Dynamic MIDI to Direct Index the 
Note Series - see Dynamic MIDI Destinations.

<DynDst><ParmsClock>
Control - Clock Parameters
 

Here you can make settings for the clock that will operate the KARMA Module (and its GE). The Clock Parameters control 
whether the effect will be advanced by the Internal/External Clock (automatically generated), or whether certain actions 
as configured in the Dynamic MIDI Page will supply “triggers” to advance the effect manually (Manual Advance). This can 
be used so that various triggers such as foot pedals or keys in a certain area of the keyboard give the user rhythmic 
control over when the notes will be generated, while the exact order of the notes as they are generated are controlled by 
the other settings of the GE.
<0085>
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   [Clock Advance Mode] (popup menu) [0...4]

Selects one of several different modes for advancing the generation of the GE, including the internal clock, user supplied 
triggers from Dynamic MIDI, or combinations of both.

0: Internal
Allows the Internal Master Clock (or externally received Midi Clock) to advance the effects. This is most normal, for 
automatically generated effects. The Rhythm Patterns of the effect decide when the notes will be generated.

1: DynMidi
Allows various actions configured in the Dynamic MIDI Page to supply “triggers” to advance the effect. Exactly how the 
advancing will be performed is determined by the setting of the other Clock Parameters in this section.

2: Int + D - Internal and DynMidi
Allows the Internal Master Clock (or externally received Midi Clock) to advance the effects according to the Rhythm 
Patterns, while allowing actions configured in the Dynamic MIDI Page to supply additional triggers. For example, you could 
use this to have a normal automatically generated arpeggio and then have the Mod Wheel assigned to “sweep advance” the 
effect at the same time.

3: Int + DS - DynMidi stops Internal
Same as “Int + D” above, except the Master Clock will be stopped when receiving a trigger from Dynamic MIDI. For 
example, you can use this to have a normally generated phrase that can be interrupted and “taken over” by user 
controlled triggers.

    The following 4 parameters are not available when Clock Advance Mode is set to “Internal”:
<0086>
    [Clock Advance Size] (popup menu) [0...11]

Specifies the unit by which the GE’s Phrase or Pattern will be advanced by triggers supplied through Dynamic MIDI.

0...10: 64th Note Triplet to Quarter Note
Each trigger advances the effect by the chosen rhythmic size, according to the Rhythm Patterns stored in the GE. This can 
be used so that it takes several triggers to advance the effect, so that when layering several modules using these type of 
effects, they will not all advance at the same rate. For example, if the GE had a Rhythm Pattern of straight 8th notes and 
the Size menu was set to “16th Note,” then each trigger would advance the effect by a 16th note, and it would 
consequently take two received triggers to generate each note or cluster. If the Size menu was “32nd Note,” it would 
take four received triggers to generate each note or cluster.

11: Event
The Rhythm Patterns stored with the GE are ignored, and each trigger received advances the effect, generating a note or 
cluster (chord). 
<0087>

    [Clock Advance Velocity Sensitivity] (numerical) [001...127]

Specifies the lower limit of a scaled velocity range (‘n’ to 127). Triggers being provided by a velocity sensitive 
controller will be scaled according to this before being applied to the generated notes. In other words, if the Dynamic MIDI 
Source configured to provide the triggers is Note or Velocity, the phrase will be produced by applying the velocity of each 
Manual Advance trigger to the notes as they are generated, as scaled by this parameter. For example, with a setting of 1, 
the velocity data will be input to the GE with an unmodified range of 1 ~ 127 (full sensitivity). With a setting of 64, 
velocity data in the range of 1 ~ 127 will be scaled to the range of 64 ~ 127, and the controller will appear to be half as 
sensitive.
<0088>
    [Chord Trigger Mode] (popup menu) [0...4]

Specifies how a chord will be sounded when input from the keyboard in the input note area. This can be used to allow the 
input chord to play the first note or chord, after which subsequent triggers continue with Manual Advance.

0: Off
There will be no sound when you input a chord from the keyboard. This is analogous to a guitarist changing the position of 
the left hand - it prepares a chord for the picking action of the right hand. In other words, when you play a chord on the 
keyboard, nothing will happen until you start sending triggers by whatever action is selected in the Dynamic Midi Page. 

1: 1st - play first note
When you input a chord from the keyboard, the first step of the phrase or pattern will sound. When you send in triggers 
with the controller, the phrase or pattern will continue advancing (from the second step that would normally be 
generated).

2: Con - play chord and continue
When you input a chord from the keyboard, the first several steps of the phrase or pattern will sound, according to the 
number of notes that you input. The Strum parameter in the GE Editor > Cluster Page controls an amount of strum for the 
chord. When triggers are received after this, the effect will continue advancing from where it currently is.
<CluEd/Strum>

3: Rst - play chord and restart
Same as 2: Con, except subsequently received triggers restart the effect from the beginning.
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4: 2nd - play chord and continue from second note
Same as 2: Con, except subsequently received triggers start with what would be the second note of the effect, as if only 
1 note had been generated (and not a chord). Useful for certain guitar fingerpicking simulations, by allowing you to create 
a natural connection between the played chord and the fingerpicking caused by operating the controller.
<ParmsNM>
Control - Note Map Parameters
 

The Note Map Parameters allow a “final note shaper” to be applied at the end of the KARMA note generation process. 
Implemented as a large grid (128 x 129), it allows any incoming MIDI note generated by KARMA (0~127) to be remapped 
to any other MIDI note (0~127), or filtered out (removed). Therefore, a diagonal line represents “linear/no change,” and 
what goes in is what comes out. You can use it to remap drum kits from one set of drum sounds to another, remove or 
substitute different drum sounds within the same kit, remove certain pitches from melodic output, constrain output 
pitches to various scales, limit notes generated thru Melodic Repeat to certain pitches, and more. Note Maps may are also 
referred to in these descriptions as “tables”, since a Note Map is essentially a table of x,y values.

The black and blue Table Display object shows a tiny version of a portion of the currently selected table. The Note Map 
Editor can be opened by clicking on this representation of the table, allowing you to edit the values in the table. You can 
also open it from the Window Menu > Note Map Editor.
<NteMap>

Each Performance contains a single user table (named “Custom”). The settings of this single table are stored inside the 
Performance. Additionally, there are a number of tables stored in global memory, with pre-defined functions, that can be 
selected for use by any Module in any Performance.

The same table can be applied to multiple Modules at the same time. All Modules can run through the single Custom table at 
the same time, or be assigned to utilize various Global Maps, in any combination.
<1547>
    [Note Map Mode] (popup menu) [0...4]

Selects one of several different modes of operation, controlling whether all notes generated by KARMA or a subset of 
those notes are modified by the specified Note Map Table.

0: Off
The table is inactive and no filtering or remapping is done.

1: On-Main     Main Notes Only
The table is used to map or filter notes being generated from the Note Series or Drum Pattern(s), but not any notes 
generated as a result of the Melodic Repeat parameters.

2: On-Rpt       Repeat Notes Only
The table is used to map or filter notes being generated as a result of the Melodic Repeat parameters, but not the main 
notes generated by the Note Series or Drum Pattern(s). For example, this can be used to “thin out” repeats or limit 
“strange notes” in Drum Patterns from transposed repeats, without affecting the main notes.

3: On-All 1     Main + Repeats (transposed)
The table is used to map or filter all notes being generated by the module. Any repeated notes generated by Melodic Repeat 
features are based off of the transposed note (which then runs through the Note Map Table as well). So if a note is altered 
to another note by the Note Map Table, any repeated notes start with the transposed pitch. In versions of KARMA prior to 
3.0, this was the only “All” option - however, this setting does not always operate logically especially when used on 
drum patterns. For example, if you run a snare through a Note Map Table such that it is mapped to a sidestick, but then set 
up repeats with a transpose of 0 on that Drum Pattern, the repeats enter the table as sidesticks, and may therefore be 
changed to some other note, and not continue repeating as sidesticks. For that reason, the following additional option was 
added:

4: On-All 2     Main + Repeats (original)
The table is used to map or filter all notes being generated by the module. Any repeated notes generated by Melodic Repeat 
features are based off of the original note. So if a note is altered to another note by the Note Map Table, any repeated 
notes start with the original pitch (which then runs through the Note Map Table as well). So if a note is altered to another 
note by the Note Map Table, any repeated notes start with the original pitch. For example, if you run a snare through a 
Note Map Table such that it is mapped to a sidestick, but then set up repeats with a transpose of 0 on that Drum Pattern, 
the repeats enter the table as snares (original pitch), and are therefore changed into sidesticks as well, so that you get 
the correct effect of repeating the same note. This option was added in KARMA 3.0, and is the recommended setting to use 
for most applications. It generally replaces the previous option, which has been retained for historical reasons and for 
compatibility with some existing content.
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<1548><1551>
    [Note Map Table] (popup menu) [0 = Custom, 1...64 = Global]

Selects the “Custom” Note Map in each Performance, or one of the Global Note Map Tables. The black and blue Table 
Display object below it shows a tiny version of a portion of the actual table. The Note Map Editor can be opened by clicking 
on this representation of the table, allowing you to edit the values in the table. You can also open it from the Window Menu 
> Note Maps item.
<NteMap>
    [~Note Map Table + Off] (virtual) [-1 = Off, 0 = Custom, 1...64 = Global]

This is not a true parameter, but a “virtual” parameter for RT Parm control. It does not physically exist on the Control 
Page, but performs a modifying function on the Note Map Table parameter above. It can be found in the Control Group when 
assigning parameters in the Performance Editor > RT Parms Page, and has a tilde (~) at the beginning of the parameter 
name (indicating that it is virtual). This parameter operates exactly the same as Note Map Table above, with the 
additional feature that a setting of -1 turns the Note Map Table off. This allows a single RT Slider in the Master Control 
Layer of a Performance to select various Note Maps, yet also be able to bypass them when at the minimum setting.
<1552>

    [Note Map Transpose] (numerical) [-12...+12]

Allows you to set up a “fixed” Modal Note Map, without “Chord Track” or “Keyboard Track (C1 Ref),” and then apply an 
offset to transpose it to other keys. In other words, you could set up a fixed map so that no matter what you play, it 
comes out in C Mixolydian. Then you can set the Note Map Transpose to +2, and it would be in D Mixolydian, etc.

    Only available when “Chord Track” is off.
<1549>
    [Chord Track] (checkbox) [Off, On]

Selects whether the Note Map Table will track your chord changes within the range of a single octave.

The table programming is done with the key of C as a reference. As an example, assume you play a C Chord that generates 
a C Major arpeggio (C-E-G etc.) in the Middle C octave (C3-60 to C4-72). You edit that octave in the note Map Editor to 
have no 3rd (E4 removed). With Chord Track set to off, playing a D chord would exhibit no changed notes, because there is 
no E4 in the arpeggio. With Chord Track set to on, the D chord would sound the same as the C chord (no 3rd), except it 
would be in the key of D. When on, all chords played in the Middle C octave would have their 3rd removed. However, if you 
play the input chord an octave lower, the notes would go through the octave of the table below Middle C, and would not 
have the removed note. This allows you to set up different maps for each octave, yet have the table track your chord 
changes within each octave.

    The functioning of this parameter may be additionally modified by Kbd Track (C1 Ref) below.
<1550>
    [Kbd Track (C1 Ref)] (checkbox) [Off, On]

Selects whether the Note Map Table will track your chord changes across the entire keyboard, with reference to C1 (MIDI 
Note Number 36).

    C1 or C2 will be displayed in the parameter name depending on the settings of the “Middle C Display” option in the 
Preferences - Workspace settings. This is only a display setting and the feature operates identically either way, with 
reference to MIDI Note Number 36. <Prefs/MidC>

When Chord Track is already turned on, setting Kbd Track to on provides the additional functionality of tracking the table 
to the lowest note of the input chord (with reference to C1), no matter where it is played. In other words, any chord 
played in any octave will be transposed so it ends up with its lowest note in the C1 octave before being run through the 
table, and returned to the correct octave after. As an example, assume you play an input chord in the key of C in the C1 
octave (lowest octave of a 61 note keyboard). If you remove the 3rd (for example) which is E2, playing a chord anywhere 
on the keyboard will have the lowest note run through the table at C1 and hence keep the exact same table mapping for any 
chord, removing the third in any key, in any octave. This allows you to set up complex melodic maps spanning several 
octaves if desired, and then have them track your chords all over the keyboard.

    Not available unless Chord Track is set to on.
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Trigger
Sections in this chapter:

Overview<TrgEd/Over>

Quantize and Delay Start Parameters<TrgEd/ParmsDel>

Note and Envelope Triggering Parameters<TrgEd/ParmsTrig>

Trigger By Module Parameters<TrgEd/ParmsPerc>

Cutoff Grid<TrgEd/ParmsCut>

 

<Over>
Trigger - Overview
The Trigger Page contains parameters that control different options for how and when the GE contained inside a Module 
will be triggered. It also specifies whether a Module will cutoff other Modules that may be playing, whether to delay the 
start of the Module after it has been triggered, and settings that control the Stutter feature (rapid retriggering). The 
triggering of various envelopes that may be used in a GE may also be individually controlled here.

There are essentially two different “components” of a GE that may be triggered and controlled:

(1) The notes: the actual start of the generation of notes from the Note Series (or Drum Pattern), the restarting from the 
programmed beginning of the effect, and whether playback continues when keys are released on a keyboard/controller.

(2) The envelopes: each of a GE’s three envelopes can be individually triggered, with special latching options that permit 
the envelopes to complete all or portions of their shape when keys are released on a keyboard/controller. The latch 
options also permit looping of all or portions of the envelope, in conjunction with the GE Editor > Envelopes Page Loop 
parameters. <EnvEd/Loop>

A column exists for each of the Modules in a Performance, which may be grayed out depending on how many Modules are 
active in the current Performance. The Module Name displayed at the top of the column can be assigned on the GE 
Setup/Mix Page. Each column is divided into seven sections, which can be roughly grouped into four areas:

Quantize and Delay Start Parameters
Determines whether the triggering of the Module will be quantized to a specified metric division, and allows the start of a 
Module’s effect to be delayed by a certain amount once it is triggered.

Note and Envelope Triggering Parameters
Control the triggering, restarting and latching of the notes and envelopes in the effect, as well as settings for the Stutter 
feature.

Trigger By Module Parameters
Allow a Module’s effect (both notes and envelopes) to be triggered by a percentage of the length of another Module’s 
effect, in addition to the other triggering options - allowing Modules to “trade-off” with each other.
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Cutoff Grid
Controls whether the triggering of a Module’s effect will stop any other Module’s effects that are playing. In the Factory 
Performances, this is often used to have the drum fill (Module 6) shut off the main drum groove (Module 1) when it is 
triggered.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy From Performance... <PEUtils/Mco>

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the Performance Editor > RT Parms Page for more information. 

<RPPEd><ParmsDel>
Trigger - Quantize and Delay Start Parameters
 

The parameters in this section control quantization of the triggering of the Module, and allow you to program a delay from 
when it is triggered to when it actually starts.
<0090>
    [Module Name] (label)

Displays a descriptive name for each Module, which can be assigned on the GE Setup/Mix Page.
<MixEd/ParmsGE><0101>

    [Quantize Triggers] (checkbox) [Off, On]

Allows chords and other incoming triggers to be quantized to an already existing beat or groove.

Off
No quantization is performed. Triggering will occur instantly at the moment you play the keyboard or activate a trigger 
through Dynamic MIDI. Most useful for natural glissando and cadenza type effects, where locking to a beat is unnecessary, 
or there is no beat to lock to.

On
Incoming triggers are quantized to a metric division of the beat specified by the Quantize Window setting, relative to the 
current tempo. This is useful when KARMA is generating grooves and you are trying to lock your chord changes to the 
beat, or when triggering effects via other means.
<0091>
    [Quantize Window] (popup menu) [0...5]
Specifies the metric division by which input note data or Dynamic MIDI Triggers will be quantized before triggering the 
Module and the start of the phrase. Use larger values for more relaxed triggering.

16th Triplet…Quarter:
Specifies the time window as a note value interval relative to the tempo. For triplet-based patterns, you may need to 
select one of the triplet-based settings if you intend to retrigger “off the beat.”
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    When Quantize Trigger is on (checked), triggering at a timing that is within a 32nd note of the Quantize Window setting 
will be considered “late” (shown by the pink color in the diagram above), and will cause the playback to begin 
immediately while bringing the Module into sync with other running Modules. If the trigger is later than this, it will be 
considered “early” (shown by the yellow color in the diagram above), and playback will start at the next metric division 
corresponding to the Quantize Window.
<0092>
    [Delay Start] (popup menu) [0...25]

Allows the start of a Module’s GE to be delayed by a certain amount once it is triggered. For example, this can be used to 
delay the start of one Module a certain number of beats, while another Module starts immediately. This affects both the 
triggering of the envelopes and the start/restart of the notes.

0: Off
When a Module receives a trigger, it starts immediately.

1. Fixed ms - (milliseconds)
Makes available the “Fixed ms” field beneath the popup, where an absolute length may then be specified in milliseconds to 
delay triggering envelopes and starting/restarting the notes. Note that this is independent of any tempo settings. You 
might use this to delay one module a short period of time from another Module, and have this delay stay constant 
regardless of the overall tempo of the Performance.

    “ms” field not available unless “Fixed ms” is selected in the Delay Start popup menu.

2...25: 64th Note Triplet to 4 Whole Notes (16 beats)
Allows the start of the envelopes and start/restart of the notes to be delayed by the selected note duration. Note that this 
is tempo dependent, so changing tempos changes the amount of Delay Start and keeps the effect locked to tempo.
<0093>
    [Fixed ms] (numerical) [1...5000 milliseconds]

Specifies an absolute amount in milliseconds by which to delay the start of the Module’s GE. Note that this is independent 
of any tempo settings.

<ParmsTrig>
Trigger - Note and Envelope Triggering Parameters
 

This section contains the Triggering and Latching parameters for the notes and envelopes in the GE. The Triggering 
parameters control how notes and envelopes in the GE may be triggered (started or restarted), including parameters 
related to the Stutter feature. The Latch Parameters control how and when note generation stops when keys are released, 
and how the envelopes will act when triggered and keys are released. 
<0094>
    [Note Trigger] (popup menu) [0...3]

Specifies how the notes of the pattern or phrase produced by the GE will start (or restart) in response to a trigger (i.e. a 
chord on a keyboard). All of the following options also allow a MIDI Controller to perform the triggering as chosen in the 
Dynamic MIDI Page.
<DynEd>

0: Any - any note + Dynamic MIDI
Playing any new chords or notes (even while holding others) will cause the notes to restart at the beginning.

1: AKR - 1st note after key release + Dynamic MIDI
The first note or chord received will trigger the notes. Playing any new notes while still sustaining at least one note will 
not cause retriggering; all keys must first be released, and then the next chord or note will perform the triggering. By 
changing the chord you play on the input device while holding at least one note, you can selectively control whether the 
phrase or pattern starts from the beginning again or not.
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2: 1st - 1st only until Module stops + Dynamic MIDI
From a state where KARMA is stopped, only the first note or chord will cause triggering. Subsequent notes will be 
ignored. Until the actual playback of the effect is stopped, the notes cannot be retriggered. This is typically used with 
drum effects or long phrases, where you want to play the keyboard after starting without restarting the Module. This is 
also the way that most auto-accompaniment keyboards operate.

3: Dyn - Dynamic MIDI
Allows only the setting in the Dynamic MIDI Page (such as a footswitch or joystick) to perform the note triggering, and 
effectively disconnects the notes from the input device (i.e. keys on the keyboard) from triggering. You can use this so 
that playing a chord on the keyboard sets up the effect in memory, but it will not start until the selected controller is 
activated.

    When rapidly retriggered by the Stutter feature, this setting is ignored and the “Any” setting is used.
<0095>
    [Note Latch] (popup menu) [0...2]

Specifies one of several options for whether the overall generation of the phrase or pattern will stop when all the input 
notes have been released.

0: Off  - Module is never latched
With this option, releasing the input notes will always cause the GE to stop playing its phrase. There is no connection 
between the Module and the Latch On/Off button in the Real-Time Controls Editor.

1: LB - Module obeys Latch Button status
With this option, the latch for the Module is tied to the status of the overall Latch On/Off button in the Real-Time Controls 
Editor. When the Latch button is on, the Module is latched and the generation of the phrase will continue when the input 
notes are released. When the Latch button is off, generation will stop when the input notes are released. 

2: On - Module is always latched
With this option, releasing the input notes will not stop the GE, and the GE will always continue playing its phrase. There is 
no connection between the Module and the Latch On/Off button in the Real-Time Controls Editor. This setting is mainly of 
use for the melodic and drum fill features. In most of the Factory Performances, you will find that Module 6 is set to this 
option, while the other five Modules are set to “LB” so that they can be controlled by the Latch On/Off button. This means 
that you can turn the Latch button off in the middle of a Performance, while KARMA is playing, and the five Modules will 
stop, creating silence, but you can then trigger the fill (since it is still latched) and use it to bring the music back in by 
turning the Latch button back on.
<0102>
    [Update On Release] (checkbox) [Off, On]

Allows the release of individual input notes to remove those notes from the notes going to the GE, thereby changing the 
effect to use only those notes still being held.

Off
Releasing some notes while holding others causes no change to the input source material, and therefore no change in the 
Generated Effect. This is the most smooth and natural way, and similar to most advanced auto-accompaniment keyboards.

On
Notes that are released are removed from the input source material, thereby changing the effect to use only those notes 
still being held. This is typically the way simple arpeggiators work, especially if their latch mode is turned off.
<0103>
    [Stutter Gate] (checkbox) [Off, On]

When using the Stutter feature, notes are rhythmically retriggered at a rapid speed. When this is on, each module is also 
gated with CC11 (expression) to accentuate the chopping effect.

    This is the only parameter in this section that affects all Modules at the same time, and is not available within each 
Module’s column. 
<0089><Stutter>
    [Stutter Window] (popup menu) [0...8: 64th Note Triplet to Quarter Note]

Specifies the “base” metric division by which the Module will be rapidly continuously retriggered when the Stutter 
feature is assigned in Dynamic MIDI. The Dynamic MIDI Destinations then allow this value to be multiplied to provide 
different speeds of the Stutter effect. Therefore, typically this value will be set to one of the smaller values since the 
Dynamic MIDI options multiply it and make it longer.

    While most of the Factory Performances have all Modules set to the same value so that they all stuttersimultaneously 
with the same rhythmic value, it’s possible to set the Modules differently so that they are stuttering at different 
rhythms. For example, if you set one Module to a 32nd Note Triplet, and another Module to a 16th Note Triplet, the first 
Module would be stuttering twice as fast as the second one but they would still “line up” rhythmically.
<0096>
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   [Envelope 1/2/3 Trigger] (popup menu) [0...3]

Specifies how the selected envelope will start (or restart) in response to a trigger (i.e. a chord on a keyboard). If any 
envelopes have been programmed as part of the effect, you can individually control the way they can be triggered, 
independent of how the retriggering of the start of the notes is being controlled. Typically, these may be set to the same 
option as the Notes Trigger menu, but it is possible to find other interesting combinations. For example, you can retrigger 
a velocity envelope to cause a crescendo/decrescendo, without restarting the notes from the beginning of the effect. All 
of the following options also allow a MIDI Controller to perform the triggering as chosen in the Dynamic MIDI Page.
<DynEd>

0: Any - any note + Dynamic MIDI
Playing any new chords or notes (even while holding others) will cause the envelope to restart at the beginning.

1: AKR - 1st note after key release + Dynamic MIDI
The first note or chord received will trigger the envelope. Playing any new notes while still sustaining at least one note 
will not cause retriggering; all keys must first be released, and then the next chord or note will perform the triggering. 
By changing the chord you play on the input device while holding at least one note, you can selectively control whether the 
envelope starts from the beginning again or not.

2: 1st - 1st only until Module stops + Dynamic MIDI
From a state where KARMA is stopped, only the first note or chord will cause triggering. Subsequent notes will be 
ignored. Until the actual playback of the effect is stopped, the envelope cannot be retriggered.

3: Dyn - Dynamic MIDI
Allows only the setting in the Dynamic MIDI Page (such as a footswitch or joystick) to perform the envelope triggering, 
and effectively disconnects the notes from the input device (i.e. keys on the keyboard) from triggering. 

    When rapidly retriggered by the Stutter feature, this setting is ignored and the “Any” setting is used.
<EnvLatch><0097>

    [Envelope 1/2/3 Latch] (popup menu) [0...4]

Specifies how the selected envelope’s operation will be affected by the release of input notes. In the following 
explanations, the word “key” or “chord” is used to indicate either keyboard keys, or another type of triggering control 
as set up in the Dynamic MIDI Page.

0: Off - key release enters release immediately
The envelope will not be latched. Releasing the keys causes any envelopes in use to immediately go into their Release 
phases. This is “normal” operation for most synthesizer type envelopes. If the envelope is set to loop to the Sustain 
level, the envelope will loop as long as the key is held - key release will cause the loop to stop (see table below).

1: Sus1 - play to sustain, then use key release, key release ends looping
Once triggered, the envelope will play through the Attack and Decay phases as specified regardless of when the keys are 
released. If they are released before this has been completed, then when reaching the Sustain level the envelope will 
immediately go into the Release phase. If the keys are held until the Sustain Level is reached, then this option is the same 
as “Off.” This can be used so that playing a chord and releasing it (even a chord with a short duration) will still perform 
the first part of an envelope as specified, before going into the Release phase. If the envelope is set to loop to the Sustain 
level, the envelope will loop as long as the key is held - key release will cause the loop to stop (see table below).

2: Rel1 - play entire shape to release (skip sustain), key release ends looping
Once triggered, the envelope will play through the Attack and Decay phases, and upon reaching the Sustain level, 
immediately enter the Release phase (thus playing the entire envelope shape). The Sustain level will be ignored, even if 
you are holding the keys when it is reached - the envelope will still go into the Release phase. Therefore, key release has 
no effect whatsoever on the envelope shape. This can be used so that playing a chord and releasing it will perform the 
entire shape of the envelope as specified (without stopping at the Sustain level), or so that holding a chord is no different 
than striking a chord and releasing it quickly. If the envelope is set to loop to one of the Release Level options, the 
envelope will loop as long as the key is held - key release will cause the loop to stop (see table below). The only difference 
between this option and “Rel2” below is that key release will stop the envelope if it is looping.

3: Sus2 - play to sustain and stop, ignore key release, loop continuously
Once triggered, the envelope will play through the Attack and Decay phases and stop at the Sustain level. Key release has 
no effect whatsoever, and the envelope will never enter the Release phase. This can be used so that playing a chord and 
releasing it will perform the first part of an envelope as specified, but then stop at a predetermined sustain level. If the 
envelope is set to loop to the Sustain level, releasing the keys will not stop the loop, so this can also be used to 
continuously loop an envelope without having to hold down any keys (see table below).

4: Rel2 - play entire shape to release (skip sustain), loop continuously
Once triggered, the envelope will play through the Attack and Decay phases, and upon reaching the Sustain level, 
immediately enter the Release phase (thus playing the entire envelope shape). The Sustain level will be ignored, even if 
you are holding the keys when it is reached - the envelopes will still go into the Release phase. Therefore, key release has 
no effect whatsoever on the envelope shape. If the envelope is set to loop to one of the Release Level options, the envelope 
will loop continuously (see table below). The only difference between this option and “Rel1” above is that key release 
does not stop looping.

    Important: Note Latch must be set to on in order to hear the effects of the Envelope Latch options.
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The following table illustrates the relationship between the Envelope Latch Modes described above, and the three Envelope 
Loop Modes (set in the GE Editor > Envelopes Page).<EnvEd/Loop>

 

<ParmsPerc>
Trigger - Trigger By Module Parameters
 

The Trigger By Module parameters allow a Module’s GE (both notes and envelopes) to be triggered by a percentage of the 
length of another Module’s GE, in addition to the other triggering options. This is typically used for something like a harp 
glissando Performance, where each Module is simulating one sweep of the harpist’s hands. Each Module can trigger the 
start of the next Module a certain percentage through the sweep, allowing a convincing overlap of a portion of the two 
Modules. As more notes are played on the keyboard, the sweeps will be longer (containing more notes), and therefore the 
percentage to be played before triggering the next Module will be adjusted accordingly. This is far more realistic than 
using Delay Start on the Modules, since the delay would not be automatically adjusted according to the number of notes 
played.

This can also be used to “cycle” back and forth between two or more Modules, since you can trigger a Module by the 
keyboard and by a percentage of another Module’s GE length at the same time. An example of this technique being used in a 
KARMA Motif Performance is “36: At An Exhibition” (shown at the top of this chapter), where Modules 1 and 2 are 
both Drum Modules. Module 1 is triggered by the keyboard (set to Note Trigger “1st”). Module 2 will not be triggered by 
the keyboard, since the Note Trigger Mode is set to “Dyn” (Dynamic MIDI only). Module 1 plays the main “groove”, and 
then triggers Module 2 when it has completed 88% of its phrase, which provides a recurring randomized fill. The 
triggering of Module 2 stops Module 1 due to the “Cutoff Other Modules” setting. When Module 2 has completed 12% of its 
phrase, it retriggers Module 1, which then shuts off Module 2 - so these two Modules are looping and constantly trading 
off with each other.
<0098>
    [Trigger By Module] (popup menu) [0...6]

Allows a Module’s GE (both notes and envelopes) to be triggered by a percentage of the length of another Module’s GE, in 
addition to the other triggering options.

0: Off
Trigger By Module not being used.

1: M1% - percentage of Module 1’s length
Makes the “Module %” field available below, which allows a certain percentage of Module 1’s Generated Effect Length to 
trigger the start of the selected Module’s notes and envelopes. For example, if Module 2 was set to this and 85%, then 
after Module 1 had completed 85% of its phrase or pattern Module 2 would be triggered.

2: M2% - percentage of Module 2’s length
3: M3% - percentage of Module 3’s length
4: M4% - percentage of Module 4’s length
5: M5% - percentage of Module 5’s length *
6: M6% - percentage of Module 6’s length *
As described above, except use a percentage of the specified Module’s effect.
<0099>
    [Module %] (numerical) [0...100%]

Specifies a percentage of a Module’s overall GE length after which triggering of this Module will occur. When the KARMA 
Module chosen above advances by the percentage of length specified here, this Module will be automatically triggered. The 
actual overall “length” of a GE is determined by the number of Phase Pattern Steps, the Phase Length Mode, and various 
other Phase Page settings.

    Not available when the Trigger By Module popup setting is “Off.”

    Setting a Module to be triggered by a percentage of its own riff will have no additional effect.

<ParmsCut>
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Trigger - Cutoff Grid
  

<0100>
    [Cutoff Other Modules] (button grid) [Grey = Off, Blue = On]

Specifies whether the phrase or pattern generated by other Modules will be stopped automatically when this Module is 
triggered. There is one button for each of the six Modules; when this Module’s effect is triggered, it will cutoff any 
effects that are playing on the specified Modules.

This is mainly used when you want to have the Fill feature shut off a Module or two when the fill is triggered. For 
example, usually you want a drum fill to stop the drum GE providing the main groove while the fill is playing. The Module 
that has been stopped is then restarted at the end of the fill by the “Retrigger Ar End” parameters of the Fill/Stop Page. 
<StpEd/Retrigger>

This is also used when you do not want effects from the Modules overlapping each other, but want them to appear 
continuous (i.e. 4 sax riffs, 4 different strumming effects, etc.) For example, you could trigger different Modules in 
separate areas of the keyboard, and only have one playing at any particular time. This can also be used to cycle back and 
forth between Modules (as described above under Trigger By Module), with each Module shutting off the previous Module 
when it is triggered in rotation.
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<0486>

MIDI Filter
Sections in this chapter:

Overview<FilEd/Over>

Input Data Parameters<FilEd/FiltIn>

Generated Data Parameters<FilEd/FiltGen>

 

<Over>
MIDI Filter - Overview
The MIDI Filter Page contains parameters that control which types of MIDI data are passed through to the KARMA Modules 
and Keyboard Layers, and which types of MIDI data KARMA will generate. Two sub-pages exist to separate the Input Data 
Parameters (shown above) and the Generated Data Parameters. A column exists for each of the Modules in a 
Performance, which may be grayed out depending on how many Modules are active in the current Performance. An 
additional column contains the settings for the two Keyboard Layers at the far right (on the Input Data sub-page only). 
<1981><1982>

Input/Generated Selection Buttons
Switches between two different sub-pages in the sub-page area.

Sub-Page Area
When the Input Button is selected, displays the Input Data Parameters, which control how the incoming MIDI data is 
passed as input to the Modules and Keyboard Layers for processing (as shown above).
<FilEd/FiltIn>

When the Generated Button is selected, displays the Generated Data Parameters, which allow control over which types of 
MIDI data are generated by KARMA (and passed on to your destination devices), in addition to a few other Envelope control 
options.
<FilEd/FiltGen>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:
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Copy From Performance... <PEUtils/Mco>

Input Data - All Off
Input Data - All On
Allows you to quickly turn on or off all checkboxes in all Modules and Keyboard Layers, in the Input Data section. Grayed 
out when the Generated Data sub-page is shown.

Generated Data - All Off
Generated Data - All On
Allows you to quickly turn on or off all checkboxes in all Modules, in the Generated Data section. Grayed out when the 
Input Data sub-page is shown.

Default Input Setup
Sets a default starting point for the Input Data sub-page settings consisting of all checkboxes off for the Modules, and the 
recommended checkboxes on for controlling the Keyboard Layers. Grayed out when the Generated Data sub-page is shown.

<FiltIn><0484>
MIDI Filter - Input Data Parameters
 

The Input Data Parameters on the Input Data sub-page allow you to selectively remove certain MIDI Data from the input 
note and control source(s) before passing it on to the Modules for processing. When on (checked), the specified MIDI data 
is sent through. In many instances it is useful to filter different controllers out by unchecking (disabling) the appropriate 
checkbox. For example, if you are using the Sustain Pedal to control some aspect of KARMA (through the Dynamic MIDI 
Page), you will probably not want the Sustain Pedal also performing its normal function (for whichever Modules are 
affected). In this case, you would uncheck the “Sustain - CC64” checkbox for that Module. However, there are times 
when you will want to set these to “Thru” - for example, to allow the Pitch Bend Wheel of your controller to bend the 
entire effect of a Module while it is playing.

    It’s important to note that the checkboxes will be on to send the data, and off to filter the data; hence the reminder 
that √ = Enabled at the top of the page.
<0488><1966><1974>

    [Module/Keyboard Layer Name] (label)

Displays a descriptive name for each Module or Keyboard Layer, which can be assigned on the GE Setup/Mix Page. Due to 
space requirements, the Keyboard Layer 1 label is at the top of the Keyboard Layer Parameters and applies to the left 
column of checkboxes, while the Keyboard Layer 2 label is at the bottom and applies to the right column of checkboxes. 
<MixEd/ParmsGE><0470><1967><2473>
    [Pitch Bend] (checkbox) [Off, On]

Specifies whether MIDI Pitch Bend data from the Input Source is filtered or sent thru to the KARMA Module or Keyboard 
Layer. When off (unchecked) the data is removed from the stream going to the selected Module or Keyboard Layer; when 
on (checked) it is passed on unaltered.
<0471><1968><2474>
    [Aftertouch] (checkbox) [Off, On]

Specifies whether MIDI Aftertouch data from the Input Source is filtered or sent thru to the KARMA Module or Keyboard 
Layer. When off (unchecked) the data is removed from the stream going to the selected Module or Keyboard Layer; when 
on (checked) it is passed on unaltered.
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<0473><1969><2475>
    [MW/JS(Y+) - CC01] (checkbox) [Off, On]

Specifies whether MIDI Mod Wheel/Joystick Y+ data (CC 01) from the Input Source is filtered or sent thru to the KARMA 
Module or Keyboard Layer. When off (unchecked) the data is removed from the stream going to the selected Module or 
Keyboard Layer; when on (checked) it is passed on unaltered.
<0474><1970><2476>
    [BC/JS(Y-) - CC02] (checkbox) [Off, On]

Specifies whether MIDI Breath Controller/JoyStick Y- data (CC 02) from the Input Source is filtered or sent thru to the 
KARMA Module or Keyboard Layer. When off (unchecked) the data is removed from the stream going to the selected 
Module or Keyboard Layer; when on (checked) it is passed on unaltered.
<0487><1971><2478>
    [Ribbon - CC22] (checkbox) [Off, On]

Specifies whether Ribbon data (CC 22) from the Input Source is filtered or sent thru to the KARMA Module or Keyboard 
Layer. When off (unchecked) the data is removed from the stream going to the selected Module or Keyboard Layer; when 
on (checked) it is passed on unaltered.
<0472><1972><2477>
    [Sustain - CC64] (checkbox) [Off, On]

Specifies whether MIDI Sustain Pedal data (CC 64) from the Input Source is filtered or sent thru to the KARMA Module or 
Keyboard Layer. When off (unchecked) the data is removed from the stream going to the selected Module or Keyboard 
Layer; when on (checked) it is passed on unaltered.
<1983><1984><2484>

    [Cutoff/Resonance - CC74/71] (checkbox) [Off, On]

Specifies whether Filter Cutoff (CC 74) and Resonance (CC 71) from the Input Source is filtered or sent thru to the 
KARMA Module or Keyboard Layer. When off (unchecked) the data is removed from the stream going to the selected 
Module or Keyboard Layer; when on (checked) it is passed on unaltered.
<0489><1975><2480>
    [Assignable Switch 1] (checkbox) [Off, On]

Specifies whether the CCs for assignable switch 1 from the Input Source (or GUI) is filtered or sent thru to the KARMA 
Module or Keyboard Layer. When off (unchecked) the data is removed from the stream going to the selected Module or 
Keyboard Layer; when on (checked) it is passed on unaltered. The actual CC number is set on the MIDI Setup (Global) > RTC 
Setup Page.
<0490><1976><2481>
    [Assignable Switch 2] (checkbox) [Off, On]

Specifies whether the CCs for assignable switch 2 from the Input Source (or GUI) is filtered or sent thru to the KARMA 
Module or Keyboard Layer. When off (unchecked) the data is removed from the stream going to the selected Module or 
Keyboard Layer; when on (checked) it is passed on unaltered. The actual CC number is set on the MIDI Setup (Global) > RTC 
Setup Page.
<1979><1977><2482>
    [Assignable Knob 1] (checkbox) [Off, On]

Specifies whether the CC for assignable knob 1 from the Input Source is filtered or sent thru to the KARMA Module or 
Keyboard Layer. When off (unchecked) the data is removed from the stream going to the selected Module or Keyboard 
Layer; when on (checked) it is passed on unaltered. The actual CC number is set on the MIDI Setup (Global) > RTC Setup 
Page.
<1980><1978><2483>
    [Assignable Knob 2] (checkbox) [Off, On]

Specifies whether the CC for assignable knob 2 from the Input Source is filtered or sent thru to the KARMA Module or 
Keyboard Layer. When off (unchecked) the data is removed from the stream going to the selected Module or Keyboard 
Layer; when on (checked) it is passed on unaltered. The actual CC number is set on the MIDI Setup (Global) > RTC Setup 
Page.
<0475><1973><1986><1987><2479><2485>

    [Other Controllers] (checkbox) [Off, On]

Specifies whether other MIDI CC data from the Input Source is filtered or sent thru to the KARMA Module or Keyboard 
Layer. For the Yamaha Motif/MOX, this parameter covers Attack (CC 73), Decay (CC 75), Sustain (CC 31 for 
MOX/MOXF, SysEx for XS/XF) and Release (CC 72). When off (unchecked) the data is removed from the stream going to 
the selected Module or Keyboard Layer; when on (checked) it is passed on unaltered.

<FiltGen><0485>
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MIDI Filter - Generated Data Parameters
 

The Generated Data Parameters on the Generated Data sub-page allow you to selectively filter or send various MIDI data 
that KARMA may be generating. For example, if a GE has had automatic pitch-bending effects programmed as part of its 
effect, but you want to disable the pitch-bending for the Module using that GE, you would uncheck (turn off) the “Pitch 
Bend” checkbox for that Module. Setting any of the checkboxes to on (enabled) allows the selected parameter to operate 
normally, as programmed.

    It’s important to note that the checkboxes will be on to send the data, and off to filter the data; hence the reminder 
that √ = Enabled at the top of the page.

    If a particular type of data is not being generated by a GE, filtering or sending the data will have no effect.
<1985>

    [Module Name] (label)

Displays a descriptive name for each Module, which can be assigned on the GE Setup/Mix Page.
<MixEd/ParmsGE><0476>
    [Pitch Bend] (checkbox) [Off, On]

Specifies whether the MIDI Pitch Bend data generated by the KARMA Module will be transmitted. When off (unchecked) 
Pitch Bend data being generated by KARMA is not sent to the selected Module; when on (checked) it is generated as usual. 

    This affects any Pitch Bend data being generated by KARMA, whether it comes from the Bend Page, the Envelopes 
Page, or the CCs Page.
<0477><0478>
    [CC-A/CC-B] (checkbox) [Off, On]

Specifies whether the MIDI Control Change (CC) data generated by the KARMA Module will be transmitted. When off 
(unchecked) Control Change (CC) data being generated by KARMA from the GE Editor > CCs Page as “CC-A” or “CC-B” is 
not sent to the selected Module; when on (checked) it is generated as usual. The actual controller number that this refers 
to is selected in the GE Editor > CCs Page. For example, if CC-A is set to “[10] Pan,” then any Pan data being generated 
through the use of the CCs Page settings can be selectively removed.
<PanEd><0479><0480><0481>
    [Envelope 1, 2, 3] (checkbox) [Off, On]

Specifies whether the selected Envelope will function as programmed (checked) or as if it is turned off (unchecked). This 
applies not only to Envelopes that are sending CCs, but Tempo Envelopes, Velocity Envelopes, and Duration Envelopes. In 
other words, if a GE is using Envelope 2 to control Velocity, you can “remove” its effect by setting this to off, and the GE 
will operate as if the Velocity Envelope is turned off. As another example, if Envelope 1 is generating CC 01, you can stop 
the data from being sent by setting this to off. 

    Pitch Bend Envelope(s) are not affected by this setting, but by the “Pitch Bend” Filter above. 
<0482> 
    [Notes] (checkbox) [Off, On]

Specifies whether the MIDI note-on/note-off messages generated by the KARMA module will be transmitted. When off 
(unchecked), you can mute the note phrases generated by the KARMA module, and use only the control data generated 
from the KARMA module (e.g., pan, filter cutoff, resonance) to apply modulation to phrases or chords you yourself play 
on the keyboard. When on (checked) the notes are generated in the usual fashion according to the settings of the GE.
<0483> 
    [WaveSeq] (checkbox) [Off, On]

Specifies whether the KARMA Wave-Sequencing messages generated by the KARMA module will be transmitted. When off 
(unchecked), any KARMA Wave-Sequencing messages (whether they are SysEx, Program Changes, or CCs)  programmed 
as part of the GE are not generated; when on (checked) they are generated normally.

Page 143



 <0501><2440><0507><2441>

Key Zones
Sections in this chapter:

Overview<KeyEd/Over>

Key Zone Parameters<KeyEd/Zone>

Transpose Parameters<KeyEd/Transpose>

Thru Parameters<KeyEd/Thru>

 

<Over>
Key Zones - Overview
The Key Zones Page allows each of the six Modules and two Keyboard Layers to each have their own Key Zone (range for 
MIDI Input). Only notes received within that range will be allowed thru to the Module or Keyboard Layer as input source 
material, which allow different areas of the keyboard to trigger and control different effects. Also found here are various 
“Thru” parameters which control whether notes received as MIDI Input are echoed thru to the Module or Keyboard Layer 
(while the KARMA Function is on or off), along with Transpose settings that may be applied to those thru notes 
independently. A row exists for each of the Modules, which may be grayed out depending on how many Modules are active 
in the current Performance. The Module or Keyboard Layer Name displayed to the left of each row can be assigned on the 
GE Setup/Mix Page.
<MixEd/ParmsGE>

    Notes within or outside of a zone also show up as Sources in the Dynamic MIDI Page.
<DynEd><0499><0503><0502>

Keyboard Display
Displays incoming MIDI notes that are used to trigger the KARMA GEs or play the Keyboard Layers. The display only 
shows nine full octaves from MIDI Note 12 to MIDI Note 119; notes outside this range are not shown. A graphic above the 
Keyboard Display shows the ranges of popular sizes of MIDI keyboards within this nine octave range, while Note Names 
and MIDI Note Numbers are shown beneath the display for reference.

    Whether the labels reference Middle C as C3 or C4 is controlled by the “Middle C Display” option in the Preferences - 
Workspace settings.
<Prefs/MidC><0500><2444>

Zone Range Bars
A graphic editor for the Zone of each Module and Keyboard Layer, which displays the current input range in blue. Click and 
drag to set a new range, or edit the values directly with the Zone Bottom/Top fields (when the Key Zone Parameters are 
displayed in the Parameter Area).
<0504>

Note Activity Displays
Displays the Note Data that is being generated on each Module as vertical lines, with longer lines indicating higher 
velocities.
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Parameter Selector Buttons/Parameter Area
The three radio buttons switch the Parameter Area below them and to the left of the Zone Range Bars between three 
different sets of parameters:

Key Zone Parameters (Key Zone Bottom/Top) <KeyEd/Zone>

Transpose Parameters (Transpose Inside Zone/Outside Zone) <KeyEd/Transpose>

Thru Parameters (Timbre Thru (Off), Thru Inside Zone/Outside Zone) <KeyEd/Thru>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy From Performance... <PEUtils/Mco>

The following three utilities allow you to quickly configure some useful default Key Zone ranges:

Set All Off
Sets all Key Zones for all Modules and Keyboard Layers to off (Note 0 ~ 0).

Set All On
Sets all Key Zones for all Modules and Keyboard Layers to on over the whole range (Note 0 ~ 127).

Set KARMA LH Split
Sets the typical split used in most of the Factory Performances: all six Modules and Keyboard Layer 1 cover the range of 
the B below Middle C down (0 ~ 59) to be triggered or played by the left hand, while Keyboard Layer 2 covers the range 
of Middle C up (60 ~ 127) to be played by the right hand.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the Performance Editor > RT Parms Page for more information. 
<RPPEd><Zone><0493><0509>
Key Zones - Key Zone Parameters
 

The Key Zone Parameters, shown when the “Key Zone” radio button is selected, work in conjunction with the Zone Range 
Bars to the right to set the bottom and top of the Key Zone range (lowest and highest notes that will be allowed as input to 
the KARMA Module or Keyboard Layer). Ranges can be set by either clicking and dragging in the Zone Range Bar beneath 
the Keyboard Display, or directly entering/scrolling values in the Bottom and Top parameter fields. The MIDI Note names 
shown are the Bottom and Top of the Range. Only notes received within that range will be allowed thru to the Module as 
input source material. The fields can also be clicked and scrolled to the desired values by clicking and dragging the mouse. 
To directly enter a note name, click on the field and type a letter followed by a number; i.e. “c3.” 

    To drag a Key Zone while keeping the relationship between the bottom and top value constant, Cmnd+click (Mac) or 
Ctrl+click (Win) with the mouse. This will drag the top and bottom values at the same time.

    Notes within or outside of a zone also show up as Sources in the Dynamic MIDI Page. <DynEd>
<2450><2445><0494>
    [Key Zone Bottom] (numerical) [0...127: C-2...G8 when Mid C=C3]

Sets the Bottom of the Key Zone range (lowest note that will be allowed as input to the KARMA Module or Keyboard 
Layer). Notes lower than this note are considered “Outside Zone.”
<2451><2446><0495>
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    [Key Zone Top] (numerical) [0...127: C-2...G8 when Mid C=C3]

Sets the Top of the Key Zone range (highest note that will be allowed as input to the KARMA Module or Keyboard Layer). 
Notes higher than this note are considered “Outside Zone.”

    Whether the note names reference Middle C as C3 or C4 is controlled by the “Middle C Display” option in the 
Preferences - Workspace settings. <Prefs/MidC>

<Transpose><0496><2449>
Key Zones - Transpose Parameters
 

The Transpose Parameters, shown when the “Transpose” radio button is selected, allow you to separately transpose 
notes that are passed through inside or outside of the Key Zone for the Module or Keyboard Layer.

    For Keyboard Layers, the “Transpose Inside Zone” setting is the parameter that is often assigned in the factory 
Performances to Real-Time Controls to change the octave of the LH pad or RH lead sound. However, when assigning it in 
the RT Parms Page, it is named “Kbd Layer Transpose.” 

    These settings only have an effect on the “Thru” data, so therefore they only work if the corresponding “Thru Inside 
Zone” or “Thru Outside Zone” checkbox is turned on. These settings do not affect the notes generated by the KARMA 
Modules - to transpose them, you would use the “Transpose” setting on the GE Setup/Mix Page.
<0497><2447><2452>
    [Transpose Inside Zone] (numerical) [-36...+36 semitones]

Allows you to set a separate Transpose Value in semitones for notes that are passed through inside the Key Zone for the 
Module or Keyboard Layer.
<0498>
    [Transpose Outside Zone] (numerical) [-36...+36 semitones]

Allows you to set a separate Transpose Value in semitones for notes that are passed through outside of the Key Zone for 
the Module. Not available for Keyboard Layers.

    [~Octave Transp. Thru InZ] (virtual) [-36...+36 semitones; quantized]
    [~Octave Transp. Thru OutZ] (virtual) [-36...+36 semitones; quantized]
    [~Oct/5 Transp. Thru InZ] (virtual) [-36...+36 semitones; quantized]
       [~Oct/5 Transp. Thru OutZ] (virtual) [-36...+36 semitones; quantized]
These are not true parameters, but “virtual” parameters for RT Parm control. They do not physically exist on the Key 
Zones Page, but perform a modifying function on the Transpose parameter above. They can be found in the Key Zones 
Group when assigning parameters in the Performance Editor > RT Parms Page, and have a tilde (~) at the beginning of the 
parameter name (indicating that it is virtual). These parameters operate exactly the same as the Transpose parameter 
above, but are specifically for assigning to a continuous controller such as a slider. With “Octave Transpose” the 
transpose setting will only change to the octave values (-36, -24, -12, 0, 12, 24, 36), and with “Oct/5 Transpose” the 
values will only change on the octave or fifth values (-36, -29, -24, -27, -12, -5, 0, 7, 12, 19, 24, 31, 36).

<Thru><0508><2448>
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Key Zones - Thru Parameters
 

The Thru Parameters, shown when the “Thru Notes” radio button is selected, control whether or not the notes received 
as MIDI Input are also echoed directly thru to the Module or Keyboard Layer. There are separate controls for KARMA Off 
(Timbre Thru (Off), and KARMA On (Thru Inside Zone, Thru Outside Zone). 
<0506><2453><2442>

    [Timbre Thru (Off)] (checkbox) [Off, On]

Specifies whether or not MIDI data being received on a Module or Keyboard Layer’s MIDI In Channel will be sent thru to the 
MIDI Out Channel when the KARMA Function is off. For a Keyboard Layer, this should be on or the layer will not sound 
while KARMA is off.

Off
When the KARMA Function is turned off in the Real-Time Controls Window, any MIDI Data being received by the Module or 
Keyboard Layer will be NOT be sent out (thru) on the specified out channel. The destination device on the Module’s MIDI 
Out Channel will be silent.

On
When the KARMA Function is turned off in the Real-Time Controls Window, any MIDI Data being received by the Module 
will be sent out (thru) on the Module’s MIDI Out Channel. This allows you to “play” the destination device, even when the 
KARMA Function is off.
<0491><0505><2454><2443>
    [Thru Inside Zone] (checkbox) [Off, On]

When on, input notes that are within the Key Zone for the Module or Keyboard Layer will be also echoed thru to the output. 
For a Module, to hear the actual notes played within the Key Zone in addition to the notes generated by KARMA, turn this 
on. When off, only the notes generated by KARMA will be sent to the Module, and Keyboard Layers will be silent. For a 
Keyboard Layer, this should be on or the layer will not sound while KARMA is on.
<0492>
    [Thru Outside Zone] (checkbox) [Off, On]

(Not available for Keyboard Layers.) When on, input notes that are outside of the Key Zone for the Module will be also 
echoed thru to the output. To hear the actual notes played outside of the Key Zone in addition to the notes generated by 
KARMA, turn this on. When off, only the notes generated by KARMA will be sent to the Module. This can be used to let one 
area of the keyboard generate input to KARMA, while the area outside the zone is simply sent through. For example, this 
could let you solo outside of the Key Zone on top of what KARMA is generating in response to the input from within the Key 
Zone.

    For Modules, to send all notes thru (when KARMA is on) with no regard for Key Zone, simply turn both checkboxes on 
for that Module (Inside Zone and Outside Zone).

Page 147



RT Parms (Real-Time Parameters)
Sections in this chapter:

Overview<RPPEd/Over>

GE RT Parms<RPPEd/GERT>

Performance RT Parms<RPPEd/PERT>

About Values To Display<RPPEd/ValDisp>

Effects of the Stored (Center) Value<RPPEd/Stored>

 

<Over>
RT Parms - Overview
Real-Time Parameters (RT Parms or RTP for short) indicate any of the parameters within KARMA that are assigned to be 
varied in real-time by operating a controller of some sort. Each GE can have up to 32 RTP assigned within the GE from the 
hundreds of GE parameters. Up to 8 Performance Parameters can also be assigned from the many Performance and Module 
parameters. The Performance RT Parms Page has seven sub-pages for viewing the GE RTP for each Module, and the Perf. 
RTP, as described below.

    GE RTP are stored as part of the GE, and are selected from the hundreds of GE parameters in the GE Editor > RT Parms 
Page. <RTPEd>
<0510>

Current Module/Performance
Selects from seven different sub-pages, depending on how many active Modules are in the current Performance. Buttons 
[1 ~ 6] display the GE RTP for each Module, while the [P] sub-page displays the RTP that may have been assigned on the 
Performance Level.

    Clicking one of the Module Buttons [1 ~ 6] also changes which Module is the “Current Edit Module.” This affects which 
Module’s information is displayed in the Status Area of the Main Window, as well as which GE is viewed and can be edited 
in the GE Editor.<GE>
<0528><0529>

Master/Module Layer
When a Module is selected for editing, switches between the Master Layer and Module Layer assignments. The same 32 GE 
RTP can be assigned to various controllers in both the Module and Master Layers of the Control Layer. Each Module has its 
own dedicated Control Layer, in addition to potentially being controlled by the Master Layer as well. 
<0511><0512>

Values To Display
Switches between displaying the actual Stored (Center) Values, and the Current (Controlled) Values that may be modified 
by the positions of any assigned Real-Time Controls. See below: About Values To Display. <RPPEd/ValDisp>

Stored (Center) Values
Displays the stored settings in the Value fields. These are editable, and reflect the “center” position of any assigned 
controller.
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Current (Controlled) Values
Displays the actual current settings in the Value fields. These are not editable, but represent the Value as modified by any 
assigned controller.
<0527>

Row Selection Buttons
Only shown when a Module’s GE RTP are being displayed. Switches the sub-page area between rows 1~8, 9~16, 17~24, 
or 25~32.
<0530>

RTC Model
This label displays the RTC Model type for the GE loaded into a particular Control Layer, or [MASTER] when displaying the 
Performance RTP.

Sub-Page Area
Depending on which sub-page is being displayed (selected with the Current Module/Performance buttons), this area shows 
either the GE RTP for the selected Module or the Performance RTP. If showing a Module’s GE RTP, the area displays RTP 
1~8, 9~16, 17~24, or 25~32, depending on the Row Selection Buttons. If showing the Performance RTP, there are only 8 
rows and the Row Selection Buttons are hidden.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy Perf. RTP From Performance...<PEUtils/Mco>
Opens the Copy From Performance Dialog with the proper options already set. 

Copy/Swap GE RTP In Current Module...<GEUtils/Rcs>
Opens the Copy/Swap GE RTP Dialog, for operating on RT Parms within the Current Edit Module.

Clear Control Assignments (Current Sub-Page)
Clears all “Assign” settings on the currently showing sub-page (Module or Performance) by setting them to off.

Clear Control Assignments (All Sub-Pages)
Clears all “Assign” settings in all sub-pages [1 ~ 6, P] by setting them to off.

Clear Perf. RTP (P Sub-Page)
Clears all parameter settings from the “P” (Performance) sub-page, leaving empty rows. Grayed-out unless you are on 
the Performance sub-page.

Sort Perf. RTP (P Sub-Page)
Sorts all parameter settings from the “P” (Performance) sub-page, moving empty rows to the bottom and ordering the 
remaining rows based on the order of the Group setting, and the Parameter within the Group. Grayed-out unless you are 
on the Performance sub-page.

<GERT>
RT Parms - GE RT Parms
 

When the Current Module/Performance buttons are displaying one of the Modules (1 ~ 6), the sub-page area displays the 
GE RT Parameters (GE RTP) for that Module. Each GE can have up to 32 preset parameters that are suitable for controlling 
the phrase or pattern in real-time. The GE parameters displayed will depend on the selected GE. Up to a maximum of 32 GE 
RTP can be assigned, but there may be fewer. Empty parameter “locations” will be grayed out.
<0513>

    [Parameter] (label)

Displays the GE parameter that is assigned to this location in the GE for the current Module. For a complete list of all GE 
Parameters within each group, see the Appendix RT Parms Reference.<RTPRef/GrpGE>

    This is only a label, and cannot be edited. To edit the GE RTP, you must use the GE Editor > RT Parms Page.
<RTPEd>
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�    If you see asterisks (**) in this parameter label, it indicates a programming error where the assigned RT Parm is 
configured incorrectly. Check the GE RT Parm Min/Max settings and the Phase/Env/Drum assignment.
<0026>
    [Info] (label)

This non-editable label displays the “type” of user interface object associated with the selected parameter, and the 
overall available Min/Max Range. You can limit the range using the Min/Max parameters below if desired. This 
information is mainly for help in programming the desired response.

pop:     the parameter is a popup menu object
num:    the parameter is a numerical object
but:     the parameter is a button object, or button grid
rng:     the parameter is a range bar object
vir:     the parameter is a “virtual parameter” not associated with any other UI object

    When a parameter is first assigned, if it exists in more than one module, the info popup will remind you to make an 
assignment in the Module button grid discussed below by displaying “** select mod ->.”

    If you see asterisks (**) in this parameter label, it indicates a programming error where the assigned RT Parm is 
configured incorrectly. Check the GE RT Parm Min/Max settings and the Phase/Env/Drum assignment.

    Many ranges and values in KARMA are “zero relative.” In other words, a popup menu might show 64 items, which 
would be referred to as a range of “0 ~ 63.”
<0027>
    [Minimum] (numerical) [-5000...+5000]

Specifies the Minimum Value that can be operated by an assigned controller or entered into the Value field. The available 
range will depend on the selected parameter. When a GE is first loaded into a Module, the Min/Max fields will show the 
settings programmed into the GE; you can override them here in the Performance.
<0028>
    [Maximum] (numerical) [-5000...+5000]

Specifies the Maximum Value that can be operated by an assigned controller or entered into the Value field. The available 
range will depend on the selected parameter. When a GE is first loaded into a Module, the Min/Max fields will show the 
settings programmed into the GE; you can override them here in the Performance.
<0514>
    [Value] (numerical) [varies depending on Min/Max range above]

Sets the Value of the GE Parameter. The range of this parameter will vary depending on the settings for the RT Parm 
Min/Max fields above. When you load a GE into a Module, the default values that are preset for each GE will be loaded. 
Using the Value field here, you can edit the default values and store those settings with the Performance.

    The value you specify here will be the center value when a KARMA RT Control Slider is assigned and used to control 
this parameter. To view the actual modified value, and not the stored center value, switch the “Value To Display” buttons 
to “Current (Controlled) Values.” When a Switch or Slider As Switch is assigned, the Value field will be disabled and is 
not used. See About Values To Display. <RPPEd/ValDisp>
<0515><Assign>
    [Assign] (popup menu) [0...32]

Assigns the selected GE Parameter to a controller, such as the Sliders and Switches in the Real-Time Controls Editor or 
Dynamic MIDI.

    If you hold down the Cmnd Key (Mac) or Ctrl Key (Win) while selecting an assignment from the popup menu, it will 
automatically adjust the Value field so that it is the “Center” of the Min/Max Range.

0: -- (Off)
 No assignment.

1...8: S1...S8 (Slider 1 ~ 8)
Assigns the parameter to the Real-Time Controls Editor Slider 1 ~ 8. The slider will continuously adjust the Value, 
between the RT Parm Min/Max stored in the GE using the Value setting as the “center” of the range. See The Effect Of 
The Stored (Center) Value. <RPPEd/Stored>

    For KARMA Motif using the remote mode, this corresponds to RTC Sliders 1 ~ 8 when the RTC View is active.

9...16: A1...A8 (Slider w/Switch Action 1 ~ 8)
Assigns the parameter to Real-Time Controls Editor Slider 1 ~ 8, but with a “switch action.” The slider will switch the 
value between minimum and maximum only, with no in between values. The bottom of the slider is off, and the center and 
top is on.
<RPPEd/OnSwitch>

    For KARMA Motif using the remote mode, this corresponds to RTC Sliders 1 ~ 8 when the RTC View is active.

17...24: W1...W8 (Switch 1 ~ 8)
Assigns the parameter to the Real-Time Controls Editor Switch 1 ~ 8. The Value will be controlled between the minimum 
and maximum values.
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<RPPEd/OnSwitch>

    For KARMA Motif using the remote mode, this corresponds to RTC Switches 1 ~ 8 when the RTC View is active.

25...32: D1...D8 (DynMidi)
This corresponds to the Dynamic MIDI Page, rows 1 ~ 8. Select this if you wish to control a GE RT Parm using the 
controller selected for “Source” in the Dynamic MIDI Page (Set the Dynamic MIDI “Destination” to RT Parms Control 
Assign.) For example, you can use this to control a GE RT Parm with the Joystick or Foot Switch. See Dynamic MIDI Page.
<DynEd><0516><Polarity>

    [Polarity] (button) [+, -]

Specifies the polarity (the direction the Value moves in) when you operate the assigned KARMA Real-Time Control.

+ (plus)
In the case of Slider 1 ~ 8, moving down from center will lower the Value, and moving up will raise it.
In the case of Slider w/Switch Action 1 ~ 8, the bottom will be off, and the center and above will be on.
In the case of Switch 1 ~ 8, the parameter will be on when the LED is lit (Switch is on).

- (minus)
In the case of Slider 1 ~ 8, moving up from center will raise the Value, and moving down will lower it.
In the case of Slider w/Switch Action 1 ~ 8, the bottom will be on, and the center and above will be off.
In the case of Switch 1 ~ 8, the parameter will be on when the LED is dark (Switch is off).

<PERT>
RT Parms - Performance RT Parms
 

When the [P] button is clicked in the Current Module/Performance area, the sub-page area changes to display the eight 
Performance Real-Time Parameters (Perf. RTP). As shown above, there are eight rows for eight possible parameter 
assignments. Unused rows will be grayed out. The Master/Module Layer buttons are grayed out, since Performance RTP 
can only be assigned to the Master Layer.

 

<0518>
    [Group] (popup menu) [0...7]

Selects the group of Performance Parameters that you wish to assign. Groups correspond to six of the pages in the 
Performance Editor and the main Performance Editor itself. Each Group contains some (but not necessarily all) of the 
parameters that can be found in that page or editor. For a complete list of all Performance Parameters within each group, 
see the Appendix RT Parms Reference.<RTPRef/GrpPE>

0: Off
No assignment. The rest of the parameters in the row will be grayed out.

1: Performance
2: GE Setup/Mix
3: Control
4: Trigger
5: Key Zones
6: Random Seeds
7: MIDI Setup
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<0519><0517>
    [Parameter] (popup menu) [varies depending on Group (above)]

Depending on the Group setting (above), certain parameters from within the various Performance Pages and Performance 
Editor will appear in this menu. Selecting one assigns that parameter to be controlled by the Value field, and any assigned 
RT Control.

    Once a parameter is assigned as an RT Parm, it will have a grayed out appearance in its normal location. If you click on 
it to edit it, If you try to edit such a parameter, it will present you with the RT Parm Warning Dialog and not allow editing 
unless you hold down the Cmnd Key (Mac) or Ctrl Key (Win) when clicking the parameter. Once it is assigned, editing the 
Value field in this page or moving an assigned RT Control will change that value in place. 
<OthDlg/RTPWarn><0520>
    [Info] (label)

This non-editable label displays the “type” of user interface object associated with the selected parameter, and the 
overall available Min/Max Range. You can limit the range using the Min/Max parameters below if desired. This 
information is mainly for help in programming the desired response.

pop:     the parameter is a popup menu object
num:    the parameter is a numerical object
but:     the parameter is a button object, or button grid
rng:     the parameter is a range bar object
vir:     the parameter is a “virtual parameter” not associated with any other UI object

    When a parameter is first assigned, if it exists in more than one module, the info popup will remind you to make an 
assignment in the Module button grid discussed below by displaying “** select mod ->.”

    If you see asterisks (**) in this info label, it indicates a programming error where the assigned RT Parm is configured 
incorrectly. Check the Min/Max settings and the Module assignment.

    Many ranges and values in KARMA are “zero relative.” In other words, a popup menu might show 64 items, which 
would be referred to as a range of “0 ~ 63.”
<0521>
    [Module] (button grid) [1...6]

Specifies the Module(s) to which the settings of the selected RT Parm will apply. A single RT Parm can therefore affect 
multiple Modules at the same time.
<0522>
    [Minimum] (numerical) [-8192..+8192]

Specifies the Minimum Value that can be operated by an assigned controller or entered into the Value field. The available 
range will depend on the selected Parameter. When the Parameter is selected, the Minimum parameter value (displayed in 
the Info Label) will be set as the default.
<0523>
    [Maximum] (numerical) [-8192..+8192]

Specifies the Maximum Value that can be operated by an assigned controller or entered into the Value field. The available 
range will depend on the selected Parameter. When the Parameter is selected, the Maximum parameter value (displayed in 
the Info Label) will be set as the default.
<0524>
    [Value] (numerical) [varies depending on Min/Max range above]

Sets the Value of the selected Performance RT Parameter. The range of this parameter will vary depending on the settings 
for the RT Parm Min/Max fields above. When you select a parameter and assign a Module, the Value displayed here 
initially will be set to the current Value of the parameter. If you add other Modules to it, they will all be set to the same 
value. If you remove Modules, they will be restored to their previous settings.

    The value you specify here will be the center value when a KARMA RT Control (Slider/Switch) is assigned and used to 
control this parameter. To view the actual modified value, and not the stored center value, switch the “Value To Display” 
buttons to “Current (Controlled) Values.” See About Values To Display. <RPPEd/ValDisp>
<0525>
    [Assign] (popup menu) [0...32]

Assigns the selected Performance Parameter to a controller, such as the Sliders and Switches in the Real-Time Controls 
Editor or Dynamic MIDI. See the description above for Assign under RT Parms Page - GE RT Parms. 
<RPPEd/Assign><0526>

    [Polarity] (button) [+, -]

Specifies the polarity (the direction the Value moves in) when you operate the assigned KARMA Real-Time Control. See 
the description above for Polarity under RT Parms Page - GE RT Parms. <RPPEd/Polarity>

<ValDisp>
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RT Parms - About Values To Display
 

As shown above, when the Values To Display button is changed to “Current (Controlled) Values,” the Value fields become 
grayed out and are not editable. However, in this mode they display the actual current values as they may be modified by 
the positions of the assigned controllers, and not the stored center values. In other words, in the example above, RT Parm 
#1 is assigned to Slider 1. While the actual range of the parameter might be 0 ~ 102, and the stored center value 50, it 
presently displays the current value of 29 since the slider is about 25% from the bottom.

    To experiment with this, select any Performance, switch the Values To Display to “Current (Controlled) Values,” and 
move the Sliders in the Real-Time Controls Editor. Watch the values of the parameters here that are assigned to the 
Sliders and Switches change to reflect the actual setting as based on the position of the controller.

<Stored>
RT Parms - Effects Of The Stored (Center) Value

    This only relates to a Continuous Controller (Slider, Knob, etc.). Has no effect on a Switch or Slider As Switch.

For example, let’s assume that the RT Parm has a Min/Max range of +0000...+0100. 

If you set Value = +0050, Assign = S1 (Slider 1), and Polarity = + (plus):

Slider 1 at the center position will produce a value of +0050. At the bottom the value will be +0000, and at the top the 
value will be +0100. Moving the slider from center toward the bottom will control the value from +0050...+0000, and 
moving it from center toward the top will control the value from +0050...+0100. This is known as a linear response, 
since both halves of the control have the same range.

0      32     64     96    127   Controller Value
'------'------'------'------'
0      25     50     75    100   RT Parm (linear)
0<----------->50<--------->100

If you set Value =  +0080, Assign = S1 (Slider 1), and Polarity = + (plus):

Slider 1 at the center position will produce a value of +0080. At the bottom the value will be +0000, and at the top the 
value will be +0100. Moving the slider from center toward the bttom will control the value from +0080...+0000, and 
moving it from center toward the top will control the value from +0080...+0100. This is known as a non-linear response, 
since one half of the control has a larger variation than the other.

0      32     64     96    127   Controller Value
'------'------'------'------'
0      40     80     90    100   RT Parm (non-linear)
0<----------->80<--------->100
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Dynamic MIDI
Sections in this chapter:

Overview<DynEd/Over>

Input Parameters<DynEd/ParmsSrc>

Output Parameters<DynEd/ParmsDst>

Alt. Dyn MIDI Port/Channel<DynEd/Alt>

Setup<DynEd/Setup>

 

<Over>
Dynamic MIDI - Overview
The Dynamic MIDI Page allows various MIDI Controllers and other actions to be used to control various aspects of KARMA 
in real time. Up to eight sources can be used to control eight different destinations. In the KARMA Motif Factory 
Performances, generally the first six rows are programmed in a standardized fashion to control features such as the Fill 
Button, Retrigger Button and Stutter Buttons. Rows 7 and 8 are sometimes used to change the right hand lead sound or 
transpose it, among other applications.

Input Parameters
Parameters that select the source action or controller, how it operates, and its range.

Output Parameters
Parameters that select the destination to be controlled, which Modules it affects, and the Polarity (direction) it operates 
in.
<0540>

Row For Each Assignment
Each row is a separate Source/Destination routing for a single Dynamic MIDI Effect. If the Destination is “RT Parms 
Control Assign,” the row numbers are available as Control Assignments in the RT Parms Page “Assign” parameters. This 
allows Dynamic MIDI control to be routed into the various GE RTParms and Performance RTParms to control parameters 
of the Modules and Keyboard Layers.

Alt. Dyn MIDI Port/Channel
Selects an alternate MIDI Port and Channel that can be used to control and trigger Dynamic MIDI effects with an external 
controller. The alternatate port can be merged with the programmed settings so that both are active at the same time.

Setup
Selects one of several modes for changing Dynamic MIDI Setups when Performances are changed.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

Page 154



� 

Copy From Performance... <PEUtils/Mco>

Copy Alt. Dyn MIDI Port to all Performances…
Copies the Alt. Dyn MIDI Port setting (but not the channel) to all Performances in the current KDF File. You might use this 
when you open a file created on some other computer with a different MIDI Setup, and you want to change them all to work 
on your current setup.

    Note that this only changes the Performances in RAM. To save these changes to disk, you must choose “Save” or 
“Save As…” from the File menu or Toolbar and update the KDF File on disk.

Clear All
Clears all assignments from all eight rows in the current Performance only.

<ParmsSrc>
Dynamic MIDI - Input Parameters
 

The Input Parameters select a MIDI Controller or other action to control various functions of KARMA.
<0532>

    [Input Port/Channel] (popup menu) [1...8, A]

Selects one of the Ports and Channels that are specified in the Performance’s MIDI Setup. If the Source involves using the 
Module’s Key Zone, that is also applied.

1 ~ 6: Module’s Port/Chan/KeyZone (1 - 6, for each Module)
The MIDI data stream going to the selected Module is used. In other words, if “2 - Module 2’s Port/Chan/KeyZone” is 
selected, then whatever Port and Channel has been selected for Module 2 in the Input section of the Performance Editor > 
MIDI Setup Page is used here as a source of MIDI Data. Furthermore, in the case of using some specialized Sources with 
the word “Zone” such as “Note # Inside Zone,” the settings for the Module’s Key Zone in the Key Zone Page also have an 
effect. Note that this is only for Note Numbers and Velocities; other controller data is not effected by the Key Zone 
settings.

7 ~ 8: Keyboard Layer’s Port/Chan/KeyZone (1 - 2, for each Keyboard Layer)
The MIDI data stream going to the selected Keyboard Layer is used. In other words, if “7 - Kbd Layer 1’s 
Port/Chan/KeyZone” is selected, then whatever Port and Channel has been selected for Keyboard Layer 1 in the Input 
section of the Performance Editor > MIDI Setup Page is used here as a source of MIDI Data. Furthermore, in the case of 
using some specialized Sources with the word “Zone” such as “Note # Inside Zone,” the settings for the Keyboard 
Layer’s Key Zone in the Key Zone Page also have an effect. Note that this is only for Note Numbers and Velocities; other 
controller data is not effected by the Key Zone settings.

    When a Keyboard Layer is selected, the only Output Destination available is “RT Parms Control Assign,” since 
Keyboard Layers do not contain GEs and all of the other destinations affect the operation of a Module’s GE. However, 
Dynamic MIDI can be used on Keyboard Layers to control the Transpose of the LH and RH sounds, and change the MIDI 
Output Channel so as to change the RH lead sound in different scenes - as demonstrated in many of the Factory 
Performances.

9: A - Alt. Dynamic MIDI Port/Chan
The MIDI Data stream selected as the Alternate Dynamic MIDI Port/Channel at the bottom of this page is used as a source 
of MIDI Data. This can be used to route an external controller to control Dynamic MIDI effects.

For information on setting Ports and Channels in the Performance, see the Performance Editor > MIDI Setup chapter.
<MidEd><0533>
    [Source] (popup menu) [0...67]

Chooses a MIDI Controller or other action from the selected Input Port/Channel to control the Destination. For a complete 
description of the currently available Sources, see the Appendix Dynamic MIDI Sources.
<DynSrc><0534>
    [Action] (popup menu) [0...2]

Selects one of three different ways the Source can operate on the Destination.
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0: M - Momentary Switch
Selecting this option makes the Source function as a momentary switch. For example, if a Sustain Pedal was set to 
Momentary Switch, pressing it turns the Destination on, and releasing it turns the Destination off. Note that this can be 
used with Continuous Controllers also, in which case the values set in the Bottom and Top fields are used to switch on/off.

1: T - Toggle Switch
Selecting this option makes the Source function as a toggle. For example, if a Sustain Pedal was set to Toggle Switch, then 
pressing and releasing it once will turn the Destination on, and pressing and releasing it again will turn the Destination off. 
Note that this can be used with Continuous Controllers also, in which case the values set in the Bottom and Top fields are 
used to toggle on/off.

2: C - Continuous
Selecting this option makes the Source function as a Continuous Controller. For example, if the Mod Wheel was the Source, 
this will send the full range of 0 ~ 127 (or the portion specified by the Bottom/Top fields) to the selected Destination 
(which may or may not make sense, depending on the Destination).
<0535><0536>

    [Bottom/Top (Range)] (numericals) [0...127]

Sets an overall range of operation for the selected Source. Depending on the Source and what the Action menu is set to, 
they can have different functions. With Continuous Controllers, they can specify only a portion of the full range to be used. 
With Note # and Velocity Sources, they can be used to set note or velocity windows so that only certain areas of the 
keyboard or velocity range will trigger the Destination, for example. The Polarity menu in the Destination Parameter area 
can effectively reverse these fields. For more information, see the Appendix Dynamic MIDI Sources.

<DynSrc><ParmsDst>
Dynamic MIDI - Output Parameters
 

The Output Parameters control which Destination is affected by the Source Controller or action, which Modules it affects, 
and the Polarity (direction) it operates in.
<0537>
    [Module] (button grid) [1...7]

Chooses a Module or Modules to control. For certain Destinations such as “Global Tempo” or “RT Parms Control Assign” 
the Module area is grayed out.

1 ~ 6:  Module
Only the selected Module(s) will be affected. For example, if the Destination selected was “Module Stop” and Module 3’s 
button is on, then the specified action would only stop Module 3’s effect.

7: L - Last Triggered Module
Only the Last Triggered Module will be affected. For example, this allows you to assign different Modules to be triggered 
from different parts of the keyboard, and depending which one was last triggered, route a Dynamic MIDI effect to it 
on-the-fly, such as Direct Indexing.
<0538>
    [Destination] (popup menu) [0...29]

Selects a KARMA function/feature to control with the selected Source. For a complete description of the currently 
available Destinations, see the Appendix Dynamic MIDI Destinations.
<DynDst>

    If Destination is “RT Parms Control Assign” the row numbers are available as Controller Assignments in the 
Performance Editor > RT Parms Page “Assign” parameter, allowing you to route Dynamic MIDI Control to individual GE 
and PE RT Parms.
<RPPEd/0515><0539>
    [Polarity] (popup menu) [0...3]

Affects the direction the selected Source will operate in. This may also be affected by the Bottom and Top settings in the 
Source Parameters section.

0: (+) Positive
Controller acts as usual: 0 ~ 127 = 0 ~ 127.
 

1: (-) Negative
Inverts the polarity: 0 ~ 127 = 127 ~ 0.

2: (+/-) Positive/Negative
Useful with Pitch Bend Wheel:  Center = 0; Center ~ Top = 0 ~ 127;  Center ~ Bottom = 0 ~ 127.

3: (-/+) Negative/Positive
The reverse of 2:   Center = 0; Center ~ Top = 127 ~ 0;  Center ~ Bottom = 127 ~ 0.

<Alt><0541><0542><0543><0544>
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Dynamic MIDI - Alt. Dyn MIDI Port/Channel
 

    [Alternate Dyn MIDI Port] (popup menu) [varies depending on the MIDI Ports on your computer]

Selects an alternate MIDI Port that can be used to control and trigger Dynamic MIDI effects. You might use this with an 
external controller such as a Korg nanoPAD or a Steinberg CMC-PD. The choices in this menu will be determined by the 
MIDI Ports on your computer. Enabled ports are determined by the MIDI Port Manager.
<MidPort>
    [Alternate Dyn MIDI Channel] (popup menu) [1...16]

Selects an alternate MIDI Channel that can be used to control and trigger Dynamic MIDI effects. 

    [Merge] (checkbox) [Off, On]

When on, messages from the Alternate Dyn MIDI Port/Chan will be sent to all active rows above, in addition to the 
assigned Input Port/Chan. When off, only those rows specifically set to use the Alt. Port ‘A’ will receive the messages. 
This is useful for allowing an alternate controller to trigger the functions that are already assigned without having to 
modify the Input Port settings.

<Setup><0531>
Dynamic MIDI - Setup
 

    [Setup] (popup menu) [0...2]

Selects one of several modes for changing Dynamic MIDI Setups when Performances are changed.

    For normal operation, this should always be set to “Performance,” indicating each Performance uses its own settings.

0: Performance
Each Performance can store a separate Dynamic MIDI Setup. Choose this option if you want each Performance to use its 
own routing setup.

1: File
Each KDF File stores one Global Dynamic MIDI Setup which can be used for all the Performances in the entire file. This 
overrides the MIDI Setup stored with each Performance.

2: Global
A single Global Dynamic MIDI Setup exists for the entire program, which is saved in the Preferences file. Choose this 
option if you want to override any settings stored with the File or with each Performance.
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Random Seeds
Sections in this chapter:

Overview<RsdEd/Over>

How KARMA Generates Random Numbers<RsdEd/How>

Example: Two Randomized Modules In Harmony<RsdEd/Example>

Share Parameters<RsdEd/Share>

Start Parameters<RsdEd/Start>

Capture Random Seeds Dialog<RsdEd/Capt>

 

<Over>
Random Seeds - Overview
The Random Seeds Page allows you to control some aspects of how a KARMA GE’s randomizations are performed. For the 
GE selected for each KARMA Module, you can often control the sequence of randomizations for various parameter groups 
such as Rhythm, Duration, Velocity etc. The random calculations are performed based on initial starting values, known as 
“seeds . ”

One of the main intentions of this feature is to allow the same randomized GE to be used in more than one Module at the 
same time, and have all or parts of the randomizations stay in sync between the Modules. This can be used to have two 
different instruments play the same randomized line in unison or in harmony. For example, if a GE was programmed using 
Random Rhythms, Random Indexes, and Random Velocities, you might set two Modules to use the same GE and share the 
same Random Seeds for Rhythm and Index, but not for Velocity (so that two different “musicians” play the same rhythm 
and notes, but with different randomized velocities).

It is important to note that the actual settings for whether or not randomizations are used are made in the GE itself. This 
page only allows you to determine whether different Modules using the same GE will share various sequences of random 
numbers. If two Modules are using different GEs, setting them to use the same seeds will likely cause no audible effect, 
unless they have portions that are identical, such as the Rhythm Pattern, Velocity Pattern, etc.

    Changing these settings will not have any effect for GEs that were not designed to utilize the various random 
capabilities.
<0545><0546>

Share/Start Selection Buttons
Switches between two different sub-pages in the sub-page area.

Sub-Page Area
When the Share Button is selected, displays the Share Parameters (Seed Offset/Module Grids) as shown above.
<RsdEd/Share>

When the Start Button is selected, displays the Start Parameters (Start Seed, Freeze Loop Length, Retrigger Each Time).
<RsdEd/Start>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:
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Copy From Performance... <PEUtils/Mco>

Set All Different
Set All Same
Allows you to quickly set the Seed Offset/Module Grids to one of two different configurations: “All Different” (a diagonal 
line) and “All Same” (all Seed Offsets set to 1).

    Not available unless the Share Parameters are being display in the sub-page area, and there is more than one active 
Module in the Performance.

Link Start Seeds
If turned on, when you specify a “Start Seed” value for one of the active KARMA Modules, the “Start Seed” of all other 
active Modules in the Performance will be set to the same value. This is useful for quickly trying out new settings on all 
Modules at the same time. 

    When this is turned on, a checkmark appears next to the item in the popup menu. This setting is ignored while “Capture 
Random Seeds...” is being executed.

    Not available unless the Start Parameters are being display in the sub-page area, and there is more than one active 
Module in the Performance.

Capture Random Seeds...
Brings up a dialog allowing you to capture the internal seed settings to the “Start Seed” field. See later in this chapter: 
Capture Random Seeds Dialog
<RsdEd/Capt>

    Not available unless the Start Parameters are being display in the sub-page area.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the Performance Editor > RT Parms Page for more information. 

<RPPEd><How>
Random Seeds - How KARMA Generates Random Numbers
KARMA creates its randomizations using what is known as “pseudo-random” numbers. (Actually, all computer-based 
randomizations are pseudo-random in nature. There is no way to actually calculate truly random choices. But that 
discussion is beyond the scope of this help file.) A pseudo-random number generator starts a string of calculations with a 
number known as a “seed.” A randomized number is generated by performing a special mathematical operation on the 
seed. When the next random number is needed, the same operation is performed on the previous random number and so on, 
with all randomizations in a sequence descending from the initial seed (“start seed”). Therefore, it is possible to repeat 
exactly a sequence of randomizations if you start with the same seed. Different seeds yield completely different 
sequences of randomized numbers. Since KARMA bases its choices for rhythms, durations, notes etc. on these sequences 
of random numbers, totally random-based phrases and patterns can be recalled, stored, and repeated at any time, and 
shared between Modules!

<Example>
Random Seeds - Example: Two Randomized Modules In Harmony
Theory:
To make two modules play the same randomized GE in harmony, set up the same GE into both modules (using one that is 
programmed for randomizations), and set them to share the Random Seeds that apply to the characteristics that you want 
to stay in sync. For example, if using the same GE on Module 1 and 2 with random rhythms, set Module 1 & 2 Rhythm 
Seed Offsets to the same row. It doesn’t really matter which row, as long as they are the same. The picture below shows 
an example where Modules 1 & 2 are both set to use Seed Offset 1 for Rhythm, Duration and Index. Note that it is not 
necessary to use the same seed across different musical attributes; having Module 1 & 2 sharing Seed Offset 1 for 
Rhythm and sharing Seed Offset 2 for Index will have the same effect as if they were all using Seed Offset 1. They must 
only share the same offset within a particular grid. You could then do the same thing for the Velocity Seed Offset, if you 
wanted them to play with the same velocities; or leave that one set diagonally, so that the two musicians play with 
different “velocity feeling.”
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Then change the GE Editor > Note Series “Inversion” parameter for the second module, i.e. Module 1 Inversion = 0, 
Module 2 Inversion = 4 (usually assigned to a GE RTP in the GE’s RTC Model, so edit in the Performance Editor > RT Parms 
Page). This way, when each GE’s Note Series Index moves through the two Note Series and picks notes to generate, they 
will be in the same location, but offset from each other by the Inversion parameter. This creates a harmony effect. For a 
specific example of this technique, see the Random Seeds Tutorial in the Tutorials Folder.
<SetupKMO/TutFolder>

    This is sometimes a very tricky feature to use. If you wanted to set up the same, randomized GE in two modules, and 
have them play in harmony, you must make sure that they have the same Note Series length. Depending on certain other 
parameters (such as Note Type, Filter Dupes, etc.), changing the Inversion parameter will actually cause the Note Series 
to be recreated with a different number of notes than the other Module’s GE. In this case, it may be impossible for the two 
Modules to “stay in sync,” even though they are set to share the same Random Seeds. This might be because one GE 
changes Phases earlier than the other, or has to cycle back at the end of a Phase when the other does not, etc.

<Share><0547><0548><0549>
Random Seeds - Share Parameters
 

Choosing “Share” with the Share/Start Selection Buttons displays the Share Parameters sub-page. An area exists for 
each of the Modules.

    [Seed Offset/Module Grid] (grid)

For each of the “musical attributes” that utilize randomization in KARMA, a grid is available. These grids relate to the 
associated pages in the GE Editor: Rhythm, Duration, Index, Cluster, Velocity, CCs, WaveSeq and Drum. The X-axis of 
each grid is the Module Number, while the Y-axis is one of six Start Seed Offsets. Each row corresponds to one of six 
Start Seed Offsets, while each column corresponds to one of up to six Modules. Inactive Modules will be grayed out. The 
cell selected in a particular row and column indicates which Start Seed Offset is being used by a particular Module.

It is important to note that this is an offset, and not an absolute ID of a seed value. KARMA chooses its Start Seeds from 
billions of variations (or from the specific value you enter in the Start Seed field), so this does not imply there are only 
six Start Seeds. Rather, think of it as Offset 1 is a randomly specified start Seed from billions of possibilities at a given 
moment in time, while Offset 2 is a second variation based on that number, and Offset 3 is a third variation etc.

For example, if you select Rhythm Seed Offset 1 for two KARMA Modules, running the same GE under the same conditions 
will cause the randomness of the rhythms to be identical. If different types of randomness are being used, such as 
Duration, Velocity etc., setting all the seed offsets to the same value within each grid (for those two Modules) will cause 
the resulting phrases to be identical.

Conversely, if you select Rhythm Seed Offset 1, 2, 3, and 4 respectively for the four KARMA Modules and run the same 
GE under the same conditions, the randomness of the rhythms will be different. If different types of randomness are being 
used, such as Duration, Velocity etc., setting all the seed offsets to the different values within each grid will cause the 
resulting phrases to be completely different.

Normally, you will select different values for each module (a diagonal line being an example). Select identical values if you 
want two or more KARMA Modules to play the same GE in unison or harmony with the same randomizations. For an 
example of how to do this, see above: Example: Two Randomized Modules In Harmony.
<RsdEd/Example>
    There is no connection between the grids. Setting all Rhythm Seeds to 1 and all Duration Seeds to 1 has no special 
meaning, and audibly would act the same as setting all Rhythm Seeds to 1 and all Duration Seeds to 6. Rather, it is the 
sharing of the seeds within a particular grid that has significance.

    When the Duration Pattern Advance Mode is set to “Lock (R/S) - Lock to Rhythm Pattern, Synchronize 
Randomization,” the Duration Pattern uses the Rhythm Seeds Grid, and the Duration Seeds Grid has no effect.

    The sharing of the Start Seeds relates to the programming of Random Pools (and/or Random Ties/Rests where 
applicable) within the Pattern Grids of the above pages. Furthermore, this also relates to how the randomizations are 
being restarted in the Phase Page. If there are no randomizations programmed, sharing Start Seeds will have no effect.

<Start><0561>
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Random Seeds - Start Parameters
 

Choosing “Start” with the Share/Start Selection Buttons displays the Start Parameters sub-page. An area exists for 
each of the Modules.
<0561>

    [Module Name] (label)

Displays a descriptive name for each Module, which can be assigned on the GE Setup/Mix Page.
<MixEd/ParmsGE><0550>
    [Start Seed] (numerical) [-2147483648…0: Random…+2147483647]

Specifies the “Start Seed” that is used by the KARMA Module to generate a sequence of random numbers, from within a 
range of over four billion possibilities. This value will be used each time a trigger occurs.

This Start Seed is used to calculate a number of other internal Start Seeds for each of the musical attributes such as 
Rhythm, Duration, Velocity etc. It is these other internal Start Seeds that are shared according to the “Seed 
Offset/Module Grids” explained earlier in this chapter. See Share Parameters.
<RsdEd/Share>
0: Random:
A different phrase will be generated each time the trigger occurs. Internally within the KARMA Module, a different “Start 
Seed” value is chosen randomly each time the trigger occurs.

Any value other than Random:
The same phrase will be generated each time the trigger occurs. Different values for the Start Seed parameter will 
produce different phrases, but the same phrase will always be generated if the Start Seed value is the same.

    When experimenting with the example above, try entering your birthday in Module 1’s Start Seed field for fun (i.e. 
12/24/64 = 122464) - you may be surprised by the results! Notice that each time you trigger the phrase, it repeats the 
same series of notes, even though it is randomized. 
<RsdEd/Example><0551>
    [Freeze Loop Length] (numerical) [0:Off, 1...32 Bars]

Specifies the number of measures (bars) in the phrases that are repeatedly generated by the KARMA Module. After being 
triggered, the Module will generate a phrase of the number of measures you specify here, and will then repeat that 
phrase. If you set this Off, the phrase will not be repeated.

The table below and the explanations that follow describe how various combinations of “Start Seed” and “Freeze Loop 
Length” settings will affect the phrase or control data that is randomly generated by the KARMA Module each time 
triggering occurs, according to the GE settings you are using.

 

(1) “Start Seed”: 0: Random, “Freeze Loop Length”: 0: Off
The phrase will change randomly each time triggering occurs. Each time the phrase repeats, it will change randomly. For 
example, suppose there is a GE that, if you input C-D-E-F, will randomly vary the order of notes, and repeatedly play 
four notes in each measure. When you trigger this GE, it produces notes in a random order of (for example) C-D-E-F, 
C-C-D-F, F-D-C-E…. When you trigger this GE again, it produces a different random phrase of (for example) E-D-C-C, 
C-C-D-D, C-D-C-E....

(2) “Start Seed”: any value, “Freeze Loop Length”: 0: Off
Each time triggering occurs, the same phrase will be generated. Different “Start Seed” values cause different phrases to 
be generated. The phrase will change randomly each time it repeats, but the same phrase will always be generated each 
time you retrigger with a given “Start Seed” value. This lets you select any desired one of more than four billion (!) 
different phrase variations. For example, suppose there is a GE that, if you input C-D-E-F, will randomly vary the order 
of notes, and repeatedly play four notes in each measure. When you trigger this GE, it produces notes in a random order of 
(for example) C-D-D-C, D-C-E-C, D-E-C-D…. Even if you trigger this GE again, it reproduces the same phrase of 
C-D-D-C, D-C-E-C, D-E-C-D…. If you change the “Start Seed” value, a different phrase will be generated; for example, 
E-E-C-D, D-C-C-C, E-E-E-E….
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(3) “Start Seed”: 0: Random, “Freeze Loop Length”: 1…32
The phrase will change randomly each time triggering occurs. However, that phrase will loop (repeat) for the number of 
measures you specified in “Freeze Loop Length.” The same phrase will continue looping until you trigger the GE again. 
When you trigger the GE again, a different phrase will loop. For example, suppose there is a GE that, if you input C-D-E-F, 
will randomly vary the order of notes, and repeatedly play four notes in each measure. If you set “Freeze Loop Length” 
to 1 (measure) and trigger this GE, the same four notes will continue looping (e.g., F-E-D-C, F-E-D-C, F-E-D-C, …). When 
you trigger it again, a different phrase will loop (e.g., D-D-C-C, D-D-C-C, D-D-C-C,…). Also see “Retrigger Each Time” 
below.

(4) “Start Seed”: any value, “Freeze Loop Length”: 1...32
The same phrase will play each time you trigger the GE. That phrase will loop for the number of measures you specified in 
“Freeze Loop Length.” For example if you select a program or combination, and make these settings for a KARMA Module 
that generates random changes each time it is triggered, the exact same phrase will loop every time. The phrase that is 
looped will be different if you change the “Start Seed” value. For example, suppose there is a GE that, if you input 
C-D-E-F, will randomly vary the order of notes, and repeatedly play four notes in each measure. If you set “Freeze Loop 
Length” to 1 (measure) and trigger this GE, the same four notes will loop (e.g., D-E-E-C, D-E-E-C, D-E-E-C, …). Even if 
you trigger the GE again, the same phrase (D-E-E-C, D-E-E-C, D-E-E-C, …) will be reproduced. If you change the “Start 
Seed” value, a different phrase (e.g., C-C-E-E, C-C-E-E, C-C-E-E, …) will loop. Also see “Retrigger Each Time” below.

    [~Freeze LoopLen + Reset] (virtual)

This is not a true parameter, but a “virtual” parameter for RT Parm control. It does not physically exist on the Random 
Seeds Page, but performs a modifying function on the Freeze Loop Length parameter above. It can be found in the Random 
Seeds Group when assigning parameters in the Performance Editor > RT Parms Page, and has a tilde (~) at the beginning of 
the parameter name (indicating that it is virtual). This parameter operates exactly the same as Freeze Loop Length above, 
with the following difference:

When this is used, and the Start Seed is set to some other value than 0: Random, changing the Freeze Loop Length to any 
value except 0: Off will reset the Start Seed internally to the indicated value, thereby restoring the original phrase at the 
next downbeat without retriggering it from the keyboard. 

Normally, if you were generating a randomized riff from a particular Start Seed value, setting Freeze Loop Length to 0: 
Off would cause the phrase to continue randomizing from its current internal position. If you then set the Freeze Loop 
Length to some other value than 0: Off, thereby looping the phrase, it does not automatically reset the Start Seed until 
you retrigger it from the keyboard (depending on Trigger settings). By using “Freeze LoopLen + Reset,” a change in the 
Freeze Loop Length can additionally reset the internal Start Seed and therefore generate the same phrase as before, 
allowing instantaneous switching between “randomized” and “preset” phrases.
<0552>
    [Retrigger Each Time] (checkbox) [Off, On]

Specifies whether the phrase will retrigger each time it completes the specified Freeze Loop Length, or retrigger 
according to the GE’s internal settings.

On
Every time the specified loop length is completed, the Phase Pattern, Envelopes, and Indexes will retrigger as if the 
keyboard itself was retriggered. This means that the notes in the phrase will be restarted according to the Note Trigger 
settings in the Trigger Page and the applicable internal settings of the GE. Any envelopes will be retriggered according to 
the Envelope Trigger/Latch settings in the Trigger Page likewise.

Off
The overall length of the internal GE Phase Pattern controls when the loop will be retriggered. For example, if the Phase 
Pattern is 8 bars, and the “Freeze Loop Length” is set to 2 bars, then the randomizations will reset every 2 bars 
(controlling the rhythm and movement of notes, for example), but the melody and envelopes may not trigger from the 
beginning until every 8 bars is completed.

    Not available unless “Freeze Loop Length” is set to something other than “0” (off).

    In some cases, the two settings may sound identical depending on the GE’s internal settings.

<Capt><1135><1139>
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Random Seeds - Capture Random Seeds Dialog
 

When the Start Parameters are being displayed in the sub-page area, the “Capture Random Seeds...” utility is enabled on 
the Menu Button. Selecting it opens the above dialog.

Use this when KARMA has been randomizing a GE’s performance, and you hear an effect you would like to “lock in.” When 
you execute this command, the “Start Seed” setting (which is the source of the randomness of the phrase generated by 
the KARMA Module) will automatically be set to the “Seed” value that is being internally used by the KARMA Module at 
that moment. When you are listening to the randomly changing phrases generated each time a KARMA Module is triggered, 
and you hear a phrase that you would like to reproduce consistently each time you trigger that GE, you can execute this 
command to capture the seed that resulted in that phrase.
<1136>
    [Module] (popup menu) [depends on number of active Modules]

If you are in a Performance using more than one KARMA Module, this selects the Module for which you want to capture 
the seed value. This popup menu will have only the applicable number of Modules inside, with the last item being “All.” If 
you select a single Module, the seed value will be captured for that KARMA Module only. If you select “All,” the seed 
values will be captured for all active KARMA Modules.
<1137><1138>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing the operation. The OK Button (green checkmark) closes the 
dialog and executes the Random Capture. 

    It is not possible to use this function on a Module when it has the Start Seed parameter assigned as an RT Parm in the 
RT Parms Page. In this case, an error message will be displayed.
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CC Offsets                                      
Sections in this chapter:

Overview<OffEd/Over>

CC Offset Parameters<OffEd/Parms>

 

<Over>
CC Offsets - Overview
The CC Offsets Page provides four “CC Offsets” for each of the six Modules. Each CC Offset is comprised of a MIDI 
Control Change (CC) Number and a Value for the MIDI CC. These Values are sent out when a Performance is loaded, 
provided the KARMA Function is on in the Real-Time Controls Editor. Alternatively, they are sent out when the KARMA 
Function is turned on, and then reset to default “Off Values” when the KARMA Function is turned off. A column exists for 
each of the six Modules, which may be grayed out depending on how many Modules are active in the current Performance. 
The Module Name displayed at the top of the column can be assigned on the GE Setup/Mix Page.

Since most synths have ways of controlling tonal characteristics through MIDI CCs, this can be used to further modify the 
programs on the destination device to respond differently to KARMA when it is on, yet return to a previous state when it 
is off. In addition, these can be used to switch on and off other functions of a device, such as the effect sections.

Unlike the CCs generated by KARMA from the GE, which can be continuously changing or can be generated with each note, 
this is a “one-time” setting that is broadcast when the Performance is loaded, or when the KARMA Function is turned on. 
(When the KARMA Function is turned off, any CCs that are assigned here will be reset to a default “Off Value,” such as 0, 
64, or 127 depending on the CC Number).

    This feature was developed for the Korg versions of KARMA; it was not used in the factory Performances created for 
the Yamaha version, although it may prove useful in some situations.

CC Offset Parameters
Four rows corresponding to CC Offsets 1 ~ 4. Each CC Offset is comprised of a MIDI Control Change (CC) Number and a 
Value for the MIDI CC.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy From Performance... <PEUtils/Mco>
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Set All Off
Resets all CC Offsets in all six Modules to off, with a Value of 0. If the KARMA Function is on, will reset any CCs that may 
be assigned before turning them off.

<Parms><0593>
CC Offsets - CC Offset Parameters
 

Each CC Offset is comprised of a MIDI Control Change (CC) Number and a Value for the MIDI CC. The message is 
transmitted when the Performance is loaded, provided the KARMA Function is on in the Real-Time Controls Editor. 
Alternatively, they are sent out when the KARMA Function is turned on, and then reset to default “Off Values” when the 
KARMA Function is turned off.
<0594>

    [Module Name] (label)

Displays a descriptive name for each Module, which can be assigned on the GE Setup/Mix Page.
<MixEd/ParmsGE><0591>
    [CC Number] (popup menu) [0: Off...126]

Selects the MIDI Control Change Message that will be transmitted, with the specified Value. The popup menu displays some 
common names for various controllers.

    For KARMA Motif, the CC names shown in the popup menu relate directly to the Yamaha Motif/MOX Sound Engine.
<0592>
    [CC Value] (numerical) [0...127]

Sets the Value for the specified MIDI Control Change Message, which is then transmitted.

    The CC Values will only be transmitted if the KARMA Function is turned on in the Real-Time Controls Editor.
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MIDI Setup (Performance)
Sections in this chapter:

Overview<MidEd/Over>

Input Parameters<MidEd/ParmsIn>

Output Parameters<MidEd/ParmsOut>

Link/Setup<MidEd/Link>

 

<Over>
MIDI Setup - Overview
The MIDI Setup Page controls the MIDI In and Out options for each Performance. These can be stored individually with each 
Performance, or overridden on a global level. This is where you setup which keyboards/controllers will send input data to 
KARMA, and where the data being generated by KARMA will be sent to. For examples of different input and output uses for 
recording KARMA to an external sequencing program, see the separate tutorial:

Sequencing With KARMA Motif (in the Tutorials Folder)<SetupKMO/TutFolder>

    The MIDI Channels for the Chord Triggers, which also can be different and are stored in each Performance as well, are 
located in the Chord Triggers Editor.
<CtgEd>

Input Parameters
Settings for each of the KARMA Modules and Keyboard Layers that specify which ports and channels of your MIDI Setup 
are being used for incoming MIDI data.

Output Parameters
Settings for each of the KARMA Modules and Keyboard Layers that specify which ports and channels of your MIDI Setup 
are being used for the outgoing MIDI data generated or passed through by KARMA.
<0158>

MIDI Received LED
Flashes whenever MIDI data of any type is received on any MIDI channel on an open port (ports are opened with the MIDI 
Port Manager).
<MidPort>

Keyboard Layer Rows
Each row corresponds to one of the two Keyboard Layers, providing MIDI In and Out settings for each Layer.

Module Rows
Each row corresponds to one of the six KARMA Modules, providing MIDI In and Out settings for each Module.
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Link All Ports
Selects whether the Modules and Keyboard Layers have their port settings linked to the Global In/Out port in the MIDI 
Setup (Global) Editor > General Page. <MsuGen/Global>

Setup
Selects one of several modes for changing MIDI Setups when Performances are changed.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Set Default Channels in Current Performance
Sets the MIDI Channels of all 8 parts to the default arrangement of all parts on Input Channel 1, and Output Channels 1~8.

Copy Port Settings To All Performances
Copies the current In and Out Port Settings (but not the channels) to all Performances in the current KDF File. You might 
use this when you open a file created on some other computer with a different MIDI Setup, and you want to change them all 
to work on your current setup. In this case, simply set the ports as desired on an example Performance, get it working 
how you want, and then copy the Port Settings to all other Performances.

This is only needed if you have unchecked Link All Ports To Global Ports, and are using the setup stored in each 
Performance.
<MidEd/Link>

    Every Performance in KARMA has its own MIDI setup that controls how the six Modules and two Keyboard Layers are 
routed, and on which MIDI Channels. Since the data in a particular KDF File may be stored with a configuration that does 
not match your computer system, you may find you need to change the MIDI ports of all Performances in a file (if you are 
not using Link All Ports To Global). You may simply find that all of the Ports are set to the wrong selection, or you may 
receive an error message that “Invalid Port Settings in MIDI Ins & Outs Editor have been adjusted.” 

Copy Input Channel Settings To All Performances
Copies the current Input Channel Settings to all Performances in the current KDF.

    Note that both of these only change the Performances in RAM.  To save these changes to disk, you must choose 
“Save” or “Save As…” from the File menu or Toolbar and update the KDF File on disk.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the Performance Editor > RT Parms Page for more information. 
<RPPEd>

MIDI Port Manager... - opens the MIDI Port Manager. <MidPort>

<ParmsIn><0157>
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MIDI Setup - Input Parameters
 

The settings in this section determine which MIDI Port and Channel each of the six KARMA Modules and two Keyboard 
Layers will receive MIDI data on (the “Source”). This input data can be used to control and trigger the GE for each 
Module, and play keyboard parts on top of them. The diagram above to the left shows the appearance for normal use with a 
single Motif/MOX; the diagram to the right shows an example where an external MIDI Controller (Korg M3) is being used 
to play the Keyboard Layers, and a third device is triggering Module 2 on a different MIDI Channel. The Module or 
Keyboard Layer Name displayed to the left of each row can be assigned on the GE Setup/Mix Page.
<MixEd/ParmsGE><0150>
    [Input Mode] (button) [Single, Multi]

    Not available when the Link All Ports To Global Ports setting is on.<MidEd/Link>

Controls whether a single Input Port is used, or multiple Input Ports.

Single
Displays only the Input Port for Module 1. This setting is then used for all six Modules and both Keyboard Layers. When 
“Link All Ports To Global Ports” is selected, all Input Ports will be grayed out and the Global In Port will be used.

Mult i
Displays a separate Input Port for each of the six Modules and two Keyboard Layers. This allows each Module or Keyboard 
Layer to be controlled by a different MIDI device if desired.
<0145><0146>
    [Input Port] (popup menu) [varies depending on the MIDI Ports on your computer]

Selects the MIDI Port that each Module or Keyboard Layer will receive MIDI data on (the “Source”). The choices in this 
menu will be determined by the MIDI Ports on your computer. Enabled ports are determined by the MIDI Port Manager.
<MidPort>

    Not available when the Link All Ports To Global Ports setting is on.<MidEd/Link>
<0147>
    [Input Channel] (popup menu) [0...15, 16: 1...16, Global]

Selects the MIDI Channel that each Module or Keyboard Layer will receive MIDI data on, from the device selected in the 
Input Port menu.
<0144>
    [GCh Also] (checkbox) [Off, On]

Determines whether input on the Global Channel will also be used for the selected Module, in addition to the channel that is 
selected in the Input Channel menu. 

Off
The selected Module will receive data from the specified Input Channel, and will not receive data from the Global Input 
Channel.

On
The selected Module will receive data from the specified Input Channel and the Global Input Channel. This is useful when 
using a Chord Trigger on a specific MIDI Channel to send data into a Module. Turning “GCh Also” on allows a keyboard 
(sending on the Global Channel) to also control the same Module. Otherwise, the keyboard would not be able to trigger note 
generation.

    Not available unless the Module’s Input Channel menu is set to something other than Global Channel.
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<ParmsOut>
MIDI Setup - Output Parameters
 

The settings in this section determine which MIDI Port and Channel each of the six KARMA Modules and two Keyboard 
Layers will send MIDI Data to (the “Destination”). Data that is being generated or played for each Module or Keyboard 
Layer will be sent to this destination. The diagram above to the left shows the appearance for normal use with a single 
Motif/MOX; the diagram to the right shows an example where Modules 1 and 3 are playing sounds on a Korg M3.
<0151>
    [Output Mode] (button) [Single, Multi]

    Not available when the Link All Ports To Global Ports setting is active.<MidEd/Link>

Controls whether a single Output Port is used, or multiple Output Ports.

Single
Displays only the Output Port for Module 1. These settings are then used for all six Modules and both Keyboard Layers. 
When “Link All Ports To Global Ports” is selected, all Output Ports will be grayed out and the Global Out Port will be used.

Mult i
Displays a separate Output Port for each of the six Modules and two Keyboard Layers. This allows each Module or 
Keyboard Layer to play a different MIDI device if desired. 
<0152><0153>
    [Output Port] (popup menus) [varies depending on the MIDI Ports on your computer]

Selects the MIDI Port that each Module or Keyboard Layer will send MIDI Data on (the “Destination”). The choices in this 
menu will be determined by the MIDI Ports on your computer. Enabled ports are determined by the MIDI Port Manager.
<MidPort>

    Not available when the Link All Ports To Global Ports setting is active.<MidEd/Link>
<0154>
    [Output Channel] (popup menu) [0...15: 1...16, Global]

Selects the MIDI Channel that each Module or Keyboard Layer will send MIDI Data on, to the device selected in the Output 
Port menu.

<0148><Link>
MIDI Setup - Link/Setup
 

    [Link All Ports To Global Ports] (checkbox) [Off, On]

When on, the Input and Output Ports will be automatically “linked” to the port settings in the MIDI Setup (Global) Editor > 
General Page. In other words, regardless of the stored port settings in the Performance, changing to a new Performance 
will not select them, but the ports will remain set to the same settings as the Global In/Out Port.
<MsuGen/Global>
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The reason for this is to allow you to easily use a KDF file with your keyboard without having to worry about what port 
settings may be stored in each Performance. Typically, for a new user and a new installation, this should be set to on. 
(The exception to this is when you want to use a different external MIDI keyboard as the main controller, or for devices 
that do not have built-in keyboards and must use an external controller.)

When off, and the setup menu is set to “Performance,” each Performance will load its own port settings, allowing you to 
have the KARMA data sent to different destination devices, or to allow different input devices to trigger the KARMA 
effects. You can set up a completely different configuration with multiple devices for each Performance.
<Setup><0149>
    [Setup] (popup menu) [0...2]

Selects one of several modes for how and when the MIDI Setup (settings in this editor) will be changed.

    For normal use, this should always be set to “Performance,” indicating each Performance uses its own settings.

0: Performance 
Each Performance can store a separate MIDI Setup. Select this option if you want each Performance to change the MIDI 
Setup when it is loaded.

1: File
Each KDF File stores one File MIDI Setup that can be used for all the Performances in the entire file. This overrides the 
MIDI Setup stored with each Performance.

2: Global
A single Global MIDI Setup exists for the entire program, which is saved in the Preferences file. Choose this option if you 
want to override any settings stored with the File or with each Performance. This can be useful for setting up a particular 
MIDI setting for a complex MIDI rig, and then switching to other Performances without disturbing the MIDI Setup.
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Fill/Stop
Sections in this chapter:

Overview<StpEd/Over>

Stop Parameters<StpEd/Stop>

Retrigger Parameters<StpEd/Retrigger>

Play Final Event<StpEd/Final>

Set Up Module For Fill Dialog<StpEd/Setup>

  

<Over>
Fill/Stop – Overview
The Fill/Stop Page allows you to set up one or more KARMA Modules to act as a “fill,” such as a drum fill or a melodic 
fill that can be triggered by KARMA’s Fill button or external MIDI control. Fills can be useful for adding extra musical 
excitement or human feel to a KARMA Performance, segueing between different scenes and parts of the song, or even as 
an intro to start off a performance.

Multiple methods of ending the fill once it has been triggered are provided, such as automatically on a specified bar 
division, at a scene change, at the next chord played, and more. Note that any combination of these can be used together 
so that multiple ways of ending the fill can be specified – and whichever one happens to occur first ends the fill.

Typically, only one module (usually Module 6) is used as a fill in a performance, but it is possible to use more than one, 
such as a drum fill and a melodic fill that play together. For example, you could have a drum fill and a matching syncopated 
horn riff that play together when the Fill button is activated.

In many of the included performances, drum fills are used – however, single melodic fills are also used to good effect. For 
example, in an orchestral performance, the Fill button might trigger a harp glissando that you can use to lead into another 
scene.

The Fill Feature works by keeping the fill module running at the same time as all other modules when the performance is 
triggered, but the module’s “Run” button is off – therefore, it is running in sync with the rest of the modules, but muted 
(in all scenes). Triggering the fill turns the Run button on, so that you can now hear the output of the fill module – and the 
Run button is turned off at the appropriate time by whichever of the selected stop methods occurs first.

Since the Fill Module uses a GE the same as any other module, it has its own RT Control Layer, and the fill can be 
configured completely differently in each of the scenes.

For nearly all drum fills, a Drum Type GE created with the RTC Model “DF1 – Drum Fill 1” is used. New in KARMA 3.0, 
this RTC Model was specially designed for drum fills, and has a number of differences from normal Drum GEs. Notably, the 
third drum pattern is used to specify a note or group of notes that will be optionally played on the downbeat when the fill 
is ended – such as a cymbal crash, hit, percussion effect etc. See the reference documentation on RTC Models for more 
information.

Page 171



Column For Each Module
A column exists for each of the modules in a KARMA Performance, which may be grayed out depending on how many 
modules are active in the current performance. The Module Name displayed at the top of the column can be assigned on the 
GE Setup/Mix Page. Each column is divided into seven sections, which can be roughly grouped into three areas:

Stop Parameters
Specify multiple methods by which the fill, once triggered, may be stopped/ended, such as automatically on a specified 
bar division, at a scene change, at the next chord played etc. Multiple methods may be selected, and whichever one 
happens to occur first will stop the fill.

Retrigger Parameters
Allow the end of a fill to retrigger selected modules from the beginning of their patterns. Typically, this is used to 
retrigger all modules except the fill module(s). It can also be used to restart modules that have been stopped by a fill in 
conjunction with the “Cutoff Other Modules” setting on the Trigger Page.

Play Final Event
For melodic fills only, allows a final note/event to be played on the ending downbeat of the fill. (For drum fills, the option 
to play a final note and which note it is can be controlled by the RT Control Layer settings for the fill module.)

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

  

Setup Module For Fill…<StpEd/Setup>

<Stop>
Fill/Stop – Stop Parameters
 
 

These settings specify multiple methods by which the fill, once triggered, may be stopped/ended, such as automatically on 
a specified bar division, at a scene change, at the next chord played etc. Multiple methods may be selected, and whichever 
one happens to occur first will stop the fill. For drum fills, a cymbal crash or other specified sound/hit can occur when 
the fill is ended on a downbeat (which can be individually configured in each scene through the RTC settings in the RT 
Control Layer. For melodic fills, an additional parameter is provided (explained below) that allows a final note or notes to 
be played on the downbeat. 

    At least one stop method must be selected, or a fill will continue looping forever once triggered (or at least until 
KARMA is stopped or turned off.)
<1954>
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   [Module Name] (label)

Displays a descriptive name for each Module, which can be assigned on the GE Setup/Mix Page.
<MixEd/ParmsGE><1959>
    [Stop By Scene Change] (checkbox) [Off, On]

When on, the execution of a scene change will stop a running fill. When off, the fill will continue playing through the scene 
change, but will change to the new scene’s settings for the fill module. This is typically set to on in most included 
Performances, since it’s very useful to use a fill to lead into a scene change and then have the execution of the scene 
change end the fill (with an optional cymbal crash or other sound.)
<1948>
    [Stop By Module Trigger] (checkbox) [Off, On]

When on, a running fill will be ended by the triggering of the specified Modules, such as from the keyboard input area or by 
playing a chord trigger. When off, you can play new chords on the keyboard or chord triggers without ending the fill. 
<1949>
    [Module To Stop By] (buttons) [Off, On]

Specifies which modules will end the fill by being triggered. Typically, this is set to all modules except the fill module(s), 
so that any triggered module will stop the fill, but other more complex setups can be accomplished - such as only a 
particular module stopping the fill.
<1958>
    [Stop By Dyn MIDI] ( l abe l )

Three checkboxes that control whether a running fill will be stopped by several other Dynamic MIDI functions mapped to 
various controllers: the Retrigger button, and the Stutter buttons.
<1963>
    [RT] [Stop By Dyn MIDI – Retrigger] (checkbox) [Off, On]

When on, a running fill will be stopped by the use of the Retrigger button (which is the Dynamic MIDI “Trigger Notes & 
Envs - Sync” feature, mapped to a controller).
<1964>

    [SF] [Stop By Dyn MIDI - Stutter First] (checkbox) [Off, On]

When on, a running fill will be stopped by the first note of the Dynamic MIDI “Stutter” feature (Stutter buttons). Cannot 
be used at the same time as the SL checkbox - they are mutually exclusive.
<1965>
    [SL] [Stop By Dyn MIDI - Stutter Last] (checkbox) [Off, On]

When on, a running fill will be stopped by the last note (end) of the Dynamic MIDI “Stutter” feature, when the stuttering 
ends on the final downbeat. Allows the fill to run during stuttering but end at the same time.
<1950>
    [Stop By Time Signature] (checkbox) [Off, On]

When on, the fill will play the specified amount of time and end. In other words, a 2/4 setting will always play a fill two 
beats in length no matter when it is triggered, even in the middle of the beat. Since this is entirely dependent on 
accurately pressing the fill while knowing how long it is going to be, it is likely not as useful as the “Stop By Bar 
Division” setting explained below.
<1951>
    [Length Of Time] (label)

When “Stop By Time Signature” is in use, the specified number of beats to be performed when the fill is triggered, after 
which the fill is stopped. The time signature is set using:
<1956>

    [Time Signature Numerator] (popup menu) [1...32]

When “Stop By Time Signature” is in use,  sets the top part of the Time Signature. The required number of beats is then 
performed when the fill is triggered, after which the fill is stopped.
<1957>

    [Time Signature Denominator] (popup menu) [16, 8, 4, 2]

When “Stop By Time Signature” is in use,  sets the bottom part of the Time Signature. The required number of beats is 
then performed when the fill is triggered, after which the fill is stopped.
<1952>
    [Stop By Bar Division] (checkbox) [Off, On]

When on, a running fill will automatically end at the specified bar division, allowing the fill to stop on a normal musical 
downbeat without further action. Since you can trigger the fill at any time within the window, and it will stop at the 
specified bar division, this is one of the most useful options.
<1953>
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    [Number Of Bars] (popup menu) [1...8 bars]

When “Stop By Bar Division” is in use, specifies the bar division at which the fill will stop automatically - a typical 
setting is 1 or 2 bars.
<1947>
    [Beats/Bars As Intro] (popup menu) [1...3 beats; 1...4 bars]

When “Stop By Bar Division” is in use, specifies a different length for the fill when using it to start a Performance that is 
not already running - for example, you can set a shorter two beat pickup.
<1946>
    [Intro Uses End Of Fill] (checkbox) [Off, On]

When on, an intro fill will start the specified beats/bars from the end of the fill, rather than the beginning. This allows 
you to specify a short intro fill and play the end part of the fill - not a portion of the beginning.

    With a GE having a “Drum Fill - DF1” RTC Model (almost always the case for Drum Fill GEs), this feature works best 
when the GE has been constructed with both Phases’s Rhythm Patterns having the same values in all steps in both phases: 
i.e. all steps set to a 16th note, or an 8th note, or an 8th triplet note, etc.

<Retrigger>
Fill/Stop – Retrigger Parameters
 

These settings allow the end of a fill to retrigger selected modules from the beginning of their patterns. Used with “Cutoff 
Other Modules” on the Trigger Page, you can stop modules with the fill and then restart them when it ends. For example, 
you can have a drum fill stop the normal drum groove GE, and then restart it when it is finished.
<1961>
    [Retrigger At End] (checkbox) [Off, On]

When on, the ending of a fill by any method will retrigger the specified modules from the beginning. When off, the modules 
will continue undisturbed by the end of the fill. 
<1962>

    [Module To Retrigger] (buttons) [Off, On]

Specifies which modules will be retriggered from the beginning of their patterns by the ending of the fill. Used to restart 
modules that have been stopped by the fill, or to resynchronize modules when it ends. A typical setting is to retrigger all 
modules except the fill module, but other uses are possible.

<Final>
Fill/Stop – Play Final Event
  

<1960>
    [Play Final Event] (checkbox) [Off, On]

This checkbox is only available for musical fills (not drum fills), depending on the GE Type. It specifies whether the fill 
will play a final note or notes at the point it is stopped, such as on a downbeat. Drum fills have this feature in the RTC 
Model, and it can be set independently in each scene if desired, in the fill module’s RT Control Layer.

<Setup><1955>
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Fill/Stop – Set Up Module For Fill Dialog
 

 

The “Set Up Module For Fill” dialog allows you to quickly set up a chosen module with the typical default options for 
configuring a fill module. It can be accessed from the Menu Button on the Fill/Stop Page. 
<1945>
    [Module] (popup menu) [1...6, depending on number of enabled modules]

Specifies which of the modules you want to set up as a fill module.
<1944>
    [Set Up Dynamic MIDI Routing] (checkbox) [Off, On]

When on, executing the dialog attempts to set up one of the rows in the Dynamic MIDI Page to trigger the fill, with the 
default settings. Normally, this is the Fill button, with an associated CC number. If a row is not available, or is already 
assigned, a warning dialog will be displayed.
<1942><1943>

    [OK/Cancel] (button)

The Cancel Button (red X) closes the dialog without performing the setup operation. The OK Button (green checkmark) 
closes the dialog and performs the setup operation.
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Velocity Response
Sections in this chapter:

Overview<KbrEd/Over>

About the Chord Trigger Velocity Curve<KbrEd/AboutCT>

Parameters<KbrEd/Parms>

Copy Vel. Response From Performance Dialog<KbrEd/Copy>

 

<Over>
Velocity Response – Overview
The Velocity Response Page allows you to control how various features of KARMA respond to velocity-sensitive playing 
from the keyboard or controller that is being used to provide input notes, or to trigger the Chord Triggers. As shown 
above, the Parameter Area is divided into five separate sections, or “Velocity Curve Parameter Groups.” Throughout 
this manual, the term “Velocity Curve” refers to one of those five separate parameter groupings, and all of the 
parameters in that group.

The five separate Velocity Curves allow different features of KARMA to be individually processed with different settings. 
They are virtually identical, with a few minor differences explained later in this chapter. When the “Curve On” checkbox 
at the upper left of each section is off, the entire parameter group is disabled and the settings have no effect.

The Velocity Curves make it easy to adjust the response characteristics of various aspects of the KARMA Performance. 
For example, when you play left hand chords on a velocity sensitive keyboard, these chords will trigger the KARMA 
Modules. In general, you probably don’t want softer chords to lower the volume of the backing tracks that KARMA 
generates, so in most of the Factory Performances, you will find that the “KARMA Input” Velocity Curve is set to a 
straight line, thereby making all chords played generate a consistent volume. However, if you did want to control the 
level of the music by how hard you play the chords, you could change the settings on the “KARMA Input” Velocity Curve 
to allow this. As another example, the right hand lead sound in most Factory Performances (Keyboard Layer 2) is run 
through the “Keyboard 2” Velocity Curve with settings that decrease the overall sensitivity but still allow a certain 
degree of control - this is easier and more convenient than having to edit the velocity response settings in the Motif/MOX 
Voice itself. Also, you can use the same Voice in different Performances, and have different Velocity Curve settings 
without having to create Mixing Voices or additional modified User Voices in the Motif/MOX itself.

Velocity Curve Parameter Groups
Five different sections provide individual control over the following five types of input:

Chord Triggers
The notes coming from the Chord Triggers when they are in a velocity-sensitive mode. See About The Chord Triggers 
Velocity Curve below for more information. <KbrEd/AboutCT>

Keyboard 1
The notes played on the Keyboard Layer 1 part of the Performance, which is generally the left hand pad sound in most 
Factory Performances.
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Keyboard 2
The notes played on the Keyboard Layer 2 part of the Performance, which is generally the right hand lead sound in most 
Factory Performances.

KARMA Input
The notes that are passed as input to trigger the KARMA Modules, which are generally the notes coming from the left hand 
area of the keyboard, or the Chord Triggers that are assigned to trigger KARMA (usually Chord Triggers 1-8 in most 
Factory Performances).

KARMA Timbre/Zone Thru
The notes that are passed through to a KARMA Module by the use of the “Timbre Thru”, “Thru In Zone” and “Thru 
Outside Of Zone” parameters in the Key Zones Page. <KeyEd/Thru>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy Vel. Response From Performance… <KbrEd/Copy>
Allows you to copy the settings of one or more Velocity Curves from another Performance to the current Performance.

Reset All
Resets (initializes) all five Velocity Curve Parameter Groups to default starting values.

<AboutCT>
Velocity Response – About the Chord Triggers Velocity Curve
It’s important to note that the Chord Triggers Response Curve affects the velocities that issue from the Chord Triggers 
only when they are in a velocity-sensitive mode. So this will only be in effect when using an external pad controller that 
has velocity-sensitive pads and when the Chord Trigger Velocity Mode setting allows velocity-sensitive control. 
<CtgEd/VelMode>

Furthermore, the notes from the Chord Trigger in many cases play the Keyboard 1 (LH) sound, as well as being fed into 
the KARMA input zones. In these cases, the Velocity Curves for those features can be selectively applied to the notes 
coming from the Chord Trigger (and usually are) by checking the “Use On Chd Trig” checkbox inside those Velocity Curve 
Parameter Areas. This applies to the Chord Trigger notes whether the Chord Triggers are in a velocity sensitive mode or 
not. In the case of using the Chord Triggers in a velocity sensitive mode where the Chord Trigger Curve applies to them, 
they can therefore be “double-processed” by two curves; it’s up to the user whether this is useful or not.

The main situation where the Chord Trigger Curve is used by itself is when a Chord Trigger is set to some other channel 
that does not feed into KARMA or the keyboard sounds, but plays other sounds. An example would be having some of the 
pads on Channel 9, playing percussion sounds. In this case, if those Chord Triggers are set to be velocity-sensitive, the 
Chord Trigger Curve applies directly to the way those notes are played.

<Parms>
Velocity Response – Parameters
 

The parameters of each Velocity Curve allow you to tailor the response of the applicable KARMA feature to the velocities 
of the incoming notes, which then affects the overall sound that is output by KARMA. For example, by raising the “Low 
Velocity” setting closer to the “High Velocity” setting, and bowing the curve upwards with a positive “Factor,” you 
compress the velocity response into a louder and less-sensitive configuration.

Each of the five Velocity Curve Parameter Groups have the same settings, with the following exceptions:

- The Chord Triggers Velocity Curve does not have a “Use On Chord Triggers” checkbox.
- The KARMA Input Velocity Curve is the only group having the “Apply To Module” buttons.
<2031>
    [Curve On] (checkbox) [Off, On]

Turns on or off the functioning of the Velocity Curve. When off, the entire parameter group is disabled and the settings 
have no effect.
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<2039>
    [Notes Activity LED] (LED)

Flashes when notes run through the Velocity Curve – useful for determining which notes are actually being affected by 
which curves.
<2032>
    [Use On Chord Triggers] (checkbox) [Off, On]

Specifies whether the Velocity Curve will be used to process notes that come to it from the Chord Triggers (Pads). Note 
that the Chord Triggers have their own curve as well. This checkbox is not available in the Chord Triggers Velocity Curve.
<2033>

    [High Velocity] (numerical) [1...127]

Sets the highest velocity that will be produced at the output of the Velocity Curve, with an input of 127. By setting this 
lower, you decrease the overall output of the curve on the hardest-played notes.
<2034>

    [Low Velocity] (numerical) [1...127]

Sets the lowest velocity that will be produced at the output of the Velocity Curve, with an input of 1. By setting this 
higher, you 
<2035>

    [Curve Name] (label)

Shows the name of the Velocity Curve (which section/feature of KARMA will be responding to it.) For the Keyboard 1 and 
Keyboard 2 Velocity Curves, the name assigned to the Keyboard Layer is displayed.
<2036>
    [Curve Table] (graphic display)

Displays the shape of the Velocity Curve according to the current settings.
<2037>
    [Curve Shape] (popup menu) [Exponential, Logarithmic]

Specifies one of several shapes for the Velocity Curve - the degree of slope to the curve is controlled by the “Curve 
Factor” setting.
<2038>

    [Curve Factor] (numerical) [-99...+99]

Specifies the degree of slope to the Velocity Curve. Negative values not only invert but also rotate the curve.
<2040>
    [Apply To Module] (buttons) [1...6]

Specifies whether the Velocity Curve is applied to each Module’s incoming MIDI velocities. You can affect all Modules, or 
just selected ones.
<Copy><2416>
Velocity Response – Copy Vel. Response From Performance Dialog
 

The Copy Vel. Response From Performance DIalog allows you to copy the settings of one or more Velocity Curves from 
another Performance to the current Performance.
<2417>
    [Bank] (popup menu) [Performance Banks in current KDF]

Selects the Performance Bank containing the source Performance.
<2418>
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    [Performance] (popup menu) [1...128]

Selects the source Performance.
<2419>

    [Chord Triggers] (checkbox) [Off, On]

When on, the Chord Triggers Velocity Curve settings will be copied from the source Performance.
<2420>
    [Keyboard 1] (checkbox) [Off, On]

When on, the Keyboard 1 Velocity Curve settings will be copied from the source Performance.
<2421>
    [Keyboard 2] (checkbox) [Off, On]

When on, the Keyboard 2 Velocity Curve settings will be copied from the source Performance.
<2422>
    [KARMA Input] (checkbox) [Off, On]

When on, the KARMA Input Velocity Curve settings will be copied from the source Performance.
<2423>

    [KARMA Tmb/Zone Thru] (checkbox) [Off, On]

When on, the KARMA Tmb/Zone Thru Velocity Curve settings will be copied from the source Performance.
<2424>

    [Execute] (button)

Performs the copy or swap operation without closing the dialog, in case you want to perform other operations.
<2425><2426>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any operations. The OK Button (green checkmark) closes 
the dialog and performs the copy or swap operation.
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Other (Yamaha)                                  
Sections in this chapter:

Overview<KexEd/Over>

Parameters<KexEd/Parms>

 

<Over>
Other (Yamaha) - Overview
The Other Page is where specific settings related to the type of keyboard that your version of the KARMA software is 
controlling can be found. In the case of KARMA Motif, the page is titled “Yamaha” and contains some special parameters 
related to controlling and interacting with your Motif/MOX.

Parameter Area
Parameters related to controlling the Yamaha Motif/MOX are located here, along with a few miscellaneous parameters 
related to the overall Performance.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy From Performance... <PEUtils/Mco>

<Parms>
Other (Yamaha) - Parameters
 

<0568>
    [Programmer] (label)

Displays the name of the programmer and/or copyright information stored with the Performance. To edit this, click on the 
label. A dialog will open allowing you to edit the information.
<0571>
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   [Category] (popup menu) [0...17]

Selects one of 18 different sound categories for the current Performance. The way this is used in KARMA Motif is to 
categorize the Performance according to the RH lead sound when the Performance is first loaded. Some Performances 
have two different lead sounds, so the Category represents the lead sound in the startup scene.
<0581>
    [Mode] (popup menu) [0...4]

Specifies which mode of the Motif/MOX contains the location matching this KARMA Performance. Each Performance can 
call up a different mode on the Motif/MOX (although the Factory Performances all use the Song Mode). When the 
Performance is loaded, a SysEx Mode Change message is sent to the Motif/MOX.

    When changing to the Voice Mode, you may see this Voice Mode Warning Dialog.
<PEUtils/VoiceWarn><0580>
    [Bank] (popup menu) [Voice Mode: 1...16, Performance Mode: 1...4]

Specifies which one of the Motif/MOX’s Banks contains the location matching this KARMA Performance. Only available for 
Performance or Voice mode. Some banks may be disabled depending on which Yamaha model you have. When the KARMA 
Performance is loaded, a bank change message is sent to the device to select the corresponding bank.
<0579>
    [Number] (numerical) [Varies in Voice Mode, depending on Bank, 1...64 in Song or Pattern Mode]

Specifies which of the Motif/MOX’s Songs, Patterns, Voices, Performances or Masters goes with this KARMA 
Performance. When the KARMA Performance is loaded, a message is sent to load the corresponding mode and location. The 
available range of the parameter varies depending on which Mode and Bank you have selected.

    While it is possible to set these to any Mode, Bank and Number within a bank of KARMA Performances, in practice it is 
best to keep the relationship between the KARMA Performance and the Motif/MOX Song (for example) in a sequential, 
fixed order. This is especially important if you want to use the feature to remotely select KARMA Performances in the 
software from the front panel of the Motif/MOX (which presently only works in Song Mode). In this case, if you load Song 
5, it will select Performance location 5 in the current bank of Performances. For more information, see Select 
Performances Remotely. <MsuGen/SelectPerf>

    You can change these settings for a number of Performances at the same time using the Renumber Yamaha IDs utility 
function available from a Performance Bank Display’s Menu Button. 
<PEUtils/Renumber><0575>

    [Performance Notes] (text field)

Specifies the path/name of the Performance Notes file associated with this Performance. Clicking the button to the right 
opens it (or brings it to the front).
<0577>

    [Open Performance Notes] (button)

Opens or brings to the front the specified Performance Notes file, allowing you to test the path name.
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<0179>

GE (Generated Effect) Editor
Sections in this chapter:

Overview<GE/Over>

GE Management<GE/GenEffect>

Global Parameters<GE/Parms>

 

<Over>
GE Editor - Overview
A Generated Effect (GE) is a single collection of parameters specifying a complete algorithmic MIDI Effect to be generated. 
The Generated Effect Editor (also referred to as the “GE Editor”) gives you access to the hundreds of parameters 
comprising a GE, allowing you to edit existing GEs or create new ones. You can only view and edit one GE at a time - the 
“Current Edit GE” which is loaded into the Current Edit Module - although you can switch between Modules and view and 
edit other GEs while keeping all edits in the Performance’s edit buffers. The Current Edit Module is selected using the 
buttons in the Edit column in the Main Window’s Status Area, or the Current Edit Module command in the applications’s 
Edit Menu. The Current Edit Module can also be changed from the Performance Editor > RT Parms Page.

GE Management
Allows you to load GEs from banks of stored GEs, and to store changes or new GEs you have created.

Global Parameters
Parameters that affect the entire GE such as the basic type of the GE, options related to GE Type “Generated-Gated,” and 
the GE’s Template Bank, among others.
<0171><0172>

Phase Activity Display
Shows the current Phase and Step of the Phase Pattern while the GE is playing. The Phase Pattern is selected and 
controlled through the Phase Page.
<PhsEd><0162>

Page Selection Buttons
Allow different groupings of parameters (pages) to be displayed in the Page Display Area (center window of the screen). 
Each of the GE Editor Pages has a separate chapter in this manual describing their parameters and features.
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<GESect>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this editor:

 

Click on the links below for detailed information on the utilities not fully explained here:

Initialize Current GE...<GEUtils/Init>

Find GE By Name...<OthDlg/FBN>

Performance Info<Pfi>

Load GE Options…<Prefs/GELoad>
Opens the Preferences Dialog to the General tab, where the Load GE Options settings can be found.

Clear Unused GEs…
Clears all GEs from a KDF file that are not being used in at least one Performance. You will be given an opportunity to 
cancel. This is mainly for developer use.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><GenEffect>
GE Editor - GE Management
 

The parameters in this section allow you to load GEs from banks of stored GEs, and to store changes or new GEs you have 
created.
<0164>
    [Bank] (popup menu) [number of GE Banks in current KDF File]

Selects one of the GE Banks within the current KDF File. The GE is then loaded into that Module, replacing the previous 
settings, and the parameters in the various editing windows change to reflect the new values. Using this menu is the same 
as using the GE Bank menu in the Performance Editor > GE Setup/Mix Page, for the Current Edit Module.
<0165>
    [GE] (popup menu) [0...127]

Selects one of many GEs from within the current GE Bank for that Module. The GE is then loaded into that Module, replacing 
the previous settings, and the parameters in the various editing windows change to reflect the new values. Using this 
menu is the same as using the GE menu in the Performance Editor > GE Setup/Mix Page, for the Current Edit Module.
<0178>
    [Open GE Bank Display] (button)

Opens a GE Bank Display for the current bank of GEs.
<GBD><0166>
    [Save] ( b u t t o n )

Brings up a Save Dialog allowing you to name the GE and save it in a memory location.
<OthDlg/Mbs><0167>

    [Clear] ( b u t t o n )

Brings up a dialog allowing you to clear the selected GE. You will be given an opportunity to cancel. After clearing, the GE 
will disappear from the GE popup menus in other places in the application.

    Storing or clearing only affects the GEs in RAM. To save these changes to disk, you must save the KDF File by choosing 
“Save,” “Save As…” or “Save All…” from the File menu.

    Since the changes are not written to disk until one of the Save commands is executed, to undo a change after you have 
stored or cleared a GE you can close and reopen the current KDF file.
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�    About Locked Banks: The Factory Performances come with a number of banks of GEs that have been locked, using the 
Bank Lock Icon in the GE Bank Display. When you attempt to Save or Clear a GE in one of these banks, you will receive a 
warning and be given an opportunity to Cancel. Except in very special circumstances, you should not be replacing, editing, 
or deleting these GEs as it may affect other Performances using the same GE, or future Performances that Karma-Lab or 
others may release. In this case, it’s best to save the edited GE in a User Bank as a new GE. 

<GBD/Lock><Parms>
GE Editor - GE Global Parameters
 

This parameters in this section affect the entire GE.
<1535>

    [Module Name] (label)

Displays the name of the Current Edit Module, which contains the GE being displayed and edited. The name can be assigned 
on the GE Setup/Mix Page.
<MixEd/ParmsGE><0173>
    [GE Type] (popup menu) [0...3]

Selects one of several different overall algorithm configurations for the current Generated Effect. This setting determines 
some basic modes of operation, and which parameters are available within the various GE Pages.

0: Generated - Riff
Produces riffs, arpeggios, and chord clusters based on the notes given as input source material. The notes are expanded, 
transposed, replicated, and otherwise altered to form a Note Series by the parameters in the Note Series Page. Effects 
are generated based on the Rhythm Pattern as it relates to the clock source or tempo envelope.

1: Generated - Gated
A Note Series is created as in 0: Generated – Riff above, but only a portion of the Note Series is retriggered according to 
the parameters. Effects are generated based on the Rhythm Pattern as it relates to the clock source or tempo envelope. 
The notes themselves can be generated repetitively in several different ways, or as a sustained set of notes which is then 
“sliced and diced” by a selected controller value. This can be used to simulate several types of popular techno effects, 
such as gating a synth pad with a hi-hat track and an external audio gate/compressor. This GE Type can also be used to 
simulate the Korg Triton Arpeggiator, along with “Gate Type = Vel CP,” explained below.

2: Generated - Drum
Uses special patterns of predetermined pitches rather than the Note Series to generate notes. These can be used not only 
to create Drum Patterns, but also to create controlled musical patterns. Effects are generated based on the Rhythm 
Pattern as it relates to the clock source or tempo envelope. Riffs based on the notes in the Note Series can be applied as 
pitch bend, to create wave-sequence and other unique effects, and to control other things such as the length of Phases.

3: Real-Time
Different from the previous types in that the actual notes given as input source material are used as a starting point, 
from which effects are generated over time according to time calculations. Examples include glissandos and arpeggios 
which start with the note(s) given as input (Melodic Repeat), and Auto-Bending an input note a certain amount or to 
another note.
<0174>
    [Gate Type] (popup menu) [0...5]

Selects one of several different Gate Type settings. Two “Vel” options retrigger the notes repeatedly, while the “CC” 
options allow sustained notes to be chopped or stepped with CC Values.

    Available only when GE Type = “Generated - Gated.”

0: Vel - retrigger ALL input notes with Velocity
The actual notes given as input source material (all of them) are generated repetitively as note-ons and note-offs 
according to the parameters. In other words, if you play eight notes, all eight notes will be repeatedly generated at once. 
This produces a “gated” effect where each cluster of notes possesses the attack portion of the program being used, as if 
someone was repeatedly striking a keyboard very quickly. A Velocity Pattern can be used to impart different velocities to 
the clusters of notes. The Cluster Pattern Grid is disabled and has no effect on how many notes are generated.

1: Vel CP - retrigger Cluster Pattern notes with Velocity
The Cluster Pattern Grid is used to indicate which notes are to be generated from a portion of the Note Series 
corresponding to the number of input notes played. In other words, the ten rows of the Value portion of the Cluster 
Pattern grid allow you to specify which of up to ten notes you may have played are to be generated. If a step of the 
Cluster Pattern has rows 0, 2 and 4 selected, then the first, third, and fifth notes in the Note Series will be generated at 
that step. What these notes actually are will be influenced by the Note Series and Input Sort settings. This can be used to 
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simulate the operation of the Korg Triton Arpeggiator, for example. Note that filling all ten rows of each column is 
essentially the same as using 0: Vel above.

2...5: CC - 4 different CC Gate Types
When one of the four “CC Gate Types” is chosen, an additional popup to the right becomes available where you select a 
MIDI Control Change Message (CC). The actual notes given as input source material are then generated as note-ons only 
once at the beginning of the effect; the rest of the note-ons are turned into the specified CC controller value with the same 
value as the velocity of the note-on; the note-offs are turned into CC values of 0. Essentially, this means that a pad will 
be sustained, having the attack portion triggered only once. For example, if the selected CC was 11 (Expression) or 07 
(Volume), the pad will be repeatedly turned on and off, simulating the popular techno effect of gating a synth pad with a 
hi-hat track and an external audio gate/compressor. However, the Velocity Pattern can be used to control the value of 
each CC that is generated for a note-on, and the Duration Pattern can be used to control the duration of each “slice.”

Other CCs can produce other interested stepped and wave-sequence like effects, depending on how your tone module 
responds to different CCs. For example, using a CC to control Filter Cutoff Frequency can produce interesting “Sample & 
Hold” effects.

2: CC [T] - sustain notes; retrigger only if Phase Transpose is different
When this first CC option is chosen, the “pad” will only be triggered manually (i.e. when you strike the keyboard), or only 
if there is a Phase Change and the Phase Transpose is different, requiring that the generated notes be transposed. 
Therefore, if the Phase Transposes are the same, the “pad” will never retrigger unless you trigger it manually.

3: CC [1] - sustain notes; retrigger when entering Phase 1
Same as CC [T] above, with the exception that the “pad” will be retriggered when striking the keyboard, and every time 
that the Phase Pattern enters a step containing Phase 1. You can use this to have the notes retriggered occasionally while 
moving through the Phase Pattern.

4: CC [2] - sustain notes; retrigger when entering Phase 2
Same as CC [T] above, with the exception that the “pad” will be retriggered when striking the keyboard, and every time 
that the Phase Pattern enters a step containing Phase 2. You can use this to have the notes retriggered occasionally while 
moving through the Phase Pattern.

5: CC [A] - sustain notes; retrigger when entering any Phase
Same as CC [T] above, with the exception that the “pad” will be retriggered when striking the keyboard, and every time 
that the Phase Pattern causes a Phase Change. You can use this to have the notes retriggered occasionally while moving 
through the Phase Pattern.
<0175>
    [Gate CC] (popup menu) [0...127] 

Selects which CC will be transmitted instead of the note-ons and note-offs of the generated notes. For example, for 
“chopping” effects, set to 12 (CC 11).

0: Off
No MIDI CCs are generated.

1 ~ 127: MIDI CC 000 ~ 126
The specified MIDI CC is generated in place of the Module’s note-ons and note-offs. Note-offs are generated as a value of 
“0,” while note-ons are generated as a value equal to the velocity of the note-on.

    Available only when Gate Type is one of the 4 “CC options”)
<1534>

    [Open Template Bank Display] (button)

Opens a Template Bank Display for the current bank of Templates.
<TBD><0176>
    [Template Bank] (popup menu) [number of Template Banks in current KDF File]

Selects one of the Template Banks in the current KDF File to be used by the GE for any Templates required. Templates are 
predefined collections of certain pattern-related settings for the Rhythm, Duration, Index, Cluster, Velocity, CC, 
WaveSeq and Drum Pages. For more on Templates, see the Template Management sections of the chapters dedicated to 
those pages.
<1533>
    [Force Mono] (checkbox) [Off, On]

Selects whether the GE will operate polyphonically according to its other internal settings, or whether the generation of 
more than one note at a time and overlapping durations will be suppressed.

Off
Notes will be generated as expected according to the internal settings of the GE. Polyphonic clusters of notes may be 
generated according to the Cluster Pattern, repeated notes may be generated on top of other notes, and the durations of 
notes may overlap according to Duration settings.

Page 186



On
The normal behavior of certain aspects of the GE will be overridden, suppressing the generation of multiple notes at the 
same time. Any clusters being generated will be removed, essentially generating what would be the single lowest note in 
the cluster. Any notes from Melodic Repeat that happen to be generated on top of another note will be suppressed. Multiple 
repeated notes happening at the same instance will only play one of them. Durations of generated notes will not be allowed 
to overlap, but may only extend up until the next note to be generated. Any note will cut off the previous note’s duration 
if it is sustaining. The result is that only one note at a time will be generated or sustaining at any given moment.

    When polyphonic GEs are applied to monophonic programs, the results may be strange due to the overlapping notes and 
durations. By turning on “Force Mono,” any GE can be applied to a monophonic program and made to sound good. However, 
it can also sound good as an effect on polyphonic programs, because it can simplify a dense GE in an interesting sounding 
way. For example, you can turn a comping keyboard part into a single note bass line.

    Force Mono and Rhythm Page > Humanize:
When Force Mono is on, the effects of the Rhythm > Humanize setting are removed if Melodic Repeat is being used at the 
same time. A GE can be stored with a normal amount of Humanize, so that it can be used that way with the Force Mono 
parameter off, and then Force Mono can be turned on in real-time. The reason for this is that the Force Mono effect uses 
the first note arriving within a section of time (i.e. 16th notes) to window out the rest of the notes. If the underlying main 
notes are slightly late as a result of Humanize, it is possible for overlapping repeated notes to arrive slightly before 
them, and then the main notes get masked out while the repeated notes take precedence. Since Humanize is a randomly 
varied amount, this results in a completely unpredictable sequence of notes in this case, that cannot produce consistent 
results. By removing the Humanize amount when Force Mono is on with Melodic Repeat, the result is consistent and 
predictable.

With drums, when Force Mono is on, Humanize is removed even if not using repeats. This is because each note in a column 
of a drum pattern is affected individually by the Humanize parameter, and the Force Mono effect requires them to all line 
up on the same instant in order to allow only one of them to be produced.

    Force Mono and Cluster Page > Strum:
When Force Mono is on, the effects of the Strum parameter are removed, since no clusters can be generated.
<0163>
    [GE Tempo] (numerical) [40.0...240.0 BPM]

Each Generated Effect is stored with the tempo that was being used when it was last saved, so that a reference exists for 
the correct tempo to use it at. However, the overall Performance Tempo overrides the settings of all the GEs being used 
by that Performance. When you load a GE using the popup menus, the GE Tempo will be displayed here in the GE Editor, but 
will not normally affect the Performance Tempo (which is displayed in the Performance Editor) unless the “Loading GE 
Loads GE Tempo” option in the Options Menu is checked. Therefore, if you are auditioning single GEs and want to hear them 
at the tempo that they were intended to be used at, you should select this option. Then when the GE is loaded, it will 
replace the Performance Tempo with the GE Tempo.

    The GE Tempo and Performance Tempo settings are “linked,” in that if you adjust the GE Tempo while listening to a GE 
you will also be changing the Performance Tempo.

    When you save a GE, it will be saved with the current GE Tempo value, not the Performance Tempo. That means that 
when creating GEs, you should use the GE Tempo field to adjust the tempo; once you have it as you like it and save it, it 
will have the correct reference tempo. Then you can use it in other Performances and it will retain its tempo, even if you 
resave it inside a Performance with a different tempo. For example, if you load a GE that was created at 100 BPM, set 
the Performance Tempo to 150 BPM and save the GE (perhaps because you have tweaked some other parameter), the GE 
Tempo will still remain 100 BPM. If you want to save it with the new Performance’s tempo, you must manually set the GE 
Tempo to be the same as the Performance Tempo. Saving a Performance does not affect the stored GE Tempos of the 
individual GEs in any way.
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Note Series
Sections in this chapter:

Overview<RifEd/Over>

Note Series Parameters<RifEd/Parms>

RT Parm Virtual Parameters<RifEd/Virt>

Note Series Display<RifEd/NS>

Display Parameters<RifEd/NSParms>

Display Setup Dialog<RifEd/Setup>

Category/Programmer Area<RifEd/Cat>

 

<Over>
Note Series - Overview
The Note Series Page controls the creation of a “Note Series” in memory, which is the foundation of a large percentage of 
Generated Effects. The Note Series is a collection of pitches and corresponding velocities, created from initial notes 
coming from input source material (i.e. a keyboard, or sequence data which is being used as input). The various 
parameters control how these initial notes are replicated, shifted, sorted, filtered, and otherwise arranged into the Note 
Series. The Note Series is then used as the basic collection of pitches and velocities from which notes are generated, as 
controlled by most of the other parameters of the Generated Effect.

Note Series Display
Displays the current contents of the Note Series and various markers that change as the effect is generated.

Display Parameters
Parameters that change the characteristics of the Note Series Display.

Note Series Parameters
Parameters that actually create and change the Note Series.

Category/Programmer Area
Allows a category, subcategory and programmer name to be assigned to the GE. See Category/Programmer Area.
<RifEd/Cat>

Menu Button
A popup menu allowing instant access to this help chapter.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><Parms>
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Note Series - Note Series Parameters
 

This section contains the Parameters that actually create and change the Note Series.

    When GE Type = “Generated - Drum,” the effect of changing most of these parameters is only apparent if the Note 
Series is being applied as pitch bend in the Phase Page and Bend Page, or “Note Series -> Length” is being used in the 
Drum Page.

    The following three parameters will have an effect on when Phases change if the Phase Length Mode is set to 
“Actual”: Replications, Filter Steps, and Filter Dupes. See Phase Page. <PhsEd>
<0030>
    [Note Type] (popup menu) [0...9]

Selects one of several modes for supplying the initial notes from which the Note Series is created.

0: Regular
The Note Series created in memory will be produced based on the actual notes given as input source material (i.e. a 
keyboard, or sequence data which is being used as input).

1: Scalic
The Note Series created in memory will be produced based on chord analysis of the input source material; then a group of 
notes corresponding to the analyzed chord will be used instead of the actual notes. The initial octave is based on the lowest 
note received as input source material. This can be used so that one finger chords produce scalic riffs, or to supply notes 
that are not present in the source material.

2: Scalic 2
Same as Scalic (above), except an attempt is made to keep a seven-note scale for each chord type. In other words, there 
will be more passing tones, and it will sound more “modal” in nature. For a good example of the difference, play a four 
note diminished chord with each one. This can be of use for creating a bass line that is more predictable when changing 
chords, or jazzy soloing kinds of effects.

3: Chromatic
The 12 steps of a chromatic scale will be used as input source material. The first note of the Note Series is based on the 
lowest note received as input source material.

4: WholeTone
The 6 steps of a whole tone scale will be used as input source material. The first note of the Note Series is based on the 
lowest note received as input source material.

5: Diminished
The 4 steps of a diminished chord will be used as input source material. The first note of the Note Series is based on the 
lowest note received as input source material.

6: Augmented
The 3 steps of an augmented chord will be used as input source material. The first note of the Note Series is based on the 
lowest note received as input source material.

7: Fourths
3 steps of stacked fourths will be used as input source material. The first note of the Note Series is based on the lowest 
note received as input source material.
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8: Tritones
2 steps of a tritone (augmented fourth) will be used as input source material. The first note of the Note Series is based on 
the lowest note received as input source material.
 

9: Fifths
2 steps (root and fifth) will be used as input source material. The first note of the Note Series is based on the lowest note 
received as input source material.
<0031> 
    [Input Sort] (popup menu) [0...3]

How the notes (and corresponding velocities) from the input source material are arranged prior to creating the Note 
Series.

0: Up
Notes are arranged from lowest to highest.

1: Down
Notes are arranged from highest to lowest.

2: Actual
Notes are left in the order received. With a Note Type of “Regular,” the Note Series will therefore be capable of being 
created in many different orders, since the order of the input notes can vary. With any other type, the input notes are not 
actually used and a scale is substituted instead (as explained above). For these Note Types, using “Actual” will result in a 
different order than “Up” or “Down,” but it will be the same order each time for each chord type.

3: Random
Notes are randomly arranged. This guarantees the initial order will be different each time.
<0052>

    [Input Transpose] (numerical) [-48...+48]

Allows the input notes to be shifted by a specified number of semitones prior to the creation of the Note Series. The 
transposed input notes are then replicated and shifted according to the other parameters described below. This can be 
used, in conjunction with other Note Series Parameters, to shift and flip the Note Series into other configurations or 
inversions in real-time.
<0032>

    [Inversion] (numerical) [-24...+24]

Allows different inversions of the input notes (after they are sorted) prior to creation of the Note Series. For example, if 
the notes {C, E, G, B} were received in that order as a chord and Inversion was 1, then the notes would be shifted to {E, 
G, B, C 8va} before creation of the Note Series (thus playing the 1st inversion). This is especially useful for setting 
multiple modules to play different inversions of the same effect, such as natural harp glissandos or riffs in harmony. 
Normally used with Input Sort set to “Up” or “Down.” The effect of this parameter when Input Sort is “Actual” or 
“Random” is less predictable, although potentially useful for some effects.
<0033>

    [Replications] (numerical) [0.0...40.0]

Sets how many times the input notes will be replicated according to the Interval. For example, 3.0 Replications with an 
Interval of 12 will give you a 3 octave arpeggio. Decimal places create only a portion of the last replication. Note that if 
GE Type = “Generated - Gated,” this has no audible effect on the pitches of the Generated Effect; however, this still 
affects the overall range of the available notes for Direct Indexing of the Note Series (described elsewhere).

    When this parameter is assigned as an RT Parm, the value is represented as being x100 - so 3.5 here would be 
represented as 350 in the RT Parm setting, 4.75 would be represented as 475, etc. 

    For information related to using the associated Inc/Dec (up/down arrows) with a floating point numerical, see Basic 
Operations.<Basic/UI>
<0034>
    [Max] (numerical) [1...255]

Sets an overall “final index” in the Note Series, beyond which indexes will never be chosen during playback, even if other 
settings might allow it. This is a playback only parameter that does not affect the creation of the Note Series. This is one 
way to change the overall length of the Note Series in real-time.
<0035>

    [Symmetry] (button) [Off, On]

When turned on, additional notes are extrapolated at the end of the Note Series beyond the number specified by the 
Replications setting. These are accessed when clusters are generated in that area of the Note Series, or when the Index 
Page Double/Invert parameters are used. This primarily allows different cluster sizes to be used without affecting the 
length and shape of the resulting riff. This interacts with Cluster Patterns and the Index Pattern Cluster Advance Mode, 
discussed elsewhere. Note that when this is off, clusters will “wrap around” at the end of a phase, or cause Phase 
Changes or cycling. Doubled notes caused by the use of the “Double” parameter in the Index Page will also be wrapped 
around at the top of the Note Series when this is off.
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On
Extra notes may be extrapolated at the end of the range depending on the cluster size at that point. The result will be a 
widening of the apparent range of the riff.
<0036>
    [Interval] (numerical) [-24...24]

The number of semitones to offset each replication of the input notes by. For example, if set to 12 or -12, the Arpeggio 
will repeat in octaves (most normal). If set to 2, and Replications to 3, then playing a CMaj {C, E, G} will produced a 
CMaj, then DMaj {D, F#, A}, then EMaj {E, G#, B} as each replication is shifted by a whole-tone. Settings other than 
multiples of 12 are extremely useful in conjunction with “Chord Shift,” described below, so that atonal notes are shifted 
to musically correct pitches.
<0038>
    [Chord Shift] (popup menu) [0...2]

Allows notes in the Note Series that may be atonal (out of a chord’s scale) to be shifted to tonal notes, using one of 
several different tables.

0: Off
The Note Series is created with no further modification from this setting.

1: Scalic
Chord analysis is performed on the input source material, and as the Note Series is created, notes which may be “atonal” 
based on the analyzed chord (due to being shifted by non-octave values of Interval) are shifted to tonal notes. Especially 
useful when “Interval” (discussed above) is set to something other than multiples of 12. The note tables used to shift the 
notes are the same as the ones used in “Note Type: Scalic,” described above.

2: Scalic 2
Same as Scalic (above), except that the note tables used to shift the notes are the same as the ones used in “Note Type: 
Scalic 2,” described above. Scalic 2 is more modal in nature and has more passing tones than Scalic.
<0049><0050>

    [Wrap Bottom/Top] (numericals) [0...127: C-1...G9]

Sets an overall range for the pitches in the Note Series. Notes created beyond this range are lowered or raised an octave 
(depending on which end). Mainly intended to limit the Note Series to useable ranges, these settings can also be used 
creatively to force a riff to cycle around inside a certain range.
<0037>
    [Voicing] (popup menu) [0...8]

Selects one of several options for “spreading out” the input notes before creating the Note Series. This can be used to 
widen the voicing, create guitar-like voicings, or produce interesting variations.

0: Closed
The Note Series is created with no further modification from this setting.

1...8: Open 1A ~ 4B
The Note Series has certain notes shifted up by an octave as it is created, then may be re-ordered according to the setting 
of the Note Sort menu. These can be used to create different types of wider voiced chords for simulating guitar or string 
section voicings. For a complete description of the different effects, see the Appendix 

Open Voicing Reference.

<OVoice><0054>
    [Final Sort] (checkbox) [Off, On]

When on, performs an additional final sort of the Note Series, based on the pitches and the Input Sort direction. You can 
use this to once again order the notes sequentially if they have been placed out of order by the settings of other 
parameters.
<0040>
    [Filter Dupes] (popup menu) [0...2]

Allows duplicate notes in the Note Series to be removed in several different ways.

0: Off
The Note Series is created with no further modification from this setting.

1: Adjacent
As the Note Series is being created, notes that are the same as the immediately preceding note are discarded.

2: All
After the Note Series has been created, any notes that are duplicates of any others are removed.

    Not available if GE Type = “Generated - Gated.”
<0041>

Off
The notes determined by the Repetitions setting (described above) are used as the range within which to generate notes.

Page 191



    [Filter Steps] (editing grid) [0...11]

A 12 button grid corresponds to the 12 scale tones, with regards to a current key that is determined by chord analysis of 
the input source material. For example, if the key is determined to be “C,” then the grid steps 0 through 11 correspond 
to C, C#, D to B; if the key is determined to be “E,” then steps 0 through 11 correspond to E, F, F# to D#. Clicking on a 
step creates a green button indicating the step is selected. After the Note Series is created, notes belonging to the chosen 
steps are removed, thus “filtering” them out. For example, if {C, E, G, B} was the input material, “CMaj7” would be the 
analyzed chord; if step #4 “3rd” was selected on the grid, all occurrences of E would be removed from the Note Series. 
For example, this is useful for creating complex grooves where several modules are all supplied with the same source 
material, where you might not want the bass line to play the 3rd even if it is supplied from the keyboard, might want to 
remove all chance of 7ths from a comping guitar part, etc. These settings can also be modified by several “virtual” RT 
Parms. See Note Series Page - RT Parm Virtual Parameters. <RifEd/Virt>

    Selecting all steps to be filtered will result in a single note in the Note Series, determined by the settings of other 
parameters such as Input Sort, Inversion, etc.

    To “fix” the resulting filtered collection of notes with regards to a specific key, use the “Fixed” checkbox (described 
below).

    Not available if GE Type = “Generated - Gated.”
<0042>
    [Fixed] (checkbox) [Off, On]

When the “Filter Steps” grid is used above, allows the resulting tonality of the Note Series to be “fixed” in relation to 
the key of C. For example, assume that Note Type is set to “Chromatic” and Chord Shift is off, so that the Note Series is 
essentially a chromatic scale. If you play a single “C” (and Inversion is set to “0”), you will get a chromatic scale 
starting with C. If you then set up the Filter Steps grid so that you are filtering steps {1,3,6,8,10}, you would have a C 
Major diatonic scale. With Fixed set to off, if you then play a “D” on the keyboard, the whole scale will shift to become a 
D Major diatonic scale. With Fixed set to on, the scale stays fixed to the key of C, but you are starting on the D; 
essentially, you have a D minor scale. You will be playing different modal scales starting with different pitches. Note that 
this is always related to the key of C; so if you want to put the resulting filtered, fixed Note Series into another key, you 
can use the Performance GE Setup/Mix Page Transpose parameter to do so. For example, if you set the transpose to +4, 
you would still play notes in the key of C, but the resulting generated notes would be in the key of E. In the above example, 
playing a C would result in a E diatonic scale, playing a D results in an F# minor scale (F# Dorian mode) and so on.

    Not available if GE Type = “Generated - Gated.”

<Virt>
Note Series - RT Parm Virtual Parameters
The following parameters are not true parameters, but “virtual” parameters for RT Parm control. In other words, they 
do not physically exist on the Note Series Page, but perform a modifying function on one or more of the other parameters. 
They can be found in the Note Series Group when assigning parameters in the GE Editor > RT Parms Page, and have a tilde 
(~) at the beginning of the parameter name (indicating that they are virtual).

    [~Filter Template] (virtual) [0...77]

Allows the entire Filter Steps grid to be changed to one of 78 different settings. Template 0 is all steps off (no steps 
filtered), while Template 77 is all steps on except the maj7 (meaning only the 11th step is allowed in the Note Series). As 
the Templates proceed from 0 to 78, more and more steps are filtered out, in different combinations. See the diagram 
below for a visual representation of all Filter Steps Templates.
 

    [~Filter Templ + Restore] (virtual) [-1...77]

Operates the same as “Filter Template” (above), with the difference that when the RT Parm is set to the minimum value 
specified by the RT Parm range parameters, the internal setting of the GE for the Filter Steps grid will be restored. In 
other words, you can have a certain Filter Steps setting already set up on the grid. Using “Filter Templ + Restore” as an 
RT Parm, you specify a range where the Min value restores the internal settings, and the rest of the range selects 
Templates, replacing the internal settings. So if the Min value was 5 and the Max value was 10, choosing 5 would restore 
the internal settings, and 6 through 10 would select the corresponding Filter Steps Template. You can use this to keep the 
internal settings of the GE, while still allowing a wide variety of Filter Templates to be substituted. In this case, the 
available range is -1~77. You can assign the full range of all 77 Templates, with -1 indicating “Restore,” or only a 
portion of the range, and still have the ability to restore the original internal settings. See the diagram below for a visual 
representation of all Filter Steps Templates.
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<NS><0043>
Note Series - Note Series Display
 

The Note Series Display shows the current state of the Note Series, along with various range markers and other 
indicators that may shift as the effect is generated. The colors of the various items may be specified as described in the 
Display Setup Dialog.<RifEd/Setup>
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Available Indexes
When the Note Series is created, the indexes that are potentially available for generation of notes are displayed in a 
specified color (orange, in the example above). Note that if “Symmetry” is turned off (described above), this will be all 
of the indexes in the Note Series.

Current Indexes
As notes are generated during playback of the effect, the indexes being chosen are shown in a specified color (yellow, in 
the example above).

Symmetry Indexes
When “Symmetry” is turned on (described above), additional indexes beyond the available indexes are added to the Note 
Series, so that clusters may utilize these additional notes as the effect is generated. They will be displayed in a specified 
color (light green, in the example above).

Octave Labels
Show the locations of each octave in the display. Whether the note names reference Middle C as C3 or C4 is controlled by 
the “Middle C Display” option in the Preferences > Workspace settings. <Prefs/MidC>

Note Area
The top 90% of the display, where each note in the Note Series is shown as a small horizontal bar (index).

Velocity Area
The bottom 10% of the display, where the velocity of each note in the Note Series is shown as a vertical line, 
representing a velocity of 1 to 127.

Start Line
A vertical line displaying the index at which the effect will start when it is triggered (in the first Phase only). This is 
controlled by the setting of the “Start %” parameter in the Phase Page. Depending on the setting of the “Start Mode” 
(also in the Phase Page), there may be an additional Start Line present, showing the start of the other Phase.
See Phase Page - General Parameters. <PhsEd/ParmsGen>

Start Line (Other Phase)
Depending on the setting of the “Start Mode” parameter in the Phase Page, there may be an additional Start Line present, 
showing the start of the other Phase.
See Phase Page - General Parameters. <PhsEd/ParmsGen>

    Even if both phases are in use in the Phase Pattern, the Start Line for the second phase will only be shown if the [ir] 
button is on for the first occurrence of the other phase – otherwise, the starting index for that phase is determined by 
where the previous phase ends up, and it’s not possible to predict what it will be.

If both phases are being used by the GE, the initial Start Lines for each phase will be displayed when it is first triggered; 
as the phases change while the GE is running, the display will update to show only the current phase’s Start Line and Start 
Direction Triangle.

Start Direction Triangle
A small triangle to either side of the Start Line that displays the general direction of movement through the Note Series 
when the effect is first triggered. This is controlled by the setting of the “Direction” parameter for the first Phase in the 
Phase Page.
See Phase Page - Phase Specific Parameters. <PhsEd/ParmsSpec>

Phase Area
The portion of the Note Series specified for use in the current Phase is displayed in a specified background color (black, in 
the example above). As the effect is generated, this will shift to display the useable area in each Phase. This is controlled 
by the settings of the “Beginning/End Offset” parameters for each Phase in the Phase Page.
See Phase Page - Phase Specific Parameters. <PhsEd/ParmsSpec>

End Loop Area
The portion of the Note Series specified for use when an End Loop is being used is displayed in a specified background color 
(blue, in the example above). As the effect is generated, this will shift to display the useable area when an End Loop is 
entered. If an End Loop is not being used, this color will not be displayed. This is controlled by the settings of the “End 
Loop” parameters in the Phase Page.
See Phase Page - End Loop Parameters. <PhsEd/ParmsELoop>

Max Area (End)
The portion of the Note Series beyond which indexes will never be chosen is displayed in a specified background color 
(dark gray, in the example above). This area starts with the first index (beginning of the Note Series) and ends with the 
index specified by the “Max” parameter (described above).
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�Wrap Top/Wrap Bottom
Horizontal lines that display in a specified color the current settings of the Wrap Bottom/Top parameters (described 
above). As the Note Series is created, notes above or below these boundaries will be shifted to remain within the specified 
range.

Horizontal/Vertical Marker Lines
Vertical and horizontal marker lines may be displayed in a specified color in the background, dividing the display into 
octaves and groups of 4 indexes. These may be turned off and on with the Markers buttons in the Display Parameters area 
(described below).

Middle C
A horizontal line displaying the location of Middle C in the Note Series.

<NSParms>
Note Series - Display Parameters
 

These parameters allow some aspects of the Note Series Display to be changed.
<0044>
    [Resolution] (popup menu) [range x1...x8]

Sets the width (in pixels) that each index in the Note Series will be displayed with. For most situations, a setting of x6 to 
x8 should be adequate; if many Replications are set up, the smaller resolutions can be used to display the longer Note 
Series.
<0045><0051><0039>

    [Markers] (buttons)

Horizontal
Allows the horizontal marker lines (grid lines) to be turned on and off.

Vertical
Allows the vertical marker lines (grid lines) to be turned on and off.
<0046>
    [Setup] (button)

Opens the Display Setup Dialog (discussed below), allowing the colors for various parts of the Note Series Display to be 
customized.

<Setup>
Note Series - Display Setup Dialog
 

<0714><0715><0716><0717><0718><0719><0720><0721><0722><0723><0724><0725><0726><0727>
The Note Series Display Setup Dialog can be opened by clicking on the “Setup” button underneath the Note Series Display. 
It allows you to customize the colors of the display if desired.

Click on the color squares to change any of the colors (see the description of Note Series Display above for a description 
of the different areas or items the colors refer to, or use the tooltips feature to check each label). Changes will be 
displayed in the Note Series Display. Click OK (green checkmark) to save your changes, or Cancel (red X) to cancel your 
changes. The “Default” button returns the colors to the default settings shown here.

<Cat>
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Note Series - Category/Programmer Area
 

The Category/Programmer Area shows the Cateogry, Subcategory, and Programmer name related to the Current Edit GE.
<0047>
    [Category] (popup menu) [0...12]

Selects one of 12 different categories for the current GE being edited. Changing this will display “** Not Defined **” in 
the Subcategory menu, indicating that a Subcategory needs to be assigned as well.

    This can be useful when searching for GEs by category type using the GE Bank Display - Filter By Category feature. 
<GBD/Fbc><0053>
    [Subcategory] (popup menu) [0...n]

Selects one of several different subcategories for the current GE being edited, the number will vary depending on the 
category.

    This can be useful when narrowing your search for GEs by subcategory type using the GE Bank Display - Filter By 
Category feature. 
<GBD/Fbc><0048>

    [Programmer] (label)

Displays the name of the programmer stored with the GE. To edit this, click on the label. A dialog will open allowing you to 
edit the name.
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Phase (Part 1)
Sections in this chapter:

Overview<PhsEd/Over>

Phase Pattern Constructor<PhsEd/PatCon>

Phase Activity Grid (General)<PhsEd/PhsGrid>

Phase Activity Grid (Drums)<PhsEd/DrmGrid>

Step Transpose Parameters<PhsEd/Step>

General Parameters<PhsEd/ParmsGen>

Phase Specific Parameters<PhsEd/ParmsSpec>

End Loop Parameters<PhsEd/ParmsELoop>

Sections in Part 2:<PhsEd2>

RT Parm Virtual Parameters<PhsEd2/Virt>

 

<Over>
Phase - Overview
A Generated Effect has two different “Phases.” Each of them is a separate collection of certain parameters including 
Rhythm, Duration, Index, Cluster, Velocity, WaveSeq and CCs/Pitch Patterns, among others. As the effect is generated, a 
Phase Pattern controls switching between the two Phases, so that completely different collections of parameters can be 
used for a period of time. The Phase Page contains parameters that control the length, direction, and various other 
attributes of each Phase, the number of times and in what order the Phases will play, various settings and actions that 
may be selectively activated while switching between the Phases, and whether or not a portion will be looped.

General Parameters
Parameters that affect the playback of the entire effect.

Phase Specific Parameters
An identical group of parameters for each Phase that affect playback within that Phase.

Phase Pattern Constructor
Allows a pattern of switching between the two Phases to be constructed.
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Phase Activity Grids (General/Drums)
Allow certain types of behavior to be initiated or controlled as each step of the Phase Pattern is executed.
<0077>

LED Tracking Arrays
Rows of gray dots along the horizontal and vertical axes of the pattern grids, with one or more green dots displaying the 
current activity and the current step of the Phase Pattern.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy Phases...<GEUtils/Pco>

    If settings of the Phase Pattern indicate a particular Phase is not being used, the Phase Specific Parameters for that 
Phase will not be available.

    For an overview of Phases, see also: KARMA Memory Architecture.<MemArch>

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><PatCon><0079>
Phase - Pattern Constructor
 

The Phase Pattern Constructor allows a pattern of switching between the two Phases of a Generated Effect to be 
constructed. The resulting Phase Pattern may have a minimum of 1 step and a maximum of 16 steps. The example above 
shows an eight step Phase Pattern: seven times through Phase 1 followed by once through Phase 2. After completing the 
eight steps, execution may loop back to step one. Note that the actual number of steps performed and whether it loops 
back at the end will be determined by other settings described in this chapter.
<0072>
    [Pattern Items] (popup menu) [1...16]

Sets the number of steps in the Phase Pattern. This will make available a certain number of columns here and below in the 
two Pattern Activity Grids.

    To “replicate” (copy) a number of steps into more steps, hold down the option key (Mac) or alt key (Win) when 
selecting a larger value from the popup menu.  For example, say you have a four step Phase Pattern all set up the way you 
want in the grid, and you want to double it to an eight step pattern without setting all the buttons manually. Hold down the 
option/alt key and select “8,” and the grid will automatically be filled in. You can also use option-click (Mac) or alt-click 
(Win) with the mouse to do the same thing.
<0073>

    [Pattern Step “n”] (numericals) [1, 2]

Sets which Phase will be used for generating data when a specific step of the Phase Pattern is entered during playback. 
For each step that is enabled, the value may be set to either Phase 1 or Phase 2. These parameters can also be controlled 
by several “virtual” RT Parms. See Phase Page - RT Parm Virtual Parameters. <PhsEd2/Virt>

    When this parameter is assigned as an RT Parm, the values are represented [0, 1] as 0: Phase 1 and 1: Phase 2.

<PhsGrid><0074>
Phase - Phase Activity Grid (General)
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The Phase Activity Grid (General) is always available, regardless of the GE Type. Depending on the number of Phase 
Pattern Items set in the Phase Constructor section above, a corresponding number of columns will be enabled here. As 
shown in the example above, eight steps have been chosen, so the first eight columns have been enabled; the last eight 
columns are disabled showing a lighter gray color. Each row in the grid performs a specific function; all of them relate to 
something that happens as each step in the Phase Pattern (column) is executed during playback of the effect. The 
intersection of each row and column can have a button turned on.

The rows are divided into ten distinct sections, each of which deals with a separate group of parameters. We will discuss 
the top nine sections here (the Step Transpose row is a special case that is discussed in a following section Phase Page - 
Step Transpose Parameters.
<PhsEd/Step>

Due to limitations of size, two and three letter abbreviations have been chosen to indicate the function of each row in the 
upper nine sections; they should be easy to remember once you learn what they indicate. The following table indicates 
what each row’s function is:

 

<1189>

<1190>

<1191>

<1192>

<1193>

<1194>

<1188>
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 <1195>

<1196>

<1197>

ˆ

*note1 - When [ir] (index restart) is on, will continue from an adjacent index only if that is possible given the settings of 
the Phase Beginning and End Offsets. When using End Loop, this only has an effect on the step during which the End Loop is 
entered. This means that if the button is on and the End Loop is entered, it will switch to one end of the Phase, depending 
on the Phase Pattern. If the button is off, the End Loop will be adjacent to the last index of the previous step. After the End 
Loop has started, the note pitch buttons have no other effect. 

*note2 - The [mr] (melodic repeat) row has no effect when the GE Type is “Generated - Drum,” since each Drum Pattern 
has its own [mr] row - see Phase Activity Grid (Drums) below.

*note3 - setting [no] (no overlap) for Melodic Repeat in the first step only causes them to be shut off when the Phase 
Pattern plays through and re-enters the first step. This has no effect on repeated notes that are still being generated 
when you first trigger the effect. To cause them to stop when the effect is triggered, use the Melodic Repeat Stop Mode 
parameter in the Melodic Repeat Page.

*note4 - The two Mute choices are mutually exclusive - only one may be used at a time. Also, see the virtual parameter 
~Mutes Template+Restore for a way to change the mute settings with an RT Parm so that different configurations can be 
selected in scenes.  <PhsEd2/MuteTemp>

    When editing the two Mutes rows, you may see the Template Edit Warning dialog if certain parameters related to these 
rows are assigned as GE RTP. <GEUtils/TempEdWarn>

<DrmGrid><0075>
Phase - Phase Activity Grid (Drums)
 

The Phase Activity Grid (Drums) is only available when the GE Type is “Generated - Drum.” It controls different effects 
that may be applied to the Drum Patterns that are being used at the time. Depending on the number of Phase Pattern Items 
selected in the Phase Constructor section above, a corresponding number of columns will be enabled here. As shown in the 
example above, eight steps have been chosen, so the first eight columns have been enabled; the last eight columns are 
disabled showing a lighter gray color. Each row in the grid performs a specific function; all of them relate to something 
that happens as each step in the Phase Pattern (column) is executed during playback of the effect. The intersection of each 
row and column can have a button turned on.
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The rows are divided into six distinct sections: there are two sections for each of the three Drum Patterns, each of which 
deals with a separate group of parameters. Due to limitations of size, two letter abbreviations have been chosen to 
indicate the function of each row in the seven sections; they should be easy to remember once you learn what they 
indicate. The following table indicates what each row’s function is (Drum Pattern 1 shown; Drum Patterns 2 and 3 are 
identical):
<1198><1199><1200><1201><1202><1203>
 

*note1 - For a more complete description of [ri] Resynchronize Index, see the Drum (Part 2) Chapter.
<DrmEd2/ri>

*note2 - The [mr] (melodic repeat) buttons in the upper Phase Activity Grid (General) have no effect, but are replaced by 
these. Also, see the virtual parameter Drum: ~Repeat On/Off Combs for a way to change the settings of the three [mr] 
rows with an RT Parm so that different configurations can be selected in scenes.  <DrmEd2/RptOnOffCombs>

    When editing the [ri] or [mr] rows, you may see the Template Edit Warning dialog if certain parameters related to 
these rows are assigned as GE RTP. <GEUtils/TempEdWarn>

<Step><0078>
Phase - Step Transpose Parameters
 

The Step Transpose row of the Phase Activity Grid (General) is a special case - you cannot edit the values in the grid 
directly. They are only a graphical representation of the Step Transpose Values that are accessed through a separate 
dialog. Clicking on the “St.Transpose” label, or the row itself in the Phase Activity Grid (General) opens the Step 
Transpose Dialog shown below.

 

Here you can set a Transpose Value for each of the 16 steps of the Phase Pattern. The “Reset” button sets all 16 value 
fields to “0.” The Cancel button (red X) closes the dialog and restores the previous values, discarding any edits you may 
have made, while the OK button (green √) closes the dialog and saves the edits into the Phase Pattern. 
<1204><1205><1206><1207>
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   [Step Transpose Value] (numerical) [-48...+48 semitones]

Allows a separate Transpose Value to be used in each step of the Phase Pattern (-48...+48 semitones) that affects all 
notes that are generated during that step. The 16 value fields in the dialog shown above correspond to the 16 available 
steps in a Phase Pattern, and may be grayed out depending on the length of the Phase Pattern.

    The Step Transpose Value is cumulative with the Phase Transpose Value discussed below. For example, if a Step 
Transpose Value is –12, and the Phase Transpose Value for the Phase in use during that step is +24, the overall transpose 
would be +12.

    While these values are not directly accessible as GE RT Parms, they may be set as part of a GE and varied by the 
following 2 GE RT Parameters:

Step Transpose On/Off 
~Step Transpose Template (discussed in the section Phase Page - RT Parm Virtual Parameters).
<PhsEd2/Step><0076>

    [Step Transpose On/Off] (checkbox) [Off, On]

The checkbox next to the label allows the effect of the Step Transpose Values in each Phase Pattern Step to be turned on 
or off for the entire Phase Pattern.

<ParmsGen>
Phase - General Parameters
 

This group of parameters affects some overall characteristics of Phase performance.
<0055>
    [Total Steps] (popup menu) [0 = ∞, 1...32]

Sets the total number of steps of the Phase Pattern that will be played before stopping. The infinity sign “∞” sets it to 
loop forever; otherwise the setting represents a number of steps of the selected Phase Pattern. For example, if the Phase 
Pattern is a simple two-step pattern of {1, 2}, and the Total Steps menu is {4}, then four Phases would be played in the 
following order before stopping: {1, 2, 1, 2}.
<0056>
    [Final Note] (button) [Off, On]

Operates in conjunction with the Total Steps menu above. When this is on and generation stops, the first note from what 
would be the next Phase is played, essentially adding a downbeat at the end. However, for more predictable results, the 
note/cluster is played with the current Phase’s Cluster, Rhythm, Duration and Velocity Pattern Values.

    Not available when the Total Steps menu is set to infinity “∞”.
<0057>
    [Start %] (numerical) [0...100%, 101 = Random]

Controls the location in the Note Series at which the effect will start when it is triggered. Closer to 0% starts nearer the 
beginning while closer to 100% starts nearer the end; beginning/end relates to highest/lowest depending on the Phase 
Direction setting. A setting of 101% indicates an index will be selected at random. This can be applied just once when first 
triggering the effect, or as various steps of the Phase Pattern are entered, in conjunction with the Start Mode described 
below. 

    Not available when GE Type = “Generated - Gated.” If “Generated - Drum,” the Note Series can be applied as pitch 
bend, discussed elsewhere.
<0058>
    [Start Mode] (popup menu) [0...3]

Controls how the Start % setting above is applied to the effect as it is being generated (whether it’s only used when first 
triggered, or at other times during the Phase Pattern.)

0: T - only when Triggered
The Start % is applied only when the effect is triggered, i.e. from the keyboard or through Dynamic MIDI. When other 
steps of the Phase Pattern are entered during subsequent playback, the Note Series will reset to either the top or bottom 
depending on the Phase Direction setting (and the status of the [ir] (index restart) buttons in the Index section of the 
Phase Activity Grid).
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1: 1 - when entering Phase 1 (if [ir] button on in grid)
Each time that playback of a Phase Pattern step containing Phase 1 begins, the Start % will be applied (but only if the [ir] 
(index restart) button is on in the Index section of the Phase Activity Grid). This can be used to start a phase somewhere 
in the middle of the Note Series from which the indexes can be chosen in either direction according to the Index Pattern.

2: 2 - when entering Phase 2 (if [ir] button on in grid)
Each time that playback of a Phase Pattern step containing Phase 2 begins, the Start % will be applied (but only if the [ir] 
(index restart) button is on in the Index section of the Phase Activity Grid). This can be used to start a phase somewhere 
in the middle of the Note Series from which the indexes can be chosen in either direction according to the Index Pattern.

3: A - when entering any Phase (if [ir] button on in grid)
Each time that playback of any Phase Pattern step begins, either Phase 1 or Phase 2, the Start % will be applied (but only 
if the [ir] (index restart) button is on in the Index section of the Phase Activity Grid). This can be used to start a phase 
somewhere in the middle of the Note Series from which the indexes can be chosen in either direction according to the 
Index Pattern.

    With options 1, 2, or 3, if the first step of the Phase Pattern has the [ir] button off, triggering the effect will not use 
the Start %. This allows you to trigger the effect starting at the bottom or top of the Note Series, but have subsequent 
Phase Pattern steps start somewhere in the middle.

    Not available when GE Type = “Generated - Gated.” If “Generated - Drum,” the Note Series can be applied as pitch 
bend, discussed elsewhere.
<1541>
    [[ir] Mode] (popup menu) [0...1]

Index Restart Mode selects one of two ways of continuing from an adjacent index at the beginning of a Phase, when there 
is a cluster generated as the last event of the previous Phase, and the [ir] button is off in the new Phase Step. When the 
[ir] button is off, it means to continue the indexing of the Note Series from an adjacent index, rather than starting at the 
beginning or end of the phase. However, when a cluster is generated as the last note(s) of the previous Phase, there are 
two ways that the indexing could continue from an adjacent index:

0: B  - if [ir] is Off, continue from bottom note of previous Cluster

1: T  - if [ir] is Off, continue from top note of previous Cluster

    Not available unless at least one Phase Pattern Step has the [ir] button turned off.
<0059>
    [End Dupes] (button) [No, Yes]

When set to no, attempts to eliminate duplicate pitches at Phase Changes; also has an effect on how the cycling back is 
performed when the end of the Note Series is reached before a time signature or number of events has been completed. 
The easiest way to hear what this does is to set an effect to play a simple forward/backward arpeggio, with the Phase 
Length Mode set to “AC - Actual.” When set to yes, the top and bottom notes will repeat when the Phase changes, which 
can be used to simulate some typical arpeggiator behavior; when set to no, they will not repeat. However, in some other 
situations the effect of this may not be immediately apparent. For example, if only using a single phase in the Phase 
Pattern, this has no effect. It only has an effect when switching phases from a forward to backward Phase Direction 
(up/down).

    Not available when GE Type = “Generated - Gated.” If “Generated - Drum,” the Note Series can be applied as pitch 
bend, discussed elsewhere.
<1540>
    [Beg Dupes] (button) [No, Yes]

When set to no, if the first note in a new phase would be a duplicate of the last note in a previous phase, the note will be 
adjusted to an adjacent index (next note in Note Series), preventing duplicates. When set to yes, a duplicate will be 
allowed to occur. However, this only has an effect when at least one Phase’s Index Pattern Type is “Random” or 
“Random Walk.” 

    Not available unless at least one Phase’s Index Pattern Type is “Random” or “Random Walk.” Not available when GE 
Type = “Generated - Gated.” If “Generated - Drum,” the Note Series can be applied as pitch bend, discussed elsewhere.
<0060>
    [Phase Length Mode] (popup menu) [0...2]

Selects one of several modes for determining when a Phase Change from the current step to the next step of the Phase 
Pattern will occur. Note that this has a certain interaction with the Cycle Mode parameter, described below.

0: AC - Actual
Causes the Phase Change to be completely dependent on the length of the Note Series and the Phase Beginning/End Offsets. 
The portion of the Note Series to be used as specified by the Phase Beginning/End Offsets (described below) is referred to 
as the “playback portion” of the Note Series. The notes are generated by moving through the note series according to the 
Index Page settings; when either end of the playback portion has been reached, a Phase Change occurs. Therefore, if more 
or less notes are played, the Phases will change sooner or later and bear no relation to any time signatures or specific 
number of events. This can be used to simulate traditional arpeggiator behavior. 

    Not available if GE Type = “Generated - Gated.”
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1: TS - Time Signature
Causes popup menus to appear in the Phase Specific Parameter area of each Phase (described below). These allow setting 
each Phase to various time signatures, which cause the Phase to playback a certain number of beats regardless of any 
other circumstances that might trigger a Phase Change. When moving through the Note Series, if either end of the 
playback portion is reached (specified by the Phase Beginning/End Offsets) before the amount of beats specified has 
occurred, then the movement either freezes, generates silence, wraps around, or cycles back and continues (depending on 
the setting of the Cycle Mode parameter, described below). Useful for groove generation and constraining effects to 
certain time signatures.

2: EV - Events
Causes a numerical field to appear in the Phase Specific Parameter area of each Phase (described below). This is used to 
set the Phase to perform a certain number of events before changing Phases (an event being a note or cluster). When 
moving through the Note Series, if either end of the playback portion is reached (specified by the Phase Beginning/End 
Offsets) before the number of events specified has occurred, then the movement either freezes, generates silence, wraps 
around, or cycles back and continues (depending on the setting of the Cycle Mode parameter, described below). Useful for 
constraining effects to a certain number of specific events, such as four strums per Phase.
<0061>
    [Phase Cycle Mode] (popup menu) [0...6]

Determines what will happen when either end of the playback portion of the Phase (specified by the Phase Beginning/End 
Offsets and/or the length of the Note Series) is reached during note generation. If the Phase Length Mode parameter is 
“TS - Time Signature” or “EV - Events,” “cycling” can be allowed to occur.

    Not available if Phase Length Mode (above) = “Actual.” Not available if GE Type = “Generated-Gated” unless Gate 
Type = “Vel CP.” If GE Type = “Generated-Drum,” the Note Series can be applied as pitch bend, discussed elsewhere.

0: S-replace with silence
If note generation would extend beyond either end of the playback portion of the Phase, those notes are skipped and 
replaced with silence. Once the specified number of events (including silent notes) or beats of a time signature are 
generated, a Phase Change occurs. This can be used to simulate the Korg Triton/M50 Arpeggiator setting “Arpeggio Type: 
As Played.”

1: F-fill with top/bottom note
If note generation would extend beyond either end of the playback portion of the Phase, those notes are limited and 
replaced with the bottom or top note of the Phase. Once the specified number of events or beats of a time signature are 
generated, a Phase Change occurs. Settings of the Index Pattern or Cluster Pattern which would cause movement beyond 
that point have no effect. This can be used to simulate the Korg Triton/M50 Arpeggiator setting “Arpeggio Type: As 
Played (Fill).”

2: R-restart at other end of Phase
If note generation would extend beyond either end of the playback portion of the Phase, those notes are replaced by notes 
within the playback portion, as if the riff restarted at the other end. (For the more technically oriented, the index is kept 
within range using modulo division.) Once the specified number of events or beats of a time signature are generated, a 
Phase Change occurs. This can be used to simulate the Korg Triton/M50 Arpeggiator setting “Arpeggio Type: Running 
Up. ”

3: W-wrap at either end of Phase
If note generation would extend beyond either end of the playback portion of the Phase, those notes are replaced by notes 
within the playback portion, as if the riff is being “wrapped around” the end point. (For the more technically oriented, the 
index is kept within range by inverting it.) Once the specified number of events or beats of a time signature are 
generated, a Phase Change occurs. This can be used to simulate the Korg Triton/M50 Arpeggiator setting “Arpeggio Type: 
Up&Down.”

4: B-cycle back from beginning of Phase
Allows “cycling” to occur at the beginning of the playback portion of the Phase. For example, if the movement specified 
by the Index Pattern causes the index to go backwards beyond the beginning of the playback portion, “cycling” will occur 
(the index will automatically be jumped back into the playback portion by a calculated amount). I

5: E-cycle back from end of Phase
Allows “cycling” to occur at the end of the playback portion of the Phase. For example, if the movement specified by the 
Index Pattern causes the index to go forwards beyond end of the playback portion, “cycling” will occur (the index will 
automatically be jumped back into the playback portion by a calculated amount).

6: BE-cycle back from beginning & end of Phase
Allows the behavior described above at both ends of the playback portion of the Phase.

<ParmsSpec>
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Phase - Phase Specific Parameters
 

For each of the two Phases, a group of Phase Specific Parameters allows control of some performance characteristics 
within each Phase. If settings of the Phase Pattern indicate a particular Phase is not being used, the Phase Specific 
Parameters for that Phase will not be available.
<0062>
    [Direction] (popup menu) [=> Forwards, <= Backwards]

Selects the basic direction for movement through the Note Series in a particular Phase. Works in conjunction with the 
parameters in the Index Page, which control how the index(es) move through the Note Series. For example, when the 
Direction is “=> Forwards,” the Index Pattern values are added to the index to move it through the Note Series from left 
to right; when Direction is “<= Backwards,” the Index Pattern values are subtracted to move the index through the Note 
Series from right to left.

    Not available when GE Type = “Generated - Gated.” If “Generated - Drum,” the Note Series can be applied as pitch 
bend, discussed elsewhere.
<0063><0064><0065>

    [Beginning/End Offset] (numericals/range bar) [0...100%]

Sets an overall beginning (b) and end (e) percentage range for note generation within the Phase. Even though settings in the 
Note Series Page may have created a very long Note Series, these can be used to select just a portion of the Note Series 
from which to generate notes over the length of a particular Phase. During playback, the Note Series Display will show the 
adjusted ranges displayed in the chosen colors. 

You can edit these by entering values in the fields, clicking and scrolling the numericals, or clicking and dragging on the 
Range Bar.

    To drag the range bar while keeping the relationship between the bottom and top value constant, Cmnd+click (Mac) or 
Ctrl+click (Win) with the mouse. This will drag the top and bottom values at the same time.

    Not available when GE Type = “Generated - Gated” unless Gate Type = “Vel CP.” If “Generated - Drum,” the Note 
Series can be applied as pitch bend, discussed elsewhere.
<0066>
    [Transpose] (numerical) [-36...+36 semitones]

Allows each Phase to be transposed individually. This applies to each time the Phase occurs in the overall Phase Pattern, 
unlike the Step Transpose Value. Has no effect on Direct Indexing effects, or when GE Type = “Generated - Drum.” This 
parameter can also be controlled by several “virtual” RTParms. See Phase Page - RT Parm Virtual Parameters.
<PhsEd2/Virt>

    The Phase Transpose value is cumulative with the Step Transpose value discussed above. For example, if a Step 
Transpose Value is –12, and the Phase Transpose Value for the Phase in use during that step is +24, the overall transpose 
would be +12. Not available when GE Type = “Generated - Drum.” 
<0067><0068><1208><1209>
    [Time Numerator] (popup menu) [0...31 = 1...32]
    [Time Signature Denominator] (popup menu) [0...3 = 16, 8, 4, 2]
    [Events] (numerical) [1...96]

The parameters in this particular area vary according to the setting of the Phase Length Mode, described in General 
Parameters above. When the Phase Length Mode is “TS - Time Signature,” popup menus are available which allow you to 
specify various time signatures for each Phase. The required number of beats is then performed in the Phase, regardless 
of any other circumstances that might trigger a Phase Change. When the Phase Length Mode is “EV - Events,” a numerical 
is available which allows you to specify a certain number of events (an event being a note or cluster of notes). The 
specified number of events is then performed in each Phase, regardless of any other circumstances that might trigger a 
Phase Change. When the Phase Length Mode is “AC - Actual,” then no parameters are available and this area is blank. The 
Phases will then change according to the movement through the Note Series. The following diagram illustrates the three 
different appearances, for Phase 1 only:
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<ParmsELoop>
Phase - End Loop Parameters
 

Determines whether a portion of the effect will loop (an “End Loop”), after a certain total number of steps of the Phase 
Pattern have been completed. Note that once the loop has started, it continues using the Phase Pattern, and current Phase 
Length Mode.
<0069>
    [End Loop On/Off] (button) [Off, On]

Enables/disables this feature, and the following two parameters.
<0070>
    [End Loop Start Step] (popup menu) [1...17]

Selects a total number of Phase Pattern steps to complete before entering the End Loop. For example, if the Phase Pattern 
was set to a two step pattern of {1, 2} and the End Loop Start Step menu to “4,” the loop would be entered after the 2nd 
time through the Phase Pattern, at the end of the 4th step in total {1, 2, 1, 2 [enter loop] 1, 2, etc.}. Not available if End 
Loop On/Off is set to off.
<0071>
    [End Loop Length] (numerical) [1...96]

Determines how many events (notes or clusters) will be moved forward/backward while looping, according to various 
other parameters such as the Index Pattern and the Phase Pattern Length Mode. Not available if End Loop On/Off is set to 
of f .

Page 207



Phase (Part 2)
Sections in this chapter:

RT Parm Virtual Parameters<PhsEd2/Virt>

Sections in Part 1:<PhsEd>

Overview<PhsEd/Over>

Phase Pattern Constructor<PhsEd/PatCon>

Phase Activity Grid (General)<PhsEd/PhsGrid>

Phase Activity Grid (Drums)<PhsEd/DrmGrid>

Step Transpose Parameters<PhsEd/Step>

General Parameters<PhsEd/ParmsGen>

Phase Specific Parameters<PhsEd/ParmsSpec>

End Loop Parameters<PhsEd/ParmsELoop>

<Virt>
Phase - RT Parm Virtual Parameters
The following parameters are not true parameters, but “virtual” parameters for RT Parm control. In other words, they 
do not physically exist on the Phase Page, but perform a modifying function on one or more of the other parameters. They 
can be found in the Phase Group when assigning parameters in the GE Editor > RT Parms Page, and have a tilde (~) at the 
beginning of the parameter name (indicating that they are virtual).

    [~Octave Transpose] (virtual) [-36...+36 semitones]

Allows the Phase’s Transpose value to be quantized to the nearest octave, so that when being changed in real-time, only 
transposition by octaves is possible. In this case, the value of the virtual parameter changes by semitones, but the actual 
transpose value will only change at certain points within the range:

-36 to -31 = -36  (-3 octaves)
-30 to -19 = -24  (-2 octaves)
-18 to  -7 = -12  (-1 octave)
 -6 to   5 =   0  (no transpose)
  6 to  17 =  12  (+1 octave)
 18 to  29 =  24  (+2 octaves)
 30 to  36 =  36  (+3 octaves)

    [~Oct/5th Transpose] (virtual) [-36...+36 semitones]

Allows the Phase’s Transpose value to be quantized to the nearest octave or fifth, so that when being changed in 
real-time, only transposition by octaves or fifths is possible. In this case, the value of the virtual parameter changes by 
semitones, but the actual transpose value will only change at certain points within the range:

-36 to -33 = -36  (-3 octaves)
-32 to -27 = -29  (-3 octaves +5th)
-26 to -21 = -24  (-2 octaves)
-20 to -15 = -17  (-2 octaves +5th)
-14 to  -9 = -12  (-1 octave)
 -8 to  -3 =  -5  (-1 octave  +5th)
 -2 to   3 =   0  (no transpose)
  4 to   9 =   0  (+5th)
 10 to  15 =  12  (+1 octave)
 16 to  21 =  17  (+1 octave  +5th)
 22 to  27 =  24  (+2 octaves)
 28 to  33 =  31  (+2 octaves +5th)
 34 to  36 =  36  (+3 octaves)

    [~Template (All Steps)] (virtual) [0...15]

Selects one of 16 templates (each having 4 steps) that can be applied to all or parts of the Phase Pattern. They specify 16 
different combinations of Phase 1 and Phase 2 within a 4 step section:

0   - 1111
1   - 2222
2   - 1212
3   - 2121
4   - 1112
5   - 1121
6   - 1211
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7   - 2111
8   - 1122
9   - 1221
10 - 2211
11 - 2112
12 - 1222
13 - 2221
14 - 2212
15 - 2122

With “Templates (All Steps),” the chosen template is applied to all steps of the Phase Pattern, regardless of how many 
there are. For example, if you selected “Template 6” (1211), then the following would happen to the Phase Pattern:

If the Phase Pattern had 1 step:     1
If the Phase Pattern had 2 steps:   12
If the Phase Pattern had 4 steps:  1211
If the Phase Pattern had 7 steps:   1211 121
If the Phase Pattern had 16 steps: 1211 1211 1211 1211

    [~Template Steps 1-4] (virtual) [0...15]

Applies the selected template only to the first 4 steps of the Phase Pattern.
If there are more steps, they will remain unchanged.

    [~Template Steps 5-8] (virtual) [0...15]

Applies the selected template only to steps 5-8 of the Phase Pattern. If there are more steps, they will remain unchanged. 
Steps 1-4 will remain unchanged.

    [~Template Steps 9-12] (virtual) [0...15]

Same as above, except for steps 9~12.

    [~Template Steps 13-16] (virtual) [0...15]

Same as above, except for steps 13~16.

Note that if the number of steps in the Phase Pattern (Pattern Items) is less than the steps for which Templates are being 
changed, these will produce no audible results.
<Step>

    [~Step Transpose Template] (virtual) [0…17]

Allows one of 18 different templates for the 16 steps of a Phase Pattern to be chosen and applied to the current Phase 
Pattern. These 18 templates correspond to various settings of the Korg Triton Arpeggiator “Octave” and “Octave 
Motion” parameters, and can be used to simulate Triton Arpeggio performances.

                                                         Octave   Octave Motion*
0:  [ 0]  0  0  0  0  0  0  0  0  0  0  0  0  0  0  0       1        U D B
1:  [ 0 12]  0 12  0 12  0 12  0 12  0 12  0 12  0 12       2        U B
2:  [12  0] 12  0 12  0 12  0 12  0 12  0 12  0 12  0       2        D
3:  [ 0 12 24]  0 12 24  0 12 24  0 12 24  0 12 24  0       3        U
4:  [24 12  0] 24 12  0 24 12  0 24 12  0 24 12  0 24       3        D
5:  [ 0 12 24 12]  0 12 24 12  0 12 24 12  0 12 24 12       3        B
6:  [ 0 12 24 36]  0 12 24 36  0 12 24 36  0 12 24 36       4        U
7:  [36 24 12  0] 36 24 12  0 36 24 12  0 36 24 12  0       4        D
8:  [ 0 12 24 36 24 12]  0 12 24 36 24 12  0 12 24 36       4        B
9:  [ 0]  0  0  0  0  0  0  0  0  0  0  0  0  0  0  0       1        U D B (x2)
10: [ 0  0 12 12]  0  0 12 12  0  0 12 12  0  0 12 12       2        U B (x2)
11: [12 12  0  0] 12 12  0  0 12 12  0  0 12 12  0  0       2        D (x2)
12: [ 0  0 12 12 24 24]  0  0 12 12 24 24  0  0 12 12       3        U (x2)
13: [24 24 12 12  0  0] 24 24 12 12  0  0 24 24 12 12       3        D (x2)
14: [ 0  0 12 12 24 24 12 12]  0  0 12 12 24 24 12 12       3        B (x2)
15: [ 0  0 12 12 24 24 36 36]  0  0 12 12 24 24 36 36       4        U (x2)
16: [36 36 24 24 12 12  0  0] 36 36 24 24 12 12  0  0       4        D (x2)
17: [ 0  0 12 12 24 24 36 36 24 24 12 12]  0  0 12 12       4        B (x2)
* U = Up, D = Down, B = Both
<MuteTemp>
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   [~Mutes Template+Restore] (virtual) [-1 = As Stored, 0...112]

Allows one of 112 different templates of settings for the Mute buttons [all] and [fn] to be applied to the 16 steps of a 
Phase Pattern, along with reverting back to the stored settings. This allows you to configure different mutings of steps of 
the phrase and control them in the scenes, thereby introducing space or changing the way the phrase plays. The diagrams 
below illustrate the steps that will have buttons turned on for two different types of mutes ([all] buttons in blue, [fn] 
first note buttons in purple). All Phase Mute Templates are 8 steps long - they will be replicated across however many 
steps of the Phase Pattern are in use.
<PhsEd/PhsGrid>

Templates 0 ~ 36:     different configurations of the [all] buttons
Templates 37 ~ 73:   different configurations of the [fn] buttons
Templates 74 ~ 112: different configurations of combinations of the two

For example, you could create your own stored settings of a particular arrangement of muted steps in the GE, and assign 
an RT Switch to change between -1 and 0. -1 restores your settings, and 0 turns all mutes off so that all steps of the 
pattern would play. As another example, you could store the GE with all Phase Mutes off, and then switch between -1 and 
36, which mutes every other Phase Pattern Step. You will find this parameter used in a number of the Factory 
Performances.

    *When this parameter is assigned to an RT Control, the minimum value of the controller as specified by the RT 
Parameter Minimum field represents the [As Stored] setting. In other words, if the control was assigned to a range of -1 
to 112, the a value of -1 would select [As Stored]. If the range was 6 to 112, then a value of 6 (the minimum setting of 
the controller) would select [As Stored], while other values would select the corresponding templates. This allows a 
smaller range of the included templates to be targeted, while still allowing the [As Stored] setting to be selected by the 
minimum position of the controller.

    When editing the Mutes rows [all] and [fn] in the Phase Pattern and this parameter is assigned in the GE, you may 
encounter the Template Edit Warning dialog, explained in the GE Dialogs chapter.
<GEUtils/TempEdWarn>
            All Note Mutes ([all] buttons)                    First Note Mutes ([fn] buttons)
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Combinations of First Note and All Mutes
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Rhythm
Sections in this chapter:

Overview<RhyEd/Over>

About Rhythm Patterns<RhyEd/About>

Global Parameters<RhyEd/Global>

Pattern Grid & Associated Parameters<RhyEd/PatGrid>

Random Weighting Parameters (Pools)<RhyEd/RandPool>

Random Weighting Parameters (Ties)<RhyEd/RandTie>

Template Management<RhyEd/Template>

RT Parm Virtual Parameters<RhyEd/Virt>

 

<Over>
Rhythm - Overview
The Rhythm Page controls the rhythmic characteristics of the Generated Effect. It can also have an influence on when 
“Auto Bend” pitch bending effects (set up on the Bend Page) are generated.

Global Parameters
Parameters that affect rhythmic/bend characteristics during playback of either Phase in a Generated Effect.

Phase Specific Parameters
An identical group of parameters for each Phase that affect the rhythmic/bend characteristics during playback of that 
Phase only. For more on Phases, see the Phase Page.
<PhsEd><0196>

Phase Selection Buttons
Selects which Phase (a separate collection of the Phase Specific Parameters) to display and edit.

Pattern Grid
Allows Rhythm Patterns to be constructed in various ways, which then control the rhythm of the notes as they are 
generated. The “no bend” row affects when Auto Bend effects are generated.

Random Weighting Parameters
Parameters that allow weighting curves to be applied to any random pools (more than one value in a column) which may 
have been created in the Pattern Grid. There is a separate section for allowing weighting curves to be applied to random 
ties within the pattern.
<0198>

LED Tracking Arrays
Rows of gray dots along the horizontal and vertical axes of the pattern grid, with one or more green dots displaying the 
currently chosen index (column) and rhythm values (rows).
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Template Management
Allows the contents of the Pattern Grid and certain associated parameters to be saved as a “Template.” It will then 
appear in the popup menu for future use when creating/editing Rhythm Patterns. Selecting a Template from the menu loads 
it into the Pattern Grid and associated parameters.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy Phases...<GEUtils/Pco>
<1702>
 

    If settings in the Phase Page indicate a particular Phase is not being used, the Phase Specific Parameters will not be 
available for that Phase. The message “Phase Not In Use” will be displayed near the Phase Selection Buttons.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><About>
Rhythm - About Rhythm Patterns
Rhythm Patterns control the timing with which notes will be generated. A value derived from a Rhythm Pattern is the size 
of the step between each generated note. Choices can be made from “Random Pools” of values as described in detail later 
on. Furthermore, values can be tied to each other; the ties can be absolute or random.

Rhythm Patterns may be multiplied by the Rhythm Multiplier, which gives them many more variations, in addition to 
providing easy ways to experiment with fractal and polyrhythmic effects. A Rhythm Pattern of {8th 16th 16th} with a 
Rhythm Multiplier of 200% will play {Quarter 8th 8th}.

A Rhythm Pattern will loop as long as note generation continues. It normally will not reset to the beginning of the Pattern 
unless a new Trigger is received, or the Phase Page has been configured to restart it at the beginning of certain Phases by 
using the [pr] (pattern restart] buttons. This means that a four step Rhythm Pattern can be looping while an eight step 
Velocity Pattern and a twelve step Cluster Pattern are also independently looping, for example.

<Global>
Rhythm - Global Parameters
 

The Global Parameters section contains parameters that relate to shifting the overall timing of the notes that are 
generated. The Humanize parameter allows subtle randomizations of timing, while the other five Swing-related 
parameters deal with adding a “swing” or ”hip-hop” feel to the rhythms.
<0180>
    [Humanize] (numerical) [0...255 ms]

Sets a range in milliseconds within which each note/cluster may be randomly shifted in time. For example, if set to 10 
ms, then each cluster or note as it is generated has a possibility of a random offset in time of between 0 ~ 10 ms. This 
affects all of the notes in the cluster at the same time. This can be used to impart a more “human,” less machine-like 
precision to generated notes. This can also be used to totally destroy the timing!
<0181>
    [Swing %] (numerical) [-200...+200%]

Sets the percentage of swing/hip-hop feeling to be applied. 0 = no swing, 50 % = triplets, while 100% pushes the swung 
notes all the way to the next value of half the note length set by the Swing Note popup. For example, if swinging straight 
16th notes, 100% would push the swung notes to 32nds. 200% would push the swung notes all the way to the next 16th. 
Negative values push the swung notes the other direction.

    Triplets may or may not be swung depending on the setting of the “Swing Triplets” parameter below.
<SwingVirt>
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   [~Swing % 0~100,101,102] (numerical) [0...100 = 0...+100%, 101 = +200%, 102 = -200%]

This special “virtual” variation of the Swing % parameter allows only the most useful settings to be applied as an RT 
Parm, for assigning to a Real-Time Control. A setting of 0...100 corresponds to 0...100% swing factor, while a value of 
101 selects +200%, and a value of 102 selects -200%. Using this ensures that the most useful settings will be available 
over the widest range of the assigned control, while allowing the useful +/-200% values to still be selected. 
<0182>
    [Swing Note] (popup menu) [0...3: 32nd, 16th, 8th, Qtr notes]

Selects the base note value to be used in calculating swing. For example, if you want to add a swing feel to a steady string 
of 16th notes, you would select a 16th note. Straight 8th notes would exhibit no change with this setting, since they do 
not swing in such a feel unless they are syncopated. On the other hand, if you swing 16th notes with an 8th note Swing 
Note selected, the 16th notes are swung in an 8th note feel. While this is not necessarily natural “swing,” interesting 
shiftings of timings can be produced. Note that the setting of this menu can be modified by the “Use Multiplier Mode” 
parameter, explained below.
<0183>
    [Use Multiplier Mode] (popup menu) [0...3]

The Rhythm Multiplier (explained later in this chapter) causes the values in the Rhythm Pattern to be increased or 
decreased by a percentage. The Use Multiplier Mode specifies several options for selectively applying (or not applying) 
the Rhythm Multiplier(s) to the Swing Note value also, thereby affecting the resulting swing feel.

0: Off - do not use Multipliers for Swing
The Rhythm Multipliers in each Phase do not have any affect on the Swing Note value. For example, if generating 16th 
notes with a Rhythm Multiplier of 100% and Swing Note set to “16th,” the resulting 16th notes will be swung with a 
16th note feel. If the Rhythm Multiplier is changed to 50%, the resulting 32nd notes will still be swung with a 16th note 
feel. If the Rhythm Multiplier is changed to 200%, the resulting 8th notes will also be swung with a 16th note feel, 
resulting in no perceptible swing (unless the rhythm is syncopated).

1: Ind - independently use each Phase’s Multiplier
Each Phase’s Rhythm Multiplier will independently affect swing calculations while generating rhythms within that Phase. 
In other words, the Swing Note value will also have the Rhythm Multiplier applied to it. For example, if generating 16th 
notes with a Rhythm Multiplier of 100% and Swing Note set to “16th,” the resulting 16th notes will be swung with a 
16th note feel. If the Rhythm Multiplier is changed to 50%, the resulting 32nd notes will be swung with a 32nd note feel. 
If the Rhythm Multiplier is changed to 200%, the resulting 8th notes will be swung with an 8th note feel. With this setting, 
it is possible to swing with different note values in the two Phases, such as swinging with an 8th note feel in one phase 
and swinging with a 16th note feel in the other.

2: P1 - always use Phase 1’s Multiplier
Same as “Ind” above, except that Phase 1’s Rhythm Multiplier will always be used, regardless of which Phase is 
currently generating rhythms. This allows the Rhythm Multiplier to be varied in Phase 1 while affecting the overall swing 
settings for the whole effect. For example, if generating 16th notes in both phases with both Phase’s Rhythm Multipliers 
set to 100% and Swing Note set to “16th,” the resulting 16th notes will be swung with a 16th note feel. If Phase 1’s 
Rhythm Multiplier is changed to 200%, the resulting 8th notes in Phase 1 and 16th notes in Phase 2 will all be swung with 
an 8th note feel. If the Rhythm Multiplier in Phase 1 is 100% and changed to 50% in Phase 2, the resulting 16th notes in 
Phase 1 and 32nd notes in Phase 2 will all be swung with a 16th note feel.

3: P2 - always use Phase 2’s Multiplier
Same as “P1” described above, except utilizing Phase 2’s Rhythm Multiplier.
<0184>
    [Swing Triplets] (checkbox) [Off, On]

When off, any natural triplets within the rhythm will not be swung, but other straight notes will. This is more natural for 
jazz and swing feels. When on, triplets will also be affected by the swing settings, which may produce interested results. 
When the rhythm pattern is all triplets, swing can be used to create a sort of 6/8 or 3/4 swing. This also can be used to 
simulate the Korg Triton Arpeggiator, which adds the swing feel to all notes. 
<0185>

    [Swing Affects Duration] (checkbox) [Off, On]

When on, the shifting of notes caused by the swing effect will also shorten and lengthen the durations appropriately. This 
is more natural for most situations, but you may want to disable it in certain cases.

<PatGrid><0197>
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Rhythm - Pattern Grid & Associated Parameters
 

<0199>
    [Pattern Grid] [21 rows x 32 steps]

A Rhythm Pattern controls the rhythm that the notes are generated with according to a grid of rhythmic values. Note that 
this only controls when the notes are generated; it does not necessarily affect the actual durations of the notes, which is 
controlled by the settings in the Duration Page. 

A Rhythm Pattern may have any number of steps up to 32, and loop independently of other patterns being used at the same 
time. Each step is represented by one column on the grid. As shown above, unused columns will appear disabled; clicking 
on a disabled column inserts a value into it and any other disabled columns between it and the last column in use. The first 
column must always contain at least one value. Note that a Pattern with a single value in a single column is functionally 
equivalent to many columns each containing the same value. For general information on working with the various Pattern 
Editing Grids, see Using The Pattern Grids.
<UseGrid>

The top part of the grid corresponds to 18 different rhythmic values; the bottom three rows are special purpose rows. 
The first two are “tie” rows allowing values in the upper part of the grid to be tied together. The two tie rows are 
mutually exclusive; only one at a time can be used in any given column. 
<0189>

[rand] - Random Tie: 
Randomly ties the rhythmic value in the same column to the previous column’s rhythmic value. For example, a 16th note 
in the first column followed by a 16th note and a random tie in the 2nd column yields either an 8th note or two 16th notes. 
If the first column had a 16th note, and the next three columns all had 16th notes and random ties, then one of potentially 
seven different rhythmic combinations would be generated, always occupying the space of a quarter note. The buttons are 
shown in orange. When at least one random tie has been selected, a weighting curve becomes available to the right of the 
grid that allows choices to be slanted towards more ties or less ties, as described later.

[abs] - Absolute Tie: 
Always ties the rhythmic value in same column to the previous column’s rhythmic value. For example, a 16th note in the 
first column followed by a 16th note and an absolute tie in the 2nd column yields an 8th note. The buttons are shown in 
yellow.
<0190>

[no bend] - No Bend:
The final row is the “no bend” row - the buttons are shown in light blue. It affects when Automatic Pitch Bending effects 
can occur, as set up on the Bend Page. These effects will normally be triggered with every single generated note or 
cluster. By using the “no bend” row, you can specify that bends will not occur on various steps of the Rhythm Pattern. 
Note that these have no effect if the [pb] (pitch bend) row of the Phase Activity Grid in the Phase Page does not have some 
buttons turned on, so that bending can occur throughout various steps of the Phase Pattern.

If the first column contains a tie, then when the effect is started a “rest” will be generated, and further entries into the 
Phase will have the option of tieing over depending on the setting of the [d] (downbeat) row in the Phase Activity Grid in 
the Phase Page. Note that tieing over the end of Phases into the next Phase (as controlled by the Phase Pattern) is tricky. 
If the [d] (downbeat) button for a Phase is not turned on in the Phase Activity Grid of the Phase Page, that a tie can not 
only cross over into the next Phase, but wrap around and tie into the beginning of the current Phase’s Rhythm Pattern if it 
happens to be the last Pattern value in the Phase.
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More than one value can be entered in any given column (in the top 18 rows corresponding to rhythmic values) by using 
the [shift] key. These then become a “random pool” from which choices will be made at random, subject to the use of a 
weighting curve as described later on. The weighting curve becomes available when there is at least one random pool 
selected. The example above shows a random choice from a 16th, 8th, or Quarter, followed by seven 16th notes, followed 
by a 16th note absolutely tied to the next 16th note (an 8th note), then randomly tied to the next two 16ths, etc. Whether 
or not the random choices will be different each time through the Phase is controlled in the Phase Page; you can choose to 
repeat the same random sequence a number of times or always generate new random sequences of choices.

The Rhythm Pattern can start from the beginning each time a Phase change occurs, or can continue from where it 
previously left off. This is also controlled in the Phase Page, with the [pr] (pattern restart) row of the Phase Activity 
Grid. For example, assume the pattern contained 10 items and a Phase only used eight of them before changing to a 
different Phase. If the pattern was not set to restart in the Phase Page, then the second time through the same Phase it 
would pick up where it left off: at the 9th value of the pattern. For information on both restarting the pattern and 
repeating random sequences, see Phase Page - Phase Activity Grid (General).
<PhsEd/PhsGrid><0191>

    [Rhythm Multiplier] (numerical) [1...800%]

Multiplies the selected Rhythm Pattern by the percentage. Useful for polyrhythmic and fractal effects, such as using the 
same Rhythm pattern at different multiplications. For example, if a Pattern is {16th, 8th, 8th}, then using a Rhythm 
Multiplier of 50% changes it to {32nd, 16th, 16th}; using a Multiplier of 200% changes it to {8th, Quarter, Quarter}. This 
parameter can also be controlled by several “virtual” RT Parms. See Rhythm Page - RTParm Virtual Parameters. 

<RhyEd/Virt><RandPool><0202><0200>
Rhythm - Random Weighting Parameters (Pools)
 

The Random Weighting Parameters (Pools) are made available when at least one step in the Rhythm Pattern Grid contains 
multiple buttons turned on in the top 18 rows of rhythmic values (constituting a “random pool” of values). Whenever a 
random pool is encountered in playing through the pattern, a random choice is made from the values in that step. Certain 
areas of the random pool can be favored by the use of a weighting table, with various shaped curves. Using the curves, 
you can influence certain choices to be made more or less often than others, allowing very musical real-time control of 
the randomness.

Whether or not a certain random sequence will repeat for a number of times is controlled by the [nr] (new random 
sequence) buttons in the Phase Page. See Phase Page - Phase Activity Grid (General).
<PhsEd/PhsGrid><0192>
    [Weighting Curve] (popup menu) [0...3]

Selects one of four different curves that act to favor certain areas of the pool over others when each random choice is 
made. Next to the Weighting Curve menu, a small graphic displays the actual shape of the chosen curve based on the 
setting of the “Factor” field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top 
will favor values towards the top of the columns in the grid. For a more complete discussion of the various shapes and 
how the Factor influences the choices, see the Appendix Random Weighting Curves. 
<RandCurves> 

0: Exponential
With a positive Factor (-), choices will be exponentially weighted towards the shorter rhythms (pool values higher in the 
grid column). With a negative Factor (-), choices will be exponentially weighted towards the longer rhythms (pool values 
lower in the grid column).

1: Logarithmic
With a positive Factor (-), choices will be logarithmically weighted towards the shorter rhythms (pool values higher in 
the grid column). With a negative Factor (-), choices will be logarithmically weighted towards the longer rhythms (pool 
values lower in the grid column).

2: Exp-S (Exponential S)
With a positive Factor (+), choices will be exponentially weighted towards the middle rhythms (pool values towards the 
center of each pool), and away from the shorter and longer rhythms. With a negative Factor (-), choices will be 
exponentially weighted towards the shorter and longer rhythms (pool values lower and higher in the grid column), and 
away from the middle rhythms.

3: Log-S (Logarithmic S)
With a positive Factor (+), choices will be logarithmically weighted towards the middle rhythms (pool values towards the 
center of each pool), and away from the shorter and longer rhythms. With a negative Factor (-), choices will be 
logarithmically weighted towards the shorter and longer rhythms (pool values lower and higher in the grid column), and 
away from the middle rhythms.
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    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves. 
<RandCurves/Compare>

    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen. A Factor of “+99” with 
either of the S-Curves yields a straight line across the middle, and only the middle value in the pool will be chosen. A 
Factor of “-99” with either of the S-Curves yields a split straight line across the bottom and top, and random choices 
between only the lowest and highest values in the pool will be chosen.

The following table summarizes the effect of the various Weighting Curves and the Factor field on the choices from the 
Rhythm Pools:

 

<0193>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is either +99 or -99, the choices are “locked” to the highest or 
lowest values in the columns, and there are no random choices at all. (The only exception to this is an S-shaped curve 
with a value of -99. In this case, a random choice will be made between the highest and lowest values only.)

<RandTie><0201>
Rhythm - Random Weighting Parameters (Ties)
 

The Random Weighting Parameters (Ties) are made available when at least one step (column) in the Rhythm Pattern Grid 
contains a Random Tie. Whenever this step is encountered in playing through the pattern and a random choice must be 
made, the likelihood of a tie occurring can also be favored by the use of a weighting table.

Whether or not a certain random sequence will repeat for a number of Phases is controlled by the [nr] (new random 
sequence) buttons in the Phase Page. See Phase Page - Phase Activity Grid (General).
<PhsEd/PhsGrid><0194>
    [Weighting Curve] (popup menu) [0...1]

Selects one of two different curves that affect the likelihood of a tie occurring when a random choice is made. Next to the 
Weighting Curve menu, a small graphic displays the actual shape of the chosen curve based on the setting of the “Factor” 
field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top will favor the rhythmic 
choices more often than the ties, while a curve arced towards the bottom will cause the occurrence of more ties. For a 
more complete discussion of the various shapes and how the Factor influences the choices, see the Appendix Random 
Weighting Curves.
<RandCurves> 

0: Exponential
With a positive Factor (+), choices will be exponentially weighted towards rhythm values more often. With a negative 
Factor (-), choices will be exponentially weighted towards ties more often.

1: Logarithmic
With a positive Factor (-), choices will be logarithmically weighted towards the rhythm values more often. With a 
negative Factor (-), choices will be logarithmically weighted towards the ties more often.

    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves.
<RandCurves/Compare>

    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen.
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The following table summarizes the effect of the various Weighting Curves and the Factor field on random ties:

 

<0195>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is +99, the choices are “locked” to no ties whatsoever; when the 
value is -99, the choices are “locked” to ties always (and the effect is the same as if absolute ties were selected).

<Template>
Rhythm - Template Management
 

Certain of the parameters in the Rhythm Page can be saved as a “Template.” This can be useful for Templates that you 
use often, or that you like to use as a starting point for further experimentation, or to maintain a library of Templates. 
Furthermore, Templates can be switched in real-time when they are assigned as RT Parms, causing radical changes in 
what is being generated.

What is saved in a Rhythm Pattern Template:
- the configuration of the Pattern Editing Grid;
- the Random Pool Weighting Parameters (Weighting Curve and Factor);
- the Random Ties Weighting Parameters (Weighting Curve and Factor).

There can be more than one bank of Templates in a KDF File. Each GE stores a reference to which Bank it is using, which is 
set by the Template Bank parameter in the GE Editor. All Templates used in a GE must come from the same bank - for 
example, you cannot use Rhythm Templates from one bank and Index Templates from another at the same time.

    When a Template is selected and loaded via RT Parm control, the Weighting Curve and Factor will remain as presently 
set if the Weighting Curve or Factor is also assigned as an RT Parm. In other words, a Weighting Curve and Factor are 
stored as part of the Template, but if they are under RT Parm control, their current settings are not replaced when the 
Template is loaded.
<1701>

    [Open Template Bank] (button)

Opens a Template Bank Display Window for the current bank of Rhythm Pattern Templates.
<0186>
    [Template] (popup menu) [0 = [As Stored], 1...63]

Selects from 63 different Rhythm Pattern Templates (shared by both Phase 1 and 2), and loads the parameters into the 
current Phase’s Editing Area.

Selecting Template 0 (which is always named [As Stored] and cannot be overwritten) reloads the stored internal settings 
of the GE for the parameters corresponding to the template. In other words, you can have a complex pattern set up on the 
grid, select one or more Templates, thereby completely replacing it, and then return to the original settings by selecting 
[As Stored].

When selected by the mouse using the popup menu, the [As Stored] selection is always available. When the Template is 
being controlled as a Real-Time Parameter, there are two different options available:

Template [1...63]
The internal settings of the GE for the set of parameters corresponding to the chosen Template are never used; rather 
they are always replaced by one of the selected Templates from within the Min/Max range specified for the RT Parm. In 
this case, available range is 1~63, and it is not possible to select 0: [As Stored].

Template + Restore [0...63]
Similar to the above setting; however, the internal settings of the GE can be restored and used as part of the real-time 
Template operation. In this case, the Min setting of the Template Range actually does not select that Template; rather, it 
causes the internal settings of the GE to be restored for that Template’s set of parameters. In other words, you can have 
a complex pattern already set up on the grid. Using “Template + Restore” as a GE RT Parm, you specify a range where 
the Min value restores the internal settings, and the rest of the range selects Templates, replacing the internal settings. 
So if the Min value was 5 and the Max value was 10, choosing 5 would restore the internal settings (the same as selecting 
“0 [As Stored]”), and 6 through 10 would select the corresponding Template. You can use this to keep the internal 
settings of the GE, while still allowing a wide variety of Templates to be substituted for various groups of parameters. In 
this case, the available range is 0~63. You can assign the full range of all 63 Templates, or only a portion of the range, 
and still have the ability to restore the original internal settings.
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�    When a GE is first loaded, the Template popup will always display “As Stored.” If you select a Template, the popup 
menu will display the name of the Template, but after you save the GE and load it again, it will once again display “As 
Stored.” This is because the Template value is not saved in the GE, but the contents of the Pattern Grid and associated 
parameters are.
<0187>
    [Save] (button)

Brings up a Save Dialog allowing you to name the Template and save it in memory. After saving a Template, it will then be 
available in the Template popup menus for both Phases.
<OthDlg/Sbs><0188>
    [Clear] (button)

Brings up a dialog allowing you to clear the selected Template. You will be given an opportunity to cancel. After clearing, 
the Template will disappear from the Template popup menus for both Phases.

    Saving or clearing only affects the Templates in RAM. To save these changes to disk, you must save the KDF File by 
choosing “Save,” “Save As…” or “Save All…” from the File menu.

    Since the changes are not written to disk until one of the Save commands is executed, to undo a change after you have 
stored or cleared a Template you can close and reopen the current KDF file.

<Virt>
Rhythm - RT Parm Virtual Parameters
The following parameters are not true parameters, but “virtual” parameters for RT Parm control. In other words, they 
do not physically exist on the Rhythm Page, but perform a modifying function on one or more of the other parameters. 
They can be found in the Rhythm Group when assigning parameters in the GE Editor > RT Parms Page, and have a tilde (~) 
at the beginning of the parameter name (indicating that they are virtual). They allow you to select from one of three 
different quantized sets of values for the Rhythm Multiplier field, without getting all of the in between values, plus 
provide a special variation for the Swing % setting.

    [~Straight Multipliers] (virtual) [0...5]

     {0, 1, 2, 3, 4, 5} = {25, 50, 100, 200, 400, 800}
Selects from a quantized set of “straight” values for the Rhythm Multiplier field. In other words, when applied to a 
Rhythm pattern containing values such as 16th notes, the resulting rhythmic values will be straight values such as 8th 
notes, quarter notes, etc.

    [~Straight/Trip Mults] (virtual) [0...10]

     {0, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10} = {25, 34, 50, 68, 100, 136, 200, 272, 400, 544, 800}
Selects from a quantized set of “straight & triplet” values for the Rhythm Multiplier field. In other words, when applied 
to a Rhythm pattern containing values such as 16th notes, the resulting rhythmic values will be straight values such as 
8th notes, quarter notes, etc. or various triplet values.

    [~Str/Dot/Trip Mults] (virtual) [0...15]

     {0, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10} =
     {25, 34, 37, 50, 68, 75, 100, 136, 150, 200, 272, 300, 400, 544, 600, 800}
Selects from a quantized set of “straight, triplet & dotted” values for the Rhythm Multiplier field. In other words, when 
applied to a Rhythm pattern containing values such as 16th notes, the resulting rhythmic values will be straight values 
such as 8th notes, quarter notes, etc., various triplet values, or various dotted values.

    [~Swing % 0~100,101,102] (numerical) [0...100 = 0...+100%, 101 = +200%, 102 = -200%]

See the description in the Global Parameters section. <RhyEd/SwingVirt>
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Duration
Sections in this chapter:

Overview<DurEd/Over>

About Duration Patterns<DurEd/About>

Global Parameters<DurEd/Global>

Pattern Grid & Associated Parameters<DurEd/PatGrid>

Random Weighting Parameters (Pools)<DurEd/RandPool>

Random Weighting Parameters (Ties)<DurEd/RandTie>

Template Management<DurEd/Template>

 

<Over>
Duration - Overview
The Duration Page contains the parameters that control the duration of the notes in a Generated Effect.

Global Parameters
Parameters that affect duration characteristics during playback of either Phase in a Generated Effect.

Phase Specific Parameters
An identical group of parameters for each Phase that affect the duration characteristics during playback of that Phase 
only. For more on Phases, see the Phase Page.
<PhsEd><0204>

Phase Selection Buttons
Selects which Phase (a separate collection of the Phase Specific Parameters) to display and edit.

Pattern Grid
Allows Duration Patterns to be constructed in various ways, which then control or affect the duration of the notes as they 
are generated, depending on the Duration Mode.

Random Weighting Parameters
Parameters that allow weighting curves to be applied to any random pools (more than one value in a column) which may 
have been created in the Pattern Grid. There is a separate section for allowing weighting curves to be applied to random 
ties within the pattern.
<0217>

LED Tracking Arrays
Rows of gray dots along the horizontal and vertical axes of the pattern grid, with one or more green dots displaying the 
currently chosen index (column) and duration values (rows).
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Template Management
Allows the contents of the Pattern Grid and certain associated parameters to be saved as a “Template.” It will then 
appear in the popup menu for future use when creating/editing Duration Patterns. Selecting a Template from the menu 
loads it into the Pattern Grid and associated parameters.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy Phases...<GEUtils/Pco>
<1856>
 

    If settings in the Phase Page indicate a particular Phase is not being used, the Phase Specific Parameters will not be 
available for that Phase. The message “Phase Not In Use” will be displayed near the Phase Selection Buttons.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><About>
Duration - About Duration Patterns
Duration Patterns control the duration of notes for each “rhythm event” that is generated according to the settings in the 
Rhythm Page. Choices can be made from “Random Pools” of values as described in detail later on. Furthermore, values 
can be tied to each other; such ties can be absolute or random.

A Duration Pattern will loop as long as note generation continues. It normally will not reset to the beginning of the Pattern 
unless a new Trigger is received, or the Phase Page has been configured to restart it at the beginning of certain Phases by 
using the [pr] (pattern restart] buttons. This means that a four step Duration Pattern can be looping while an eight step 
Velocity Pattern and a twelve step Cluster Pattern are also independently looping, for example.

<Global><0203>
Duration - Global Parameters
 

    [Randomize] (range bar) [-60...60 ms]

Sets a range of randomization to be applied to each note’s duration as it is generated. The range is -60 ~ 60 ms, in 
increments of 5 ms. Note that this can be used to make the duration of each note in a cluster slightly different. Useful for 
more human sounding effects, with less machine-like precision. The effect of this will only be applied depending on the 
Duration Mode (discussed below). When it is “Poly Extend,” “Poly Extend/Damped,” or “Mono Extend,” it will only have 
an effect on notes where the pattern has been set to “damp” the auto-extended durations.

    Not affected by the Performance’s Random Seeds parameters. 

<PatGrid><0218>
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Duration - Pattern Grid & Associated Parameters
 

<0219>
    [Pattern Grid] [20 rows x 32 steps]

A Duration Pattern controls the duration that the notes are generated with according to a grid of rhythmic values. It may 
have any number of steps up to 32, and loop independently of other patterns being used at the same time. Each step is 
represented by one column on the grid. As shown above, unused columns will appear disabled; clicking on a disabled column 
inserts a value into it and any other disabled columns between it and the last column in use. The first column must always 
contain at least one value. Note that a Pattern with a single value in a single column is functionally equivalent to many 
columns each containing the same value. For general information on working with the various Pattern Editing Grids, see 
Using The Pattern Editing Grids.
<UseGrid>

The top part of the grid corresponds to 18 different rhythmic values; the bottom 2 rows are special purpose “tie” rows 
allowing values in the upper part of the grid to be tied together. The 2 tie rows are mutually exclusive; only one at a time 
can be used in any given column. 
<0211>

[rand] - Random Tie:
Randomly ties the rhythmic value in the same column to the previous column’s rhythmic value. For example, a 16th note 
in the first column followed by a 16th note and a random tie in the 2nd column yields either an 8th note or two 16th note 
durations.

[abs] - Absolute Tie:
Always ties the rhythmic value in same column to the previous column’s rhythmic value. For example, a 16th note in the 
first column followed by a 16th note and an absolute tie in the 2nd column yields an 8th note duration.

When at least one random tie has been selected, a weighting curve becomes available to the right of the grid that allows 
choices to be slanted towards more ties or less ties, as described later. A tie in the first column will not have any effect 
unless the pattern wraps around, in which case the last value in the pattern will tie around into the first step. Unlike 
Rhythm Patterns, a tie over a Phase is not permitted.

More than one value can be entered in any given column (in the top 18 rows corresponding to rhythmic values) by using 
the [shift] key. These then become a “random pool” from which choices will be made at random, subject to the use of a 
weighting curve as described later on. The weighting curve becomes available when there is at least one random pool 
selected. The example above shows a random choice from five different durations in the fifth step of the pattern. Whether 
or not the random choices will be different each time through the Phase is controlled in the Phase Page; you can choose to 
repeat the same random sequence a number of times or always generate new random sequences of choices.

Also controlled in the Phase Page is whether or not the Duration Pattern will start from the beginning each time a Phase 
starts, with the [pr] (pattern restart) row of the Phase Activity Grid. For example, assume the pattern contained 10 
items and a Phase only used eight of them before changing to a different Phase. If the pattern was not set to restart in the 
Phase Page, then the second time through the same Phase it would pick up where it left off: at the 9th value of the 
pattern. For information on both restarting the pattern and repeating random sequences, see Phase Page - Phase Activity 
Grid (General).
<PhsEd/PhsGrid>

    If the Duration Mode is “Timed,” “Rhythm Overlap,” or “Rhythm %,” the Pattern Grid will not be available.
<0205>
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   [Duration Mode] (popup menu) [0...7]

Selects one of several modes of operation for generating durations in the current Phase.

    Based on the current setting, the Duration Pattern Grid, Random Weighting Parameters and Pattern Advance Mode 
menu may not be available.

0: Poly Extend (Value range: 1 ~ 800 %)
Each note will sustain until the next generation of the same note, or until that note is no longer a part of the Note Series 
(caused by playing a new chord, for example). For example, if the notes to a CMaj chord are sustaining and the chord is 
changed to a CMinor, only the Es will be damped. Especially useful for fingerpicked and strummed guitar effects. Certain 
steps may be “damped” by using the Duration Pattern Grid to indicate a duration value shorter than the current Rhythm 
Pattern value. The “Duration Value” parameter is used to specify a percentage of the Duration Pattern value, making it 
shorter or longer by a certain amount. For example, if the Rhythm Pattern is generating quarter notes, any step in the 
Duration Pattern (as modified by the Duration Value) that is shorter than a quarter note will cause the notes (and all 
sustaining notes at that time) to have the specified duration. This is useful for simulating the technique of strumming and 
damping certain chords within the progression. Any value in a Duration Pattern step (as modified by the Duration Value) 
that is longer than the current Rhythm Pattern value will be ignored, and the notes will sustain as described above. The 
Duration Value field specifies a percentage of the overall value (1 ~ 800 %) - therefore, values less than 100% will 
shorten the duration represented by the Pattern Step, and values greater than 100% will lengthen it.

1: Poly Extend/Damped (Value range: 1 ~ 800 %)
The same as above, except all sustaining notes will be damped when the chord changes, not just notes that are no longer in 
the Note Series.

2: Mono Extend (Value range: 1 ~ 800 %)
The same as above, except each note is sustained until the next note (of any pitch) is generated. When used with clusters, 
only one note in a cluster will actually be sustained. This can be used to simulate a monophonic instrument, for example, 
although other modes here can also do that depending on how you set the parameters.

3: Timed (Value range: 1 ~ 5000 ms)
The Duration Value field is used to specify the duration of the generated notes, in milliseconds (1 ~ 5000 ms). All notes 
will therefore have the same length. Note that this is independent of the current tempo - if it is set to 50 ms, it will 
always be 50 ms, regardless of tempo.

4: Rhythm Overlap (Value range: -500 ~ 500 ms)
The Duration Value field is used to specify an amount by which each note or cluster will overlap or be separated from the 
next note or cluster, in milliseconds (-500 ~ 500 ms). Note that this relates to the Rhythm Pattern values. Positive 
values cause overlapping; negative values cause separation. For example, a setting of -20 ensures that all notes will 
extend and be separated from the next notes by 20 ms regardless of the actual rhythm the notes are generated with, or 
the current tempo. Note that while the Rhythm Pattern values themselves are relative to tempo, the value specified here 
is not. Using the example setting of -20, there will always be a gap of 20 ms between notes regardless of the tempo.

5: Rhythm % (Value range: 1 ~ 800 %)
The Duration Value field is used to specify a percentage of the rhythmic value a note is generated with to use as a duration 
(1 ~ 800%). Note that this relates to the Rhythm Pattern values. The actual time is then calculated on the fly, taking into 
account the current tempo. For example, with a setting of 50%, if the Rhythm Pattern specifies a string of 8th notes, 
they will appear to be generated as a string of 16th notes separated by 16th note rests (each 8th note will have the 
duration of a 16th note, or 50%). Note that this value is therefore relative to tempo.

6: Pattern Overlap (Value range: -500 ~ 500 ms)
The Duration Pattern Grid is used to construct a Duration Pattern, in a similar fashion to the Rhythm Pattern. Each step in 
the pattern indicates the duration for notes that are currently to be generated. The Duration Value field is used to specify 
an amount by which to increase or decrease the pattern values, in milliseconds (-500 ~ 500 ms). This can be used to set 
up a certain Duration Pattern, and then vary in real-time the “gate-time” of each note in the pattern simultaneously. For 
example, if the Duration Pattern is generating 16th - 8th at a tempo of 120 BPM, the notes would have the durations of 
125 ms, 250 ms, etc. If the Value field is -20, they would be generated as 105 ms, 230 ms, etc. Note that while the 
Duration Pattern values themselves are relative to tempo, the value specified here is not. Using the example setting of 
-20, the notes will always be 20 ms shorter regardless of the tempo.

7: Pattern % (Value range: 1 ~ 800 %)
The Duration Pattern Grid is used to construct a Duration Pattern, in a similar fashion to the Rhythm Pattern. Each step in 
the pattern indicates the duration for notes that are currently to be generated. The Duration Value field is used to specify 
a percentage by which to increase or decrease the pattern values (1 ~ 800%). This can be also be used to set up a certain 
Duration Pattern, and then vary in real-time the “gate-time” of each note in the pattern simultaneously, similar to the 
previous option. For example, if the Duration Pattern is generating 16th - 8th at a tempo of 120 BPM, the notes would 
have the durations of 125 ms, 250 ms, etc. If the Value field is 80%, they would be generated as 100 ms, 200 ms, etc. 
Note that this value is therefore relative to tempo.
<0206>
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    [Duration Value] (numerical) [-500...5000] range/function varies depending on Duration Mode

Depending on the Duration Mode setting, sets or modifies the durations of the generated notes. The range and function of 
the field varies - see the descriptions above under “Duration Mode.” Note that the valid ranges are different for several 
of the Duration Modes, so if the Duration Mode (above) is changed and the current setting for the Duration Value is out of 
range, it will be limited to the top or bottom of the applicable range. This also means that if the Duration Mode is assigned 
as an RT Parm and varied in real-time, it is possible that it will affect the setting of the Duration Value at various times. 
In this case, the Duration Value will be limited internally (and the limited value will be displayed in the GE Editor > 
Duration Page), but the “Current (Controlled) Value” and “Stored (Center) Value” of the RT Parm as displayed in the PE 
or GE Editors may not reflect the actual value. The same is true for the “Floating Parameter Value Displays” in the 
Realtime Controls Editor, if the Duration Value is assigned to one of the controls.

Duration Mode:                Duration Value Valid Range:
Poly Extend                                1 ~ 800%
Poly Extend/Damped                   1 ~ 800%
Mono Extend                               1 ~ 800%
Timed                                         1 ~ 5000 ms
Rhythm Overlap                         -500 ~ 500 ms
Rhythm %                                   1 ~ 800%
Pattern Overlap                         -500 ~ 500 ms
Pattern %                                   1 ~ 800%
<0207>

    [Use Rhythm Multiplier] (checkbox) [Off, On]

When on, the durations of the generated notes will be affected by the current setting of the Rhythm Page Rhythm 
Multiplier. For example, if the Duration Pattern specifies a duration of a 16th note, and the Rhythm Multiplier is set to 
200% in the current Phase, the actual resulting duration will be an 8th note. This is useful when you want to vary the 
Rhythm Multiplier in real-time and have the Duration Pattern also lengthen the notes appropriately.
<0212>
    [Advance Mode] (popup menu) [0...5]

Determines whether the Duration Pattern will use its own index to move through the pattern or lock to another pattern’s 
index. A Duration Pattern has an associated index that moves through the pattern and dictates the current step to be used. 
The LED Tracker Arrays show the current step and chosen value during operation. The Advance Mode parameter controls 
one of several methods of operation:

0: Independent - 1 step per Rhythm Event
Each time the Rhythm Pattern determines it is time to generate a note or notes, a value will be chosen from the current 
step of the Duration Pattern, after which the index will be advanced to the next step of the Duration Pattern. The index 
will therefore advance through the pattern without skipping any steps, and upon reaching the end, loop back to the 
beginning. If using Drum Patterns, each Drum Pattern maintains a separate index into the Note Pattern that advances 1 
step for each note, but does not advance for any rests in the Drum Pattern. Therefore, if the Drum Patterns have 
different rests in different places, it is possible for the values they are selecting to be from different steps of the Note 
Pattern.

1: Lock (R) - Lock To Rhythm Pattern & Ties
The Duration Pattern will “lock” to the Rhythm Pattern, by essentially using the Rhythm Pattern’s index. This is useful 
when the Rhythm Pattern has been set to include random ties. For example, if the Rhythm Pattern has 16 steps including 
random ties, creating a 16 step Duration Pattern and using this mode assures that when the Rhythm Pattern “skips” a 
step (due to a random tie occurring), the Duration Pattern will skip the same step. If the patterns are of unequal length, 
the index will be wrapped around to a valid location. If using Drum Patterns, each Drum Pattern will select values from 
the same step at the same time, regardless of any rests in the Drum Patterns.

2: Lock (D1) - Lock To Drum Pattern 1
3: Lock (D2) - Lock To Drum Pattern 2
4: Lock (D3) - Lock To Drum Pattern 3
The Duration Pattern will “lock” to the selected Drum Pattern, by essentially using the selected Drum Pattern’s index. 
The only time this is any different than Lock (R) is when the Rhythm Pattern contains Random Ties. If you want the 
Duration Pattern values to be selected in a linear fashion, one after the other, and not skip over certain steps of the 
pattern, you can lock to one of the Drum Patterns. If the Drum Pattern and Duration Pattern are of unequal length, the 
index will be wrapped around to a valid location. Note that a rest in the Drum Pattern will still advance the index, unlike 
“Independent” above. Therefore, if all three Drum Patterns are in use, locking to any one of the three will produce 
identical results, other than taking the length of the Drum Pattern into consideration.

5: Lock (R/S) - Lock To Rhythm Pattern, Synchronize Randomization
Basically the same as “Lock (R)” above: the Duration Pattern will “lock” to the Rhythm Pattern, by essentially using the 
Rhythm Pattern’s index. The difference is that the Duration Pattern then uses the Rhythm Pattern’s Random Seeds, which 
means they will refer to the same sequence of random numbers. This means that you can set up a Random Rhythm Pattern 
and a corresponding Random Duration Pattern, and they will stay completely in sync, as long as you have the same 
randomizations in both, the same number of steps, etc.
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They don’t need to have the same rhythmic values; just the same number of pools in the same places, or the same random 
rests in the same places. In other words, assume a Rhythm Pattern of all 16ths with some random ties. If you set up the 
exact same pattern in the Duration Page, with the same values and same random rests, and select the “Lock (R/S)” 
mode, they will do exactly the same thing. Then, you can set some of the Duration values to be other than 16th notes, so 
that certain steps are shorter/longer, yet as long as the Random Ties are in the same place, they will stay locked 
together. If 3 ties occur next to each other in the Rhythm Pattern, they will also occur the same way in the Duration 
Pattern.

Another example is a Rhythm Pattern with a number of pools in it, i.e. at steps 4, 6, and 8. If you create a Duration 
Pattern, they don’t need to have the same values, as long as there are pools of some values at the same steps, 4, 6, and 
8. This ensures that every time the Rhythm Pattern makes a random choice from a pool of values, so does the Duration 
Pattern. Then they can stay “locked” in the random sequence.

<RandPool><0222><0220>
Duration - Random Weighting Parameters (Pools)
 

The Random Weighting Parameters (Pools) are made available when at least one step in the Duration Pattern Grid contains 
multiple buttons turned on in the top 18 rows of rhythmic values (constituting a “random pool” of values). Whenever a 
random pool is encountered in playing through the pattern, a random choice is made from the values in that step. Certain 
areas of the random pool can be favored by the use of a weighting table, with various shaped curves. Using the curves, 
you can influence certain choices to be made more or less often than others, allowing very musical real-time control of 
the randomness.

Whether or not a certain random sequence will repeat for a number of times is controlled by the [nr] (new random 
sequence) buttons in the Phase Page. See Phase Page - Phase Activity Grid (General).
<PhsEd/PhsGrid><0213>
    [Weighting Curve] (popup menu) [0...3]

Selects one of four different curves that act to favor certain areas of the pool over others when each random choice is 
made. Next to the Weighting Curve menu, a small graphic displays the actual shape of the chosen curve based on the 
setting of the “Factor” field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top 
will favor values towards the top of the columns in the grid. For a more complete discussion of the various shapes and 
how the Factor influences the choices, see the Appendix Random Weighting Curves. 
<RandCurves> 

0: Exponential
With a positive Factor (-), choices will be exponentially weighted towards the shorter durations (pool values higher in the 
grid column). With a negative Factor (-), choices will be exponentially weighted towards the longer durations (pool values 
lower in the grid column).

1: Logarithmic
With a positive Factor (-), choices will be logarithmically weighted towards the shorter durations (pool values higher in 
the grid column). With a negative Factor (-), choices will be logarithmically weighted towards the longer durations (pool 
values lower in the grid column).

2: Exp-S (Exponential S)
With a positive Factor (+), choices will be exponentially weighted towards the middle durations (pool values towards the 
center of each pool), and away from the shorter and longer durations. With a negative Factor (-), choices will be 
exponentially weighted towards the shorter and longer durations (pool values lower and higher in the grid column), and 
away from the middle durations.

3: Log-S (Logarithmic S)
With a positive Factor (+), choices will be logarithmically weighted towards the middle durations (pool values towards the 
center of each pool), and away from the shorter and longer durations. With a negative Factor (-), choices will be 
logarithmically weighted towards the shorter and longer durations (pool values lower and higher in the grid column), and 
away from the middle durations.

    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves.
<RandCurves/Compare>

    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen. A Factor of “+99” with 
either of the S-Curves yields a straight line across the middle, and only the middle value in the pool will be chosen. A 
Factor of “-99” with either of the S-Curves yields a split straight line across the bottom and top, and random choices 
between only the lowest and highest values in the pool will be chosen.
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The following table summarizes the effect of the various Weighting Curves and the Factor field on the choices from the 
Duration Pools:

 

<0214>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is either +99 or -99, the choices are “locked” to the highest or 
lowest values in the columns, and there are no random choices at all. (The only exception to this is an S-shaped curve 
with a value of -99. In this case, a random choice will be made between the highest and lowest values only.)

<RandTie><0221>
Duration - Random Weighting Parameters (Ties)
 

The Random Weighting Parameters (Ties) are made available when at least one step (column) in the Duration Pattern Grid 
contains a Random Tie. Whenever this step is encountered in playing through the pattern and a random choice must be 
made, the likelihood of a tie occurring can also be favored by the use of a weighting table.

Whether or not a certain random sequence will repeat for a number of Phases is controlled by the [nr] (new random 
sequence) buttons in the Phase Page. See Phase Page - Phase Activity Grid (General).
<PhsEd/PhsGrid><0215>
    [Weighting Curve] (popup menu) [0...1]

Selects one of two different curves that affect the likelihood of a tie occurring when a random choice is made. Next to the 
Weighting Curve Menu, a small graphic displays the actual shape of the chosen curve based on the setting of the “Factor” 
field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top will favor the rhythmic 
choices more often than the ties, while a curve arced towards the bottom will cause the occurrence of more ties. For a 
more complete discussion of the various shapes and how the Factor influences the choices, see the Appendix Random 
Weighting Curves.
<RandCurves> 

0: Exponential
With a positive Factor (+), choices will be exponentially weighted towards duration values more often. With a negative 
Factor (-), choices will be exponentially weighted towards ties more often.

1: Logarithmic
With a positive Factor (-), choices will be logarithmically weighted towards the duration values more often. With a 
negative Factor (-), choices will be logarithmically weighted towards the ties more often.

    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves. 
<RandCurves/Compare>

    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen.

The following table summarizes the effect of the various Weighting Curves and the Factor field on random ties:

 

<0216>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is +99, the choices are “locked” to no ties whatsoever; when the 
value is -99, the choices are “locked” to ties always (and the effect is the same as if absolute ties were selected).

<Template>
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Duration - Template Management
 

Certain of the parameters in the Duration Page can be saved as a “Template.” This can be useful for Templates that you 
use often, or that you like to use as a starting point for further experimentation, or to maintain a library of Templates. 
Furthermore, Templates can be switched in real-time when they are assigned as RT Parms, causing radical changes in 
what is being generated.

What is saved in a Duration Pattern Template:
- the configuration of the Pattern Editing Grid;
- the Random Pool Weighting Parameters (Weighting Curve and Factor);
- the Random Ties Weighting Parameters (Weighting Curve and Factor).

There can be more than one bank of Templates in a KDF File. Each GE stores a reference to which Bank it is using, which is 
set by the Template Bank parameter in the GE Editor. All Templates used in a GE must come from the same bank - for 
example, you cannot use Rhythm Templates from one bank and Index Templates from another at the same time.

    When a Template is selected and loaded via RT Parm control, the Weighting Curve and Factor will remain as presently 
set if the Weighting Curve or Factor is also assigned as an RT Parm. In other words, a Weighting Curve and Factor are 
stored as part of the Template, but if they are under RT Parm control, their current settings are not replaced when the 
Template is loaded.
<0223>

    [Open Template Bank] (button)

Opens a Template Bank Display Window for the current bank of Duration Pattern Templates.
<0208>
    [Template] (popup menu) [0 = [As Stored], 1...63]

Selects from 63 different Duration Pattern Templates (shared by both Phase 1 and 2), and loads the parameters into the 
current Phase’s Editing Area.

Selecting Template 0 (which is always named [As Stored] and cannot be overwritten) reloads the stored internal settings 
of the GE for the parameters corresponding to the template. In other words, you can have a complex pattern set up on the 
grid, select one or more Templates, thereby completely replacing it, and then return to the original settings by selecting 
[As Stored].

When selected by the mouse using the popup menu, the [As Stored] selection is always available. When the Template is 
being controlled as a Real-Time Parameter, there are two different options available:

Template [1...63]
The internal settings of the GE for the set of parameters corresponding to the chosen Template are never used; rather 
they are always replaced by one of the selected Templates from within the Min/Max range specified for the RT Parm. In 
this case, available range is 1~63, and it is not possible to select 0: [As Stored].

Template + Restore [0...63]
Similar to the above setting; however, the internal settings of the GE can be restored and used as part of the real-time 
Template operation. In this case, the Min setting of the Template Range actually does not select that Template; rather, it 
causes the internal settings of the GE to be restored for that Template’s set of parameters. In other words, you can have 
a complex pattern already set up on the grid. Using “Template + Restore” as a GE RT Parm, you specify a range where 
the Min value restores the internal settings, and the rest of the range selects Templates, replacing the internal settings. 
So if the Min value was 5 and the Max value was 10, choosing 5 would restore the internal settings (the same as selecting 
“0 [As Stored]”), and 6 through 10 would select the corresponding Template. You can use this to keep the internal 
settings of the GE, while still allowing a wide variety of Templates to be substituted for various groups of parameters. In 
this case, the available range is 0~63. You can assign the full range of all 63 Templates, or only a portion of the range, 
and still have the ability to restore the original internal settings.

    When a GE is first loaded, the Template popup will always display “As Stored.” If you select a Template, the popup 
menu will display the name of the Template, but after you save the GE and load it again, it will once again display “As 
Stored.” This is because the Template value is not saved in the GE, but the contents of the Pattern Grid and associated 
parameters are.
<0209>
    [Save] (button)

Brings up a Save Dialog allowing you to name the Template and save it in memory. After saving a Template, it will then be 
available in the Template popup menus for both Phases.
<OthDlg/Sbs><0210>
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   [Clear] (button)

Brings up a dialog allowing you to clear the selected Template. You will be given an opportunity to cancel. After clearing, 
the Template will disappear from the Template popup menus for both Phases.

    Saving or clearing only affects the Templates in RAM. To save these changes to disk, you must save the KDF File by 
choosing “Save,” “Save As…” or “Save All…” from the File menu.

    Since the changes are not written to disk until one of the Save commands is executed, to undo a change after you have 
stored or cleared a Template you can close and reopen the current KDF file.

Page 228



Index
Sections in this chapter:

Overview<NteEd/Over>

About Index Patterns<NteEd/About>

Pattern Grid & Associated Parameters<NteEd/PatGrid>

Random Weighting Parameters<NteEd/RandPool>

Template Management<NteEd/Template>

 

<Over>
Index - Overview
The Index Page controls the order of the pitches as they are generated from the Note Series, and some other 
characteristics that can affect the number of notes generated at a time.

Phase Specific Parameters
An identical group of parameters for each Phase that affect the note generation characteristics during playback of that 
Phase only. For more on Phases, see the Phase Page. 
<PhsEd><0224>

Phase Selection Buttons
Selects which Phase (a separate collection of the Phase Specific Parameters) to display and edit.

Pattern Grid
Allows Index Patterns to be constructed in various ways, which then control the order of the pitches as they are 
generated from the Note Series.

Random Weighting Parameters
Parameters that allow weighting curves to be applied to any random pools (more than one value in a column) which may 
have been created in the Pattern Grid.
<0237>

LED Tracking Arrays
Rows of gray dots along the horizontal and vertical axes of the pattern grid, with one or more green dots displaying the 
currently chosen index (column) and pattern values (rows).

Template Management
Allows the contents of the Pattern Grid and certain associated parameters to be saved as a “Template.” It will then 
appear in the popup menu for future use when creating/editing Index Patterns. Selecting a Template from the menu loads it 
into the Pattern Grid and associated parameters.
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Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy Phases...<GEUtils/Pco>
<1861>
 

    If settings in the Phase Page indicate a particular Phase is not being used, the Phase Specific Parameters will not be 
available for that Phase. The message “Phase Not In Use” will be displayed near the Phase Selection Buttons. If GE Type = 
“Generated - Gated,” the Phase Specific Parameters will not be available for either Phase.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><About><0240>
Index - About Index Patterns
Index Patterns describe a way of moving through the Note Series in memory and consequently controls the order of the 
pitches as they are generated. The Note Series has an index associated with it that indicates the current position, and the 
next note to be generated. The Index Pattern values indicate how the index will be moved after generating the note at the 
current position. A positive value moves forward from the current position; a negative value moves backwards; a value 
of {0} repeats an index. Choices can be made from “Random Pools” of values as described in detail later on. When the 
Phase Direction is set to “Backwards,” the values operate in inverted fashion.

Since the first value in the Index Pattern is not used until after the first note has been generated, an Index Pattern of {1 1 
1 -2} will cause the generation of the first 4 notes in the Notes Series, after which it jumps back to the 2nd note in the 
Note Series and so on.

Note that it is possible to create Index Patterns that will not move ahead or will actually move backwards, given that you 
can start from a position that is somewhere in the middle of a Note Series by using either the “Initial Start %” or 
“Beginning/End Offset %” parameters in the Phase Page. If you do create an Index Pattern that simply stays in one place 
(i.e. {1, -1}, or {0}), a Phase Change will only occur if the Phase Length Mode is not set to “Actual,” since in this mode it 
waits for the end of the Index Series to be reached, and this will never happen if there is no forward movement.

An Index Pattern will loop as long as note generation continues. It normally will not reset to the beginning of the Pattern 
unless a new Trigger is received, or the Phase Page has been configured to restart it at the beginning of certain Phases by 
using the [pr] (pattern restart) buttons. This means that a four step Index Pattern can be looping while an eight step 
Velocity Pattern and a twelve step Cluster Pattern are also independently looping, for example.

Besides using Index Patterns, several other means of moving through the Note Series are provided. These options are 
controlled with the Index Mode parameter, as described below.

<PatGrid><0238>
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Index - Pattern Grid & Associated Parameters
 

<0239>
    [Pattern Grid] [15 rows x 32 steps]

An Index Pattern may have any number of steps up to 32, and loop independently of other patterns being used at the same 
time. Each step is represented by one column on the grid. As shown above, unused columns will appear disabled; clicking 
on a disabled column inserts a value into it and any other disabled columns between it and the last column in use. The first 
column must always contain at least one value. Note that a Pattern with a single value in a single column is functionally 
equivalent to many columns each containing the same value. For general information on working with the various Pattern 
Editing Grids, see Using The Pattern Grids.
<UseGrid>

More than one value can be entered in any given column (by using the [shift] key), which then becomes a “random pool” 
from which choices will be made at random, subject to the use of a weighting curve as described later on. The weighting 
curve becomes available when there is at least one random pool selected. The example above shows a pattern where the 
first 8 notes of the Note Series will be played in order (the Index Pattern always effectively starts with the 2nd note), 
followed by a jump back of either 1 or 2, selected at random. Whether or not the random choices will be different each 
time through the Phase is controlled in the Phase Page; you can choose to repeat the same random sequence a number of 
times or always generate new random sequences of choices.

Also controlled in the Phase Page is whether or not the Index Pattern will start from the beginning each time a Phase 
starts, with the [pr] (pattern restart) row of the Phase Activity Grid. For example, assume the pattern contained 10 
items and a Phase only used eight of them before changing to a different Phase. If the pattern was not set to restart in the 
Phase Page, then the second time through the same Phase it would pick up where it left off: at the 9th value of the 
pattern. For information on both restarting the pattern and repeating random sequences, see Phase Page - Phase Activity 
Grid (General).<PhsEd/PhsGrid>

    If the Index Mode menu is not set to “Pattern,” the Pattern Grid will not be available.

    If GE Type = “Generated - Gated,” then the Pattern Grid and all of the following parameters will not be available.
<0225>
    [Index Mode] (popup menu) [0...2]

For each Phase, selects one of several different Modes of operation for indexing the Index Series:

0: Pattern
Movement through the Index Series will be controlled by an Index Pattern constructed in the pattern grid.

1: Random
Causes the pitches to be chosen at random from the applicable portion of the Note Series. Unlike most arpeggiators, the 
random algorithm used here does not allow notes to happen twice in a row, which sounds less machine-like and more 
musical. Once a note has been chosen, future choices of that note will not occur until all other notes in the applicable 
portion have been chosen.

    If you want the possibility of notes happening twice or more in a row, you can configure the Index Pattern to have 
pools of values including “0.”
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2: Random Walk
Causes the index to meander from the start index in a random fashion, with the largest step that can be taken in any 
direction controlled by the “Random Walk Max Step” parameter (described below). For example, if “Max Step” is set to 
“2,” then the “pool” of possible choices for movement from the current note is {-2, -1, 1, 2}. Note that {0} is not 
allowed as a possible choice. This is good for creating riffs which sound like improvisation, especially when you use the 
Phase Page to ensure that random phrases will be repeated a number of times before new ones are chosen.

    If you want the possibility of notes happening twice or more in a row, you can configure the Index Pattern to have 
pools of values including “0.”

<0226>
    [Random Walk Max Step] (numerical) [1...9]

Sets the largest step that can be taken when the Index Mode is set to 2: Random Walk, as described above. The value 
relates to movement of the Index through the Note Series, not a particular musical interval.

    Not available unless Index Mode is set to “Random Walk.”
<0232>
    [Invert] (button) [Off, On]

When on, the index will be inverted with regards to the overall Note Series (taking into consideration the Beginning and 
End Offsets in the Phase Page) and generated again, thereby generating twice as many notes at a time. This will also cause 
any clusters to be inverted.

Off
Example: Index Pattern = 1, Cluster Size = 2
Note Series: C2 E2 G2 B2 C3 E3 G3 B3
Step 1:      C2 E2 
Step 2:         E2 G2
Step 3:            G2 B2
Step 4:               B2 C3

On
Note Series: C2 E2 G2 B2 C3 E3 G3 B3
Step 1:      C2 E2             G3 B3
Step 2:         E2 G2       E3 G3
Step 3:            G2 B2 C3 E3
Step 4:            G2 B2 C3 E3
<0233>
    [Double] (button) [Off, On]

When on, the “Amount” popup menu becomes available, and the index will be doubled by the interval indicated and generated 
again, thereby generating twice as many notes at a time. This will also cause any clusters to be doubled.

    When using Double and Invert at the same time, four times as many notes will be generated.
<0234>
    [Double Amount] (popup menu) [0...12]

This parameter becomes available when “Double” is on, and the index will be doubled by the interval indicated and 
generated again, thereby generating twice as many notes at a time. When set to “Auto,” a pleasing interval is 
automatically calculated depending on the number of notes in the Note Series. The other settings specify exact distances 
from the current index in terms of the order of notes in the Notes Series (not semitones).

Example: Index Pattern = 1, Cluster Size = 1, Double = On, Amount = 3
Note Series: C2 E2 G2 B2 C3 E3 G3 B3
Step 1:      C2       B2
Step 2:         E2       C3
Step 3:            G2       E3
Step 4:               B2       G3

    Not available unless Double is set to on.
<0243>

    [Inv/Dbl Velocity Offset] (numerical) [0...200%]

Sets an amount by which the velocity of any inverted and doubled notes will be offset from the original notes. This allows 
you to make them a bit softer or louder than the original notes. The value is a percentage of the original note’s velocity, 
so values less than 100 will produce softer inverted and doubled notes, while values greater than 100 will produce louder 
inverted and doubled notes. A value of 0% will effectively stop the generation of inverted and doubled notes.

    Not available unless Double or Invert is set to on.
<0230>
    [Advance Mode] (popup menu) [0...4]

Determines whether the Index Pattern will use its own index to move through the pattern or lock to another pattern’s 
index. An Index Pattern also has an associated index that moves through the pattern and dictates the current step to be 
used. The LED Tracker Arrays show the current step and chosen value during operation. The Advance Mode parameter 
controls one of several methods of operation:
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0: Independent - 1 step per Rhythm Event
Each time the Rhythm Pattern determines it is time to generate a note or cluster of notes, a value will be chosen from the 
current step of the Index Pattern, after which the index will be advanced to the next step of the Index Pattern. The index 
will therefore advance through the pattern without skipping any steps, and upon reaching the end, loop back to the 
beginning. If using Drum Patterns and the [in] (use index pattern) buttons are turned on in the Phase Activity Grid 
(Drums), each Drum Pattern maintains a separate index into the Index Pattern that advances 1 step for each note, but 
does not advance for any rests in the Drum Pattern. Therefore, if the Drum Patterns have different rests in different 
places, it is possible for the values they are selecting to be from different steps of the Index Pattern. This also interacts 
with the “Cluster Mode” setting, described below.

1: Lock (R) - Lock To Rhythm Pattern & Ties
The Index Pattern will “lock” to the Rhythm Pattern, by essentially using the Rhythm Pattern’s index. This is useful 
when the Rhythm Pattern has been set to include random ties. For example, if the Rhythm Pattern has 16 steps including 
random ties, creating a 16 step Index Pattern and using this mode assures that when the Rhythm Pattern “skips” a step 
(due to a random tie occurring), the Index Pattern will skip the same step. If the patterns are of unequal length, the index 
will be wrapped around to a valid location. If using Drum Patterns and the [in] (use index pattern) buttons are turned on in 
the Phase Activity Grid (Drums), each Drum Pattern will select values from the same step at the same time, regardless 
of any rests in the Drum Patterns.

2: Lock (D1) - Lock To Drum Pattern 1
3: Lock (D2) - Lock To Drum Pattern 2
4: Lock (D3) - Lock To Drum Pattern 3
The Index Pattern will “lock” to the selected Drum Pattern, by essentially using the selected Drum Pattern’s index. The 
only time this is any different than Lock (R) is when the Rhythm Pattern contains Random Ties. If you want the Index 
Pattern values to be selected in a linear fashion, one after the other, and not skip over certain steps of the pattern, you 
can lock to one of the Drum Patterns. If the Drum Pattern and Index Pattern are of unequal length, the index will be 
wrapped around to a valid location. Note that a rest in the Drum Pattern will still advance the index, unlike “Independent” 
above. Therefore, if all three Drum Patterns are in use, locking to any one of the three will produce identical results, 
other than taking the length of the Drum Pattern into consideration.
<0231>
    [Cluster Mode] (popup menu) [0...1]

Sets the way that clusters affect the advancement through the Index Pattern. When set to Multi, a cluster will advance as 
many steps as notes in the cluster (if Advance Mode is 0:Independent).

0: Single - 1 Step Per Cluster
Each time a note, cluster of notes, or group of drum notes is generated one Index Pattern Value will be chosen for the 
resulting note or cluster of notes, after which the Index Pattern advances to the next value. For example, a cluster of six 
notes will all be generated from the next six adjacent notes in the Note Series (or Drum Pattern) and advance the pattern 
by one to the next step. In other words, when a cluster is about to be generated, the index in the Note Series will first 
move an amount determined by the previous Step’s Index Pattern Value; then all the notes in the cluster will be generated 
from adjacent indexes, after which the Pattern will again advance by one. This is useful for creating clusters of notes 
which jump around following the Index Pattern exactly; the bottom note of each cluster essentially follows the path that 
would be taken by a cluster size of one, with the effect that cluster size has no effect on how quickly the Index Pattern 
moves through the Note Series and Phase (or Drum Pattern). Also useful for randomizing Drum Patterns, since it will 
cause the index into the Drum Pattern to jump around and not move forward in a linear fashion. The LED Tracking Arrays 
will display one value at a time.

Example: Index Pattern = 2, Cluster Size = 6
Note Series: C2 E2 G2 B2 C3 E3 G3 B3 C4 E4 G4 B4...
Step 1:      C2 E2 G2 B2 C3 E3
Step 2:            G2 B2 C3 E3 G3 B3
Step 3:                  C3 E3 G3 B3 C4 E4
Step 4:                        G3 B3 C4 E4 G4 B4 etc.

1: Multi - 1 Step For Each Note In Cluster
- When Advance Mode is 0: Independent:
For every note in a cluster or group of drum notes generated simultaneously, a separate Index Pattern Value will be 
chosen after which the Index Pattern advances to the next value. For example, a cluster of six notes will be generated 
with the next six Index Pattern Values (with a net advance of six steps). This means that each note in the cluster will not 
necessarily be the adjacent note in the Note Series (or Drum Pattern), but a certain distance from the previous note as 
specified by the pattern value. This is useful for creating clusters of notes with different voicings, or randomizing Drum 
Patterns in a manner different than above. Another effect of this is that after each cluster, the next cluster starts where 
the previous cluster left off, in effect advancing through the Phase and the Note Series (or Drum Pattern) much more 
quickly. The LED Tracking Arrays will display the number of values chosen depending on the current cluster size.

Example: Index Pattern = 2, Cluster Size = 6
Note Series: C2 E2 G2 B2 C3 E3 G3 B3 C4 E4 G4 B4 C5 E5 G5 B5 C6 E6 G6 B6...
Step 1:      C2    G2    C3    G3    C4    G4
Step 2:                                          C5    G5    C6    G6...
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- When the Advance Mode is 1: Lock (R) or one of the Drum Lock options:
The Index Pattern is using the other pattern’s index; therefore, it is not possible for it to advance with each note. So it 
works slightly differently: the Index Value at the current step is used for each note in the cluster. So a cluster of six 
notes will be generated with the same distance between each index, as specified by the current Index Pattern Value. This 
value also indicates where the next cluster will start. For example, with an Index Pattern value of {3}, a cluster of 3 
notes will have the indexes spaced by 3 and the next cluster will start 3 indexes away from the last generated note.

Example: Index Pattern = {3 2 1}, Cluster Size = 3
Advance Mode: Lock (R), Cluster Mode: Multi
Note Series: C2 E2 G2 B2 C3 E3 G3 B3 C4 E4 G4 B4 C5 E5 G5 B5 C6 E6 G6 B6...
Step 1:     [C2       B2       G3]
Step 2:                                [E4    B4    E5]    
Step 3:                                                  [B5 C6 E6]...
(between)     <- 3 ->  <- 3 ->  <- 3 -> <-2-> <-2-> <-2-> <1><1><1>

    When the GE Type is “Generated - Riff,” setting this to “Multi” will have no effect unless there is a Cluster Pattern 
containing values of more than just one.

    When the GE Type is “Generated - Drum,” setting this to “Multi” will have no effect unless at least one Drum Pattern 
has the [cl] (use cluster pattern) button turned on in a Phase Pattern step in the Phase Page and there is a Cluster Pattern 
containing values of more than just one.

    If you use Index Pattern Values of {0} (no advance) and Cluster Patterns, when the Pattern Advance Mode is set to 
“Multi” a cluster will produce notes all of the same pitch, since each note in the cluster is “0” indexes away from the 
previous note. When the Pattern Advance Mode is “Single,” each note of the cluster will be heard since they are all 
played from adjacent indexes; however, the next cluster will start from the same note since there has been an overall 
advance of {0}.

    When randomizing Drum Patterns with Index Patterns and watching the LED Tracking Arrays, you may also be seeing 
the “regular” index (which may be applied to generate pitch bend information) in addition to the index for each Drum 
Pattern using the Index Pattern. You may be watching up to four indexes displayed at the same time!

<RandPool><0241><0242>
Index - Random Weighting Parameters
 

The Random Weighting Parameters are made available when at least one step (column) in the Index Pattern Grid contains 
multiple buttons turned on (constituting a “random pool” of values). Whenever a random pool is encountered in playing 
through the pattern, a random choice is made from the values in that step. Certain areas of the random pool can be 
favored by the use of a weighting table, with various shaped curves. Using the curves, you can influence certain choices 
to be made more or less often than others, allowing very musical real-time control of the randomness.

Whether or not a certain random sequence will repeat for a number of times is controlled by the [nr] (new random 
sequence) buttons in the Phase Page. See Phase Page - Phase Activity Grid (General). 
<PhsEd/PhsGrid><0235>
    [Weighting Curve] (popup menu) [0...3]

Selects one of four different curves that act to favor certain areas of the pool over others when each random choice is 
made. Next to the Weighting Curve menu, a small graphic displays the actual shape of the chosen curve based on the 
setting of the “Factor” field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top 
will favor values towards the top of the columns in the grid. For a more complete discussion of the various shapes and 
how the Factor influences the choices, see the Appendix Random Weighting Curves. 
<RandCurves> 

0: Exponential
With a positive Factor (+), choices will be exponentially weighted towards the pool values higher in the grid column. With 
a negative Factor (-), choices will be exponentially weighted towards the pool values lower in the grid column.

1: Logarithmic
With a positive Factor (+), choices will be logarithmically weighted towards the pool values higher in the grid column. 
With a negative Factor (-), choices will be logarithmically weighted towards the pool values lower in the grid column.

2: Exp-S (Exponential S)
With a positive Factor (+), choices will be exponentially weighted towards the pool values towards the center of each 
pool, and away from the values higher and lower in the grid columns. With a negative Factor (-), choices will be 
exponentially weighted towards the pool values higher and lower in the grid columns, and away from the center values.
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3: Log-S (Logarithmic S)
With a positive Factor (+), choices will be logarithmically weighted towards the pool values towards the center of each 
pool, and away from the values higher and lower in the grid columns. With a negative Factor (-), choices will be 
logarithmically weighted towards the pool values higher and lower in the grid columns, and away from the center values.

    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves.
<RandCurves/Compare>

    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen. A Factor of “+99” with 
either of the S-Curves yields a straight line across the middle, and only the middle value in the pool will be chosen. A 
Factor of “-99” with either of the S-Curves yields a split straight line across the bottom and top, and random choices 
between only the lowest and highest values in the pool will be chosen.

The following table summarizes the effect of the various Weighting Curves and the Factor field on the choices from the 
Index Pattern Pools:

 

<0236>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is either +99 or -99, the choices are “locked” to the highest or 
lowest values in the columns, and there are no random choices at all. (The only exception to this is an S-shaped curve 
with a value of -99. In this case, a random choice will be made between the highest and lowest values only.)

<Template>
Index - Template Management
 

Certain of the parameters in the Index Page can be saved as a “Template.” This can be useful for Templates that you use 
often, or that you like to use as a starting point for further experimentation, or to maintain a library of Templates. 
Furthermore, Templates can be switched in real-time when they are assigned as RT Parms, causing radical changes in 
what is being generated.

What is saved in an Index Pattern Template:
- the configuration of the Pattern Editing Grid;
- the Random Weighting Parameters (Weighting Curve and Factor).

There can be more than one bank of Templates in a KDF File. Each GE stores a reference to which Bank it is using, which is 
set by the Template Bank parameter in the GE Editor. All Templates used in a GE must come from the same bank - for 
example, you cannot use Rhythm Templates from one bank and Index Templates from another at the same time.

    When a Template is selected and loaded via RT Parm control, the Weighting Curve and Factor will remain as presently 
set if the Weighting Curve or Factor is also assigned as an RT Parm. In other words, a Weighting Curve and Factor are 
stored as part of the Template, but if they are under RT Parm control, their current settings are not replaced when the 
Template is loaded.

    The Template Management Area will be grayed out if the Index Mode is not set to “Pattern.”
<0244>

    [Open Template Bank] (button)

Opens a Template Bank Display Window for the current bank of Index Pattern Templates.
<0227>
    [Template] (popup menu) [0 = [As Stored], 1...63]

Selects from 63 different Index Pattern Templates (shared by both Phase 1 and 2), and loads the parameters into the 
current Phase’s Editing Area.

Selecting Template 0 (which is always named [As Stored] and cannot be overwritten) reloads the stored internal settings 
of the GE for the parameters corresponding to the template. In other words, you can have a complex pattern set up on the 
grid, select one or more Templates, thereby completely replacing it, and then return to the original settings by selecting 
[As Stored].

When selected by the mouse using the popup menu, the [As Stored] selection is always available. When the Template is 
being controlled as a Real-Time Parameter, there are two different options available:
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Template [1...63]
The internal settings of the GE for the set of parameters corresponding to the chosen Template are never used; rather 
they are always replaced by one of the selected Templates from within the Min/Max range specified for the RT Parm. In 
this case, available range is 1~63, and it is not possible to select 0: [As Stored].

Template + Restore [0...63]
Similar to the above setting; however, the internal settings of the GE can be restored and used as part of the real-time 
Template operation. In this case, the Min setting of the Template Range actually does not select that Template; rather, it 
causes the internal settings of the GE to be restored for that Template’s set of parameters. In other words, you can have 
a complex pattern already set up on the grid. Using “Template + Restore” as a GE RT Parm, you specify a range where 
the Min value restores the internal settings, and the rest of the range selects Templates, replacing the internal settings. 
So if the Min value was 5 and the Max value was 10, choosing 5 would restore the internal settings (the same as selecting 
“0 [As Stored]”), and 6 through 10 would select the corresponding Template. You can use this to keep the internal 
settings of the GE, while still allowing a wide variety of Templates to be substituted for various groups of parameters. In 
this case, the available range is 0~63. You can assign the full range of all 63 Templates, or only a portion of the range, 
and still have the ability to restore the original internal settings.

    When a GE is first loaded, the Template popup will always display “As Stored.” If you select a Template, the popup 
menu will display the name of the Template, but after you save the GE and load it again, it will once again display “As 
Stored.” This is because the Template value is not saved in the GE, but the contents of the Pattern Grid and associated 
parameters are.
<0228>
    [Save] (button)

Brings up a Save Dialog allowing you to name the Template and save it in memory in the current Template Bank. After 
saving a Template, it will then be available in the Template popup menus for both Phases. 
<OthDlg/Sbs><0229>
    [Clear] (button)

Brings up a dialog allowing you to clear the selected Template from the current Template Bank. You will be given an 
opportunity to cancel. After clearing, the Template will disappear from the Template popup menus for both Phases.

    Saving or clearing only affects the Templates in RAM. To save these changes to disk, you must save the KDF File by 
choosing “Save,” “Save As…” or “Save All…” from the File menu.

    Since the changes are not written to disk until one of the Save commands is executed, to undo a change after you have 
stored or cleared a Template you can close and reopen the current KDF file.
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Cluster
Sections in this chapter:

Overview<CluEd/Over>

About Cluster Patterns<CluEd/About>

Global Parameters<CluEd/Global>

Pattern Grid & Associated Parameters<CluEd/PatGrid>

Random Weighting Parameters<CluEd/RandPool>

Template Management<CluEd/Template>

 

<Over>
Cluster - Overview
The Cluster Page contains the parameters that control the “clustering” characteristics of the Generated Effect (the 
number of notes to generate simultaneously each time a rhythm event occurs). Also controlled from here is the degree of 
strumming on a cluster, and the direction in which a cluster is strummed.

Global Parameters
Parameters that affect clustering characteristics during playback of either Phase in a Generated Effect.

Phase Specific Parameters
An identical group of parameters for each Phase that affect the note generation characteristics during playback of that 
Phase only. For more on Phases, see the Phase Page.
<PhsEd><0245>

Phase Selection Buttons
Selects which Phase (a separate collection of the Phase Specific Parameters) to display and edit.

Pattern Grid
Allows Cluster Patterns to be constructed in various ways, which then control how many notes are generated at a time, 
along with a stroke direction and time percentage for strumming, if desired.

Random Weighting Parameters
Parameters that allow weighting curves to be applied to any random pools (more than one value in a column in the upper 
ten Size rows) which may have been created in the Pattern Grid.
<0251>

LED Tracking Arrays
Rows of gray dots along the horizontal and vertical axes of the pattern grid, with one or more green dots displaying the 
currently chosen index (column) and values (rows).
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Template Management
Allows the contents of the Pattern Grid and certain associated parameters to be saved as a “Template.” It will then 
appear in the popup menu for future use when creating/editing Cluster Patterns. Selecting a Template from the menu loads 
it into the Pattern Grid and associated parameters.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy Phases...<GEUtils/Pco>
<1866>
 

    If settings in the Phase Page indicate a particular Phase is not being used, the Phase Specific Parameters will not be 
available for that Phase. The message “Phase Not In Use” will be displayed near the Phase Selection Buttons. If GE Type = 
“Generated - Gated” and GE Gate Type does not = “Vel CP,” the Phase Specific Parameters will not be available for 
either Phase.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><About>
Cluster - About Cluster Patterns
A “cluster” is a group of notes that will be generated at the same time, with a size ranging from 1 to 10. Cluster 
Patterns control how many notes at a time will be generated each time the Rhythm Pattern determines that it is time to 
produce some notes (each “rhythm event”). This can be used to cause chords to be generated at certain times; the 
resulting chords may optionally be strummed or skewed in several ways, with differing degrees of looseness. Random 
choices of cluster sizes can be made from “Random Pools” of values in each column as described in detail later on. 

If the Cluster Pattern is {1}, single notes are produced (when GE Type = “Generated - Riff”). A CMaj7 as input source 
material might produced the following simple arpeggio as an example:

 

If a Cluster Pattern was {3 1 1 3 1 2} (and the Index Pattern Cluster Mode “Single”), then the following result would be 
produced by the same input notes:

 

Note that the number of notes in a cluster can be effectively doubled or quadrupled if “Invert,” “Double” or both are 
being used in the Index Page. See Index Page - Pattern Grid & Associated Parameters.
<NteEd/PatGrid>

A Cluster Pattern will loop as long as note generation continues. It normally will not reset to the beginning of the Pattern 
unless a new Trigger is received, or unless the Phase Activity Grid (General) has been configured to restart it at the 
beginning of certain Phases by using the [pr] (pattern restart) buttons. This means that a four step Rhythm Pattern can be 
looping while an eight step Velocity Pattern and a twelve step Cluster Pattern are also independently looping, for example.

<Global>
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Cluster - Global Parameters
 

<0252><Strum>
    [Strum] (numerical) [0...1000 ms]

Sets the value in milliseconds that each cluster will be “strummed” (quickly arpeggiated or flammed). Note that a single 
note cannot be strummed, so this only has an effect on cluster sizes greater than 1. This is the total time for each 
cluster, so each note in a cluster of five notes will be closer together than a cluster of three notes with the same strum 
value. This maintains a proper degree of “looseness” while changing cluster sizes. The direction of the strum (or random 
skewing if desired) is controlled by the Stroke rows of the pattern grid. By setting the Strum value to high values (so 
there are not really strums, but arpeggiations happening), interesting overlapping of each cluster over subsequent 
clusters can be made to occur.

    Not available if GE Type = “Generated - Gated” and Gate Type = one of the CC options.

<PatGrid>
Cluster - Pattern Grid & Associated Parameters
 

    If GE Type = “Generated - Gated,” and GE Gate Type does not = “Vel CP”, the Pattern Grid and associated parameters 
are not available.
<0253>
    [Pattern Grid] [16 rows x 32 steps]

A Cluster Pattern represents a series of values indicating the size of clusters of notes to be generated (chords). It may 
have any number of steps up to 32, and loop independently of other patterns being used at the same time. Each step is 
represented by one column on the grid. As shown above, unused columns will appear disabled; clicking on a disabled column 
inserts a value into it and any other disabled columns between it and the last column in use. The first column must always 
contain at least one value (unless the “Pattern Length” field is available - see the “Size” description below). Note that a 
pattern with a single value in a single column is functionally equivalent to many columns each containing the same value. 
For general information on working with the various Pattern Grids, see Using The Pattern Grids.
<UseGrid>

Whether or not the Cluster Pattern will start from the beginning each time a Phase starts is controlled by the [pr] 
(pattern restart) row of the Phase Activity Grid (General). For example, assume the pattern contained 10 items and a 
Phase only used 8 of them before changing to a different Phase. If the pattern was not set to restart in the Phase Page, 
then the 2nd time through the same Phase it would pick up where it left off: at the 9th value of the pattern. For 
information on both restarting the pattern and repeating random sequences, see Phase Page - Phase Activity Grid 
(General). 
<PhsEd/PhsGrid><0254>

Size (when using any configuration but GE Type = “Generated-Gated” and GE Gate Type = “Vel CP”):
The ten rows at the top of the grid specify the number of notes to generate simultaneously in a given step of the Cluster 
Pattern. More than one value can be entered in any given column (by using the [shift] key), which then becomes a “random 
pool” from which choices will be made at random, subject to the use of a weighting curve as described later on. The 
weighting curve becomes available when there is at least one random pool selected. The example above shows a pattern 
where randomly chosen clusters sizes are interleaved with fixed cluster sizes (single values in a column). Whether or not 
the random choices will be different each time through the Phase is controlled in the Phase Page; you can choose to repeat 
the same random sequence a number of times or always generate new random sequences of choices.

Note that in this case, the Cluster Pattern only specifies how many notes at a time to generate – it does not choose which. 
The Index Pattern and/or a Drum Pattern are used to specify which notes are to be generated at which steps.

Page 239



Size (when using GE Type = “Generated-Gated” and GE Gate Type = “Vel CP” (Triton Arp simulation)):
The Cluster Pattern Grid is used to indicate which notes from all of the input notes are to be generated. In other words, 
the 10 rows of the Cluster Pattern allow you to specify which of up to 10 notes you may be holding at any time are to be 
generated. (This can be used to simulate the operation of the Korg Triton Arpeggiator, for example.) If a column of the 
Cluster Pattern has rows 1, 3 and 5 selected, then the first, third, and fifth notes provided as input will be generated at 
that step.  (With other configurations, the Cluster Pattern only specifies how many notes at a time to generate – it does 
not choose which. The Index Pattern and/or a Drum Pattern are used to specify which notes are to be generated at which 
steps. However, with GE Gate Type = “Vel CP” the Cluster Pattern specifies directly which notes (and therefore how 
many) are to be generated, and the Index Pattern is unused.) Note that filling all 10 rows of each column is essentially the 
same as using GE Gate Type = “Vel.”

In this particular configuration only, the Cluster Pattern allows empty columns with no buttons turned on in the upper ten 
Size rows. A column without a Size button turned on essentially creates a “rest” at that step based on the Rhythm 
Pattern value (like the Korg Triton Arpeggiator). In this case, the “Pattern Length” parameter explained below is made 
available and sets the number of steps in the pattern.

    When the GE Type is not in this particular configuration the Cluster Pattern Grid does not allow empty columns, the 
same as most of the Pattern Grids in KARMA (except for the Phase Pattern). Therefore, if you are using Gate Type “Vel 
CP” and the Cluster Pattern Grid is set up with any empty columns, you will lose the empty columns if you switch to any 
other GE Type – empty columns will be filled with the default value “1.”
<0255>

Stroke
The two rows near the middle of the grid specify a direction to strum the notes in a cluster. Up and Down refer to the 
strokes as they would be executed on a guitar being played by a right-handed person, with a standard tuning arrangement. 
Therefore, an up stroke would be pulling across the strings in an upward direction (therefore arpeggiating the tones in a 
downward direction), and a down stroke would be pulling across the strings in a downward direction (therefore 
arpeggiating the tones in an upward direction).

When a single button is on in a step, that stroke direction is executed. If both Up and Down Strokes are turned on (by using 
the [shift] key), it does not perform a random choice between the two as you might suspect, but rather arpeggiates the 
notes in a “random” order. The notes of the cluster are not generated in an up or down direction, but randomly skewed - 
more useful for simulating a little slop, or several musicians playing together (when creating effects other than 
simulations of guitar strumming). If neither button is turned on in a step, it simply alternates direction with whatever the 
last previously executed direction was. Therefore, it would perform in a similar fashion to alternating the up and down 
buttons in the example pictured above.
<0256>

Strum %
The four rows at the bottom of the grid specify a percentage of the overall Strum value to be used on that step. This 
allows you to make some strokes “looser” or “tighter” than others. In other words, if the Strum value is 50 ms, then 
the rows would correspond to the following strum times:

100%   50 ms
75%     37 ms
50%     25 ms
25%     12 ms

If a single Strum % button is on in step, that is the percentage used for the cluster generated at that step. If more than 
one button is on (by using the [shift] key), one of them is chosen at random. If no Strum % buttons are on in a given step, 
the strum time is “0” (no strum or flam).
<0257>

    [Pattern Length] (numerical) [1...32]

Specifies the number of steps in the Cluster Pattern, when GE Type = “Generated-Gated” and Gate Type = “Vel CP.”

    Only available when GE Type = “Generated-Gated” and Gate Type = “Vel CP.” With this configuration, you are allowed 
to have empty steps in the Cluster Pattern, so the Length field specifies the total number of steps. In any other 
configuration, empty steps are not allowed and the length of the Pattern is determined by the number of steps with one or 
more buttons turned on.
<0258>
    [Advance Mode] (popup menu) [0...4]

Determines whether the Cluster Pattern will use its own index to move through the pattern or lock to another pattern’s 
index. A Cluster Pattern has an associated index that moves through the pattern and dictates the current step to be used. 
The LED Tracker Arrays show the current step and chosen value during operation. The Advance Mode parameter controls 
one of several methods of operation:
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0: Independent - 1 step per Rhythm Event
Each time the Rhythm Pattern determines it is time to generate a note or notes, a value will be chosen from the current 
step of the Cluster Pattern, after which the index will be advanced to the next step of the Cluster Pattern. The index will 
therefore advance through the pattern without skipping any steps, and upon reaching the end, loop back to the beginning. If 
using Drum Patterns and the [cl] (use cluster pattern) buttons are turned on in the Phase Activity Grid (Drums), each 
Drum Pattern maintains a separate index into the Cluster Pattern that advances 1 step for each note, but does not advance 
for any rests in the Drum Pattern. Therefore, if the Drum Patterns have different rests in different places, it is possible 
for the Clusters they are selecting to be from different steps of the Cluster Pattern.

1: Lock (R) - Lock To Rhythm Pattern & Ties
The Cluster Pattern will “lock” to the Rhythm Pattern, by essentially using the Rhythm Pattern’s index. This is useful 
when the Rhythm Pattern has been set to include random ties. For example, if the Rhythm Pattern has 16 steps including 
random ties, creating a 16 step Cluster Pattern and using this mode assures that when the Rhythm Pattern “skips” a step 
(due to a random tie occurring), the Cluster Pattern will skip the same step. If the patterns are of unequal length, the 
index will be wrapped around to a valid location. If using Drum Patterns and the [cl] (use cluster pattern) buttons are 
turned on in the Phase Activity Grid (Drums), each Drum Pattern will select clusters from the same step at the same 
time, regardless of any rests in the Drum Patterns.

2: Lock (D1) - Lock To Drum Pattern 1
3: Lock (D2) - Lock To Drum Pattern 2
4: Lock (D3) - Lock To Drum Pattern 3
The Cluster Pattern will “lock” to the selected Drum Pattern, by essentially using the selected Drum Pattern’s index. The 
only time this is any different than Lock (R) is when the Rhythm Pattern contains Random Ties. If you want the Cluster 
Pattern values to be selected in a linear fashion, one after the other, and not skip over certain steps of the pattern, you 
can lock to one of the Drum Patterns. If the Drum Pattern and Cluster Pattern are of unequal length, the index will be 
wrapped around to a valid location. Note that a rest in the Drum Pattern will still advance the index, unlike “Independent” 
above. Therefore, if all three Drum Patterns are in use, locking to any one of the three will produce identical results, 
other than taking the length of the Drum Pattern into consideration.

<RandPool><0259><0260>
Cluster - Random Weighting Parameters
 

The Random Weighting Parameters are made available when at least one step in the Cluster Pattern Grid contains multiple 
buttons turned on in the upper 10 rows of cluster size values (constituting a “random pool” of values), and the GE Type is 
not “Generated - Gated.” Whenever a random pool is encountered in playing through the pattern, a random choice is made 
from the values in that step. Certain areas of the random pool can be favored by the use of a weighting table, with various 
shaped curves. Using the curves, you can influence certain choices to be made more or less often than others, allowing 
very musical real-time control of the randomness.

Whether or not a certain random sequence will repeat for a number of times is controlled by the [nr] (new random 
sequence) buttons in the Phase Page. See Phase Page - Phase Activity Grid (General).
<PhsEd/PhsGrid>

    The Random Weighting Parameters are not available when the GE Type is “Generated - Gated.”
<0249>
    [Weighting Curve] (popup menu) [0...3]

Selects one of four different curves that act to favor certain areas of the pool over others when each random choice is 
made. Next to the Weighting Curve menu, a small graphic displays the actual shape of the chosen curve based on the 
setting of the “Factor” field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top 
will favor values towards the top of the columns in the grid. For a more complete discussion of the various shapes and 
how the Factor influences the choices, see the Appendix Random Weighting Curves. 
<RandCurves> 

0: Exponential
With a positive Factor (+), choices will be exponentially weighted towards the larger clusters (selected values higher in 
the grid column). With a negative Factor (-), choices will be exponentially weighted towards the smaller clusters 
(selected values lower in the grid column).

1: Logarithmic
With a positive Factor (+), choices will be logarithmically weighted towards the larger clusters (selected values higher in 
the grid column). With a negative Factor (-), choices will be logarithmically weighted towards the smaller clusters 
(selected values lower in the grid column).
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2: Exp-S (Exponential S)
With a positive Factor (+), choices will be exponentially weighted towards the middle clusters (values towards the center 
of the selected values), and away from the largest and smallest clusters. With a negative Factor (-), choices will be 
exponentially weighted towards the smaller and larger clusters (selected values higher and lower in the column), and 
away from the middle clusters.

3: Log-S (Logarithmic S)
With a positive Factor (+), choices will be logarithmically weighted towards the middle clusters (values towards the 
center of the selected values), and away from the largest and smallest clusters. With a negative Factor (-), choices will 
be logarithmically weighted towards the smaller and larger clusters (selected values higher and lower in the column), and 
away from the middle clusters.

    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves.
<RandCurves/Compare>

    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen. A Factor of “+99” with 
either of the S-Curves yields a straight line across the middle, and only the middle value in the pool will be chosen. A 
Factor of “-99” with either of the S-Curves yields a split straight line across the bottom and top, and random choices 
between only the lowest and highest values in the pool will be chosen.

The following table summarizes the effect of the various Weighting Curves and the Factor field on the choices from the 
Cluster Pools:

 

<0250>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is either +99 or -99, the choices are “locked” to the highest or 
lowest values in the columns, and there are no random choices at all. (The only exception to this is an S-shaped curve 
with a value of -99. In this case, a random choice will be made between the highest and lowest values only.)  

<Template>
Cluster - Template Management
 

Certain of the parameters in the Cluster Page can be saved as a “Template.” This can be useful for Templates that you 
use often, or that you like to use as a starting point for further experimentation, or to maintain a library of Templates. 
Furthermore, Templates can be switched in real-time when they are assigned as RT Parms, causing radical changes in 
what is being generated.

What is saved in a Cluster Pattern Template:
- the configuration of the Pattern Editing Grid;
- the Random Weighting Parameters (Weighting Curve and Factor).

There can be more than one bank of Templates in a KDF File. Each GE stores a reference to which Bank it is using, which is 
set by the Template Bank parameter in the GE Editor. All Templates used in a GE must come from the same bank - for 
example, you cannot use Rhythm Templates from one bank and Index Templates from another at the same time.

    When a Template is selected and loaded via RT Parm control, the Weighting Curve and Factor will remain as presently 
set if the Weighting Curve or Factor is also assigned as an RT Parm. In other words, a Weighting Curve and Factor are 
stored as part of the Template, but if they are under RT Parm control, their current settings are not replaced when the 
Template is loaded.
<0261>
    [Open Template Bank] (button)

Opens a Template Bank Display Window for the current bank of Index Pattern Templates.
<0246>
    [Template] (popup menu) [0 = [As Stored], 1...63]

Selects from 63 different Cluster Pattern Templates (shared by both Phase 1 and 2), and loads the parameters into the 
current Phase’s Editing Area.
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Selecting Template 0 (which is always named [As Stored] and cannot be overwritten) reloads the stored internal settings 
of the GE for the parameters corresponding to the template. In other words, you can have a complex pattern set up on the 
grid, select one or more Templates, thereby completely replacing it, and then return to the original settings by selecting 
[As Stored].

When selected by the mouse using the popup menu, the [As Stored] selection is always available. When the Template is 
being controlled as a Real-Time Parameter, there are two different options available:

Template [1...63]
The internal settings of the GE for the set of parameters corresponding to the chosen Template are never used; rather 
they are always replaced by one of the selected Templates from within the Min/Max range specified for the RT Parm. In 
this case, available range is 1~63, and it is not possible to select 0: [As Stored].

Template + Restore [0...63]
Similar to the above setting; however, the internal settings of the GE can be restored and used as part of the real-time 
Template operation. In this case, the Min setting of the Template Range actually does not select that Template; rather, it 
causes the internal settings of the GE to be restored for that Template’s set of parameters. In other words, you can have 
a complex pattern already set up on the grid. Using “Template + Restore” as a GE RT Parm, you specify a range where 
the Min value restores the internal settings, and the rest of the range selects Templates, replacing the internal settings. 
So if the Min value was 5 and the Max value was 10, choosing 5 would restore the internal settings (the same as selecting 
“0 [As Stored]”), and 6 through 10 would select the corresponding Template. You can use this to keep the internal 
settings of the GE, while still allowing a wide variety of Templates to be substituted for various groups of parameters. In 
this case, the available range is 0~63. You can assign the full range of all 63 Templates, or only a portion of the range, 
and still have the ability to restore the original internal settings.

    When a GE is first loaded, the Template popup will always display “As Stored.” If you select a Template, the popup 
menu will display the name of the Template, but after you save the GE and load it again, it will once again display “As 
Stored.” This is because the Template value is not saved in the GE, but the contents of the Pattern Grid and associated 
parameters are.
<0247>
    [Save] (button)

Brings up a Save Dialog allowing you to name the Template and save it in memory in the current Template Bank. After 
saving a Template, it will then be available in the Template popup menus for both Phases. 
<OthDlg/Sbs><0248>
    [Clear] (button)

Brings up a dialog allowing you to clear the selected Template from the current Template Bank. You will be given an 
opportunity to cancel. After clearing, the Template will disappear from the Template popup menus for both Phases.

    Saving or clearing only affects the Templates in RAM. To save these changes to disk, you must save the KDF File by 
choosing “Save,” “Save As…” or “Save All…” from the File menu.

    Since the changes are not written to disk until one of the Save commands is executed, to undo a change after you have 
stored or cleared a Template you can close and reopen the current KDF file.
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Velocity
Sections in this chapter:

Overview<VelEd/Over>

About Velocity Patterns<VelEd/About>

Global Parameters<VelEd/Global>

Pattern Grid & Associated Parameters<VelEd/PatGrid>

Random Weighting Parameters<VelEd/RandPool>

Template Management<VelEd/Template>

 

<Over>
Velocity - Overview
The Velocity Page controls most of the aspects that affect the velocities of the notes in the Generated Effect. 

Global Parameters
Parameters that affect velocity characteristics during playback of either Phase in a Generated Effect.

Phase Specific Parameters
An identical group of parameters for each Phase that affect the note generation characteristics during playback of that 
Phase only. For more on Phases, see the Phase Page. 
<PhsEd><0262>

Phase Selection Buttons
Selects which Phase (a separate collection of the Phase Specific Parameters) to display and edit.

Pattern Grid
Allows Velocity Patterns to be constructed in various ways, which then modify the velocities of the notes as they are 
generated.

Random Weighting Parameters
Parameters that allow weighting curves to be applied to any random pools (more than one value in a column) which may 
have been created in the Pattern Grid.
<0271>

LED Tracking Arrays
Rows of gray dots along the horizontal and vertical axes of the pattern grid, with one or more green dots displaying the 
currently chosen index (column) and velocity offset values (rows).

Template Management
Allows the contents of the Pattern Grid and certain associated parameters to be saved as a “Template.” It will then 
appear in the popup menu for future use when creating/editing Velocity Patterns. Selecting a Template from the menu 
loads it into the Pattern Grid and associated parameters.
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Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy Phases...<GEUtils/Pco>
<0283>
 

    If settings in the Phase Page indicate a particular Phase is not being used, the Phase Specific Parameters will not be 
available for that Phase. The message “Phase Not In Use” will be displayed near the Phase Selection Buttons. 

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><About>
Velocity - About Velocity Patterns
A Velocity Pattern represents amounts to be subtracted from the initial velocities of notes as they are about to be 
generated. This can therefore be used to provide patterns of accents in the Generated Notes, while retaining some of the 
original velocity information if desired. Choices can be made from “Random Pools” of values as described in detail later 
on.

Initial velocity is determined by the setting of the Velocity Mode, and how hard the notes are played when providing input 
notes. For example, if Velocity Mode was set to “Constant” and Velocity Value to “124,” then all of the Generated Notes 
would have an Initial Velocity of 124. Playing them with a Velocity Pattern of “0 -20 -40” would produce the following 
accented velocities:

124 104 84 124 104 84 etc...

Velocity Patterns are additive to Velocity Envelopes, and are compressed to the degree that the envelope approaches zero. 
In other words, a wide Velocity Pattern will become less wide as the envelope approaches zero to prevent notes from 
disappearing.

Velocity Patterns may be scaled by the “Velocity Scale” parameter, yielding precise control over how a Velocity Pattern 
affects an instrument, and additional variations.

A Velocity Pattern will loop as long as note generation continues. It normally will not reset to the beginning of the Pattern 
unless a new Trigger is received, or the Phase Page has been configured to restart it at the beginning of certain Phases by 
using the [pr] (pattern restart] buttons. This means that a four step Note Pattern can be looping while an eight step 
Velocity Pattern and a twelve step Cluster Pattern are also independently looping, for example.

<Global>
Velocity - Global Parameters
 

<0263>
    [Velocity Mode] (popup menu) [0...2]

Controls how the actual velocities of the notes received as input source material affect the velocities of the notes as they 
are generated. The fields next to the popup menu can change depending on the mode specified here, and have different 
functions as described below.

    When the Velocity Mode is 0: Actual or 1: Average, the Velocity Range Bottom/Top parameters are available. When 
the Velocity Mode is 2: Constant, the Velocity Value parameter is available.

0: Actual    - Set Bottom/Top Range
The actual velocities received are used as the “Initial Velocity” for each note as they are generated. Loud notes (and their 
generated counterparts) will play loud, and vice versa. The Velocity Range Bottom and Top parameters will become 
available to the right of the popup menu, allowing you to scale the amount of sensitivity.

1: Average   - Set Bottom/Top Range
The notes received as input have their velocities averaged, and this is then used as the Initial Velocity at which to 
generate notes. The Velocity Range Bottom and Top parameters will become available to the right of the popup menu, 
allowing you to scale the amount of sensitivity. 
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Using this mode allows the velocities received as input to control the overall volume of the resulting effect. For example, 
you might use this mode so that playing chords hard made the strumming of a guitar a bit louder overall, but where the 
resulting velocities in each cluster are the same.

2: Constant   - Set Value
The velocities of the notes received as input are ignored; the Velocity Value parameter becomes available to the right of 
the popup menu and specifies directly the Initial Velocity value at which to generate the notes.
<0264>

    [Velocity Value] (numerical) [1...127]

Sets the Initial Velocity value at which to generate notes. For example, entering “124” will generate all notes with an 
Initial Velocity of 124. The Pattern Values and Velocity Scale are then factored in to yield the actual generated velocities.

    Not available unless Velocity Mode is set to 2: Constant.
<0279><0280><0281>

    [Velocity Range Bottom] (numerical) [1...127]
    [Velocity Range Top] (numerical) [1...127]

Sets the overall velocity sensitivity range for input notes, which yields the Initial Velocity to which the Pattern Values 
and Velocity Scale is applied. Setting Bottom/Top to 1/127 will provide full sensitivity (any input note with a velocity of 
1~127 will go into KARMA as played). Moving the bottom value up decreases the overall sensitivity while making the 
notes gradually louder - for example, with a setting of 64/127, an input velocity of 64 would enter KARMA as 96 
(velocities in the range 1~127 are scaled into the range 64~127, or 50% louder). Moving the top value down decreases 
overall sensitivity while making the notes gradually softer - for example, with a setting of 1/64, an input velocity of 64 
would enter KARMA as 32 (velocities in the range 1~127 are scaled into the range 1~64, or 50% softer).

    Setting the two values to the same value creates a constant value, and would be the same as using Velocity Mode = 2: 
Constant. For example, setting the Mode to Average with a range of 64/64 is the same as Constant with Velocity Value = 
64.
<0278>

    [Randomize] (range bar) [-12...+12]
    [Randomize Bottom] (RT Parm) [-12...+12]
    [Randomize Top] (RT Parm) [-12...+12]

Sets a range of randomization to be applied to each note’s velocity as it is generated. Note that this can be used to make 
the velocity of each note in a cluster slightly different, while using the Velocity Pattern to generate random velocities 
applies to each cluster as a whole. Useful for more human sounding effects, with less machine-like precision.

    Not affected by the Performance’s Random Seeds parameters. 

    The “Randomize Bottom” and “Randomize Top” settings allow this parameter to be controlled via RT Parms for 
real-time control. The range bar is not directly accessible through RT Parms.

<PatGrid>
Velocity - Pattern Grid & Associated Parameters
 

<0274><0273>
    [Pattern Grid] [16 rows x 32 steps]

A Velocity Pattern subtracts certain amounts from the initial velocity value specified by the Velocity Mode as discussed 
above, thereby creating accents in the notes that are being generated. It is important to note that the reason the pattern 
operates with negative, subtractive values rather than absolute positive values is so that it can be applied to the actual 
initial velocities of the input source material, thereby superimposing a pattern of accents while not destroying already 
existing velocity nuances (if desired). 

A Velocity Pattern may have any number of steps up to 32, and loop independently of other patterns being used at the 
same time. Each step is represented by one column on the grid. As shown above, unused columns will appear disabled; 
clicking on a disabled column inserts a value into it and any other disabled columns between it and the last column in use. 
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The first column must always contain at least one value. From the top, the 16 rows represent increasing amounts of 
velocity offsets to be subtracted from the Initial Velocity of the input notes (as determined by the Velocity Mode). Note 
that a Pattern with a single value in a single column is functionally equivalent to many columns each containing the same 
value. For general information on working with the various Pattern Editing Grids, see Using The Pattern Editing Grids.
<UseGrid>

More than one value can be entered in any given column (by using the [shift] key), which then becomes a “random pool” 
from which choices will be made at random, subject to the use of a weighting curve as described later on. The weighting 
curve becomes available when there is at least one random pool selected. The example above shows a syncopated pattern 
where accents (values of 0) are interleaved with choices from pools of three possible subtractive values. Whether or not 
the random choices will be different each time through the Phase is controlled in the Phase Page; you can choose to repeat 
the same random sequence a number of times or always generate new random sequences of choices.

Also controlled in the Phase Page is whether or not the Velocity Pattern will start from the beginning each time a Phase 
starts, by using the [pr] (pattern restart) row. For example, assume the pattern contained ten items and a Phase only 
used eight of them before changing to a different Phase. If the pattern was not set to restart in the Phase Page, then the 
second time through the same Phase it would pick up where it left off: at the 9th value of the pattern. For information on 
both restarting the pattern and repeating random sequences, see Phase Page - Phase Activity Grid (General). 
<PhsEd/PhsGrid><0275>

    [Velocity Scale] (numerical) [-999...+999%]

Sets a percentage by which the chosen Velocity Pattern is scaled before being applied. Notes can be made to disappear or 
drop out using large positive values; large negative values with a very soft initial velocity can create interesting 
“reversed” effects.

Note that this can be used to “increase the resolution” of the Velocity Pattern Grid; for example, at 100% the offsets 
match the values displayed on the vertical axis; at 50% the offsets would be divided by two, for a difference of four 
between each row rather than eight and an overall range of 0 ~ -60; at 25% the offsets would be divided by four for a 
difference of two between each row and an overall range of 0 ~ -30. Conversely, at 200% the offsets would be multiplied 
by two, for a difference of sixteen between each value and an overall range of 0 ~ -240, meaning that some notes will 
drop out and leave “holes” in the sequence of notes (since any note with a velocity less than 1 is ignored).

    Not available if GE Type = “Generated - Drum.” Each pattern in the Drum Pattern Page has a separate Velocity Scaling 
parameter.
<0276>
    [Advance Mode] (popup menu) [0...4]

Determines whether the Velocity Pattern will use its own index to move through the pattern or lock to another pattern’s 
index. A Velocity Pattern has an associated index that moves through the pattern and dictates the current step to be used. 
The LED Tracker Arrays show the current step and chosen value during operation. The Advance Mode parameter controls 
one of several methods of operation:

0: Independent - 1 step per Rhythm Event
Each time the Rhythm Pattern determines it is time to generate a note or cluster of notes, a value will be chosen from the 
current step of the Velocity Pattern, after which the index will be advanced to the next step of the Velocity Pattern. The 
index will therefore advance through the pattern without skipping any steps, and upon reaching the end, loop back to the 
beginning. If using Drum Patterns and the [ve] (use velocity pattern) buttons are turned on in the Phase Activity Grid 
(Drums), each Drum Pattern maintains a separate index into the Velocity Pattern that advances 1 step for each note, but 
does not advance for any rests in the Drum Pattern. Therefore, if the Drum Patterns have different rests in different 
places, it is possible for the Velocities they are selecting to be from different steps of the Velocity Pattern.

1: Lock (R) - Lock To Rhythm Pattern & Ties
The Velocity Pattern will “lock” to the Rhythm Pattern, by essentially using the Rhythm Pattern’s index. This is useful 
when the Rhythm Pattern has been set to include random ties. For example, if the Rhythm Pattern has 16 steps including 
random ties, creating a 16 step Velocity Pattern and using this mode assures that when the Rhythm Pattern “skips” a 
step (due to a random tie occurring), the Velocity Pattern will skip the same step. If the patterns are of unequal length, 
the index will be wrapped around to a valid location. If using Drum Patterns and the [ve] (use velocity pattern) buttons are 
turned on in the Phase Activity Grid (Drums), each Drum Pattern will select velocities from the same step at the same 
time, regardless of any rests in the Drum Patterns.

2: Lock (D1) - Lock To Drum Pattern 1
3: Lock (D2) - Lock To Drum Pattern 2
4: Lock (D3) - Lock To Drum Pattern 3
The Velocity Pattern will “lock” to the selected Drum Pattern, by essentially using the selected Drum Pattern’s index. 
The only time this is any different than Lock (R) is when the Rhythm Pattern contains Random Ties. If you want the 
Velocity Pattern values to be selected in a linear fashion, one after the other, and not skip over certain steps of the 
pattern, you can lock to one of the Drum Patterns. If the Drum Pattern and Velocity Pattern are of unequal length, the 
index will be wrapped around to a valid location. Note that a rest in the Drum Pattern will still advance the index, unlike 
“Independent” above. Therefore, if all three Drum Patterns are in use, locking to any one of the three will produce 
identical results, other than taking the length of the Drum Pattern into consideration.
<0277>

Page 247



    [Cluster Mode] (popup menu) [0...1]

0: Single - 1 Step Per Cluster
Each time a note, cluster of notes, or group of drum notes is generated one Velocity Pattern Value will be chosen for the 
current step, after which the Velocity Pattern advances to the next value. For example, a cluster of six notes will all be 
generated with the same velocity and advance the Velocity Pattern by one to the next step. This is useful for creating 
very noticeable “accented patterns” within effects using large clusters of notes such as gated techno effects. The LED 
Tracking Arrays will display one value at a time.

1: Multi - 1 Step For Each Note In Cluster
For every note in a cluster or group of drum notes generated simultaneously, a separate Velocity Pattern Value will be 
chosen after which the Velocity Pattern advances to the next value. For example, a cluster of six notes will be generated 
with the next six Velocities indicated by the pattern, with a net advance of six steps. This means that each note in a 
cluster or each note of a drum pattern that is generated simultaneously can be given its own velocity. This is useful for 
more subtly shifting accents within clusters of notes, and adding more human-like velocity randomness to drum patterns. 
The LED Tracking Arrays will display the number of values chosen depending on the current cluster size, as shown in the 
example above.

Note that when using Drum Patterns with Velocity Patterns and watching the LED Tracking Arrays, you may be watching 
up to three indexes displayed at the same time!

    When the GE Type is “Generated - Riff,” setting this to “Multi” will have no effect unless there is a Cluster Pattern 
containing values of more than just one. When the GE Type is “Generated - Gated,” the number of notes being generated is 
considered the Cluster Size, and setting this to “Multi” will cause the pattern to advance by the number of notes being 
generated.

    When the GE Type is “Generated - Drum,” setting this to “Multi” will have no effect unless at least one Drum Pattern 
has the [cl] (use cluster pattern) button turned on in a Phase Pattern step in the Phase Page and there is a Cluster Pattern 
containing values of more than just one, or more than one drum note is being generated at a time (by using Drum Patterns 
in “Poly” mode).

    If you have a single Drum Pattern in “Poly” mode, you will be generating more than one drum note simultaneously 
from that Pattern at a time. This is also considered a “Cluster/Group” by the Velocity, Note and Pan Patterns; therefore, 
even if you do not have the [cl] (use cluster pattern) buttons turned on in the Phase Page, setting the Pattern Advance 
Mode to “Multi” will cause each note to advance the Velocity Patterns and get a different value because more than one 
drum note is being generated at a time. For example, if at a particular moment a kick, hi-hat and cowbell are generated at 
the same time from a single Drum Pattern, the Velocity Pattern will give them three different values and advance the 
pattern by three if the Pattern Advance Mode is set to “Multi;” if set to “Single,” then all three notes will get the same 
velocity, and the pattern will only advance by one.

    Even if the Pattern Advance Mode is set to “Single,” if using more than one Drum Pattern simultaneously, it is 
possible to generate different Velocity Values at the same time. This is because each Drum Pattern maintains its own 
separate index into the Velocity Pattern; if the Drum Patterns have rests in them at different places, the indexes will be 
“out of sync” with each other and choose different steps of the Pattern. This will be visible in the Velocity Page Tracking 
LEDs and the Data Display Window.

<RandPool><0270><0272>
Velocity - Random Weighting Parameters
 

The Random Weighting Parameters are made available when at least one step (column) in the Velocity Pattern Grid 
contains multiple buttons turned on (constituting a “random pool” of values). Whenever a random pool is encountered in 
playing through the pattern, a random choice is made from the values in that step. Certain areas of the random pool can be 
favored by the use of a weighting table, with various shaped curves. Using the curves, you can influence certain choices 
to be made more or less often than others, allowing very musical real-time control of the randomness.

Whether or not a certain random sequence will repeat for a number of times is controlled by the [nr] (new random 
sequence) buttons in the Phase Page. See Phase Page - Phase Activity Grid (General).
<PhsEd/PhsGrid><0268>
    [Weighting Curve] (popup menu) [0...3]

Selects one of four different curves that act to favor certain areas of the pool over others when each random choice is 
made. Next to the Weighting Curve menu, a small graphic displays the actual shape of the chosen curve based on the 
setting of the “Factor” field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top 
will favor values towards the top of the columns in the grid. For a more complete discussion of the various shapes and 
how the Factor influences the choices, see the Appendix Random Weighting Curves.
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<RandCurves> 

0: Exponential
With a positive Factor (+), choices will be exponentially weighted towards the louder velocities (pool values higher in the 
grid column). With a negative Factor (-), choices will be exponentially weighted towards the softer velocities (pool values 
lower in the grid column).

1: Logarithmic
With a positive Factor (+), choices will be logarithmically weighted towards the louder velocities (pool values higher in 
the grid column). With a negative Factor (-), choices will be logarithmically weighted towards the softer velocities (pool 
values lower in the grid column).

2: Exp-S (Exponential S)
With a positive Factor (+), choices will be exponentially weighted towards the middle velocities (pool values towards the 
center of each pool), and away from the softer and louder velocities. With a negative Factor (-), choices will be 
exponentially weighted towards the softer and louder velocities (pool values lower and higher in the grid column), and 
away from the middle velocities.

3: Log-S (Logarithmic S)
With a positive Factor (+), choices will be logarithmically weighted towards the middle velocities (pool values towards 
the center of each pool), and away from the softer and louder velocities. With a negative Factor (-), choices will be 
logarithmically weighted towards the softer and louder velocities (pool values lower and higher in the grid column), and 
away from the middle velocities.

    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves.
<RandCurves/Compare>

    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen. A Factor of “+99” with 
either of the S-Curves yields a straight line across the middle, and only the middle value in the pool will be chosen. A 
Factor of “-99” with either of the S-Curves yields a split straight line across the bottom and top, and random choices 
between only the lowest and highest values in the pool will be chosen.

The following table summarizes the effect of the various Weighting Curves and the Factor field on the choices from the 
Velocity Pools:

 

<0269>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is either +99 or -99, the choices are “locked” to the highest or 
lowest values in the columns, and there are no random choices at all. (The only exception to this is an S-shaped curve 
with a value of -99. In this case, a random choice will be made between the highest and lowest values only.)

<Template>
Velocity - Template Management
 

Certain of the parameters in the Velocity Page can be saved as a “Template.” This can be useful for Templates that you 
use often, or that you like to use as a starting point for further experimentation, or to maintain a library of Templates. 
Furthermore, Templates can be switched in real-time when they are assigned as RT Parms, causing radical changes in 
what is being generated.

What is saved in a Velocity Pattern Template:
- the configuration of the Pattern Editing Grid;
- the Random Weighting Parameters (Weighting Curve and Factor).

There can be more than one bank of Templates in a KDF File. Each GE stores a reference to which Bank it is using, which is 
set by the Template Bank parameter in the GE Editor. All Templates used in a GE must come from the same bank - for 
example, you cannot use Rhythm Templates from one bank and Index Templates from another at the same time.

    When a Template is selected and loaded via RT Parm control, the Weighting Curve and Factor will remain as presently 
set if the Weighting Curve or Factor is also assigned as an RT Parm. In other words, a Weighting Curve and Factor are 
stored as part of the Template, but if they are under RT Parm control, their current settings are not replaced when the 
Template is loaded.
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<0282>
    [Open Template Bank] (button)

Opens a Template Bank Display Window for the current bank of Velocity Pattern Templates.
<0265>
    [Template] (popup menu) [0 = [As Stored], 1...63]

Selects from 63 different Velocity Pattern Templates (shared by both Phase 1 and 2), and loads the parameters into the 
current Phase’s Editing Area.

Selecting Template 0 (which is always named [As Stored] and cannot be overwritten) reloads the stored internal settings 
of the GE for the parameters corresponding to the template. In other words, you can have a complex pattern set up on the 
grid, select one or more Templates, thereby completely replacing it, and then return to the original settings by selecting 
[As Stored].

When selected by the mouse using the popup menu, the [As Stored] selection is always available. When the Template is 
being controlled as a Real-Time Parameter, there are two different options available:

Template [1...63]
The internal settings of the GE for the set of parameters corresponding to the chosen Template are never used; rather 
they are always replaced by one of the selected Templates from within the Min/Max range specified for the RT Parm. In 
this case, available range is 1~63, and it is not possible to select 0: [As Stored].

Template + Restore [0...63]
Similar to the above setting; however, the internal settings of the GE can be restored and used as part of the real-time 
Template operation. In this case, the Min setting of the Template Range actually does not select that Template; rather, it 
causes the internal settings of the GE to be restored for that Template’s set of parameters. In other words, you can have 
a complex pattern already set up on the grid. Using “Template + Restore” as a GE RT Parm, you specify a range where 
the Min value restores the internal settings, and the rest of the range selects Templates, replacing the internal settings. 
So if the Min value was 5 and the Max value was 10, choosing 5 would restore the internal settings (the same as selecting 
“0 [As Stored]”), and 6 through 10 would select the corresponding Template. You can use this to keep the internal 
settings of the GE, while still allowing a wide variety of Templates to be substituted for various groups of parameters. In 
this case, the available range is 0~63. You can assign the full range of all 63 Templates, or only a portion of the range, 
and still have the ability to restore the original internal settings.

    When a GE is first loaded, the Template popup will always display “As Stored.” If you select a Template, the popup 
menu will display the name of the Template, but after you save the GE and load it again, it will once again display “As 
Stored.” This is because the Template value is not saved in the GE, but the contents of the Pattern Grid and associated 
parameters are.
<0266>
    [Save] (button)

Brings up a Save Dialog allowing you to name the Template and save it in memory in the current Template Bank. After 
saving a Template, it will then be available in the Template popup menus for both Phases. 
<OthDlg/Sbs><0267>
    [Clear] (button)

Brings up a dialog allowing you to clear the selected Template from the current Template Bank. You will be given an 
opportunity to cancel. After clearing, the Template will disappear from the Template popup menus for both Phases.

    Saving or clearing only affects the Templates in RAM. To save these changes to disk, you must save the KDF File by 
choosing “Save,” “Save As…” or “Save All…” from the File menu.

    Since the changes are not written to disk until one of the Save commands is executed, to undo a change after you have 
stored or cleared a Template you can close and reopen the current KDF file.
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CCs (Part 1)
Sections in this chapter:

Overview<PanEd/Over>

About CC/Bend Patterns<PanEd/About>

Global Parameters<PanEd/Global>

Pattern Grid & Associated Parameters (CC/Bend)<PanEd/PatGrid>

Random Weighting Parameters (CC/Bend)<PanEd/RandPool>

Sections in Part 2:<POffEd>

Overview (Pitch Offsets)<POffEd/Over>

About Pitch Offset Patterns<POffEd/About>

Pattern Grid & Associated Parameters (Pitch Offsets)<POffEd/POffGrid>

Random Weighting Parameters (Pitch Offsets)<POffEd/RandPitch>

Template Management<POffEd/Template>

 

<Over>
CCs - Overview
The CCs Page allows the editing of parameters that control generation of CC (MIDI Control Change) messages. For 
example, this can control the panning (CC 10) of the notes in the Generated Effect (stereo placement left to right). Any 
other CC data may also be generated to control any MIDI controllable characteristic of your synthesizer, such as 
resonance, filter frequency, vibrato, etc. You may also use the CC Pattern to generate stepped Pitch Bend messages, 
technically not a “CC.” 

    In one special case, you can use the CC Pattern to transpose notes, which has nothing to do with CCs or stepped Pitch 
Bend. Most of the time, the CCs Page will show the CC/Bend Phase Specific Parameters as shown in the above picture, for 
both Phase 1 and Phase 2. The only exception is when the Phase Mode = “CC-A Both Phases, Pitch Offsets.” In that case, 
Phase 2 becomes a 64 step Pitch Offset Pattern that will be applied as Transpose Values to each note as it is generated. 
This can be used to simulate the Korg Triton Arpeggiator Pitch Offset value for each step, or generate other unique 
effects. This is discussed in the following chapter CCs Page (Part 2). 
<POffEd>

Global Parameters
Parameters that affect CC or Pitch Bend generation during playback of either Phase in a Generated Effect.

Phase Specific Parameters
An identical group of parameters for each Phase that affect the note generation characteristics during playback of that 
Phase only. For more on Phases, see the Phase Page. 
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<PhsEd><0284>

Phase Selection Buttons
Selects which Phase (a separate collection of the Phase Specific Parameters) to display and edit.

Pattern Grid
Allows CC/Bend Patterns to be constructed in various ways, which then control how the CC or Pitch Bend information is 
generated.

Random Weighting Parameters
Parameters that allow weighting curves to be applied to any random pools (more than one value in a column) which may 
have been created in the Pattern Grid.
<0297>

LED Tracking Arrays
Rows of gray dots along the horizontal and vertical axes of the pattern grid, with one or more green dots displaying the 
currently chosen index (column) and CC/Bend value 0~127 (row).

Template Management
Allows the contents of the Pattern Grid(s) and certain associated parameters to be saved as a “Template.” It will then 
appear in the popup menu for future use when creating/editing CC Patterns. Selecting a Template from the menu loads it 
into the Pattern Grid and associated parameters.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy Phases...<GEUtils/Pco>

Turn Pitch Offsets On In All Steps Of Phase Pattern
Turn Pitch Offsets Off In All Steps Of Phase Pattern
    Not available unless using Pitch Offsets. See CCs Page (Part 2). <POffEd/Menu>
<0291>
 

    If settings in the Phase Page indicate a particular Phase is not being used, the Phase Specific Parameters will not be 
available for that Phase. The message “Phase Not In Use” will be displayed near the Phase Selection Buttons. 

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><About>
CCs - About CC/Bend Patterns
A value derived from a CC/Bend Pattern is a MIDI Control Change value from 0 ~ 127 (or Pitch Bend if selected). The 
values are sent out as each note or cluster of notes is generated. Choices can be made from “Random Pools” of values as 
described in detail later on. Pitch Offsets are different and are discussed in the next chapter: About Pitch Offset Patterns.
<POffEd/About>

If the selected CC is 10 (Pan) for example, a CC Pattern such as {0 127} would cause every other note to pan to the 
opposite side of the stereo spectrum. A CC Pattern of {0 0 0 0 127 127 127 127} would play four notes left, then four 
notes right. A CC Pattern may be inverted any time (caused to go in the opposite direction, 127 ~ 0) by using the 
“Polarity” Parameter, which is an easy way to reverse the direction of the pattern without redrawing it.

Note that if your synthesizer does not respond to the particular CC data being generated, CC Patterns will have no effect. 
For example, on some synthesizers it is not possible to Pan Drum Programs.

A CC Pattern will loop as long as note generation continues. It normally will not reset to the beginning of the Pattern 
unless a new Trigger is received, or unless the Phase Page has been configured to restart it at the beginning of certain 
Phases by using the [pr] (pattern restart) buttons. This means that a four step CC Pattern can be looping while an eight 
step Velocity Pattern and a twelve step Cluster Pattern are also independently looping, for example.

There are two different CCs (CC-A and CC-B) or Pitch Bend that may be selected in the Global Parameters section 
(described below). The Phase Mode controls which Phase’s Pattern grid applies to which CC.

<Global>
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CCs - Global Parameters
 

The parameters in this section affect CC, Pitch Bend or Pitch Offset generation during playback of either Phase in a 
Generated Effect.
<0285>
    [Phase Mode] (popup menu) [0...5]

Specifies several ways that two different CCs or Pitch Bend (chosen below) will be generated, with regards to the two 
different Phases of a GE. The last option allows the Phase 2 Pattern to become a 64 step Pitch Offsets Pattern. See About 
Pitch Offset Patterns.
<POffEd/About>

0: CC-A In Both Phases
The selected CC (or Pitch Bend) in the CC-A menu will be sent all the time, in both Phase 1 and Phase 2, according to the 
selected Pattern and Type. During Phase 1, the Phase 1 Pattern and Type will be used to send CC-A, and during Phase 2 
the Phase 2 Pattern and Type will likewise be used to send CC-A. CC-B will not be sent at any time. 

1: CC-B In Both Phases
The selected CC (or Pitch Bend) in the CC-B menu will be sent all the time, in both Phase 1 and Phase 2, according to the 
selected Pattern and Type. During Phase 1, the Phase 1 Pattern and Type will be used to send CC-B, and during Phase 2 
the Phase 2 Pattern and Type will likewise be used to send CC-B. CC-A will not be sent at any time. 

2: Alternate (CC-A Phase 1, CC-B Phase 2)
During playback of Phase 1, CC-A will be generated; during playback of Phase 2, CC-B will be generated. For example, if 
CC-B [18]* Slider in the example above was controlling filter frequency, then the phases would switch between sending 
pan data and controlling filter frequency. Therefore, the Phase 1 CC Pattern and parameters are associated with CC-A; 
the Phase 2 CC Pattern and parameters are associated with CC-B.

3: Split (CC-A Phase 1, CC-B Phase 2, simultaneously)
The Phase 1 CC Pattern and parameters are associated with CC-A; the Phase 2 CC Pattern and parameters are associated 
with CC-B. However, they generate CC data simultaneously, ignoring the Phase Pattern settings. For example, this means 
the Pattern Grid in Phase 1 can be used to generate a complex CCs Pattern, at the same time that the Pattern Grid in 
Phase 2 can be used to generate a completely different complex pattern to control resonance or filter frequency. The 
switching of Phases which normally occurs according to the Phase Pattern is ignored, and they both generate data for 
their associated CC (or Pitch Bend) simultaneously, all the time.

4: Both (CC-A & CC-B simultaneously)
The two selected CCs (or Pitch Bend) are controlled in tandem. The Phase Pattern switching of Phases is used as normal, 
but both CC-A and CC-B are sent out simultaneously as specified by the Pattern and Type (with the same values). For 
example, you can set up a complex pattern in Phase 1, and a different complex pattern in Phase 2, and let the Phase 
Pattern control switching between them. Both CC-A and CC-B data will be generated for each note or group of notes. In 
other words, with the above example settings, every time a CC 10 Pan Value is sent the same Value will be sent as CC 18 
Slider.

5: CC-A Both Phases, Pitch Offsets
Selecting this mode causes the Phase 2 CC/Bend Pattern Grid to be replaced with a 64 Step Pitch Offsets Pattern, 
described in the next chapter. Pitch Offsets are transpose values that are applied to each step of the pattern (notes or 
clusters) as they are generated, thereby transposing the MIDI pitches of the notes. This can be used to simulate the Korg 
Triton Arpeggiator among other unique effects. In this case, it operates similar to “3: Split” above, in that the Phase 
switching controlled by the Phase Pattern is ignored. The CC specified in the CC-A menu is generated all of the time 
according to the Pattern and Type setup in the Phase 1 parameters. The Pitch Offset Pattern in the Phase 2 section of the 
Page is simultaneously generated/applied with no regard for the changing of Phases, and CC-B will not be sent at any 
time.

    When you change from any other Mode setting to “5: CC-A Both Phases, Pitch Offsets” or vice versa, you are 
actually reconfiguring internally the data for the Phase 2 Grid. Therefore, you will be given a warning dialog and a chance 
to cancel the operation. Answering “OK” erases any data that may be in the Phase 2 Pattern Grid and initializes it for the 
new configuration.
<0286><0287>
         [CC-A] (popup menu) [-1...+126]
    [CC-B] (popup menu) [-1...+126]

-1: Off
0...125: MIDI CC Messages
126: Pitch Bend
Selects one of 125 MIDI Control Change Messages supported by the MIDI specification, in addition to Pitch Bend (in the last 
position of the popup menu). This CC (or Pitch Bend) will be generated according to the setting of the Phase Mode popup 
menu above.
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�    Even if CC-A and CC-B are configured properly, you may not be hearing any effects if the MIDI Filter parameters have 
been set to filter out the generation of that CC. See MIDI Filter Page - Generated Data Parameters. 

<FilEd/FiltGen><PatGrid>
CCs - Pattern Grid & Associated Parameters (CC/Bend)
 

The parameters in this section are an identical group of parameters for each Phase that affect the note generation 
characteristics during playback of that Phase only. They will be different, however, in Phase 2 if the Phase Mode is set to 
“5: CC-A Both Phases, Pitch Offsets.”
<0299><0300>

    [Pattern Grid] [32 rows x 64 steps]

A CC Pattern represents a series of values indicating a MIDI Control Change (or Pitch Bend) value to be generated. The 
particular controller is selected according to the parameters in the Global area (described above). It may have any number 
of steps up to 64, and loop independently of other patterns being used at the same time. Each step is represented by one 
column on the grid. As shown above, unused columns will appear disabled; clicking on a disabled column inserts a value 
into it and any other disabled columns between it and the last column in use. The first column must always contain at least 
one value. Each row represents a CC or Pitch Bend value in multiples of four (0, 4, 8, 12 etc.). Note that a pattern with a 
single value in a single column is functionally equivalent to many columns each containing the same value. For general 
information on working with the various Pattern Grids, see Using The Pattern Grids.
<UseGrid>

More than one value can be entered in any given column (using the [shift] key), which then becomes a “random pool” from 
which choices will be made at random, subject to the use of a weighting curve as described later on. The weighting curve 
becomes available when there is at least one random pool selected. If CC 10 (Pan) was being sent, the example above 
shows a pattern where the first 8 notes will get random values chosen from 12 positions extending from the right (127) 
towards the center. The next 8 values will be randomly chosen from 12 positions extending from the left (0) towards the 
center; the next 16 values will perform a right to left “sweep.” Whether or not the random choices will be different each 
time through the Phase is controlled in the Phase Page; you can choose to repeat the same random sequence a number of 
times or always generate new random sequences of choices. The special bottom row (“inv”) indicates whether or not to 
invert the Random Weighting Curve (discussed later on). See Weighting Curve Inversion Row
<PanEd/InvRow>

Also controlled in the Phase Page is whether or not the CC Pattern will start from the beginning each time a Phase starts. 
For example, assume the pattern contained ten items and a Phase only used eight of them before changing to a different 
Phase. If the pattern was not set to restart in the Phase Page, then the second time through the same Phase it would pick 
up where it left off: at the 9th value of the pattern. For information on both restarting the pattern and repeating random 
sequences, see Phase Page - Phase Activity Grid (General)
<PhsEd/PhsGrid>

    Pattern Grid not available if the CC Mode parameter is other than “Pattern,” or the Fixed/On parameter is other 
than “128.”

    If the CC Pattern does not look like the above example in terms of available parameters or layout, you may be looking 
at Phase 2 with a Pitch Offsets Pattern. See CC Page (Part 2).
<POffEd><0288>
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   [Fixed/On] (numerical) [0...128]

Allows the CC/Bend Pattern to be overridden with a fixed value. When set to “128,” the Pattern Grid becomes available, 
and the CC/Bend Pattern is sent out. When set to any other value, a single CC or Pitch Bend value corresponding to the 
fixed value is sent, and the Pattern Grid becomes grayed out. If assigned as an RT Parm, this can allow you to “sweep” a 
controller manually and then return it to being automatically generated by the pattern.

    Not available in Phase 2 when Pitch Offsets are being used.
<0289>
    [CC Mode] (popup menu) [0...5]

When “Pattern” is selected, the Pattern Grids will be used to generate the assigned CC/Bend. The “Index” options allow 
the data to be generated based on the position of the index in the Note Series from left to right.

0: Pattern
The Pattern Grid described above will be available and operate as described.

1: Index to 0 <->127 (scales Note Series Indexes into CC values 0 ~ 127).
The index of the note in the Note Series (about to be generated) is compared to the minimum and maximum indexes that 
will be generated according to the current settings and scaled into a value from 0 ~ 127 so that the first index to be used 
generates 0 and the last 127, with indexes in between being scaled accordingly. The “Polarity” button can invert this for 
the opposite effect (127 ~ 0). Can be useful for simulating stereo miking of an instrument like a piano or harp (with Pan 
data), or for simply tracking the movement of the indexes with any other CC data. The Pattern Grid described above will 
not be available.

2: Index to 24 <->108 (scales Note Series Indexes into CC values 24 ~ 108).
3: Index to 32 <->  96 (scales Note Series Indexes into CC values 32 ~ 96).
The same as above, except scales the indexes into other smaller (less wide) ranges that are centered.

4: Index to   0 <->  64 (scales Note Series Indexes into CC values 0 ~ 64).
5: Index to  64 <->127 (scales Note Series Indexes into CC values 64 ~ 127).
The same as above, except scales the indexes into other ranges. For example, if used with CC 10 Pan data, would be left 
to center or center to right.

    Not available in Phase 2 when Pitch Offsets are being used.
<0292>

    [Scale Min/Max] (numericals) [0...127]

Allows the CC Messages to be scaled into a smaller or different range. For example, if the grid has a full range of values 
sweeping from 0 to 127, a Min/Max setting of 32/96 would compress the resulting CCs into a sweep from 32 to 96. You 
can use this to scale a full range pattern into a smaller range, or a different section of the range. Setting the Minimum 
higher than the Maximum inverts the pattern, the same as the Polarity setting below.
<0290>

           [Polarity] (button) [Off (+), On (-)]

Reverses the polarity of the CC Pattern (causing it to produce inverted values, where 0 ~ 127 becomes 127 ~ 0). This is 
an easy way to reverse the direction of the pattern without redrawing it.

Regular (+)
The CC Pattern is sent out as originally created.

Inverted (-)
The CC Pattern is inverted; i.e. 0 is sent out as 127, 127 is sent out as 0, 96 is sent out as 32, etc. This allows the same 
pattern to be used in two different directions.
<0302>
    [Advance Mode] (popup menu) [0...4]

Determines whether the CC Pattern will use its own index to move through the pattern or lock to another pattern’s index. 
A CC Pattern has an associated index that moves through the pattern and dictates the current step to be used. The LED 
Tracker Arrays show the current step and chosen value during operation. The Advance Mode parameter controls one of 
several methods of operation:

0: Independent - 1 step per Rhythm Event
Each time the Rhythm Pattern determines it is time to generate a note or notes, a value will be chosen from the current 
step of the CC Pattern, after which the index will be advanced to the next step of the CC Pattern. The index will therefore 
advance through the pattern without skipping any steps, and upon reaching the end, loop back to the beginning. Unlike 
Velocity and Cluster Patterns, the Drum Patterns share a single index into the CC Pattern, so it is not possible to be at 
different steps in the CC Pattern for each Drum Pattern.

1: Lock (R) - Lock To Rhythm Pattern & Ties
The CC Pattern will “lock” to the Rhythm Pattern, by essentially using the Rhythm Pattern’s index. This is useful when 
the Rhythm Pattern has been set to include random ties. For example, if the Rhythm Pattern has 16 steps including random 
ties, creating a 16 step CC Pattern and using this mode assures that when the Rhythm Pattern “skips” a step (due to a 
random tie occurring), the CC Pattern will skip the same step. If the patterns are of unequal length, the index will be 
wrapped around to a valid location.
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2: Lock (D1) - Lock To Drum Pattern 1
3: Lock (D2) - Lock To Drum Pattern 2
4: Lock (D3) - Lock To Drum Pattern 3
The CC Pattern will “lock” to the selected Drum Pattern, by essentially using the selected Drum Pattern’s index. The 
only time this is any different than Lock (R) is when the Rhythm Pattern contains Random Ties. If you want the CC Pattern 
values to be selected in a linear fashion, one after the other, and not skip over certain steps of the pattern, you can lock 
to one of the Drum Patterns. If the Drum Pattern and CC Pattern are of unequal length, the index will be wrapped around to 
a valid location. Note that a rest in the Drum Pattern will still advance the index, unlike “Independent” above. Therefore, 
if all three Drum Patterns are in use, locking to any one of the three will produce identical results, other than taking the 
length of the Drum Pattern into consideration.

<RandPool><0296><0298>
CCs - Random Weighting Parameters (CC/Bend)
 

The Random Weighting Parameters are made available when at least one step in the CC Pattern Grid contains multiple 
buttons turned on in the upper 31 Value rows (constituting a “random pool” of values). Whenever a random pool is 
encountered in playing through the pattern, a random choice is made from the values in that step. Certain areas of the 
random pool can be favored by the use of a weighting table, with various shaped curves. Using the curves, you can 
influence certain choices to be made more or less often than others, allowing very musical real-time control of the 
randomness.

Note that CCs Patterns differ slightly from the other patterns in that there is a special “Inversion” row at the bottom of 
the grid. This row is only active in any particular column when a pool exists in that column; when turned on, it allows the 
weighting curve to be inverted for that particular pool (column). This is discussed in more detail at the end of the 
following section. 

Whether or not a certain random sequence will repeat for a number of times is controlled in the Phase Page. See Phase 
Page - Phase Activity Grid (General).
<PhsEd/PhsGrid><0294>
    [Weighting Curve] (popup menu) [0...3]

Selects one of four different curves that act to favor certain areas of the pool over others when each random choice is 
made. Next to the Weighting Curve Menu, a small graphic displays the actual shape of the chosen curve based on the 
setting of the “Factor” field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top 
will favor values towards the top of the columns in the grid (except when the Weighting Curve Inversion Row buttons are 
turned on, explained at the end of the following section). For a more complete discussion of the various shapes and how the 
Factor influences the choices, see the Appendix Random Weighting Curves.
<RandCurves> 

0: Exponential
With a positive Factor (+), choices will be exponentially weighted towards the higher values (selected values higher in the 
grid column). With a negative Factor (-), choices will be exponentially weighted towards the lower values (selected values 
lower in the grid column).

1: Logarithmic
With a positive Factor (+), choices will be logarithmically weighted towards the higher values (selected values higher in 
the grid column). With a negative Factor (-), choices will be logarithmically weighted towards the lower values (selected 
values lower in the grid column).

2: Exp-S (Exponential S)
With a positive Factor (+), choices will be exponentially weighted towards the center values (values towards the center 
of the selected values), and away from the highest and lowest values. With a negative Factor (-), choices will be 
exponentially weighted towards the lowest and highest values (selected values higher and lower in the column), and away 
from the middle values.

3: Log-S (Logarithmic S)
With a positive Factor (+), choices will be logarithmically weighted towards the center values (values towards the center 
of the selected values), and away from the highest and lowest values. With a negative Factor (-), choices will be 
logarithmically weighted towards the lowest and highest values (selected values higher and lower in the column), and 
away from the middle values.

    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves.
<RandCurves/Compare>
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�    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen. A Factor of “+99” with 
either of the S-Curves yields a straight line across the middle, and only the middle value in the pool will be chosen. A 
Factor of “-99” with either of the S-Curves yields a split straight line across the bottom and top, and random choices 
between only the lowest and highest values in the pool will be chosen.

The following table summarizes the effect of the various Weighting Curves and the Factor field on the choices from the CC 
Pools:
 

<0295>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is either +99 or -99, the choices are “locked” to the highest or 
lowest values in the columns, and there are no random choices at all. (The only exception to this is an S-shaped curve 
with a value of -99. In this case, a random choice will be made between the highest and lowest values only.)
<InvRow><0301>

    [Weighting Curve Inversion Row]

CC Patterns differ slightly from the other patterns in that there is a special “Inversion” row at the bottom of the grid 
(abbreviated “inv”). This row is only active in any particular column when a pool exists in that column. When turned on, 
it allows the weighting curve to be inverted for that particular pool (column). This is mainly intended for use with CC 10 
(Pan), but can be useful with other CCs as well; the reason is for setting up pools on either side of “center” and then 
choosing inner/outer edges of those pools. For example, suppose you were using the Pattern illustrated earlier in this 
chapter as an example. The first eight steps of the pattern are pools on the right side of center; the next eight steps are 
pools on the left side of center. If you were to use an Exponential Weighting Curve with a positive value, and no Inversion 
Row buttons were turned on, then all choices would be weighted towards the tops of the pools (higher values in the 
column), with the result that choices would be made more towards the right side in the first eight steps, but then more 
towards the center in the second eight steps. Using the Inversion Row buttons on the second eight steps inverts the 
weighting curve with respect to those steps, so that choices from them will be more towards the bottom of the column 
(and the leftmost values). This makes the weighting symmetrical on both sides of center; i.e. towards the outer edges of 
the stereo field when the curve value is positive, towards the inner edges when the curve value is negative.)

For parameters related to Template Management, please see the next Chapter. <POffEd/Template>
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CCs (Part 2) - Pitch Offsets
Sections in this chapter:

Overview (Pitch Offsets)<POffEd/Over>

About Pitch Offset Patterns<POffEd/About>

Pattern Grid & Associated Parameters (Pitch Offsets)<POffEd/POffGrid>

Random Weighting Parameters (Pitch Offsets)<POffEd/RandPitch>

Template Management<POffEd/Template>

Sections in Part 1: <PanEd>

Overview<PanEd/Over>

About CC/Bend Patterns<PanEd/About>

Global Parameters<PanEd/Global>

Pattern Grid & Associated Parameters (CC/Bend)<PanEd/PatGrid>

Random Weighting Parameters (CC/Bend)<PanEd/RandPool>

 

<Over>
CCs (Pitch Offsets) - Overview
The CCs Page normally allows the editing of parameters that control generation of CC (MIDI Control Change). However, in 
one special case, the CC Pattern may also be used to specify “Pitch Offsets” that will be applied as Transpose Values to 
each note as it is generated. This can be used to simulate the Korg Triton Arpeggiator Pitch Offset value for each step, or 
generate other unique effects.

The features of the CCs Page that apply to both the normal use and this use are covered in the previous chapter. This 
chapter will only explain the differences pertaining to this special configuration.

Pattern Grids
Allows Pitch Offset Patterns to be constructed in various ways, which then control a pitch transpose value on a 
note-by-note basis.

Random Weighting Parameters
Parameters that allow weighting curves to be applied to any random pools (more than one value in a column) which may 
have been created in the Pattern Grids.
<Menu>
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Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy Phases...<GEUtils/Pco>

Turn Pitch Offsets On In All Steps Of Phase Pattern
Turn Pitch Offsets Off In All Steps Of Phase Pattern
When using Pitch Offsets, allows all of the buttons in the [po] (use pitch offsets) row(s) of the Phase Activity Grid to be 
turned on/off at once, saving you a trip to the Phase Page. The Pitch Offset Pattern will not be applied if none of these 
buttons are on, regardless of how the parameters are set. This allows you to individually apply the Pitch Offset Pattern to 
selected steps of the Phase Pattern, or to all of them.
<PhsEd/PhsGrid><1229>
 

    When none of the [po] (use pitch offset) buttons are turned on in the Phase Activity Grid (General), all of the Pitch 
Offset Parameters will be grayed out and unavailable, and the message “Not In Use In Phase Page” will appear in the 
upper right corner.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><About>
CCs - About Pitch Offset Patterns
A value derived from a Pitch Offsets Pattern is a semitone pitch transpose value of -48...+48. The transpose value is 
added to the MIDI note number of each pitch that is to be generated at that step. Choices can be made from “Random 
Pools” of values as described in detail later on.

A Pitch Offsets Pattern may be inverted any time by using the “Polarity” Parameter, which is an easy way to invert the 
direction of the pattern without redrawing it. Note that in this case it only inverts the semitone Pitch values in the upper 
25 rows of the grid, and not the octave values (which would make it go too far outside of useful ranges).

A Pitch Offset Pattern will loop as long as note generation continues. It normally will not reset to the beginning of the 
Pattern unless a new Trigger is received, or unless the Phase Page has been configured to restart it at the beginning of 
certain Phases by using the [pr] (pattern restart) buttons. This means that a four step Pitch Offset Pattern can be looping 
while an eight step Velocity Pattern and a twelve step Cluster Pattern are also independently looping, for example.

<POffGrid>
CCs - Pattern Grid & Associated Parameters (Pitch Offsets)
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The parameters in this section are specific to Phase 2 only, when the Phase Mode is set to “5: CC-A Both Phases, Pitch 
Offsets.”
<1214><1215><1216>
    [Pattern Grids] [Pitches: 25 rows x 64 steps, Octaves: 7 rows x 64 steps]

When Phase Mode is “CC-A Both Phases, Pitch Offsets,” Phase 2 (only) becomes a 64 step Pitch Offsets Pattern utilizing 
two separate linked Pattern Grids, and the Phase Specific Parameters (for Phase 2 only) are completely different, as 
shown above. 

In this case, the grid is split into two portions: the top portion (Pitches) contains 25 rows, corresponding to a Transpose 
value of –12 to +12 semitones. The bottom portion (Octaves) contains 7 rows, corresponding to a Transpose value of –3 
to + 3 octaves. By combining the two Transpose values, any offset from –48 to +48 can be achieved. The transpose value 
is added to the MIDI note number of each pitch that is to be generated at that step. This can be used to simulate the Korg 
Triton Arpeggiator Pitch Offset value for each step, in addition to many other unique effects.

The grids may have any number of steps up to 64 (both the same), and loop independently of other patterns being used at 
the same time. Each step is represented by one column on the grid. As shown above, unused columns will appear disabled; 
clicking on a disabled column inserts a value into it and any other disabled columns between it and the last column in use. 
The first column must always contain at least one value. Note that a pattern with a single value in a single column is 
functionally equivalent to many columns each containing the same value. For general information on working with the 
various Pattern Grids, see Using The Pattern Grids. 
<UseGrid>

More than one value can be entered in any given column (using the [shift] key), separately for each of the two grids, 
which then becomes a “random pool” from which choices will be made at random, subject to the use of a weighting curve 
as described later on. The weighting curves become available when there is at least one random pool selected in the grid 
associated with the Random Weighting Parameters. There are separate curves for each of the two sections of the grid, so 
that octaves can be varied independently of semitone pitches.

Also controlled in the Phase Page is whether or not the Pitch Offsets Pattern will start from the beginning each time a 
Phase starts. For example, assume the pattern contained ten items and a Phase only used eight of them before changing to 
a different Phase. If the pattern was not set to restart in the Phase Page, then the 2nd time through the same Phase it 
would pick up where it left off: at the 9th value of the pattern. For information on both restarting the pattern and 
repeating random sequences, see Phase Page - Phase Activity Grid (General).
<PhsEd/PhsGrid><1210>

    [Pitch Offsets On/Off] (button) [Off, On]

When on, the Pitch Offset pattern specified by the Phase 2 Pattern Grid is applied as transpose values to notes as they are 
generated. This allows the effect of the Pitch Offsets Pattern to be switched on and off in real-time.

    Will not have any effect unless at least one step of the Phase Pattern has a [po] (use pitch offsets) button turned on. 

    The utilities in the Menu Button for the CCs Page provide a quick and easy way turn on or off all [po] (use pitch offset) 
buttons in the Phase Page without going there.
<1213>

    [Chord Shift] (button) [0...2]

Selects one of several options for using chord recognition algorithms to shift any atonal notes (due to the Pitch Offset 
Pattern Values) to musically correct ones.

0: Off
The Pitch Offsets are applied with no further modification from this setting.

1: Scalic
Chord analysis is performed on the input source material, and as the Pitch Offset values are applied to transpose the 
generated notes, notes that may be “atonal” based on the analyzed chord are shifted to tonal notes. Useful for creating 
complex chromatic Pitch Offset Patterns and ensuring that the results stay in a certain key or chord, or for making a 
minor riff play in a major key when a major chord is detected.

2: Scalic2
Same as Scalic (above), except that the note tables used to shift the notes have more passing tones for each chord; 
therefore, Scalic 2 sounds more modal in nature.
<1224>
    [Polarity] (button) [Off (+), On (-)]

Inverts the semitone portion (upper 25 rows) of the Transpose Value in a given step. The Octave Values are not inverted. 
In other words, if a step had +3 in the Pitch section and +1 octave in the Octave section, with Polarity Off, the Transpose 
Value would be 3 + 12 = +15 semitones. With Polarity on, the value would be -3 + 12 = +9. This keeps the pattern in the 
same octave range basically, but inverts the melody.

Regular (+)
The Pitch Offsets Pattern is sent out as originally created.
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Inverted (-)
The Pitch Offsets Pattern is inverted, but only the semitone portion chosen from the Pitch section of the grids (upper 25 
rows). 
<2460>
    [Advance Mode] (popup menu) [0...4]

Determines whether the Pitch Offsets Pattern will use its own index to move through the pattern or lock to another 
pattern’s index. A Pitch Offsets Pattern has an associated index that moves through the pattern and dictates the current 
step to be used. The LED Tracker Arrays show the current step and chosen value during operation. The Advance Mode 
parameter controls one of several methods of operation:

0: Independent - 1 step per Rhythm Event
Each time the Rhythm Pattern determines it is time to generate a note or notes, a value will be chosen from the current 
step of the Pitch Offsets Pattern, after which the index will be advanced to the next step of the Pitch Offsets Pattern. The 
index will therefore advance through the pattern without skipping any steps, and upon reaching the end, loop back to the 
beginning. Unlike Velocity and Cluster Patterns, the Drum Patterns share a single index into the Pitch Offsets Pattern, so 
it is not possible to be at different steps in the Pitch Offsets Pattern for each Drum Pattern.

1: Lock (R) - Lock To Rhythm Pattern & Ties
The Pitch Offsets Pattern will “lock” to the Rhythm Pattern, by essentially using the Rhythm Pattern’s index. This is 
useful when the Rhythm Pattern has been set to include random ties. For example, if the Rhythm Pattern has 16 steps 
including random ties, creating a 16 step Pitch Offsets Pattern and using this mode assures that when the Rhythm Pattern 
“skips” a step (due to a random tie occurring), the Pitch Offsets Pattern will skip the same step. If the patterns are of 
unequal length, the index will be wrapped around to a valid location.

2: Lock (D1) - Lock To Drum Pattern 1
3: Lock (D2) - Lock To Drum Pattern 2
4: Lock (D3) - Lock To Drum Pattern 3
The Pitch Offsets Pattern will “lock” to the selected Drum Pattern, by essentially using the selected Drum Pattern’s 
index. The only time this is any different than Lock (R) is when the Rhythm Pattern contains Random Ties. If you want the 
Pitch Offsets Pattern values to be selected in a linear fashion, one after the other, and not skip over certain steps of the 
pattern, you can lock to one of the Drum Patterns. If the Drum Pattern and Pitch Offsets Pattern are of unequal length, the 
index will be wrapped around to a valid location. Note that a rest in the Drum Pattern will still advance the index, unlike 
“Independent” above. Therefore, if all three Drum Patterns are in use, locking to any one of the three will produce 
identical results, other than taking the length of the Drum Pattern into consideration.
<PatAdv>
    Note about Pattern Advance Mode when used with Pitch Offsets:
Because the Pitch Offsets pattern does not have two phases, and is only a single long pattern grid of 64 steps, when using 
the Pattern Advance Mode “Lock (R)” setting, it operates in a special manner: the length of the Phase 1 Rhythm Pattern 
corresponds to a first portion of the grid, while the length of the Phase 2 Rhythm Pattern corresponds to a later portion 
of the grid, starting after the first portion. In other words, if the Phase 1 Rhythm pattern is 16 steps long, then the first 
16 steps of the Pitch Offsets grid will be indexed when the Rhythm Pattern is in Phase 1; when the GE switches to Phase 
2, the Pitch Offsets pattern will begin at step 17, and continue for the length of the Phase 2 Rhythm Pattern.

Therefore, by setting up a 32 step Rhythm Pattern in both Phase 1 and Phase 2, and setting the Phase Pattern so that you 
play the 32 steps in each Rhythm pattern, you can index the full 64 steps of the Pitch Offsets Pattern. 

An example would be to set both Rhythm Pattern phases to 32 16th notes; then set the Phase Pattern to {1, 2}, in Time 
Signature Mode, with 8/4 for both phases. This will play 32 16th notes in each phase, and Phase 1 will index the first 32 
steps of the Pitch Offsets Pattern, while Phase 2 will index the second 32 steps of the Pitch Offsets Pattern.

The one peculiar aspect of this is that if you set the Phase Pattern to begin with Phase 2, i.e. {2,1}, or simply do not use 
Phase 1, the Pitch Offsets Pattern will appear to be starting somewhere in the middle of the grid (depending on the length 
of the Phase 1 Rhythm Pattern, even if it is not in use).
<2461>

    [Cluster Mode] (button) [0...1]

0: Single - 1 Step Per Cluster
Each time a note, cluster of notes, or group of drum notes is generated one Pitch Offsets Pattern Value will be chosen for 
the current step, after which the Pitch Offsets Pattern advances to the next value. For example, a cluster of six notes 
will be generated with a single CC value preceding it, and advance the pattern by one to the next step. The LED Tracking 
Arrays will display one value at a time.

1: Multi - 1 Step For Each Note In Cluster
For every note in a cluster or group of drum notes generated simultaneously, a separate Pitch Offsets Pattern Value will 
be chosen after which the Pitch Offsets Pattern advances to the next value. For example, a cluster of six notes will be 
generated with each note preceded by the next six CC values indicated by the pattern, with a net advance of six steps. 
This means that each note in a cluster or each note of a drum pattern that is generated simultaneously can be given its 
own transpose value. The LED Tracking Arrays will display the number of values chosen depending on the current cluster 
size.

    When the GE Type is “Generated - Gated,” the number of notes being generated is considered the Cluster Size.
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�    When the GE Type is “Generated - Riff,” setting this to “Multi” will have no effect unless there is a Cluster Pattern 
containing values of more than just one.

    When the GE Type is “Generated - Drum,” setting this to “Multi” will have no effect unless at least one Drum Pattern 
has the [cl] (use cluster pattern) buttons turned on in the Phase Page and there is a Cluster Pattern containing values of 
more than just one, or more than one drum note is being generated at a time (by using more than one Drum Pattern, or by 
using a single Drum Pattern in “Poly” mode).

    If you are using more than one Drum Pattern simultaneously or have a single Drum Pattern in “Poly” mode, you will 
most likely be generating more than one drum note at a time. This is also considered a “Cluster/Group” by the Velocity, 
Note and CCs Patterns; therefore, even if you do not have the [cl] (use cluster pattern) buttons turned on in the Phase 
Page, setting the Pattern Advance Mode to “Multi” will cause each note to advance the CCs Patterns and get a different 
value because more than one drum note is being generated at a time. For example, if at a particular moment a kick, hi-hat 
and cowbell are generated at the same time, the CCs Pattern will give them three different pan values and advance the 
pattern by three if the Pattern Advance Mode is set to “Multi;” if set to “Single,” then all three notes will be preceded 
by one pan value, and the pattern will advance by only one.

However, if the [cl] (use cluster pattern) buttons are turned on in the Phase Page and there is a Cluster Pattern containing 
values of more than just one, the total advancement will be multiplied by the current cluster size. For example, if the 
Cluster Pattern causes four notes to be generated from each of three Drum Patterns simultaneously and the CCs Pattern 
Advance Mode is set to “Multi,” then the next twelve CCs Pattern values (4 x 3) will be generated (one in front of each 
note) and the CCs Pattern will advance by twelve; if set to “Single,” then all twelve notes will be preceded by one pan 
value and the pattern will advance by only one. In this case, setting the Drum Patterns to “Poly” will not cause any 
additional values to be generated.

<RandPitch><1220><1223><1211><1217>
CCs - Random Weighting Parameters (Pitch Offsets)
 

The Random Weighting Parameters (Pitches) are made available when at least one step in the Pitch Offsets Pattern Grid 
contains multiple buttons turned on in the upper 25 Pitch rows (constituting a “random pool” of values). The Random 
Weighting Parameters (Octaves) are made available when at least one step in the Pitch Offsets Pattern Grid contains 
multiple buttons turned on in the lower 7 Octave rows (constituting a “random pool” of values). Since they operate the 
same, the following discussion applies to both.

Whenever a random pool is encountered in playing through the pattern, a random choice is made from the values in that 
step. Certain areas of the random pool can be favored by the use of a weighting table, with various shaped curves. Using 
the curves, you can influence certain choices to be made more or less often than others, allowing very musical real-time 
control of the randomness.

Whether or not a certain random sequence will repeat for a number of times is controlled in the Phase Page. See Phase 
Page - Phase Activity Grid (General).
<PhsEd/PhsGrid><1218><1221>
    [Weighting Curve] (popup menu) [0...3]

Selects one of four different curves that act to favor certain areas of the pool over others when each random choice is 
made. Next to the Weighting Curve Menu, a small graphic displays the actual shape of the chosen curve based on the 
setting of the “Factor” field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top 
will favor values towards the top of the columns in the grid (except when the Weighting Curve Inversion Row buttons are 
turned on, explained at the end of the following section). For a more complete discussion of the various shapes and how the 
Factor influences the choices, see the Appendix Random Weighting Curves.
<RandCurves> 

0: Exponential
With a positive Factor (+), choices will be exponentially weighted towards the higher values (selected values higher in the 
grid column). With a negative Factor (-), choices will be exponentially weighted towards the lower values (selected values 
lower in the grid column).

1: Logarithmic
With a positive Factor (+), choices will be logarithmically weighted towards the higher values (selected values higher in 
the grid column). With a negative Factor (-), choices will be logarithmically weighted towards the lower values (selected 
values lower in the grid column).
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2: Exp-S (Exponential S)
With a positive Factor (+), choices will be exponentially weighted towards the center values (values towards the center 
of the selected values), and away from the highest and lowest values. With a negative Factor (-), choices will be 
exponentially weighted towards the lowest and highest values (selected values higher and lower in the column), and away 
from the middle values.

3: Log-S (Logarithmic S)
With a positive Factor (+), choices will be logarithmically weighted towards the center values (values towards the center 
of the selected values), and away from the highest and lowest values. With a negative Factor (-), choices will be 
logarithmically weighted towards the lowest and highest values (selected values higher and lower in the column), and 
away from the middle values.

    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves. 
<RandCurves/Compare>

    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen. A Factor of “+99” with 
either of the S-Curves yields a straight line across the middle, and only the middle value in the pool will be chosen. A 
Factor of “-99” with either of the S-Curves yields a split straight line across the bottom and top, and random choices 
between only the lowest and highest values in the pool will be chosen.

The following table summarizes the effect of the various Weighting Curves and the Factor field on the choices from the CC 
Pools:

 

<1219><1222>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is either +99 or -99, the choices are “locked” to the highest or 
lowest values in the columns, and there are no random choices at all. (The only exception to this is an S-shaped curve 
with a value of -99. In this case, a random choice will be made between the highest and lowest values only.)

    For all other Parameters related to the CCs Page and using Pitch Offsets, see the previous chapter CCs Page (Part 1).
<PanEd><Template>
CCs - Template Management
 

Certain of the parameters in the CCs Page can be saved as a “Template.” This can be useful for Templates that you use 
often, or that you like to use as a starting point for further experimentation, or to maintain a library of Templates. 
Furthermore, Templates can be switched in real-time when they are assigned as RT Parms, causing radical changes in 
what is being generated.

What is saved in a CCs/Pitch Offsets Pattern Template:
- the configuration of the Pattern Editing Grid;
- the Random Weighting Parameters (Weighting Curve and Factor);
- Polarity.

There can be more than one bank of Templates in a KDF File. Each GE stores a reference to which Bank it is using, which is 
set by the Template Bank parameter in the GE Editor. All Templates used in a GE must come from the same bank - for 
example, you cannot use Rhythm Templates from one bank and Index Templates from another at the same time.

    When a Template is selected and loaded via RT Parm control, the Weighting Curve and Factor will remain as presently 
set if the Weighting Curve or Factor is also assigned as an RT Parm. In other words, a Weighting Curve and Factor are 
stored as part of the Template, but if they are under RT Parm control, their current settings are not replaced when the 
Template is loaded.
<1228>

    [Open Template Bank] (button)

Opens a Template Bank Display Window for the current bank of CCs/Bend/Pitch Pattern Templates.
<1225>
    [Template] (popup menu) [0 = [As Stored], 1...63]

Selects from 63 different CC/Bend/Pitch Offset Pattern Templates (shared by both Phase 1 and 2), and loads the 
parameters into the current Phase’s Editing Area.
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Selecting Template 0 (which is always named [As Stored] and cannot be overwritten) reloads the stored internal settings 
of the GE for the parameters corresponding to the template. In other words, you can have a complex pattern set up on the 
grid, select one or more Templates, thereby completely replacing it, and then return to the original settings by selecting 
[As Stored].

When selected by the mouse using the popup menu, the [As Stored] selection is always available. When the Template is 
being controlled as a Real-Time Parameter, there are two different options available:

Template [1...63]
The internal settings of the GE for the set of parameters corresponding to the chosen Template are never used; rather 
they are always replaced by one of the selected Templates from within the Min/Max range specified for the RT Parm. In 
this case, available range is 1~63, and it is not possible to select 0: [As Stored].

Template + Restore [0...63]
Similar to the above setting; however, the internal settings of the GE can be restored and used as part of the real-time 
Template operation. In this case, the Min setting of the Template Range actually does not select that Template; rather, it 
causes the internal settings of the GE to be restored for that Template’s set of parameters. In other words, you can have 
a complex pattern already set up on the grid. Using “Template + Restore” as a GE RT Parm, you specify a range where 
the Min value restores the internal settings, and the rest of the range selects Templates, replacing the internal settings. 
So if the Min value was 5 and the Max value was 10, choosing 5 would restore the internal settings (the same as selecting 
“0 [As Stored]”), and 6 through 10 would select the corresponding Template. You can use this to keep the internal 
settings of the GE, while still allowing a wide variety of Templates to be substituted for various groups of parameters. In 
this case, the available range is 0~63. You can assign the full range of all 63 Templates, or only a portion of the range, 
and still have the ability to restore the original internal settings.

    Pitch Offset Patterns (described in the next chapter) share the same Template Bank as CC/Bend Templates, since they 
are in the same page of the Editor. However, Templates are not interchangeable between the two. If you try to load a 
Template created for the other type of Pattern, you will be given an error message and it will not load.

    When a GE is first loaded, the Template popup will always display “As Stored.” If you select a Template, the popup 
menu will display the name of the Template, but after you save the GE and load it again, it will once again display “As 
Stored.” This is because the Template value is not saved in the GE, but the contents of the Pattern Grid and associated 
parameters are.
<1226>
    [Save] (button)

Brings up a Save Dialog allowing you to name the Template and save it in memory in the current Template Bank. After 
saving a Template, it will then be available in the Template popup menus for both Phases. 
<OthDlg/Sbs><1227>
    [Clear] (button)

Brings up a dialog allowing you to clear the selected Template from the current Template Bank. You will be given an 
opportunity to cancel. After clearing, the Template will disappear from the Template popup menus for both Phases.

    Saving or clearing only affects the Templates in RAM. To save these changes to disk, you must save the KDF File by 
choosing “Save,” “Save As…” or “Save All…” from the File menu.

    Since the changes are not written to disk until one of the Save commands is executed, to undo a change after you have 
stored or cleared a Template you can close and reopen the current KDF file.
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WaveSeq (Part 1)
Sections in this chapter:

Overview<WavEd/Over>

About Waveform Patterns<WavEd/About>

Global Parameters<WavEd/Global>

Pattern Grid & Associated Parameters<WavEd/PatGrid>

Random Weighting Parameters<WavEd/RandPool>

Sections in Part 2:<WavEd2>

Template Management<WavEd2/Template>

Waveform Select Dialog<WavEd2/Dlg>

Other related chapters:

Appendix: KARMA Wave-Sequencing<KWS>

 

<Over>
WaveSeq - Overview
The WaveSeq Page controls a set of parameters that allow the waveforms of the destination synth’s programs to be 
varied in real-time, creating popular “wave-sequence” style effects that we refer to as “KARMA Wave-Sequencing.” 
Although typically used with the voices in your Motif/MOX that the software is connected to, different Device Types can 
be specified for controlling other synths, such as a full range of Korg synths - or other Yamaha synths you may own. 
Typically, SysEx messages are used to change the waveforms, but other Message Types can be specified allowing you to 
control various plug-ins and soft synths in a DAW that are capable of reacting to CC (Control Change) or Program Change 
messages to change waveforms or even complete programs.

Global Parameters
Parameters that affect KARMA Wave-Sequencing during playback of either Phase in a Generated Effect.

Phase Specific Parameters
An identical group of parameters for each Phase that affect KARMA Wave-Sequencing during playback of that Phase only. 
For more on Phases, see the Phase Page. 
<PhsEd><1556>

Phase Selection Buttons
Selects which Phase (a separate collection of the Phase Specific Parameters) to display and edit.
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Waveform Parameters
Controls which waveforms are selected for each row, and whether they are shifted or offset while being generated.

Pattern Grid
Allows KARMA Wave-Sequencing Patterns to be constructed in various ways, which then modify the waveforms (or 
programs) of the synth being played by the Module’s GE.

Random Weighting Parameters
Parameters that allow weighting curves to be applied to any random pools (more than one value in a column) that may 
have been created in the Pattern Grid.
<1565>

LED Tracking Arrays
Rows of gray dots along the horizontal and vertical axes of the Pattern Grid, with one or more green dots displaying the 
currently chosen index (column) and pattern values (rows).

Template Management
Allows the contents of the Pattern Grid and certain associated parameters to be saved as a “Template.” It will then 
appear in the popup menu for future use when creating/editing Waveform Patterns. Selecting a Template from the menu 
loads it into the Pattern Grid and associated parameters.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Click on the links below for detailed information on the utilities not fully explained here:

Copy Phases...<GEUtils/Pco>

Apply Waveform Offset
When the “Wave Offset” field is set to something other than zero, that value is being added to all the displayed 
waveforms to create a different set of waveforms. If you find you like a certain offset and you want to make it the basic 
setting of the GE, you can execute this utility and the Wave Offset will be added (permanently) to all the waveforms. 
“Wave Offset” will then be reset to zero, and the Waveform Choice labels will refresh to show the new, actual waveform 
settings.

Reset Waveforms to Off
All 16 Waveform Choices will be set to Off, in the Phase that you are viewing.

Reset Waveforms By…
Brings up the generic Specify Value Dialog, allowing you to enter a value that will be used to set the values of all 16 
Waveform Choices in the Phase that you are viewing, starting with waveform 1. For example, if the value entered is 1, 
the Waveform Choices will be set to waveforms 1 to 16. If the value entered is 2, they would be set to 1, 3, 5, 7, etc.
<OthDlg/SpecVal>

Default Setup For Yamaha
Initializes the settings in both Phases to a default setup suitable for experimenting and programming with the Yamaha 
Motif/MOX.

Set All GEs In KDF To Global Device...
Allows you to change the Device Type setting for all GEs in the current KDF file to “[Global Device],” a new setting added 
in version 3.1 that automatically adjusts the SysEx Messages depending on which Yamaha Model you are using with the 
software. This cannot be undone other than by reloading the KDF file; however, you will be given an opportunity to cancel.
<1581>
 

    If settings in the Phase Page indicate a particular Phase is not being used, the Phase Specific Parameters will not be 
available for that Phase. The message “Phase Not In Use” will be displayed near the Phase Selection Buttons. 

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 
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<RTPEd><About>
WaveSeq - About Waveform Patterns
Waveform Patterns control the waveforms (or sounds) of the synth programs that are being used to generate notes. Here 
you can sequence a pattern of up to 32 different Waveform Choices (16 in each phase). A value derived from a Waveform 
Pattern is the ID of a specific waveform or sound choice. Choices can be made from “Random Pools” of values as 
described in detail later on. The waveforms change with each note (although you can specify a number of steps containing 
the same waveform, of course, so that it repeats the same waveform for a number of notes.) 

You can set up effects that more resemble traditional wave sequences by setting the Index Page or the Note Series to only 
repeat a single pitch, or by using GE Mode = Gated, with Gate Type = Vel, instead of generating notes all over the place. 
Then you can concentrate on just changing waveforms, and the notes remain static.

On the other hand, part of the beauty of KARMA Wave- Sequencing is having the notes change in a sequenced fashion, while 
the waveforms are also changing. Presently, it is not possible to have the waveforms change while notes are sustaining, 
so you cannot use GE Mode = Gated with Gate Type = CC (for chopped pads.)

Alternately, you can have it generate just waveform changes, without actually generating any notes. For example, you 
can have it randomly pick a new waveform (from a group you’ve defined) with each note you play on the keyboard. Or you 
can assign a range of waveforms to an RT Control and select the one you want to use, in real-time.

One of the most interesting features is the ability to offset the entire waveform map that you’ve set up, either by 
varying the “Wave Offset” parameter, or by tracking it with the keyboard. Since the results are totally dependent on the 
destination synth’s waveform order, completely unexpected and unplanned results can be achieved that would be 
impossible to get any other way. For example, a Waveform Pattern of mallet-like sounds could be shifted instantly into a 
group of guitar or industrial noise waveforms, radically modifying the resulting timbre of the phrase.

A Waveform Pattern will loop as long as note generation continues. It normally will not reset to the beginning of the 
Pattern unless a new Trigger is received, or the Phase Page has been configured to restart it at the beginning of certain 
Phases by using the [pr] (pattern restart] buttons. This means that a four step Waveform Pattern can be looping while an 
eight step Velocity Pattern and a twelve step Cluster Pattern are also independently looping, for example.

<Global>
WaveSeq - Global Parameters
 

The parameters in this section affect both Phases of the KARMA Wave-Sequencing at the same time; hence, they are 
“Global” as opposed to “Phase-Specific.” In the following discussions, “Oscillator” refers to Oscillators 1 and 2 in a 
Korg Program, and Elements 1 and 2 in a Yamaha Voice. For a detailed description of the differences between the Korg 
implementation and the Yamaha implementation, see the Appendix KARMA Wave-Sequencing.
<KWS><1557>
    [On/Off] (button) [Off, On]

An overall switch for turning the KARMA Wave-Sequencing effect on/off. Setting to off will return the program to normal 
operation (and may optionally reset the waveforms to their original values, if your synth supports this behavior). For 
example, in the Korg versions, this allows you to activate the effect in real-time, where turning it off sets the timbres 
being affected back to their original waveforms. In the Yamaha version, this function is not available and it will reset to 
the first specified waveform in the startup Phase. When off, all of the parameters on the page will be grayed out.
<1580>
             [Message Type] (popup menu) [0...3]

Specifies the type of message that will be sent to change waveforms or programs in the destination device. Four different 
types of KARMA Wave-Sequencing control messages are provided, including “SysEx” and three others that can allow 
various plug-ins (in an external DAW) that are able to switch waveforms or programs to be controlled in a similar 
fashion.

0: SysEx
This is the regular mode of sending System Exclusive messages that change the keyboard’s waveforms in one or more 
oscillators with each note that is generated. When this setting is selected, the “Device Type” menu is enabled, which 
typically will be set to the Yamaha Device that you are operating the software with. However, rather than tie the 
operation of this to the one keyboard the software goes with, you can select from a number of Korg and Yamaha devices, 
so that you can use other external keyboards you may have and control KARMA Wave-Sequencing on them as well.
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1: Program Change (0~127)
Any plug-in that is capable of changing programs in real-time with a Program Change message and Bank MSB/LSB can use 
this (example: Purity). You can also use this with Korg or Yamaha keyboards, and change the whole program/voice inside 
a timbre/track/part with each generated note (although response times of loading the program/voice may be a factor). 
When this option is selected, the Delay field (explained below) is available to compensate for the amount of time necessary 
to change the program/voice.

2: 1 CC (0~127)
Any plug-in that can select waveforms via a CC (Control Change) Message and value can use this (example: Crystal). 
When this option is selected, the Delay field (explained below) is available to compensate for the amount of time necessary 
to change the sound.

3: 4 CCs (On/Off)
A special mode allowing plug-ins with separate elements (up to 4) to sequentially and individually activate each element 
(examples: Dimension Le, WusikStation). In other words, rather than changing waveforms (which may not be possible on 
the plug-in), you can set up multiple elements with different waveforms ahead of time, and then switch between them by 
turning each element on and off. The “CC Number” setting the specifies the first CC Number of a range of four 
consecutive CCs to be used to control individual “elements.” The destination device must be programmed to match those 
four CC Numbers. When this option is selected, the Delay field (explained below) is available to compensate for the amount 
of time necessary to change the sound.
<MessDgm>

As shown in the diagram below, the Message Type setting affects which of several other parameters are available, either 
enabling and disabling them, or changing the parameters that are shown above the Pattern Grid:

 

<1579>
    [Device Type] (popup menu) [Global Device, number of supported devices]

For System Exclusive messages, specifies the type of the destination device from a list of supported Korg and Yamaha 
devices. Changing the Device Type causes the appropriate list of waveform names for the device to be displayed in the 
Waveform Choice labels to the left of the grid and in the Waveform Select Dialog. When set to “[Global Device]” (the 
default), the GE uses the Device Type setting specified in the MIDI Setup (Global) Editor > General Page. This allows the GE 
to automatically display the correct list of waveforms and send the correct SysEx messages for the Yamaha device that 
you are controlling. If you had more than one type of supported Yamaha device, for example a Motif XS and an MOXF, you 
could switch the software from one to the other and any wave-sequencing GEs would still work. However, there are times 
you may wish to set this to a specific device. For example, if you had a Motif XF and a Kronos, you could select the Kronos 
as an external destination for one of the Modules, and then create a GE that controls KARMA Wave-Sequencing on the 
Kronos. 
<WavEd2/Dlg>

    The Device Type is only available when the Message Type is set to “SysEx.” It will be grayed out for other Message 
Types.
<1558>
    [Osc Mode] (popup menu) [0...4]

Specifies several ways that two different oscillators in the destination program(s) can be controlled (if the destination 
synth supports this behavior), with regards to the two different Phases of a GE.

    The Osc Mode is only available when the Message Type is set to “SysEx.” It will be grayed out for other Message 
Types.

0: Osc1 In Both Phases
The specified waveforms will be selected according to the switching of the Phase Pattern, but only for Oscillator 1. 
During steps utilizing Phase 1, the Phase 1 Pattern will be used to change the waveforms, and during steps utilizing Phase 
2, the Phase 2 Pattern will likewise be used. Oscillator 2 (if used in the program) will not be affected. 

1: Osc2 In Both Phases
The specified waveforms will be selected according to the switching of the Phase Pattern, but only for Oscillator 2. 
During steps utilizing Phase 1, the Phase 1 Pattern will be used to change the waveforms, and during steps utilizing Phase 
2, the Phase 2 Pattern will likewise be used. Oscillator 1 will not be affected.

    This setting will have no effect on a single-oscillator or drum program.
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2: Alternate (Osc1 Phase 1, Osc2 Phase 2)
During playback of Phase 1, Oscillator 1 waveform changes will be generated. During playback of Phase 2, Oscillator 2 
waveform changes will be generated. Therefore, the Phase 1 Pattern and parameters are associated with Oscillator 1, 
and the Phase 2 Pattern and parameters are associated with Oscillator 2. When in Phase 1, Osc 2 will remain on the last 
sent waveform change of Phase 2, and when in Phase 2, Osc 1 will remain on the last sent waveform change of Phase 1. 
This creates an “alternating” sort of effect between the two oscillators, where one oscillator will change for a period of 
time, then the other, but not at the same time.

    The Phase 2 parameters will have no effect on a single-oscillator or drum program.

3: Split (Osc1 Phase 1, Osc2 Phase 2, simultaneously)
The Phase 1 Pattern and parameters are associated with Oscillator 1, and the Phase 2 Pattern and parameters are 
associated with Oscillator 2. However, they generate waveform changes simultaneously, ignoring the Phase Pattern 
settings. For example, this means the Pattern Grid in Phase 1 can be used to generate a wave-sequence pattern for Osc 1, 
at the same time that the Pattern Grid in Phase 2 can be used to generate a completely different wave-sequence pattern 
for Osc 2. The switching of Phases which normally occurs according to the Phase Pattern is ignored, and they both 
generate waveform changes for their respective oscillators simultaneously, all the time. 

    The Phase 2 parameters will have no effect on a single-oscillator or drum program.

4: Both (Osc1 & Osc2 same, simultaneously)
The two oscillators are controlled in tandem. The Phase Pattern switching between Phases is used as normal, but both Osc 
1 & 2 are changed as specified by the Pattern (with the same values). For example, you can set up a complex pattern of 
up to 16 waveforms in Phase 1, and a different complex pattern with different waveforms in Phase 2, and let the Phase 
Pattern control switching between them. Every time Osc 1 is changed, Osc 2 will also change to the same waveform.

    An example of where you might use “4: Both” would be having the first two elements in a Yamaha Voice set with 
identical waves, panned left and right with some detuning. You could then wave-sequence both elements with the same 
waves, such that it still kept the detuning and stereo aspect.
<1576>
    [Delay] (numerical) [0...255 ms]

When using the non-SysEx Message Types (Program Change, 1 CC, 4 CC) to change waveforms on a device, allows you to 
specify a millisecond delay between the sending of the message and the generated note that follows it. This allows you to 
compensate for devices that take a few milliseconds to complete the waveform or program change, so that the note does 
not sound before the change has been completed.

<PatGrid>
WaveSeq - Pattern Grid & Associated Parameters
 

<1575><1567>
    [Pattern Grid] [16 rows x 32 steps]

A Waveform Pattern specifies a sequence of waveform select messages (SysEx, Program Change or CC) to be sent to a 
destination synth program, thereby changing the waveform of the sound with each note (if desired).
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A Waveform Pattern may have any number of steps up to 32, and loop independently of other patterns being used at the 
same time. Each step is represented by one column on the grid. As shown above, unused columns will appear disabled in a 
lighter gray; clicking on a disabled column inserts a value into it and any other disabled columns between it and the last 
column in use. The first column must always contain at least one value. Note that a Pattern with a single value in a single 
column is functionally equivalent to many columns each containing the same value. For general information on working 
with the various Pattern Editing Grids, see Using The Pattern Editing Grids.
<UseGrid>

More than one value can be entered in any given column (by using the [shift] key), which then becomes a “random pool” 
from which choices will be made at random, subject to the use of a weighting curve as described later on. The weighting 
curve becomes available when there is at least one random pool selected. The example above shows a pattern of 8 single 
waveform choices in the first 8 steps, after which waveform choices are made at random from the entire group of 16 
waveforms for an additional 8 steps, followed by random choices from the middle group of 8 waveforms for an additional 
8 steps. Whether or not the random choices will be different each time through the Phase is controlled in the Phase Page; 
you can choose to repeat the same random sequence a number of times or always generate new random sequences of 
choices.

Also controlled in the Phase Page is whether or not the Waveform Pattern will start from the beginning each time a Phase 
starts, by using the [pr] (pattern restart) row. For example, assume the pattern contained ten items and a Phase only 
used eight of them before changing to a different Phase. If the pattern was not set to restart in the Phase Page, then the 
second time through the same Phase it would pick up where it left off: at the 9th value of the pattern. For information on 
both restarting the pattern and repeating random sequences, see Phase Page - Phase Activity Grid (General). 
<PhsEd/PhsGrid><1571>
    [Waveform Choice] (label) [Off, number of available waveforms]

16 Waveform Choices for the Waveform Pattern Grid are displayed to the left of the grid. Click the round button with the 
triangle next to each waveform name, and the Waveform Select Dialog will appear, allowing you to choose a waveform (or 
other sound choice depending on the Message Type) for the corresponding row of the grid. The names and number of 
available waveforms is determined by the Message Type and Device Type settings.

    For Korg Kronos or Oasys, depending on the setting of Waveform Type below, the list of names will either display 
MultiSound names, or Korg WaveSequence names.
<WavEd2/Dlg><1574>

    [Waveform Select Button] (button)

Opens the Waveform Select Dialog and allows you to choose a waveform (or other sound choice depending on the Message 
Type) for the corresponding row of the Pattern Grid. The list of available choices changes depending on the Message Type 
and Device Type settings.
<WavEd2/Dlg><1572>
    [Start Offset] (popup menu) [0 = Sample Start, 1...8]

Chooses one of the available start offset points for the selected waveform. Only the applicable number of available start 
offsets for the selected waveform will be enabled; unavailable offsets will be grayed out.

    Start Offsets will only be available for Korg Synths that support this feature. They will be grayed out for Yamaha 
Motif/MOX.

    When this parameter is being varied by an RT Parm assignment, the full range of Start Offsets will be available. 
However, the actual value will be limited internally to the available number of Start Offsets for the specified waveform.

    Korg WaveSequences do not have Start Offsets. Therefore, when the Waveform Type is “WaveSequence,” all Start 
Offsets other than Sample Start will be grayed out. 
<1568>

    [Waveform Offset] (numerical) [+/- number of waveforms]

Offsets the entire group of 16 Waveform Choices by the specified amount (each waveform has the specified number added 
to it.) This can be a quick way to transform a pattern into a completely unexpected result. Waveforms will be limited to 
the first and last waveforms if the offset causes them to go out of range.<1568>
<1577>
       [Waveform Type] (popup menu) [MultiSound, WaveSequence]

Specifies whether the messages sent will change the program’s oscillator(s) to different Multisounds, or different Korg 
Wave Sequences.

    The Waveform Type will only be available when the Message Type is “SysEx” and the Device Type is “Korg Kronos” 
or “Korg Oasys.” It will be grayed out for other Device Types, or change to a different set of parameters for other 
Message Types. See the diagram for Message Type above. <WavEd/MessDgm>

MultiSound
The choices indicated by the pattern values will cause various MultiSounds to be selected for the specified oscillators. The 
list of names in the Waveform Choice labels will change to display the available MultiSounds.

WaveSequence
The choices indicated by the pattern values will cause various Korg WaveSequences to be selected for the specified 
oscillators. The list of names in the Waveform Choice labels will change to display the available WaveSequences.
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<1559><1560><1561>
   [MSB/LSB] (numericals) [0...127]

Specifies the MSB (CC#00) and LSB (CC#32) settings for the Bank Select Message that will be sent before the Program 
Change Message. The two values together allow you to select a certain bank in the destination device. You can specify a 
different bank in each Phase.

    The MSB/LSB will only be available when the Message Type is “Program.” It will change to a different set of 
parameters for other Message Types. See the diagram for Message Type above. <WavEd/MessDgm>
<1582>
    [CC Number] (popup menu) [Off, 0...126]

When the message Type is “1 CC”, this specifies the Control Change Message number - you can specify a different CC in 
each Phase. When the Message Type is “4 CCs”, this specifies the first CC number of a range of four consecutive CCs to 
be used to control individual “elements.” For example, if you specify CC 44, then CCs 44, 45, 46, and 47 will be sent for 
the four different Waveform Choices. Since this parameter is available in both Phases, you could conceivably use 8 
different CCs at different times. The destination device must be programmed to match those four CC Numbers.

    The CC Number will only be available when the Message Type is “1 CC” or “4 CCs.” It will change to a different set 
of parameters for other Message Types. See the diagram for Message Type above. <WavEd/MessDgm>
<1569>

               [Kbd Track (C1)] (checkbox) [Off, On]

When on, allows the specified 16 Waveform Choices to track the keyboard (lowest note played, with reference to C1-36). 
In other words, the 16 waveforms will be used exactly as specified when the lowest input note played is a C1. If the 
lowest note is higher or lower than C1, the number of steps that it is higher/lower will be added to or subtracted from 
each waveform, offsetting the entire group. This provides a completely different resulting wave-sequence depending on 
where the input notes are played.

    C1 or C2 will be displayed in the parameter name depending on the settings of the “Middle C Display” option in the 
Preferences > Workspace settings. This is only a display setting and the feature operates identically either way, with 
reference to MIDI Note Number 36. <Prefs/MidC>
<1578>

    [Pattern Length] (numerical) [1...32]

Specifies the number of steps of the Waveform Pattern that will be used during note generation. This allows you to loop a 
smaller portion of the entire pattern. For example, if the Waveform Pattern Grid has been set up with a 20 step pattern, 
and Pattern Length = 3, then only the first three steps of the pattern will be used to generate notes. Those three steps 
will loop continuously as the GE generates notes, and the other steps will not be used. To use all steps of any Waveform 
Pattern that is loaded, even when changing Waveform Templates, set this to 32. If the Waveform Pattern contains less 
than 32 steps, the number of steps in the Waveform Pattern will be used.
<1570>
    [Advance Mode] (popup menu) [0...4]

Determines whether the Waveform Pattern will use its own index to move through the pattern or lock to another pattern’s 
index. For example, if the Rhythm Pattern is skipping steps due to the use of Random Ties, you might want the Waveform 
Pattern to also skip the same steps in tandem – or you might not.

A Waveform Pattern has an associated index that moves through the pattern and dictates the current step to be used. The 
LED Tracker Arrays show the current step and chosen value during operation. The Advance Mode parameter controls one 
of several methods of operation:

0: Independent - 1 step per Rhythm Event
Each time the Rhythm Pattern determines it is time to generate a note or notes, a value will be chosen from the current 
step of the Waveform Pattern, after which the index will be advanced to the next step of the Waveform Pattern. The 
index will therefore advance through the pattern without skipping any steps, and upon reaching the end, loop back to the 
beginning.

1: Lock (R) - Lock To Rhythm Pattern & Ties
The Waveform Pattern will “lock” to the Rhythm Pattern, by essentially using the Rhythm Pattern’s index. This is useful 
when the Rhythm Pattern has been set to include random ties. For example, if the Rhythm Pattern has 16 steps including 
random ties, creating a 16 step Waveform Pattern and using this mode assures that when the Rhythm Pattern “skips” a 
step (due to a random tie occurring), the Waveform Pattern will skip the same step. If the patterns are of unequal length, 
the index will be wrapped around to a valid location.
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2: Lock (D1) - Lock To Drum Pattern 1
3: Lock (D2) - Lock To Drum Pattern 2
4: Lock (D3) - Lock To Drum Pattern 3
The Waveform Pattern will “lock” to the selected Drum Pattern, by essentially using the selected Drum Pattern’s index. 
The only time this is any different than Lock (R) is when the Rhythm Pattern contains Random Ties. If you want the 
Waveform Pattern values to be selected in a linear fashion, one after the other, and not skip over certain steps of the 
pattern, you can lock to one of the Drum Patterns. If the Drum Pattern and Waveform Pattern are of unequal length, the 
index will be wrapped around to a valid location. Note that a rest in the Drum Pattern will still advance the index, unlike 
“Independent” above. Therefore, if all three Drum Patterns are in use, locking to any one of the three will produce 
identical results, other than taking the length of the Drum Pattern into consideration.

<RandPool><1564><1566>
WaveSeq - Random Weighting Parameters
 

The Random Weighting Parameters are made available when at least one step (column) in the Waveform Pattern Grid 
contains multiple buttons turned on (constituting a “random pool” of values). Whenever a random pool is encountered in 
playing through the pattern, a random choice is made from the values in that step. Certain areas of the random pool can be 
favored by the use of a weighting table, with various shaped curves. Using the curves, you can influence certain choices 
to be made more or less often than others, allowing very musical real-time control of the randomness.

Whether or not a certain random sequence will repeat for a number of times is controlled by the [nr] (new random 
sequence) buttons in the Phase Page. See Phase Page - Phase Activity Grid (General).
<PhsEd/PhsGrid><1562>
    [Weighting Curve] (popup menu) [0...3]

Selects one of four different curves that act to favor certain areas of the pool over others when each random choice is 
made. Next to the Weighting Curve menu, a small graphic displays the actual shape of the chosen curve based on the 
setting of the “Factor” field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top 
will favor values towards the top of the columns in the grid. For a more complete discussion of the various shapes and 
how the Factor influences the choices, see the Appendix Random Weighting Curves.
<RandCurves> 

0: Exponential
With a positive Factor (+), choices will be exponentially weighted towards the waveform choices higher in the grid column 
(values closer to the top of each pool). With a negative Factor (-), choices will be exponentially weighted towards the 
waveform choices lower in the grid column (values closer to the bottom of each pool).

1: Logarithmic
With a positive Factor (+), choices will be logarithmically weighted towards the waveform choices higher in the grid 
column (values closer to the top of each pool). With a negative Factor (-), choices will be logarithmically weighted 
towards the waveform choices lower in the grid column (values closer to the bottom of each pool)..

2: Exp-S (Exponential S)
With a positive Factor (+), choices will be exponentially weighted towards the waveform choices nearer the center of the 
grid column (values towards the center of each pool), and away from the higher and lower choices. With a negative Factor 
(-), choices will be exponentially weighted towards the waveform choices higher and lower in the grid column (nearer the 
top and bottom of each pool), and away from the middle choices.

3: Log-S (Logarithmic S)
With a positive Factor (+), choices will be logarithmically weighted towards the waveform choices nearer the center of 
the grid column (values towards the center of each pool), and away from the higher and lower choices. With a negative 
Factor (-), choices will be logarithmically weighted towards the waveform choices higher and lower in the grid column 
(nearer the top and bottom of each pool), and away from the middle choices.

    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves.
<RandCurves/Compare>
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�    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen. A Factor of “+99” with 
either of the S-Curves yields a straight line across the middle, and only the middle value in the pool will be chosen. A 
Factor of “-99” with either of the S-Curves yields a split straight line across the bottom and top, and random choices 
between only the lowest and highest values in the pool will be chosen.

The following table summarizes the effect of the various Weighting Curves and the Factor field on the choices from the 
Waveform Pools:

 

<1563>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is either +99 or -99, the choices are “locked” to the highest or 
lowest values in the columns, and there are no random choices at all. (The only exception to this is an S-shaped curve 
with a value of -99. In this case, a random choice will be made between the highest and lowest values only.)
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WaveSeq (Part 2)
Sections in this chapter:

Template Management<WavEd2/Template>

Waveform Select Dialog<WavEd2/Dlg>

Sections in Part 1: <WavEd>

Overview<WavEd/Over>

About Waveform Patterns<WavEd/About>

Global Parameters<WavEd/Global>

Pattern Grid & Associated Parameters<WavEd/PatGrid>

Random Weighting Parameters<WavEd/RandPool>

Other related chapters:

Appendix: KARMA Wave-Sequencing<KWS>

<Template>
WaveSeq - Template Management
 

A set of certain parameters in the WaveSeq Page can be saved as a “Template.” This can be useful for Templates that you 
use often, or that you like to use as a starting point for further experimentation, or to maintain a library of Templates. 
Furthermore, Templates can be switched in real-time when they are assigned as RT Parms, causing radical changes in 
what is being generated.

What is saved in a Waveform Pattern Template:
- the configuration of the Pattern Editing Grid;
- the sixteen choices in the Waveform Choice menus, and the corresponding Start Offset values;
- the Random Pool Weighting Parameters (Weighting Curve and Factor);

There can be more than one bank of Templates in a KDF File. Each GE stores a reference to which Bank it is using, which is 
set by the Template Bank parameter in the GE Editor. All Templates used in a GE must come from the same bank - for 
example, you cannot use Rhythm Templates from one bank and Index Templates from another at the same time.

    When a Template is selected and loaded via RT Parm control, the Weighting Curve and Factor will remain as presently 
set if the Weighting Curve or Factor is also assigned as an RT Parm. In other words, a Weighting Curve and Factor are 
stored as part of the Template, but if they are under RT Parm control, their current settings are not replaced when the 
Template is loaded.
<2432>

    [Open Template Bank] (button)

Opens a Template Bank Display Window for the current bank of Wave Sequence Pattern Templates.
<2429>
    [Template] (popup menu) [0 = [As Stored], 1...63]

Selects from 63 different Wave Sequence Pattern Templates (shared by both Phase 1 and 2), and loads the parameters 
into the current Phase’s Editing Area.

Selecting Template 0 (which is always named [As Stored] and cannot be overwritten) reloads the stored internal settings 
of the GE for the parameters corresponding to the template. In other words, you can have a complex pattern set up on the 
grid, select one or more Templates, thereby completely replacing it, and then return to the original settings by selecting 
[As Stored].

When selected by the mouse using the popup menu, the [As Stored] selection is always available. When the Template is 
being controlled as a Real-Time Parameter, there are two different options available:

Template [1...63]
The internal settings of the GE for the set of parameters corresponding to the chosen Template are never used; rather 
they are always replaced by one of the selected Templates from within the Min/Max range specified for the RT Parm. In 
this case, available range is 1~63, and it is not possible to select 0: [As Stored].

Template + Restore [0...63]
Similar to the above setting; however, the internal settings of the GE can be restored and used as part of the real-time 
Template operation. In this case, the Min setting of the Template Range actually does not select that Template; rather, it 
causes the internal settings of the GE to be restored for that Template’s set of parameters. In other words, you can have 
a complex pattern already set up on the grid. Using “Template + Restore” as a GE RT Parm, you specify a range where 
the Min value restores the internal settings, and the rest of the range selects Templates, replacing the internal settings. 

Page 274



So if the Min value was 5 and the Max value was 10, choosing 5 would restore the internal settings (the same as selecting 
“0 [As Stored]”), and 6 through 10 would select the corresponding Template. You can use this to keep the internal 
settings of the GE, while still allowing a wide variety of Templates to be substituted for various groups of parameters. In 
this case, the available range is 0~63. You can assign the full range of all 63 Templates, or only a portion of the range, 
and still have the ability to restore the original internal settings.

    When a GE is first loaded, the Template popup will always display “As Stored.” If you select a Template, the popup 
menu will display the name of the Template, but after you save the GE and load it again, it will once again display “As 
Stored.” This is because the Template value is not saved in the GE, but the contents of the Pattern Grid and associated 
parameters are.
<2430>
    [Save] (button)

Brings up a Save Dialog allowing you to name the Template and save it in memory. After saving a Template, it will then be 
available in the Template popup menus for both Phases.
<OthDlg/Sbs><2431>
    [Clear] (button)

Brings up a dialog allowing you to clear the selected Template. You will be given an opportunity to cancel. After clearing, 
the Template will disappear from the Template popup menus for both Phases.

    Saving or clearing only affects the Templates in RAM. To save these changes to disk, you must save the KDF File by 
choosing “Save,” “Save As…” or “Save All…” from the File menu.

    Since the changes are not written to disk until one of the Save commands is executed, to undo a change after you have 
stored or cleared a Template you can close and reopen the current KDF file.

<Dlg>
WaveSeq - Waveform Select Dialog
 

The Waveform Select Dialog is opened by clicking on any of the round triangle buttons to the left of any Waveform Choice 
label. It allows you to choose one of the available waveforms for the selected row of the Pattern Grid. The up/down arrow 
keys or the scroll bar to the right side can be used to navigate the list. You can also type the first letter or first few 
letters of a name to jump directly to it, or enter a number directly in the value field at the bottom left to select a 
waveform if you know the ID. The current selection is highlighted in green. You will hear the changes immediately in the 
pattern (assuming this row is being used in the grid). You can change rows in the Waveform Pattern without closing this 
dialog by using the Previous Row and Next Row buttons.
<1591>
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   [Title (Current Row ID)] (label)

Displays the number of the row that you are editing. Useful when moving through the rows with the Previous Row and 
Next Row buttons.
<1588><1589>
   [Previous/Next Row] (buttons)

Moves to the previous or next row in the Waveform Pattern without closing the dialog.
<1583><1590>

    [Waveform Selection List] (scrolling list) [Off, number of available waveforms]

Displays the list of available waveforms or sound choices (which can be changed using the Menu Button). You may use the 
computer keyboard’s up/down arrow keys to navigate the list, or scroll with the scroll bar or mouse wheel. You can also 
type the first few letters of a name to jump to it, or enter a number directly in the value field at the bottom left to select 
a waveform if you know the ID. Click on a row to select, double-click to select and close the dialog. The current selection 
is highlighted in green.

 

As shown in the diagram above, the list displayed in the dialog will vary depending on the “Message Type” setting:

SysEx:
The dialog will display a list of waveforms taken from the specified Korg or Yamaha device.

Program (0~127):
The dialog will display a list of 128 “Program Number” entries corresponding to Program Change Messages 0~127. 

1 CC (0~127):
The dialog will display a list of 128 “CC Number” entries corresponding to Control Change Messages 0~127. 

4 CCs (On/Off):
The dialog will display a list of four “Elements” corresponding to four sequential CC numbers based on the CC Number 
parameter.
<1585>
    [Waveform ID] (numerical) [0...number of available waveforms]

Allows you to enter a Waveform ID number directly, for quick selection of a desired waveform. The tab key will move the 
“focus” of the dialog between the list (for the arrow keys) and the numerical (for entering the ID). For example, if you 
wanted to set multiple rows to the same Waveform, you can open the dialog, hit the tab key, enter the ID, and use the 
Previous/Next Row buttons – that’s about as quick as it gets. You can also use the arrow keys when you are inside the 
numerical, but they operate in reverse from when the list is selected.
<1584>
    [Solo] (button)

When the Solo button is on, you will hear only the notes that are being generated with the corresponding row of the 
Waveform Pattern. If you leave the Solo button on when you close, it will remain soloed, and you need to open the dialog to 
clear it, or load a new Performance or GE.

    When soloed and GE Type = Generated Riff, you will not hear any notes that are generated as a result of Melodic Repeat 
being used on the Notes Series. This is because repeated notes do not cause a Waveform Change in and of themselves; only 
notes from the Note Series transmit a Waveform Change. 
<1586><1587>

    [OK/Cancel] (buttons)

Cancel (red X) closes the dialog and returns the waveform to the previous selection. OK (green checkmark) closes the 
dialog and accepts the edited choice.

��    Cancelling out of the dialog while navigating between rows with the Previous and Next Row buttons and performing 
edits in multiple rows will revert all edits made since the dialog was opened back to the previous state.
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<0310>

Envelopes
Sections in this chapter:

Overview<EnvEd/Over>

About Envelopes<EnvEd/About>

Parameters<EnvEd/Parms>

RT Parm Virtual Parameters<EnvEd/Virt>

 

<Over>
Envelopes - Overview
Each Generated Effect has three independent envelopes that can be applied to various functions such as Velocity, Tempo, 
Pitch Bend, Duration, and to send any CC (MIDI Control Change Message).

Row For Each Envelope
Each envelope consists of a row of parameters, color-coded to match the graphic: Envelope 1 (green), Envelope 2 
(yellow), and Envelope 3 (magenta).

Graphic Editor
Displays the shapes of whichever envelopes are active. Envelope parameters can be edited by clicking and dragging in the 
Graphic Editor on the appropriate points of the displayed envelope.

Status Line
When clicking and dragging in the Graphic Editor, the Status Line at the top shows which point is being edited and the 
current value. If you click on the small colored square to the left side of the Status Line, the front-most envelope will 
cycle through all active envelopes (useful if points overlap).

Envelope On/Off
Makes an envelope active, and displays it in the Graphic Editor.

P a r a m e t e r s
Allows the envelope shape to be edited by entering or scrolling to the desired values, along with other parameters. 
<0311><0327><0328>

Level Display
Shows the action of the three envelopes when they are being run. The colors match the Graphic Editor.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:
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Copy Envelopes...<GEUtils/Eco>

    In addition to being triggered by the keyboard and various controllers through Dynamic MIDI, the envelopes can also be 
selectively triggered by each note as it is generated (see below), or at Phase Changes according to settings in the Phase 
Activity Grid (General). <PhsEd/PhsGrid>

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><About>
Envelopes - About Envelopes
For those of you familiar with synthesizer envelopes, these are standard ADSR Envelopes, with the addition of a Start 
Level. For those who are not, ADSR stands for “Attack, Decay, Sustain, Release.” When the envelope is triggered in some 
fashion like a key being depressed, the envelope starts at the Start Level and moves to the Attack Level in the amount of 
time specified by Attack Time. This is the “Attack Phase” of the envelope. Once the envelope reaches the Attack Level, it 
then immediately continues to the Sustain Level in the amount of time specified by Decay Time. This is the “Decay 
Phase.” When it reaches the Sustain Level, it will remain there until some event causes it to enter the “Release Phase,” 
typically a key being released. The envelope then moves to the Release Level in the amount of time specified by Release 
Time. 

An envelope simply describes the shape of some function, and the time that it takes. In the case of KARMA, the function is 
either a crescendo/decrescendo of the velocity levels of the notes in the phrase, an accelerando/ritard of the speed at 
which the notes are generated, an overall sweeping of the pitch, a continuous varying of a selected CC (MIDI Control 
Change), etc. The best way to understand how the envelopes function is to play with them!

Note that in the case of Velocity Envelopes, the envelope’s shape is subtractive to the Initial Velocity Level generated 
according to the Velocity Mode Parameter. The loudest value the envelope will produce is the Initial Velocity received. 
However, when low Initial Velocities are received, the Envelope is automatically scaled so that a consistent shape is 
maintained regardless of the value. In other words, the Envelope will be compressed to the degree that the Initial Velocity 
is less than 127. For more information on Initial Velocity, see Velocity Page - Global Parameters.
<VelEd/Global>

    When and how the Envelopes will be triggered is determined by the Envelope Trigger Parameters in the Trigger Page of 
the Performance Editor. See Trigger Page - Note and Envelope Triggering Parameters.
<TrgEd/ParmsTrig>

    In addition to being triggered by the keyboard, the envelopes can also be selectively triggered at Phase Changes 
according to settings in the Phase Activity Grid (General).

<PhsEd/PhsGrid><Parms>
Envelopes - Parameters
 

You can edit the three envelopes by clicking on the Graphic Editor and dragging the envelope points to new locations, which 
will update the values in the parameter fields. Alternatively, you can directly enter values in the parameter fields, or 
click and drag up/down to scroll the values, which will update the Graphic Editor.
<0312>

    [Envelope On/Off] (button) [Off, On]

Turns on the corresponding envelope, shows its shape in the Graphic Editor, and makes its parameters available to be 
edited. The parameters are the same for all three of the envelopes, and are discussed in the following section.

    Even if the envelope is turned on, you may not be hearing any effect if the Envelope MIDI Filter parameters in the 
Performance are filtering out that particular envelope. See Performance Editor > MIDI Filter Page.
<FilEd/FiltGen><0313>
    [Envelope Type] (popup menu) [0...127]

Selects the function that the envelope performs. The first six settings are specific predetermined types, while the others 
allow any MIDI CC Message to be sent by the envelope.

0: [VE] Velocity
Controls the crescendo and decrescendo of the Riff, much like an Amplitude Envelope controls the volume on a synthesizer. 
The envelope’s range of 0~99 is scaled into 0~127, which is then combined with the actual velocities of the notes being 
generated, to impart an overall velocity shape while maintaining the accents within the individual notes.

1: [TA] Tempo - Absolute
Controls the speed of the Riff, for accelerando and ritard effects. When active, the effect does not sync to the Internal 
Master Clock or External Sync, but runs on its own clock, controlled by the Tempo Envelope. This means that the envelope 
is in absolute control of the tempo, and changing the Performance or GE Tempo has no effect.
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2: [TR] Tempo - Relative
Controls the speed of the Riff, for accelerando and ritard effects. When active, the effect does not sync to the Internal 
Master Clock or External Sync, but runs on its own clock, controlled by the Tempo Envelope. However, this option takes 
into account the tempo of the Performance, so if the tempo is slower the Tempo Range of the envelope will also be slower. 
Note that this does not mean the time over which the envelope operates, which is a different option discussed below under 
the “Tempo Relative (T.Rel)” parameter.

The calculation is a ratio of the GE’s stored tempo, and the present tempo of the Performance - therefore, make sure your 
GE tempo is stored correctly (which is not the same as the Performance tempo necessarily!)

Example: assume that the envelope is set to a shape that generates an increase/decrease from 100 BPM - 120 BPM, and 
the GE is stored with a tempo of 120. If the Performance Tempo is 60 (one-half of the GE Tempo), the envelope will 
produce an increase/decrease from 50 - 60 BPM; if the Performance Tempo is 240 (two times the GE Tempo), the 
envelope will produce an increase/decrease from 200 - 240 BPM.

    If varying the Performance Tempo and using a Tempo Envelope, if the Tempo Envelope has finished running, varying the 
Performance Tempo will have no effect until the envelope is restarted.             

3: [PB] Pitch Bend
Controls an overall pitch bend on the entire effect. Note that the overall range of the Pitch Bend can be set in either the 
Bend Editor.

4: [DU] Duration
Controls an overall shortening of durations of generated notes. In other words, the normal calculated duration of the note 
becomes the maximum duration length, and the shape of the envelope scales the durations between 0~100% of the 
minimum duration length and that value. The minimum and maximum duration values depend on the Duration Mode setting in 
the Duration Page, as explained below:

- Poly Extend, Poly Extend/Damped, Mono Extend
The Duration Envelope only affects notes that have durations shorter than the current Rhythm Pattern value (as specified 
by the Duration Pattern Grid), since the other notes will be auto-extending to the next note or next occurence of the same 
note. For the shorter notes, the length of the Duration Pattern Value represents the maximum duration, and the envelope’s 
0~99 range represents 0~100% of that value, with 1 ms being the minimum duration. To adjust the minimum duration, 
you would adjust the envelope’s level settings to only move between the higher values, i.e. 50~99.

- Timed (Duration Value range: 1 ~ 5000 ms)
The Duration Value represents the maximum duration in milliseconds, and the envelope’s 0~99 range represents 0~100% 
of that value. For example, if the Duration Value is set to 250 ms, then the envelope shapes the durations from 1 ms to 
250 ms over its 0~99 range. To make the durations go from 125 ms to 250 ms, you would adjust the envelope’s level 
settings so that it moves from 50~99 (50%-100%).

- Rhythm Overlap, Pattern Overlap (Duration Value range: -500 ~ 500 ms)
The Duration Value represents the maximum overlap or gap (in milliseconds) between successive notes, and the 
envelope’s 0~99 range represents 0~100% of that value. For example, if the Duration Value is set to +20, then the 
envelope shapes the durations from -500 ms to +20 ms over its 0~99 range. To adjust the minimum duration, you would 
adjust the envelope’s level settings to only move between the higher values, i.e. 50~99.

- Rhythm %, Pattern % (Duration Value range: 1 ~ 800 %)
The Duration Value represents the maximum percentage of the current Rhythm Pattern Value, and the envelope’s 0~99 
range represents 0~100% of that value. For example, if the Duration Value is set to 50% ms, then the envelope shapes 
the durations from 1% to 50% of the Rhythm Pattern Value over its 0~99 range. To make the durations go from 25% to 
50%, you would adjust the envelope’s level settings so that it moves from 50~99 (50%-100%).

For more information about Duration Modes, see Duration Page - Pattern Grid & Associated Parameters.
<DurEd/PatGrid>

5: [RT] Repeat Time
Controls an overall shortening of the repeat time that is selected for use in the Melodic Repeat Group. In other words, the 
normal calculated repeat time becomes the maximum time, and the shape of the envelope scales the repeat time between 
0~100% of 1 ms and that value. For example, if the Repeat Rhythm Value was set to a 16th note at 120 BPM, the repeat 
time would be 125 ms for each note. A Repeat Time Envelope would vary the envelope’s range of 0~99 between 1 ms and 
125 ms. This can provide interesting “bouncing” delay effects with repeats of the same pitch on drum and perc sounds, 
among other unique effects.

[6...127] MIDI CC Numbers 0...121
Send the selected CC value according to the shape of the envelope - the envelope’s range of 0–99 is scaled into 0–127 and 
sent as the selected controller. This is especially useful when you loop the envelopes to get slow, sweeping LFO effects, 
for controlling various tone generation characteristics on synthesizers and effects devices that support this type of 
control. Note that for looping to work, you must set the Loop Mode and Envelope Latch Modes properly - see the “Loop 
Mode” parameter below.

    All of the following Level and Time parameters may also be controlled in different combinations via a group of 
“virtual” RT Parms. See Envelope Page - RT Parm Virtual Parameters. <EnvEd/Virt>
<0314>

    [Start Level (SL)] (numerical) [0...99]

The level at which the envelope begins when triggered. 
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<0315>
    [Attack Time (AT)] (numerical) [0...99]

The time it will take to reach the Attack Level. This is a portion of the overall time setting specified in the “Time Scale” 
menu described below. 
<0316>

    [Attack Level (AL)] (numerical) [0...99]

The first level the envelope reaches in the amount of time specified by Attack Time.
<0317>
    [Decay Time (DT)] (numerical) [0...99]

The time it will take to reach the Sustain Level from the Attack Level. This is a portion of the overall time setting 
specified in the “Time Scale” menu described below.
<0318>

    [Sustain Level (SL)] (numerical) [0...99]

The second level the envelope reaches in the amount of time specified by Decay Time. The envelope will remain at this 
level until the keys depressed on the keyboard are released, or some other function causes the envelope to enter the 
Release Phase.
<0319>

    [Release Time (RT)] (numerical) [0...99]

The time it will take to reach the Release Level from the Sustain Level, once the Release Phase is triggered. This is a 
portion of the overall time setting specified in the “Time Scale” menu described below.
<0320>
    [Release Level (RL)] (numerical) [0...99]

The final level the envelope reaches in the amount of time specified by the Release Time.
<0321>

    [Amplitude Amount (Amt)] (numerical) [0...99]

Represents the maximum level that the envelope will reach. The rest of the envelope is scaled accordingly. For example, 
if this is set to “50,” the envelope’s output will be half what the other parameters specify.
<0322>
    [Time Scale] (popup menu) [0: R-Riff Length, 1...10: 1 to 10 seconds in 1 second increments]

Specifies the overall amount of time that each segment will take when set to its maximum value. The envelopes in a 
KARMA GE are three segment envelopes; they have an attack segment, decay segment, and release segment. For example, 
if the attack segment time (attack time) was set to “99” and the Time Scale to “1 second,” the attack segment will take 
1000 ms; if attack time was set to “50,” then the attack segment will take 500 ms. If the times of all three segments 
were set to “99,” the total time of the envelope would be approximately 3 seconds (not taking into account any time 
spent at the sustain level). When set to “Riff Length,” the Time Scale is automatically scaled to the length of the 
Generated Effect. This can be useful for such things as harp glissandos, where supplying more/less notes as input will 
cause the resulting envelopes to be slower/faster. Note that if the Phase Length Mode is set to Time Signature, then the 
length of a Phase is determined by the Time Signature and not the number of notes played, so the results of setting this to 
“Riff Length” may not be noticeable in that case.
<0323>

    [Tempo Relative (T. Rel)] (checkbox) [Off, On]

When on, makes the selected envelope’s time scale relative to tempo. This means that the envelope can “track” the notes 
being generated, or a particular length of time. If you have it set to make a particular shape over one bar of 4/4, then 
changing the tempo will maintain this relationship by scaling the tempo range of the envelope accordingly. 

For example, assume you have an envelope timed to produce a sweep over one bar of 4/4 at 120 BPM. If you change the 
tempo to 60 and the T.Rel checkbox is off, the envelope will still operate for the same length of time, therefore sweeping 
over 1/2 of the bar of 4/4. If you set tempo to 240, it would sweep over two measures of 4/4. With T.Rel on, the time 
scale of the envelope is changed according to the tempo. Therefore, it will always sweep over one bar of 4/4 regardless 
of the tempo.

    You can use this with the [TR] Tempo - Relative Envelope Type (described above), so that it not only has a range that 
is influenced by the tempo, but its time scale is also influenced by the tempo.
<Loop><0324>
    [Loop Mode] (popup menu) [0...3]

Selects one of several methods of causing the envelope to loop continuously from one point back to another.

Off
Envelope will proceed through all its segments in a normal fashion.

0: S - Start Level <--> Sustain Level
Upon reaching the Sustain Level, the envelope will loop back to the Start Level and start over. Requires Envelope Latch 
Mode (in the Performance Editor > Trigger Page) to be set to “Off,” “Sus1,” or “Sus2.” For continuous looping after 
key release, you must have “Sus2” selected - see the table below.
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1: R - Start Level <--> Release Level
Upon reaching the Release Level, the envelope will loop back to the Start Level and start over. Requires Envelope Latch 
Mode (in the Performance Editor > Trigger Page) to be set to “Rel1” or “Rel2.” For continuous looping after key release, 
you must have “Rel2” selected - see the table below.

2: A - Attack Level <--> Release Level
Upon reaching the Release Level, the envelope will loop back to the Attack Level and start over. Requires Envelope Latch 
Mode (in the Performance Editor > Trigger Page) to be set to “Rel1” or “Rel2.” For continuous looping after key release, 
you must have “Rel2” selected - see the table below.

The following table illustrates the relationship between the three Envelope Loop Modes described above, and the Envelope 
Latch Modes (set in the Performance Editor > Trigger Page). <TrgEd/EnvLatch>

 

<0325>
    [Attack Smooth (Sm)] (checkbox) [Off, On]

When set to off, retriggering an envelope will start it at its preset Start Level regardless of its current position. When 
set to on, the envelope will restart from its current position, not the Start Level. This can be used to “smooth” the 
repeated retriggering of the envelope.
<0326>

             [Note Trigger (Nt)] (checkbox) [Off, On]

Allows an envelope to be triggered with every single note. When set to off, the envelope is triggered normally as specified 
by the settings of the Performance Editor > Trigger Page, Dynamic MIDI, and the Envelope Triggering rows of the Phase 
Editor. When set to on, every single note that is generated will retrigger the selected envelope. For example, this can be 
useful for adding Vibrato to individual notes (using an envelope set to CC 01 (Mod Wheel)), or fading in/out individual 
notes (using an envelope Type of CC 07 (Volume) or CC 11 (Expression)). 

<Virt>
Envelopes - RT Parm Virtual Parameters
The following parameters are not true parameters, but “virtual” parameters for RT Parm control. In other words, they 
do not physically exist on the Envelope Page, but perform a modifying function on one or more of the other parameters. 
They allow different combinations of several parameters from the same envelope to be varied at the same time. They can 
be found in the Envelope Group when assigning parameters in the GE Editor > RT Parms Page, and have a tilde (~) at the 
beginning of the parameter name (indicating that they are virtual).

    [~Sta/Att Level] (virtual) [0...99]

Controls an Envelope’s Start and Attack Levels at the same time - both will be set to the same value.

    [~Sta/Sus Level] (virtual) [0...99]

Controls an Envelope’s Start and Sustain Levels at the same time - both will be set to the same value.

    [~Sta/Rel Level] (virtual) [0...99]

Controls an Envelope’s Start and Release Levels at the same time - both will be set to the same value.

    [~Att/Sus Level] (virtual) [0...99]

Controls an Envelope’s Attack and Sustain Levels at the same time - both will be set to the same value.

    [~Att/Rel Level] (virtual) [0...99]

Controls an Envelope’s Attack and Release Levels at the same time - both will be set to the same value.

    [~Sus/Rel Level] (virtual) [0...99]

Controls an Envelope’s Sustain and Release Levels at the same time - both will be set to the same value.

    [~Sta/Att/Sus Level] (virtual) [0...99]

Controls an Envelope’s Start, Attack and Sustain Levels at the same time - all will be set to the same value.
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   [~Sta/Att/Rel Level] (virtual) [0...99]

Controls an Envelope’s Start, Attack and Release Levels at the same time - all will be set to the same value.

    [~Sta/Sus/Rel Level] (virtual) [0...99]

Controls an Envelope’s Start, Sustain and Release Levels at the same time - all will be set to the same value.

    [~Att/Sus/Rel Level] (virtual) [0...99]

Controls an Envelope’s Attack, Sustain and Release Levels at the same time - all will be set to the same value.

     [~All Levels] (virtual) [0...99]

Controls an Envelope’s Start, Attack, Sustain and Release Levels at the same time - all will be set to the same value.

    [~Att/Dec Time] (virtual) [0...99]

Controls an Envelope’s Attack and Decay Times at the same time - both will be set to the same value.

    [~Att/Rel Time] (virtual) [0...99]

Controls an Envelope’s Attack and Release Times at the same time - both will be set to the same value.

    [~Dec/Rel Time] (virtual) [0...99]

Controls an Envelope’s Decay and Release Times at the same time - both will be set to the same value.

    [~All Times] (virtual) [0...99]

Controls an Envelope’s Attack, Decay and Release Times at the same time - all will be set to the same value.
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Melodic Repeat
Sections in this chapter:

Overview<RptEd/Over>

About Melodic Repeat<RptEd/About>

General Parameters<RptEd/ParmsGE>

Real-Time Parameters<RptEd/ParmsRT>

Range Parameters<RptEd/ParmsRange>

RT Parm Virtual Parameters<RptEd/Virt>

 

<Over>
Melodic Repeat - Overview
Melodic Repeat™ allows any note to be repeated in a delay-like fashion, with many additional features and enhancements. 
When the GE Type is one of the “Generated” types (i.e.“Generated - Riff”), the notes as they are generated may each 
start sequences of repeating notes. When the GE Type is “Real-Time,” the actual input notes may each start sequences of 
repeating notes. As shown above, the parameters have been divided into several distinct groups:

General Parameters
Parameters that affect repeating note generation in general, regardless of which GE Type is selected.

Real-Time Parameters
Additional parameters that only are available and have an effect when the GE Type is “Real-Time.”

Range Parameters
Parameters that affect the pitch range of the repeating notes as they transpose, and what happens when they go outside of 
the range. Also contains parameters for using a velocity range to trigger repeats.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Turn On In All Steps Of Phase Pattern
Turn Off In All Steps Of Phase Pattern
Allows all of the buttons in the [mr] (melodic repeat) row(s) of the Phase Activity Grid to be turned on/off at once, 
saving you a trip to the Phase Page. Melodic Repeat will not occur if none of these buttons are on, regardless of how the 
parameters are set.
<PhsEd/PhsGrid><0358>
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    When none of the [mr] (melodic repeat) buttons are turned on in the Phase Activity Grids, all of the Repeat Page 
Parameters will be grayed out and unavailable, and the message “Not In Use In Phase Page” will appear in the upper right 
corner.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><About>
Melodic Repeat - About Melodic Repeat
Melodic Repeat is based on a familiar technique know as “MIDI Delay,” where MIDI notes are repeated at certain time 
intervals while their velocities decrease, thus imitating the effect of delay in an external effects processor. However, as 
typically implemented, this causes severe polyphony problems, and the creative options are few. In KARMA, many 
sophisticated enhancements and improvements have been added, including:

• Slow down the Master Tempo and the repeated notes will remain in time with the original notes.
• Use the Tempo envelope to create drastic accelerandos and ritards and then lock the repeated notes to the envelope.
• Use a Repeat Time Envelope to modulate the time between each repeat, for unique rhythmic effects.
• Unique Duration Modes not only save polyphony, but create interesting performance options as well.
• Delayed pitches may be transposed and melodically shifted using Chord Recognition.
• Transposed notes may be rebounded or wrapped around within a range. The range may be an absolute range, or a 
“sliding” range that tracks the input notes.
• Only notes within certain a certain velocity range can trigger repeated notes, while others will not.
• The Rhythm Patterns, Note Patterns, Velocity Patterns, etc. may be used to control when and how the repeated notes 
are generated.

However, no repeats will actually occur unless the [mr] (melodic repeat) row(s) of the Phase Activity Grid in the Phase 
Page has some buttons turned on. This allows you to set up an effect where repeats only occur in one or more steps of the 
Phase Pattern, while other steps have no repeats. The Menu Button popup provides a convenient way to turn these on/off 
all at once. Furthermore, certain steps of the Phase Pattern can be set to “turn off” pending repeats which might overlap 
into the new step, by using the Bend/Repeat [no] (no overlap) row of the grid. See Phase Page - Phase Activity Grid 
(General).
<PhsEd/PhsGrid>

    When the “GE Type” is one of the Generated types (i.e. Generated-Riff), the notes as they are generated may each 
start strings of repeating notes. When the “GE Type” is Real-Time, the actual input notes may each start strings of 
repeating notes.

    Repeats can not be generated when “GE Type” = Generated-Gated and “Gate Type” is one of the CC Types, since notes 
are not actually generated in this mode, but a sustained set of notes is manipulated by a selected CC, i.e. “chopped” by CC 
#11 (Expression).

<ParmsGE>
Melodic Repeat - General Parameters
 

The parameters in this section affect repeated note generation in general, regardless of which GE Type is selected.
<0334>
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    [Rhythm] (popup menu) [0...25]

Sets the rhythm (repeat time) for each repeated note (16th note, dotted 16th, etc.). All rhythms chosen here lock to the 
Global Tempo, or to the Tempo Envelope if “Tempo Env. Lock” is on, described below.

0: None
The repeated notes are put out simultaneously with the generated/input notes, without any delay. This can be used to 
generate clusters of notes, while using Repeat Transpose (below) to change the pitch intervals between them, for creating 
harmonies and other effects.

1...24: Note Values
Selects a rhythmic value to use for each repeated note. When one of these Note Values is chosen, the same rhythmic value 
is used for each repeated note.

25: Pattern
The Rhythm Pattern in the Rhythm Page is used (indicated by a grid graphic in the popup), so that repeated notes can have 
different rhythms.

The Rhythm parameter can also be controlled by several “virtual” RT Parms. See Repeat Page - RT Parm Virtual 
Parameters. 
<RptEd/Virt><0335>
    [Use Swing] (button) [Off, On]

Sets whether the repeated notes will take on the swing feel that is set in the Rhythm Page. If off, the generated notes may 
be swung but the repeated notes will not be.

    When the Rhythm Page Swing % is 0, this parameter has no effect.
<0357>

    [Time Offset (ms)] (numerical) [-127...+127]

Allows a positive or negative millisecond offset to be applied to very short repeat times, making them slightly shorter or 
longer. One use is to “tune” resonant delay effects created with short repeat times to a certain key.

    Only available and operable when one of the first three settings of the Rhythm menu are selected (None, 64th triplet, 
or 64th). For example, you can use it to adjust a short Rhythm setting, and then switch to a longer setting via RT Parm 
control, and the offset will be ignored, allowing the longer rhythms to stay in sync.
<0336>

    [Repetitions] (numerical) [0...100, 101 = ∞]

The maximum number of repeated notes to generate. Note that due to other settings and circumstances, not all of them 
may actually be generated. A setting of 101 (infinity ∞) causes the notes to repeat indefinitely, unless something else 
stops them.
<0337>

    [Initial Velocity] (numerical) [-126...+126]

The velocity above or below the original note that the first repeated note is generated at, after which the Decay 
parameter is added to them with each successive repetition. Note that this operates in conjunction with the Velocity 
Pattern specified in the Velocity Page.
<0338>
    [Decay] (numerical) [-126...+126]

The amount by which each successive repeated note changes in velocity. Negative numbers cause the delayed notes to 
decrease in volume (more common), while positive numbers cause the delayed notes to increase in volume. Interesting 
effects can be created by a combination of a high negative Initial Velocity (i.e. -120) and a small positive Decay (i.e. 4). 
Note that this operates in conjunction with the Velocity Pattern specified in the Velocity Page.
<0339>
    [Transpose] (numerical) [-24...+24 semitones, Index Pattern)

The amount by which each successive repeated note is transposed in pitch. When one of the number values is selected, the 
same value is used for each repeated note. When “Index Pattern” is selected, the Index Pattern in the Index Page is used, 
so that each repeated note can transpose a different amount from the previous repeated note. Depending on the input 
notes, anything other than 0 or multiples of 12 may produce atonal results; these can be shifted to tonal results using 
“Chord Shift,” described below.
<0340>
    [Chord Shift] (popup menu) [0...2]

When repeated notes are being transposed in pitch, atonal results may occur depending on the Transpose setting. When 
Chord Shift is off, no change occurs in the transposition. Setting Chord Shift to one of the Scalic modes causes chord 
recognition algorithms to shift the notes to musically correct ones, even in pending repeated notes that haven’t yet 
sounded.
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Even when the Transpose setting is “0,” this can be used to make the pending repeated notes conform to the new chord, 
which is impossible with outboard analog/digital delays. For example, if Chord Shift is off and you strike a BMaj chord 
which will repeat 10 times, and then play a C Major chord before they have all repeated, the still to be generated repeats 
will be BMaj repeats overlapping CMaj repeats (dissonant). With Chord Shift on, the still to be generated repeats will shift 
to the new chord and blend with the new repeats.

    When used with GE Type “Real-Time,” a certain area of the keyboard may need to be assigned as a Control Area (in 
the Dynamic MIDI Page) for Chord Shift to produce the desired results.

0: Off
The transposed notes are repeated with no further modification from this setting.

1: Scalic
As the notes are repeated, notes which may be “atonal” based on the analyzed chord (due to being transposed) are shifted 
to tonal notes. Especially useful when “Transpose” (discussed above) is set to something other than 0 or multiples of 12. 
The note tables used to shift the notes have fewer passing tones than Scalic (described below), and therefore may produce 
results that are more pleasing.

2: Scalic 2
Same as Scalic (above), except that the note tables used to shift the notes have more passing tones for each chord; 
therefore, Scalic 2 sounds more modal in nature.

    When running Drum Patterns through Melodic Repeat, if the [ntt] button is off for a particular Drum Pattern, notes 
from that pattern will not be affected by the Chord Shift feature.
<0341>
    [Adjust Dupes] (button) [Off, On]

When Chord Shift is set to “Scalic” or “Scalic 2,” notes are shifted as they are transposed to avoid atonal notes, based 
on chord analysis. If small Transpose values are used (+1, for example), this results in duplicate notes side by side. While 
you may want this effect sometimes, setting Adjust Dupes to on activates an algorithm that pleasantly meanders the 
duplicate notes to adjacent pitches. Note that this does not affect deliberately generated duplicate notes when using a Note 
Pattern with Melodic Repeat (i.e. set Transpose menu to “Pattern,” and the Note Pattern has values of “0” in it) - only 
notes that would be duplicated because of the Chord Shift feature being on.

    Not available when Chord Shift is set to off.
<0342>
    [Stop Mode] (popup menu) [0...2]

Allows pending repeated notes that haven’t sounded yet to be discarded (stopped) by various actions.

0: Off
Playing new chords or notes do not affect pending repeated notes - they will continue repeating as the parameters specify. 
This allows previously started repeats to overlap newly started repeats.

1: Any Note
Playing any new chords or notes will cause all pending repeated notes to be discarded, and only the new notes will be 
repeated.

2: AKR - 1st Note After Key Release
Playing any new notes while still sustaining at least one note will not cause damping; all keys must first be released, and 
then the next chord/note will discard any pending repeated notes.

    When a Dynamic MIDI Destination is set to “Trigger Notes” or “Trigger Notes & Envs,” the Stop Mode parameter also 
applies to whether the repeats will be stopped when triggered by the Dynamic MIDI action.

    A MIDI Controller can also be assigned to perform the stopping of repeats by using the “Melodic Repeat Stop” Dynamic 
MIDI Destination.
<0343>
         [Tempo Env. Lock] (button) [Off, On]

When a Tempo Envelope is being used (in the Envelope Page), setting this to on causes the repeated notes to lock their 
rhythm to the Tempo Envelope (as the Tempo Envelope speeds up the times between them get smaller). Setting this to off 
causes the rhythm of the notes to remain relative to the Global Tempo; even though the Tempo Envelope may be speeding 
up or slowing down the effect, the repeat times remain the same.

    When the Tempo Envelope is off, this parameter has no effect.

<ParmsRT>
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Melodic Repeat - Real-Time Parameters
 

If the GE Type is “Real-Time,” these additional parameters will also become available.
<0344>
    [Duration Mode] (popup menu) [0...4]

Chooses one of several different modes for the durations of the repeated notes, which not only can greatly reduce 
problems with polyphony, but also provide some interesting performance options.

0: As Played
Each delayed note will have the same duration as the initial note, with the exception that if Transpose is 0, then notes of 
the same pitch will not overlap. If Transpose is other than 0, and many notes are sustained, this can quickly eat up a lot of 
the polyphony of your sound modules.
1: Fixed
The original note will have the duration as played, but each repetition will have a fixed length, set by the Duration ms 
parameter, in milliseconds. This can be used so that holding long notes will have repeated notes with short durations, 
saving polyphony or creating useful effects.
2: As Played-No Overlap
If the original note is shorter than the repeat time, each delayed note will have the same duration as the initial note. If the 
original note is longer than the repeat time, it will be cut-off by the first repeat, and each repeat will cut-off the 
preceding one. Therefore, all notes including the original one will not have a duration longer than the repeat time.
3: Fixed-No Overlap
If the original note is longer than the repeat time, it will be cut-off by the first repeated note. Furthermore, each repeated 
note will have a fixed value in milliseconds, set by the Duration ms parameter.
4: As Played-Delay No Overlap
The original note will have the duration as played, and so will the delays, as long as they are shorter than the repeat time. 
If the original note is longer than the repeat time, it will not get cut-off, but the delays will limit their lengths to the 
repeat time.

The diagram below gives a visual representation of the Duration Modes:
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<0345>
    [Duration ms] (numerical) [2...5000 ms]

Specifies the length of the durations of the repeated notes (in milliseconds).

    Only available when the Duration Mode is one of the Fixed modes.
<0346>
       [Key Mode] (button) [Down (Off), Up (On)]

Selects whether the repeated notes start immediately upon receiving a “key down” event, or wait until notes are 
released (“key up”).

Down
Generation of the repeated notes starts immediately upon receiving a note according to the settings of the parameters.

Up
Generation of the repeated notes is not started until the input source note(s) are released. This allows you to trigger the 
start of a repeated effect with the release of the keys.
<0347>
    [Chord Quantize] (button) [Off, On]

Causes one of two different types of behavior, depending on the setting of the Key Mode parameter above:

When Key Mode is “Down”
When a chord is played on the keyboard, there is a certain amount of “slop” associated with hitting the keys: the fingers 
arrive at slightly different times, there is a built in amount of MIDI timing inaccuracy, etc. When using Melodic Repeat to 
repeat the chord a number of times, you will hear the same slop it was received with repeated exactly. This corresponds 
to the Chord Quantize setting of off. This may or may not be desirable; sometimes you may want it, other times you may 
not. When Chord Quantize is set to on, the notes in the first repeat of the chord will be hard quantized so that they 
generate simultaneously. All subsequent repeats will be based on those quantized notes, and therefore will also be 
quantized.

When Key Mode is “Up”
The repeats will be normally triggered when the key(s) are released, so they will be quantized together at that point to 
occur simultaneously anyway, with no “slop.” However, depending where you released them overall in time, they may be 
“out of sync” with the rhythm or groove that may be being generated. This corresponds to the Chord Quantize setting of 
off. When Chord Quantize is set to on, the release (and generation of the first repeats) will be quantized to correspond to 
the nearest rhythmic division of note generation. This will either be a 16th note, or the rhythm value chosen in the Repeat 
Rhythm popup menu, whichever is longer.

<ParmsRange>
Melodic Repeat - Range Parameters
 

These parameters affect the pitch range of the repeating notes as they transpose, and what happens when they go outside 
of the range. The range can be expressed differently, depending on the Range Mod. As shown above, when the Range Mode 
is Absolute, you specify a highest and lowest note. When the Range Mode is one of the relative options, you specify a 
sliding range that follows your hands around the keyboard. This section also controls a range for triggering by velocity.
<0348>
    [Range Mode] (popup menu) [0...3]

Selects one of several options for how the Range Bottom and Range Top values are used, which specify a range within 
which repeated notes will be maintained. This can be either an “absolute range,” or a “sliding range” that tracks your 
hands around the keyboard. When notes go beyond this range, they will either stop repeating, wrap around or rebound, as 
determined by the Rebound Mode setting (described later on).

0: Absolute
The Range Bottom and Range Top parameters are Note Number values that specify the absolute bottom and top of the pitch 
range for repeated notes. 

1: Lowest Note Relative
The Range Bottom and Range Top parameters define a “sliding range” with regards to the lowest note played. The range 
fields change to numbers indicating semitones. For example, if you set bottom to -12 and top to +12, this means that the 
notes will be kept in range from an octave below the lowest note played to an octave above the lowest note played. 
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2: Highest Note Relative
The same as above, but relates to the highest note played.

3: Lowest/Highest Note Relative
The Range Bottom parameter relates to the lowest note played, and the Range Top parameter relates to the highest note 
played. Therefore, you control the overall range according to the spread of the notes that are played. For example, if you 
set both Range Bottom and Range Top to “0” in this mode, then repeated notes would never be generated outside of the 
range of the lowest to highest note that were provided as input.
<0349><0350><0351>
    [Range Bottom/Top] (numericals)  [C-2...G8 (when Mid C = C3) or -64...+63] 
    [Range Bottom/Top (abs)] (RT Parm)  [C-2...G8  (when Mid C = C3)]

    [Range Bottom/Top (rel)] (RT Parm)  [-64...+63]

Specifies a pitch range within which to keep repeated notes that are being transposed. The values selected here have 
different meanings depending on the Range Mode described above. When the pitches of repeated notes exceed this range, 
the setting of the Rebound Mode comes into effect.

When Range Mode is “Absolute”:
The Bottom and Top values are Note Numbers in the range [0...127, C-2...G8], and specify the absolute bottom and top of 
the pitch range for repeated notes. 

When Range Mode is one of the “Relative” settings:
The Bottom and Top values are semitone offsets in the range [-64...+63], and specify a “sliding range” with regards to 
the notes played.

    When using RT Parms to control the Range Bottom/Top, you must choose between using the Range Bottom/Top (abs) 
parameters (for Range Mode = 0: Absolute), or the Range Bottom/Top (rel) parameters (for Range Mode = 1...3: Relative 
settings).

    Whether the note names reference Middle C as C3 or C4 is controlled by the “Middle C Display” option in the 
Preferences > Workspace settings.
<Prefs/MidC><0352>
    [Rebound Mode] (popup menu) [0...2]

When using Transpose with repeated notes and many repetitions, eventually the pitches of the repeated notes may go 
beyond a certain range. This can be an absolute overall range, or a smaller “sliding” range designed to track the hands 
around the keyboard. The range and functioning of it is determined by the settings of the Range Mode and Range 
Bottom/Top parameters described above. When the pitches of repeated notes goes beyond this range, the Rebound Mode 
setting determines whether the repeats will end or continue in a modified fashion.

0: Off
When repeated notes go beyond the specified range, they will cease to repeat, regardless of the number of repetitions left.

1: Wrap
When repeated notes go beyond the specified range, they will drop up or down an algorithmically determined interval 
(depending on which end of the range they exceed) and continue until the required number of repetitions have been 
generated. This will cause a “cycling” effect at the top or bottom of the range.

2: Rebound
When repeated notes go beyond the specified range, they will reverse their direction (essentially by inverting the current 
Transpose values) and continue in the opposite direction until the required number of repetitions have been generated.
<0353><0354><0355>

    [Velocity Bottom/Top] (numericals) [1...127]

Specifies a Velocity Range for initiating the generation of repeated notes. Input notes with velocities outside of this range 
will not generate repeats.

When GE Type is “Real-Time,” these specify a velocity range within which input notes will trigger the generation of 
repeated notes. Notes outside of the velocity range will not generate repeats. This is an easy way to allow the velocity 
with which you play to control the triggering of repeated notes.

When GE Type is any of the other options, these specify a velocity range within which generated notes (such as notes from 
the Note Series, or Drum Pattern notes) will trigger the generation of repeated notes. Notes outside of the velocity range 
will not generate repeats. This allows only certain notes within certain velocity ranges to trigger the generation of 
repeated notes, while others will not.

<Virt>
Melodic Repeat - RT Parm Virtual Parameters
The following parameters are not true parameters, but “virtual” parameters for RT Parm control. In other words, they 
do not physically exist on the Melodic Repeat Page, but perform a modifying function on one or more of the other 
parameters. They can be found in the Repeat Group when assigning parameters in the GE Editor > RT Parms Page, and have 
a tilde (~) at the beginning of the parameter name (indicating that they are virtual).
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   [~Straight Rhythm Values] (virtual) [0...11]

Selects a value for the Repeat Rhythm field from a subset of the entire range. The subset consists of the straight values 
(no triplets or dotted values) along with None and Rhythm Pattern. This is used to provide real-time control of the Repeat 
Rhythm parameter while excluding certain of the in-between values.

0: None (Instant)
1: 64th
2: 32nd
3: 16th
4: 8th
5: Quarter
6: Half
7: Whole
8: 2 Wholes
9: 3 Wholes
10: 4 Wholes
11: Rhythm Pattern

    [~Dotted Rhythm Values] (virtual) [0...8]

Selects a value for the Repeat Rhythm field from a subset of the entire range. The subset consists of the dotted values 
along with None and Rhythm Pattern. This is used to provide real-time control of the Repeat Rhythm parameter while 
excluding certain of the in-between values.

0: None (Instant)
1: 64th Dotted
2: 32nd Dotted
3: 16th Dotted
4: 8th Dotted
5: Quarter Dotted
6: Half Dotted
7: Whole Dotted
8: Rhythm Pattern

    [~Triplet Rhythm Values] (virtual) [0...8]

Selects a value for the Repeat Rhythm field from a subset of the entire range. The subset consists of the triplet values 
along with None and Rhythm Pattern. This is used to provide real-time control of the Repeat Rhythm parameter while 
excluding certain of the in-between values.

0: None (Instant)
1: 64th Triplet
2: 32nd Triplet
3: 16th Triplet
4: 8th Triplet
5: Quarter Triplet
6: Half Triplet
7: Whole Triplet
8: Rhythm Pattern

    [~Selected Rhythm Values] (virtual) [0...13]

Same as “Straight Rhythm Values,” except adds the two most musically useful dotted values also.

0: None (Instant)
1: 64th
2: 32nd
3: 16th
4: 8th
5: 8th Dotted (additional dotted value)
6: Quarter
7: Quarter Dotted (additional dotted value)
8: Half
9: Whole
10: 2 Wholes
11: 3 Wholes
12: 4 Wholes
13: Rhythm Pattern

Page 290



   [~Selected Rhythm Values 2] (virtual) [0...18]

Specially created for Drum GEs, providing the same subset as Selected Rhythm Values (above), with the addition of the 
most useful short note values (which can be “tuned” using the Time Offset (ms) Parameter).

0: None (Instant)
1: 64th Triplet
2: 64th
3: 64th Dotted
4: 32nd Triplet
5: 32nd
6: 16th Triplet
7: 16th
8: 8th Triplet
9: 8th
10: 8th Dotted
11: Quarter
12: Quarter Dotted
13: Half
14: Whole
15: 2 Wholes
16: 3 Wholes
17: 4 Wholes
18: Rhythm Pattern
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Bend
Sections in this chapter:

Overview<BndEd/Over>

General Parameters<BndEd/ParmsGE>

Real-Time Parameters<BndEd/ParmsRT>

Drum Parameters<BndEd/ParmsDrm>

Range Parameters<BndEd/ParmsRng>

 

<Over>
Bend - Overview
The Bend Page allows various shapes of automatic pitch bending to be applied to individual notes as they are generated 
(“Auto Bend”). It also allows a special “arpeggiated bending” option to be applied to Drum Patterns. As shown above, the 
parameters have been divided into several distinct groups:

General Parameters
Parameters that affect automatic pitch bending in general, regardless of which GE Type is selected.

Real-Time Parameters
Additional parameters that only have an effect when the GE Type is “Real-Time.”

Drum Parameters
Additional parameters that only have an effect when the GE Type is “Generated-Drum.”

Range Parameters
An overall Bend Range setting that affects all pitch bending for the GE, including Pitch Bend Envelopes and CC-A/CC-B (if 
generating bend).

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Turn On In All Steps Of Phase Pattern
Turn Off In All Steps Of Phase Pattern
Allows all of the buttons in the [pb] (pitch bend) row of the Phase Activity Grid to be turned on/off at once, saving you a 
trip to the Phase Page.
<PhsEd/PhsGrid>
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    No bending will actually occur unless the [pb] (pitch bend) row of the Phase Activity Grid in the Phase Page has some 
buttons turned on. This allows you to set up an effect where bending only occurs in one or more steps of the Phase 
Pattern, while other steps have no bending. See Phase Page - Phase Activity Grid (General).
<PhsEd/PhsGrid>

    Bending is also affected by the Rhythm Pattern’s “no bend” row. Bending will normally be triggered with every single 
generated note or cluster within a Phase Pattern step where bending is activated. By using the “no bend” row, you can 
specify that bends will not occur on various notes (single steps) of the Rhythm Pattern. See Rhythm Page - Pattern Grid & 
Associated Parameters. 
<RhyEd/PatGrid>

    Note that even if bending is properly activated, you may not be hearing any bending effects if the Performance’s MIDI 
Filter Page has been set to filter out the pitch bend data that KARMA is generating. See MIDI Filter Page - Generated Data 
Parameters. 
<FilEd/FiltGen><0360>
 

    When none of the [po] (pitch bend) buttons are turned on in the Phase Activity Grid (General), most of the Bend Page 
Parameters will be grayed out and unavailable, and the message “Not In Use In Phase Page” will appear in the upper right 
corner.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><ParmsGE>
Bend - General Parameters
 

<0361>
    [Bend On/Off] (button) [Off, On]

Allows the bending effects configured on this page to be turned on or off. While there are several other ways to disable 
bending effects, this is mainly provided to allow the RT Parms to control this in real-time. 

    This has no effect if there are no Phase Pattern Steps with bending enabled, or every step of the Rhythm Pattern has a 
“no bend” button turned on.

    The utilities in the Menu Button for the Bend Page provide a quick and easy way turn on or off all [pb] (pitch bend)) 
buttons in the Phase Page without going there.
<0362>
    [Amount] (popup menu) [-12...+18]

Sets the size in semitones of the bends, or selects one of several special bending options. Note that the actual resulting 
size of the bend also depends on the setting of the Bend Range parameter, described later on. The following descriptions 
apply when the Bend Range value is “12” (an octave). If the Bend Range was “6,” the semitones would actually be 
half-semitones; if the Bend Range was “24,” the semitones would actually be whole tones.

0: Random (-12~12)
Each bend selects a random semitone size from -12 ~ 12 (excluding 0).

-12...+12 (Semitones)
Bends each note the selected semitone size.
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13: Next Note
Bends each note to what will be the next note. For example, if the notes to be generated were {C, E, G, B, C...}, then the C 
will bend to the E, the E will bend to the G, etc. This is very useful for simulation of portamento, or effects like sliding 
from one bass note to the next within a phrase.

14: Next Note + 1
Bends each note to what will be the note two notes from the current note. For example, if the notes to be generated were 
{C, E, G, B, C...}, then the C will bend to the G, the E will bend to the B, etc.

15: Next Note + 2
Bends each note to what will be the note three notes from the current note. For example, if the notes to be generated were 
{C, E, G, B, C...}, then the C will bend to the B, the E will bend to the second C, etc.

16: Prev Note
Bends each note to what was the previous note. For example, if the notes to be generated were {C, E, G, B, C...}, then the 
E would bend to the C, the G would bend to the E, the B would bend to the G, etc. In this case, if C was the first note to be 
generated, a bend to E would be calculated since there is no actual “previous” note.

17: Prev Note - 1
Bends each note to the note that was two notes previous. For example, if the notes to be generated were {C, E, G, B, C...}, 
then the G will bend to the C, the B will bend to the E, etc.

18: Prev Note - 2
Bends each note to the note that was three notes previous. For example, if the notes to be generated were {C, E, G, B, 
C...}, then the B will bend to the C, the second C will bend to the E, etc.

    For the Previous Note settings, when no notes have yet been played, KARMA extrapolates what it thinks the bends 
would have been for the first few notes, based on various settings. Most of the time this will produce a 
“musical-sounding” bend.

    For the Next and Previous Note settings, a bend of “0” is not allowed, even if the next or previous notes to be 
generated are the same pitch. In this case, a bend to the next or previous note in the Note Series will be used, in order to 
preserve the illusion of continuous bending. If all possibilities are exhausted, a bend of an octave (12) will be used.

    Settings 13, 14, 15, 17 and 18 are not available when GE Type = “Real-Time.”
<0378>
    [Force Bend If Zero] (checkbox) [Off, On]

When using next or previous note bending, if the two pitches to be bent between are adjacent, a bend of zero can result (no 
bend). When Force Bend If Zero is on, a bend will be created anyway, with an appropriate automatically calculated amount. 
This allows each note to have an audible bend, even if it technically shouldn’t, thereby maintaining an illusion of continuous 
bending (useful for synth bass lines, for example). When off, no bends will be created between notes of the same pitch 
(useful for acoustic and electric bass lines, for example).

    Not available unless Amount is set to one of the Next or Previous Note settings.
<0379>
       [Phase Ends Use Prev] (checkbox) [Off, On]

When using Next Note bending, depending on the position of the index into the Note series at the end of a phase, a large 
jump to the beginning pitch of the next phase can occur. For example, if using only one Phase, and the start index is low, 
while the last index at the end of the Phase is high, a next note bend may produce an undesirably large bend (compared to 
other bends that were occurring in the phase.) Turning this on makes the last note bend to the previous note instead of the 
next note (first note of the next phase), thereby producing generally a smaller bend that may sound more musical.

    This only has an effect at the end of phases where the next phase is set to the same direction (Phase Direction). In 
other words, a good example would be a phase pattern of {1 1 1 2}, where the Phase Direction is set to Forward for Phase 
1 and Backwards for Phase 2. This parameter would effect the ends of Phase Pattern Steps 1 and 2, but not 3 and 4.

    Not available unless Amount is set to one of the Next Note settings.
<0363>
    [Shape] (popup menu) [0...2]

Selects one of three different overall shapes for the resulting bend. “Bend” is a single bend to a destination pitch, while 
the “Hammer” settings bend to the pitch and back. See the diagrams in the Appendix Using Auto-Bend - The Different Bend 
Shapes. 
<UseAutoBend/Shape>

0: Bend
Bends the current note to whichever note or by whichever semitone size is selected in the Amount parameter. The timing 
and length of the bend is determined by the Length, Start and End parameters. Useful for portamento simulation and ethnic 
bending effects, among others.

1: Hammer
Bends the current note to whichever note or by whichever semitone size is selected in the Amount parameter, then back 
to the current pitch. The timing and length of the bend is determined by the Length, Start and End parameters, and the 
Width parameter. Useful for guitar hammer-on effects, among others.
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�2: Hammer Bend
Bends the current note to whichever note or by whichever semitone size is selected in the Amount parameter, then back 
to the current pitch, then again to the note or pitch selected in the Amount parameter. The timing and length of the bend is 
determined by the Length, Start and End parameters, and the Width parameter. Useful for ethnic bending effects, among 
others.
<0364>
    [Alternation] (popup menu) [0...1]

0: Off     1: Alternating
When set to “Alternating,” causes alternate bends to flip back and forth between the (+) and (-). For example, if the 
Amount parameter is set to +12, then the bends produced with a series of notes will be {+12, -12, +12, -12...} etc. When 
Next/Prev Note Bending is selected, it will alternate between Next and Prev. For example, if “Next” is selected in the 
size Menu, then the bends will be {Next, Prev, Next, Prev...} etc.
<0365>
    [Step Mode] (popup menu) [0: Smooth, 1...12 semitones]

Sets whether the bends will be smooth (continuous) or divided into steps (glissando bends).

0: Smooth
Bends will be continuous, with a value sent out every “n” milliseconds as specified by the Rate parameter.

1:   1   ST - Chromatic
2:   2   ST - Whole Tone
3:   3   ST - Diminished
4:   4   ST - Augmented
5:   5   ST - Fourth
6:   6   ST - Tritone
7:   7   ST - Fifth
8:   8   ST - Aug. Fifth
9:   9   ST - Sixth
10: 10 ST - Dom. 7th
11: 11 ST - Maj. 7th
12: 12 ST - Octave
Bends will be quantized to the semitone step size selected, producing “glissando” bends. For example, if the Amount 
parameter is set to 12 and Step Mode is set to “2 ST,” then the resulting bend will be quantized to 6 steps of 2 semitones 
each (a Whole Tone scale). 

    When one of the Semitone settings is selected, the Rate parameter is not available.
<0366>
    [Length] (popup menu) [0...25]

Specifies an overall length for a “bend window” within which the bend will take place. The actual timing of the bend within 
that window is based on the Start and End parameters.

0...23: Rhythmic Values
Sets the overall length of each bend window to the selected rhythm value; each bend will be therefore be the same length. 
Note that this is tempo dependent, so changing tempos changes the length of the bend and keeps the effect locked to tempo. 
If the length of the bend is longer than the actual duration of the note with which it is generated, part or all of the bend 
will not be heard.

24: Fixed ms - (milliseconds)
Makes available the Fixed-ms field beneath the popup menu. A length of absolute time may then be specified in milliseconds 
for each bend window. Note that this is independent of any tempo settings. You might use this to keep the same length and 
speed of a bend regardless of the tempo.

25: Note Duration
The duration of the note as it is generated is used as the bend window, with the Start and End parameters specifying 
where in the note’s duration the bend will start and end. Each bend may therefore be a different length, depending on the 
durations of the notes. A 16th note duration will have a bend that is half the length and twice as fast as an 8th note 
duration. If the duration is varied in real-time, the length of the bends will also be varied.

    “Note Duration” not available if GE Type = “Real-Time,” since the duration of the note is determined by actually 
playing the keyboard, so it cannot be known in advance. If selected, this setting will act the same as 7: 16th note.
<0367>
     [Fixed-ms] (numerical) [0...5000 ms]

Specifies a fixed length of absolute time for each bend window. Note that this is independent of any tempo settings. You 
might use this to keep the same length and speed of a bend regardless of the tempo.

    Not available unless “Fixed ms” is selected in the Length popup menu.
<0368>
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�   [Start %] (numerical) [0...100%]

Specifies the start point of the bend in the overall bend window (set by the Length parameter). The value is a percentage 
of the overall bend window. For example, if 0%, the bend will start as soon as the note begins to play; other values will 
cause a certain “delay” before the start of the bend.
<0369>
    [End %] (numerical) [0...100%]

Specifies the end point of the bend in the overall bend window (set by the Length parameter). The value is a percentage of 
the overall bend window. For example, if 100%, the bend will extend all the way to the end of the bend window; other 
values will cause the bend to reach the destination pitch and “hang there” for a period of time.
<0370>
         [Width %] (numerical) [0...100%]

Specifies the width of the “hammer” when the Hammer shapes are selected. This controls the amount of bend at each end 
of the hammer (the “back-and-forth” bend). For example, 0% creates a triangle wave shape, and 100% creates a square 
wave shape, with other values somewhere in between. Width also controls the length of the final bend when the Hammer 
Bend shape is selected. See the description in the Appendix Using Auto-Bend - Length of Bends.
<UseAutoBend/Length>

    Not available when Shape = “Bend.”
<0371>
    [Rate (ms)] (numerical) [1...100 ms]

Specifies how often a bend value will be sent out (in milliseconds). This controls the density of the MIDI data. For long 
bends, a higher rate may be acceptable, while for short bends a lower rate will be necessary. Usually, a setting of 8~10 
ms is adequate.

    Not available when Step Mode = “Smooth.”

<ParmsRT>
Bend - Real-Time Parameters
 

If the GE Type is “Real-Time,” the following parameters will also be available.
<0372>
    [Direction] (button) [From (Off), To (On)]

Selects whether the pitch is bent from the note to the destination (“To”) or from the destination to the note (“From”). 
This most often relates to which Bend Shape is selected.

From
The bend starts at a pitch offset equal to the Amount setting, and ends at the current pitch (i.e. pitch wheel center). For 
example, if Amount = -12 and Shape = Bend, it would be the same as starting a note with the pitch wheel all the way in 
the down position, and then moving it to the center.

To
The bend starts at the current pitch (i.e. pitch wheel center), and ends at a pitch offset equal to the Amount setting. For 
example, if Amount = -12 and Shape = Bend, it would be the same as starting a note with the pitch wheel in the center 
position, and then moving it all the way down.

For more information on practical uses for this, see the Appendix Using Auto-Bend - Next Note/Previous Note Bends.
<UseAutoBend/Next><0373>
    [Key Mode] (button) [Down (Off), Up (On)]

Selects whether the bend will be initiated when the keys are pressed (MIDI note-ons are received) or when the keys are 
released (MIDI note-offs are received).

Down
The bend window specified by the Length setting starts immediately upon receiving a note according to the settings of the 
parameters.

Up
The bend window is not started until the input source note is released. Note that for this kind of bend effect to be audible, 
you must either be using a synth program with a long release, or set the Release Delay parameter below to something 
other than off.
<0380><0381><0382>
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   [Velocity Range Bottom/Top] (numericals) [0...127]

Specifies a Velocity Range for triggering the generation of pitch bend effects. Input notes with velocities outside of this 
range will not trigger the bending. This is an easy way to allow the velocity with which you play to control the triggering 
of pitch bending effects.
<0374>
    [Release Delay (Length)] (popup menu) [0...24]

0...23: Rhythmic Durations     24: Off
Allows the release (note-offs) of notes to be delayed by certain amounts (various rhythmic durations at the current 
tempo). This is mainly to allow bends to be produced when you release the keys (with Key Mode set to Up). When off, no 
delay is added.
<0375>
    [Release Damping] (button) [Off, On]

When on, starting new notes while others are still sustaining (because of a delayed note-off from the Release Delay 
parameter above) will shut the sustaining notes off. This is useful for creating monophonic style bending effects using Key 
Mode and Release Delay. When off, the notes are allowed to overlap.

<ParmsDrm>
Bend - Drum Parameters
 

<0376>
    [Drum Bend Mode] (popup menu) [0...1]

Selects one of two different bending techniques for Drum GEs: “Generated” according to the parameters on this page, or 
“Arpeggiated” using the current Note Series settings.

0: Generated - generate shape for each note
Causes bending to be generated for each drum note the same as with any other GE Type. All of the parameters described 
above operate as described.

1: Arpeggiated - use Note Series for stepped bends
Disables most of the other bend parameters, and instead uses the pitches of the notes in the Note Series to generate 
stepped “pitch bend sequences.” The riff or arpeggio that would normally be being produced if the GE Type was 
“Generated - Riff” is still being generated internally, even though the Drum Pattern(s) are being played. This internal riff 
or arpeggio can be applied to the resulting drum rhythms as Pitch Bend values. The Index Pattern controls the order of the 
pitch bend values, which are selected from within the Note Series, just as if the GE Type was “Generated - Riff.” This 
results in “Wave-Sequencing” effects and other unique sounds.

    Not available when GE Type is not “Generated - Drum.”

<ParmsRng>
Bend - Range Parameters
 

<0377>
    [Bend Range - Semitones] (numerical) [0...24 semitones]

Sets the overall bending range of the whole GE, by setting the pitch bend range of the external MIDI device. This affects 
pitch bend envelopes and CC-A/CC-B if generating pitch bend, also. Note that this must be set to 12 for the 
semitone-related bend parameters described above to actually be semitones. Also note that some devices do not allow 
bend ranges beyond 12 semitones.
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Drum (Part 1)
Sections in this chapter:

Overview<DrmEd/Over>

About Drum Patterns<DrmEd/About>

Pattern Editing Grid & Associated Parameters<DrmEd/PatGrid>

Random Weighting Parameters (Pools)<DrmEd/RandPool>

Random Weighting Parameters (Rests)<DrmEd/RandRest>

Sections in Part 2:<DrmEd2>

Range & NTT Parameters<DrmEd2/Range>

Additional Parameters Dialog<DrmEd2/Add>

Template Management<DrmEd2/Template>

RT Parm Virtual Parameters<DrmEd2/Virt>

Copy/Swap Patterns/Rows Dialog<DrmEd2/CopySwap>

 

<Over>
Drum - Overview
The Drum Page allows up to three different Drum or Melodic Patterns (of equal or different lengths) to be created, edited, 
and simultaneously looped, while being separately modified by various other parameters. Many of these modifications are 
controlled by settings in the Phase Page Activity Grid (Drums). This allows you to set up effects where various things 
happen only on certain steps of the Phase Pattern; such as a four bar Drum Pattern that is randomized with a Cluster 
Pattern every fourth time through (bars 13 - 16). See Phase Page - Phase Activity Grid (Drums).
<PhsEd/DrmGrid> 

As shown above, the parameters are divided into several distinct areas:

Pattern 1, 2, 3 Editing Grid & Associated Parameters
Allows Drum and Melodic Patterns to be constructed in various ways, which then control which notes will be generated. 
As shown above, there are three identical areas, one for each Drum Pattern.
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Random Weighting Parameters
Parameters that allow weighting curves to be applied to any random pools (more than one value in a column) which may 
have been created in the Pattern Grids. There is a separate section for allowing weighting curves to be applied to random 
rests within the pattern.
<0438>

LED Tracking Arrays
Rows of gray dots along the horizontal and vertical axes of the pattern grid(s), with one or more green dots displaying the 
currently chosen indexes (columns) and notes (rows).

Drum/Note Names (Opens Additional Parameters Dialog)
Clicking on any popup menu in this area opens the Additional Parameters Dialog, where seven Drum Sounds or Note 
Numbers are selected for each Pattern Grid. Other additional parameters associated with each Pattern are also located in 
this dialog.

Range & NTT Parameters
The Range Parameters set an overall range within which the pitches generated by the Patterns Grids will be limited 
(wrapped around), while the NTT Parameter specifies one of several tables to be used by melodic patterns with the [ntt] 
button turned on.

Template Management
Allows the contents of the Pattern Grid and certain associated parameters to be saved as a “Template.” It will then 
appear in the popup menu for future use when creating/editing Drum Patterns. Selecting a Template from the menu loads it 
into the Pattern Grid and associated parameters.
<Menu>

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Click on the links below for detailed information on the utilities not fully explained here:

Turn Drum Row Solo Off
When the Drum Pattern Row Solo feature is in use in any of the Additional Parameter Dialogs for the three Drum Patterns, 
this menu item allows you to clear all solo buttons and return to normal operation. <DrmEd2/Solo>

Use Drum Names
Selects whether or not the note names will have Drum Names added to them, i.e. “36 C_1” or “36 C_1 - Kick 1.” The 
names are based on the KARMA Motif Drum Map (which itself is a slightly modified GM2 Drum Map - see the Performance 
Notes Table of Contents for details.)

    This is the same setting as controlled by “Use Drum Names” in the Preferences Popups Tab, and changing it in either 
place stores it into the preferences. However, the GE Editor also automatically controls this setting by turning it on when 
the GE’s RTC Model is “DP1 - Drum/Perc 1” or “DF1 - Drum Fill 1”, but turning it off when the RTC Model is “DM1 - 
Drum Melodic 1.”<Prefs/Popups>
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Shift Drum Names +12 (Korg)
For Korg keyboards, typically the internal Drum Kits are mapped an octave higher than a GM Drum Map. In other words, in 
the GM Drum Map, Kick1 is C2 and Snare1 is D2. In Korg Drum Kits, they are C3 and D3 (with reference to Middle C = 
C4). Checking this option shifts the drum names so they display an octave higher, matching most of the Korg Drum Kits 
more closely. This does not change the note number designations; C3 is still C3. It just changes which drum name is 
displayed for C3.

    This is the same setting as controlled by “Display Names +12” in the Preferences Popups Tab, and changing it in 
either place stores it into the preferences.
<Prefs/Popups>

Copy/Swap Patterns/Rows…
<DrmEd2/CopySwap>

Rename Drum Template Bank…
<OthDlg/Brn>

    The following operations (to the end of the menu) all perform modifications to the Drum Patterns. These operations 
cannot be undone except by reloading the GE. Some of these functions are mainly developer tools of limited use to the 
average user.

Transpose Notes By...
Brings up the generic Specify Value Dialog, allowing you to enter a number of semitones that will be used to transpose the 
Drum Sound/Note assignments of the patterns. Will only be applied to patterns that are turned on, so you can apply it to 
individual patterns by turning the others off temporarily.
<OthDlg/SpecVal>

Set Unused Rows To Off...
Sets the Drum Sound/Note assignment for any rows that are not being used by the patterns to off. Will only be applied to 
patterns that are turned on, so you can apply it to individual patterns by turning the others off temporarily.

Remap To Drm/Cym/Perc
Redistributes the rows across all 3 Drum Patterns according to the general KARMA concept of:
    Pattern 1: kick, snare, toms
    Pattern 2: cymbals (hi-hats, rides, crashes)
    Pattern 3: percussion

Move Empty Rows To Top
Allows you to “clean up” the Drum Patterns by moving empty rows to the top of each pattern and moving rows with 
active cells to the bottom of each pattern.

Maximize Row Vel. Offsets
Within each Drum Pattern, finds the loudest row based on the row’s Velocity Offset, and increases the Velocity Offsets of 
all rows (if negative) so that at least one is at zero, and then applies the difference to the Pattern Velocity Offset. The end 
result is that the level of the notes in the pattern play the same, but the individual row Velocity Offsets are maximized. 

Maximize Row Vel. Offset + Pat. Vel Off.
The same as above, with the additional refinement that all three Drum Patterns are analyzed at the end and have their 
Pattern Velocity Offsets raised so that at least one pattern is at zero (i.e. as loud as the patterns can go and still maintain 
the same velocity relationships. 

Sort Rows For Notes Played = Rows
Similar to the “Move Empty Rows To Top” operation above, this moves empty rows to the top as well, but optimizes the 
order of the remaining rows so that they work well with the Notes Played = Rows parameter/feature.
<DrmEd2/NotesPlayed>

    The following operations all have the additional feature of only working on the Drum Patterns that are turned on; so 
you can apply them to individual patterns without affecting the others - just turn off the ones you don’t want to affect.

Reverse Patterns
Reverses the cells in the Drum Patterns that are turned on, so that they essentially “play backwards.”

Invert Drum/Note Choices
Mainly for use with Melodic Drum GEs, this command inverts the assignments of the 7 rows in each Drum Pattern that is 
turned on, such that a melodic pattern plays in an inverted fashion compared to the original.

Shuffle By 2 Steps
Shuffle By 4 Steps
Shuffle By 8 Steps
These three commands all “mix up” (shuffle) the order of the columns in the Drum Patterns that are turned on - the 
position of the specified number of steps (columns) is swapped with every other number of steps. In other words, for 
“Shuffle By 2 Steps,” columns 1 and 2 are swapped with 3 and 4, columns 5 and 6 are swapped with 7 and 8, etc.
<0446>
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    If the GE Type is not “Generated - Drum,” all of the parameters will be disabled and the message “GE Type not Drum” 
will be displayed near the top.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><About>
Drum - About Drum Patterns
A Drum Pattern is a special type of “fixed” pattern that contains Note Numbers. These can be used to construct Drum and 
Percussion Patterns, or Melodic Patterns of a more fixed nature than what is generated by using the Note Series Page. 
Although you can create Drum Patterns with any mixture of notes you desire, a basic concept used throughout the 
available Performances was to have the three patterns (and three Drum Template Banks) follow these basic rules:

Pattern 1/Bank                  1: Kick, Snare, and Tom Notes
Pattern 2/Bank                   2: Hi-Hat, Ride, and Cymbal Notes
Pattern 3/Bank 3: Percussion Notes

This allows you to mix and match Kick/Snare Patterns with different Hi-Hat Patterns and Percussion Patterns, allowing 
great flexibility and variation.

Drum Patterns with more than one sound turned on in a column can operate either “polyphonically” (generating more than 
one drum note at a time) or as random “pools”, where a random choice will be made from one of the drum sounds in the 
column. The bottom row of each grid allows a rest to be placed as a step, or added to the pools for the possibility of a 
rest .

A Drum Pattern consists of only Drum Sounds (Note Numbers) and rests; there are no durations, no velocities, no 
rhythms. The other information is supplied by the Rhythm, Velocity, Cluster, and other Patterns. It helps to think in terms 
of straight 16ths (or 32nds) while constructing new patterns. You can of course later play the Drum Patterns with 
Rhythm Patterns of other than straight values, for more variations.

A Drum Pattern will loop as long as note generation continues. The three Patterns are independently loopable, so they can 
be of different lengths; a four bar Kick/Snare Pattern can be used with a two bar Hi-hat Pattern and a three bar 
Percussion Pattern, etc. They normally will not reset to the beginning of the Pattern unless a new Trigger is received, or 
unless the Phase Page has been configured to restart them at the beginning of certain Phases. This also means that a 
sixty-four step Drum Pattern can be looping while an eight step Velocity Pattern and a twelve step Cluster Pattern are 
also independently looping, for example.

The riff or arpeggio that would normally be being produced if the GE Type was “Generated - Riff” is still being generated 
internally. Therefore, if Note Patterns, Cluster Patterns, or Velocity Patterns are being used by the GE, these can be 
applied to the Drum Patterns with very interesting results, causing randomization and improvisational effects. These 
randomizations can be controlled by settings in the Phase Page Activity Grid (Drums). This allows you to set up effects 
where various things happen only on certain steps of the Phase Pattern, such as a four bar Drum Pattern that is 
randomized with a Velocity Pattern every fourth time through (bars 13 - 16).

In addition, the same riff or arpeggio can be applied to the resulting drum rhythms as Pitch Bend values, on the Bend Page. 
This results in “Wave-Sequencing” effects and other unique sounds. Note that this requires the synth channel you are 
sending the Drum Patterns to have pitch bend active. For each of the steps that are being used as specified in the Phase 
Page’s Phase Pattern, a button is available which activates the Pitch Bend for that particular step. This means that you 
can do something like have no Pitch Bend through three steps and then have Pitch Bend on the fourth step. 

For information on how to control various actions of the Drum Pattern with the Phase Pattern, see Phase Page - Phase 
Activity Grid (Drums).

<PhsEd/DrmGrid><PatGrid>
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Drum - Pattern Editing Grid & Associated Parameters
 

<0452><0440>
    [Pattern Grid] [8 rows x 64 steps, step 65 = Always Column]

A Drum Pattern is a grid of 8 rows by 64 columns. The bottom row of the grid is the “Rest” row, and has orange buttons. 
The other seven rows correspond to the seven Drum Sound/Note Number popup menus to the left of the grid, and have 
green buttons. You select seven different Drum Sounds or Notes with which to construct your pattern using these menus; 
when a green button in a row is turned on, the corresponding Drum Sound/Note will be played when that step is reached.

A Drum Pattern may have any number of steps up to 64, and loop independently of other patterns being used at the same 
time. Each step is represented by one column on the grid. Unused columns will appear disabled; clicking on a disabled 
column inserts a value into it and any other disabled columns between it and the last column in use. Enabled columns may 
not be “empty”; they must contain at least one Drum Sound/Note, or a rest. Note that a Pattern with a single value in a 
single column is functionally equivalent to many columns each containing the same value. For general information on 
working with the various Pattern Editing Grids, see Using The Pattern Grids.
<UseGrid>

More than one value can be entered in any given column (using the [shift] key). The pattern can then operate in either 
“poly” mode (generating more than one drum note at a time) or in “pool” mode, where each column is treated as a 
“Random Pool” from which choices will be made at random, subject to the use of the weighting curves as described later 
on. When at least one random pool is selected, a weighting curve becomes available to the right of the grid that allows 
choices to be shifted towards different areas of the pool, making different drum notes more or less likely to be generated. 
Rests that may be a part of a pool have their own weighting curve to influence the density or complexity of the resulting 
rhythms, rather than the note choices themselves.

The example above shows a kick, snare, toms and maracas pattern, where the bottom two rows of green buttons in the 
top part of the grid have their corresponding Drum Sound menus set to kick and snare. 

The bottom row of orange buttons (rests) are interleaved with the kick and snare choices to form a groove to be played 
with a straight 32nd note Rhythm Pattern. Therefore, the entire grid represents a two bar phrase of 4/4 time, with 
every eight columns representing one quarter note (eight 32nd notes).

Also shown above is a 65th column, known as the “Always Column” and indicated by the abbreviation “a” underneath it. 
When a yellow button is turned in any of the rows of this column, it will cause any values in that row of the Drum Pattern 
to always be played, regardless of any randomization that is going on, or regardless of the Poly/Pools setting (discussed 
later on).

For example, in the third column there are three buttons turned on: a kick, a maracas, and a rest. Because of the settings 
of the Always Column, the maracas will always be played no matter what. Then there will be a random choice made at 
that point of a kick or a rest. At the end of the pattern you can see a string of snare notes with rests added at every other 
column. This creates a fill which has many different potential ways of ending up, since either none, or one, or many of the 
rests could end up being used instead of the straight snare notes. Step 30 shows a “pool” of choices, including the snare 
and 4 different toms. At this step, there will be a random chance any one of those, with the maracas always being played 
due to the Always Column.

Whether or not the random choices will be different each time through the Phase is controlled in the Phase Page with the 
[nr] (new random sequence) buttons. You can choose to repeat the same random sequence a number of times or always 
generate new random sequences of choices.

Also controlled in the Phase Page is whether or not the Drum Pattern will start from the beginning each time a Phase 
starts. Using the above example where the grid represents a two bar phrase of 4/4 time, if Phase 1 was set to play one 
bar of 4/4 time, you could set up a Phase Pattern of four steps playing Phase 1 each time. However, if you re-started the 
Drum Pattern in each of the first three steps but not the 4th step, then Drum Pattern steps 1 - 32 would be played 
through three times, followed by columns 33 - 64 once, yielding a four bar Drum Pattern with a fill at the end. For 
information on both restarting the pattern and repeating random sequences, see Phase Page - Phase Activity Grid 
(Drums).
<PhsEd/DrmGrid><0425>
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   [Drum Sound/Note] (name/note display)

Clicking on any of the names causes the Additional Parameters Dialog to open, where you select one of many Drum Sounds 
(or Note Numbers) to be assigned to the corresponding row of the Pattern Editing Grid, in addition to other parameters. 
See Additional Parameters Dialog.
<DrmEd2/Add>

Note that whether the popups display Drum Sound Names, Note Numbers, or a combination of the two is controlled by 
settings in the Preferences - Popups Tab.
<Prefs/Popups><0426><0445>
    [Link] (button) [Off, On]

The three Drum Patterns can be linked together to form longer Drum Patterns; in this case, they do not play 
simultaneously, but “back-to-back.” When on, the upper Link Button links Patterns 1 & 2 (creating a 128 step Drum 
pattern). The lower Link Button links Patterns 2 & 3 in the same way. When both Link Buttons are on, all three Patterns 
are linked for a total of 192 steps. This can be used to create lengthy drum grooves or melodic phrases, have the 
specified drum kit notes change for parts of a phrase, have melodic patterns change to using different pitches or octaves, 
etc.

    When using the Drum Pattern Link feature to link two patterns, and the Rhythm Pattern is being randomized, the Drum 
Patterns will switch when reaching the physical end of the pattern (whenever that may be as determined by the Rhythm 
Pattern). Unlike the effect of randomizing the Drum Patterns with Index Patterns, it is not possible to switch between the 
patterns after filling a particular amount of time. (When using Index Patterns to jump around, the underlying Rhythm 
Pattern is still what determines when the switch between the linked patterns will take place, so the switch still takes 
place as if the pattern was not being jumped around by the Index Pattern.) You can, however, still use the “Resync Index” 
[ri] buttons in the Phase Pattern to cause the Drum Patterns to resynchronize within whichever of the linked patterns is 
currently being played.
<0427>
    [On (Play On/Off)] (button) [Off, On]

When on, the Drum Pattern is played during note generation. When off, the Grid may contain values but will not be played 
during note generation. This can be used to temporarily “mute” one or more patterns during editing or playback. This 
parameter can also be controlled as an RT Parm, or a “virtual” RT Parm. See Drum Page - RT Parm Virtual Parameters.
<DrmEd2/Virt>

    Since the RTC Models generally use the Pattern Velocity Offset to control switching the patterns on and off, this has 
become more of a programming aid or override.
<0428>
    [Kbd - Keyboard Track] (button) [Off, On]

Allows the Drum Pattern to track the input notes if desired, thereby changing keys depending on the chord. Off is normal 
for Drum Patterns while on is normal for Melodic Patterns.

When set to off, the Drum or Melodic Pattern is “fixed” - it doesn’t matter which notes you play on the keyboard. The 
pattern will always produce the same pitches, according to the settings of the Drum Sound/Note settings. This is most 
typical for Drum Patterns. When on, the pitches of the notes generated “track” the lowest key played on the keyboard (or 
other input device), related to C1 (MIDI Note #36). This is most useful for Melodic Patterns. In other words, when you 
play a C1, the pattern will be produced using the Note Numbers as specified by the Drum Sound/Note settings, and any 
other applicable parameters. If you then play an E2, the notes being generated will be transposed up by four steps. 
Assuming the Notes that are assigned are in the key of C, this puts the resulting pattern in the Key of E. This is often 
useful in conjunction with the “NTT - Note Table Transposition” parameter, described next. Note that the “Root Position” 
parameter in the Performance Editor > Control Page can be used to cause different inversions of the same chord to always 
transpose the notes as if the chord was played in root position.
<0429>

    [NTT - Note Table Tranposition] (button) [Off, On]

Mainly for use with Melodic Patterns, this allows the chords received to shift certain pitches in the Drum Pattern to notes 
that fit the analyzed chord. Often used in conjunction with Keyboard Track.

When off, different chords played on the keyboard (or other input device) have no effect on the pitches of the notes 
related to each other (although the overall key may change when using “Keyboard Track” above). When on, Chord 
Analysis is performed on the input chord, and certain pitches as they are generated may be shifted to other notes to fit 
the chord. This is useful in conjunction with the “Kbd - Keyboard Track” parameter described above. If you have created 
a Melodic pattern that is being transposed, you can also have the tonality of the pattern shift to match different chords as 
you play them, similar to popular auto-accompaniment keyboards. In other words, you can write a pattern that plays a 
musical phrase in a major key, and have it change to a minor key when you play minor chords, automatically. Note that 
the “Root Position” parameter in the Performance Editor > Control Page can be used to cause different inversions of the 
same chord to always transpose the notes as if the chord was played in root position.

    One of several different tables producing different results for the shifted notes is specified by the “NTT Table” 
parameter at the top of the page.
<0430><0451>

    [Pools/Poly] (radio buttons) [0, 1]

Selects one of two modes of operation for the entire grid relating to columns that contain more than one Drum Sound 
and/or a rest.
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0: Poly
If there is more than one Drum Sound turned on in a column (and no rest), all of the Drum Sounds at that step will be 
played; if you had a kick, snare, and hi-hat in the same column, all three would be played when that Step was reached. 
This is the typical operation of most grid-based rhythm pattern software. However, if a rest is also turned on, there will 
be a random possibility of a rest or a Drum Sound for each of the Drum Sounds. In other words, if you had a kick, snare, 
hi-hat and rest in the same column, for each of the three Drum Sounds a choice between the sound and the rest would be 
made (subject to the Random Rest Weighting Curve described later on). This would result in one of eight possible 
combinations:

kick, snare, hi-hat       ->                                                  kick, snare, hi-hat
(rest), snare, hi-hat     ->                            snare, hi-hat
kick, (rest), hi-hat       ->                                        kick, hi-hat
kick, snare, (rest)                                              ->                                                                                    kick, snare
(rest), snare, (rest)                              ->                                                      snare
(rest), (rest), hi-hat                                                   ->                              hi-hat
kick, (rest), (rest)                                ->                        kick
(rest), (rest), (rest)     ->         rest (nothing)

    The “Always Column” described below can modify this behavior.

1: Pools
If there is more than one Drum Sound turned on in a column, those sounds form a “pool” of choices from which only one 
will be chosen at random. If a rest is also turned on, then there will be a possibility of a rest or only one of the Drum 
Sounds. For example, if you had a kick, snare, hi-hat and rest in the same column, there would first be a choice of one of 
the three Drum Sounds (subject to the Random Pool Weighting Curve described later on), then a choice as to whether to 
play the single chosen Drum Sound or a rest (subject to the separate Random Rest Weighting Curve described later on). 
This would result in one 4 possible choices:

kick
snare
hi-hat
res t

    The “Always Column” described below can modify this behavior.
<0431>
    [a - Always Column] (65th column of Grid) [Off, On]

When a yellow button is turned in any of the rows of this column, it causes any values in that row of the Drum Pattern to 
always be generated, regardless of any randomization that may be set up. This means it ignores the Poly/Pools setting 
(discussed above). This can be used to cause one note or sound to always play, while there is randomization going on 
around it.

<RandPool><0434><0443>
Drum - Random Weighting Parameters (Pools)
 

The Random Weighting Parameters (Pools) are made available when at least one step in the Drum Pattern Grid contains 
multiple buttons turned on in the upper seven rows (not counting the “rest” row), and Pools/Poly Mode is set to “Pools.” 
This step then constitutes a “random pool” of Drum Sounds/Notes. Whenever a random pool is encountered in playing 
through the pattern, a random choice is made from the values in that step. Certain areas of the random pool can be 
favored by the use of a weighting table, with various shaped curves. Using the curves, you can influence certain choices 
to be made more or less often than others, allowing very musical real-time control of the randomness. For example, you 
can influence whether a tom will be played at a certain step more often than a snare.

Whether or not a certain random sequence will repeat for a number of times is controlled in the Phase Page. See Phase 
Page - Phase Activity Grid (Drums).<PhsEd/DrmGrid>
<0432><0441>
    [Weighting Curve] (popup menu) [0...3]

Selects one of four different curves that act to favor certain areas of the pool over others when each random choice is 
made. Next to the Weighting Curve Menu, a small graphic displays the actual shape of the chosen curve based on the 
setting of the “Factor” field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top 
will favor values towards the top of the columns in the grid. For a more complete discussion of the various shapes and 
how the Factor influences the choices, see the Appendix Random Weighting Curves.
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<RandCurves> 

0: Exp - Exponential
With a positive Factor (+), choices will be exponentially weighted towards the Drum Sounds/Notes higher in the grid 
column. With a negative Factor (-), choices will be exponentially weighted towards the Drum Sounds/Notes lower in the 
grid column.

1: Log - Logarithmic
With a positive Factor (+), choices will be logarithmically weighted towards the Drum Sounds/Notes higher in the grid 
column. With a negative Factor (-), choices will be logarithmically weighted towards the Drum Sounds/Notes lower in the 
grid column.

2: ES - Exp-S (Exponential S)
With a positive Factor (+), choices will be exponentially weighted towards Drum Sounds/Notes near the center of each 
pool, and away from the lower and higher choices. With a negative Factor (-), choices will be exponentially weighted 
towards the Drum Sounds/Notes lower and higher in the grid column, and away from the center choices.

3: LS - Log-S (Logarithmic S)
With a positive Factor (+), choices will be logarithmically weighted towards Drum Sounds/Notes near the center of each 
pool, and away from the lower and higher choices. With a negative Factor (-), choices will be logarithmically weighted 
towards the Drum Sounds/Notes lower and higher in the grid column, and away from the center choices.

    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves.
<RandCurves/Compare>

    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen. A Factor of “+99” with 
either of the S-Curves yields a straight line across the middle, and only the middle value in the pool will be chosen. A 
Factor of “-99” with either of the S-Curves yields a split straight line across the bottom and top, and random choices 
between only the lowest and highest values in the pool will be chosen.

The following table summarizes the effect of the various Weighting Curves and the Factor field on Drum Sound choices:

 

<0433><0442>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is either +99 or -99, the choices are “locked” to the highest or 
lowest values in the columns, and there are no random choices at all. (The only exception to this is an S-shaped curve 
with a value of -99. In this case, a random choice will be made between the highest and lowest values only.)

<RandRest><0437><0444>
Drum - Random Weighting Parameters (Rests)
 

The Random Weighting Parameters (Rests) are made available when at least one column in the grid has a rest and at least 
one other Drum Sound turned on. This will happen with either the “Pool” or “Poly” buttons selected, since you can have 
random rests in both modes; they just operate differently (see description above under “Pools/Poly”). 

Whenever this step is encountered in playing through the pattern and a random choice must be made, the likelihood of a 
rest occurring can be favored by the use of a separate weighting table.

Whether or not a certain random sequence will repeat for a number of Phases is controlled in the Phase Page. See Phase 
Page - Phase Activity Grid (Drums).
<PhsEd/DrmGrid><0435>
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   [Weighting Curve] (popup menu) [0...1]

Selects one of two different curves that affect the likelihood of a rest occurring when a random choice is made. Next to 
the Weighting Curve Menu, a small graphic displays the actual shape of the chosen curve based on the setting of the 
“Factor” field; this graphic is oriented to relate to the grid. For example, a curve arced towards the top will favor the 
rhythmic choices more often than the ties. For a more complete discussion of the various shapes and how the Factor 
influences the choices, see the Appendix Random Weighting Curves.
<RandCurves> 

0: Exp - Exponential
With a positive Factor (+), choices will be exponentially weighted towards the Drum Sounds/Note more often. With a 
negative Factor (-), choices will be exponentially weighted towards the rests more often.

1: Log - Logarithmic
With a positive Factor (+), choices will be logarithmically weighted towards the Drum Sounds/Notes more often. With a 
negative Factor (-), choices will be logarithmically weighted towards the rests more often.

    While exponential and logarithmic curves may seem to have a similar shape, they have slight differences that can 
affect the outcome of the random choices. For a comparison, see the Appendix Random Weighting Curves.
<RandCurves/Compare>

    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen.

The following table summarizes the effect of the various Weighting Curves and the Factor field on random rests:

 

<0436>
    [Factor] (numerical) [-99...+99]

Controls the degree of slope to the Weighting Curve. 0 = a Linear Curve with any Weighting Curve. Negative values not 
only invert but also rotate the curve. When the value is +99, the choices are “locked” to no rests whatsoever; when the 
value is -99, the choices are “locked” to rests always.
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Drum (Part 2)
Sections in this chapter:

Range & NTT Parameters<DrmEd2/Range>

Additional Parameters Dialog<DrmEd2/Add>

Template Management<DrmEd2/Template>

RTParm Virtual Parameters<DrmEd2/Virt>

Copy/Swap Patterns/Rows Dialog<DrmEd2/CopySwap>

Sections in Part 1:<DrmEd>

Overview<DrmEd/Over>

About Drum Patterns<DrmEd/About>

Pattern Editing Grid & Associated Parameters<DrmEd/PatGrid>

Random Weighting Parameters (Pools)<DrmEd/RandPool>

Random Weighting Parameters (Rests)<DrmEd/RandRest>

<Range>
Drum - Range & NTT Parameters
 

<1876>
    [NTT Table] (popup menu) [0...3] 

When the [ntt] button is on for a Drum Pattern, the notes are run through Note Transposition Tables (NTT) based on chord 
analysis, such that notes that do not belong to the analyzed chord or scale will be shifted to notes that do. This is what 
allows the notes of a melodic Drum Pattern to be shifted to fit different chords and keys. This parameter specifies which 
of several different table variations are applied to all patterns using NTT.

    Not available unless at least one Drum Pattern has the [ntt] button turned on.

0: Chordal 1
Specifies a table that constrains notes to the predominant notes of the recognized chord, without most of the passing tones 
in the scale.

1: Chordal 2
Identical to Chordal 1 except does not allow the 6th to be generated for a straight Minor chord, but shifts it to the 
dominant 7th.

2: Scalic 1
Specifies a table that constrains notes to a simplified scale matching the recognized chord, without some of the passing 
tones. This allows more possibilities than the Chordal options, while avoiding some of the passing tones that might sound 
out of place.

3: Scalic 2
Specifies a table that constrains notes to a 7-note scale matching the recognized chord. Scalic 2 is more modal in nature 
and has more passing tones than Scalic 1.
<1873><1874><1875>
    [Note Wrap Bottom/Top] (numericals) [0...127: C-2...G8 when Mid C=C3]

Sets an overall range that notes from all three Drum Patterns will be limited to. Notes going beyond the range will be 
transposed up or down by however many octaves necessary to keep them within the specified range. This is mainly 
intended for use with Melodic Patterns that are being transposed by using the Keyboard Track feature.

    Whether the note names reference Middle C as C3 or C4 is controlled by the “Middle C Display” option in the 
Preferences > Workspace settings.

<Prefs/MidC><Add><1871>
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Drum - Additional Parameters Dialog
 

The Drum Page Additional Parameters Dialog contains the Drum Sound/Note selections for the associated Drum Pattern, 
and some other related parameters. It is opened by clicking on any of the Drum Sound/Note popups (display only) in the 
main Drum Page window. 

Row Parameters
Parameters for each of the upper seven rows of the applicable Drum Pattern. Orientation matches the Pattern Grid.

Pattern Parameters
Parameters that affect the entire applicable Drum Pattern.
<0459>

Assign From Keyboard Buttons (AFK)
Allow the Drum Sound/Note for a particular row to be assigned from the keyboard. Click on a button, and the next note 
you play will be assigned to that row. Click on all seven, and you can assign the next seven played notes sequentially from 
the bottom row to the top row.
<0466>

Cancel
Closes the dialog without accepting any of the changes you have made. Values are restored to the settings they had prior 
to opening the dialog.
<0467>

OK
Closes the dialog and accepts the modified settings.

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information. 

<RTPEd><0460>
    [Drum Sound/Note] (popup menu) [0, 1...127: Off, C#-2...G8 when Mid C=C3]

Selects a Drum Sound/MIDI Note Number for each of the top seven rows of the selected Drum Pattern (Note Number 0 is 
used to indicate “Off”). Audible feedback is provided while selecting. The small keyboard button next to each row allows 
the note to be assigned from the keyboard itself. Click on the button, and the next note you play will be assigned to that 
row. Click on all seven, and you can assign the next seven played notes sequentially from the bottom row to the top row. 
Note that whether the popups display Drum Sound Names, Note Numbers, or a combination of the two is controlled by 
settings in the  Preferences - Popups Tab.
<Prefs/Popups><0453>

    [Row Velocity Offset] (numerical) [-127...+127]

Allows the velocity for notes from that row only to be offset with regards to other rows. For example, you can use this 
to make a snare softer overall than a kick. Note that this is subtractive/additive: “0” leaves velocities at the Initial 
Velocity they would normally be generated at based on the Velocity Page settings. 

    You can also use this to get different velocity levels of the same note by assigning the same note to more than one 
row of the pattern, and then setting different Row Velocity Offsets.

    Setting positive amounts may interfere with the Velocity control that you have specified elsewhere. One example is 
controlling the velocity sensitivity of the Drum Pattern with the keyboard. Regardless of your Velocity Page settings, if 
the Row Velocity Offset here was a large positive value, you would get no apparent velocity sensitivity from the 
keyboard for this row, since this value would be added and effectively cancel out the effects of the Velocity Mode and 
Value. Of course, maybe that’s what you wanted!
<1872><Solo>
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    [Solo] (checkbox) [Off, On]

Allows one or more rows in the Drum Pattern to be soloed during playback. This does not solo the Module itself, but only 
the rows inside the pattern. Rows can be soloed in more than one Drum Pattern by opening the Additional Parameters 
Dialog for the other patterns. You can un-solo all selected rows at once using the “Turn Drum Row Solo Off” command 
from the Drum Page’s Menu Button.
<0454>

    [Rhythm Multiplier] (numerical) [1...800%]

Multiplies the current Rhythm Pattern by the specified setting. Note that this is entirely independent of the same 
parameter in the Rhythm Page. This means that each Drum Pattern can have a different Rhythm Multiplier. For example, if 
you set the Rhythm Pattern to 32nds, you could drive one Drum Pattern with a Rhythm Multiplier of 100% at 32nd note 
speed, and another Drum Pattern at 200% for 16th note speed. If they were the same number of steps, it would take 
twice as long to perform the entire 16th-based pattern as the 32nd-based pattern. This also means that the Rhythm 
Pattern driving the underlying Riff (that may be applied as Pitch Bend or used to randomize the Drum Patterns) can be 
operating at a different rhythmic relationship. For example, if the Rhythm Pattern was set to 16ths, and the Drum 
Pattern Rhythm Multiplier to 50%, the Drum Pattern would be generated as 32nd-based, while any arpeggiated pitch bend 
would be 16th-note based, or 1 bend every 2 steps of the Drum Pattern. This parameter can also be controlled by several 
“virtual” RT Parms. See Drum Page - RT Parm Virtual Parameters.
<DrmEd2/Virt><0455>

    [Pattern Velocity Offset] (numerical) [-127...127]

Subtracts or adds a constant amount to the velocities for each Pattern. This applies to the entire Pattern (all rows), 
unlike the Row Velocity Offset. Allows a Pattern’s relative volume to be raised or lowered with regard to the other two 
Patterns. Note that this is subtractive/additive: “0” leaves velocities at the Initial Velocity they would normally be 
generated based on the Velocity Page settings. 

    Setting positive amounts may interfere with the Velocity control that you have specified elsewhere. One example is 
controlling the velocity sensitivity of the Drum Pattern with the keyboard. Regardless of your Velocity Page settings, if 
the Pattern Velocity Offset here was a large positive value, you would get no apparent velocity sensitivity from the 
keyboard, since this value would be added and effectively cancel out the effects of the Velocity Mode and Value. Of course, 
maybe that’s what you wanted!
<0456>

    [Pattern Velocity Scale %] (numerical) [-999...+999%]

Specifies a percentage by which the Velocity Pattern in the Velocity Page is scaled before being used to generate notes 
from the Drum Pattern, if this feature has been assigned in the Phase Page ([ve] (use velocity pattern) row). Notes can be 
made to disappear or drop out using large positive values; large negative values with a very soft Initial Velocity can 
create interesting “reversed” effects. The same field in the Velocity Page itself is disabled for Drum GEs, since each 
Pattern here has its own Velocity Scale.

    Has no effect unless at least one step of the Phase Pattern has the [ve] (use velocity pattern) row turned on for the 
selected Drum Pattern. See Phase Page - Phase Activity Grid (Drums).
<PhsEd/DrmGrid><0457>

    [Pattern Transpose] (numerical) [-36...+36]

Allows each Pattern to be individually transposed in semitones with regards to the other two Patterns. This is additive to 
the transpose in the Performance GE Setup/Mix Page. This parameter can also be controlled by several “virtual” RT 
Parms. See Drum Page - RT Parm Virtual Parameters.
<DrmEd2/Virt><0458>

    [Note Series -> Length] (button) [Off, On]

When on, the Pattern uses the GE’s actual Note Series Length as the length of the Drum Pattern. For example, if the Note 
Series Page was set to Replications 4.0 with Symmetry off, and four notes were played, a 16 note Note Series would 
normally be created. Assuming the [pr] (pattern restart) rows of the Phase Page Activity Grid (Drums) are on, the Drum 
Pattern would restart after 16 steps of it have been played. Playing one note would change the Note Series Length to four, 
and the Drum Pattern would restart after four steps. This can be used to change the apparent length or time signature of 
the Drum Pattern or Melodic Phrase in real-time. When this is off, the Drum Pattern loops through its full length, subject 
to the [pr] (pattern restart) rows of the Phase Page Activity Grid (Drums).
<0465><NotesPlayed>
    [Notes Played = Rows] (button) [Off, On]

When on, the number of keys pressed on the keyboard determines which rows of the Drum Pattern are played. If only one 
key is pressed, then only the notes indicated by the first row of the Drum Pattern (lowest row of the seven rows 
specifying drum notes) are generated. If three keys are pressed, then only the notes specified by the lowest three rows 
are generated. This can be used to simulate the Korg Triton Arpeggiator setting “Fixed Tone Mode: Trigger As Played.”

<Template>
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Drum - Template Management
 

Certain of the parameters in the Drum Patterns Page can be saved as a “Template.” This can be useful for Templates that 
you use often, or that you like to use as a starting point for further experimentation, or to maintain a library of 
Templates. Furthermore, Templates can be switched in real-time when they are assigned as RT Parms, causing radical 
changes in what is being generated.

What is saved in a Drum Pattern Template:
- the configuration of the Drum Editing Grid;
- Pools/Poly setting;
- the seven choices in the Drum Sounds menus;
- the Random Weighting Parameters (Pools) (Weighting Curve and Factor);
- the Random Weighting Parameters (Rests) (Weighting Curve and Factor).

There can be more than one bank of Templates in a KDF File. Each GE stores a reference to which Bank it is using, which is 
set by the Template Bank parameter in the GE Editor. All Templates used in a GE must come from the same bank - for 
example, you cannot use Rhythm Templates from one bank and Index Templates from another at the same time.

    When a Template is selected and loaded via RT Parm control, the Weighting Curve and Factor will remain as presently 
set if the Weighting Curve or Factor is also assigned as an RT Parm. In other words, a Weighting Curve and Factor are 
stored as part of the Template, but if they are under RT Parm control, their current settings are not replaced when the 
Template is loaded.
<0469>

    [Open Templates] (button)

Opens a Template Bank Display Window for the current Template Bank.
<0468>

    [Open Template Bank] (button)

Opens a Template Bank Display Window for the current bank of Drum Pattern Templates.
<0461>
    [Bank] (popup menu) [0...3]

Selects from one of three Banks of Drum Pattern Templates within the current selected Template Bank, and loads the 
parameters into the selected Drum Pattern’s Editing Area.
<0462>
       [Template Bank 1] (popup menu) [0 = [As Stored], 1...63]
    [Template Bank 2] (popup menu) [0 = [As Stored], 1...63]
    [Template Bank 3] (popup menu) [0 = [As Stored], 1...63]

Selects from 63 different Drum Pattern Templates within the currently selected Template Bank (shared by all three Drum 
Patterns), and loads the parameters into the selected Drum Pattern Editing Grid and associated parameters.

Selecting Template 0 (which is always named [As Stored] and cannot be overwritten) reloads the stored internal settings 
of the GE for the parameters corresponding to the template. In other words, you can have a complex pattern set up on the 
grid, select one or more Templates, thereby completely replacing it, and then return to the original settings by selecting 
[As Stored].

When selected by the mouse using the popup menu, the [As Stored] selection is always available. When the Template is 
being controlled as a Real-Time Parameter, there are two different options available:

Template [1...63]
The internal settings of the GE for the set of parameters corresponding to the chosen Template are never used; rather 
they are always replaced by one of the selected Templates from within the Min/Max range specified for the RT Parm. In 
this case, available range is 1~63, and it is not possible to select 0: [As Stored].

Template + Restore [0...63]
Similar to the above setting; however, the internal settings of the GE can be restored and used as part of the real-time 
Template operation. In this case, the Min setting of the Template Range actually does not select that Template; rather, it 
causes the internal settings of the GE to be restored for that Template’s set of parameters. In other words, you can have 
a complex pattern already set up on the grid. Using “Template + Restore” as a GE RT Parm, you specify a range where 
the Min value restores the internal settings, and the rest of the range selects Templates, replacing the internal settings. 
So if the Min value was 5 and the Max value was 10, choosing 5 would restore the internal settings (the same as selecting 
“0 [As Stored]”), and 6 through 10 would select the corresponding Template. You can use this to keep the internal 
settings of the GE, while still allowing a wide variety of Templates to be substituted for various groups of parameters. In 
this case, the available range is 0~63. You can assign the full range of all 63 Templates, or only a portion of the range, 
and still have the ability to restore the original internal settings.
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�    When a GE is first loaded, the Template popup will always display “As Stored.” If you select a Template, the popup 
menu will display the name of the Template, but after you save the GE and load it again, it will once again display “As 
Stored.” This is because the Template value is not saved in the GE, but the contents of the Pattern Grid and associated 
parameters are.
<0463>
    [Save] (button)

Brings up a Save Dialog allowing you to name the Template and save it in memory in the current Template Bank. After 
saving a Template, it will then be available in the Template popup menus for both Phases. 
<OthDlg/Mbs><0464>
    [Clear] (button)

Brings up a dialog allowing you to clear the selected Template from the current Template Bank. You will be given an 
opportunity to cancel. After clearing, the Template will disappear from the Template popup menus for both Phases.

    Saving or clearing only affects the Templates in RAM. To save these changes to disk, you must save the KDF File by 
choosing “Save,” “Save As…” or “Save All…” from the File menu.

    Since the changes are not written to disk until one of the Save commands is executed, to undo a change after you have 
stored or cleared a Template you can close and reopen the current KDF file.

<Virt>
Drum - RT Parm Virtual Parameters
The following parameters are not true parameters, but “virtual” parameters for RT Parm control. In other words, they 
do not physically exist on the Drum Page, but perform a modifying function on one or more of the other parameters. They 
can be found in the Drum Group when assigning parameters in the GE Editor > RT Parms Page, and have a tilde (~) at the 
beginning of the parameter name (indicating that they are virtual).

    [~On/Off Combinations] (virtual) [0...7]

Controls all three Drum Pattern On/Off buttons at the same time, in various combinations. This allows you to use a single 
RT Control (such as a slider in the Real-Time Controls Editor) to turn all three Patterns on and off in real-time. The values 
0~7 select one of 8 different combinations, shown in the following table:

 

    [~Straight Multipliers] (virtual) [0...5]

     {0, 1, 2, 3, 4, 5} = {25, 50, 100, 200, 400, 800 (%)}
Selects from a quantized set of “straight” values for the Rhythm Multiplier field of the associated Drum Pattern(s). In 
other words, when applied to a Rhythm pattern containing values such as 16th notes, the resulting rhythmic values will be 
straight values such as 8th notes, quarter notes, etc.

     [~Straight/Trip Mults] (virtual) [0...10]

     {0, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10} = {25, 34, 50, 68, 100, 136, 200, 272, 400, 544, 800 (%)}
Selects from a quantized set of “straight & triplet” values for the Rhythm Multiplier field of the associated Drum 
Pattern(s). In other words, when applied to a Rhythm pattern containing values such as 16th notes, the resulting rhythmic 
values will be straight values such as 8th notes, quarter notes, etc. or various triplet values.

      [~Str/Dot/Trip Mults] (virtual) [0...15]

     {0, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10} =
     {25, 34, 37, 50, 68, 75, 100, 136, 150, 200, 272, 300, 400, 544, 600, 800 (%)}
Selects from a quantized set of “straight, triplet & dotted” values for the Rhythm Multiplier field of the associated Drum 
Pattern(s). In other words, when applied to a Rhythm pattern containing values such as 16th notes, the resulting rhythmic 
values will be straight values such as 8th notes, quarter notes, etc., various triplet values, or various dotted values.
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    [~Octave Transpose] (virtual) [-36...+36]

Allows the Drum Pattern’s Transpose value to be quantized to the nearest octave, so that when being changed in 
real-time, only transposition by octaves is possible. In this case, the value of the virtual parameter changes by 
semitones, but the actual transpose value will only change at certain points within the range:

-36 to -31 = -36  (-3 octaves)
-30 to -19 = -24  (-2 octaves)
-18 to  -7 = -12  (-1 octave)
 -6 to   5 =   0  (no transpose)
  6 to  17 =  12  (+1 octave)
 18 to  29 =  24  (+2 octaves)
 30 to  36 =  36  (+3 octaves)

    [~Oct/5th Transpose] (virtual) [-36...+36]

Allows the Drum Pattern Transpose value to be quantized to the nearest octave or fifth, so that when being changed in 
real-time, only transposition by octaves or fifths is possible. In this case, the value of the virtual parameter changes by 
semitones, but the actual transpose value will only change at certain points within the range:

-36 to -33 = -36  (-3 octaves)
-32 to -27 = -29  (-3 octaves +5th)
-26 to -21 = -24  (-2 octaves)
-20 to -15 = -17  (-2 octaves +5th)
-14 to  -9 = -12  (-1 octave)
 -8 to  -3 =  -5  (-1 octave  +5th)
 -2 to   3 =   0  (no transpose)
  4 to   9 =   0  (+5th)
 10 to  15 =  12  (+1 octave)
 16 to  21 =  17  (+1 octave  +5th)
 22 to  27 =  24  (+2 octaves)
 28 to  33 =  31  (+2 octaves +5th)
 34 to  36 =  36  (+3 octaves)

    [~Repeat On/Off Pattern] (virtual) [0...2]

Allows an individual Drum Pattern to have its Melodic Repeat settings [mr] in the Phase Activity Grid (Drums) set to one 
of three states:

0: Off
The Melodic Repeat button [mr] will be turned off in each step of the Phase Pattern, for the specified Drum Pattern.

1: On
The Melodic Repeat button [mr] will be turned on in each step of the Phase Pattern, for the specified Drum Pattern.

2: As Stored
The Melodic Repeat button [mr] will be set to the internally stored settings of the GE, for each Phase Pattern Step. This 
means that repeats can be on in some steps, and off in others, such as just generating repeated notes in the last bar of a 
four bar pattern.
<RptOnOffCombs>

    [~Repeat On/Off Combs (Combinations)] (virtual) [0...8]

Allows all three Drum Patterns to have their Melodic Repeat settings in the [mr] rows of the Phase Activity Grid (Drums) 
controlled at the same time, in various combinations (templates). This allows you to use a single RT Control (such as a 
slider in the Real-Time Controls Editor) to control all three Patterns at the same time - as is typically configured in Drum 
GEs. The values 0~8 select one of 9 different combinations, shown in the following table:  <PhsEd/DrmGrid>

 

Off
The Melodic Repeat button [mr] will be turned off in each step of the Phase Pattern, for the specified Drum Patterns.

On
The Melodic Repeat button [mr] will be turned on in each step of the Phase Pattern, for the specified Drum Patterns.
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As Stored
The Melodic Repeat button [mr] will be set to the internally stored settings of the GE, for each Phase Pattern Step. This 
means that repeats can be on in some steps, and off in others, such as just generating repeated notes in the last bar of a 
four bar pattern.

    When editing the Melodic Repeat [mr] rows in the Phase Pattern and this parameter is assigned in the GE, you may 
encounter the Template Edit Warning dialog, explained in the GE Dialogs chapter. <GEUtils/TempEdWarn>
<ri>

    [~Resync Index Templates] (virtual) [-1: As Stored, 0...13]

Controls the selection of one of 12 Resync Index Template settings, which apply different values to each step of the 
Resync Index [ri] rows of the Phase Pattern, in the specified Drum Pattern’s section of the Phase Pattern Drum Activity 
Grid. This causes the Drum Pattern’s playback indexes to resynchronize at various steps of the Phase Pattern.
<PhsEd/DrmGrid>

Index Pattern settings may be used to modify a specified Drum Pattern’s playback, often with randomized results, 
according to settings in the Phase Page and Index Page. When doing so, the use of the Index Pattern can cause playback of 
the various steps of the Drum Pattern to skip around and play out of order, creating new variations, often with a 
“free-form” improvisational feel. While quite useful, this can often feel “too syncopated,” as the pattern can become 
completely disconnected from its original placement.

However, as playback of the Phase Pattern enters a particular step, if the Resync Index button [ri] is on, then the 
selected Drum Pattern’s playback index will be reset to the position that it normally would be in if it wasn’t being 
modified by the application of the Index Pattern. This can “resynchronize” the Drum Pattern back to the downbeat every 
four beats, or every two beats, etc., while allowing it to then begin skipping around again.

As playback of the Phase Pattern enters a particular step, if the Resync Index button [ri] is off, no resetting of the Drum 
Pattern’s index is performed, and the generation of the Drum Pattern continues from wherever it may be.

The following table illustrates the various values loaded into the Phase Pattern when a Resync Index Template is loaded 
for a particular Drum Pattern:

  

-1: As Stored (or minimum setting of assigned RT Control*)
The Resync Index buttons [ri] for the specified Drum Pattern will be set to whatever values they are stored to internally 
in the GE. They could be all on or all off, or any combination of on and off.

0...4: Templates based on 2 and 4
5...8: Templates based on 2 and 4 (alternate)
9...13: Templates based on 3
The Resync Index buttons [ri] for the specified Drum Pattern will be set to one of the various patterns of on and off 
values, causing the Drum Pattern playback indexes to resynchronize at various steps of the Phase Pattern.

    *When this parameter is assigned to an RT Control, the minimum value of the controller as specified by the RT 
Parameter Minimum field represents the [As Stored] setting. In other words, if the control was assigned to a range of -1 
to 13, the a value of -1 would select [As Stored]. If the range was 6 to 13, then a value of 6 (the minimum setting of the 
controller) would select [As Stored], while other values would select the corresponding templates. This allows a smaller 
range of the included templates to be targeted, while still allowing the [As Stored] setting to be selected by the minimum 
position of the controller.

    When editing the Resync Index [ri] rows in the Phase Pattern and this parameter is assigned in the GE, you may 
encounter the Template Edit Warning dialog, explained in the GE Dialogs chapter.
<GEUtils/TempEdWarn>

<CopySwap><2021>
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Drum - Copy/Swap Patterns/Rows Dialog
 

The Copy/Swap Drum Patterns/Rows Dialog allows the three Drum Patterns within the current GE (or individual rows 
within them) to be copied and swapped around. It can be opened from the “Copy/Swap Patterns/Rows…” command in the 
GE Editor Drum Page’s Menu Button.

Menu Button
A popup menu allowing instant access to this help chapter.
<2014><2022><2013><2024>
    [Source] (popup menus)

Specifies the source Drum Pattern (and optional row if the Rows checkbox is on) for the copy or swap operation.
<2015><2023><2025>
    [Destination] (popup menus)

Specifies the destination Drum Pattern (and optional row if the Rows checkbox is on) for the copy or swap operation.
<2016>

    [Copy/Swap] (button) [Copy, Swap]

Sets whether the source will be copied to the destination (single-headed arrow), or the source and destination will be 
swapped (double-headed arrow).
<2017>
     [Row] (checkbox) [Off, On]

Allows individual rows within the source and destination patterns to be copied or swapped. When this is on, only the 
specified row in the specified patterns will be copied or swapped, not the whole pattern.
<2018>

       [Execute] (bu t ton )

Performs the copy or swap operation without closing the dialog, in case you want to perform other operations
<2019><2020>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing the copy or swap operation. The OK Button (green 
checkmark) closes the dialog and performs the specified copy or swap operation.
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Direct Index
Sections in this chapter:

Overview<DixEd/Over>

General Parameters<DixEd/ParmsGen>

Duration Parameters<DixEd/ParmsDur>

Repeat Parameters<DixEd/ParmsRpt>

Bend Parameters<DixEd/ParmsBnd>

 

<Over>
Direct Index - Overview
“Direct Index™” means to take a controller and map it into the Note Series directly, so that notes can be directly indexed 
and generated in real-time. One use is to take an area of a keyboard and map it into the Note Series, so that when you play 
the keys you are not generating the true note, but are selecting notes from within the Note Series. You can set up one area 
of the keyboard to supply the input notes to the Note Series, and another area to perform the Direct Indexing. This can 
allow you to “solo” with musically correct notes, without really thinking about what you are doing. Another use is to take 
a controller like a Joystick or Mod Wheel and map it into the Note Series, so that sweeping the controller sweeps through 
the Note Series and generates glissandos and flurries of notes. This can be done in addition to the normal effect that the GE 
may be programmed to generate.

As shown above, the parameters have been divided into several distinct groups:

General Parameters
Parameters that affect Direct Indexing in general.

Duration Parameters
Parameters that affect the durations of the Direct Index notes.

Repeat Parameters
Parameters that effect whether Melodic Repeat effects are used with Direct Index notes.

Bend Parameters
Parameters that allow bending effects to be added to Direct Index notes, independent of the Auto Bend effects set up in the 
Bend Page.

Menu Button
A popup menu allowing instant access to this help chapter.

Page 315



�    Note that to perform Directing Indexing, a controller must be selected as a Source in the Performance Editor > 
Dynamic MIDI Page, and one of two different options selected as a Destination:

- Direct Index
- Direct Idx & Mdl Stop

For more information, see:

Dynamic MIDI Sources <DynSrc>

Dynamic MIDI Destinations <DynDst>

Performance Editor > Dynamic MIDI Page. <DynEd>

    Any parameters that have a gray/black appearance (but are not disabled), yet are unable to be edited when clicked, 
are assigned as RT Parms (Real-Time Parameters). See the GE Editor > RT Parms Page for more information.

<RTPEd><ParmsGen>
Direct Index - General Parameters
 

The parameters in this section affect the overall Direct Indexing effect in general.
<0383>
    [Index Shift] (popup menu) [0...3]

Selects one of several options for shifting the indexes coming from the controller, if the Note Series at any given time is 
longer than the range of the selected controller. For example, if you specified an octave of keys (12 keys) as a controller, 
and there were 24 notes in the Note Series, those 12 potential indexes can be directed to different areas of the Note 
Series.

If the number of steps in the range of the selected controller is less than or equal to the number of notes in the Note 
Series, this parameter has no effect and KARMA automatically maps the indexes to the proper notes. If the number of 
steps is equal, there will be a predictable one-to-one correspondence between the controller and the Direct Index notes. If 
there are fewer notes in the Note Series than, KARMA automatically maps the indexes in a way that prevents adjacent 
controller indexes from selecting the same note. In addition, in the case of using a CC to sweep through the Note Series, 
values that would cause duplicate notes will be filtered out. This means you can comfortably use a CC with a range of 
0~127 to sweep through a 15 note Note Series.

0: Top
If the length of the Note Series is greater than the range of the selected controller, the indexes will be shifted to the top, 
so that the highest Direct Index note will be the highest note in the Note Series.

1: Bottom
If the length of the Note Series is greater than the range of the selected controller, the indexes will be shifted to the 
bottom, so that the lowest Direct Index note will be the lowest note in the Note Series.

2: Center
If the length of the Note Series is greater than the range of the selected controller, the indexes will be centered around 
the middle note of the Note Series.

3: Skip
If the length of the Note Series is greater than the range of the selected controller, the indexes will be scaled into the Note 
Series so that the lowest Direct Index note will be the lowest note in the Note Series, the highest Direct Index note will be 
the highest note in the Note Series, and the other indexes will be spread out over the Note Series, resulting in one or more 
notes in the Note Series being skipped (cannot be indexed from the controller).
<0384>
    [Trill Mode] (popup) [0...5]

Selects one of several options for producing an automatic randomized trill/arpeggio when holding down a certain number 
of Direct Index notes. The rate at which the notes are generated is automatically calculated based on the tempo. This can 
be used to simulate fast soloing riffs while performing Direct Indexing.
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0: Off/DynMIDI
No trill effect will be introduced, no matter how many Direct Indexing notes are held down simultaneously. A Dynamic 
MIDI destination may be assigned to switch the trill on and off (for (IJ) InterJam only).

1...5: 1 Note Or More ~ 5 Notes Or More
Specifies the required number of notes that must be held down before the trill/arpeggio starts. When set to “1 Note Or 
More,” playing even a single note causes it to start repeating at the automatically calculated rate. Other notes may then 
be added to become part of the trill/arpeggio.
<0385>

     [Held Note Trigger Mode] (popup) [0...3]

Selects one of several options for deciding what happens when Direct Index notes are being sustained, and the chord is 
changed so that the sustained notes no longer “fit” the chord (are no longer a part of the Note Series). Part of the concept 
with this parameter is to allow soloing only within a “correct” key or Note Series.

0: Off
Nothing is done. The note(s) remain sustained, even if they are “wrong.”

1: Bend/Retrigger
If only one Direct Index note is being sustained, it is bent (with pitch bend) down to the nearest pitch in the new Note 
Series (if it is no longer present in the Note Series). If more than one note is being sustained, they will all be changed to 
the nearest notes in the new Note Series and retriggered. If several are sustained, and only one is “incorrect,” they will 
all be retriggered.

2: Retrigger
All sustaining Direct Index notes will be changed to the nearest notes in the new Note Series and retriggered. If several 
are sustained, and only one is “incorrect,” they will all be retriggered.

3: Mute
Any sustaining Direct Index notes not present in the new Note Series will be shut off.
<0386>
    [Transpose] (numerical) [-36...+36 semitones]

Transposes the pitch of the Direct Indexing notes as they are selected from the Note Series. This separate setting allows 
you to choose the octave for Direct Indexing independent of where the rest of the current GE is designed to work. Note 
that this is completely separate from the Transpose setting in the Performance GE Setup/Mix Page, so changing the 
octave there will have no effect on Direct Indexing.
<0387>

    [Vel. Sensitivity (Kbd)] (numerical) [1...127]

Specifies the lower limit of a scaled velocity range (‘n’ to 127). Triggers being provided by a velocity sensitive 
controller will be scaled according to this before being applied to the Note Series. This controls the velocities of the Direct 
Index notes as they are generated. For example, if the value is 1, then the velocities would be exactly as played with an 
unmodified range of 1 ~ 127 (full sensitivity). If the value is 64, the velocities would be half as sensitive, because any 
velocity received from 1 ~ 127 will be scaled into the range of 64 ~ 127. Note that if the controller is a CC such as a 
joystick, there is no velocity associated with moving it, so the last received keyboard velocity is used, or a default.
<0403>
    [Vel. Offset (CCs)] (numerical) [0...200%]

When a CC such as a joystick or ribbon is being used as a Direct Index controller, there is no velocity associated with 
moving it, so the last received keyboard velocity is used, or a default. Velocity Offset (CCs) specifies an amount by which 
the velocity of the indexed notes will be offset from the GE’s internal velocity setting. This allows you to make them a bit 
softer or louder than generated notes from the same GE, for example. The value is a percentage of the initial velocity, so 
values less than 100 will produce softer indexed notes, while values greater than 100 will produce louder notes. A value 
of 0% will effectively stop the generation of indexed notes.

<ParmsDur>
Direct Index - Duration Parameters
 

The parameters in this section affect the durations of the Direct Index notes. You can be in control of them yourself from 
the keyboard, or select several different options for automatically generating the durations.
<0388>
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   [Control] (popup) [0...2]

Determines whether the durations of the Direct Index notes will be controlled by the other parameters in this section, or 
by the user (through the controller doing the Direct Indexing). The notes that may be generated normally by the GE are 
still independently controlled by the settings in the Duration Page.

0: GE
Direct Index notes will have the duration specified by the other two parameters in this section, the Duration Mode menu 
and the ms field (if applicable). The actual durations of the controller keys are not taken into account. For example, you 
might set up an effect with a short duration that then uses Melodic Repeat to generate further notes. Setting this to “GE” 
ensures that the user’s release of a key has no effect on the actual durations.

1: Kbd - Poly
Direct Index notes will have the actual duration of the controller keys - pressing a key starts a note and releasing it ends 
a note. The Duration Mode menu and ms field become grayed out and unavailable. This allows the user to control the 
duration, especially useful for simulating soloing. The controller will act polyphonically - multiple notes can be played and 
held down simultaneously.

2: Kbd - Mono
Same as “Kbd - Poly” above, except the keys act monophonically - you cannot play more than one note at a time. Useful 
for certain types of simulations such as saxophone and synthesizer solos.
<0389>
    [Mode] (popup) [0...3]

Selects one of several modes of operation for controlling durations of the Direct Index notes, when the Duration Control 
parameter is set to “GE”:

0: Poly Extend
Each note will sustain until the next generation of the same note, or until that note is no longer a part of the Note Series 
(caused by playing a new chord, for example). For example, if the notes to a CMaj chord are sustaining and the chord is 
changed to a CMinor, only the Es will be shut off. 

1: Poly Extend/Damped
The same as above, except all sustaining notes will be damped (shut off) when the chord changes, not just notes that are 
no longer in the Note Series.

2: Mono Extend
Each note is sustained until the next note (of any pitch) is generated.

3: Timed (1 to 5000 ms)
Makes available the “ms” field, where you specify in milliseconds the duration of the generated notes. All notes will 
therefore have the same length. Note that this is independent of the current tempo - if it is set to 50 ms, it will always be 
50 ms, regardless of tempo.

    Not available if Duration Control is not set to “GE.”
<0390>
    [ms - milliseconds] (numerical) [1...5000 ms]

When the Duration Mode above is “Timed,” specifies in milliseconds the duration of the generated notes. All notes will 
therefore have the same length. Note that this is independent of the current tempo - if it is set to 50 ms, it will always be 
50 ms, regardless of tempo.

    Not available if Duration Control is not set to “GE” or Duration Mode is not set to “Timed.”

<ParmsRpt>
Direct Index - Repeat Parameters
 

<0391>
    [Repeat On/Off] (button) [Off, On]

Allows Melodic Repeat to be independently controlled for Direct Indexing. When this is on, the Direct Index notes will have 
Melodic Repeat according to the settings of the parameters in the Melodic Repeat Page. The [mr] (melodic repeat) buttons 
in the Phase Page - Phase Activity Grid do not affect Direct Indexing. This allows you to have a GE set up where the 
normally generated effect has Melodic Repeat while Direct Indexing does not, and vice versa, or other variations.

<ParmsBnd>
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Direct Index - Bend Parameters
 

The Bend Parameters section controls automatic pitch bending effects that may be applied to the Direct-Indexed notes. 
Most of the following parameters have the same functionality as those described in the Bend Page. However, the bend 
specified here will only happen for Direct Indexing notes. This means that a GE can have one type of Auto Bend effect for 
notes that are being generated, and a different Auto Bend effect for Direct Index notes. Alternatively, Direct Indexing 
notes can have bending while notes generated automatically by the same GE do not.

There are several differences between Direct Index Auto Bend and Auto Bend for generated notes (set in the Bend Page):

- It is not possible for the length of the bend to be set to “Note Dur,” since in most cases the duration is not known ahead 
of time. Therefore, this option is not available in the Length popup.

- The “Next and Prev Note” bending options are replaced with “Next and Prev Index” options. The difference is that 
when notes are being generated, it is possible to calculate ahead of time what will be the next note. With Direct Indexing, 
it is impossible to know what the next note is since you chose it yourself. Therefore, when set to Next Index, it will bend 
from the currently chosen index in the Note Series to the next adjacent index in the Note series. The same difference 
applies for “Prev Index.” These differences are explained further below.
<0392>
    [Bend On/Off] (button) [Off, On]

When set to off, Direct Index notes will have no bending, but the GE can still generate Auto Bend according to the Bend 
Page settings when triggered normally. When set to on, Direct Index notes will have bending according to the parameters 
in this page - the settings in the Bend Page do not affect them (other than Bend Range).
<0393>
    [Amount] (popup menu) [-12...+18]

Sets the size in semitones of the bends, or selects one of several special bending options. Note that the actual resulting 
size of the bend also depends on the setting of the Bend Range parameter (in the Bend Page). The following descriptions 
apply when the Bend Range value is “12” (an octave). If the Bend Range was “6,” the semitones would actually be 
half-semitones; if the Bend Range was “24,” the semitones would actually be whole tones.

0: Random (-12~12)
Each bend selects a random semitone size from -12 ~ 12 (excluding 0).

-12...+12 (Semitones)
Bends each note the selected semitone size.
 

13: Next Index
Bends each note to the next index in the Note Series (note that his may be an up or down bend depending on how the Note 
Series is constructed and sorted). For example, if the Note Series contains {C, E, G, B, C...}, then when the E is Direct 
Indexed it will bend to the G.

14: Next Index + 1
Bends each note to the index in the Note Series that is two indexes forward (note that his may be an up or down bend 
depending on how the Note Series is constructed and sorted). For example, if the Note Series contains {C, E, G, B, C...}, 
then when the E is Direct Indexed it will bend to the B.

15: Next Index + 2
Bends each note to the index in the Note Series that is three indexes forward (note that his may be an up or down bend 
depending on how the Note Series is constructed and sorted). For example, if the Note Series contains {C, E, G, B, C...}, 
then when the E is Direct Indexed it will bend to the second C.
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16: Prev Index
Bends each note to the previous index in the Note Series (note that his may be an up or down bend depending on how the 
Note Series is constructed and sorted). For example, if the Note Series contains {C, E, G, B, C...}, then when the B is 
Direct Indexed it will bend to the G.

17: Prev Index - 1
Bends each note to the index in the Note Series that is two indexes backward (note that his may be an up or down bend 
depending on how the Note Series is constructed and sorted). For example, if the Note Series contains {C, E, G, B, C...}, 
then when the B is Direct Indexed it will bend to the E.

18: Prev Index - 2
Bends each note to the index in the Note Series that is three indexes backward (note that his may be an up or down bend 
depending on how the Note Series is constructed and sorted). For example, if the Note Series contains {C, E, G, B, C...}, 
then when the B is Direct Indexed it will bend to the first C.
<0394>
    [Shape] (popup menu) [0...2]

Selects one of three different overall shapes for the resulting bend. “Bend” is a single bend to a destination pitch, while 
the “Hammer” settings bend to the pitch and back. See the diagrams in the Appendix Using Auto-Bend - The Different Bend 
Shapes.
<UseAutoBend/Shape>

0: Bend
Bends the current note to whichever note or by whichever semitone size is selected in the Amount parameter. The timing 
and length of the bend is determined by the Length, Start and End parameters. Useful for portamento simulation and ethnic 
bending effects, among others.

1: Hammer
Bends the current note to whichever note or by whichever semitone size is selected in the Amount parameter, then back 
to the current pitch. The timing and length of the bend is determined by the Length, Start and End parameters, and the 
Width parameter. Useful for guitar hammer-on effects, among others.

2: Hammer Bend
Bends the current note to whichever note or by whichever semitone size is selected in the Amount parameter, then back 
to the current pitch, then again to the note or pitch selected in the Amount parameter. The timing and length of the bend is 
determined by the Length, Start and End parameters, and the Width parameter. Useful for ethnic bending effects, among 
others.
<0395>

    [Alternation] (popup menu) [0...1]

0: Off     1: Alternating
When set to “Alternating,” causes alternate bends to flip back and forth between the (+) and (-). For example, if the 
Amount parameter is set to +12, then the bends produced with a series of notes will be {+12, -12, +12, -12...} etc. When 
Next/Prev Note Bending is selected, it will alternate between Next and Prev. For example, if “Next” is selected in the 
size Menu, then the bends will be {Next, Prev, Next, Prev...} etc.
<0396>
    [Step Mode] (popup menu) [0: Smooth, 1...12 semitones]

Sets whether the bends will be smooth (continuous) or divided into steps (glissando bends).

0: Smooth
Bends will be continuous, with a value sent out every “n” milliseconds as specified by the Rate parameter.

1:                               1  ST - Chromatic
2:   2  ST - Whole Tone
3:   3  ST - Diminished
4:   4  ST - Augmented
5:   5  ST - Fourth
6:   6  ST - Tritone
7:   7  ST - Fifth
8:   8  ST - Aug. Fifth
9:   9  ST - Sixth
10: 10 ST - Dom. 7th
11: 11 ST - Maj. 7th
12: 12 ST - Octave
Bends will be quantized to the semitone step size selected, producing “glissando” bends. For example, if the Amount 
parameter is set to 12 and Step Mode is set to “2 ST,” then the resulting bend will be quantized to 6 steps of 2 semitones 
each (a Whole Tone scale). 

    When one of the Semitone settings is selected, the Rate parameter is not available.
<0397>
    [Length] (popup menu) [0...24]

Specifies an overall length for a “bend window” within which the bend will take place. The actual timing of the bend within 
that window is based on the Start and End parameters.
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0...23: Rhythmic Values
Sets the overall length of each bend window to the selected rhythm value; each bend will be therefore be the same length. 
Note that this is tempo dependent, so changing tempos changes the length of the bend and keeps the effect locked to tempo. 
If the length of the bend is longer than the actual duration of the note with which it is generated, part or all of the bend 
will not be heard.

24: Fixed ms - (milliseconds)
Makes available the Fixed-ms field beneath the popup menu. A length of absolute time may then be specified in milliseconds 
for each bend window. Note that this is independent of any tempo settings. You might use this to keep the same length and 
speed of a bend regardless of the tempo.
<0398>
    [Fixed-ms] (numerical) [0...5000 ms]

Specifies a fixed length of absolute time for each bend window. Note that this is independent of any tempo settings. You 
might use this to keep the same length and speed of a bend regardless of the tempo.

    Not available unless “Fixed ms” is selected in the Length popup menu.
<0399>
    [Start %] (numerical) [0...100%]

Specifies the start point of the bend in the overall bend window (set by the Length parameter). The value is a percentage 
of the overall bend window. For example, if 0%, the bend will start as soon as the note begins to play; other values will 
cause a certain “delay” before the start of the bend.
<0400>
         [End %] (numerical) [0...100%]

Specifies the end point of the bend in the overall bend window (set by the Length parameter). The value is a percentage of 
the overall bend window. For example, if 100%, the bend will extend all the way to the end of the bend window; other 
values will cause the bend to reach the destination pitch and “hang there” for a period of time.
<0401>
    [Width %] (numerical) [0...100%]

Specifies the width of the “hammer” when the Hammer shapes are selected. This controls the amount of bend at each end 
of the hammer (the “back-and-forth” bend). For example, 0% creates a triangle wave shape, and 100% creates a square 
wave shape, with other values somewhere in between. Width also controls the length of the final bend when the Hammer 
Bend shape is selected. See the description in the Appendix Using Auto-Bend - Length of Bends.
<UseAutoBend/Length>

    Not available when Shape = “Bend.”
<0402>
    [Rate] (numerical) [1...100 ms]

Specifies how often a bend value will be sent out (in milliseconds). This controls the density of the MIDI data. For long 
bends, a higher rate may be acceptable, while for short bends a lower rate will be necessary. Usually, a setting of 8~10 
ms is adequate.

    Not available when Step Mode = “Smooth.”
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RT Parms (Real-Time Parameters)
Sections in this chapter:

Overview<RTPEd/Over>

Parameters<RTPEd/Parms>

About Values to Display<RTPEd/ValDisp>

 

<Over>
RT Parms - Overview
The GE RT Parms Page is where you can select up to thirty-two parameters within the GE to be brought to the Performance 
level for possible real-time control. The parameters selected here appear in the Performance Editor > RT Parms Page, and 
may be modified (without affecting the underlying settings of the GE) or assigned to various real-time control options, such 
as the sliders in the Real-Time Controls Window.

Parameters Area
Displays GE RT Parms 1~8, 9~16, 17~24, or 25~32, depending on the Row Selection Buttons.
<0410>

Row Selection Buttons
Switches the Parameter Area between rows 1~8, 9~16, 17~24, or 25~32.
<0408><0409>

Values To Display
Switches between displaying the actual Stored (Center) Values, and the Current (Controlled) Values that may be modified 
by the positions of any assigned Real-Time Controls. See About Values To Display below.
<RTPEd/ValDisp>

Stored (Center) Values
Displays the stored settings in the Value fields. These are editable, and reflect the “center” position of any assigned 
controller (or the actual current setting if no controller is assigned).

Current (Controlled) Values
Displays the actual current settings in the Value fields. These are not editable, but represent the Value as modified by any 
assigned controller.
<0411>

RTC Model Data File
Displays the name of the currently loaded RTC Model Data File, which is a factory provided specification for how to assign 
the RT Controls when a GE is loaded. This generally does not need to be changed by the user.
<0420>
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RTC Model
Displays the name of the current GE’s RTC Model Type, which controls how the RT Controls are assigned to it when it is 
loaded.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this page:

 

Copy RT Parms From Another GE...<GEUtils/Rco>

Copy/Swap RT Parms In Current GE...<GEUtils/Rcs>

Clear RT Parms (Current 8)
Clears all RT Parm assignments for the currently showing eight rows.

Clear RT Parms (All 32)
Clears all RT Parm assignments for all 32 rows.

Set RTC Model to “Custom”
Allows you to change a GE’s RTC Model Type to “Custom,” meaning that no RT Controls will be hooked up to the GE RT 
Parms in the Performance when the GE is selected.

Reset RTCModel Data File
There is an external file used by the KARMA application that contains RTC Model data. In the unlikely event that this file 
cannot be located, use this command to reset the file location to the factory default. The name of the currently loaded RTC 
Model Data file is displayed below the Menu Button.

<Parms><0419>
RT Parms - Parameters
 

<0412>
    [Group] (popup menu) [0...15]

Selects the group of GE Parameters that you wish to assign. Groups correspond to all of the GE Editor Pages (with the 
exception of the RT Parms Page itself) and the main GE Editor. For a complete list of all GE Parameters within each group, 
see the Appendix RT Parms Reference.
<RTPRef/GrpGE>

0: Off
No assignment. The rest of the parameters in the row will be grayed out.

1: GE
2: Note Series
3: Phase
4: Rhythm
5: Duration
6: Index
7: Cluster
8: Velocity
9: CCs
10: WaveSeq
11: Envelopes
12: Repeat
13: Bend
14: Drum
15: Direct Index
<0413>
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    [Parameter] (popup menu) [varies depending on Group]

Depending on the Group setting (above), certain parameters from within the various GE Pages and GE Editor will appear in 
this menu. Selecting one assigns that parameter to be controlled by the Value field, and any assigned RT Control. RT Control 
assignments are done in the Performance Editor > RT Parms Page.
<RPPEd>

    Once a parameter is assigned as an RT Parm, it will have a gray and black appearance in its normal location. If you click 
on it to edit it, it will present you with the RT Parm Warning Dialog and not allow editing unless you hold down the Cmnd 
Key (Mac) or Ctrl Key (Win) when clicking the parameter. Once it is assigned, editing the Value field in this page or moving 
an assigned RT Control will change that value in place. 
<OthDlg/RTPWarn>

    It is only advisable to modify RT Parm assignments in the slots that are not required for the GE’s RTC Model. Each GE 
that is configured to use a particular RTC Model has a certain number of “required” parameters, that are in a particular 
order. Modfying them will interfere with GE loading operations. The safe slots are located towards the end of the 32 RTP, 
and are indicated by an asterisk (*) preceding the slot name. Otherwise, you risk compromising the RTC Model concept for 
that GE, and when it is reloaded, it will not automatically hookup the RT Controls properly. 
<0414>
    [Info] (label)

This non-editable label displays the “type” of user interface object associated with the selected parameter, and the 
overall available Min/Max Range. You can limit the range using the Min/Max parameters below if desired. This information 
is mainly for help in programming the desired response.

pop:     the parameter is a popup menu object
num:    the parameter is a numerical object
but:     the parameter is a button object, or button grid
rng:     the parameter is a range bar object
vir:     the parameter is a “virtual parameter” not associated with any other UI object

    When a parameter is first assigned, if it exists in more than one place (such as both Phases or all three Envelopes or 
Drum Patterns), the info popup will remind you to make an assignment in the Phase/Env/Drum button grid discussed below 
by displaying a message such as “** select phase ->.”

    If you see asterisks (**) in this info label, it indicates a programming error where the assigned RT Parm is configured 
incorrectly. Check the Min/Max settings and the Phase/Env/Drum assignment.

    Many ranges and values in KARMA are “zero relative.” In other words, a popup menu might show 64 items, which 
would be referred to as a range of “0 ~ 63.”
<0415>

    [Phase/Env/Drum] (button grid) [0...2]

When the selected parameter has more than one “instance” (it exists in both Phases, or all three Envelopes or Drum 
Patterns), these buttons become available to indicate which parameter you wish to control. You can control them 
individually with two or three RT Parm rows, or click all the buttons to control them all identically at the same time.
<0416>
    [Minimum] (numerical) [-500...+5000, limited according to applicable range]

Specifies the Minimum Value that can be operated by an assigned controller or entered into the Value field. The available 
range will depend on the selected Parameter. When the Parameter is selected, the Minimum parameter value (displayed in 
the Info Label) will be set as the default.
<0417>
     [Maximum] (numerical) [-500...+5000, limited according to applicable range]

Specifies the Maximum Value that can be operated by an assigned controller or entered into the Value field. The available 
range will depend on the selected Parameter. When the Parameter is selected, the Maximum parameter value (displayed in 
the Info Label) will be set as the default.

    You can reverse the polarity (invert the operation) of a GE RT Parm by either reversing the Min/Max settings or using 
the Polarity parameter in the Performance > RT Parms Page.
<0418>
    [Value] (numerical) [-500...+5000, limited according to min/max range]

Sets the Value of the selected GE RT Parameter. The range of this parameter will vary depending on the settings for the RT 
Parm Min/Max fields above. When you select a parameter, the Value displayed here initially will be set to the current 
Value of the parameter. If the parameter has more than one Phase/Env/Drum button selected, they will all be set to the 
same value.

    The value you specify here will be the center value when a slider is assigned and used to control this parameter, and 
the min or max when a Switch is assigned. To view the actual modified value, and not the stored center value, switch the 
“Value To Display” buttons to “Current (Controlled) Values.” See “About Values To Display” below.

<ValDisp>
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RT Parms - About Values To Display

    To experiment with this, select any Performance, switch the Values To Display to “Current (Controlled) Values,” and 
move the Sliders in the Real-Time Controls Editor. Watch the values of the parameters here that are assigned to the 
Sliders and Switches change to reflect the actual setting as based on the position of the controller.

 

As shown above, when the Values To Display button is changed to “Current (Controlled) Values,” the Value fields become 
grayed out and are not editable. However, in this mode they display the actual current values as they may be modified by 
the positions of any assigned controllers, and not the stored center values. In other words, in the example above, GE RT 
Parm #1 happens to be assigned to a slider in the Real-Time Controls Window. Out of the available range of -200…+200, 
the RT Parm has been set to have a controllable range of 0...+100. The Value (not shown) has been set to +50 in the 
“Stored (Center) Values” view, so that the center of the slider is 50 and the parameter varies from 0 to 100 as the slider 
moved from left to right. However, currently the slider is nearly all the way to the left, so the actual “Current 
(Controlled) Value” of the parameter is 7.
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Preferences
Sections in this chapter:

Overview<Prefs/Over>

General<Prefs/General>

Workspace<Prefs/Work>

Popups<Prefs/Popups>

 

<Over>
Preferences - Overview
The Preferences Dialog allows you to edit many global settings that affect the way the KARMA application works. These 
are separate from the MIDI-related global settings, which can be found in the MIDI Setup (Global) Editor. <MsuEd>

The Preferences Dialog can be opened by the following methods:
- pressing the “Preferences” button in the main application window’s Toolbar;
- choosing “Preferences” from the Application Menu (Mac) or Edit Menu (Windows);
- using the keyboard shortcut Cmnd+, (Mac) or Ctrl+, (Win).

Page Tabs/Page Display Area
The Page Tabs select one of several groups of related parameters for editing in the Page Display Area.

Default Button
Reverts the current page to default factory settings.
<0749>

Cancel Button
Closes the dialog without saving any changes you have made.
<0750>

OK (Save) Button
Closes the dialog and saves your changes.
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Preferences - General
 

The General Tab contains some global settings that control how the KARMA Application functions.
<0751><0752>
    [Upon Startup] (radio buttons)

Determines the file-loading behavior of KARMA when it is launched.

Load Last Files
KARMA will attempt to locate and load the last used KDF file(s) after being launched. If not found, you will be presented 
with a dialog box asking you to locate the missing file.

Ask For Files
After KARMA is launched, you will be presented with a dialog box asking you to locate the KDF file that you want to load.
<0746>

    [Always confirm when overwriting (unless same name)] (checkbox)

When on, attempting to store a Performance or GE into a location occupied by one with a different name will put up a 
confirmation dialog asking you if you really want to replace it, giving you a chance to reconsider. This can be helpful if 
you find yourself accidentally overwriting items that you didn’t want to. The dialog will not be presented if you are trying 
to replace an item with the same name (the assumption is that you are updating it).
<0742>

    [Warn when edited and selecting a new Performance or GE] (checkbox)

When on, selecting a new Performance or GE when there are unsaved edits will present a warning dialog allowing you to 
cancel the selection. Since any real-time playing with a combi edits the performance, this may get annoying, but some 
users have requested this type of notification, so it has been included (and it defaults to off). By using this, you’ll never 
blow out an edit by changing inadvertently to a new Performance or GE. 
<0743>

       [Warn when edited and selecting a new Performance via MIDI] (checkbox)

This option is separate from the above for use with the feature that allows Performances in the software to be changed by 
selecting songs on the Motif/MOX. When on, selecting a new Performance via MIDI Song Select Message when there are 
unsaved edits will present a warning dialog allowing you to cancel the selection. The two options are separate, since you 
may wish to disable the other one, but it’s easy to be in the middle of a deep edit, and change to a different song on the 
Motif/MOX to check something, forgetting that this will blow out your edit. This also defaults to off.
<0745>

    [Warn when edited and reloading the current Performance] (checkbox)

This option relates to the “Sequencing Reset” feature in the MIDI Setup (Global) Editor > General Page. When on, 
attempting to reload the current Performance (by SPP=0 from the sequencer) when it has been edited will present a 
warning dialog allowing you to cancel the selection. It is recommended to turn this off when using that feature during 
sequencing. 

    Note that the Motif/MOX automatically sends an SPP=0 message when you save a song in the Motif/MOX, and if this is 
off, you may inadvertently lose an edited Performance when simply working on Performance creation.
<0747>
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  [Programmer Name] (text field)

A programmer name can be stored with each Performance and GE. You can enter the name here that you would like stored 
with your Performances and GEs, in the event that you share them with others. Note that this does not change the names 
that are presently stored in any GEs or Performances. It only presets the name that will be displayed when you click on 
the Programmer Name fields in the GE or Performance.
<0772>

    [Tap Tempo - number of taps to recalculate] (numerical) [2...9]

When the Tap Tempo function is enabled in the Options menu, specifies the number of taps (on the space bar) required to 
recalculate and reset the tempo. In other words, it takes at least one tap to start a time period, and a second tap to end it. 
However, by setting it to 3, 4 or 5 for example, the taps are averaged and the resetting of the tempo occurs on the last 
tap. If no taps are received for three seconds, the tap tempo function will start over with the next tap.
<GELoad><0775><0776><0777><0778><0780><0781>
    [Load GE Options] (radio buttons and checkboxes)

The settings in this section determine how the RTC models are applied when you load a GE into a Performance:

Automatically setup the RTC Control Settings
When this option is selected, loading a GE will remap the Real-Time Controls according to the GE’s RTC Model Type, 
optionally initializing all scenes.

Use the GE’s stored RTC Model
When on (recommended), the RT Controls will be set up according to the GE’s stored RTC Model Type. When off, an 
attempt to hook the GE’s RTP to the current setup will be made.

Reset all scenes to original values
When on, all scenes in the Module’s Control Layer will be reset to the default settings of the GE. When off, the scene 
settings will not be altered if the RTC Model Type is the same as the previous GE.

Clear all RT Control Settings
When this option is selected, loading a GE will clear all RT Control Settings (so that no controllers are assigned to the GE’s 
RTP), optionally initializing the rest of the Module settings as well (Trigger, Control, Seeds, etc.)

Initialize KARMA Module Settings
When off, nothing will be changed in the Module settings (recommended for most situations). When on, all Module 
parameters within the Performance will be reset to default values (except for Key Zone and Thru). 

Do not adjust RT Control Settings
Nothing will be changed when loading a new GE. Sliders and switches will remain assigned to whatever new parameters 
are in the 32 GE RTP. This is likely only useful in certain advanced situations.

Here is an explanation of the various combinations of settings and what results they achieve:

1. (*) Automatically setup the RTC Control Settings
       [x] Use the GE’s stored RTC Model
       [x] Reset all scenes to original values

- If new GE has an RTC Model, load it and reset it according to the RTC Model Spec, and reset all 8 scenes and scene 
names. This wipes out all previous settings.

- If new GE has no RTC Model, clear all RTC settings, load GE with nothing assigned. Reset scenes and names to INIT. This 
wipes out all previous settings. In this case, same as Example [4] below.

This is the best option for selecting and loading a new GE. It guarantees everything gets set up correctly, with all 16 
RTControls and Names automatically assigned to the 32 GE RTP and ready for use.

2. (*) Automatically setup the RTC Control Settings
       [x] Use the GE’s stored RTC Model
       [ ] Reset all scenes to original values

- If new GE has the same RTC Model as the currently loaded GE, load it and reset it according to the RTC Model Spec. 
However, do not reset scenes - the scene settings will be kept, and applied to the newly loaded GE. For example, this 
means that if you have a certain Melodic Repeat effect set up in a scene, that settings would be kept and the new GE would 
be able to use those settings in that scene, since they are basically the same RTC Model and RTParms.

- If the new GE has a different RTC Model from the currently loaded GE, load it and reset it according to the RTC Model 
Spec, and reset all 8 scenes. This wipes out all previous settings. This is the same as Example [1], in this case.

- If new GE has no RTC Model, clear all RTC settings, load GE with nothing assigned. This wipes out all previous settings. 
In this case, same as Example [4] below.
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3. (*) Automatically setup the RTC Control Settings
       [ ] Use the GE’s stored RTC Model
       --- Reset all scenes to original values (disabled)

RTC models are not taken into consideration for any existing RTC Assignments. Rather, this uses a different method 
written specially to deal with the following situation: User loads a GE with a specific RTC Model, but clears all control 
assignments. Then user sets up the GE with his own Control Assignments. User then wants to change GE to another GE 
having the same RTC Model (or maybe different), and keep his control assignments while switching. In this case, the 
system will “remap” the settings (attempting to keep his setup as much as possible). If a control is assigned to Velocity 
Scale, the code looks for Velocity Scale in the new GE and moves the control assignment to that slot. If the RTParm is not 
found in the new GE, it is removed. The Scene settings will not be affected, and can be applied to the new GE.

4. (*) Clear all RT Control Settings
       [ ] Initialize KARMA Module Settings

Loading any GE clears all RTC settings, resets all scenes/names, and loads GE with nothing assigned. This wipes out all 
previous settings. GE is guaranteed to play correctly, any time. No controls are connected.

5. (*) Clear all RT Control Settings
       [x] Initialize KARMA Module Settings

Same as above, with the additional step of initializing all Module parameter with the exception of the Key Zone and Thru 
settings. In other words, this resets all Module triggering settings, clock advance, random seeds, CC offsets, MIDI 
filtering, etc.

6. (*) Do not adjust RT Control Settings

Loading a GE does nothing, other than load the GE. If the RTParms in the slots don’t match, and the controls that were 
previously assigned make no sense with the new GE (as is often the case), it will not match and likely perform strangely. 
However, this might have an application in vertain advanced situations with custom-designed GEs.
<0741>

    [Reset Warning Dialogs] (button)

Pressing this button resets any of the “Don’t Show Again” settings that are stored in the Preferences. In some of the 
warning dialogs displayed during operation, you may see a checkbox with the words “Do not display again” or “Do Not 
Display Again this session”, or a button with a similar command. Some of these work on a session basis (in other words, 
the next time you launch the app they are reset and will appear again until you tell them not to), and others are stored in 
the Preferences, such as whether to show the “First Launch” window when launching the application. 
<0740>

    [Performance Notes Folder] (text field)

Specifies the path to the main folder containing the Performance Notes files for each Performance. By default, the 
specified folder is located in the application’s folder.

Mac:
If a tilde (~) prepends the name, the folder can optionally be located in the User’s Documents folder inside a KARMA Motif 
folder (~/Documents/KARMA Motif/).

Windows:
If a tilde (~) prepends the name, the folder can optionally be located in the User’s Data Folder inside a Karma-Lab\KARMA 
Motif folder. The User’s Data Folder and resulting path depends on which version of Windows you are running:

Windows 8, Windows 7, Vista:
C:\Users\(UserName)\AppData\Roaming\Karma-Lab\KARMA Motif\

XP:
C:\Documents and Settings\(UserName)\Application Data\Roaming\Karma-Lab\KARMA Motif\

    Note: these are hidden folders on a default Windows Installation. You may need to go into “Folder Options > View” and 
turn on “Show hidden files and folders.”
<0748>

    [Default] (button)

Restores the settings on the General Tab only to the recommended default settings.

<Work>
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Preferences - Workspace
 

The Workspace Tab contains some global settings that control how the KARMA Application window appears and functions.
<2320>

    [Main Window - Keep KARMA Window Centered] (checkbox)

(Windows only) When on, keeps KARMA’s Main Application Window centered inside the parent window if it is made larger 
than the Main Application Window.
<2321><2322>
    [KARMA Window] (radio buttons)

Determines whether the application will always show a specified page when launched, or will remember the page that it 
was on when it was last closed.

Remember last selected page
When the KARMA software is launched, it will open on the page it was displaying the last time you used it.

Open on this page
When the KARMA software is launched, it will always open on the specified page.
<2328><2329>
    [Chord Displays] (radio buttons)

Affects how any chord names are displayed in parts of the KARMA Applications, such as the top of the GE Editor.

Traditional
Chord names are displayed in a “traditional” shortened format, such as C, Cm, Cdim etc. This is the format used in the 
Korg Karma Music Workstation.

Extended
Chord names are displayed in an “extended” format, such as C Maj, C Min7, C Dim etc.
<2327>

    [Pattern Grids: Remove last cell in column: shift + opt/alt keys] (checkbox)

Patterns created in the various pattern editing grids can normally be shortened or cleared by removing all the cells in a 
column (with the mouse), which causes all columns after that one to be emptied and grayed out. Turning this checkbox on 
means that you must hold down the [shift] + [option] keys (Mac) or [shift] + [alt] keys (Win) to remove the last cell in any 
column. This makes it more difficult to accidentally erase half of your pattern because you removed a cell in the middle, 
when all you wanted to do was change it. Pattern Grids affected: Rhythm, Duration, Index, Cluster, Velocity, CCs, 
WaveSeq and Drum.
<2330><Tooltips>

    [Tooltips (Popup Help Messages)] (checkboxes)

Popup Tooltips are short descriptions that popup while holding the mouse cursor over various labels, parameters and 
objects in the application. Tooltips can be turned on or off globally for the entire application, in addition to having several 
groups within the tooltip system that can be independently controlled. You can control exactly which objects have tooltips 
and the amount of time delay before they pop up, or only the use of the ‘t’ key to make them pop up.
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For example, after you get used to working with KARMA, it may be helpful to set the tooltips to only popup over labels 
(and not parameters), and have the longest delay time setting. That way, you may never notice they are there during 
normal speed of working, but if you want a reminder or a hint about some function, you can hold the mouse over a label 
and it will appear. Or, you may wish to use the option where popping up is completely disabled, but you can still press the 
‘t’ key to make a tooltip popup at any time.

    When a tooltip is showing, if you press Cmnd+H (Mac) or Ctrl+H (Win), you will be taken directly to the Help File and 
the parameter associated with the tooltip for more information.

Show Tooltips
Turns on/off the presence of popup tooltips in the application. This setting can also be toggled on/off by the “Show 
Tooltips” item in the Help Menu. When this is on, the items underneath become available to be edited, giving you more 
control over when and how the tooltips popup:
<2331>

Parameters
When on, popup tooltips will be presented any time the cursor is held over an actual “parameter object” such as a popup 
menu, a number box, or a parameter button. When off, these objects will not be popup the tooltips (but the others objects 
selected here may be if desired).
<2332>

Labels
When on, popup tooltips will be presented any time the cursor is held over a “label” such as the names next to the actual 
parameters. When off, these objects will not be popup the tooltips (but the others objects selected here may be if 
desired). This is potentially most useful, as you can get tooltip help without interfering with the usage of the actual 
parameter entry objects.
<2333>

Other
When on, popup tooltips will be presented any time the cursor is held over other objects like Menu Buttons, Page Selection 
Buttons, keyboard graphics, etc. When off, these objects will not be popup the tooltips (but the others objects selected 
here may be if desired).
<2334>
    [Initial Delay] (popup menu) [0...5]

Short, Medium, Medium Long, Long, Very Long
Sets the amount of time required to wait before popping up tooltips when the cursor is over an object. The shortest time 
is about a half-second, the longest time is about 6 seconds. Note that the ‘t’ key is always operational in these modes as 
well .

Off - use ‘t’ key
When this option is selected, tooltips will not popup at all. However, you can still use the ‘t’ key. Simply place the cursor 
over an object, and press ‘t’ - the tooltip will pop up. You can hold down the ‘t’ key and move the cursor over other 
objects and the tooltips will keep popping up.
<2323><2324><MidC>
    [Middle C Display] (radio buttons)

Affects how various keyboard display objects and other interface objects display MIDI note names with reference to 
Middle C (60).

C3 (Yamaha Standard)
Changes various parts of the interface that refer to MIDI note numbers to reference C3 as being Middle C (60), which is 
Yamaha’s standard.

C4 (Korg Standard)
Changes various parts of the interface that refer to MIDI note numbers to reference C4 as being Middle C (60), which is 
Korg’s standard.
<2325><2326>

     [Computer Keyboard] (radio buttons)

Changes how several keys on the computer keyboard are assigned to certain KARMA features, depending on whether your 
keyboard has a Function Key [F13] or not.

Computer Keyboard (Standard)
Use this setting if your computer keyboard only has function keys up to [F12] (i.e. a standard keyboard or laptop). [F12] 
will trigger the Fill, while Shift + [F12] will change Module Control Layers.

Computer Keyboard (Extended)
Use this setting if your computer keyboard has more than 12 Function keys. [F13] will trigger the fill, while [F12] will 
change Module Control Layers.
<2335>

    [Default] (button)

Restores the settings on the Workspace Tab only to the recommended default settings.

<Popups>
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Preferences - Popups
 

The Popups Tab allows you to modify the way items like GE Names, Performance Names, etc. are displayed in the popup 
menus. The popup menus have two states:
<0797>

Display
The “unclicked” state, where the menu is simply displaying a single item in one of the windows.

Popup
When the popup is actually clicked, and the full contents are displayed.

The main purpose of this is to allow more letters rather than numbers to be displayed in the “unclicked” (display) states 
of the popups, where space is often at a premium. However, it’s up to you. The following options are available for all of 
the following described popups:
<0798><0800><0801><0804><0806><0807><0810><0812><0813><0816><0818><0819><0822><0825><0826>

Add Location Numbers
Selects whether or not the names will be shown with a numerical locator before them, such as “Cool Groove” or “56 
Cool Groove.”
<0798><0799><0802><0803><0805><0808><0809><0811><0814><0815><0817><0820><0821><0823><0827><0828>

Use Leading Zeroes (i.e. 004)
If the “Add Location Numbers” option above is turned on, selects whether or not the numerical locator will be displayed 
with zeroes so that the number is padded to the same length, i.e. “56 Cool Groove” or “056 Cool Groove.”

The following option is available for any popups that display Drum Note Names:
<0824><0829><0830>

Use Drum Names
Selects whether or not the note names will have Drum Names added to them, i.e. “36 C_1” or “36 C_1 - Kick 1.” The 
names are based on the KARMA Motif Drum Map (which itself is a slightly modified GM2 Drum Map - see the Performance 
Notes Table of Contents for details.)

    This is the same setting as controlled by “Use Drum Names” in the GE Editor > Drum Page Menu Button, and changing it 
in either place stores it into the preferences. However, the GE Editor also automatically controls this setting by turning it 
on when the GE’s RTC Model is “DP1 - Drum/Perc 1” or “DF1 - Drum Fill 1”, but turning it off when the RTC Model is 
“DM1 - Drum Melodic 1.”
<DrmEd/Menu><0832>

Display Names +12
For Korg keyboards, typically the internal Drum Kits are mapped an octave higher than the GM Drum Map. In other words, 
in the GM Drum Map, Kick1 is C2 and Snare1 is D2. In Korg Drum Kits, they are C3 and D3 (with reference to Middle C = 
C4). Checking this option shifts the drum names so they display an octave higher, matching most of the Korg Drum Kits 
more closely. This does not change the note number designations; C3 is still C3. It just changes which drum name is 
displayed for C3.

    [GE Popup Menus]

Display options for:
GE Editor > GE Bank and GE popups
Performance Editor > GE Setup/Mix Page: GE Bank and GE popups for each module
Main Window > Status Area > Current GE Info: GE name and bank name
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   [Performance Popup Menus]

Display options for:
Performance Editor > Performance Bank and Performance popups

    [Template Popup Menus]

Display options for:
GE Editor > Rhythm Page: Template popup
GE Editor > Duration Page: Template popup
GE Editor > Note Page: Template popup
GE Editor > Cluster Page: Template popup
GE Editor > Velocity Page: Template popup
GE Editor > CCs Page: Template popup
GE Editor > WaveSeq Page: Template popup
GE Editor > Drum Page: Template popups

    [Drum Name Popup Menus]

Display options for:
GE Editor > Drum Page: Drum Choice popups (seven in each Drum Pattern)
Metronome: Note popup
<0831>

       [Default] (button)

Restores the settings on the Popups Tab only to the recommended default settings.
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Performance Dialogs
Sections in this chapter:

Initialize Current/Selected Performance<PEUtils/Init>

Renumber Yamaha IDs<PEUtils/Renumber>

Copy From Performance<PEUtils/Mco>

Copy/Swap Module In Current Performance<PEUtils/ModSwap>

Module Name Select<PEUtils/ModNames>
\

Export Performance Names<PEUtils/Xpn>

Voice Mode Warning<PEUtils/VoiceWarn>

This chapter describes in detail some of the dialogs you will encounter when using the Performance Utilities available 
from the Menu Buttons in various windows, and from the application’s main Utilities Menu. 

<Init><1990><1995><1996>
Performance Dialogs - Initialize Current/Selected Performance
 

The Initialize Performance Dialog has two variations, as shown above, depending on how you are accessing the feature. It 
can be called from a Performance Bank Display Menu Button, with the “Initialize Selected Performances…” or “Initialize 
This Bank…” commands, in which case the dialog on the right is shown. The operation is then applied to one or more 
selected Performance locations in the Performance Bank Display (or the entire bank), initializing them to a default 
starting point (shift-click in the Bank Display to select more than one).

It can also be called from the Performance Editor’s Menu Button with the “Initialize Current Performance…” command, in 
which case the dialog on the left is shown, giving you an additional option to select one of the 14 GE RTC Models, and a 
special “Custom - No RTC Model” setting (which essentially is CL1 - Comp/Lead 1 without any GE RTP or RT Controls 
assigned to it). The operation is then applied to the current Performance (in the edit buffer), and the specified RTC Model 
Type is applied to the GE in Module 1.

In either case, you specify a “Module Setup Type” that controls the number of Modules in the initialized Performance and 
optional default controller routings.
<1994>
    [Module Setup Type] (popup menu) [0...2]

Selects one of several different configurations for the resulting initialized Performance, controlling the number of active 
Modules and some default controller settings:

1 Module
Initializes a single-module Performance, with the other Modules disabled, the Keyboard Layers muted, and the Control 
Layer set to Module 1. This is the easiest setting to use for trying to experiment with KARMA GEs, and for importing 
phrases.

6 Module
Initializes a multi-module Performance with all six Modules and both Keyboard Layers enabled and set to default settings, 
but only the Run button turned on for the first Module.
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6 Module, Standard Controllers
Initializes a multi-module Performance with all six Modules and both Keyboard Layers enabled and set to default settings, 
but only the Run button turned on for the first Module (the same as the previous option). Additionally, this sets up 
additional parameters such as the Performance > Dynamic MIDI Page to have the usual factory program style controller 
parameters hooked up, such as Stutter, Retrigger and Fill. It also sets up Module 6 to be controlled as a Fill Module, even 
though it is still a default arpeggio at this time. This might be the best choice if you wish to start programming your own 
Performance in the style of the Factory Performances (but it does require that you are more familiar with the workings 
of KARMA and have more experience creating Performances.)
<1991>
    [GE RTC Model Type] (popup menu) [RTC Models 1...14, Custom]

Will only be shown when doing “Initialize Current Performance…” from the Performance Editor Menu Button.  Selects one 
of the 14 GE RTC Models or a special “Custom - No RTC Model” setting (which essentially is CL1 - Comp/Lead 1 without 
any GE RTP or RT Controls assigned to it). The specified RTC Model Type is applied to the GE in Module 1.

    Only the first Module’s GE is set to the selected RTC Model type; the other Modules are set to GE 0000. You can 
initialize other Modules and their GEs to different types of GEs by applying the Initialize Current GE command from the GE 
Editor’s Menu Button. <GEUtils/Init>

Based on which RTC Model is selected, certain Module-level parameters (outside of the GE) will be reset and adjusted 
within the Performance’s Module settings. First, the entire Module will be initialized, resetting everything except Key 
Zone and Thru settings on the Zones Page. Then, for some (but not all) of the RTC Model Types, further adjustments are 
made as follows:

LF1-Dual LFOs 1
Quantize Triggers = Off
MIDI Filter (Transmit) Notes = Off
Env 1 Latch Mode = Rel2
Env 2 Latch Mode = Rel2

EG1- Dual Env Gen 1
Quantize Triggers = Off
MIDI Filter (Transmit) Notes = Off
Env 1 Latch Mode = Sus1
Env 2 Latch Mode = Sus1

MB1-Melodic Rpt/Bend 1
MR1-Melodic Repeat 1
RB1-Real-time Bend 1
Quantize Triggers = Off
If a Program, or a Combi and Module 1, LATCH button = OFF
<1992><1993>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any action. The affected Performances are not changed. 
The OK Button (green checkmark) closes the dialog and performs the initialization.

<Renumber><2310>
Performance Dialogs - Renumber Yamaha IDs
 

The Renumber Yamaha IDs Dialog allows you to renumber all Performances in the bank to call up a specific Mode of the 
Motif/MOX, and the sequential location in the bank. It is available from a Performance Bank Display’s Menu Button. This 
sets the Mode, Bank and Number parameters in the Performance Editor > Other Page for each Performance in the bank. 
This can be useful if you have pasted Performances from other locations into the bank and wish to renumber them to call 
up the correct associated song, voice etc. in the Motif/MOX. 
<KexEd/Parms><2312>
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    [Mode] (popup menu) [0...4]
Specifies which mode of the Motif/MOX to set the Performances to. Each Performance can call up a different mode on the 
Motif/MOX.
<2311>
    [Bank] (popup menu) [varies depending on Mode]

Specifies which one of the Motif/MOX Banks to set the Performances to. Only available for Performance or Voice mode.
<2313><2314>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any action. The OK Button (green checkmark) closes the 
dialog, sets the parameters as specified in each Performance in the bank, and renumbers their Song or Program IDs 
sequentially.

<Mco>
Performance Dialogs - Copy From Performance
 

The Copy From Performance Dialog allows you to copy various settings from another Performance in the same KDF File to 
the currently loaded Performance. It can be opened by any of the following methods:

- the “Copy From Performance...” item in the Performance Editor’s Menu Button, and many of the Menu Buttons in the 
other pages of the Performance Editor;
- the “Copy From Performance...” item in the main application Utilities Menu: Copy/Swap sub-menu.

Menu Button
A popup menu allowing instant access to this help chapter.

Source Performance
Selects the Performance in the current KDF File from which you want to copy some data.
<0930>
    [Bank] (popup menu) [0...number of banks in KDF file-1]

Selects a bank of Performances in the current KDF file from which to copy.
<0931>
    [Performance] (popup menu) [0...127]

Selects a Source Performance within the selected bank of the current KDF File, from which data will be copied into the 
currently loaded Performance.

Performance Data
Selects various types of Performance data that can be copied from the Source Performance. The following types of data 
can be copied:
<0932>

    [Copy Performance RTParms] (checkbox) [Off, On]

When checked, the Source Performance’s Real-Time Parm assignments on the (P) sub-page of the PE Editor > Real-Time 
Parms Page will be copied into the currently loaded Performance.
<0933>
    [Copy Dynamic MIDI Setup] (checkbox) [Off, On]

When checked, the Source Performance’s Dynamic MIDI Setup will be copied into the currently loaded Performance.
<0934>
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   [Copy Scene Settings] (checkbox) [Off, On]

When checked, the Source Performance’s Scene settings (in the Real-Time Controls Editor) will be copied into the 
currently loaded Performance.
<0935>
    [Copy RT Control Names] (checkbox) [Off, On]

When checked, the Source Performance’s RTC Name Assignments (in the Real-Time Controls Editor) will be copied into the 
currently loaded Performance.
<0936>

    [Copy Chord Triggers] (checkbox) [Off, On]

When checked, the Source Performance’s Chord Trigger settings (in the Real-Time Controls Editor) will be copied into the 
currently loaded Performance.

Module Data
The Module settings for a particular Module can be copied with or without any of the preceding Performance data.

    Module Data includes settings such as the Trigger Page, Key Zones Page, Control Page, MIDI Filter Page, etc.
<0937>

         [Copy Module(s)] (checkbox) [Off, On]

When checked, the selected Module Data in the Source Performance will be copied into the currently loaded Performance, 
as specified below.
<0941>
    [Source Module] (popup menu) [varies depending on Performance Type]

Selects a Module in the Source Performance to copy into the Destination Module below. 

    Not available if there is only a single Module in the Source Performance. If the Source Performance and the currently 
loaded Performance have the same number of active Modules (based on the Performance Type parameter), both popup 
menus will also contain the choice “All,” which copies all Modules from the source to the currently loaded Performance. 
Otherwise, will contain the number of Modules in the Source Performance.
<0942>
    [Destination Module] (popup menu) [varies depending on Performance Type]

Selects a Module or Modules in the currently loaded Performance into which the selected Source Module(s) will be copied.

    Not available if there is only a single Module in the currently loaded Performance. If the Source Performance and the 
currently loaded Performance have the same number of active Modules (based on the Performance Type parameter), both 
popup menus will also contain the choice “All,” which copies all Modules from the source to the currently loaded 
Performance. Otherwise, will contain the number of Modules in the Destination Performance.
<0938>

    [Execute] (button)

Copies the selected data from the Source Performance into the currently loaded Performance, but does not close the 
window, in case you wish to perform other copy operations.
<0939><0940>

     [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without copying anything. The currently loaded Performance is not changed. 
The OK Button (green checkmark) closes the dialog and performs the selected copy operations.

Menu Button
A popup menu allowing instant access to this help chapter and any utilities associated with this dialog.

<ModSwap><1459>
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Performance Dialogs - Copy/Swap Module In Current Performance
 

The Copy/Swap Module In Current Performance Dialog allows you to copy one module to another, or to swap the position 
of two modules - for example, say you wrote a Performance with the Drums in Module 2 and the Bass in Module 1, and 
you wanted them the other way around, with the Drums in Module 1. This utility function intelligently swaps (or copies) 
all settings related to the Module, including RT Control Assignments, Dynamic MIDI etc.

Menu Button
A popup menu allowing instant access to this help chapter.
<1457>
    [Source] (popup menu) [Module 1...6]

Specifies the Source Module for the copy or swap operation.
<1460>

    [Copy/Swap] (button) [Copy, Swap]

Selects one of two different operations for the Source and Destination: “Swap” <-> (double-headed arrow) swaps the 
Source and Destination, while “Copy” --> (single-headed arrow) copies the Source to the Destination.
<1458>
    [Destination] (popup menu) [Module 1...6]

Specifies the Destination Module for the copy or swap operation.
<1461>

    [Execute] (button)

Performs the copy or swap operation without closing the dialog, so that you can perform additional operations.
<1462><1463>

         [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any operations. The OK Button (green checkmark) closes 
the dialog and performs the copy or swap operation.

<ModNames><2222><2223><2229><2230><2233><2234><2235><2236>
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Performance Dialogs - Module Name Select
 

The Module Name Select Dialog allows you to give each Module and Keyboard Layer a descriptive name, selected from a 
list of predefined names. It is opened by clicking on the small round triangle buttons next to the name labels in the 
Performance Editor > GE Setup/Mix Page.
<2221><2228>
    [Name Selection List] (scrolling list) [0...number of names]

Allows you to select one of many predetermined names to describe the selected Module or Keyboard Layer. You may use 
the computer keyboard’s up/down arrow keys to navigate the list, or scroll with the scroll bar or mouse wheel. You can 
also type the first few letters of a name to jump to it. Click on a row to select, double-click to select and close the dialog. 
The current selection is highlighted in blue.
<2219><2220><2226><2227>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without saving any edits you may have made. The OK Button (green checkmark) 
close the dialog and accepts your selection.

<Xpn>
Performance Dialogs - Export Performance Names
 

The Export Performance Names Dialog allows you to export the names and various parameters of all the Performances in 
the current KDF File to a text file. It can be opened from the main application Utilities Menu > Export Names/Lists 
sub-menu.

The file itself is saved in Microsoft Excel Text format, but can be opened in any text application.
<1061>
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    [Add Internal Parameter Info] (checkbox) [Off, On]

When on, the settings of various internal Performance parameters are added to the list.
<1055>

    [Add Category, Programmer] (checkbox) [Off, On]

When on, the Programmer Name and Category of each Performance are added to the list.
<1056>

    [Export with RT Control Names] (checkbox) [Off, On]

When on, the names of all eight RT Control assignments (from the Real-Time Controls Editor) are listed with each 
Performance.
<1057>

    [Show GE(s) used in Performance] (checkbox) [Off, On]

When on, the names of all GEs used by each Performance are added to the list, and the following option is also made 
available:
<1060>

    [Add GE Category, Programmer] (checkbox) [Off, On]

When on, the Programmer Name and Category of each GE are added to the list of GEs used in each Performance. Not 
available unless “Show GE(s) used in Performance” above is checked.
<1058><1059>

         [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without completing the export. The OK Button (green checkmark) closes the 
dialog and opens the Standard File Save Dialog, where you can name and choose a location for the exported file.

    If none of the options are checked and you continue with the Export, only a list of Performance Names and Locations 
will be exported, without any additional information.

<VoiceWarn>
Performance Dialogs - Voice Mode Warning
 

All of the Factory Performances at this time use the Motif/MOX’s Song Mode. However, it is possible to have a KARMA 
Performance switch to any mode in the Motif/MOX such as Performance Mode, Voice Mode, etc. using the Mode setting in 
the Performance Editor > Other Page.
<KexEd>

The default settings for KARMA Motif recommend the Motif/MOX to be set to Local Control on, which works just fine with 
the Song Mode. However, when setting the Mode setting to call up the Voice Mode, you will see this dialog reminding you 
that when using it with Voice Mode, you should set Local Control to off - otherwise, you will hear the keyboard notes on 
top of the KARMA phrase whether you want to or not.

    When using with Voice Mode, if you do want to hear the keyboard notes on top of the phrase, you should still set Local 
Control off in the Motif/MOX and use the Thru Parameters in the Performance Editor > Key Zones Page.
<KeyEd/Thru>
    [Do not show again this session] (checkbox)

If you get really annoyed at seeing this during a session, you can turn this checkbox on before closing the dialog. The 
dialog will not appear again for the rest of that session, until the next time you launch KARMA Software.
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GE Dialogs
Sections in this chapter:

Initialize Current/Selected GE<GEUtils/Init>

Copy Phases<GEUtils/Pco>

Copy Envelopes<GEUtils/Eco>

Copy/Swap GE RT Parms<GEUtils/Rcs>

Copy RT Parms From Another GE<GEUtils/Rco>

Export GE Names<GEUtils/Xgn>

Template Edit Warning<GEUtils/TempEdWarn>

Template Overwrite Warning<GEUtils/Overwrite>

This chapter describes in detail some of the dialogs you will encounter when editing and saving GEs, or using various 
GE-related utility functions available from the Menu Buttons in various editors and the application’s main Utilities Menu.
<Init><2351><2355><2356>

GE Dialogs - Initialize Current/Selected GE
 

The Initialize GE Dialog has two variations, as shown above, depending on how you are accessing the feature. It can be 
called from a GE Bank Display Menu Button, with the “Initialize Selected GEs…” or “Initialize This Bank…” commands, in 
which case the dialog on the right is shown. The operation is then applied to one or more selected GE locations in the GE 
Bank Display (or the entire bank), initializing them to a default starting point (shift-click in the Bank Display to select 
more than one).

It can also be called from the GE Editor’s Menu Button with the “Initialize Current GE…” command, in which case the 
dialog on the left is shown, containing an additional option for initializing the current Module’s parameters. The operation 
is then applied to the current Module in the current Performance (in the edit buffer).

In either case, you select an initialized GE from one of the 14 types of GE RTC Models, and a special “Custom - No RTC 
Model” setting (which essentially is CL1 - Comp/Lead 1 without any GE RTP or RT Controls assigned to it).
<2352>
    [GE RTC Model Type] (popup menu) [RTC Models 1...14, Custom]

Selects one of the 14 GE RTC Models or a special “Custom - No RTC Model” setting (which essentially is CL1 - Comp/Lead 
1 without any GE RTP or RT Controls assigned to it).

Based on which RTC Model is selected, certain Module-level parameters (outside of the GE) will be reset and adjusted 
within the Performance’s Module settings. First, the entire Module will be initialized, resetting everything except Key 
Zone and Thru settings on the Key Zones Page. Then, for some (but not all) of the RTC Model Types, further adjustments 
are made as follows:

LF1-Dual LFOs 1
Quantize Triggers = Off
MIDI Filter (Transmit) Notes = Off
Env 1 Latch Mode = Rel2
Env 2 Latch Mode = Rel2

EG1- Dual Env Gen 1
Quantize Triggers = Off
MIDI Filter (Transmit) Notes = Off
Env 1 Latch Mode = Sus1
Env 2 Latch Mode = Sus1

MB1-Melodic Rpt/Bend 1
MR1-Melodic Repeat 1
RB1-Real-time Bend 1
Quantize Triggers = Off

   If a Program, or a Combi and Module 1, LATCH button = OFF
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    [Initialize Module (except Key Zones)] (checkbox) [Off, On]

Will only be shown when doing “Initialize Current GE…” from the GE Editor Menu Button. When checked on, performing the 
initialization will also initialize all of the Module’s settings in the Performance such as Trigger, Control, MIDI Filter etc. - 
with the exception of Key Zone settings, which will remain as they are presently set in the current Performance.
<2353><2354>

           [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any action. The affected GEs are not changed. The OK 
Button (green checkmark) closes the dialog and performs the initialization.

<Pco>
GE Dialogs - Copy Phases
 

The Copy Phases Dialog allows you to copy the Phase Specific Parameters of certain GE Editor Pages from one Phase to 
the other. It can be opened by the “Copy Phases...” command in the GE Editor > Phase Page’s Menu Button, and the Menu 
Buttons in the other pages having Phase Specific Parameters (Rhythm, Duration, Index etc.).

Exactly what is copied is determined by the Phase Specific Parameters of each page. To copy the GE’s entire Phase to the 
other Phase, simply select all buttons (you can drag down the column).

Menu Button
A popup menu allowing instant access to this help chapter.
<0914>
    [Phase Copy Direction] (popup menu) [Off, On]

Phase 1 --> Phase 2
Phase 2 --> Phase 1
Selects the source and destination Phases for the copy operation.
<0915><0925>
    [Phase] (button) [Off, On]

Specifies that Phase Specific Parameters from the Phase Page will be copied.
<0916>
    [Rhythm] (button) [Off, On]

Specifies that Phase Specific Parameters from the Rhythm Page will be copied.
<0917>
    [Duration] (button) [Off, On]

Specifies that Phase Specific Parameters from the Duration Page will be copied.
<0918>
    [Index] (button) [Off, On]

Specifies that Phase Specific Parameters from the Index Page will be copied.
<0919>
    [Cluster] (button) [Off, On]

Specifies that Phase Specific Parameters from the Cluster Page will be copied.
<0920>
    [Velocity] (button) [Off, On]

Specifies that Phase Specific Parameters from the Velocity Page will be copied.
<0921>

Page 343



        [CCs] (button) [Off, On]

Specifies that Phase Specific Parameters from the CCs Page will be copied.
<0926>
    [WaveSeq] (button) [Off, On]

Specifies that Phase Specific Parameters from the WaveSeq Page will be copied.
<0922>

    [Execute] (button)

The Execute Button (three green arrows) performs the specified copy operation without closing the dialog, in case you 
want to perform other operations.
<0923><0924>

     [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing the copy operation. The OK Button (green checkmark) 
closes the dialog and performs the specified copy operation.

<Eco>
GE Dialogs - Copy Envelopes
 

The Copy Envelopes Dialog allows you to copy an entire envelope’s settings from any envelope in the Performance to 
another. It can be opened by the “Copy Envelopes...” command in the GE Editor > Envelope Page’s Menu Button.

You can copy from one envelope to another inside a GE simply by setting the Source and Destination Modules both to the 
current Module containing the GE that you are editing. Alternatively, you can copy an envelope from another GE by loading 
it into a different Module and specifying the Source and Destination Modules appropriately.

Menu Button
A popup menu allowing instant access to this help chapter.
<0910>
    [Source Module] (popup menu) [varies depending on number of Modules in use]

Selects the Module containing the Source GE that you wish to copy an envelope from. The menu will only contain the 
available Modules in the current Performance.
<0904>
    [Destination Module] (popup menu) [varies depending on number of Modules in use]

Selects the Module containing the Destination GE that you wish to copy the envelope to. The menu will only contain the 
available Modules in the current Performance.
<0905>
    [Source Envelope] (popup menu) [0...2: Envelope 1 to 3]

Selects the Envelope in the Source GE that you wish to copy.
<0906>
    [Destination Envelope] (popup menu) [0...2: Envelope 1 to 3]

Selects the Envelope in the Destination GE that you wish to be replaced with the Source Envelope.
<0907>

    [Execute] (button)

The Execute Button (three green arrows) performs the specified copy operation without closing the dialog, in case you 
want to perform other operations.
<0908><0909>
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   [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing the copy operation. The OK Button (green checkmark) 
closes the dialog and performs the specified copy operation.

<Rcs>
GE Dialogs - Copy/Swap GE RT Parms
 

The Copy/Swap GE RT Parms Dialog allows you to copy and swap the locations of the up to 32 GE RTP within a currently 
loaded GE. It can be opened by any of the following methods:

- the “Copy/Swap RT Parms In Current GE..” command in the GE Editor > RT Parms Page’s Menu Button;
- the “Copy/Swap RT Parms In Current Module..” command in the Performance Editor > RT Parms Page’s Menu Button.
<0967>

There are eight rows available to perform eight concurrent copy or swap operations. The example above shows the 
locations of GE RT Parms 22 and 23 being swapped, and 24 and 25 being swapped. You can specify a copy rather than a 
swap by clicking on the Copy/Swap arrows. <0968>

    It is only advisable to copy/swap RT Parms in the slots that are not required for the GE’s RTC Model. Each GE that is 
configured to use a particular RTC Model has a certain number of “required” parameters, that are in a particular order. 
Swapping them around will interfere with GE loading operations. The safe slots are located towards the end of the 32 RTP, 
and are indicated by an asterisk (*) preceding the slot name. Otherwise, you risk compromising the RTC Model concept for 
that GE, and when it is reloaded, it will not automatically hookup the RT Controls properly. 

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this dialog:

 

Reset
Resets all eight rows to default initialized settings.

1…8 to 2…9
9…16 to 10…17
17…24 to 18…25
25…31 to 26…32
Quickly sets up different groups of 8 parameters to be shifted down by one.
<0960>
    [Active] (checkbox) [Off, On]

Activates the selected row so that its specified copy/swap operation will be performed. The Source and destination can 
then be set.
<0961><0963>
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    [Source] (popup menu) [0...31]
    [Destination] (popup menu) [0...31]

Specifies a source and destination GE RT Parm from the 32 available locations. The names of the parameters are 
displayed.
<0962>
   [Copy/Swap] (button) [Copy, Swap]

Selects one of two different operations for the Source and Destination:

Swap <->
Select two different GE RT Parms for the Source and Destination settings, and they will be swapped. If there are any RT 
Control assignments in the Performance RT Parms Page, they will also be swapped so that everything continues to work 
correct ly.

Copy -->
Select two different GE RT Parms for the Source and Destination settings, and the Source will be copied to the Destination. 
If there are any RT Control assignments in the Performance RT Parms Page, they will also be copied.
<0964>

    [Execute] (button)

The Execute Button (three arrows) performs the selected operation without closing the dialog, so that you can perform 
more operations if you desire.
<0965><0966>

     [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without executing the operation. The OK Button (green checkmark) closes the 
dialog and executes the operation.

<Rco>
GE Dialogs - Copy RT Parms From Another GE
 

The Copy RT Parms From Another GE Dialog allows you to selectively copy GE RT Parms from any other GE in the same 
KDF File. It can be opened by the “Copy RT Parms From Another GE…” command in the GE Editor > RT Parms Page’s Menu 
Button.
<0955><0956>

There are 32 rows that allow some or all of the up to 32 RT Parms to be copied at once.

    It is only advisable to copy RT Parms in the slots that are not required for the GE’s RTC Model. Each GE that is 
configured to use a particular RTC Model has a certain number of “required” parameters, that are in a particular order. 
Changing them will interfere with GE loading operations. The safe slots are located towards the end of the 32 RTP, and are 
indicated by an asterisk (*) preceding the slot name. Otherwise, you risk compromising the RTC Model concept for that 
GE, and when it is reloaded, it will not automatically hookup the RT Controls properly. 
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Menu Button
A popup menu allowing instant access to this help chapter and any utilities associated with this dialog:

 

Select All
Select None
Quickly selects all (or none) of the “Select For Copy” checkboxes preceding each row.
<0948>
    [Bank] (popup menu) [number of banks of GEs in current KDF File]

Selects one of the Banks of GEs in the current KDF File.
<0949>
    [GE] (popup menu) [0...127]

Selects a GE in the current KDF File. The names of the 32 GE RT Parms from that GE will be displayed in the 32 rows of 
the dialog.
<0954>
    [RT Parm Name] (label)

Displays the name of the GE RT Parm in each location in the selected GE.
<0953>
    [Select For Copy] (checkbox) [Off, On]

Activates the selected row so that it will be copied when the operation is executed.
<0950>

     [Execute] (button)

The Execute Button (three arrows) performs the selected operation without closing the dialog, so that you can perform 
more operations if you desire.
<0951><0952>

           [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without executing the operation. The OK Button (green checkmark) closes the 
dialog and executes the operation.

<Xgn>
GE Dialogs - Export GE Names
 

The Export GE Names Dialog allows you to export the names and various parameters of all the GEs in the current KDF File 
to disk. It can be opened from the main application Utilities Menu > Export Names/Lists sub-menu.

The file itself is saved in Microsoft Excel Text format, but can be opened in any text application.
<1064>

    [Add GE Internal Parameter Info] (checkbox) [Off, On]

When on, information about some of the parameters in each GE is added to the list.
<1065>

    [Add Category, Programmer] (checkbox) [Off, On]

When on, the Programmer Name and Category of each GE are added to the list.
<1066>

    [Show Performances containing each GE] (checkbox) [Off, On]

 When on, the Performances in the KDF File that use each GE are added to the list.
<1067><1068>

Page 347



   [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without completing the export. The OK Button (green checkmark) closes the 
dialog and opens the Standard File Save Dialog, where you can name and choose a location for the exported file.

    If none of the options are checked and you continue with the Export, only a list of GE Names and Locations will be 
exported, without any additional information.

<TempEdWarn>
GE Dialogs - Template Edit Warning
 

The Template Edit Warning Dialog may be shown if you are editing certain parameters in the GE Editor. While the exact 
wording depends on the parameter involved, a few examples are shown above. It indicates the following situation:

You are editing a particular parameter that is template-based, and a template is loaded. An example of this would be: a GE 
has the Rhythm Pattern “Template + Restore” RT Parm assigned in the GE’s RTP Page and hooked up to Slider 2 in the 
Module Layer (a common setting). The slider has been moved so that one of the Rhythm Templates has been selected 
(loaded into the pattern grid and associated parameters), and hence the [As Stored] setting is not being used. If you then 
edit the grid or any other parameters that are part of the template, you will see this warning dialog. It will only be shown 
the first time you are editing a particular template that has not yet been edited in that GE. If the template is reloaded at 
some point, the next time you try to edit it you will see it again (unless the “Don't Show Again” checkbox has been 
selected).

It is informing you that if you save the edits to the GE (and choose to overwrite the [As Stored] settings when you are 
prompted by the Template Overwrite Warning dialog below), the edits will go into the [As Stored] location, and not the 
template location that you are presently viewing. For example, if Template 20 was selected and edited, after you store 
the GE Template 20 would be reloaded and it would appear that your edits are gone – but they are now in the [As Stored] 
location. If you wanted to call up your stored edited settings, you would need to set the associated RTP or the Real-Time 
Controller that is attached to it (Slider 2 in this example) to the minimum setting to display the [As Stored] configuration.
<GEUtils/Overwrite><TempParmList>

The following GE RT Parameters use templates and can put up this dialog when parts of a template are being edited:
Rhythm:
     Template, Template + Restore <RhyEd/0186>
Duration:
     Template, Template + Restore <DurEd/0208>
Index:
     Template, Template + Restore <NteEd/0227>
Cluster:
     Template, Template + Restore <CluEd/0246>
Velocity:
     Template, Template + Restore <VelEd/0265>
CCs:
     Template, Template + Restore <POffEd/1225>
WaveSeq:
     Template, Template + Restore <WavEd2/2429>
Drum:
     Template Bank ‘x’, Templ Bank ‘x’ + Restore (3 bank variations each) <DrmEd2/0462>
     ~Repeat On/Off Combs <DrmEd2/RptOnOffCombs>
     ~Resync Index Template <DrmEd2/ri>
Phase:
     ~Mutes Template + Restore <PhsEd2/MuteTemp>
<1780>
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    [Don't Show Again] (checkbox)

If you get really annoyed at seeing this during a session, you can turn this checkbox on before closing the dialog. The 
dialog will not appear again for the rest of that session, for any template-based parameters, until the next time you 
launch KARMA Software.
<1778>
    [OK] (button)

The OK Button dismisses the dialog, until the next time you edit a template-based parameter (unless the “Don't Show 
Again” checkbox has been selected).
<1779>
    [Help] (button)

The Help Button dismisses the dialog, and opens the Help File to this section.

<Overwrite>
GE Dialogs - Template Overwrite Warning
 

The Template Overwrite Warning dialog may be shown when you save a GE if various template-based parameters are 
assigned as GE RT Parms, and they have been edited. Because many of the template-based parameters allow the restoring 
of the [As Stored] setting via real-time control, the dialog makes sure that you are aware that you are about to 
overwrite any applicable [As Stored] settings. A list of the RT Parameters that can cause this dialog to appear is shown in 
the description for the Template Edit Warning dialog above.
<GEUtils/TempParmList>

You will only see this dialog if the template and its associated parameters have been edited. In other words, as an 
example, if the Rhythm Pattern Template + Restore is assigned to an RT Slider, and a template is selected by a scene (but 
not edited), storing other edits to the GE at that time will automatically restore the internal [As Stored] settings to the 
Rhythm Template, the loaded template will not be stored into the GE, and you will not see this dialog. However, if you 
have edited the template in any way, you will see the above dialog – and then you can choose to “Save and Overwrite” the 
listed templates, to “Save” (without overwriting them), or “Cancel” while you think about what you want to do.
<1247>

    [Save] (button)

The Save Button closes the dialog and saves the GE without overwriting the listed templates - they are internally 
restored to the [As Stored] settings.
<1249>

    [Save and Overwrite] (button)

The Save and Overwrite Button closes the dialog and saves the GE, replacing the [As Stored] settings of the listed 
templates with the current edits. Note that if a template is selected, however, it will be reloaded and you will need to 
select the [As Stored] setting in order to see your saved edits.
<1248>
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    [Cancel] (button)

The Cancel Button closes the dialog without saving the GE so that you can decide what to do. 
<1250>
    [Help] (button)

The Help Button dismisses the dialog, and opens the Help File to this section.
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Real-Time Controls Dialogs
Sections in this chapter:

RTC Name Select<RtcDlg/Names>

Scene Name Select<RtcDlg/SceneNames>

Copy and Swap Scenes<RtcDlg/CopySwapScenes>

Reorder Scenes<RtcDlg/Reorder>

Swap RTC Settings<RtcDlg/Swap>

Set RTC Values In Scenes<RtcDlg/SetRTC>

Set Mix Values In Scenes<RtcDlg/SetMix>

This chapter describes in detail some of the dialogs you will encounter when using the utility functions available from the 
RTC Editor’s Menu Button. <RtcEd/MenuBut>

<Names><2204><2205><2211><2212><2215><2216><2217><2218>
RT Controls Dialogs - RTC Name Select
 

The RTC Name Select Dialog is opened by clicking on any of the round triangle buttons to the left of any RTC Slider or 
Switch name in the RTC Editor. It allows you to choose one of the available names for the selected slider or switch. The 
up/down arrow keys or the scroll bar to the right side can be used to navigate the list. You can also type the first letter 
or first few letters of a name to jump directly to it.
<2203><2210>
    [Name Selection List] (scrolling list) [0...number of names]

Allows you to select one of many predetermined names to describe the function of the corresponding slider or switch. You 
may use the computer keyboard’s up/down arrow keys to navigate the list, or scroll with the scroll bar or mouse wheel. 
You can also type the first few letters of a name to jump to it. Click on a row to select, double-click to select and close 
the dialog. The current selection is highlighted in blue.
<2201><2202><2208><2209>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without saving any edits you may have made. The OK Button (green checkmark) 
close the dialog and accepts your selection.

<SceneNames><2240><2241><2247><2248><2251><2252><2253><2254>
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RT Controls Dialogs - Scene Name Select
 

The Scene Name Select Dialog is opened by clicking the round triangle button to the left of the Scene popup menu in the RTC 
Editor. It allows you to choose one of the available names for the current scene in the current Module Control Layer. The 
up/down arrow keys or the scroll bar to the right side can be used to navigate the list. You can also type the first letter 
or first few letters of a name to jump directly to it.
<2239><2246>
    [Name Selection List] (scrolling list) [0...number of names]

Allows you to select one of many predetermined names to describe the current scene in the current Module Control Layer. 
You may use the computer keyboard’s up/down arrow keys to navigate the list, or scroll with the scroll bar or mouse 
wheel. You can also type the first few letters of a name to jump to it. Click on a row to select, double-click to select and 
close the dialog. The current selection is highlighted in blue.
<2237><2238><2244><2245>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without saving any edits you may have made. The OK Button (green checkmark) 
close the dialog and accepts your selection.

<CopySwapScenes><1852>
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RT Controls Dialogs - Copy and Swap Scenes
 

The Copy and Swap Scenes Dialogs are opened by selecting “Copy Scenes...” or “Swap Scenes...” from the Menu Button 
in the RTC Editor. When used for Copy operations, it allows you to copy a scene in one or more Control Layers, to one or 
more other scenes. When used for Swap operations, it allows you to swap any 2 scenes, in one or more Control Layers at 
the same time. Note that more sophisticated reordering of scenes can be performed with the Reorder Scenes Dialog.
<RtcDlg/Reorder>

Menu Button
A popup menu allowing instant access to this help chapter.
<1846>
    [Control Layer] (popup menu) [= ALL =, Master, Module 1...6]

Specifies which Control Layers you want to apply the copy or swap operation to. You can choose the Master Layer, any of 
the Module Layers, or all layers at once.
<1847>
    [Source] (popup menu) [Scene 1...32]

Copy:
Specifies the Source Scene that you want to copy into other scene(s).

Swap:
Specifies one of the two scenes that you want to swap the locations of.
<1848>
       [Destination] (popup menu) [Scene 1...32, All Higher, = ALL =, 9 to 32]

Copy:
The destination can be any scene from 1 to 32, with the addition of three special items. “All Higher” copies the specified 
Source Scene to all scenes with a higher location. For example, if the Source is set to Scene 4, using “All Higher” would 
copy to Scenes 5 to 32. “= ALL =” copies the specified Source Scene to all other locations. “9 to 32” copies the Source 
Scene to Scenes 9 to 32.

Swap:
Specifies one of the two scenes that you want to swap the locations of. Note that more sophisticated reordering of scenes 
can be performed with the Reorder Scenes Dialog.
<RtcDlg/Reorder><1849>

    [Execute] (button)

Performs the copy or swap operation without closing the dialog, so that you can perform additional operations.
<1850><1851>

       [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any operations. The OK Button (green checkmark) closes 
the dialog and performs the copy or swap operation.

<Reorder><2255>
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RT Controls Dialogs - Reorder Scenes
 

The Reorder Scenes Dialog can be opened by using the “Reorder Scenes...” command from the Menu Button in the RTC 
Editor. It provides more sophisticated swapping of scenes than the Swap Scenes Dialog above, which only allows you to 
swap two scenes with each other. Here, you can specify a completely new order for the first 8 scenes of the KARMA 
software’s 32 scenes. Scenes 9 to 32 of the software are not affected by this operation.

To reorder scenes, you click on the scene numbers in the “Old” column one at a time in the order you would like them to 
appear, and they appear in the new order in the “New” column. When you have finished all 8 scenes, you may click OK to 
perform the reordering, or click “Start Over” to reset and begin again.

Menu Button
A popup menu allowing instant access to this help chapter.
<2256>
    [Control Layer] (popup menu) [Master, Module 1...6, = ALL =]

Specifies which Control Layer you would like to apply the reordering operation to. When reordering scenes in a finished 
Performance, it is typical to use the “= ALL = ” setting, so that all layers of the scenes are reordered at the same time 
and maintain their relationships, and you are reorganizing what happens when you click on the Master Layer scenes. 
However, it is possible to also reorder scenes in a particular layer.
<2257><2258>

    [Old Scene Location] (button) [1...8]
    [New Scene Location] (label) [1...8]

When you click on scene numbers in the “Old” column, they will be added to the “New” column in the next available 
location. Clcik them one at a time in the new order you would like them to appear, and when you have completed all eight 
buttons, press Execute or OK.
<2259>

    [Start Over] (button)

Resets the “Old” column and clears the “New” column so that you can begin reordering the scenes again.
<2260>

    [Execute] (button)

Performs the reordering operation without closing the dialog, so that you can perform additional operations.
<2261><2262>

     [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any operations. The OK Button (green checkmark) closes 
the dialog and performs the reordering operation.

<Swap><1041>
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RT Controls Dialogs - Swap RTC Settings
 

The Swap RTC Settings Dialog can be opened by using the “Swap RTC Settings...” command from the Menu Button in the 
RTC Editor. It allows you to swap the locations of the assigned controls within the current Module Control Layer of the 
current Performance. In other words, say that you have a whole Performance set up with various settings controlled by 
different slider and switch assignments. Then you decide you’d like to have the function of sliders 1 and 2 switched, in the 
Master or a Module Layer. This utility can do that and renumber all control assignments within the Performance and 
Scenes so that everything still works correctly.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this dialog:

 

Reset
Resets all four rows to default initialized settings.
<1034>
    [Active] (checkbox) [Off, On]

Makes a particular row of the dialog active. The Source and Destination menus can then be set to perform a swap 
operation.
<1035><1037>
         [Source] (popup menu) [Sliders 1...8, Switches 1...8]
    [Destination] (popup menu) [Sliders 1...8, Switches 1...8]

Selects the Source and Destination RT Controls from among the eight sliders and eight switches. The example above 
shows Slider 1 being swapped with Slider 6, and Slider 2 being swapped with Slider7.
<1038>

    [Execute] (button)

The Execute Button (three arrows) performs the selected operation without closing the dialog, so that you can perform 
more operations if you desire.
<1039><1040>

     [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without executing the operation. The OK Button (green checkmark) closes the 
dialog and executes the operation.

<SetRTC>
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RT Controls Dialogs - Set RTC Values In Scenes
 

The Set RTC Values In Scenes Dialog allows you to modify any or all of the 16 Real-Time Parameters assigned to any RT 
Control Layer, in all 32 scenes at the same time. It is opened by the “Set RTC Values In Scenes...” command in the RTC 
Editor’s Menu Button. For example, let’s say you decided you want the Master Layer’s Slider 1 “Rhythm Swing %” at 
50% in all of the scenes in a Performance; however, it is presently at 0%. You could manually edit every single scene, or 
use this utility function. You would enable Slider 1, set the value to 64, and instantly apply the modification to all 32 
scenes.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this dialog:

 

Disable All
Turns off all 16 checkboxes next to the RT Switch and RT Slider Values, disabling them all.

Enable All
Turns on all 16 checkboxes next to the RT Switch and RT Slider Values, enabling them all.
<1635>
    [RT Control Layer] (popup menu) [Master, Module 1...6]
Selects which RT Control Layer the modifications will be applied to. All 32 scenes in the specified RT Control Layer will 
receive the selected modifications.
<1636>

     [RT Switches] (row)
In this row, an on/off switch is provided for individually modifying the settings of the eight RT Switches stored in each 
scene. The checkboxes allow one or more RT Switches to be modified without affecting the others.
<1637>

    [RT Sliders] (row)
In this row, a value field is provided for individually modifying the settings of the eight RT Sliders stored in each scene. 
The checkboxes allow one or more RT Sliders to be modified without affecting the others.
<1638>
    [RT Switch Active] (checkbox) [Off, On]
When on, the selected RT Switch will be modified in all 32 scenes of the specified RT Control Layer. When off, no 
modifications will be made to the settings of the selected RT Switch.
<1639>
    [RT Switch Value] (button) [Off, On]
Sets the on/off value for the RT Switch that will be applied to all 32 scenes in the specified RT Control Layer.
<1640>
    [RT Slider Active] (checkbox) [Off, On]
When on, the selected RT Slider will be modified in all 32 scenes of the specified RT Control Layer. When off, no 
modifications will be made to the settings of the selected RT Slider.
<1641>
    [RT Slider Value] (numerical) [0...127]
Sets the value for the RT Slider that will be applied to all 32 scenes in the specified RT Control Layer.
<1642>

         [Execute] (button)

Applies the selected RTC modifications to all 32 scenes in the specified RT Control Layer, without closing the dialog, so 
that you can perform additional operations.
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<1643><1644>
   [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any modifications. The OK Button (green checkmark) closes 
the dialog and applies the selected RTC modifications to all 32 scenes in the specified RT Control Layer.

<SetMix>
RT Controls Dialogs - Set Mix Values In Scenes
 

The Set Mix Values In Scenes Dialog allows you to modify any or all of the Track Volumes and Track Mutes, in all 32 
scenes at the same time. It is opened by the “Set Mix Values In Scenes...” command in the RTC Editor’s Menu Button. For 
example, let’s say you decided you want to raise the volume of Module 5 in all 32 scenes. You could manually edit every 
single scene, or use this utility function. You would choose the “Adjust Volumes (+/-)” button at the top, enable Track 
Volume 5, set the value to a positive amount, and instantly apply the modification to all 32 scenes.

Menu Button
A popup menu allowing instant access to this help chapter and the following utilities associated with this dialog:

 

Disable All
Turns off all 16 checkboxes next to the Track Volumes and Track Mutes, disabling them all.

Enable All
Turns on all 16 checkboxes next to the Track Volumes and Track Mutes, enabling them all.
<1647>
    [Set Volumes and Mutes] (radio button)
Allows you to set the Track Volumes and Track Mutes of selected Modules and Keyboard Layers to absolute values. For 
example, you could use this mode to set the volume of a specific Module to an absolute value in all scenes, or mute a 
module in all scenes.
<1648>

    [Adjust Volumes (+/-)] (radio button)
Allows you to adjust the Track Volumes of selected Modules and Keyboard Layers up or down by a specified amount. For 
example, you could use this mode to raise the volume of a specific Module a certain amount in all scenes.
<1649><1659>

    [Module/Keyboard Layer Name] (label)
Displays the name of the Module or Keyboard Layer, which can be assigned in the Performance Editor > GE Setup/Mix 
Page.
<1650>

    [Track Volumes] (row)
In this row, a value field is provided for individually modifying the settings of the eight Track Volumes stored in each 
scene. The checkboxes allow one or more Track Volumes to be modified without affecting the others.
<1651>

    [Track Mutes] (row)
In this row, an on/off switch is provided for individually modifying the settings of the eight Track Mutes stored in each 
scene. The checkboxes allow one or more Track Mutes to be modified without affecting the others.
<1652>
    [Volume Active] (checkbox) [Off, On]
When on, the selected Track Volume will be modified in all 32 scenes. When off, no modifications will be made to the 
settings of the selected Track Volume.
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<1653>
    [Volume Value] (numerical) [0...127, -64...+64]
Sets the value for the Track Volume that will be applied to all 32 scenes. When “Set Volumes and Mutes” is selected, this 
is an absolute value. When “Adjust Volumes (+/-)” is selected, this is an amount to increase or decrease.
<1654>
    [Mute Active] (checkbox) [Off, On]
When on, the selected Track Mute will be modified in all 32 scenes. When off, no modifications will be made to the settings 
of the selected Track Mute.
<1655>

     [Mute Switch Value] (button) [Off, On]
Sets the on/off value for the Track Mute that will be applied to all 32 scenes.
<1656>

         [Execute] (button)

Applies the selected Volume and Mute modifications to all 32 scenes, without closing the dialog, so that you can perform 
additional operations.
<1657><1658>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any modifications. The OK Button (green checkmark) closes 
the dialog and applies the selected Volume and Mute modifications to all 32 scenes.
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Chord Trigger Dialogs
Sections in this chapter:

Copy/Swap Chord Triggers<CtgDlg/CopySwap>

Clear Chord Triggers<CtgDlg/Clear>

Copy Chord Triggers From Performance<CtgDlg/CopyPE>

This chapter describes in detail some of the dialogs you will encounter when using the utility functions available from the 
Chord Trigger Editor’s Menu Button. <CtgEd/MenuBut>

<CopySwap><2397>
Chord Trigger Dialogs - Copy/Swap Chord Triggers
 

The Copy/Swap Chord Triggers Dialog allows you to copy or swap Chord Trigger settings within the current Performance.
<2398>
    [Source] (popup menu) [Chord Trigger 1...16]

Selects the Chord Trigger to act as the source.
<2400>

    [Copy/Swap] (button)

Specifies whether the source will be copied to the destination (right arrow), or swapped with the destination (double 
arrow).
<2399>
    [Destination] (popup menu) [Chord Trigger 1...16]

Selects the Chord Trigger to act as the destination.
<2401>

    [Execute] (button)

Performs the copy or swap operation without closing the dialog, in case you want to perform other operations.
<2402><2403>

       [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any operations. The OK Button (green checkmark) closes 
the dialog and performs the copy or swap operation.

<Clear><2407>
Chord Trigger Dialogs - Clear Chord Triggers
 

The Clear Chord Triggers Dialog allows you to clear the settings of one or more Chord Triggers in the current 
Performance, which unassigns all notes and initializes all settings to off.
<2408>
    [Chord Triggers] (popup menu) [Chord Trigger 1...16, Groups of 4, Groups of 8, All]

Selects the Chord Trigger or group of Chord Triggers to clear.
<2409>
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    [Clear Notes Only] (checkbox) [Off, On]

When this option is on, only the Note settings will be cleared; all other settings will remain as they are.
<2410>

    [Execute] (button)

Clears the specified Chord Triggers without closing the dialog, in case you want to perform other operations.
<2411><2412>

       [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any operations. The OK Button (green checkmark) closes 
the dialog and clears the selected Chord Triggers.

<CopyPE><2386>
Chord Trigger Dialogs - Copy Chord Triggers From Performance
 

The Copy Chord Triggers From Performance Dialog allows you to copy the settings of one or more Chord Triggers from 
another Performance to the current Performance.
<2387>
    [Bank] (popup menu) [Performance Banks in current KDF]   

Selects the Performance Bank containing the source Performance.
<2388>

    [Performance] (popup menu) [1...128]

Selects the source Performance.
<2389>
    [Source] (popup menu) [Chord Trigger 1...16, Groups of 4, Groups of 8, All]

Selects the Chord Trigger or group of Chord Triggers in the source Performance from which to copy the settings.
<2390>
    [Destination] (popup menu) [Chord Trigger 1...16, Groups of 4, Groups of 8, All]

Selects the Chord Trigger or group of Chord Triggers within the current Performance to which the settings will be copied.
<2391>

    [Execute] (button)

Performs the copy operation without closing the dialog, in case you want to perform other operations.
<2392><2393>

       [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any operations. The OK Button (green checkmark) closes 
the dialog and performs the copy operation.

Page 360



Other Dialogs
Sections in this chapter:

Send SysEx Message<OthDlg/SSX>

Send CC Message<OthDlg/SCC>

Find By Name<OthDlg/FBN>

Rename Bank/General Rename<OthDlg/Brn>

Rename Selected Performance/GE<OthDlg/Bdr>

Specify Value<OthDlg/SpecVal>

Single-Bank Save<OthDlg/Sbs>

Multi-Bank Save<OthDlg/Mbs>

RT Parm Warning<OthDlg/RTPWarn>

Save All Edits Warning<OthDlg/SaveAllWarn>

This chapter describes in detail some of the dialogs you will encounter when using the utilities available from the Menu 
Buttons in various windows, and from the application’s Utilities Menu. A few other types of dialogs that are not utilities 
are also discussed here.

<SSX><1241>
Other Dialogs - Send Sysex Message
 

The Send Sysex Message Dialog allows you to send any System Exclusive message to any device you select with the Port 
menu. It can be opened from the application’s Utilities Menu. You can use this for testing various SysEx messages when 
programming fader boxes and controllers to work with your keyboard, or other development activities.
<1240>

     [Message] (text field)

Enter a SysEx message here, in the format “FO xx xx xx xx ... F7,” with each byte consisting of two hexadecimal 
characters, and each byte separated by a space. For example, the message shown in the image above (the default message 
when you open the dialog) changes the Motif/MOX to Master Mode (Motif XS shown).
<1242>
    [Port] (popup menu) [varies depending on the MIDI Ports on your computer]

Selects the MIDI Port that KARMA will use to send the CC message. The choices in this menu will be determined by the 
MIDI Ports on your computer. Enabled ports are determined by the MIDI Port Manager.
<MidPort><1237>
    [Send] (button)

Sends the specified SysEx message without closing the dialog, so that you can send additional messages.
<1238><1239>

       [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any operations. The OK Button (green checkmark) closes 
the dialog and sends the specified SysEx message.

<SCC><2342>
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Other Dialogs - Send CC Message
 

The Send CC Message Dialog allows you to send any Control Change (CC) message to any device you select with the Port 
menu. It can be opened from the application’s Utilities Menu. You can use this for testing various CC messages when 
programming fader boxes and controllers to work with your keyboard, or other development activities.
<2343>
    [Port] (popup menu) [varies depending on the MIDI Ports on your computer]

Selects the MIDI Port that KARMA will use to send the CC message. The choices in this menu will be determined by the 
MIDI Ports on your computer. Enabled ports are determined by the MIDI Port Manager.
<MidPort><2344>
    [Channel] (popup menu) [1...16]

Selects the MIDI Channel that KARMA will use to send the CC message on the selected Port.
<2345>

    [CC (Control Change)] (numerical) [0...127]

Specifies the Control Change (CC) number of the message. For example, CC 10 is Volume, and CC 11 is Pan.
<2346>
    [Value] (numerical) [0...127]

Specifies the value of the Control Change (CC) message.
<2347>
    [Send] (button)

Sends the specified Control Change (CC) message without closing the dialog, so that you can send another when finished.
<2348><2349>

     [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without performing any operations. The OK Button (green checkmark) closes 
the dialog and sends the specified Control Change (CC) message.

<FBN>
Other Dialogs - Find By Name
 

The Find By Name Dialog allows you to search for a Performance or GE by name, within the current KDF File. You can 
either try to match the whole name exactly (case sensitive) or a portion of the beginning of the name (case sensitive). It 
can be opened by the following methods:
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- the “Find Performance By Name...” item in the Menu Buttons of the Performance Editor and Performance Bank Displays;
- the “Find GE By Name...” item in the Menu Buttons in the GE Editor and GE Bank Displays;
- the “Find By Name...” item in the main application Utilities Menu;
- the key shortcut Cmnd+F (Mac) or Ctrl+F (Win). 
<1046>

    [Performance] (button)

Specifies that the search will be performed in Performance Banks.
<1047>

    [GE (GenEffect)] (button)

Specifies that the search will be performed in GE Banks.
<1048>

    [Name Entry Field] (edit text field)

Enter the whole name, or a portion of the first part of the name (case sensitive).
<1049>
    [Match Entire Name] (checkbox) [Off, On]

When on, must match the entire name exactly. Otherwise, will search for the first part of the name.
<1050><1051>

     [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without searching. The OK Button (green checkmark) closes the dialog and 
performs the search. 

When searching for a Performance, if it is located the Performance will be loaded and the Bank Display Editor will open 
showing the bank containing the Performance (with it selected). When searching for a GE, if it is located the Bank Display 
Editor will open showing the bank containing the GE (with it selected), but the GE will not be loaded.

<Brn><1150><1162><1166>
Other Dialogs - Rename Bank/General Rename
 

The Rename Bank Dialog can be used to rename Performance, GE, Template, or Drum Template Banks. It can be opened by 
any of the following methods:

- the “Rename This Bank...” command in the Performance and GE Bank Displays;
- the “Rename Selected Bank...” command in the Main Window’s Menu Button;
- the “Rename Drum Template Bank...” command in the GE Editor > Drum Page.

You will also see the version pictured on the left when editing names in various other parts of the application, such as 
Programmer Names, Note Map Table Names, etc.
<1161>
    [Bank] (popup menu)

Selects the Drum Template Bank that you wish to rename (only available when renaming Drum Template Banks).
<1158><1163>
    [Name] (edit text field)

Allows you to enter a new name for the item.
<1159><1160><1164><1165>

    [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without saving any changes. The OK Button (green checkmark) closes the dialog 
and renames the bank in the current KDF File.

<Bdr>
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Other Dialogs - Rename Selected Performance/GE
 

The Rename Selected Performance/GE Dialog is accessed from an open Performance/GE Bank Display by the following 
methods:

- the “Rename Selected Performance/GE...” item in the Bank Display’s Menu Button;
- holding the option(Mac) or alt(Win) key while clicking a Performance or GE in a Bank Display;
- holding the option(Mac) or alt(Win) key while using an arrow key in a Bank Display.

It allows you to rename a Performance or GE without using the “Save” buttons in the GE or Performance Editors to 
overwrite it, and also allows editing of the GE/Performance Category/Subcategory, the Programmer Name and colored 
Label.
<1152>
    [Name] (edit text field)

Allows you to enter a new name for the Performance or GE.
<1151>

    [Programmer Name] (edit text field)

Allows you to edit the Programmer Name if desired.
<1155>
    [Category] (popup menu) 

Selects a category name from the list of available categories.
<1156>
    [Subcategory] (popup menu) 

Selects a subcategory name from the list of available subcategories (when renaming a GE only).
<1157>
    [Label] (popup menu)

Allows you to affix a colored label to the object, for organizational purposes, such that it is displayed in the various 
menus where you can view and select it.
<1153><1154>

     [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without saving any edits. The OK Button (green checkmark) closes the dialog 
and saves your changes into the GE or Performance.

<SpecVal><1170>
Other Dialogs - Specify Value
 

The generic Specify Value Dialog appears when various Utility functions are used that require asking the user for a value. 
The title label will vary depending on which function is opening the dialog. An example would be the “Transpose Note Map 
By…” command from the Note Maps Editor Menu Button, shown above.
<1167>
    [Value] (edit text field)

Allows you to enter a value for the setting. Only positive or negative numbers are allowed.
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<1168><1169>
   [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without applying the settings. The OK Button (green checkmark) closes the 
dialog and applies the settings.

<Sbs><1235>
Other Dialogs - Single-Bank Save
 

The Single-Bank Save Dialog is presented whenever you save an item that does not have banks. The title changes to show 
the type of object being saved. This dialog will be presented when you:

- click the “Save” Button in the GE Editor > Rhythm Page, Duration Page, Index Page, Cluster Page, Velocity Page, 
WaveSeq or CCs Page to save a Template. (Templates do have banks, but you are always saving within whatever bank of 
Templates the current GE is set to use - so there is no bank to choose from within the dialog.)
<1233>
    [Location] (popup menu) [number of items in bank]

Selects the location that you want to save the data in.
<1234>

    [Name Entry Field] (edit text field)

Allows you to enter the name for the item you wish to save. The number of characters is limited according to the 
maximum length for the item.
<1230><1231>

         [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without saving the item. The OK Button (green checkmark) closes the dialog and 
saves the item at the specified location.

<Mbs><0016>
Other Dialogs - Multi-Bank Save
 

The Multi-Bank Save Dialog is presented whenever you save an item that has multiple Banks. The title changes to show the 
type of object being saved. This dialog will be presented when you:

- click the “Save” Button in the GE Editor, to save a GE;
- click the “Save” Button in the Performance Editor, to save a Performance;
- click the “Save” Button in the GE Editor Drum Page, to save a Drum Template.
<0013>
    [Bank] (popup menu) [number of banks of specified type]

Selects the Bank that you want to save the data in.
<0014>
    [Location] (popup menu) [number of items in bank]

Selects the location that you want to save the data in.
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<0015>
   [Name Entry Field] (edit text field)

Allows you to enter the name for the item you wish to save. The number of characters is limited according to the 
maximum length for the item.
<0017>
    [Label] (popup menu)

Allows you to affix a colored label to the object, for organizational purposes, such that it is displayed in the various 
menus where you can view and select it.
<0010><0011>

     [OK/Cancel] (buttons)

The Cancel Button (red X) closes the dialog without saving the item. The OK Button (green checkmark) closes the dialog and 
saves the item at the specified location.

<RTPWarn>
Other Dialogs - RT Parm Warning
 

The RT Parm Warning Dialog is presented when you click on a grayed-out (disabled) parameter that is assigned as an RT 
Parm, in either the GE Editor or the Performance Editor. This is a warning that since the parameter is assigned, directly 
editing it in its original place may cause unwanted or confusing behavior. Technically, if it is not assigned to a RT Control 
in the Performance Editor > RT Parms Page, it’s OK to edit it in place, and you can bypass the restriction by holding down 
the [cmnd] key (Mac) or [ctrl] key (Win). However, if it is assigned to an RT Control, editing it will only be a temporary 
edit and the parameter’s value will no longer coincide with the physical position of the assigned slider or switch. The next 
time you move the assigned RT Control, or change scenes, your edit will be lost. Therefore, you are better off going to 
the RT Parms Page and editing it there, which is why there’s a button in the dialog to take you there.
<1146>

     [Don’t show again] (button)

If you get really annoyed at seeing this during a session, you can click this button. The dialog will close and will not appear 
again for the rest of that session, until the next time you launch KARMA Software. However, you will still get a beep 
when you click on the disabled parameters and will need to use the [cmnd] key (Mac) or [ctrl] key (Win).
<1147>
    [Go to RT Parms Page] (button)

Clicking this closes the dialog and takes you to the correct sub-page of the Performance Editor > RT Parms Page, where 
you can edit the parameter in place or check if it is assigned to an RT Control before doing so.
<1148>

    [OK]

The OK Button (green checkmark) closes the dialog.

<SaveAllWarn><2466>
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Other Dialogs - Save All Edits Warning
 

When the “Save All Edits (Perf/GE/KDF)” command is used from the application’s File Menu, or the Save All Button in the 
Main Window’s Toolbar, you are telling KARMA to:

    (1) save any edited GEs to the same locations;
    (2) save the current Performance to the same location;
    (3) save the KDF under the same name and location.

This warning dialog appears if a GE has been edited in one or more Modules, indicating that by continuing you are about to 
overwrite them, which might affect other Performances using the same GE. Therefore, you are given a chance to review 
what you want to do and possibly cancel the operation.
<2470>
    [Do not show again this session] (checkbox)

If you get really annoyed at seeing this during a session, you can turn this checkbox on before closing the dialog. The 
dialog will not appear again for the rest of that session, until the next time you launch KARMA Software.
<2467>

    [Save All Except GEs] (button)

Closes the dialog and saves the edits to the Performance and KDF, but does not overwrite the indicated GEs - they will 
still be in their edited states so you can decide what to do with them.
<2468><2469>

         [OK/Cancel] (buttons)

The Cancel Button closes the dialog without saving any edits to the GEs, Performance, or KDF. The OK Button closes the 
dialog and saves the edits to the GEs, saves the edits to the current Performance, and finally saves the current KDF.

    Care should be exercised in using this option, since saving edits to GEs that you might not know you made could affect 
the operation of other Performances that use the same GE.
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Menu Reference (Part 1)
Sections in this chapter:

Application Menu (Mac OS X)<MenuRef/App>

File Menu<MenuRef/File>

Edit Menu<MenuRef/Edit>

Window Menu<MenuRef/Windows>

Options Menu<MenuRef/Options>

See also the next chapter for the following menus:

Part 2:<MenuRef2>

Utilities, Help

    Many of these commands operate on the current KDF File. If more than one KDF is open, the names of the files will 
appear at the bottom of the Window Menu and the Main Window’s Menu Button. The current KDF will have a checkmark 
next to it. You can make a different KDF file current by selecting it from either of those menus.

<App>
Menu Reference - Application Menu (Mac OS X)
 

The Application menu (Mac OS X only) contains the following items related to KARMA Motif:

    About KARMA Motif…

Opens the about box containing info on version, copyrights, trademarks, credits, and other information.
For Windows, this command is found on the Help Menu.

    Preferences…              Cmnd+, (Mac)

Opens the Preferences Editor, where global settings for the application are made. See Preferences.
For Windows, this command is found on the Edit Menu.
<Prefs>
    Quit (Mac)                   Cmnd+Q (Mac)

Quits the application. For Windows, the Exit command is found on the File Menu.

<File>
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Menu Reference - File Menu
 

The File Menu contains commands for managing the data files that KARMA works with, such as opening, closing, importing 
and exporting various file formats. It also contains commands for closing windows and exiting the application (Windows 
OS). Most of these commands can also be operated by buttons in the Main Window’s Toolbar.
<SWGUI/Toolbar><NewKDF>
    New KDF…                Cmnd+N (Mac)     Ctrl+N (Win)

Allows you to create a new KDF file containing a single Performance bank - you are given the option to add the factory GE 
and Template banks if desired (recommended) - otherwise, a single GE bank and a single Templates bank will be created. 
The file will also have the default set of RT Control Names, Module Names, Scene Names, and Note Map Tables.

    Open…                     Cmnd+O (Mac)     Ctrl+O (Win)

Brings up the standard Open Dialog, allowing you to locate and select a KDF file (KARMA Data File). The file will load and 
become the current KDF. You may have a maximum of 16 KDF files open simultaneously, depending on available memory. If 
more than one KDF is open, the names of the files will appear at the bottom of the Window Menu and the Main Window’s 
Menu Button. 

    Save                       Cmnd+S (Mac)     Ctrl+S (Win)

Saves any changes to the current KDF file. If no changes have been made, the Save item will be grayed out.

  Save Current Performance…

Brings up the Multi-Bank Save Dialog, allowing you to store the current Performance in the same location, or a different 
location. If no changes have been made to the current Performance, the item will be grayed out. This is the same as 
clicking on the Save Button at the top of the Performance Editor, or the Save Performance Button in the Main Window’s 
Toolbar.
<OthDlg/Mbs>

  Save All Edits (Perf/GE/KDF)

Similar to Save, in that it saves any changes to the current KDF file. In addition, it also saves any changes to the current 
Performance, including any edits to any GEs within it. In other words, it is equivalent to performing the following 
operations in this order:

    (1) save any edited GEs to the same locations;
    (2) save the current Performance to the same location;
    (3) save the KDF under the same name and location. 

    Care should be exercised in using this option, since saving edits to GEs that you might not know you made could affect 
the operation of other Performances that use the same GE. Therefore, if any GEs are edited, you will be given an option to 
cancel with the Save All Edits Warning Dialog, so that you can decide if you really want to overwrite the GEs.
<OthDlg/SaveAllWarn>
   Save As…

Brings up the standard Save Dialog, allowing you to save the current KDF File in a different location or with a different 
name.

   
Page 370



    Close                            Cmnd+W (Mac)     Ctrl+W (Win)

Closes the topmost window.

   Exit (Windows Only)                                     Ctrl+Q (Win)

Quits (exits) the application. For Mac OS X, this item is found on the Application Menu.

<Edit>
Menu Reference - Edit Menu
 

The Edit Menu contains commands for editing text data, for copying, pasting and clearing KDF Banks, GEs, Performances 
and Note Maps, for comparing an edited Performance to a previous version, and for editing the global Preferences (usually 
known as Properties, for Windows users). It also provides an alternate method of changing the Current Edit Module or 
Current Control Layer.

Several of the items above are hierarchical menus (sub-menus) containing additional selections. First we will discuss the 
non-hierarchical items and then each of the sub-menus.

    Cut                                   Cmnd+X (Mac)                               Ctrl+X (Win)
    Copy                            Cmnd+C (Mac)     Ctrl+C (Win)
    Paste                           Cmnd+V (Mac)                                       Ctrl+V (Win)
    Clear                                    Cmnd+B (Mac)                                   Ctrl+B (Win)
    Select All                     Cmnd+A (Mac)                                       Ctrl+A (Win)

The above standard editing commands will only be available when there is something in the application’s window to which 
they can apply. They operate in a standard fashion that most computer users should be familiar with. Most of the time 
they will apply to the bank rows in the KDF Area of the Main Window. However, depending on which editor or page is 
frontmost, the focus of these commands changes, and the titles themselves in the menu change to reflect the focus. In 
other words, the example above shows the menu when a GE Bank Display is in front. The commands all refer to GEs, such 
as “Cut GEs,” “Copy GEs,” etc. If a Performance Bank Display was in front, the commands would say “Cut 
Performances,” “Copy Performances,” and so on.

    When copying and pasting GEs and Performances, you cannot Paste into more destinations than items that were copied. 
In other words, if you copy three GEs, and then select six GEs and execute the Paste command, it will only paste the three 
GEs into the first three locations.
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  Import Xpansion Pack…

Xpansion Packs are available separately from Karma-Lab, providing additional KARMA Performances and KARMA GEs to 
expand your library and creativity. This command allows you to combine the new Performances and GEs in the Xpansion 
Pack with your current KDF file. For example, you may wish to combine them with your copy of the Factory KARMA 
Performances, just to have everything in one KDF file. It brings up the standard Open Dialog, where you are prompted to 
locate a Karma-Lab Xpansion Pack KDF file - the contents will then be merged with your current KDF file. More details can 
be found in the Installation Guide included with each Xpansion Pack.  



  Paste Special…

This command is only available in two cases:

1. When you have copied GE data from a GE Bank Display Window, and you are going to paste it into another GE Bank 
Display Window. In this case, using this command presents a dialog allowing you to renumber any GE references inside 
Performances that are using that GE. In other words, you can use this to move a GE from one location to another, while 
updating any Performances that may be referencing it.

2. When you have copied Performance data from a Performance Bank Display Window, and you are going to paste it into 
another Performance Bank Display Window. In this case, using this command allows you to paste only the Module Names, 
Programmer Names, and Performance Names of the copied Performances to the new locations. You can use this to copy 
the Performances to the clipboard prior to receiving a SysEx dump of a Performance Bank using the Replace or Merge 
option, so that you can then paste the information back on top of the newly received Performances and not have the 
Module Names get set to the default.

    Compare                       Cmnd+K (Mac)     Ctrl+K (Win)

Allows you to revert back to the unedited version of the current Performance, to compare it with the edited version. You 
may toggle back and forth, but if you edit it while it is in the unedited state, it will become the new edited version.

    Clear Solo                    + (Mac)                + (Win)

When one or more Modules and/or Keyboard Layers is soloed, this command will clear all of the solos at the same time - 
the same as command-clicking on one of them (Mac) or control-clicking on one of them (Windows).
 

    Preferences (Windows Only)                      Ctrl+, (Win)

Opens the Preferences Editor, where global settings for the application are made. See Preferences.
For Mac OS X, this command is found on the Application Menu.
<Prefs>
 

    Current Edit Module        Option+1~6 (Mac)     Alt+1~6 (Win)

The Current Edit Module sub-menu provides an alternate method of selecting the Current Edit Module. It performs the 
same function as clicking on the Module Edit Buttons in the Main Window’s Status Area. However, this sub-menu also 
allows the computer’s keyboard to be used to change the Current Edit Module. As shown above, the descriptive name 
assigned to the Module is shown, along with a checkmark indicating the Current Edit Module. The number of available 
Modules will be limited to those in use in the current Performance.
<SWGUI/Status>
 

    Current Control Layer      Cmnd+1~6 (Mac)     Ctrl+1~6 (Win)

The Current Control Layer sub-menu provides an alternate method of selecting the current RT Control Layer. It performs 
the same function as clicking on the RT Control Layer Buttons in the Main Window’s Status Area. However, this sub-menu 
also allows the computer’s keyboard to be used to change the RT Control Layer. As shown above, the descriptive name 
assigned to the Module is shown for the Module Layers, and MASTER is shown for the Master Layer, along with a 
checkmark indicating the Current Control Layer. The number of available Layers will be limited to those in use in the 
current Performance.

<SWGUI/Status><Windows>
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Menu Reference - Window Menu
 

The Window Menu contains commands for opening and navigating through the various windows and editors in the 
application, along with a utility function to reset all windows to their factory default locations.

    Reset Windows To Defaults…

A command that will reset all windows to the default Factory Position, the same as when the application was first 
launched. You will be given an opportunity to cancel.

    MIDI Setup (Global) Editor     Cmnd+U (Mac)     Ctrl+U (Win)

Opens the MIDI Setup (Global) Editor, where overall preferences settings related to the MIDI operation of the application 
are made. The Pages sub-menu below (not shown) performs the same operation while allowing you to move to any page 
within it as well.
<MsuEd>
    Performance Editor              Cmnd+P (Mac)     Ctrl+P (Win)

Opens the Performance Editor, where settings for up to six different Modules and two Keyboard Layers to be configured 
as a “Performance.” The Pages sub-menu below (not shown) performs the same operation while allowing you to move to 
any page within it as well.
<PE>

    GE Editor                                                                                       Cmnd+G (Mac)     Ctrl+G (Win)

Opens the GE (Generated Effect) Editor, where you can existing GEs or create new ones. The Pages sub-menu below (not 
shown) performs the same operation while allowing you to move to any page within it as well.
<GE>
    Real-Time Controls (RTC)                          Cmnd+L (Mac)      Ctrl+L (Win)

Opens the Real-Time Controls Editor, and displays the RTC View for the current layer in the bottom section.
<RtcEd>
    Real-Time Controls (Mix)                              Cmnd+; (Mac)      Ctrl+; (Win)

Opens the Real-Time Controls Editor, and displays the Mix View in the bottom section.
<RtcEd>
    Scene Matrix                                                Cmnd+M (Mac)     Ctrl+M (Win)

Opens the Scene Matrix Editor, a much larger version of the Scene Matrix Grid in the Real-Time Controls Editor.
<SmxEd>
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    Chord Triggers                     Cmnd+T (Mac)    Ctrl+T (Win)

Opens the Chord Trigger Editor, which displays the settings for the 16 Chord Triggers stored in the current Performance, 
as well as some editing utilities for them.
<CtgEd>
    Chord Input/Virtual Kbd         Cmnd+I (Mac)     Ctrl+I (Win)

Opens the Chord Input/Virtual Keyboard Editor, which provides you with two different ways to input MIDI data into 
KARMA Motif using just the computer keyboard and the mouse.
<CjmEd>

Opens the Data Display Editor, which displays the MIDI data being generated in a captivating visual display.
<DadEd>
    Bank Display                        Cmnd+- (Mac)     Ctrl+- (Win)

Opens the Bank Display Editor, which can display any bank of data from the KDF Area of the Main Window.
<PBD>
    Note Maps                            Cmnd+J (Mac)                       Ctrl+J (Win)

Opens the Note Maps Editor, where settings are made for the custom Note Map within each Performance, or the Global 
Note Maps.
<NteMap>
    Import To GE                                                                     Cmnd+E (Mac)                           Ctrl+E (Win)

Opens the Import To GE Editor, which allows you to import Standard MIDI File Format phrases as GEs.
<ImpGE>
    Performance Info                  Cmnd+' (Mac)     Ctrl+' (Win)

Opens the Performance Info Window, which displays information about the current performance, including which GEs are 
being used, how many other times those GEs are used in other Performances, and other information. Also available from 
the Menu Buttons in the GE Editor and Performance Editor.
<Pfi>
    Performance Notes                                       Cmnd+\ (Mac)      Ctrl+\ (Win)

Opens a document containing detailed information about the currently selected Performance. You can edit or create your 
own Performance Notes documents; the path to the file is stored in the Performance Editor > Other Page.
<KexEd>
    MIDI Port Manager                Cmnd+= (Mac)                         Ctrl+= (Win)

Opens the MIDI Port Manager, which provides a method for managing which MIDI ports will be opened for use within the 
KARMA software.
<MidPort>

    Communication Status

Opens or brings to the front the Communication Status Window, which shows the current status of communications 
between KARMA and the Motif/MOX.
<CommStat>
    Open KDF Files

The bottom portion of the Window Menu dynamically displays all currently open KDF Files, and allows you to switch 
between them. The Current KDF File is indicated by a checkmark. When a file has been edited, it receives an “edited 
mark” in front of it (a “diamond” shape on the Mac and an “asterisk” on Windows - as shown).

<Options>

    Data Display                                                           Cmnd+D (Mac)             Ctrl+D (Win)
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Menu Reference - Options Menu
 

The Options Menu allows you to conveniently operate several global options. They all toggle between off (unchecked) and 
on (checked), and are stored in the Preferences when you quit the application (except for Bypass).
<Prefs>
    Bypass                          C m n d +0  (Mac)     Ctrl+0  (Win)

Turning Bypass on allows you to completely “disconnect” the KARMA Software from the Motif/MOX, as if it was not 
even launched and you were just working with the keyboard. This can be useful if you don’t want to quit the application, 
but wish to take the software “offline” and just do something on the keyboard.

Bypass does the following things:
- it disables the software’s generation of MIDI data in response to incoming MIDI;
- toggles the Local Control On/Off setting (in the keyboard’s Global > MIDI Page) or other Thru options depending on 
settings in the software’s Preferences Editor.

When activated, you will see a [BYPASS] label in the Main Window’s Status Area, to alert you to the fact that it is 
presently bypassed, since it’s sometimes easy to forget this.

    This is the same as using the Bypass Button in the Main Window’s Toolbar. <SWGUI/Toolbar>

    Note that when bypassed you can still use the computer’s Function Keys to trigger the chord pads from your computer.

    Keyboard Thru

When Keyboard Thru is on, any MIDI data received on the Global In Port (selected in the MIDI Sedtup (Global) Editor) is 
echoed thru to the Global Out Port on whichever MIDI Channel it is received. *

    * Not if Auto Local Control is on and the option Toggle Local Control is selected.
<MsuGen/Local>

Generally, for KARMA Motif Keyboard Thru should be off (and is the default factory setting), and the Local Control setting 
in the Motif/Mox’s UTILITY page should be on. Since KARMA uses the Song Mode for the Factory Performances, this 
allows you to change parts while a KARMA Performance is playing and use the knobs and controllers to affect the voices 
in the different parts. In other words, you could change to the part containing the bass line, and use the Tone Knobs to 
directly affect the resonance and filter cutoff of that bass voice. While this is also possible with Local Control off and 
Keyboard Thru on, it’s a little more difficult to work with recording KARMA Motif into a sequencer that way.

One exception is if you decide to use a KARMA Performance to call up the Motif/MOX’s Voice Mode using the Mode setting 
in the Performance Editor > Other Page - in this case, you do NOT want to have Local Control on, and you will receive the 
Voice Mode Warning Dialog when you change the Performance to call up Voice Mode. Furthermore, when the Performance 
has been set to Voice Mode, the Keyboard Thru setting is ignored regardless of it being on or off, since you never want to 
echo thru the data in Voice Mode.
<PEUtils/VoiceWarn>

For reference, KARMA Software already has parameters to control whether the keyboard is passed Thru to the Modules 
and Keyboard Layers, stored as art of each Performance These Thru check boxes are located in the Performance Editor > 
Key Zones Page.
<KeyEd>

    Return Stops Melodic Repeat

Melodic Repeat is capable of adding delay-like repeated effects to the notes of a GE. If you are in the habit of using the 
Return Key to “Stop” the KARMA Effects, you may or may not wish the repeated notes to end abruptly at the same time. 
When this is on, the Return Key will abruptly stop all notes, including repeated notes. When this is off, it will stop the 
generated notes from the GE, but any repeated notes will be allowed to die away on their own, much like an analog or 
digital delay.

    This also controls whether the repeated notes will be automatically stopped when the KARMA On/Off switch is used in 
the Real-Time Controls Window. Note that even with this off, you can set up Dynamic MIDI to stop repeated notes when the 
KARMA On/Off switch is turned off - which it generally is in most of the Factory Performances. See Dynamic MIDI 
Destinations.
<DynDst>
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   Loading GE Loads GE Tempo

Each Generated Effect is stored with the tempo that was being used when it was last saved, so that a reference exists for 
the correct tempo to use it at. However, the Performance Tempo overrides the settings of all the GEs being used by that 
Performance. When you load a GE using the popup menus, the GE Tempo will not normally affect the Performance Tempo 
unless the “Loading GE Loads GE Tempo” option in the Options Menu is checked. Therefore, if you are auditioning single 
GEs and want to hear them at the tempo that they were stored with, you should select this option. Then when the GE is 
loaded, it will replace the Performance Tempo with the GE Tempo.

This only applies to GEs that are loaded using the popup menus in the GE Editor or the corresponding GE popup menus in the 
Performance Editor > GE Setup/Mix Page, or by selecting a GE in a GE Bank Display. It does not apply to GEs that are 
automatically loaded when changing Performances, for example.

    The GE Tempo and Performance Tempo settings are “linked,” in that if you adjust the GE Tempo while listening to a GE 
you will also be changing the Performance Tempo.

    Tap Tempo On (Use Space Bar)

When this is on, the Tap Tempo function is activated, and you can use the computer keyboard’s space bar to tap out a 
tempo for the current Performance. The number of taps required to recalculate the tempo can be adjusted in the 
Preferences - General Tab.
<Prefs/General>
For any menus not covered in this chapter, please see:
Menu Reference (Part 2) <MenuRef2>
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Menu Reference (Part 2)
Sections in this chapter:

Utilities Menu<MenuRef2/Utilities>

Help Menu<MenuRef2/Help>

See also the previous/next chapters for the following menus:

Part 1:<MenuRef>

File, Edit, Window, Options

    Many of these commands operate on the current KDF File. If more than one KDF is open, the names of the files will 
appear at the bottom of the Window Menu and the Main Window’s Menu Button. The current KDF will have a checkmark 
next to it. You can make a different KDF file current by selecting it from either of those menus.

<Utilities>
Menu Reference - Utilities Menu
 

In general, the Utilities Menu can be thought of as a place for functions and utility operations that are global in nature, or 
that aren’t specifically associated with an editor or editor page. Many more utility functions are located on the Menu 
Buttons inside each editor and editor page, since they are associated more directly with those pages.

Several of the items above are hierarchical menus (sub-menus) containing additional selections. First we will discuss the 
non-hierarchical items and then each of the sub-menus.

    Find By Name...                     Cmnd+F (Mac)     Ctrl+F (Win)

Opens the Find By Name Dialog allowing you to search for a Performance or GE by name, within the current KDF File. Also 
available from the Menu Buttons in the GE Editor and Performance Editor.
<OthDlg/FBN>
    All Notes Off                                 Cmnd+/ (Mac)     Ctrl+/ (Win)

Should you ever experience stuck notes, you can use this command to send note-off messages everywhere to fix the 
problem. This is also a “general reset” for many of KARMA’s internal variables and states, so if the software ever 
starts acting peculiar, you can try executing this command.

    Stop!                                [ R e t u r n ]

The Return Key stops all notes that are being generated by the KARMA function without actually turning it off. You can 
immediately restart it by playing the keyboard or activating a Chord Trigger Button. This can be more useful than the 
actual KARMA On/Off Button in the Realtime Controls Window.

    Whether or not repeated notes caused by the Melodic Repeat parameters will also stop is controlled separately by the 
“Return Stops Melodic Repeat” option on the Options Menu.

    Send SysEx Message...          Cmnd+` (Mac)                                                  Ctrl+` (Win)

Opens the Send SysEx Message dialog, which allows you to send any System Exclusive message to any external device. 
This can be useful for test purposes when setting up various pedals and external devices to control each other with SysEx 
- you can easily test messages from the KARMA software to make sure they work like you intend.
<OthDlg/SSX>

    Send CC Message...

Opens the Send CC Message dialog, which allows you to send any Control Change (CC) message to an external device. This 
can be useful for test purposes when setting up various pedals and external devices to control each other with CCs - you 
can easily test messages from the KARMA software to make sure they work like you intend.
<OthDlg/SCC>
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The Labels heirarchical sub-menu contains global utilities related to the use of colored labels in the Bank Display Editor. 
Individual labeling settings and utilities can be found in the Bank Display Menu Buttons.

    Count Labeled Items In All Performances

Counts all labeled items in all Performance Banks, and puts up a dialog showing a report. For example, this could be useful 
if you have labeled all rock Performances as yellow, and all jazz Performances as orange, you could see how many of 
each there are. You can count labels in a single bank from the Bank Display Menu Button.

       Count Labeled Items In All GEs

Counts all labeled items in all GE Banks, and puts up a dialog showing a report. For example, this could be useful if you 
have labeled all rock GEs as yellow, and all jazz GEs as orange, you could see how many of each there are. You can count 
labels in a single bank from the Bank Display Menu Button.

    Clear All Labels In All Performances…

Clears all label settings in all Performances in the current KDF File (but not labels in GEs). You will be given an opportunity 
to cancel. You can clear labels in a single bank from the Bank Display Menu Button.

    Clear All Labels In All GEs…

Clears all label settings in all GEs in the current KDF File (but not labels in Performances). You will be given an opportunity 
to cancel. You can clear labels in a single bank from the Bank Display Menu Button.

    Clear All Labels In KDF…

Clears all label settings in all Performances and GEs in the current KDF File. You will be given an opportunity to cancel.

 

The Export Names/Lists hierarchical sub-menu contains operations related to exporting text lists of various parameters 
or names to disk. All files are saved in Text (tab-delimited) format.

    Export GE Names...

Opens the Export GE Names Dialog, which allows you to export the names and various parameters of all the GEs in a KDF 
File to disk.
<GEUtils/Xgn>

    Export Performance Names...

Opens the Export Performance Names Dialog, which allows you to export the names and various parameters of all the 
Performances in a KDF File to disk.
<PEUtils/Xpn>

    Export RT Control Names...

Brings up the Standard File Save Dialog, allowing you to export a list of all the RT Control Names in the current KDF File, 
and the number of times each one is used in that file.

    Export Templates Names...

Brings up the Standard File Save Dialog, allowing you to export a list of all the Template Names in the current KDF File.
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    Export List Of Unused GEs...

Brings up the Standard File Save Dialog, allowing you to export a list of all GEs in the current KDF File that are not used in 
any Performances in that file, along with their categories and programmer names.

    Export List of PEs Using GEs...

Brings up the Standard File Save Dialog, allowing you to export a sequential list of all GEs in the current KDF File, showing 
every Performance that uses that GE, along with category and programmer information.

    Export List Of Drum GE Note Maps...

Brings up the Standard File Save Dialog, allowing you to export a list of all GEs having GE Type = Generated-Drum, with 
the MIDI Note Numbers that each row of each Drum Pattern is set to.

    Export List Of Templates Used...

Brings up the Standard File Save Dialog, allowing you to export a list of all GEs that use Templates, and the various 
Templates and ranges used by each of them.
<Help>
Menu Reference - Help Menu
 

The Help Menu provides access to the Help File and various online pages designed to help you get the most out of KARMA 
Software.

    Show Tooltips

Turns on/off the presence of popup tooltips in the application. When this is on, holding the mouse cursor over various 
labels, parameters and objects in the application will cause short explanations of the items to appear. Tooltips can be 
turned on or off globally for the entire application, in addition to having several groups within the tooltip system that can 
be independently controlled. In the Preferences Dialog, you can control exactly which objects have tooltips and the amount 
of time delay before they pop up, or the use of the ‘t’ key to make them pop up.
<Prefs/Work>

For example, after you get used to working with KARMA, it may be helpful to set the tooltips to only popup over labels 
(and not parameters), and have the longest delay time setting. That way, you may never notice they are there during 
normal speed of working, but if you want a reminder or a hint about some function, you can hold the mouse over a label 
and it will appear. Or, you may wish to use the option where popping up is completely disabled, but you can still press the 
‘t’ key to make a tooltip popup at any time.

    When a tooltip is showing, if you press Cmnd+H (Mac) or Ctrl+H (Win), you will be taken directly to the Help File and 
the parameter associated with the tooltip for more information.
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   KARMA Help

Four items in this section give you immediate acces to the KARMA Software Help File, while the fifth opens the Tutorials 
Folder on your computer containing the tutorials included with the installation.

KARMA Help                          Cmnd+H (Mac)     Ctrl+H (Win)
Opens the Help File (or brings it to the front), and takes you to the Table Of Contents (Index), where you can quickly select 
a Chapter Title for viewing.

    Remember, you can also press Cmnd+H (Mac) or Ctrl+H (Win) at any time when a tooltip is showing, and be taken 
directly to the section of the Help File that contains that object for more information.

Using The Help File
Opens the Help File (or brings it to the front), and takes you to the chapter of the same name for basic info useful to new 
users.

Keyboard Shortcuts
Opens the Help File (or brings it to the front), and takes you to the Keyboard Shorcuts Chapter for a quick reference to 
any key commands you may need.

Menu Reference
Opens the Help File (or brings it to the front), and takes you to the Menu Reference Chapter for in depth explanations of 
every item that appears on any of the application menus.

Tutorials Folder
Opens (or brings to the front) the Tutorials Folder on your computer containing the tutorials included with the installation.

    KARMA Online Support

Assuming you have an Internet connection, the five items in this section of the menu will open your browser (if it is not 
open already) and take you directly to the following locations:

KARMA Online Support
The main support page for Karma-Lab. Link from here to documentation, dowloads, tutorials and more.
(http://karma-lab.com/support)

User Forums
Karma-Lab Forums, our acclaimed user forum area. Ask a question, get an answer, share your knowledge, or enjoy a chat 
about some other topic in one of the non-specific areas.
(ht tp: / /karma-lab.com/forum/mot i f )

Tutorials Online
Takes you to Karma-Lab’s KARMA Motif Documentation page, where you can view and download additional tutorials and 
reference materials that may not have been included in your installation.
(http://karma-lab.com/kmo/docs)

Software Updates
A page devoted to any available updates, and information pertaining to updates and upgrades of KARMA Software.
(http://karma-lab.com/updates)

New Sounds!
Learn about the additional sound collections available from Karma-Lab for your KARMA Software.
(http://karma-lab.com/sounds)

    About KARMA Motif…

(Windows OS) - Opens the about box containing info on copyrights, version, trademarks, credits, and other information. 
For Mac OS X, this item is found on the Application Menu.

For any menus not covered in this chapter, please see:
Menu Reference (Part 1) <MenuRef>
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Keyboard Shortcuts
Sections in this chapter:

In Menus<KbdShort/Menus>

KARMA Functions<KbdShort/FunKeys>

Arrow Keys<KbdShort/ArrowKeys>

In The Help Window<KbdShort/Help>

In Dialogs<KbdShort/Dlog>

With Pattern Grids<KbdShort/PatGrid>

This chapter is a reference to the use of the computer keyboard with the menus and other functions of the KARMA 
application.
<Menus>
Keyboard Shortcuts - In Menus
Only items with keyboard shortcuts are shown in these diagrams. For detailed information on each of these commands, see 
the chapter Menu Reference.
<MenuRef>
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<FunKeys>
Keyboard Shortcuts - KARMA Functions
Various KARMA Functions can be controlled from the computer keyboard using the following shortcuts. [Fn] refers to the 
Function Keys across the top of your computer keyboard:

M a c
[F1] - Chord Trigger Button 1
[F2] - Chord Trigger Button 2
[F3] - Chord Trigger Button 3
[F4] - Chord Trigger Button 4
[F5] - Chord Trigger Button 5
[F6] - Chord Trigger Button 6
[F7] - Chord Trigger Button 7
[F8] - Chord Trigger Button 8
Shift + [F1] - Chord Trigger Button 9
Shift + [F2] - Chord Trigger Button 10
Shift + [F3] - Chord Trigger Button 11
Shift + [F4] - Chord Trigger Button 12
Shift + [F5] - Chord Trigger Button 13
Shift + [F6] - Chord Trigger Button 14
Shift + [F7] - Chord Trigger Button 15
Shift + [F8] - Chord Trigger Button 16

[F9] - KARMA On/Off
[F11] - Latch On/Off
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      When the Preferences - Workspace > Computer Keyboard type is “Standard”: <Prefs/2325>
[F12] - Fill
Shift + [F12] - Module Control Layer (move to next)
 

     When the Preferences - Workspace > Computer Keyboard type is “Extended”: <Prefs/2325>
[F12] - Module Control Layer (move to next)
[F13] - Fill

Cmnd + [F1] - Stutter Fast
Cmnd + [F2] - Stutter Medium
Cmnd + [F3] - Stutter Fast
Cmnd + [F5] - Retrigger
Cmnd + [F7] - A. Switch 1
Cmnd + [F8] - A. Switch 2
Cmnd + [      - Master Transpose Down
Cmnd + ]      - Master Transpose Up
Cmnd + []     - (Both) Master Transpose Reset

Cmnd + 1 - Module 1 Control Layer
Cmnd + 2 - Module 2 Control Layer
Cmnd + 3 - Module 3 Control Layer
Cmnd + 4 - Module 4 Control Layer
Cmnd + 5 - Module 5 Control Layer
Cmnd + 6 - Module 6 Control Layer
Cmnd + 8 - MASTER Control Layer
+ - Clear Solo

Ctrl + 1 - Scene 1 (in current Control Layer)
Ctrl + 2 - Scene 2 (in current Control Layer)
Ctrl + 3 - Scene 3 (in current Control Layer)
Ctrl + 4 - Scene 4 (in current Control Layer)
Ctrl + 5 - Scene 5 (in current Control Layer)
Ctrl + 6 - Scene 6 (in current Control Layer)
Ctrl + 7 - Scene 7 (in current Control Layer)
Ctrl + 8 - Scene 8 (in current Control Layer)
Ctrl + a - Chord Trigger Assign

Opt + 1 - Make Current Edit Module 1
Opt + 2 - Make Current Edit Module 2
Opt + 3 - Make Current Edit Module 3
Opt + 4 - Make Current Edit Module 4
Opt + 5 - Make Current Edit Module 5
Opt + 6 - Make Current Edit Module 6

Windows
[F1] - Chord Trigger Button 1
[F2] - Chord Trigger Button 2
[F3] - Chord Trigger Button 3
[F4] - Chord Trigger Button 4
[F5] - Chord Trigger Button 5
[F6] - Chord Trigger Button 6
[F7] - Chord Trigger Button 7
[F8] - Chord Trigger Button 8
Shift + [F1] - Chord Trigger Button 9
Shift + [F2] - Chord Trigger Button 10
Shift + [F3] - Chord Trigger Button 11
Shift + [F4] - Chord Trigger Button 12
Shift + [F5] - Chord Trigger Button 13
Shift + [F6] - Chord Trigger Button 14
Shift + [F7] - Chord Trigger Button 15
Shift + [F8] - Chord Trigger Button 16

[F9] - KARMA On/Off
[F11] - Latch On/Off

 

Shift + left arrow - Previous Scene (in current Control Layer)
Shift + right arrow - Next Scene (in current Control Layer)
Shift + down arrow - Startup Scene (in current Control Layer)
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      When the Preferences > Workspace > Computer Keyboard type is “Standard”: <Prefs/2325>
[F12] - Fill
Shift + [F12] - Module Control Layer (move to next)
 

     When the Preferences > Workspace > Computer Keyboard type is “Extended”: <Prefs/2325>
[F12] - Module Control Layer (move to next)
[F13] - Fill

Ctrl + [F1] - Stutter Fast
Ctrl + [F2] - Stutter Medium
Ctrl + [F3] - Stutter Fast
Ctrl + [F5] - Retrigger
Ctrl + [F7] - A. Switch 1
Ctrl + [F8] - A. Switch 2
Ctrl + [      - Master Transpose Down
Ctrl + ]      - Master Transpose Up
Ctrl + []     - (Both) Master Transpose Reset

Ctrl + 1 - Module 1 Control Layer
Ctrl + 2 - Module 2 Control Layer
Ctrl + 3 - Module 3 Control Layer
Ctrl + 4 - Module 4 Control Layer
Ctrl + 5 - Module 5 Control Layer
Ctrl + 6 - Module 6 Control Layer
Ctrl + 8 - MASTER Control Layer
+ - Clear Solo

Ctrl + Shift + 1 - Scene 1 (in current Control Layer)
Ctrl + Shift + 2 - Scene 2 (in current Control Layer)
Ctrl + Shift + 3 - Scene 3 (in current Control Layer)
Ctrl + Shift + 4 - Scene 4 (in current Control Layer)
Ctrl + Shift + 5 - Scene 5 (in current Control Layer)
Ctrl + Shift + 6 - Scene 6 (in current Control Layer)
Ctrl + Shift + 7 - Scene 7 (in current Control Layer)
Ctrl + Shift + 8 - Scene 8 (in current Control Layer)
Ctrl + Shift + a - Chord Trigger Assign

Alt + 1 - Make Current Edit Module 1
Alt + 2 - Make Current Edit Module 2
Alt + 3 - Make Current Edit Module 3
Alt + 4 - Make Current Edit Module 4
Alt + 5 - Make Current Edit Module 5
Alt + 6 - Make Current Edit Module 6

    If you wish to use these Function Key shortcuts, you may need to check the settings in your computer’s operating 
system preferences. Furthermore, some third party products may interfere with these operations and need to be disabled 
when using KARMA Software.

    Note to Mac OS X users: If you press [F1] and do not get Chord Trigger 1, but get the image on the screen showing a 
decrease in screen brightness, please read further: By default, the function keys on a Mac are set to perform system 
functions pictured on the keys, such as volume up/down, screen brightness etc. But they are “dual function” keys - you 
can hold down the “fn” modifier key in the lower left of the keyboard to make them work as normal function keys (which 
would then work to play the Chord Triggers etc.) To reverse these so that they work for KARMA Mac without needing the 
“fn” key, you open the System Preferences, choose Hardware > Keyboard & Mouse > Keyboard, and then turn on the 
checkbox named “Use all F1, F2 etc. keys as standard function keys” and then close the System Preferences. The 
functioning of the keys will now be reversed - they will all work normally for KARMA Mac (and other applications), and if 
you want to access the other functions such as volume up/down, screen brightness etc., you use the “fn” modifier key at 
the lower left.

Additionally, [F8] and [F9]~[F11] are configured by default to control the Spaces and Expose features of Mac OS X. This 
can also be handled in the Sytem Preferences dialog, using the sections related to Expose and Spaces (it differs depending 
whether you are running OS X 10.4 or 10.5.) We recommend using the command key as a modifier for the function keys to 
bring up Expose and Spaces; then, the normal function keys can work for KARMA’s shortcuts.
<ArrowKeys>

Shift + left arrow - Previous Scene (in current Control Layer)
Shift + right arrow - Next Scene (in current Control Layer)
Shift + down arrow - Startup Scene (in current Control Layer)
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Keyboard Shortcuts - Arrow Keys
When a Bank Display is frontmost (Performances or GEs), the arrow keys allow you to navigate around it and change 
Performances or GEs. Even when a Performance Bank Display is not in front, you can advance to the next/previous 
Performance at any time by using the up/down arrow keys and the cmnd key (Mac) or ctrl key (Win).

Shift + left arrow, right arrow and down arrow will select Previous Scene, Next Scene, and Startup Scene (see above).

The arrow keys have special functionality when the Help Window is frontmost (see below).
<Help>
Keyboard Shortcuts - In The Help Window
To open the help, use Ctrl + H (Win) or Cmnd + H (Mac).

To go directly to the section of the Help File related to a tooltip when it is showing, do the same thing.

When the Help Window is front most (or when a modal dialog is open in front of it), certain keys on the computer keyboard 
can also be used to navigate through the file, instead of or in addition to the above buttons:

 

    Even though a modal dialog may be up, you can still open and access the Help File. You cannot click on it with the mouse, 
but all of the key commands above let you navigate through it and get information on the modal dialog that is up if desired.

<Dlog>
Keyboard Shortcuts - In Dialogs
 

In all dialogs, the “Cancel” and “OK/Save/Accept” buttons are mapped as follows:

Cancel     Esc (Mac/Win), Cmnd+Period (Mac), Ctrl+Period (Win)
OK           Enter, Return (Mac/Win)

If there is a “Don’t Save” button, it is mapped to:

Don’t Save     Cmnd+D (Mac), Ctrl+D (Win)

<PatGrid>
Keyboard Shortcuts - With Pattern Grids
The mouse can be used with many different modifier keys to perform various operations on the Pattern Grids. The table 
below is a summary. See Using The Pattern Grids.<UseGrid>
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Section 7:

Appendices - General
      Using The Pattern Grids<UseGrid>

      KARMA Performance Architecture<MemArch>

      Using Auto-Bend<UseAutoBend>

      Open Voicing Reference<OVoice>

      Random Weighting Curves<RandCurves>

      Dynamic MIDI Sources<DynSrc>

      Dynamic MIDI Destinations<DynDst>

      RT Parms Reference<RTPRef>

      KARMA Wave-Sequencing<KWS>
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Using The Pattern Grids
Sections in this chapter:

Key Combinations<UseGrid/Quick>

Adding And Removing Individual Cells<UseGrid/Ind>

Adding More Than One Cell In A Column<UseGrid/More>

Connecting Two Cells In Different Columns<UseGrid/Two>

Adding and Removing Groups Of Cells<UseGrid/Group>

Replicating A Range Of Cells<UseGrid/Repl>

Rotating a Pattern Left, Right, Up or Down<UseGrid/Rotate>

All of the Pattern Grids (Rhythm, Duration, Index, Cluster, Velocity, CCs, WaveSeq and Drum) operate in the same basic 
fashion. The intersection of each row and column (“cell”) has a button which can be turned on or off. Disabled columns 
having no cells turned on will be shown in a lighter gray color than enabled columns having at least one cell turned on.

In addition, most of the operations here also apply to the Phase Pattern Grid, which operates a bit differently in that you 
do not have to use the [shift] key to add and remove cells, since the pattern length is set manually, and it is expected that 
you will have multiple items in all the columns. But you can still use the operations below with regards to connecting cells, 
drawing marquees, replicating and rotating, etc.
<Quick>
Key Combinations
The mouse can be used with many different modifier keys to perform various operations on the Pattern Grids. The table 
below is a summary. The rest of this chapter goes into detail about the various operations.

 

<Ind>
Adding And Removing Individual Cells
Use the mouse to add individual cells. When you add a cell in an empty column, all the empty columns in between the new 
column and the last clicked cell will be filled in with an interpolated value. 

Removing cells can be done in two different ways, depending on your Preference settings:
<Prefs/Work>

(a) If “Shift + Opt/Alt Keys Required To Remove Last Cell In Column” is off, then you can simply click on any active cell 
to remove it. When you remove a cell from a column with only one cell on, that column and all columns to the right will be 
emptied and become disabled (as shown in the second diagram below). This is potentially easier to use, but also makes it 
easier to potentially erase half of your pattern if you accidentally remove one in the middle that was the only cell in a 
column.

(b) If “Shift + Opt/Alt Keys Required To Remove Last Cell In Column” is on, then you can use just the mouse to remove 
cells in any column as long as there are more than one turned on. To remove the last cell in a column and thereby shorten 
the pattern, you must hold down the [shift] + [option] keys (Mac) or [shift] + [alt] keys (Win) (as shown in the third 
diagram below). The cursor will change to a “remove” (minus) symbol.

    On Windows, sometimes it is necessary to first press and release the [alt] key or move the cursor after pressing the 
[alt] key to make the remove symbol appear.

mouse to add:
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(a) When “Shift + Opt/Alt Keys Required To Remove Last Cell In Column” is off:
mouse to remove anywhere:

 

(a) When “Shift + Opt/Alt Keys Required To Remove Last Cell In Column” is on:
mouse to remove anywhere except when cell is the last one in a column, then:
[option] (Mac) or [alt] (Win) + [shift] + mouse:

 

    To clear an entire grid, simply remove any cells that are on in the second column.

<More>
Adding More Than One Cell In A Column
To add more than one cell in a column (forming a random pool in that step), hold down the [shift] key when clicking with 
the mouse. As shown in the diagram below, the cursor will change to an “add” symbol. You can drag down while the 
[shift] key is down to add multiple cells in that column, or drag across columns to add multiple cells to that row.

[shift] + mouse to add:

 

<Two>
Connecting Two Cells In Different Columns
To connect two different cells (and remove other cells in between), first click on the start cell with the mouse, then hold 
down the [command] key (Mac) or [ctrl] key (Win) and click on the destination cell. As shown in the diagram below, the 
cursor will change to a “connect” symbol. To connect two cells while adding cells to those already entered, hold the 
[shift] key when clicking the start cell, then add the [command] key (Mac) or [ctrl] key (Win) when clicking the 
destination cell. As shown in the second diagram below, the cursor will change to a combination “connect/add” symbol.

[cmnd] (Mac) or [ctrl] (Win) + mouse to connect two cells and remove others:

 

[cmnd] (Mac) or [ctrl] (Win) + [shift] + mouse to connect two cells while adding to others:

 

<Group>
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Adding and Removing Groups Of Cells
To turn on or off a group of cells, hold down the [ctrl] key (Mac) or [c] key (Win) and click and drag with the mouse. As 
shown in the diagrams below, the cursor will change to a “marquee” symbol, and as you drag, a dotted outline (marquee) 
will be formed. Depending on whether the first cell you clicked was turned on or off, all cells within the marquee will be 
turned on or off when the mouse is released. These will replace other cells that might have been on in those columns and 
rows. To add a group of cells while keeping existing cells, add the [shift] key to the [ctrl] key (Mac) or [c] key (Win) 
before clicking the first cell, as shown in the fourth diagram below. The cursor will change to a combination 
“marquee/add” symbol.

[ctrl] (Mac) or [c] (Win) + mouse to add a group:

 

[ctrl] (Mac) or [c] (Win) + mouse to remove a group:

 

[ctrl] (Mac) or [c] (Win) + mouse to add a group while removing other cells:

 

[ctrl] (Mac) or [c] (Win) + [shift] + mouse to add a group while keeping existing cells:

 

<Repl>
Replicating A Range Of Cells
To replicate a range of cells, hold down the [option] key (Mac) or [alt] key (Win) and click with the mouse. As shown in the 
diagram below, the cursor will change to a “replicate” symbol. However many columns are currently filled in will be 
replicated however many times (or portion thereof) is necessary to fill the empty columns with the same pattern of 
values. This can be useful for doubling patterns, extending Drum Patterns, etc.

    On Windows, sometimes it is necessary to first press and release the [alt] key or move the cursor after pressing the 
[alt] key to make the replicate symbol appear.

[option] (Mac) or [alt] (Win) + mouse

 

<Rotate>
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Rotating a Pattern Left, Right, Up or Down
To rotate a pattern, hold down the [shift] + [option] + [cmnd] keys (Mac) or [shift] + [alt] + [ctrl] keys (Win) and use the 
arrow keys on the keyboard. As shown in the diagrams below, if the cursor happens to be over the grid, it will change to a 
“rotate in 4 directions” symbol, just to remind you that you have the correct key combination. However, you don’t use 
the mouse - in fact, if you click with it, it will just beep. Instead, you use the four arrow keys on the keyboard to rotate 
left, right, up or down a step at a time. Depending on the length of the pattern, when you rotate right, steps will be 
removed from the end and inserted at the beginning. When you rotate left, steps will be removed from the beginning, and 
added back on to the end. Likewise, when you rotate up or down, rows will be removed from the bottom and inserted at 
the top, or vice versa. This can be very useful for moving the patterns of accents and rhythms onto different beats than 
you originally intended, coming up with something completely new.

Rotate Right:
[shift] + [opt] + [cmnd] + [right arrow] (Mac)
[shift] + [alt] + [ctrl] + [right arrow] (Win)

 

Rotate Left:
[shift] + [opt] + [cmnd] + [left arrow] (Mac)
[shift] + [alt] + [ctrl] + [left arrow] (Win)

 

Rotate Up:
[shift] + [opt] + [cmnd] + [left arrow] (Mac)
[shift] + [alt] + [ctrl] + [left arrow] (Win)

 

Rotate Down:
[shift] + [opt] + [cmnd] + [left arrow] (Mac)
[shift] + [alt] + [ctrl] + [left arrow] (Win)
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KARMA Performance Architecture
The diagrams below illustrate the overall architecture of a KARMA Performance. 
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A Generated Effect (GE) is the basic building block of the Performance. It describes how to generate notes and MIDI 
controller information. Within a single Performance, there are up to six Modules. Within each Module is a “pointer” to a 
GE that is used by that Module.

Within each GE are up to 32 GE RTParms, which show up in the Module when the GE is loaded. They can be assigned to the 
16 RT Controls in each individual Module’s Control Layer for real-time control. GE RTP settings from any of the six 
Modules can also optionally be assigned to the Master Control Layer for additional or grouped control. Furthermore, within 
the Module are groups of Module-level parameters that can be assigned to the Master Layer as up to eight Perf. RTP.

The settings of the 16 RT Controls in each Module Control Layer are stored in the Module’s 32 Scenes. The Master Control 
Layer stores the settings of its 16 RT Controls in each of the Master Layer’s 32 scenes. The Master Layer scenes also 
store the Scene ID (currently loaded Module Layer Scene) for each of the six Modules, so that loading a Master Layer 
Scene can switch each Module to a different Module Layer Scene.
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Using Auto-Bend
Sections in this chapter:

Next Note/Previous Note Bends<UseAutoBend/Next>

Length Of Bends<UseAutoBend/Length>

The Different Bend Shapes<UseAutoBend/Shape>

Auto Bend refers to a feature of KARMA that can generated a bend along with every generated note. It can be used to 
create gliding effects between notes (simulating portamento), to automatically bend each note to a preset step size, to 
produce guitar “hammer-on” effects (where a fret is pressed with a finger to a new note after the note has already been 
picked, without restriking the note), ethnic bending, and other unique effects.

    There are several other ways of producing Pitch Bend data in KARMA, including using Pitch Bend Envelopes and 
generating stepped Pitch Bend with the CCs Panel. This chapter does not apply to those additional methods.

<Next>
Using Auto-Bend - Next Note/Previous Note Bends
Generated

When the GE Type is “Generated - Riff” or “Generated - Gated,” Next Note Bending allows the current note to bend to 
what will be the next note, the note two away, or the note three away. Previous Note Bending allows the current note to 
bend to what was the previous note, the note two notes previous, or the note three notes previous.

When beginning a riff with Previous Note bends selected, since the first notes have not actually been played yet, KARMA 
extrapolates what they would have been based on the settings of various parameters. Most of the time this will produce a 
correct bend. When using Next Note bend with Random Modes, KARMA actually does know what the next note(s) will be, 
even though they are “Random.”

If the note to be bent to is the same note as the current note (a bend of “0”) KARMA automatically chooses a bend to 
another note nearby to maintain the illusion of continuous bending.

    The maximum bend size is controlled by the Bend Range setting (usually +12 semitones), even if the next/previous 
note is farther away.

In addition, although KARMA knows what the next notes will be while it is playing a riff, it can’t know when you are going 
to change a chord and start a new riff. Therefore, the last notes before a chord change may not bend to the correct notes 
at the start of a new riff, since they will bend to what would be the next note if you hadn’t changed chords. Most of the 
time this is not a problem and still sounds musically correct.

When using Next/Prev Note Bending with Clusters, Clusters will appear to bend from their bottom note to whatever the 
next/previous note is. 

When using the Bend Parameters in the Direct Index Panel to apply Auto-Bending to Direct-Indexed notes, the options are 
slightly different. Instead of Next/Prev Note Bending, we have Next/Prev Index Bending. The pitch bends are calculated 
based on the pitches of the notes in the Note Series at various indexes. Otherwise, it works the same as the previous 
description.

Rea l -T ime

When the GE Type is “Real - Time,” only Previous Note bending is available, since KARMA cannot know which note you 
will play next. However, by using the Bend Direction parameter, you can bend either “To” the previous note, or “From” 
the previous note to the one you are playing now. The Bend Shape you are using probably determines which one makes 
more sense. For example, for Hammer-ons you will probably want to bend “To” the previous note (because the Hammer 
Shape bends it back afterwards); while for the Bend Shape, you will probably want to bend “From” the previous note to 
the one you have played now, since that is where the bend will end up to the ear. However, it’s up to you!

<Length>
Using Auto-Bend - Length Of Bends
GE Type = 0: Generated-Riff, 1: Generated-Gated, or 2: Generated-Drum

Bend Panel “Length” is 0...23: Note Values
The bend length is determined by the chosen note value and will be the same regardless of the actual duration or rhythm of 
the notes. For example, if the Bend Group “Length” is 7: 16th, then the overall Bend will be within a 16th note, even if 
you are generating a pattern with quarter notes, eighth notes, and 16th notes mixed together. This allows each bend to be 
the same length, yet maintain a relationship to tempo, since slowing down the tempo will also lengthen the bend, for 
example. This also allows the durations of the notes to be varied in real-time without changing the position or length of the 
bends.
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Bend Panel “Length” is 24: Fixed-ms
The overall bend is determined by a fixed value in milliseconds, and will be the same length regardless of the tempo 
setting. For example, this allows an absolute bend length to be determined that does not change with the tempo, so that a 
guitar line with a bend in it will play slower at a slower tempo, but not bend any slower. This also allows the durations of 
the notes to be varied in real-time without changing the position or length of the bends.

Bend Panel “Length” is 25: Note Duration
The length of the bend is a percentage of the note’s duration. Therefore, if you have the Duration Group parameters set to 
produce very short durations, then very short bends (almost inaudible) will be produced. However, with normal length 
durations, using this mode allows the bend to be scaled with each note - longer notes get longer bends, shorter notes get 
shorter bends, etc. Changing the durations of the notes in real-time changes the length and position of the bends.

    A bend will never be longer than the rhythm of the generated note itself, even if you are creating overlapping notes. In 
other words, the start of a new note stops the current bend, and potentially starts another one. The diagram in the next 
section illustrates the resulting bend when the shape is “Bend,” and shows the difference between using Note Duration and 
one of the other “Bend Length” settings.

“GE Type” 3: Real-Time

Since the duration of the note is determined by actually playing the keyboard, Bend Group “Length” 25: Note Duration is 
not available for this GE Type, and will act the same as 7: 16th if selected. The other Bend Length settings operate as 
described above.

<Shape>
Using Auto-Bend - The Different Bend Shapes
Bend

When the “Bend” Shape is selected in the Shape Parameter, the Start Parameter specifies where in the note’s duration 
the bend will start, and the End Parameter specifies where in the note’s duration the bend will end. The following diagram 
illustrates the resulting bend when the shape is “Bend,” and also the difference between Note Duration and Fixed-ms/Note 
Values settings.
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Hammer, Hammer Bend

When the “Hammer” or “Hammer Bend” Shape is selected, the Start and End Parameters function a bit differently. Start 
specifies where in the note’s duration the 1st bend will start and go to the bend’s highest value (Hammer-On), and End 
specifies where in the note’s duration the 2nd bend will start and return to zero (Hammer-Off). Additionally, a third bend 
is generated for Hammer Bends.

In addition, when the Hammer or Hammer Bend Shape is selected the Width Parameter is available. Width is a percentage 
of the amount of time between the Start and End points, and therefore controls how long the Hammer-On and Hammer-Off 
bends will be. You can also think of Width as being the amount of time the bend stays at its highest value before returning 
to zero. A Width of 100% gives you a Square Shape, while a Width of 0% gives you a Triangle Shape.

In a Hammer Bend, the third bend starts at a point in the note’s duration following the End setting, and is determined by a 
ratio of the Width. Even when Width is at 100% and the Hammer-On and Hammer-Off Bends are instantaneous, the final 
third bend will still be an audible bend.

The following diagrams illustrate the shape of a Hammer Bend. A Hammer is the same thing, without the final third bend at 
the end. Hammers and Hammer Bends follow the same behavior with Duration as discussed in the previous section Length 
Of Bends.
<UseAutoBend/Length>
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Open Voicing Reference
The following diagrams illustrate the effects of the “Voicing” Parameter in the Note Series Panel, on the spread and 
order of the notes in the Note Series. Note that the Input Notes are shifted prior to the creation of the Series, so the 
results will be different for 3 and 5 note Input Chords, for example. Furthermore, when Symmetry is on, additional notes 
are created in the Note Series for use with Clusters. These are also shifted in the same fashion, the first of such 
additional notes being indicated by a diamond in the diagrams below.
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Random Weighting Curves
Sections in this chapter:

Weighting Curve Shapes and Their Effects<RandCurves/Shapes>

Comparison of Exponential and Logarithmic Curves<RandCurves/Compare>

<Shapes>
Weighting Curve Shapes And Their Effects
When using the various Pattern Grids, more than one cell clicked in a column creates a “pool” of random choices. 
Different areas of the pool may be selectively favored using a Weighting Curve. Four different shapes are available, which 
act to favor certain areas of the pool over others when each random choice is made. Next to the Weighting Curve menu, a 
small graphic displays the actual shape of the chosen curve based on the setting of the “Factor” field. 
 

 

Exponential (Exp)
With a positive Factor (+), choices will be exponentially weighted towards the upper values in the pool. With a negative 
Factor (-), choices will be exponentially weighted towards the lower values in the pool.

Logarithmic (Log)
With a positive Factor (+), choices will be logarithmically weighted towards the upper values in the pool. With a negative 
Factor (-), choices will be exponentially weighted towards the lower values in the pool.

Exponential S (Exp-S)
With a positive Factor (+), choices will be exponentially weighted towards the center values in the pool, and away from 
the lower and upper values in the pool. With a negative Factor (-), choices will be exponentially weighted towards the 
lower and upper values in the pool, and away from the values in the center of the pool.

Logarithmic S (Log-S)
With a positive Factor (+), choices will be logarithmically weighted towards the center values in the pool, and away from 
the lower and upper values in the pool. With a negative Factor (-), choices will be logarithmically weighted towards the 
lower and upper values in the pool, and away from the values in the center of the pool.

    Using negative Factors not only inverts but also rotates the curve.

The following table summarizes the effect of the Factor field on the curves and the pools:

 

<Compare>

X Axis =
Random choice with equal probability  

between min and max

min max

Exp (+ Factor) - choose from upper values more often

Exp-S (+ Factor) - choose from center values more often

Exp (- Factor) - choose from lower values more often

Exp-S (- Factor) - choose from upper and lower values more often

upper

lower

Any table, factor 0 - equal 
chance of any choice in pool

Y Axis =
The Pool

Exponential Curves with Positive/Negative Factors
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Comparison of Exponential and Logarithmic Curves
Exponential Curves and Logarithmic Curves have similar shapes. They are different, however, as the following diagram 
i l lustrates:

 

This characteristic can be used to even more finely tune the effect you are trying to achieve. For example, the top and 
bottom curves in both the Log and Exp diagrams (Factor 40 and -40) above are shown together below:

 

With a Positive Factor (+40):

Exponential Curve (Exp)
approximately 75% chance of a choice from the upper 10% of the pool
approximately 25% chance of a choice from the lower 90% of the pool
 

Factor 0

Factor -10

Factor -20

Factor -40

Factor +10
Factor +20

Factor +40

CURVE: LOG

Factor 0

Factor -10

Factor -20

Factor -40

Factor +10
Factor +20

Factor +40

CURVE: LOG-S

Factor 0

Factor -10

Factor -20

Factor -40

Factor +10
Factor +20

Factor +40

CURVE: EXP-S

Factor 0

Factor -10

Factor -20

Factor -40

Factor +10
Factor +20

Factor +40

CURVE: EXP

Y

X

Y

X

Y

X

Y

X

X Axis = random choice with equal probability  between min and max.  Y Axis = the Pool.

Log (Factor +40)

Exp (Factor +40)

upper

lower

Y Axis =
The Pool

X Axis =
Random choice with equal probability  

between min and max

min max

Exp (Factor -40)

Log (Factor -40)

Page 400



Logarithmic Curve (Log)
approximately 90% chance of a choice from the upper 25% of the pool
approximately 10% chance of a choice from the lower 75% of the pool

In general, as the positive factor increases, the Exp Curve will produce choices more from the very highest part of the 
pool, with a choice from the remaining portion more likely to occur than with the Log Curve. In contrast, the Log Curve 
will produce choices more from the mid high to highest part of the pool, with a choice from the remaining portion less 
likely to occur than with the Exp Curve.

Therefore, while both curves will weight the random choices toward the upper values in the pool, the Log Curve provides 
less of a chance of the lower and center values ever occurring, while allowing a more even distribution among the upper 
values. The Exp Curve provides more certainty that the highest values will be chosen, while still allowing a more even 
distribution among the center and lower values than the Log Curve.

With a Negative Factor (-40):

Exponential Curve (Exp)
approximately 75% chance of a choice from the lower 10% of the pool
approximately 25% chance of a choice from the upper 90% of the pool
 

Logarithmic Curve (Log)
approximately 90% chance of a choice from the lower 25% of the pool
approximately 10% chance of a choice from the upper 75% of the pool

In general, as the negative factor decreases, the Exp Curve will produce choices more from the very lowest part of the 
pool, with a choice from the remaining portion more likely to occur than with the Log Curve. In contrast, the Log Curve 
will produce choices more from the mid low to lowest part of the pool, with a choice from the remaining portion less 
likely to occur than with the Exp Curve.

Therefore, while both curves will weight the random choices toward the lowest values in the pool, the Log Curve provides 
less of a chance of the higher and center values ever occurring, while allowing a more even distribution among the lower 
values. The Exp Curve provides more certainty that the lowest values will be chosen, while still allowing a more even 
distribution among the center and upper values than the Log Curve.

    A Factor of “0” with any shaped curve yields a linear table (straight diagonal line), and each of the values in the pool 
will have an equal chance of being chosen. A Factor of “+99” or “-99” with a Logarithmic or Exponential Curve yields a 
straight line at the top or bottom, and only the lowest or highest values in the pool will be chosen. A Factor of “+99” with 
either of the S-Curves yields a straight line across the middle, and only the middle value in the pool will be chosen. A 
Factor of “-99” with either of the S-Curves yields a split straight line across the bottom and top, and random choices 
between only the lowest and highest values in the pool will be chosen.
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Dynamic MIDI Sources
See also: Dynamic MIDI Destinations<DynDst>

The Dynamic MIDI Sources can be roughly divided into three groups:

1) The Controller Group - MIDI Controllers<DynSrc/Ctl>

2) The Note Group - Note Ranges or Durations<DynSrc/Note>

3) The Velocity Group - Velocity Ranges<DynSrc/Vel>

Depending on the combination of source and destination, the selected destination may not function as you intend. Refer to 
the explanations of combining sources and destinations in each section of the Dynamic MIDI Destinations and make sure to 
select sources and destinations that are appropriate for each other.
<DynDst>

The selected Source comes from the MIDI data stream going to the Module selected in the Port/Chan menu. In other words, 
if “2 - Module 2’s Port/Chan/KeyZone” is selected, then whatever Port and Channel has been selected for Module 2 in 
the Input section of the MIDI Ins & Outs Editor is used here as a source of MIDI Data. Furthermore, in the case of using 
some specialized Sources with the word “Zone” such as “Note # Inside Zone,” the settings for the Module’s Key Zone in 
the Key Zone Editor also have an effect. Note that this is only for Note Numbers and Velocities; other controller data is not 
effected by the Key Zone settings.
<Ctl>
--- Controller Group ---

For the Controller Group, the Range Bottom and Top fields will be available. The Range fields can be used to chose only a 
portion of the normal 0 ~ 127 range if desired. This depends on whether the actual Source is a continuous controller or a 
switch. For example, if you choose [01] Mod Wheel and set the range to be 110~127, then only when the Mod Wheel 
reaches the far end of its throw would the selected Destination be affected. In most cases, you should leave them set to 
0~127 for normal operation, unless you are trying to achieve a special calculated effect in only a portion of the 
controller’s range.

[01] JS+Y/Mod Wheel
[02]  JS-Y/Breath
[04] Foot Pedal
[22] Ribbon
[64] Damper Pedal
[80] General
[81] General
[82] General
[83] General
[84] General
[85] General
[86] Switch 1 (Assignable)
[87] Switch 2 (Assignable)
[88] General
The first fourteen choices in the Dynamic MIDI Sources menu (shown above) are user selectable continuous controllers or 
switches. They default to the settings above, which can be changed in the MIDI Setup (General) > Dynamic MIDI (CC) Page.
<MsuDyn>

[14] RT On/Off
[31] RT Latch
[23] RT Slider 1
[24] RT Slider 2
[25] RT Slider 3
[26] RT Slider 4
[27] RT Slider 5
[28] RT Slider 6
[29] RT Slider 7
[30] RT Slider 8
[102] RT Switch 1
[103] RT Switch 2
[104] RT Switch 3
[105] RT Switch 4
[106] RT Switch 5
[107] RT Switch 6
[108] RT Switch 7
[109] RT Switch 8
[33] RT Scene 1
[33] RT Scene 2
[33] RT Scene 3
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[33] RT Scene 4
[33] RT Scene 5
[33] RT Scene 6
[33] RT Scene 7
[33] RT Scene 8
RT Scene (Any)
[110] RT Chord Trigger 1
[111] RT Chord Trigger 2
[112] RT Chord Trigger 3
[113] RT Chord Trigger 4
[114] RT Chord Trigger 5
[115] RT Chord Trigger 6
[116] RT Chord Trigger 7
[117] RT Chord Trigger 8
RT Chord Trigger (Any)
These correspond to the KARMA On/Off switch, Latch On/Off switch, eight sliders, eight switches, eight scene buttons, 
and first eight Chord Triggers in the Real-Time Controls Editor, and the CCs they are set to respond to in the MIDI Setup 
(Global) > RTC Setup Page. Shown above are the default CC settings. If “Receive Active” is checked for the RT Controls in 
the Preferences and a MIDI CC Message is received on the assigned controller, it will control the Dynamic MIDI 
Assignment as well as the associated control.
<MsuRTC>

Two settings are “special,” in that they refer to groups of controls: RT Scene (Any), and RT Chord Trigger (Any). When 
these are selected, the operation of any Scene button or any Chord Trigger button respectively can be intercepted and 
used as a Dynamic MIDI Source.

While all of the RT Controls are able to be assigned in their normal operation to do various things, there are times where 
using them through Dynamic MIDI can be useful. For example, the Scene buttons can be used to retrigger the groove at a 
scene change, stop any melodic repeats so that they don’t overlap the scene change, or change a parameter value in the 
RT parms of a GE, etc. Chord Triggers can be set to repeatedly trigger modules each time they are pressed, yet the 
module can be in “1st” Trigger Mode, so that playing the keyboard doesn’t retrigger the start of the groove. And the 
Latch switch could be used to change the Key Zone range or the Latch Mode for a module’s envelopes.

Furthermore, by running an RT Slider through Dynamic MIDI and into RT Parms Control, rather than assigning it to an RT 
Parm directly, you can choose only a portion of the slider’s range to affect the parameter. For example, if you selected 
RT Slider 1 as a Dynamic MIDI Source, and set the Bottom/Top to 110/127, then only at the far right of the slider will 
the slider’s values affect any destination parameters assigned through RT Parms Control.

After Touch
Selects channel (monophonic) aftertouch to be used as a controller. The Range fields will be available to choose all or a 
portion of the overall range of 0 ~ 127.

Pitch Bend/JS X
Selects pitch bend to be used as a controller. When doing so, you may want to try the “+/-” or “-/+” setting in the 
Polarity menu of the Destination Parameters, as they are intended to go with a pitch wheel or pitch lever. The Range 
fields will be available to choose all or a portion of the overall range of 0 ~ 127.

Example using Global Tempo as a Destination, with original Tempo 100 BPM, Range Bottom and Top = 000/127:

 

<Note>
--- Note Group ---

For the Note Group, when the Range Bottom/Top fields are available, they indicate MIDI Note Numbers [0...127: C-2...G8 
(C3 = Middle C)].

Short Note (Duration < 45 ms) (Select Note Range)
Allows a note received with a “short” duration to be used as a switch. The Range fields set the Note Number range within 
which a short note will be detected, for the selected Module’s Port/Channel. The length threshold has a default value of 45 
ms. For example, this means that if you play a note with a duration shorter than 45 ms, it can be used as an action to 
control some Dynamic MIDI destination. One possibility is using a short note to stop the generation of notes from a certain 
module. 
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Note # (Select Note Range)
Allows Note Numbers coming in on the selected Module’s Port/Channel to be used as a controller. The Range fields will be 
available, and specify the bottom and top note numbers for a range of notes to be used. Note that this can be a single note 
by setting the bottom and top to the same value.

Note # Inside Zone
Allows Note Numbers coming in on the selected Module’s Port/Channel to be used as a controller. However, only those 
note numbers within the Key Zone selected in the Key Zone Editor will be passed through as controllers. The Range 
parameters are not available. This is an easy way to get the same notes as a zone in the Key Zone Page.

    Bottom and Top fields (Range) not available.

Note # Outside Zone
Allows Note Numbers coming in on the selected Module’s Port/Channel to be used as a controller. However, only those 
note numbers outside the Key Zone selected in the Key Zone Editor will be passed through as controllers (the opposite of 
above). The Range parameters are not available. This is an easy way to get the all the notes that are not in a zone in the 
Key Zone Page.

    Bottom and Top fields (Range) not available.

White Note # (Select Note Range)
Allows only Note Numbers from the White Keys of the selected Module’s Port/Channel to be used as controllers. The 
Range fields will be available, and specify the bottom and top note numbers for a range of notes to be used.

Black Note # (Select Note Range)
Allows only Note Numbers from the Black Keys of the selected Module’s Port/Channel to be used as controllers. The Range 
fields will be available, and specify the bottom and top note numbers for a range of notes to be used.
<Vel>
--- Velocity Group ---

For the Velocity Group, the Range Bottom/Top fields are always available, and they indicate a velocity range from 
[0...127].

Velocity (Select Vel Range)
Allows Key Velocities to be used as controllers. The Range fields will be available, and specify the Bottom and Top Values 
(inclusive) of a Velocity Window within which velocities will be passed through.

Velocity Inside Zone (Select Vel Range)
Same as above, but only the specified range of Velocities from Notes within the Module’s Key Zone as specified in the Key 
Zone Editor will be used.

Velocity Outside Zone (Select Vel Range)
Same as above, but only the specified range of Velocities from Notes outside of the Module’s Key Zone as specified in the 
Key Zone Editor will be used.

White Velocities (Select Vel Range)
Allows Key Velocities from only White Keys to be used as controllers. The Range fields will be available, and specify the 
Bottom and Top Values (inclusive) of a Velocity Window within which velocities will be passed through.

White Velocities In Zone (Select Vel Range)
Same as above, but only the specified Range of Velocities from White Keys within the Module’s Key Zone as specified in 
the Key Zone Editor will be used.

White Velocities Outside Zone (Select Vel Range)
Same as above, but only the specified Range of Velocities from White Keys outside of the Module’s Key Zone as specified in 
the Key Zone Editor will be used.

Black Velocities (Select Vel Range)
Allows Key Velocities from only Black Keys to be used as controllers. The Range fields will be available, and specify the 
Bottom and Top Values (inclusive) of a Velocity Window within which velocities will be passed through.

Black Velocities In Zone (Select Vel Range)
Same as above, but only the specified Range of Velocities from Black Keys within the Module’s Key Zone as specified in the 
Key Zone Editor will be used.

Black Velocities Outside Zone (Select Vel Range)
Same as above, but only the specified Range of Velocities from Black Keys outside of the Module’s Key Zone as specified in 
the Key Zone Editor will be used.
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Dynamic MIDI Destinations
See also: Dynamic MIDI Sources<DynSrc>

Depending on the combination of source and destination, the selected destination may not function as you intend. Refer to 
the explanations of combining sources and destinations in each of the following sections, and make sure to select sources 
and destinations that are appropriate for each other.

The [M, T, C] indication shown at the right of each destination name indicate the source operating modes (“Action”) that 
are valid for each destination function (Momentary, Toggle, Continuous). See the Dynamic MIDI - Action parameter.
<DynEd/0534>

The chosen Destination is further supplemented by the setting of the “Module” menu, which determines which of the six 
Modules will be affected (or the last triggered Module if “Last” is selected). This does not have an effect for several 
“Global” destinations indicated below, which affect all Modules or the entire Performance only.

[OFF]
No Destination is selected and any Source settings are ignored.

RT Parms Control Assign  [M, T, C]
Assigning this as a destination means that Dynamic MIDI can be used to control any of the 32 GE RT Parms in each Module 
of the Performance, or any of the 8 Performance RT Parms. In other words, in the “Assign” popup menu in the 
Performance RT Parms Page there are eight “DynMidi” assignments (D1...D8) that correspond to the eight rows in the 
Dynamic MIDI Page. This creates a sort of assignment matrix between Dynamic MIDI and the RT Parms. If you assign a 
source in row three of the Dynamic MIDI Page to the destination “RT Parms Control Assign” and then in the RT Parms 
Page assign some parameters to “D3 (DynMidi),” you’ve routed the Dynamic MIDI control into the RT Parms section.

You should normally select a source from the Controller Group.
<DynSrc/Ctl>

    Since this setting is not Module-specific, the Module settings are grayed out and ignored. You choose which Module(s) 
it affects according to which Modules you assign it to in the Performance RT Parms Page for the Modules.

Setting example:
Mod Wheel or Joystick operations in the +Y direction will control GE RT Parm #1 in Module 2.

Dyn1 Source:            [01] JS+Y/Mod Wheel
Dyn1 Range-Btm/Top:     000/127
Dyn1 Action:            C - Continuous
Dyn1 Destination:       RT Parms Control Assign
Dyn1 Pol (Polarity):    (+)
GE RT Parm #1 Assign:   D1 (DynMidi)

Global Tempo  [M, T, C]
Allows a source action to increase or decrease the Performance Tempo. You will normally select a source from the 
Controller Group.
<DynSrc/Ctl>

    Since this setting is not Module-specific, the Module settings are grayed out and ignored.

When Polarity is (+), you can use the controller to speed up the tempo. When the value of the controller selected as the 
source is at the value specified for “Range Bottom,” the tempo will be as specified by the Performance. When the value of 
the controller selected as the source is at the value specified for “Range Top,” the tempo will be double the tempo 
specified by the respective mode. (The tempo will not be faster than a maximum tempo of 300 BPM.)

When Polarity is (–), you can use the controller to slow down the tempo. When the value of the controller selected as the 
source is at the value specified for “Range Bottom,” the tempo will be as specified by the Performance. When the value of 
the controller selected as the source is at the value specified for “Range Top,” the tempo will be half the tempo specified 
by the respective mode. (The tempo will not be slower than a minimum tempo of 40 BPM.)

Note/Env Latch [M, T]
Controls the Note Latch and Envelope Latch parameters in the Trigger Page, for any assigned Module. You will normally 
select a source from the Controller Group. For example, you can use the damper pedal (or other controller) to control note 
latch independently of the settings in the Trigger Page.
<DynSrc/Ctl>

    If you use this setting, the operation of Envelope 1, 2, and 3 will also be affected. Regardless of the Envelope Latch 
settings for each Module, you can use a damper pedal (or other controller) to turn latch on so that the currently operating 
Envelope 1, 2, or 3 will continue to be held even after you release the keyboard or a Chord Trigger button.
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Example of use (Two Module Performance):

[Module 1] Trigger Page, Note Latch: On
[Module 2] Trigger Page, Note Latch: LB
Dyn1 Source:        [64] Damper Pedal
Dyn1 Range-Btm/Top: 000/127
Dyn1 Action:        M - Momentary 
Dyn1 Destination:   Note/Env Latch
Dyn1 Module 2:      On (checked)
Dyn1 Polarity:      (+)

When the RT Controls Editor “Latch” switch is on, latch will be on for both Modules. Playing and releasing a chord will 
trigger the Modules and they will continue playing. When the RT Controls Editor “Latch” switch is off, Module 1 will 
remain playing when you release the chord because of the Trigger Page Note Latch “On” setting, but Module 2 will stop 
playing. Because of the Dynamic MIDI settings, pressing the damper pedal will now control the latching of Module 2.

Auto Transpose On/Off [M]
Allows a Source action such as a pedal to be used to latch the Auto-Transpose feature. You will normally select a source 
from the Controller Group. 
<DynSrc/Ctl>

Auto Transpose is a feature that allows you to play a voicing on the keyboard that generates a KARMA effect, and then 
“memorize” that voicing and play single notes on the keyboard to transpose the voicing to different chords quickly and 
easily. See the example under the Auto Transpose Range destination (next).

Auto Transpose Range [C]
Controls the amount of transposition for the auto transpose function. Select the source from the Note Group. If you select 
a source from the Controller Group or Velocity Group, it will not be possible to control the transpose amount of the auto 
transpose function.
<DynSrc/Note>

    The Polarity setting will be ignored.

This is normally used in conjunction with the Auto Transpose On/Off destination being assigned to another controller such 
as the damper pedal. When Auto Transpose On/Off is on, playing chord data for each KARMA module within the keyboard 
range specified as the Auto Transpose Range source will automatically transpose the current chord, rather than enter a 
new chord.

Example of use (Single Module Performance):

Dyn1 Source:        [64] Damper Pedal
Dyn1 Range-Btm/Top: 000/127
Dyn1 Action:        M - Momentary 
Dyn1 Destination:   Auto Transpose On/Off
Dyn1 Module 1:      On (checked)
Dyn1 Polarity:      +

Dyn2 Source:        Note # (Select Note Range)
Dyn2 Range-Btm/Top: 000/060 (000 = C-1, 060 = C4)
Dyn2 Action:        C - Continuous
Dyn2 Destination:   Auto Transpose Range
Dyn2 Module 1:      On (checked)
Dyn2 Polarity:      ignored

1) Turn on the KARMA function in the Real-Time Controls Editor, and play the keyboard. Play a CMaj7 chord in the LH 
area. The KARMA function will generate a phrase according to the selected GE and the settings of the KARMA module.
2) Press the damper pedal. The auto transpose function will be turned on. The Cmaj7 chord will be remembered.
3) When you play a single note number in the range specified by “Range bottom/Top” (in this case, below middle C), the 
CMaj7 chord will be transposed with that note as the root. If you play D3, the KARMA function will generate a phrase 
based on DMaj7. If you play E3, the phrase will be based on Emaj7.
4) Release the damper pedal. The auto transpose function will be turned off, and the KARMA function will resume normal 
operation.

Module Stop [M]
Operating the selected source controller when the KARMA function is operating will stop the KARMA Module. (The KARMA 
function will remain on.) This is the same as hitting the computer keyboard’s [Return] key, for the selected Module only. 
When you apply a trigger (for example by playing the keyboard), the Module will resume functioning.

You can use a source from any of the three groups, but typically it will be the Controller Group.
<DynSrc/Ctl>

Melodic Repeat Stop [M]
Some GEs (but not all of them) utilize “Melodic Repeat” to generate additional repeated notes from the notes that are 
generated. The repeated notes created by “Melodic Repeat” will normally continue playing their specified number of 
repeats even when you turn off the KARMA On/Off switch (subject to the setting of the Options Menu “Return Stops 
Melodic Repeat.”) If you want the repeated notes to stop immediately when you turn the KARMA function off, use the 
source “KARMA On/Off” to control the destination “Melodic Repeat Stop.”
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You can use a source from any of the three groups, but typically it will be the Controller Group.
<DynSrc/Ctl>

Example: using the KARMA On/Off switch to stop all repeated notes when switched off.
(Single Module Performance)

Dyn1 Source:        [14] KARMA On/Off
Dyn1 Range-Btm/Top: 000/127
Dyn1 Action:        M - Momentary 
Dyn1 Destination:   Melodic Repeat Stop
Dyn1 Module 1:      On (checked)
Dyn1 Polarity:      (-) (Polarity minus since we want to stop when off)

Module Stop & Repeat Stop [M]
Combines the effects of Module Stop and Melodic Repeat Stop (above), so that all note generation from the assigned 
module(s) will be immediately terminated.

You can use a source from any of the three groups, but typically it will be the Controller Group.
<DynSrc/Ctl>

Module Pause [M, T]
Allows a Module to be “paused” in the middle of whatever it is doing, and then be “resumed.” Technically, this is 
accomplished by the temporary disconnection of the internal clock from a selected Module’s effect as it is being 
generated, thereby pausing it at its current location. Generation can then be resumed at any time from the present 
location, without restarting from the beginning of the effect. For example, with a long up/down glissando, you can pause 
at various points in the phrase and continue from the same location.

You can use a source from any of the three groups, but typically it will be the Controller Group.
<DynSrc/Ctl>

This is a different effect from turning the GE Setup/Mix Page “Run” parameter on/off, where the module is actually still 
continuing with generation even though you cannot hear it. Normally, when the KARMA Module GE Setup/Mix Page “Run” 
parameter is turned off, the KARMA module will continue operating internally without pausing. This means that if Run is 
off and then is turned on, the phrase or pattern will not resume from where the Run button was turned off, but from 
wherever it is at the moment the Run button is turned on. In contrast, using Dynamic MIDI Module Pause makes the phrase 
or pattern resume playing from where it was stopped.

Example of use (Single Module Performance):

Dyn1 Source:        [01] JS+Y/Mod Wheel
Dyn1 Range-Btm/Top: 000/127
Dyn1 Action:        M - Momentary 
Dyn1 Destination:   Module Pause
Dyn1 Module 1:      On (checked)
Dyn1 Polarity:      (+)

When you move the joystick/mod wheel all the way in the up direction, the phrase will pause. When you return the 
joystick to the center, the phrase will resume playing.

Chord Scan [C]
Allows a Dynamic MIDI Source such as a range of keys to be analyzed by the Chord Recognition algorithms, instead of the 
normal range set in the Key Zone Page. Select the “Note # (Select Note Range),” “Note # Inside Zone,” or “Note # 
Outside Zone” sources in the Note Group. Chord analysis cannot be controlled if you select a source from the Controller 
Group, a note source other than the above, or the Velocity Group.
<DynSrc/Note>

    The Polarity setting will be ignored.

KARMA normally performs Chord Analysis independently for each module, on notes played within the Input Note Key Zone 
set up in the Key Zone Page. The resulting chord determination(s) affect the operation of the following 
parameters/features:
- Note Series: Chord Shift
- Note Series: Note Type “Scalic” or “Scalic 2”
- Note Series: Filter Notes Grid
- Melodic Repeat: Chord Shift
- Drum Pattern: NTT (Note Table Transposition)
- CC Pitch Offset Pattern: Chord Shift

There are certain cases where you may want to override the default behavior, and have KARMA use a different key range 
than the Key Zone set in the Key Zone Page. A good example is when using GE Type “Real-Time” and triggering “one 
finger riff” type effects, or overlapping repeats with transpose values other than 0, 12, -12, etc. A typical use is to 
create a Key Zone for a module having a Real-Time GE Effect extending from C4 (60) up to the top of the keyboard, and 
then selecting “Note # Outside Zone” as a Dynamic MIDI Source and “Chord Scan” as a Dynamic MIDI Destination. With 
these settings, the bottom half of the keyboard produces no sound, but instead determines the chord that is recognized by 
the Chord Analysis algorithms. Since this affects the Melodic Repeat: Chord Shift parameter, when the real-time notes 
are triggered in the upper part of the keyboard, they will be transposed according to the chord determination from the 
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lower area of the keyboard, and not have any effect themselves on the chord recognition. For example, this can be used to 
simulate harp glissandi proceeding from a selected input note, much like plucking a specific string and then trailing off 
from it, among other effects. Furthermore, if Repeat Repetitions are set high and there are many repeats, changing the 
chord in the lower area of the keyboard will cause repeats after that to be transposed according to the newly determined 
chord.

When using Chord Scan, a single note in the specified key range will be recognized as a Major chord, and all notes within 
the range will be utilized to determine the chord type. Additional control can be obtained by using “Smart Scan,” 
described below.

    For KARMA modules affected by the Chord Scan specified here, the key zone note input specified for each module will 
not be used for chord detection on that module.

Example (Single Module Performance):
Select a GE of GE Type = Real-Time using Melodic Repeat to generate repeated transposed notes, and use the keyboard to 
input the chord that will control the phrase or note being played by Melodic Repeat.

Dyn1 Source:        Note # Outside Zone
Dyn1 Range-Btm/Top: not available
Dyn1 Action:        C - Continuous
Dyn1 Destination:   Chord Scan
Dyn1 Module 1:      On (checked)
Dyn1 Polarity:      ignored

KeyZone Bottom/Top: C4/G9 (Key Zone Page)

Play the high range of the keyboard above C4 (specified as the key zone) to trigger phrases and notes produced by the 
KARMA function. At this time, play the lower range of the keyboard to control the chord of the phrase or notes in 
real-time. (Playing the lower range of the keyboard will not produce sound but will only control the chord.) This allows 
you to play the lower range of the keyboard to vary the chord while Melodic Repeat is producing an extended phrase, 
letting you control the development of the phrase.

Smart Scan [C]
The same as “Chord Scan” above, except adds a patented proprietary dual-windowing algorithm for further control. Each 
hand creates its own “sliding key zone” having a three-note threshold (within the overall key range set by the Dynamic 
MIDI Bottom/Top Range). Therefore, it requires at least three notes in either hand to change the analyzed chord.

Select the “Note # (Select Note Range),” “Note # Inside Zone,” or “Note # Outside Zone” sources in the Note Group. 
Chord analysis cannot be controlled if you select a source from the Controller Group, a note source other than the above, 
or the Velocity Group.
<DynSrc/Note>

    The Polarity setting will be ignored.

Note input by key zone or chord detection by Chord Scan requires one or more notes, while Smart Scan requires three or 
more notes to be input in a given area. In general when you perform using both hands, the chord will change when you play 
three or more notes in either hand. For example if you press C4 for key zone note input or Chord Scan, the chord will be 
detected as C Maj. In contrast, Smart Scan will not detect a chord when you press C4, but will (for example) detect C Maj 
when you simultaneously press C4/E4/G4. In addition, Smart Scan takes into consideration the keyboard location and 
number of notes that are played, allowing more sophisticated and intuitive control of the timing of chord detection and the 
bass note handling.

As an example, with Smart Scan you can play a chord with the left hand, and then solo with the right hand at the same 
time without changing the chord. As long as the right hand plays two notes or less and remains a certain distance from the 
left hand, it will not affect the Chord Analysis. Likewise, you can play a chord in the right hand, have it analyzed, and then 
play bass-lines with the left hand without changing the chord.

Additionally, when the sustain pedal (damper) is in use for a particular module (i.e. not filtered in the MIDI Filter Page), 
the Chord Analysis will not operate when the sustain pedal is down. This allows the determined chord to be “locked” while 
adding additional sustained notes in a typical pianistic fashion.

    Note input in the key zone specified for each module will not be used for normal chord detection on KARMA modules for 
which Smart Scan is operating. If Smart Scan and Chord Scan are specified simultaneously, the Chord Scan note range will 
also be handled as the Smart Scan note range.

Example (Single Module Performance):
Play a chord in either the left hand or right hand to control the phrase or pattern generated by the KARMA module. In this 
example, we will use the right hand to play a solo phrase, and the left hand to play a bass riff etc. in real-time without 
changing the chord.
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Dyn1 Source:        Note # (Select Note Range)
Dyn1 Range-Btm/Top: 000/127 (full range)
Dyn1 Action:        C - Continuous
Dyn1 Destination:   Smart Scan
Dyn1 Module 1:      On (checked)
Dyn1 Polarity:      ignored

Using your left hand, play three or more notes to control the chord. If you wish to use your right hand to play a solo part 
in the high keyboard range, the chord will not change as long as you keep a certain distance from the left hand and play 
only two notes or less. In the same way, use your right hand to play three or more notes in the upper range of the 
keyboard to control the chord. You can use your left hand to play a bass line in the lower range of the keyboard without 
changing the chord.

    Chord detection will not occur while the KARMA module is receiving damper on. When you press the damper pedal, 
chord detection will be locked, and notes you add while the damper is on will not change the chord.

Clock Advance [M, T, C]
This lets you use a controller such as the joystick or note-on/off operations to trigger the clock by which the KARMA 
function operates, thus using “Manual Advance” to advance the phrase or pattern. The Clock Advance Mode Parameter in 
the Control Page of the KARMA module being controlled must be set to “Dyn,” “Int + D,” or “Int + DS.”

You can use a source from any of the Dynamic MIDI Sources. If you select the source from the Note Group or Velocity 
Group, set the Action to “C - Continuous.”
<DynSrc>

Example 1  (Single Module Performance) - Control by joystick operations:

Dyn1 Source:        [01] JS+Y/Mod Wheel
Dyn1 Range-Btm/Top: 000/127
Dyn1 Action:        M - Momentary
Dyn1 Destination:   Clock Advance
Dyn1 Module 1:      On (checked)
Dyn1 Polarity:      (+)
Control Page, Clock Advance Mode: DynMidi

Example 2 (Single Module Performance)
Use note-on/off played in the upper range of the keyboard to advance the phrase generated by playing chords in the lower 
range of the keyboard (specified by the key zone):

Dyn1 Source:        Note # Outside Zone
Dyn1 Range-Btm/Top: not available
Dyn1 Action:        C - Continuous
Dyn1 Destination:   Clock Advance
Dyn1 Module 1:      On (checked)
Dyn1 Polarity:      (+)
Control Page, Clock Advance Mode: DynMidi
Key Zone Page, Bottom/Top:    C-1/B3
Key Zone Page, Thru In Zone:  Off
Key Zone Page, Thru Out Zone: Off

Trigger Notes & Envs [M, T, C]
Trigger Envelope 1 [M, T, C]
Trigger Envelope 2 [M, T, C]
Trigger Envelope 3 [M, T, C]
Control triggering of GE phrases and/or envelopes 1/2/3 of the KARMA Module. With Trigger Notes & Envs, GE phrases 
and envelopes 1/2/3 will all be triggered. Other settings allow these to be triggered individually.

You can use a source from any of the Dynamic MIDI Sources.
<DynSrc>

    If you are using a GE that does not use envelopes, the envelope-related settings made here will be ignored.

Direct Index [C]
Allows a Source action, such as a continuous controller or a range of keys, to directly index the Note Series and 
selectively generate notes in real-time. You can use this to sweep a controller through the Note Series, or to select notes 
from the Note Series with a keyboard, and “solo” without thinking about what you are doing. If an effect is already being 
generated by the GE, it will continue playing while you are Direct Indexing.

Normally you would select a source from:
the Controller Group<DynSrc/Ctl>
the Note Group<DynSrc/Note>

Direct Idx & Mdl Stop [C]
The same as Direct Index (above), but also stops the generation of any notes that may be happening from the normal 
triggering of the GE. You can use this to have an effect trigger normally from one area of the keyboard, and then be 
stopped by Direct Indexing notes from another area of the keyboard or a controller.
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Normally you would select a source from:
the Controller Group<DynSrc/Ctl>
the Note Group<DynSrc/Note>

Direct Index 1 Way [C]
The same as Direct Index (above), but only functions in one direction (sweep) of the selected controller. In other words, if 
you were to assign a joystick to the normal Direct Index setting above, the notes would sweep as you move the joystick in 
one direction, and then sweep back again as you return the joystick in the other direction. With Direct Index 1 Way, the 
release does not cause any note generation in the return direction - it only indexes in one direction of movement. This is 
also quite useful with the Ribbon setting, since unless “Ribbon Lock” is turned on, releasing the finger at one end of the 
ribbon will “snap back” to the center value, creating spurious notes on release (unless this setting is used).

The Polarity setting choose which direction it operates in. The following example shows the Dynamic MIDI Source set to 
“[22] Ribbon.” (Moving in the opposite direction from what is shown produces no action.)

Polarity = +:
|  Up  ----> ----> ----> ----> ----> ----> ----> ---->|
0 . . . . . . . . . . . . 64 . . . . . . . . . . . .127

Polarity = -:
|<---- <---- <---- <---- <---- <---- <---- <---- Down |
0 . . . . . . . . . . . . 64 . . . . . . . . . . . .127

Polarity = +|-:
<---- <---- <---- <- Down || Up ----> ----> ----> ---->
0 . . . . . . . . . . . . 64 . . . . . . . . . . . .127

Polarity = -|+:
<---- <---- <---- <--- Up || Down --> ----> ----> ---->
0 . . . . . . . . . . . . 64 . . . . . . . . . . . .127

Normally you would select a source from the Controller Group. <DynSrc/Ctl>

Dir. Idx 1Way & Mdl Stop [C]
The same as Direct Index 1 Way (above), but also stops the generation of any notes that may be happening from the 
normal triggering of the GE. You can use this to have an effect trigger normally from one area of the keyboard, and then 
be stopped by Direct Indexing notes from another area of the keyboard or a controller.

Normally you would select a source from the Controller Group. <DynSrc/Ctl>

Buffer Latch [M, T]
Allows a Dynamic MIDI Source such as a pedal to be used to “latch” the input of notes into KARMA, so that they are added 
to the group of input notes from which the Note Series is created. You can think of this as a sustain pedal for the input 
notes of KARMA. In other words, normally if you play one note, that one note will be used to create the Note Series (if 
Note Series Note Type is “Regular”). If you keep holding the note, and add a second note, the Note Series will then be 
recreated from the two notes. If you release the first note before adding the second note, then the second note will 
recreate the Note Series from only the second note. If Buffer Latch is being used, you can release the notes, but KARMA 
will consider them to be “sustained,” and the Note Series will be created with the additional notes as if they were not 
released. Notes can be added until the pedal/switch is released, after which the next note(s) will again create the Note 
Series without the previous notes.

Example (Single Module Performance):

Dyn1 Source:        [64] Damper Pedal
Dyn1 Range-Btm/Top: 000/127
Dyn1 Action:        M - Momentary
Dyn1 Destination:   Buffer Latch
Dyn1 Module 1:      On (checked)
Dyn1 Polarity:      (+)
MIDI Filter Page, Sustain - CC 64: Filter

1) With the KARMA function on, hold down the damper pedal, and play C4 (and release the note). The chord will be 
detected as C Maj, and a phrase based on C Maj will be played.
2) While continuing to hold down the damper pedal, play B4. The chord will be detected as C Maj7. If you were not using 
Buffer Latch, the chord would be detected as B Maj.
3) Notes will be added until you release the damper pedal and play the keyboard. Since the MIDI Filter Page Sustain setting 
is set to “Filter” in this example, the damper pedal will not produce the conventional damper effect when the KARMA 
function is on.

 

Normally you would select a source from the Controller Group. <DynSrc/Ctl>
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Trigger Fill [M]
Allows a Dynamic MIDI Source such as a button or pedal to activate the Fill button and feature in the RTC Editor. You will 
find this assigned to Module 6 in nearly all the Factory Performances, for triggering fills from the Motif/MOX Remote or 
external pad controllers.

Normally you would select a source from the Controller Group. <DynSrc/Ctl>

Trigger Notes&Envs-Sync [M]
Allows a Dynamic MIDI Source such as a button or pedal to activate the Retrigger button and feature in the RTC Editor. You 
will find this assigned to the first five Modules in nearly all the Factory Performances, for retriggering the groove from 
the Motif/MOX Remote or external pad controllers. 

The difference between this and “Trigger Notes & Envs” earlier in the list is this was specially designed for the 
Retrigger button that was added in KARMA 3.0, such that using this feature resets and synchronizes all of the various 
time windows in addition to retriggering the assigned Modules. In other words, hitting the Retrigger button retriggers the 
assigned Modules, restarts the Scene Change Quantize Window, the Fill Bar Count Window and various other time windows 
such that each time you hit the Retrigger, it’s as if you just started KARMA. Furthermore, after the Retrigger button is 
activated, there is about a bar and a half time window within which you can press a Chord Trigger or play a chord on the 
keyboard and it will also retrigger (the first time). This allows you to rapidly retrigger the groove a number of times and 
then play a new chord and the new chord ends up being the last retrigger (which is generally what you want, and the most 
natural way to use the feature).

Normally you would select a source from the Controller Group. <DynSrc/Ctl>

Stutter x 1 [M]
Stutter x 1.5 [M]
Stutter x 2 [M]
Stutter x 3 [M]
Stutter x 4 [M]
These five destinations allow a Dynamic MIDI Source such as a button or pedal to activate the Stutter buttons and Stutter 
feature in the RTC Editor at different speeds. You will find three of these programmed in every Factory Performance, 
assigned to the three Stutter buttons. They multiply the value of the Trigger Page > Stutter Window. In other words, the 
Stutter Window for each Module specifies a “base” rhythmic value at which to rapidly and continuously retrigger the 
Module while a Stutter button is held down. In other words, if the Stutter Window is a 32nd note, then Stutter x 1 will 
stutter at a 32nd note, Stutter x 1.5 will stutter at a 16th note triplet, and Stutter x 2 will stutter at a 16th note. 
Typically the Stutter Window value will be set to one of the smaller values since these Dynamic MIDI Destinations multiply 
it and make it longer.
<TrgEd/Stutter>

Normally you would select a source from the Controller Group. <DynSrc/Ctl>
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RT Parms Reference
Sections in this chapter:

GE RT Parms By Group<RTPRef/GrpGE>

Performance RT Parms By Group<RTPRef/GrpPE>

<GrpGE>
RT Parms Reference - GE RT Parms By Group
The following fifteen groups of parameters are available to be assigned as GE RT Parms in the GE Editor > RT Parms 
Page.<RTPEd>

    Virtual Parameters are indicated by a tilde “~” at the beginning of the name.

0: Off
No assignment. The rest of the parameters in the row will be grayed out.

1: GE
GE Type
Gate Type
Gate CC Number
Force Mono
See the GE Editor.<GE>

2: Note Series
Note Type
Input Sort
Input Transpose
Inversion
Replications
Max
Symmetry
Interval
Chord Shift
Wrap Bottom
Wrap Top
Voicing
Filter Dupes
Filter Fixed
~Filter Template
~Filter Temp + Restore
See the Note Series Page.<RifEd>

3: Phase
Total Steps
Start %
Start Mode
Length Mode
Cycle Mode
Direction
Phase Transpose
~Octave Phs. Transpose
~Oct/5th Phs. Transpose
Step Transpose On/Off
~Step Transp. Template
Events
TSig Numerator
TSig Denominator
Beginning Offset %
End Offset %
End Loop On/Off
End Loop Start Step
End Loop Length
Pattern Items
Pattern Step 1
Pattern Step 2
Pattern Step 3
Pattern Step 4
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Pattern Step 5
Pattern Step 6
Pattern Step 7
Pattern Step 8
Pattern Step 9
Pattern Step 10
Pattern Step 11
Pattern Step 12
Pattern Step 13
Pattern Step 14
Pattern Step 15
Pattern Step 16
~Template (All Steps)
~Template Steps 1~4
~Template Steps 5~8
~Template Steps 9~12
~Template Steps 13~16
~Mutes Template+Restore
See the Phase Page.<PhsEd>

4: Rhythm
Humanize
Swing Note Value
Swing %
~Swing% 0~100,-200,+200
Swing Use Multiplier
Pools-Random Factor
Pools-Weighting Curve
Ties-Random Factor
Ties-Weighting Curve
Rhythm Multiplier
~Straight Multipliers
~Straight/Trip Mults
~Strt/Dot/Trip Mults
Template
Template + Restore
See the Rhythm Page.<RhyEd>

5: Duration
Duration Mode
Duration Value
Pools-Random Factor
Pools-Weighting Curve
Ties-Random Factor
Ties-Weighting Curve
Use Rhythm Multiplier
Template
Template + Restore
See the Duration Page.<DurEd>

6: Index
Index Mode
Random Walk Max Step
Pools-Random Factor
Pools-Weighting Curve
Cluster Mode
Invert
Double
Double Amount
Inv/Dbl Vel. Offset
Template
Template + Restore
See the Index Page.<NteEd>
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7: Cluster
Strum
Pools-Random Factor
Pools-Weighting Curve
Template
Template + Restore
See the Cluster Page.<CluEd>

8: Velocity
Velocity Mode
Velocity Value
Velocity Range Bottom
Velocity Range Top
Randomize Bottom
Randomize Top
Pools-Random Factor
Pools-Weighting Curve
Cluster Mode
Scale
Template
Template + Restore
See the Velocity Page.<VelEd>

9: CCs
Fixed/On
CC Mode
Polarity
Pools-Random Factor
Pools-Weighting Curve
Pitches-Random Factor
Pitches-Weighting Curve
Octaves-Random Factor
Octaves-Weighting Curve
CC A
CC B
Cluster Mode
Pitch Offsets On/Off
P.Offset Chord Shift
Template
Template + Restore
Scale Min
Scale Max
See the CCs Page.<PanEd>

10: WaveSeq
WaveSequence On/Off
Oscillator Mode
Waveform Offset
Waveform Type
Row 1 Waveform
Row 2 Waveform
Row 3 Waveform
Row 4 Waveform
Row 5 Waveform
Row 6 Waveform
Row 7 Waveform
Row 8 Waveform
Row 9 Waveform
Row 10 Waveform
Row 11 Waveform
Row 12 Waveform
Row 13 Waveform
Row 14 Waveform
Row 15 Waveform
Row 16 Waveform
Row 1 Start Offset
Row 2 Start Offset
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Row 3 Start Offset
Row 4 Start Offset
Row 5 Start Offset
Row 6 Start Offset
Row 7 Start Offset
Row 8 Start Offset
Row 9 Start Offset
Row 10 Start Offset
Row 11 Start Offset
Row 12 Start Offset
Row 13 Start Offset
Row 14 Start Offset
Row 15 Start Offset
Row 16 Start Offset
Keyboard Track
Pools-Random Factor
Pools-Weighting Curve
Template
Template + Restore
See the WaveSeq Page.<WavEd>

11: Envelopes
On/Off
Type/CC
Start Level
Attack Time
Attack Level
Decay Time
Sustain Level
Release Time
Release Level
Amplitude Amount
Time Scale
Attack Smooth
Loop Mode
Tempo Relative
Note Trigger
~Sta/Att Level
~Sta/Sus Level
~Sta/Rel Level
~Att/Sus Level
~Att/Rel Level
~Sus/Rel Level
~Sta/Att/Sus Level
~Sta/Att/Rel Level
~Sta/Sus/Rel Level
~Att/Sus/Rel Level
~All Levels
~Att/Dec Time
~Att/Rel Time
~Dec/Rel Time
~All Times
See the Envelopes Page.<EnvEd>

12: Repeat
Rhythm
~Straight Rhythms
~Dotted Rhythms
~Triplet Rhythms
~Selected Rhythms
~Selected Rhythms 2
Use Swing
Time Offset (ms)
Repetitions
Decay
Initial Velocity
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Transpose
Chord Shift
Stop Mode
Rebound Mode
Tempo Env. Lock
Range Mode
Wrap Bottom (Abs)
Wrap Top (Abs)
Wrap Bottom (Rel)
Wrap Top (Rel)
Vel. Range Bottom
Vel. Range Top
Duration Mode (RT)
Duration Value (RT)
Key Mode (RT)
Chord Quantize (RT)
See the Melodic Repeat Page.<RptEd>

13: Bend
On/Off
Amount
Force Bend If Zero
Shape
Alternation
Step Mode
Length
Fixed-ms
Start %
End %
Width %
Drum Bend Mode
Bend Range
Key Mode (RT)
Direction (RT)
Rel. Delay Length (RT)
Rel. Delay Damping (RT)
Vel. Range Bottom (RT)
Vel. Range Top (RT)
See the Bend Page.<BndEd>

14: Drum
Play On/Off
~On/Off Combinations
Row 1 Note
Row 2 Note
Row 3 Note
Row 4 Note
Row 5 Note
Row 6 Note
Row 7 Note
Row 1 Vel. Offset
Row 2 Vel. Offset
Row 3 Vel. Offset
Row 4 Vel. Offset
Row 5 Vel. Offset
Row 6 Vel. Offset
Row 7 Vel. Offset
Rhythm Multiplier
~Straight Multipliers
~Straight/Trip Mults
~Strt/Dot/Trip Mults
Pattern Vel. Offset
Pattern Vel. Scale
Pattern Transpose
~Octave Transpose
~Oct/5th Transpose
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Note Series -> Length
Pools-Random Factor
Pools-Weighting Curve
Rests-Random Factor
Rests-Weighting Curve
Pools/Poly
Keyboard Track
NTT On/Off
Link To Next
Notes Played = Rows
Wrap Bottom
Wrap Top
~Repeat On/Off Pattern
~Repeat On/Off Combs
~Resync Index Template
Template Bank 1
Template Bank 2
Template Bank 3
Templ Bank1 + Restore
Templ Bank2 + Restore
Templ Bank3 + Restore
See the Drum Page.<DrmEd>

15: Direct Index
Index Shift
Trill Mode
Held Note Trig Mode
Transpose
Vel. Sensitivity(Kbd)
Velocity Offset (CCs) 
Duration Control
Duration Mode
Duration ms
Melodic Rpt On/Off
Bend On/Off
Bend Amount
Bend Shape
Bend Alternation
Bend Step
Bend Length
Bend Fixed-ms
Bend Start %
Bend End %
Bend Width %
See the Direct Index Page.<DixEd>

<GrpPE>
RT Parms Reference - Performance RT Parms By Group
The following seven groups of parameters are available to be assigned as Performance RT Parms in the Performance 
Editor > RT Parms Page.<RPPEd>

    Virtual Parameters are indicated by a tilde “~” at the beginning of the name.

0: Off
No assignment. The rest of the parameters in the row will be grayed out.

1: Performance
Time Signature
See the Performance Editor. <PE>

2: GE Setup/Mix
Run
Transpose
~Octave Transpose
~Oct/5th Transpose
See the GE Setup/Mix Page. <MixEd>
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3: Control
Force Range
Force Range Wrap
Root Position
Clock Advance Mode
Clock Advance Size
CA Vel. Sensitivity
CA Chord Trigger Mode
Note Map Mode
Note Map Table
Note Map Transpose
Note Map Chord Track
Note Map Kbd Track
~Note Map Table + Off
See the Control Page. <CtlEd>

4: Trigger
Quantize Triggers
Quantize Window
Delay Start
Delay Start ms
Note Trigger
Note Latch
Update On Release
Env1 Trigger
Env1 Latch
Env2 Trigger
Env2 Latch
Env3 Trigger
Env3 Latch
Trigger By Module
GE Phrase Length %
See the Trigger Page. <TrgEd>

5: Key Zones
Thru Inside Zone
Thru Outside Zone
Key Zone Bottom
Key Zone Top
Transpose Thru In Zone
Transpose Thru Out Zone
~Oct. Transp. Thru InZ
~Oct. Transp. Thru OutZ
~Oct/5 Transp. Thru InZ
~Oct/5 Transp. Thru OutZ
Kbd Layer Transpose
See the Key Zones Page. <KeyEd>

6: Random Seeds
Start Seed
Freeze Loop Length
~Freeze LoopLen + Reset
Retrigger Each Time
See the Random Seeds Page. <RsdEd>

7: MIDI Setup
Mod-Out Channel
Kbd-Out Channel
See the MIDI Setup Page. <MidEd>
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KARMA Wave-Sequencing
Sections in this chapter:

Yamaha vs. Korg<KWS/YK>

Waveform Order in the Yamaha XF and MOXF<KWS/Order>

<YK>
Karma Wave-Sequencing - Yamaha vs. Korg
In Korg’s program architecture, there are generally two oscillators which can have a cross-switch or cross fade in them 
with different waveforms. KARMA Wave-sequencing was designed to affect either oscillator individually, or both at the 
same time, in several different ways – controlled by the “Oscillator Mode” parameter.

In order to get around the issues of cross-faded/cross-switched oscillators using more than one waveform (say a piano 
from velocity 1 to 64 and a brass hit from 65 to 127), Korg and Karma-Lab implemented it so that if the Korg gets a 
KARMA Wave-sequencing message, it essentially becomes a one-waveform oscillator with no fades/switches, ignoring 
any cross-fades that may be set up, so that the entire range of the oscillator responds to the wave-sequencing. This way, 
KARMA can then control the two oscillators independently by specifying single waveform choices for each one, according 
to the “Oscillator Mode” parameter.

Since a Motif/MOX Voice has 8 elements (you can think of them as 8 oscillators), and no cross-fades or switches inside an 
element (you just use different elements for this), some limitations and rules for using this feature with a Motif/MOX 
are:

1) You can KARMA Wave-Sequence element 1 (osc 1), or element 2 (osc 2), or both at the same time in several ways 
(same as a Korg), but none of the other elements. Therefore, this feature will work best with a single or dual element 
voice (a simple synth voice such as PRE 6-81 W Phaser works very well, since it is a single element synth with no splits 
or velocity cross-fades). Of course, you can use the feature with any Voice and have some elements being 
wave-sequenced, and others staying as they are, but it’s most predictable with a single or dual element “simple” voice.

2) In order to change the waveforms in an element in the Motif/MOX Song Mode, two SysEx messages must be sent: 

- first, you tell it which part is going to be targeted
- then you send the message that changes the waveform in the elements of the Voice in that part. 

Therefore, since KARMA doesn’t really “know” which part in the Motif/MOX Song that a Module is sending MIDI to (and 
only knows which MIDI Channel the Module is sending on), the part number MUST match the MIDI Channel of the Module. In 
other words, if Module 3 is set to output on MIDI Channel 6 (as is usual in the Factory Performances), then KARMA 
Wave-Sequencing in Module 3 will change waveforms in the elements of the Voice in Part 6 – regardless of the MIDI 
Channel setting for that part in the Motif/MOX. So, as a convention in all of the Factory Performances, the part number 
matches the MIDI Channel assignment in the Motif/MOX Song. You don’t really need to worry about this with the Factory 
Performances – but you might need to know this if you were programming a new KARMA Performance from scratch.

3) In a Korg, there is a special message that will reset the waveform in the oscillator to the stored setting. You can start 
out with the program using its stored waveforms (i.e. a piano), turn on KARMA Wave-Sequencing, get all whacky, and 
turn it off and have it go back to the original stored waveform (i.e. a piano). Korg implemented this feature specifically 
for KARMA control; this is not possible to do with the Motif/MOX (without Yamaha modifying the Operating System), so 
the way it works is that turning off the wave-sequencing sets the wave to the first specified waveform in the GE’s 
WavSeq Phase and Pattern Grid - so at least it’s consistent. But there’s no way to get back to the original waves of the 
voice when first loaded.

<Order>
Karma Wave-Sequencing - Waveform Order in the Yamaha XF and MOXF
The Yamaha Motif XS (and the MOX, which is based on the same sound engine) have 2,670 waveforms in the ROM. The 
Motif XF (and MOXF, which is based on the XF) have 3,977 waveforms. The two different ROMs are not in the same order 
- the XF ROM has the new additional waveforms inserted into the waveform categories in various places in the list, 
making the list very different from the order of the XS/MOX list.

In order to maintain compatibility between KARMA Wave-Sequencing GEs so that they can be used on any of the supported 
Yamaha devices, a special waveform list is used for the XF and MOXF that does not match the order of the ROM in the 
keyboard itself. Rather, the XF/MOXF waveform list displayed by KARMA Motif has the exact same 2,670 waveforms as 
the XS/MOX for the first part of the list; the additional new waves are added then at the end of the list. As KARMA 
generates wave-sequencing messages for the XF/MOXF, the waveform IDs are remapped to the actual real order of the 
ROM before being sent to the keyboard.
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By doing this, all of the factory voicing that Karma-Lab produces (which only uses the waveforms in the first 2,670 
waves - in other words, the XS ROM) works exactly the same way and produces the same results regardless of which 
Motif or MOX you are using. Also, if you created your own KARMA Wave-Sequencing GEs on an XS/MOX and later change 
to an XF/MOXF, your own data would still be compatible. If you have an XF or MOXF and you wish to create GEs that use 
the additional waves beyond the 2,670 of the original XS ROM, you are free to do so - you’ll just find them at the end of 
the waveform list when you open the Waveform Select Dialog. <WavEd2/Dlg>
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Communication Configuration - XS & XF
Sections in this chapter:

Summary of Necessary Settings - XS<MotifCfg/XS>

Summary of Necessary Settings - XF<MotifCfg/XF>

Using FireWire and the FW16e or mLAN16E2 boards<MotifCfg/FW>

If you loaded the Motif XS or XF Data File as instructed in the Installation and First Launch tutorial (located in the 
Tutorials Folder), then your Motif should already be configured as described in this chapter. This is merely a reference to 
the necessary settings.
<SetupKMO/TutFolder>

    The default configuration for KARMA Motif is to have Local Control = on in the Motif. See the Sequencing With 
KARMA Motif tutorial (in the Tutorials Folder) for more information on using the software with Local Control = off. 
<SetupKMO/TutFolder>

    The following diagrams show the UTILITY screens when in Song > Mixing Mode.

<XS>
Summary of Necessary Settings - XS
 

1. [UTILITY] > Control > MIDI
Basic Receive Ch = 1
KeyboardTransmitCh = 1
Device Number = all
MIDI In/Out = USB or mLAN
MIDI Sync = MIDI  -  See also: Setting the MIDI Clock Sync Options <KMoCfg/Sync>
Clock Out = on
Sequencer Control = out
Bank Select = on
Program Change = on
Local Control = on
Receive Bulk = on
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2. [UTILITY] > Control > Remote
DAW Type = Digital Performer

3. [UTILITY] > General > AutoLoad
IEEE1394 Driver = FW (if using the mLAN board and Steinberg Drivers - see below)
<MotifCfg/FW>

4. Press the [STORE] button to write the settings to the Motif’s memory.

<XF>
Summary of Necessary Settings - XF
 

1. [UTILITY] > Control > MIDI
Basic Receive Ch = 1
KeyboardTransmitCh = 1
Device Number = all
MIDI In/Out = USB or FW
MIDI Sync = MIDI  -  See also: Setting the MIDI Clock Sync Options <KMoCfg/Sync>
Clock Out = on
Sequencer Control = out
Bank Select = on
Program Change = on
Local Control = on
Receive Bulk = on

2. [UTILITY] > Control > Remote
DAW Type = Digital Performer

Page 423



3. [UTILITY] > Control > Control
22   Ribbon Controller Control No.
11   Foot Controller 1 Control No.
04   Foot Controller 2 Control No.
088                                Foot Switch Control No.
16   Assign 1 Control No.
17   Assign 2 Control No.
86   A. Function 1 Control No.
87   A. Function 2 Control No.
02   Breath Controller Control No.

4. Press the [STORE] button to write the settings to the Motif’s memory.

<FW>
Using FireWire and the FW16e or mLAN16E2 boards

The Motif Data File contains system data that will properly configure the system settings of your Motif to work with the 
KARMA software. However, the “Interface > MIDI In/Out” setting is set to USB. If you are using the FireWire FW16E 
expansion board for MIDI connectivity (or the older mLAN16E2 board on the Motif XS, below right), you need to manually 
change the MIDI In/Out setting to FW (or mLAN) as shown below. Press [UTILITY] and select the Control > MIDI Page:

 

                               XF                                                                     XS

Furthermore, if you are using a Motif XS and the Yamaha Steinberg FW Driver, you will need to change the IEEE1394 
Driver setting from the General > AutoLoad Page from mLAN to FW:

 

                           XS ONLY

Then press the [STORE] button to write these settings into your Motif. You may wish to save a new “all” file at this time 
containing this setting and all the rest of the KARMA Motif Factory Data for easy loading in the future.

Page 424



Communication Configuration - MOX & MOXF
If you loaded the MOX or MOXF Data File as instructed in the Installation and First Launch tutorial (located in the 
Tutorials Folder), then your MOX/MOXF should already be configured as described in this chapter. This is merely a 
reference to the necessary settings.
<SetupKMO/TutFolder>

    The default configuration for KARMA Motif is to have Local Control = on in the MOX/MOXF. See the Sequencing With 
KARMA Motif tutorial (in the Tutorials Folder) for more information on using the software with Local Control = off. 
<SetupKMO/TutFolder>

    The following diagrams show the UTILITY screens when in Song > Mixing Mode.

 

1. [UTILITY] > [GENERAL] > [REMOTE]
DAW Select = Cubase

2. [UTILITY] > [CTLASN] > [ASSIGN]
02   BC  (Breath Controller)
22   RB  (Ribbon Controller)
11   FC1  (Foot Controller 1)
04   FC2  (Foot Controller 2)
16   AS1  (Assign 1 Control)
17   AS2  (Assign 2 Control)
86   AF1  (A. Function 1 Control)
87   AF2  (A. Function 2 Control)

3. [UTILITY] > [ MIDI ] > [  CH  ] (Channel)
BasicRcvCh = 1
KbdTransCh = 1
DeviceNo. = all

4. [UTILITY] > [ MIDI ] > [SWITCH]
BankSel = on
PgmChange = on
LocalCtrl = on
RcvBulk = on

5. [UTILITY] > [ MIDI ] > [ SYNC ]
MIDI Sync = external  -  See also: Setting the MIDI Clock Sync Options <KMoCfg/Sync>
ClockOut = on
SeqCtrl = in/out

6. [UTILITY] > [ MIDI ] > [OTHER]
MIDI IN/OUT = USB

7. Press the [STORE] button to write the settings to the MOX/MOXF’s memory.
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Communication Configuration - Rack-XS
Sections in this chapter:

Summary of Necessary Settings<RackCfg/XS>

Using FireWire and the mLAN16E2 board<RackCfg/FW>

If you loaded the Motif Rack-XS Data as instructed in the Installation and First Launch tutorial (located in the 
Tutorials Folder), and performed the step of setting up the System Settings, then your Rack-XS should already be 
configured as described in this chapter. This is merely a reference to the necessary settings.
<SetupKMO/TutFolder>

    The default configuration for KARMA Motif is to have Local Control = on in the Rack-XS. See the Sequencing With 
KARMA Motif tutorial (in the Tutorials Folder) for more information on using the software with Local Control = off. 
<SetupKMO/TutFolder>

    The first five screens below are from the Multi Mode [UTILITY] page. In the sixth screen, the Receive Channel must be 
set in the Voice Mode UTILITY page, or the Rack-XS will not respond to Performance changes sent by KARMA in either 
Voice or Multi Mode.

<XS>
Summary of Necessary Settings
 

Multi Mode > [UTILITY]:

1. [UTILITY] > [MIDI] > [MIDI 1/6]
MIDI IN/OUT = USB or mLAN
MIDI Sync = external  -  See also: Setting the MIDI Clock Sync Options <KMoCfg/Sync>
ClockOut = off
LocalCtrl = on
Device No. = all

2. [UTILITY] > [MIDI] > [MIDI 2/6]
Bank Select Sw = on
Prg Change Sw = on
Receive Bulk = on

3. [UTILITY] > [Controller] > [Controller 1/3]
22   RB Ctrl No. (Ribbon Controller)
11   FC 1 Ctrl No. (Foot Controller 1)
04   FC 2 Ctrl No. (Foot Controller 2)
88   FS Ctrl No. (Foot Switch)

4. [UTILITY] > [Controller] > [Controller 2/3]
16   AS 1 Ctrl No. (Assign 1 Control)
17   AS 2 Ctrl No. (Assign 2 Control)
86   A.Func1 Ctrl No. (A. Function 1 Control)
87   A.Func2 Ctrl No. (A. Function 2 Control)
02   BC Ctrl No. (Breath Controller)

5. [UTILITY] > [General] > [General 2/5]
IEEE1394 Driver = FW (if using the mLAN board and Steinberg Drivers - see below)
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�Voice Mode [UTILITY]:

6. [UTILITY] > [Voice MIDI]
          Receive Ch = 1
          Transmit Ch = 1

7. Press the [STORE] button to write the settings to the Rack-XS’s memory.

<FW>
Using FireWire and the mLAN16E2 board

If you are using the mLAN16E2 board for FireWire connectivity, you need to have the MIDI In/Out setting set to mLAN as 
shown below. Furthermore, if you are using the Yamaha Steinberg FW Driver, you need to change the IEEE1394 Driver 
setting from mLAN to FW:

 

1. [UTILITY] > [MIDI] > [MIDI 1/6]
          MIDI IN/OUT = mLAN

2. [UTILITY] > [General] > [General 2/5]
          IEEE1394 Driver = FW

3. Press the [STORE] button to write the settings to the Rack-XS’s memory.
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Communication Configuration - S70/S90 XS
Sections in this chapter:

Summary of Necessary Settings<S90XSCfg/Sum>

<SetupKMO/TutFolder>

    The default configuration for KARMA Motif is to have Local Control = on in the S70/S90 XS. See the Sequencing 
With KARMA Motif tutorial (in the Tutorials Folder) for more information on using the software with Local Control = 
off. 
<SetupKMO/TutFolder><Sum>
Summary of Necessary Settings
 

Multi Mode > [UTILITY]:

1. [UTILITY] > [MIDI] > [MIDI 1/3]
          LocalCtrl = on
          Keyboard Transmit Ch = 1
          Basic Receive Ch = 1
          MIDI IN/OUT = USB
          MIDI Sync = external  -  See also: Setting the MIDI Clock Sync Options <KMoCfg/Sync>
          ClockOut = off

2. [UTILITY] > [MIDI] > [MIDI 2/3]
          SeqCtrl = in/out
          Bank Select Sw = on
          Prg Change Sw = on

          Controller Reset = reset

3. [UTILITY] > [MIDI] > [MIDI 3/3]
          Receive Bulk = on

          Bulk Interval = 0ms
          Device No. = all

4. [UTILITY] > [Remote]
          DAW Select = Cubase

5. [UTILITY] > [Controller] > [Controller 1/2]
          22   RB Ctrl No. (Ribbon Controller)
          11   FC 1 Ctrl No. (Foot Controller 1)
          04   FC 2 Ctrl No. (Foot Controller 2)
          arp sw   FS Ctrl No. (Foot Switch)

6. [UTILITY] > [Controller] > [Controller 2/3]
          16   AS 1 Ctrl No. (Assign 1 Control)
          17   AS 2 Ctrl No. (Assign 2 Control)
          86   A.Func1 Ctrl No. (A. Function 1 Control)
          87   A.Func2 Ctrl No. (A. Function 2 Control)
          02   BC Ctrl No. (Breath Controller)

   

 

If you loaded the S70/S90 XS Data as instructed in the Installation and First Launch tutorial (located in the 
Tutorials Folder), then your S70/S90 XS should already be configured as described in this chapter. This is merely a 
reference to the necessary settings.
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Communication Configuration - KARMA Software
Sections in this chapter:

Setting up the Global MIDI Settings<KMoCfg/GMIDI>

Setting the MIDI Clock Sync Options<KMoCfg/Sync>

If you configured KARMA Motif using the MIDI Assistant as explained in the Installation and First Launch tutorial 
(located in the Tutorials Folder), you will not need to perform the steps in this section - they are all done automatically. 
However, if you are having difficulties or need to manually configure the software for some reason, use the guide below.
<SetupKMO/TutFolder><GMIDI>
Setting the Global MIDI Settings
1. If it is not already open, select the MIDI Setup (Global) Editor > General Page. In the upper left corner you’ll find the 
Global Port and Channel settings (see the image below).

 

At this point, the status message at the top of the editor most likely reads “Yamaha Motif/MOX Synthesizer not located 
on Global Ports.” To connect the Motif/MOX to the KARMA software, set the Global In and Out ports to the ports that your 
Motif/MOX is connected to. The ports available in the menus will vary depending on the drivers and devices installed on 
your computer. In the image above, there are two Motifs (an XS via USB, and an XF via FireWire), a Korg M3, a standard 
MIDI interface, and the Apple IAC Driver shown. Note that not all of the ports are enabled. This is controlled by the MIDI 
Port Manager, so you may need to open the correct port first to enable it in the menus.
<MidPort>

2. Next, set the Global In/Out Channels to 1, and make sure your Motif/MOX’s Global MIDI Channels are also set to 1 – you 
can check this in [UTILITY] > Control > MIDI. See the previous chapter in this Appendix section related to your Yamaha 
device:

Communication Configuration - XS & XF<MotifCfg>

Communication Configuration - MOX & MOXF<MOXCfg>

Communication Configuration - Rack-XS<RackCfg>

Communication Configuration - S70/S90 XS<S90XSCfg>

Once you have this correct, the status message will change (give it a few seconds or so) to something like “Yamaha 
Motif/MOX Synthesizer located on Input/Output Ports 2/2” (your numbers may be different). The Communication Status 
Window will also pop up, displaying the same message. The numbers indicate which port in the lists in the In and Out Port 
menus the Motif/MOX has been located on. <CommStat>

    If the Link All Ports To Global Ports checkbox is selected (recommended and set by default) in the Performance Editor 
> MIDI Setup Page, changing the Global Ports automatically changes the MIDI Ins & Outs Ports for each Performance - so 
you may not have to make any other changes manually. The Global Port/Channel settings are stored in the Preferences file 
for the application, while the other settings Performance’s MIDI Setup Page are stored inside each Performance. 
<MidEd/Link>
<Sync>
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�Setting the MIDI Clock Sync Options
 

Open the MIDI Setup (Global) Editor > Sync Page from the applications’s Window Menu (Cmnd+Y [Mac], Ctrl+Y [Win]), and 
configure it so that the Mode is “Auto”, the first Output Port is set to the port your Motif/MOX is located on (Port 1 of 
the Yamaha USB Driver in this example), and the “Send” checkbox is on. This way, when you change the tempo of 
Performances inside the software, the beat-synchronized effect settings (IFX/MFX) will stay properly in sync (assuming 
the Motif/MOX has been set up to recognize the sync).  

Furthermore, for the Yamaha MOX and MOXF only, set the Filter Start/Continue checkbox on:

 

For more information, see:

Communication Configuration - XS & XF<MotifCfg>

Communication Configuration - MOX & MOXF<MOXCfg>

Communication Configuration - Rack-XS<RackCfg>

Communication Configuration - S70/S90 XS<S90XSCfg>

Sync Editor <SynEd>
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Additional Rack-XS Setup
This chapter explains the essential final steps for configuring KARMA Motif and your Rack-XS along with an external 
keyboard controller.

You should already have installed the Yamaha USB Driver for the Rack-XS, available at http://download.yamaha.com. 
Alternately, you could be using the Steinberg FW Driver with the mLAN16E2 board, in which case you would be connected 
to the computer with a FireWire cable. Diagram 1 below shows one typical setup, using the USB Port on the Rack-XS. The 
external keyboard is shown using a MIDI interface, but it could also be using a USB Driver if the device’s manufacturer 
has supplied one.

 

                     Diagram 1: Typical Rack-XS setup with Yamaha USB Driver

1. In KARMA Motif, open the MIDI Setup (Global) Editor > General Page by clicking on the MIDI Setup (Global) button at the 
top of the Main Window, and choosing the General Page from the triangle buttons down the left side. 
<MsuGen>

2. The Global In/Out Ports at the center top section should be set to Port 1 of the Yamaha USB Driver as show below. (If 
you are using FireWire, the port will be named “main.”) Set the Global Channels to “1” and the Voice MIDI Transmit and 
Receive Channels inside your Rack-XS to “1.” (You can change this later if you need to, but for now use Channel 1). The 
Device menu shown below should be set to “Yamaha Motif XS.”

    These settings will normally have already been accomplished by the MIDI Setup Assistant.
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3. First, before you can assign a keyboard controller to control KARMA, you must open the MIDI port that it is connected 
to. Choose MIDI Port Manager from the application’s Window Menu, and you will see the dialog shown below.
<MidPort>

 

4. In the Input section to the left, locate and check (open) the MIDI Port that your keyboard controller is connected to. 
Then press the OK button (green checkmark) to exit the dialog. The example above uses a Korg M3 as the controller.

5. Proceed to the Performance Editor > MIDI Setup Page by clicking on the Performance button at the top of the Main 
Window, and choosing the MIDI Setup Page from the triangle buttons down the left side.
<MidEd>

6. Uncheck the “Link All Ports To Global Ports” checkbox at the lower left as shown below.

7. Set the Module 1 Input Port, which now becomes available (in the Input Section to the left) to the Port or USB Driver 
that the Keyboard is connected to (which is the Port you just opened in Step 4). 

 

You’ve now routed the keyboard controller into the input of all six Modules and two Keyboard Layers, since the Mode 
button at the top of the Input section is set to “Single.” If you play the keyboard now, you should be controlling KARMA. 
The Output section still has the destination Port set to the Rack-XS.

8. Note that this has only changed the settings for the current Performance (each Performance has its own MIDI Setup 
stored inside it). In order to propagate these changes to all Performances in the file, so they all work with this setup 
without you having to do it to each one individually, click on the round Menu Button in the upper left of the MIDI Setup Page 
(shown below). A popup menu will appear, giving you access to the Help file and other utilities that apply to the current 
window. Choose “Copy Port Settings To All Performances” and every Program/Combi receives these port settings. 
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9. Finally, it is important that you save your changes to the KDF file using the “Save” or “Save As…” commands from 
the application’s File Menu (or this work will be forgotten next time you load the file). You can give this file a new name 
and it will automatically be opened the next time you run KARMA Motif (or just overwrite the existing one).

    Note that you also need to load the Motif Rack-XS Data (if you haven’t already done so) as instructed in the Installation 
and First Launch tutorial (located in the Tutorials Folder).
<SetupKMO/TutFolder>
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